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About This Manual 
Congratulations on your purchase of the PASS package! PASS offers: 

• Easy parameter entry. 

• A comprehensive list of power analysis routines that are accurate and verified, yet are 
quick and easy to learn and use. 

• Straightforward procedures for creating paper printouts and file copies of both the 
numerical and graphical reports. 

Our goal is that with the help of these user's guides, you will be up and running on PASS quickly. 
After reading the quick start manual (at the front of User's Guide I) you will only need to refer to 
the chapters corresponding to the procedures you want to use. The discussion of each procedure 
includes one or more tutorials that will take you step-by-step through the tasks necessary to run 
the procedure. 

I believe you will find that these user’s guides provides a quick, easy, efficient, and effective way 
for first-time PASS users to get up and running.  

I look forward to any suggestions you have to improve the usefulness of this manual and/or the 
PASS system. Meanwhile, good computing! 

 

 Jerry Hintze, President 

 



   

PASS License Agreement 
Important: The enclosed Power Analysis and Sample Size software program (PASS) is licensed by NCSS to customers for 
their use only on the terms set forth below. Your purchase and use of the PASS system indicates your acceptance of these 
terms. 
 
1. LICENSE. NCSS hereby agrees to grant you a non-exclusive license to use the accompanying PASS program 
subject to the terms and restrictions set forth in this License Agreement. 
 
2. COPYRIGHT. PASS and its documentation are copyrighted. You may not copy or otherwise reproduce any part of 
PASS or its documentation, except that you may load PASS into a computer as an essential step in executing it on the 
computer and make backup copies for your use on the same computer. 
 
3. BACKUP POLICY. PASS may be backed up by you for your use on the same machine for which PASS was 
purchased. 
 
4. RESTRICTIONS ON USE AND TRANSFER. The original and any backup copies of PASS and its 
documentation are to be used only in connection with a single user.  This user may load PASS onto several machines for 
his/her convenience (such as a desktop and laptop computer), but only for use by the licensee. You may physically transfer 
PASS from one computer to another, provided that PASS is used in connection with only one user. You may not distribute 
copies of PASS or its documentation to others. You may transfer this license together with the original and all backup 
copies of PASS and its documentation, provided that the transferee agrees to be bound by the terms of this License 
Agreement. PASS licenses may not be transferred more frequently than once in twelve months. Neither PASS nor its 
documentation may be modified or translated without written permission from NCSS. 
 You may not use, copy, modify, or transfer PASS, or any copy, modification, or merged portion, in whole or in part, 
except as expressly provided for in this license. 
 
5. NO WARRANTY OF PERFORMANCE. NCSS does not and cannot warrant the performance or results that may 
be obtained by using PASS. Accordingly, PASS and its documentation are licensed "as is" without warranty as to their 
performance, merchantability, or fitness for any particular purpose. The entire risk as to the results and performance of 
PASS is assumed by you. Should PASS prove defective, you (and not NCSS nor its dealer) assume the entire cost of all 
necessary servicing, repair, or correction. 
 
6.  LIMITED WARRANTY ON CD. To the original licensee only, NCSS warrants the medium on which PASS is 
recorded to be free from defects in materials and faulty workmanship under normal use and service for a period of ninety 
days from the date PASS is delivered. If, during this ninety-day period, a defect in a CD should occur, the CD may be 
returned to NCSS at its address, or to the dealer from which PASS was purchased, and NCSS will replace the CD without 
charge to you, provided that you have sent a copy of your receipt for PASS. Your sole and exclusive remedy in the event 
of a defect is expressly limited to the replacement of the CD as provided above. 
 Any implied warranties of merchantability and fitness for a particular purpose are limited in duration to a period of 
ninety (90) days from the date of delivery. If the failure of a CD has resulted from accident, abuse, or misapplication of the 
CD, NCSS shall have no responsibility to replace the CD under the terms of this limited warranty. This limited warranty 
gives you specific legal rights, and you may also have other rights which vary from state to state. 
 
7. LIMITATION OF LIABILITY.  Neither NCSS nor anyone else who has been involved in the creation, production, 
or delivery of PASS shall be liable for any direct, incidental, or consequential damages, such as, but not limited to, loss of 
anticipated profits or benefits, resulting from the use of PASS or arising out of any breach of any warranty. Some states do 
not allow the exclusion or limitation of direct, incidental, or consequential damages, so the above limitation may not apply 
to you. 
 
8. TERM. The license is effective until terminated. You may terminate it at any time by destroying PASS and 
documentation together with all copies, modifications, and merged portions in any form. It will also terminate if you fail to 
comply with any term or condition of this License Agreement. You agree upon such termination to destroy PASS and 
documentation together with all copies, modifications, and merged portions in any form. 
 
9. YOUR USE OF PASS ACKNOWLEDGES that you have read this customer license agreement and agree to its 
terms. You further agree that the license agreement is the complete and exclusive statement of the agreement between us 
and supersedes any proposal or prior agreement, oral or written, and any other communications between us relating to the 
subject matter of this agreement. 
 
Dr. Jerry L. Hintze & NCSS, Kaysville, Utah 



Preface 
PASS (Power Analysis and Sample Size) is an advanced, easy-to-use statistical analysis software 
package. The system was designed and written by Dr. Jerry L. Hintze and other members of the 
development team over the last twenty years. Dr. Hintze drew upon his experience both in 
teaching statistics at the university level and in various types of statistical consulting. 

The present version, written for 32-bit and 64-bit versions of Microsoft Windows (7, Vista, XP) 
computer systems, is the result of several iterations. Experience over the years with several 
different types of users has helped the program evolve into its present form. 

NCSS maintains a website at www.ncss.com where we make the latest edition of PASS available 
for free downloading. The software is password protected, so only users with valid serial numbers 
may use this downloaded edition. We hope that you will download the latest edition routinely and 
thus avoid any bugs that have been corrected since you purchased your copy. 

We believe PASS to be an accurate, exciting, easy-to-use program. If you find any portion which 
you feel needs to be changed, please let us know. Also, we openly welcome suggestions for 
additions and enhancements. 

Verification 
All calculations used in this program have been extensively tested and verified. First, they have 
been verified against the original journal article or textbook that contained the formulas. Second, 
they have been verified against second and third sources when these exist. 

 

http://www.ncss.com/
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Chapter 571 

Random Effects 
Mixed Models 
Introduction 
This procedure power analyzes random effects designs in which the outcome (response) is 
continuous. Thus, as with the analysis of variance (ANOVA), the procedure is used to test 
hypotheses comparing various group means. Unlike ANOVA, this procedure relaxes the strict 
assumptions regarding the variances of the groups. Random effects models are commonly used to 
analyze longitudinal (repeated measures) data. 

This procedure extends many of the classical statistical techniques to the case when the variances 
are not equal, such as  

• Two-sample designs (extending the t-test) 
• One-way layout designs (extending one-way ANOVA) 
• Factorial designs (extending factorial GLM) 
• Split-plot designs (extending split-plot GLM) 
• Repeated-measures designs (extending repeated-measures GLM) 
• Cross-over designs (extending GLM) 

Types of Linear Mixed Models 
Several linear mixed model subtypes exist that are characterized by the random effects, fixed 
effects, and covariance structure they involve. These include fixed effects models, random effects 
models, and covariance pattern models.  

Fixed Effects Models 
A fixed effects model is a model where only fixed effects are included in the model. An effect (or 
factor) is fixed if the levels in the study represent all levels of interest of the factor, or at least all 
levels that are important for inference (e.g., treatment, dose, etc.). No random components are 
present. The general linear model is a fixed effects model. Fixed effects models can include 
interactions. The fixed effects can be estimated and tested using the F-test.  

The fixed effects in the model include those factors for which means, standard errors, and 
confidence intervals will be estimated and tests of hypotheses will be performed. Other variables 
for which the model is to be adjusted (that are not important for estimation or hypothesis testing) 
can also be included in the model as fixed factors.  
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Random Effects Models 
A random effects model includes both fixed and random terms in the model. An effect (or factor) 
is random if the levels of the factor represent a random subset of a larger group of levels (e.g., 
patients). The random effects are not tested, but are included to make the model more realistic.  

Longitudinal Data Models 
Longitudinal data arises when more than one response is measured on each subject in the study. 
Responses are often measured over time at fixed time points. A time point is fixed if it is pre-
specified. Various variance-matrix structures can be employed to model the variance and 
correlation among repeated measurements.  

Types of Factors 

Between-Subject Factors 
Between-subject factors are those that separate the experimental subjects into groups. If twelve 
subjects are randomly assigned to three treatment groups (four subjects per group), treatment is a 
between-subject factor. 

Within-Subject Factors 
Within-subject factors are those in which the response is measured on the same subject at several 
time points. Within-subject factors are those factors for which multiple levels of the factor are 
measured on the same subject. If each subject is measured at the low, medium, and high level of 
the treatment, treatment is a within-subject factor.  

Technical Details 

What is a Mixed Model? 
In a general linear model (GLM), a random sample of the individuals in is drawn. Treatments are 
applied to each individual and an outcome is measured. The data so obtained are analyzed using 
an analysis of variance table that includes an F-test.  

A mathematical model may be formulated that underlies each analysis of variance. This model 
expresses of the response variable as the sum of population parameters and a residual. For 
example, a common linear model for a two-factor experiment is 

ijkijjiijk eabbaY ++++= )(μ  

where i = 1, 2, ... , I (the number of levels of factor 1),  j = 1, 2, ..., J  (the number of levels of 
factor 2), and k = 1, 2, ... , K  (the number of subjects in the study). This model expresses the 
value of the response variable, Y, as the sum of five components:  

μ the mean. 

ai the contribution of the ith level of a factor A. 

bj the contribution of the jth level of a factor B. 
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(ab)ij the combined contribution (or interaction) of the ith level of a factor A and the jth level 
of a factor B. 

eijk the contribution of the kth individual. This is often called the residual. 

In this example, the linear model is made up of fixed effects only. An effect is fixed if the levels in 
the study represent all levels of the factor that are of interest, or at least all levels that are 
important for inference (e.g., treatment, dose, etc.).  

The following assumptions are made when using the F-test in a general linear model. 

1. The response variable is continuous. 

2. The individuals are independent. 

3. The eijk follow the normal probability distribution with mean equal to zero. 

4. The variances of the eijk are equal for all values of i, j, and k. 

The Linear Mixed Model (LMM) 
The linear mixed model (LMM) is a natural extension of the general linear model. Mixed models 
extend linear models by allowing for the addition of random effects, where the levels of the factor 
represent a random subset of a larger group of all possible levels (e.g., time of administration, 
clinic, etc.). For example, the two-factor linear model above could be augmented to include 
random effects such as an adjustment for each patient, since a patient may be assumed to be a 
random realization from a distribution of patients. The general form of the mixed model in matrix 
notation is 

y = Xβ + Zu + ε 

where 

y  vector of responses 

X known design matrix of the fixed effects 

β unknown vector of fixed effects parameters to be estimated 

Z  known design matrix of the random effects 

u  unknown vector of random effects 

ε  unobserved vector of random errors 

We assume 

u ~ N(0,G) 

ε ~ N(0,R) 

Cov[u, ε] = 0 

where 

G variance-covariance matrix of u 

R variance-covariance matrix of the errors ε 

The variance-covariance matrix of y, denoted V, is 

        V  = Var[y] 
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     = Var[Xβ + Zu + ε] 

     = 0 + Var[Zu + ε] 

     = ZGZ' + R 

Individual Subject Formulation 
Because of the size of the matrices that are involved in mixed model analysis, it is useful for 
computational purposes to reduce the dimensionality of the problem by analyzing the data one 
subject at a time. Because the data from different subjects are statistically independent, the log-
likelihood of the data can be summed over the subjects, according to the formulas below. Before 
we look at the likelihood functions, we examine the linear mixed model for a particular subject:  

yi = Xiβ + Ziui + εi,    i = 1, …, N 

where 

yi ni×1 vector of responses for subject i.  

Xi ni×p design matrix of fixed effects for subject i (p is the number of columns in X). 

β p×1 vector of regression parameters. 

Zi ni×q design matrix of the random effects for subject i. 

ui q×1 vector of random effects for subject i which has means of zero and covariance matrix 
Gsub. 

εi  ni×1 vector of errors for subject i with zero mean and covariance Ri. 

ni number of repeated measurements on subject i. 

N  number of subjects. 

The following definitions will also be useful. 

ei  vector of residuals for subject i (ei = yi - Xiβ). 

Vi  Var[yi] = ZiGsubZi' + Ri 

To see how the individual subject mixed model formulation relates to the general form, we have 
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In order to test the parameters in β, which is typically the goal in LMM analysis, the unknown 
parameters (β, G, and R) must be estimated. Estimates for β require estimates of G and R. In 
order to estimate G and R, the structure of G and R must be specified. Details of the specific 
structures for G and R are discussed later. 

The following assumptions are made when using the F-test in a LMM. 

1. The response variable is continuous. 

2. The individuals are independent. 
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3. The responses follow the normal probability distribution with mean equal to zero and 
variance structure given by V. 

A distinct (and arguably the most important) advantage of LMM over the GLM is flexibility in 
random error and random effect variance component modeling (note that the equal-variance 
assumption of GLM is not necessary for LMM). LMM allows you to model both heterogeneous 
variances and correlations among observations through the specification of the covariance matrix 
structures for u and ε. The variance matrix estimates are obtained using maximum likelihood 
(ML) or, more commonly, restricted maximum likelihood (REML). The fixed effects in the 
mixed model are tested using F-tests.  

Structure of the Variance-Covariance Matrix 

The G Matrix 
The G matrix is the variance-covariance matrix for the random effects u. Typically, when the G 
matrix is used to specify the variance-covariance structure of y, the structure for R is simply σ2I. 
Caution should be used when both G and R are specified as complex structures, since large 
numbers of sometimes redundant covariance elements can result.  

The G matrix is made up of N symmetric Gsub matrices, 
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The dimension of Gsub is q × q, where q is the number of random effects for each subject. 

Structures of Gsub 
The structure of the Gsub matrix in this procedure is diagonal. 

Diagonal Gsub 
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The R Matrix 
The R matrix is the variance-covariance matrix for errors, ε. When the R matrix is used to specify 
the variance-covariance structure of y, the Gsub matrix is not used. 

The full R matrix is made up of N symmetric R sub-matrices, 
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where  are all of the same structure.  NRRRR ,,,, 321 L

Structures of R 
There are many possible structures for the sub-matrices that make up the R matrix. The RSub 
structures that can be specified in PASS are shown below. 
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Banded(2) 
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Note: This is the same as Toeplitz(1). 
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Banded(3) 
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Partitioning the Variance-Covariance Structure with Groups 
In the case where it is expected that the variance-covariance parameters are different across 
groups of a between-subjects factor, a different set of R or G parameters can be specified for each 
group. This produces a set of variance-covariance parameters that is different for each level of the 
chosen group variable, but each set has the same structure. 

Likelihood Formulas 
There are two types of likelihood estimation methods that are generally considered in mixed 
model estimation: maximum likelihood (ML) and restricted maximum likelihood (REML). 
REML is generally favored over ML because the variance estimates using REML are unbiased 
for small sample sizes, whereas ML estimates are unbiased only asymptotically (see Littell et al., 
2006 or Demidenko, 2004). Both estimation methods are available in PASS.  

Maximum Likelihood 
The general form -2 log-likelihood ML function is  

( ) ( )π2lnln,2 1
TML N,L +′+=− − eVeVRGβ  

The equivalent individual subject form is  
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( ) ( ) ( )π2lnln,2
1

1
T

i
iiiiML NeVeVRGβ ∑

=

− +′+=−
N

,L  

where NT  is the total number of observations, or 

∑
=

=
N

i
iT nN

1

 

Restricted Maximum Likelihood 
The general form -2 log-likelihood REML function is  

( ) ( ) ( )π2lnlnln,2 11 pN,L TREML −+′+′+=− −− XVXeVeVRGβ  

The equivalent individual subject form is  

( ) [ ] ( ) ( π2lnlnln,2
1 1

11 pN,L T

N

i

N

i
iiiiiiiREML −+′+′+=− ∑ ∑

= =

−− XVXeVeVRGβ )  

where, again, NT  is the total number of observations, or 

∑
=

=
N

i
iT nN

1

 

and p is the number of columns in X or Xi. 

Estimating and Testing Fixed Effects Parameters 
The estimation phase in the analysis of a mixed model produces variance and covariance 
parameter estimates of the elements of G and R, giving R̂  and G , and hence, . The REML 
and ML solutions for β  are given by 

ˆ V̂
ˆ

( ) yVXXVXβ 111 ˆˆˆ −−− ′′=  

with estimated variance-covariance 

( ) ( ) 11ˆˆvarˆ −−′==Σ XVXβ  

See, for example, Brown and Prescott (2006), Muller and Stewart (2006), or Demidenko (2004) 
for more details of the estimating equations.  

Hypothesis tests and confidence intervals for β are formed using a linear combination matrix (or 
vector) L. Although you don’t have to specify L, it is important that you understand how its 
function. 

L Matrix Details 
L matrices specify linear combinations of β corresponding to means or hypothesis tests of 
interest. Essentially, the L matrix defines the mean or test. The number of columns in each L 
matrix is the same as the number of elements of β. For estimating a particular mean, the L matrix 
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consists of a single row. For hypothesis tests, the number of rows of L varies according to the 
test. Below are some examples of L matrices that arise in common analyses: 

L Matrix for Testing a Single Factor (Food with 4 levels) in a Single-Factor 
Model 
No. Effect Food L1 L2 L3 
1 Intercept     
2 Food HighIron 1.0000 1.0000 1.0000 
3 Food LowIron -1.0000   
4 Food None  -1.0000  
5 Food Salicyl   -1.0000 

L Matrix for a Single Mean (LowIron) of a Single Factor (4 levels) in a 
Single-Factor Model 
No. Effect Food L1 
1 Intercept  1.0000 
2 Food HighIron  
3 Food LowIron 1.0000 
4 Food None  
5 Food Salicyl  
 
L Matrix for Testing a Single Factor (Drug – 3 levels) in a Two-Factor Model 
with Interaction 
No. Effect Drug Time L1 L2 
1 Intercept     
2 Drug Kerlosin  1.0000 1.0000 
3 Drug Laposec  -1.0000  
4 Drug Placebo   -1.0000 
5 Time  0.5   
6 Time  1   
7 Time  1.5   
8 Time  2   
9 Time  2.5   
10 Time  3   
11 Drug*Time Kerlosin 0.5 0.1667 0.1667 
12 Drug*Time Kerlosin 1 0.1667 0.1667 
13 Drug*Time Kerlosin 1.5 0.1667 0.1667 
14 Drug*Time Kerlosin 2 0.1667 0.1667 
15 Drug*Time Kerlosin 2.5 0.1667 0.1667 
16 Drug*Time Kerlosin 3 0.1667 0.1667 
17 Drug*Time Laposec 0.5 -0.1667  
18 Drug*Time Laposec 1 -0.1667  
19 Drug*Time Laposec 1.5 -0.1667  
20 Drug*Time Laposec 2 -0.1667  
21 Drug*Time Laposec 2.5 -0.1667  
22 Drug*Time Laposec 3 -0.1667  
23 Drug*Time Placebo 0.5  -0.1667 
24 Drug*Time Placebo 1  -0.1667 
25 Drug*Time Placebo 1.5  -0.1667 
26 Drug*Time Placebo 2  -0.1667 
27 Drug*Time Placebo 2.5  -0.1667 
28 Drug*Time Placebo 3  -0.1667 
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Kenward and Roger Fixed Effects Hypothesis Tests 
Hypothesis tests have the general form 

H0: Lβ = 0 

where L is a linear contrast matrix of rank h corresponding to the desired comparisons to be made 
in the hypothesis test. Let d be the denominator degrees of freedom and q be the number of 
variance-covariance parameters, which is the dimension of W (defined below). 

The Kenward and Roger (1997) test statistic for testing H0 is currently the most recommended 
method of specifying the F-ratio and its degrees of freedom. The F-ratio is 

( ) βLL*LCLβF dh,
ˆˆ 1−′′′=
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Solution Algorithms 

Methods for Finding Likelihood Solutions (Newton-Raphson, 
Fisher Scoring, MIVQUE, and Differential Evolution)  
There are four techniques in the Mixed Models procedure for determining the maximum 
likelihood or restricted maximum likelihood solution (optimum): Newton-Raphson, Fisher 
Scoring, MIVQUE, and Differential Evolution. 

The general steps for the Newton-Raphson, Fisher Scoring, and Differential Evolution techniques 
are (let θ be the overall covariance parameter vector): 

1. Roughly estimate θ according to the specified structure for each. 

2. Evaluate the likelihood of the model given the data and the estimates of θ. 

3. Improve upon the estimates of θ using a search algorithm. (Improvement is defined as an 
increase in likelihood.) 

4. Iterate until maximum likelihood is reached, according to some convergence criterion. 

5. Use the final θ estimates to estimate β. 

Newton-Raphson and Fisher Scoring 
The differences in the techniques revolve around the initial estimates in Step 1, and the 
improvements in estimates made in Step 3. For the Newton-Raphson and Fisher Scoring 
techniques, Step 3 occurs as follows: 

3a.  With the estimated θ, compute the gradient vector g, and the Hessian matrix H. 
3b.  Compute d = -H-1g. 
3c.  Let λ = 1. 
3d.  Compute new estimates for θ, iteratively, using θi = θi-1+ λd. 
3e.  If θi is a valid set of covariance parameters and improves the likelihood, continue to 3f. 

Otherwise, reduce λ  by half and return to Step 3d. 
3f.  Check for convergence. If the convergence criteria (small change in -2log-likelihood) are 

met, stop. If the convergence criteria are not met, go back to Step 3a. 
 

The gradient vector g, and the Hessian matrix H, used for the Newton-Raphson and Fisher 
Scoring techniques for solving the REML equations are shown in the following table: 
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REML Gradient (g) and Hessian (H) 

Technique Gradient (g) Hessian (H) 
Newton-Raphson g1 + g2 + g3 H1 + H2 + H3 

Fisher Scoring g1 + g2 + g3 -H1 + H3 

 

The gradient vector g, and the Hessian matrix H, used for the Newton-Raphson and Fisher 
Scoring techniques for solving the ML equations are shown in the following table: 
 

ML Gradient (g) and Hessian (H) 

Technique Gradient (g) Hessian (H) 
Newton-Raphson g1 + g2 H1 + H2 

Fisher Scoring g1 + g2 -H1 

 

where g1, g2, g3, H1, H2, and H3 are defined as in Wolfinger, Tobias, and Sall (1994). 
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Second Derivatives 
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See Wolfinger, Tobias, and Sall (1994), page 1299, for details. 

MIVQUE  
The MIVQUE estimates of θ in REML estimation are found by solving 

231 )( gθHH −=+− . 

The MIVQUE estimates of θ in ML estimation are found by solving 

21 gθH −=− . 

See Wolfinger, Tobias, and Sall (1994), page 1306, for details. 

Differential Evolution  
The differential evolution techniques used in this procedure for the ML and REML optimization 
are described in Price, Storn, and Lampinen (2005). This algorithm is very slow, but it is also 
very robust. As it stands now, it is too slow to be used. However, as computers become faster, 
this algorithm will become more viable. 

Specifying the Minimum Detectable Difference 
The four main parameters of a power analysis are the sample size, the effect size, the significance 
level, and the power level. Other extraneous parameters, such as the variance, must also be 
specified. This section describes the specification of the effect size, or minimum detectable 
difference (MDD) as we choose to call it in this chapter.  

Power is defined as the probability of rejecting the null hypothesis of zero difference when the 
actual difference is a given amount. As the size of the actual difference increases, so does the 
power. The MDD (or minimum effect size) is the smallest difference among the population 
means that will be detected by an experiment at the specified settings of the other parameters.  

Typically, a longitudinal design includes a between-subjects factor, a within-subject factor, and 
their interaction. A MDD must be specified for each. As the number of factors grows, the number 
of interactions grows, and the number of MDD’s that must be specified also grows. It becomes 
crucial that you specify these values in a meaningful and accurate way.  

In the Repeated Measures module, PASS only requires the standard deviation of the group means. 
Unfortunately, this is a quantity that researchers have very little experience with. It seldom 
appears on any of the standard reports that are produced by commercial software. It is seldom 
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present in the written reports of analyses. A different method is used to specify the MDD in 
PASS.   

In this routine, the MDD is specified as the difference between the smallest and largest effects. 
For example, suppose that a factor has three levels with means 10, 15, 18. The detectable 
difference is 18 – 10 = 8. This is a simply quantity that is easy to interpret. 

The Effect Pattern for Factors 
When there are more than two means, the minimum detectable difference does not uniquely 
define a set of means that can be simulated. For example the following sets of means all have 
identical MDD’s, but the means themselves are quite different: (10, 12, 18), (10, 14, 18), and (10, 
18, 18). The following method for defining the pattern is quite informative: 

1. Set the first (low) value to -0.5. 

2. Set the last (high) value to 0.5. 

3. Set each value in between to (Mean – Min) / MDD – 0.5. 

Using these steps, the three sets of means may be reduced to MDD and a pattern as follows: 

Original MDD Pattern MDD x Pattern 
10, 12, 18 8 -0.5, -0.25, 0.5 -4, -2, 4 
10, 14, 18 8 -0.5, 0.0, 0.5 -4, 0, 4 
10, 18, 18 8 -0.5, 0.5, 0.5 -4, 4, 4 

Thus, each set of means can be easily reduced to two components: the MDD and a pattern. This is 
the method that PASS uses to supply the sets of means. Using this method, it is easy to compare 
various sizes of means. You simply enter different values for the MDD, keeping the pattern the 
same. 

The Effect Pattern for Interactions 
Specifying the structure of the interactions is a little more problematic. Often, you are not 
interested in the interaction. When the interaction is of interest, you may have only a vague idea 
of its structure. Part of your analysis will be to investigate the effect of the interaction, with little 
or no knowledge of its pattern beforehand.  

Specifying the MDD for the interaction is somewhat intuitive. The MDD defines the largest 
difference among the interaction effects. A difficulty still arises in that there is a very large 
number of possible patterns, many of which are useful. For planning purposes, we have decided 
to use a standard pattern in PASS. The interaction pattern used in PASS is defined as the 
Kronecker product of the factor patterns that make up the interaction, scaled so that the largest 
value is 0.5 and the smallest value is -0.5. 

Example 

Suppose that a two-factor interaction is made up of a three-level factor A with a pattern of -0.5, 0, 
0.5 and a two-level factor B with a pattern of -0.5, 0.5. The interaction pattern would be found as 
follows. The Kronecker product of these two patterns is 0.25, -0.25, 0.0, 0.0, -0.25, 0.25. 
Rescaling so that the minimum is -0.5 and the maximum is 0.5 is achieved by doubling the 
values. The final interaction pattern is 0.5, -0.5, 0.0, 0.0, -0.5, 0.5. This pattern compares the 
difference due to factor B across the levels of factor A. 
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Suppose the MDD for A is set to 8, the MDD for B is set to 15, and the MDD for AB is set to 10. 
Suppose the overall mean is 12. The six cell means would be found by adding the individual 
effects as follows 

Term A1B1 A1B2 A2B1 A2B2 A3B1 A3B2 
A -4.0 -4.0 0.0 0.0 4.0 4.0 
B -7.5 7.5 -7.5 7.5 -7.5 7.5 
AB 5.0 -5.0 0.0 0.0 -5.0 5.0 
Total -6.5 -1.5 -7.5 7.5 -8.5 16.5 
Overall 12.0 12.0 12.0 12.0 12.0 12.0 
Cell Mean 5.5 10.5 4.5 19.5 3.5 28.5 

The cell means are then used to simulate the data for power and sample size calculation. This set 
of cell means has the MDD’s and patterns specified. 

Specifying the Simulated Variance-Covariance Matrix 
As stated above, the variance of y is V = ZGZ' + R. In this PASS Mixed Models module, ZGZ' 
is called the random component and R is called the residual component. Since V is block-
diagonal (with one block for each subject), it is specified by specifying the random and residual 
components for one subject and repeating those components for each subject.  

ZGZ' 
When the random component is included, the model is called a random effects model. For a 
design with four time points, the structure of ZGZ' is  
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This structure only requires a single value: g.  

R 
The structure of R is quite flexible. Since it is a variance-covariance matrix, the only stipulation is 
that it must be non-negative definite. Possible choices for R when the variance is constant are 
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AR(1) List  
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Possible choices for R when the variance is allowed to vary are 

Diagonal Constant 
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ZGZ' + R 
When ZGZ' is included and R is set to diagonal as recommended, the value of V becomes 
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This is the compound symmetric pattern that is assumed in the repeated measures analysis of 
variance (RMANOVA). This model is often used to compare LMM with RMANOVA. 

Power Calculations using Computer Simulation 
Computer simulation allows us to estimate the power that is actually achieved by a test procedure in 
situations such as LMM that are not mathematically tractable. Computer simulation was once 
limited to mainframe computers. But, in recent years, as computer speeds have increased, 
simulation studies can be completed on desktop and laptop computers in a reasonable period of 
time. The simulations can still be time consuming, so we have proposed some steps below that will 
significantly shortened then time needed to obtain answers.  
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The Simulation 
It is important that you understand how the simulation is setup. There are three main tabs (panels or 
windows) that contain parameters that you will need to set. These are the Data tab, the Covariance 
tab, and the Fitted Model tab.  

Data Tab 
The Data tab contains all the parameters associated with the sample size, the effect size, and the 
significance level (alpha). The effect size parameters define the experimental design. 

Covariance Tab 
The Covariance tab specifies the parameters used to define the covariance of the data that is 
generated. Note that the covariance of the data you generate does not have to match the covariance 
model that you use to fit the data. In fact, since you seldom know even the structure of the true 
covariance matrix, it is more realistic to generate data using one type of covariance matrix and then 
fit the generated data with a different covariance structure.  

Fitted Model Tab 
The Fitted Model tab specifies the covariance matrix that is actually fit to your data. As stated 
above, the model does not need to coincide with the model used to generate the data. It may be 
more realistic if it does not. 

Steps in Conducting a Simulation Analysis 

Simulation Steps 
The steps to a simulation study are  

1. Specify the design that will be studied. Enter the sample size, MDD’s, and variance 
covariance matrix. Specify the covariance matrix of the model that is fitted to the data. 

2. Generate random samples from the design specified. Calculate the F-tests from the 
simulated data and determine if the null hypothesis is accepted or rejected. Tabulate the 
number of rejections and use this to calculate the test’s power.  

3. Repeat step 2 several hundred or more times, tabulating the number of times the simulated 
data leads to a rejection of the null hypothesis. The power is the proportion of simulated 
samples in step 2 that lead to rejection. 

4. Additionally, you can run a separate simulation to determine if the significance level 
(alpha) of the F-test matches the significance level you have selected. This is done by 
setting the MDD’s to zero. 
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Saving Simulation Time 
Simulations for large models or large sample sizes take several hours to run. The simulation time 
can be reduced by running the simulation in two steps. 

1. Specify a reasonable range for the group sample sizes. For example, you may want to try 
group sample sizes of 5, 10, 30, 80, and 120. Set the number of simulations to 300 or 500. 
Although these is not a large enough simulation size to give you definitive results, you can 
study the confidence intervals for power provided in the reports and plots to determine a 
reduced range of sample sizes. 

2. Reduce the range of the sample size values, increase the number of simulations to 1000 or 
2000, and rerun the simulations. These simulations may run for a while, so be prepared for 
running times of several minutes or hours. The power values that come from these 
simulations should be very precise. 

Generating the Random Numbers 
The simulation proceeds by generating the normal random deviates in groups that are the size of the 
number of time points. That is, a set of normals are generated for a single subject. This set of 
normals is transformed into a set of normals having the desired covariance structure using the 
commonly know technique of multiplying the generated unit normals by the square root of the 
variance-covariance matrix. The square root is taken using the Choleski decompositions. The 
resulting response vector matrix has the desired covariance matrix.  

Symbolically, suppose there are t time points and further suppose that the desired variance-
covariance matrix of the data to be simulated is given by V. Find a matrix W such that V = WW'. 
Note that, by construction, W is lower triangular. If we generate t unit random normal deviates 
and place them in a vector z, the vector y = Wz has variance-covariance matrix WW' = V. 
Finally, the appropriate cell mean (based on the minimum detectable differences) is added to the 
y to obtain the simulation data with the desired properties. Once all of the data required for a 
complete experiment is generated, the mixed model is solved using the mixed model algorithm 
coded for NCSS’s mixed model procedure. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the first 
three tabs. To find out more about using the Reports and Plot tabs go to the Procedure Window 
chapter. 

N and Effect Size Tab 
This tab contains most of the parameters and options necessary to define the sample size, 
significance level, effect size, and simulation size. 

Solve For 

Find (Solve For) 
This procedure always solves for the power, so there is no specific Solve For option. 
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Sample Size 

n (Subjects Per Group) 
Specify one or more values for the number of subjects per group. The total sample size is the sum 
of the individual group sizes across all groups. 

You can specify a list such as 2 4 6. The items in the list may be separated with commas or 
blanks. The interpretation of the list depends on the =n's check box. When the =n's box is 
checked, a separate analysis is calculated for each value of n. When the =n's box is not checked, 
PASS uses the n’s as the actual group sizes. In this case, the number of items entered must match 
the number of groups in the design, which is equal to the product of the number of levels of A 
and B. 

You can also enter the sample sizes in columns of the spreadsheet. The column contains the 
group sample sizes, one per row. Columns are indicated by adding an equals sign to the left of the 
first entry. For example, if you have entered a set of unequal group sample sizes in column 2, you 
would enter ‘=C2’ here. Multiple columns, such as columns 2 through 4, are specified as ‘=C2 C3 
C4’. 

= n’s 
This option controls whether or not the number of subjects per group is to be equal for all groups. 
When checked, the number of subjects per group is equal for all groups. A list of values such as 
‘5 10 15’ represents three designs: one with five per group, one with ten per group, and one with 
fifteen per group. A simulation is conducted for each value. 

When this option is not checked, the n’s are assumed to be unequal. A list of values represents the 
size of the individual groups. For example, ‘5 10 15’ represents a single, three-group design with 
five in the first group, ten in the second group, and fifteen in the third group. If four values are 
needed, but only two are entered, the last value is carried forward. 

Error Rates 

Alpha 
This option specifies the probability of a type-I error (alpha) for each factor and interaction. A 
type-I error occurs when you reject the null hypothesis of zero effects when in fact they are zero. 
Since they are probabilities, alpha values must be between zero and one. Routinely, the value of 
0.05 is used for alpha. This value may be interpreted as meaning that about one F-test in twenty 
will falsely reject the null hypothesis.  

Simulations 

Simulations 
This option specifies the number of iterations, M, used in each simulation. Larger numbers of 
iterations result in longer run times but more accurate results. 

The precision of the simulated power estimates can be determined by recognizing that they follow 
the binomial distribution. Thus, confidence intervals may be constructed for power estimates. The 
following table gives an estimate of the precision that is achieved for various simulation sizes 
when the power is either 0.50 or 0.95. The table values are interpreted as follows: a 95% 
confidence interval of the true power is given by the power reported by the simulation plus and 
minus the ‘Precision’ amount given in the table. 
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 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
  

Notice that a simulation size of 1000 gives a precision of plus or minus 0.014 when the true 
power is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a 
small amount of additional precision achieved.  

Because of the long run time needed to obtain an estimate of power, it is crucial that you set this 
parameter carefully. We suggest the following two-step procedure. 

Step 1 
Set the number of simulations to 200, 300, or 500 and run examples for a realistic range of 
sample sizes. Study the results (especially the confidence intervals) to determine a range of 
sample sizes you want to investigate more carefully. 

Step 2 
Reduce the range of N to just one or two values and set the number of simulations to a large 
amount. 

Step 3 (Optional) 
Take the rest of the day off—the simulation may take awhile! 

Effect Size  

Specify Effects Using 
Indicate which options are used to specify the Effect Size. The possible choices are Means in 
Spreadsheet Columns or the reset of the options on this panel. 

Means in Spreadsheet Columns 
Specify spreadsheet columns containing a hypothesized means matrix that represents the 
minimum detectable differences among the means. Under the null hypothesis, this matrix is all 
zeros.  

The between-subject factors (A & B) are represented across the columns of the spreadsheet and 
the within-subject factors (C & D) are represented down the rows. The number of columns 
specified must equal the number of groups, which is equal to the number of levels in A times the 
number of levels in B. The number of rows must equal the number of time points, which is equal 
to the number of levels in C multiplied by the number of levels in D.  
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For example, suppose you are designing an experiment that is to have two between factors (A & 
B) and two within factors (C & D). Suppose each of the four factors has two levels. The columns 
of the spreadsheet would represent 

A1B1 A1B2 A2B1 A2B2. 

The rows of the spreadsheet would represent 

C1D1 

C1D2 

C2D1 

C2D2 

Example 
To see how this option works, consider the following table of hypothesized means for an 
experiment with one between factor (A) having two groups and one within factor (C) having 
three time periods. The values in columns C1 and C2 of the spreadsheet are 

C1 C2 
2.0 4.0 
4.0 6.0 
6.0 11.0 

By subtracting the appropriate means, the following table of effects results 
C1 C2 | Means | Effects 

Row1 0.5 -0.5 | 3.0 | -2.5 
Row2 0.5 -0.5 | 5.0 | -0.5 
Row3 -1.0 1.0 | 8.5 |  3.0 

--- --- | --- 
Means 4.0 7.0 | 5.5 
Effects -1.5 1.5 

Effect Size – Factors Separating 
Subjects into Groups (Between) 
These options specify the effect sizes of the between-subjects factors (A and B). 

Levels 
Specify the number of levels (categories) in this factor. Typical values are from 2 to 8. Set this to 
a blank (or 0) to ignore the factor in the design. 

Effects Pattern 
This option specifies the pattern of the means for this factor. This pattern is multiplied by the 
Detectable Difference to form the factor means used in the simulation. For example, suppose that 
the pattern of a five-category factor is -.50 -.25 0.0 .25 0.5 and the detectable difference is 10. The 
resulting effects are -5.0 -2.5 0.0 2.5 5.0. The power reported by the simulation is the value to 
detect a difference of 10 (5 – (– 5)) when the pattern of means is a linear growth pattern. Note 
that the power depends on both the pattern and the detectable difference. 

Possible choices are displayed next using examples that assume that the factor has five categories. 

• List of Means 
Enter a list of means directly into the List of Means box to the right. 
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• Linear Up or Down 
Up: -.50 -.25 0.0 .25 0.5.   Down: .50 .25 0.0 -.25 -.50. 

• First Effect High or Low 
High: .5 -.5 -.5 -.5 -.5.   Low: -.5 .5 .5 .5 .5. 

• Last Effect High or Low 
High: -.5 -.5 -.5 -.5 .5.   Low: .5 .5 .5 .5 -.5. 

• First Half High or Low 
High: .5 .5 .5 -.5 -.5.   Low: -.5 -.5 -.5 .5 .5. 

• Zig Zag High or Low 
High: .5 -.5 .5 -.5 .5.   Low: -.5 .5 -.5 .5 -.5. 

• Interaction Effect Patterns 
The effect patterns of interactions are formed as the Kronecker product of the individual 
factor patterns. 

Detectable Difference 
This is the difference between the largest and smallest effects associated with this factor or 
interaction. This represents the minimum detectable difference between any two levels (or factor-
level combinations). The actual means used in the simulation are found by multiplying the Effects 
Pattern by this value. 

Each value specified here results in a separate simulation. Note that, because of report and plot 
labeling, it is best if you only put multiple values in one of these boxes at a time. Otherwise, the 
plots will be labeled using the less-informative term ‘Combination’. 

Example 
Suppose that you selected Linear Up as the Effects Pattern of a five-level factor and set the 
detectable difference to 8. Further suppose that the Baseline Mean (below) is set to 20. The 
resulting means for this factor would be: 16 18 20 22 24.  

Note that the maximum difference between any two of these means is 8. 

List of Means 
You can specify a list of means directly instead of specifying the pattern and detectable 
difference. When you do so, the effects pattern and detectable difference are calculated from the 
means you specify. 

When you specify too many values for the number of levels in the factor, the extra values are 
ignored. When you specify too few values, the last value you specify is copied forward. 

Using Columns in the Spreadsheet 
You can specify the list of means in columns of the spreadsheet. When you do this, you enter the 
column(s) name(s) here using the equal sign.  

For example, if you stored two sets of means, one in C5 and the other in C6, you would enter 
‘=C5 C6’ here (or you could select the columns by pressing the button to the right). Once you 
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have entered values into a spreadsheet, it is up to you to load that spreadsheet each time you run 
the simulation. 

Note that a separate simulation is run for each column you specify. 

Effect Size – Factors with Multiple 
Levels Within a Subject (Within) 
These options specify the effect sizes of the within-subject factors (C and D). 

Levels 
Specify the number of levels (categories) in this factor. Typical values are from 2 to 8. Set this to 
a blank (or 0) to ignore the factor in the design.  

Note that the number of time points is calculated as the product of the number of levels factors C 
and D. 

The rest of these options behave as described in the Between-Subject section above. 

Possible choices are displayed next using examples that assume that the factor has five categories. 

Effect Size – Interactions 
These options specify the effect sizes of any interactions that are specified. 

Interaction Check Box 
Check this box to include the corresponding interaction in the model. In most situations, you 
should include all appropriate interactions since these have an impact on the degrees of freedom 
of the F-tests. You can set their Detectable Difference near zero if you want to ignore them. 

Occasionally, you will want to limit the number of interactions that you include in the model. 

Note that the model is forced to be hierarchical. This means that if you include the three-way 
interaction ABC in the model, you must also include A, B, C, AB, AC, and BC. 

Detectable Difference 
This is the difference between the largest and smallest effects associated with this term. This 
represents the minimum detectable difference between any two factor-level combinations. The 
actual means used in the simulation are found by multiplying the effects pattern by this value. 
The effect pattern is created by forming the Kronecker product of the effect patterns of each 
factor in the interaction. The result is standardized so that the maximum difference in the pattern 
is 1.0. Each item in the pattern is multiplied by the Detectable Difference. The cell means are 
found by adding the appropriate effects for the main effects, interaction effects, and baseline 
mean.  

Each value specified here results in a separate simulation. Note that, because of report and plot 
labeling, it is best if you only put multiple values in one of these boxes at a time. Otherwise, the 
plots will be labeled using the less-informative term ‘Combination’. 
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Covariance Tab 
This tab specifies V(Y) = ZGZ’ + R which is used to form the simulated data. Note that the 
covariance matrix specified here does not have to match the covariance of the fitted model. This 
allows you to study the robustness of the fitted model to errors in the covariance specification. 

There are two matrices that can be specified: the random effects (G) and the residual structure R.  

Group Option 

Grouping Factor 
Specify a grouping factor--either Factor A or B. This causes a unique covariance matrix to be 
generated for each level of the selected factor. 

• None 
No group extension of the covariance matrix is done. Grouping is ignored in the formation of 
G and R. 

• A (or B) 
The structures of G and R are extended to include separate matrices for each level of factor A 
(or B). The number of groups is equal to the number of levels of A (or B). Individual values 
for each group are entered for g, σ² for R, and ρ. These individual group values can be entered 
as a list in the box or in a column of the spreadsheet. 

G (Covariance of Random Effects) 

Include G 
Specify whether to include G (the variance of the random effects term u) in the covariance model.  

• Not Checked 
Do not include G in the model, that is, all elements of G are zero. Hence, V(Y) is specified 
using only R. 

• Checked 
Include the diagonal matrix G, and hence ZGZ’, in the model. The diagonal elements of G are 
all set to g. 

Variances (Diagonal Elements of G) 

g (Subject σ²) 
This is used to generate the diagonal elements of G (all off-diagonal elements are zero). It is the 
variance of a subject (random effect). Since the value is a variance, it must be positive. It is 
usually obtained from a previous run of similar data through a mixed model.  

When a Grouping Factor (A or B) is used, a separate value must be entered for each level of the 
group factor. This can be done by entering a list or by entering the values in a column of the 
spreadsheet and specifying that column here using the “=C1” type syntax. 

For example, if there were 4 categories in factor A and factor A was selected as the Grouping 
Factor, you might enter “2  3  4  5” in this box or you could enter “=C2” here and make a similar 
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entry in column C2 of the spreadsheet. Assuming that there are 3 time points, the G matrix would 
be 

2 0 0 

0 2 0 

0 0 2 

3 0 0 

0 3 0 

0 0 3 

4 0 0 

0 4 0 

0 0 4 

5 0 0 

0 5 0 

0 0 5 

 

R (Covariance of Residuals) 

Specify R Using 
Specify how you want to specify R. Three choices are available: 

• Variances Only 
This option indicates that R includes only diagonal elements (no autocorrelations).  

• Variances and Autocorrelations 
This option indicates that R includes both diagonal (variance) and off-diagonal 
(autocorrelation) parameters.  

• R in Spreadsheet 
R is to be read in from the spreadsheet. 

Times 
This option specifies the time points at which measurements of the subjects are made. Often, 
measurements are made at equi-distant points through time. But this is not always the case. The 
number of time points is the product of the number of levels of all within factors. The time metric 
influences the values of the variances as well as the correlations between two measurements on 
the same individual. 

The autocorrelations are based on the formula: Corr(Yi,Yj) =  ρ ^ (|ti-tj|), where ρ is the base 
autocorrelation and ti and tj are two points in the time metric list. This formula allows you to 
easily specify many different types of autocorrelation structures. 

The syntax for entering the time metric is given next: 
 



Random Effects Mixed Models  571-27 

• STEP START INC 
Measurements are made at time intervals of length INC, beginning at START. For example, 
"STEP 0 2" would generate the time series: 0, 2, 4, 6, etc. 

• RANGE MIN MAX 
A set of equal-spaced time points is generated from the MIN value to the MAX value. This 
setting is very useful when you want to investigate the impact of increasing/decreasing the 
number of measurements per subject during the same period of time. For example, you might 
want to determine if the study will last five weeks, will the power of the statistical tests 
increase if you take 10 measurements rather than 5? 

• LIST 
You may enter a list of values separated by blanks or commas. For example, you could enter 
0 0.143 1 2 3 if times were 0 weeks, 1/7 week (day 1), 1 week, 2 weeks, 3 weeks. 

Variances (Diagonal Elements of R) 

Pattern 
This option specifies how the diagonal (variance) elements of R are specified. Possible choices 
are 

• Constant in σ² for R 
All variances are set to the value of σ² for R. 

When a Grouping Factor is used, a list of group variances can be entered in the box or read 
in from the spreadsheet using the “=C1” syntax to designate which column. In this case, each 
row of the spreadsheet provides the variance for the corresponding group. 

• Set of σ² for R values proportional to Times 
The values of σ² to R range from the first value below to the second value. The values 
between these two endpoints are constructed so that they have the same relative magnitude as 
the Times entry. 

For example, suppose there are four levels of factor C (the within factor) and the Times 
values are 1, 2, 9, 10. Further suppose that the two values of σ² for R are 10 and 100. The 
diagonal elements of R will be 10, 20, 90, and 100. 

When a Grouping Factor is used, lists of the first and last values of σ² for R can be entered in 
the box or read in from the spreadsheet using the same syntax described above. For example, 
suppose there are 4 levels in factor C and two in factor A. If the Grouping Factor is set to A, 
the entries in the first box σ² for R is “4  5 ” and the second is “7 8,” the resulting value of R 
would be 

4  0  0  0 
0  5  0  0 
0  0  6  0 
0  0  0  7 
5  0  0  0 
0  6  0  0 
0  0  7  0 
0  0  0  8 



571-28  Random Effects Mixed Models 

 

• σ² List 
A list of variances, one per time point, is specified. The list can be entered in the box or 
specified as rows of the spreadsheet using the equals sign, e.g. “=C3.” 

σ² for R (first) 
The (first) value of σ² for R is specified here. 

When a Grouping Factor is used, a list of variances can be entered in the box or read in from the 
spreadsheet. The column containing the group variance entries is specified with an equals sign, 
e.g. “=C1”. When this option is used, each row of the spreadsheet provides σ² for R for the 
corresponding group. 

σ² for R (last) 
This is the final value in the specification of the set of variances. It is used to specify the final 
diagonal element in the linear sequence. The intermediate values of σ² for R are calculated so that 
their order and magnitude are proportional to the Time values.  

When a Grouping Factor is used, a list of variances can be read in from the spreadsheet. A 
column containing the group variances is specified with an equals sign, e.g. “=C2.” When this 
option is used, each row of the spreadsheet provides the final diagonal element of the 
corresponding group. An example is given in the discussion of Pattern above. 

σ² List 
A list of σ² values, one per time point, is specified here. The number of items in the list must 
match max(1,levels of C) x max(1,levels of D). 

The list can also be specified as a column of the spreadsheet using the equals sign, e.g. “=C3.” 

Autocorrelations (Off-Diagonal 
Elements of R) 

Pattern 
This option specifies the pattern of the autocorrelations R. The three options are 

• Constant in ρ 
All autocorrelations are the same and equal to the value of ρ. 

• 1st Order: ρ, ρ², ρ³, ... 
The value of ρ is used to generate a first order autocorrelation series. This pattern reduces the 
magnitude of the autocorrelation at each successive step by multiplying the value at the 
previous step by ρ. Thus the pattern is ρ, ρ², ρ³, etc. 

Note that the exponent in this series is equal to the difference between the corresponding time 
points. For example, if the time points are 1, 3, 9, 10 the successive exponents of ρ are 2, 6, 
and 1. 

• ρ List 
A list of ρ values, separated by blanks or commas, is used to specify the autocorrelation 
pattern across the time points within a subject. 
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ρ (Autocorrelation) 
This is the value of ρ between two measurements made on a subject at two time points that differ 
by one time unit. A value near 0 indicates low correlation. A value near 1 indicates high 
correlation. Its use depends on the selection in the Pattern option. 

The possible values range from -1 to 1. However, in this situation, a positive value is usually 
assumed, so the more realistic range is 0 to 1. 

If Time > 
This is the maximum time difference between two measurement points before the autocorrelation 
is set to the value in the box to the left.  

For example, you might wish to specify a constant ρ of 0.4 for the first two time periods, and 
then, for any two measures that are greater than two time values apart, switch ρ to zero.  If you 
have specified a Constant autocorrelation pattern, and set this value to ‘2’, the resulting 
autocorrelation pattern of R would be 
1.0  0.4  0.4  0.0  0.0 

0.4  1.0  0.4  0.4  0.0 

0.4  0.4  1.0  0.4  0.4 

0.0  0.4  0.4  1.0  0.4 

0.0  0.0  0.4  0.4  1.0 

When you want to ignore this value, set it to a large number such as 100. 

Then ρ = 
This is the second ρ value. It is used when the time difference between two measurement points is 
larger than the value to the left.  

ρ List 
This is a list of autocorrelations, one for each time point. The number of autocorrelations must 
match the number of time values which is equal to the product of the number of levels for factors 
C and D.   

Since this is a type of correlation, possible values range from -1 to 1. However, positive values 
are usually assumed, so the realistic range is 0 to 1. A value near 0 indicates low correlation. A 
value near 1 indicates high correlation. 

You can alternatively enter the list of autocorrelations in a column of the spreadsheet and specify 
that column here. When the program finds an equals sign in this box, it reads in the values of the 
designated column. Blanks are converted to zeros. For example, if you have entered the 
autocorrelation list in column one, you would enter “=C1” here. 

If there are not enough values entered, the last value is copied forward. 

R in Spreadsheet 

Columns 
This option designates which columns on the spreadsheet hold R. The number of columns and 
number of rows with entries must match the number of time periods at which the subjects are 
measured. The matrix must be positive definite. 

Press the button at the right to select the columns from the spreadsheet. 
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Fitted Model Tab 
This tab controls the variance-covariance model that is actual fit during the solution of each 
simulation sample.  

G (Random Effects Component ) 

G (Random Effects Component) 
Specify whether to include G (the random effects component in) the fitted model. Possible 
choices are 

• None 
Do not include G in the fitted model. 

• G (Random Effects for Subjects) 
Include G in the fitted model. In this case, the R should be set to Diagonal (which does not 
include autocorrelations). 

Groups 
Specify a grouping factor: either factor A or B.  

When selected, a set of variance and autocorrelation parameters are fit for each level of this 
factor. 

R (Residual Component) 

Pattern 
Specify the type of R matrix (Residual Component Pattern) to be generated. The default type is 
the Diagonal matrix. When terms are specified in the Random Model, this option should be set to 
Diagonal. A brief summary of the various structures follows.  

ρ = Autocorrelation 

ρ i = ith autocorrelation 

ρ ij = autocorrelation between ith and jth time points 

σi²  = σ² for ith time point 

• Diagonal 
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• Compound Symmetry 
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• AR(1) 
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• Toeplitz(i) 
e.g. Toeplitz(3) =  
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• Banded(i) 
e.g. Banded(2) =  

⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

22

222

222

22

00
0

0
00

σρσ
ρσσρσ

ρσσρσ
ρσσ

 

• Unstructured 
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• Heterogeneous covariance structures allow for nonconstant values for 2σ . 
e.g. Diagonal - Heterogeneous = 
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Force Positive Covariances 
When checked, this option forces all values in the R and G matrices to be non-negative. When 
this option is not checked, covariances can be negative. 

Usually, negative covariances are okay and should be allowed. However, some Residual 
Component patterns such as ‘Compound Symmetry’ assume that covariances (autocorrelations) 
are positive. 

Solution Options 

Likelihood Type 
Specify the type of likelihood equation to be solved. The options are: 

• MLE 
The Maximum Likelihood solution has become less popular. 

• REML (recommended) 
The Restricted Maximum Likelihood solution is recommended. It is the default in other 
software programs (such as SAS). 

Solution Method 
Specify the method to be used to solve the likelihood equations. The options are: 

• Newton-Raphson 
This is an implementation of the popular 'gradient search' procedure for maximizing the 
likelihood equations. Whenever possible, we recommend that you use this method.  

• Fisher-Scoring 
This is an intermediate step in the Newton-Raphson procedure. However, when the Newton-
Raphson fails to converge, you may want to stop with this procedure. 

• MIVQUE 
This non-iterative method is used to provide starting values for the Newton-Raphson method. 
For large problems, you may want to investigate the model using this method since it is much 
faster. 

• Differential Evolution 
This grid search technique will often find a solution when the other methods fail to converge. 
However, it is painfully slow--often requiring hours to converge--and so should only be used 
as a last resort. 
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Solution Options – Newton-Raphson / 
Fisher Scoring Options 

Fisher Scoring Iter’s 
This is the maximum number of Fisher Scoring iterations that occur in the maximum likelihood 
finding process. When Solution Method is set to Newton-Raphson, up to this number of Fisher 
Scoring iterations occur before beginning Newton-Raphson iterations. We recommend setting 
this to ‘1’. 

Newton-Raphson Iter’s 
This is the maximum number of Newton-Raphson iterations that occur in the maximum 
likelihood finding process. When Solution Method is set to Newton-Raphson, Fisher-scoring 
iterations occur before beginning Newton-Raphson iterations. We recommend setting this to ‘5’. 

Lambda 
Each parameter’s change is multiplied by this value at each iteration. Usually, this value can be 
set to one. However, it may be necessary to set this value to 0.5 to implement step-halving: a 
process that is necessary when the Newton-Raphson diverges.  

Note: this parameter only used by the Fisher-Scoring and Newton-Raphson methods. 

Convergence Criterion 
This procedure uses relative Hessian convergence (or the Relative Offset Orthogonality 
Convergence Criterion) as described by Bates and Watts (1981). 

Recommended: The default value, 1E-8, will be adequate for many problems. When the routine 
fails to converge, try increasing the value to 1E-6. 

Zero (Rounding) 
This cutoff value is used by the least-squares algorithm to lessen the influence of rounding error. 
Values lower than this are reset to zero. If unexpected results are obtained, try using a smaller 
value, such as 1E-32. Note that 1E-5 is an abbreviation for the number 0.00001. 

Recommended: 1E-10 or 1E-12. 

Range: 1E-3 to 1E-40. 

Variance Zero 
When an estimated variance component (diagonal element) is less than this value, the variance is 
assumed to be zero and all reporting is terminated since the algorithm has not converged properly. 

To correct this problem, remove the corresponding term from the Random Factors Model or 
simplify the Repeated Variance Pattern. Since the parameter is zero, why would you want to keep 
it? 

Recommended: 1E-6 or 1E-8. 

Range: 1E-3 to 1E-40. 

Correlation Zero 
When an estimated correlation (off-diagonal element) is less than this value, the correlation is 
assumed to be zero and all reporting is terminated since the algorithm has not converged properly. 
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To correct this problem, remove the corresponding term from the Random Factors Model or 
simplify the Repeated Variance Pattern. Since the parameter is zero, why would you want to keep 
it? 

Recommended: 1E-6 or 1E-8. 

Range: 1E-3 to 1E-40. 

Max Retries 
Specify the maximum number of retries to occur. During the maximum likelihood search process, 
the search may lead to an impossible combination of variance-covariance parameters (as defined 
by a matrix of variance-covariance parameters that is not positive definite). When such a 
combination arises, the search algorithm will begin again. Max Retries is the maximum number 
of times the process will re-start to avoid such combinations. 

We recommend setting this to ‘1’. 

Solution Options – Differential 
Evolution Options 

Crossover Rate 
This value controls the amount of movement of the differential evolution algorithm toward the 
current best. Larger values accelerate movement toward the current best, but reduce the chance of 
locating the global maximum. Smaller values improve the chances of finding the global, rather 
than a local, solution, but increase the number of iterations until convergence. 

RANGE: Usually, a value between .5 and 1.0 is used.  

RECOMMENDED: 0.9. 

Mutation Rate 
This value sets the mutation rate of the search algorithm. This is the probability that a parameter 
is set to a random value within the parameter space. It keeps the algorithm from stalling on a local 
maximum.   

RANGE: Values between 0 and 1 are allowed.  

RECOMMENDED: 0.9 for random coefficients (complex) models or 0.5 for random effects 
(simple) models. 

Max Iter’s 
Specify the maximum number of differential evolution iterations used by the differential 
evolution algorithm. A value between 100 and 200 is usually adequate.  For large datasets, i.e., 
number of rows greater than 1000, you may want to reduce this number. 

Min Relative Change 
This parameter controls the convergence of the likelihood maximizer. When the relative change 
in the likelihoods from one generation to the next is less than this amount, the algorithm 
concludes that it has converged. The relative change is |L(g+1) - L(g)| / L(g) where L(g) is 
absolute value of the likelihood at generation 'g'. Note that the algorithm also terminates if the 
Maximum Generations are reached or if the number of individuals that are replaced in a 
generation is zero. The value 0.00000000001 (ten zeros) seems to work well in practice. Set this 
value to zero to ignore this convergence criterion. 
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Solutions/Iter’n 
This is the number of trial points (solution sets) that are used by the differential evolution 
algorithm during each iteration. In the terminology of differential evolution, this is the population 
size.  

RECOMMENDED: A value between 15 and 25 is recommended. More points may dramatically 
increase the running time. Fewer points may not allow the algorithm to converge. 
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Example 1 – Power of a Two Factor Repeated Measures 
Design 
Researchers are planning a study of the impact of a drug on heart rate. They want to evaluate the 
differences in heart rate among two age groups: 20-55 and over 55. Their experimental protocol 
calls for a baseline heart rate measurement, followed by administration of a certain level of the 
drug, followed by an additional measurement 30 minutes later. They want to be able to detect a 
10% difference in heart rate among the age groups. They want to detect 5% difference in heart 
rate within an individual across time. They decide the experiment should detect interaction effects 
of the same magnitude as the within-subject factor. From a heart rate of 93, a 10% reduction 
gives 84, a difference of 9. Similarly, a 5% reduction within a subject would result in a heart rate 
of 88, a difference of 5.  

They plan to analyze the data using a random effects model, setting the significance level at 0.05. 
Similar studies have found an average heart rate of 93, a subject variance of 11, and a residual 
variance of 11.  

They want to look at the power for group sizes of 3, 5, 7, and 9. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Mixed Models procedure window by clicking on Means, then 
Mixed Models, then Mixed Models. You may then follow along here by making the appropriate 
entries as listed below or load the completed template Example1 from the Template tab on the 
procedure window. 

Option Value 
Data – Effect Size Tab 

Sample Size 
n (Subjects Per Group) ........................... 3 5 7 9 
=n’s .......................................................... checked  
Alpha ....................................................... 0.05 
Simulations .............................................. 100 

Effect Size 
Specify Effects Using .............................. Effects Patterns, etc. 

Factors Separating Subjects into Groups (Between) 
Levels (A) ................................................ 2 
Effects Pattern (A) ................................... Linear Up 
Detectable Difference (A) ........................ 9 

Factors with Multiple Levels Within a Subject (Within) 
Levels (C) ................................................ 2 
Effects Pattern (C) ................................... Linear Up 
Detectable Difference (C) ........................ 5 

Interactions 
AC ........................................................... checked 
Baseline Mean ........................................ 93 
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Data - Covariance Tab 

G (Covariance of Random Effects) 
Include G ................................................. Checked 
g (Subject σ²) .......................................... 11  

R (Covariance of Residuals) 
Specify R Using ....................................... Variances Only 
Times....................................................... STEP 0 1 
Variance Pattern ..................................... Constant in σ² for R  
σ² for R .................................................... 11  

Data - Fitting Tab 

Fitted V(Y) Model 
G Estimation ............................................ G (Random Effects for Subjects) 
Groups .................................................... None 
R Estimation ............................................ Diagonal 
Groups .................................................... None 

Solution Options 
Likelihood Type ....................................... REML  
Solution Method ...................................... Newton-Raphson  

Reports Tab 
Simulation Alpha ..................................... 0.05 
 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Power Report for Each Design 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.4300 0.3314 0.5329 3 6 9.00 0.0500 100 Linear Up 
C (2) 0.4800 0.3790 0.5822 3 6 5.00 0.0500 100 Linear Up 
AC 0.4900 0.3886 0.5920 3 6 5.00 0.0500 100  
 
A (2) 0.8200 0.7305 0.8897 5 10 9.00 0.0500 100 Linear Up 
C (2) 0.7900 0.6971 0.8651 5 10 5.00 0.0500 100 Linear Up 
AC 0.9000 0.8238 0.9510 5 10 5.00 0.0500 100  
 
A (2) 0.9600 0.9007 0.9890 7 14 9.00 0.0500 100 Linear Up 
C (2) 0.8700 0.7880 0.9289 7 14 5.00 0.0500 100 Linear Up 
AC 0.9500 0.8872 0.9836 7 14 5.00 0.0500 100  
 
A (2) 0.9900 0.9455 0.9997 9 18 9.00 0.0500 100 Linear Up 
C (2) 1.0000 0.9638 1.0000 9 18 5.00 0.0500 100 Linear Up 
AC 0.9900 0.9455 0.9997 9 18 5.00 0.0500 100  
 
Simulation Time: 65.78 seconds. 

 

This report gives the simulated power for each term in the design for each value of N, one design 
at a time. It is useful when you want to compare the powers of the terms in the design at a specific 
sample size. 
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The definitions of each of the columns of the report are as follows. 

Model Term 
This column contains the identifying label of the term. The number of levels for a factor is given 
in parentheses. 

Power 
This is the simulated power for the term. 

Lower and Upper 95% C.L. of Power 
These are the lower and upper confidence limits of a 95% confidence interval for the simulated 
power. These are exact, distribution-free, confidence limits based on the binomial distribution. 

N(1) 
The value of the number of subjects per group. 

N 
The value of N is the total number of subjects in the study. 

Minimum Detectable Difference 
This is the value of the minimum detectable difference that was entered (or calculated) for this 
term. This is a measure of the magnitude of the effect size.  

Alpha 
Alpha is the significance level of the F-test for this term. 

Number of Simulation Samples 
This is the number of simulation samples for which the mixed model algorithm converged. 

Factor Pattern 
This is the type of factor pattern that was used with the detectable difference to form the group 
means. 

Term Reports 
 

Power by Term 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.4300 0.3314 0.5329 3 6 9.00 0.0500 100 Linear Up 
A (2) 0.8200 0.7305 0.8897 5 10 9.00 0.0500 100 Linear Up 
A (2) 0.9600 0.9007 0.9890 7 14 9.00 0.0500 100 Linear Up 
A (2) 0.9900 0.9455 0.9997 9 18 9.00 0.0500 100 Linear Up 
 
C (2) 0.4800 0.3790 0.5822 3 6 5.00 0.0500 100 Linear Up 
C (2) 0.7900 0.6971 0.8651 5 10 5.00 0.0500 100 Linear Up 
C (2) 0.8700 0.7880 0.9289 7 14 5.00 0.0500 100 Linear Up 
C (2) 1.0000 0.9638 1.0000 9 18 5.00 0.0500 100 Linear Up 
 
AC 0.4900 0.3886 0.5920 3 6 5.00 0.0500 100  
AC 0.9000 0.8238 0.9510 5 10 5.00 0.0500 100  
AC 0.9500 0.8872 0.9836 7 14 5.00 0.0500 100  
AC 0.9900 0.9455 0.9997 9 18 5.00 0.0500 100  
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This report provides the same information as the previous Design report, so the item definitions 
are the same. It is sorted by term, to make comparison of powers across various sample sizes 
easier.  

Whole Design Power Plots 
 

 
 

This plot shows the power values on the vertical axis and the sample sizes across the horizontal 
axis. The plot symbols represent different model terms. 

Confidence Interval Power Plots 
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These plots show the confidence limits for the power for each term across the various sample 
sizes. Using these plots, you can quickly see for which sample sizes you might want to run a more 
precise (larger) simulation. 

Individual Term Power Plots 
 

           
 

Power vs N
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These plots show the power for each term across the various sample sizes without including the 
confidence limits.  

Detectable Differences for Each Term 
 

Combination    
No. A C AC 
1 9.00 5.00 5.00 

 

This report shows the values of the Minimum Detectable Differences for each term. It is 
particularly useful to identify each combination when you enter several different values for 
various terms, so that there are several combinations. 
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Effect Pattern Section 
 

---------- A ---------- ---------- C ---------- --------- AC ---------       
Levels Value Levels Value Levels Value       
 1 -0.50  1 -0.50 1,1 0.50       
 2 0.50  2 0.50 1,2 -0.50       
    2,1 -0.50       
    2,2 0.50  

 

This report shows the patterns of each of the active terms in the model. These values are 
multiplied by the corresponding minimum detectable differences to form the effects associated 
with each term 

Expanded Effect Pattern Section 
 

---------- A ---------- ---------- C ---------- --------- AC ---------       
Levels Value Levels Value Levels Value       
1,1 -0.50 1,1 -0.50 1,1 0.50       
1,2 -0.50 1,2 0.50 1,2 -0.50       
2,1 0.50 2,1 -0.50 2,1 -0.50       
2,2 0.50 2,2 0.50 2,2 0.50       

 

This report shows the effect patterns of each of the cells in the model. These values are multiplied 
by the corresponding minimum detectable difference and summed to form the cell means for each 
group in the design. 

Hypothesized Means Matrix for Detectable Differences Combination 1 
 

Factors A1 A2 
C1 88.50 92.50 
C2 88.50 102.50 

 

This report shows hypothesized means matrix for each combination of detectable differences. 
Note that the between factors are represented across the columns of the report and the within 
factors are represented down its rows. 

Variance-Covariance Matrix  
 

Factors C1 C2 
C1 22.00 11.00 
C2 11.00 22.00 

 

This report shows the variance-covariance matrix used to generate the data. You should check 
that they are correct. 

Variance and Autocorrelations 
 

Factors C1 C2 
C1 22.00 0.50 
C2 0.50 22.00 

 

This report shows the variances on the diagonal and the autocorrelations on the off-diagonal. You 
should check that they are correct. 
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Example 2 – Repeated Measures - Validation using 
Brown and Prescott 
Brown and Prescott (2006) pages 268-269 present the following example of determining a sample 
size for a repeated measures design that is analyzed using a linear mixed model. Note that this 
analytic procedure is provided in PASS as the procedure entitled Inequality Test for Two Means 
in a Repeated Measures Design. That procedure is sometimes called the time-averaged 
difference.  

In this example, a group size of 31 is found to achieve 80% power when the residual variance is 
76, the autocorrelation is 0.53, the minimum detectable difference of a single between-subject 
factor is 5, the number of repeated measurements is 4, and the significance level is 0.05. 

In this example, because of the long running time, the number of simulation samples will be set to 
100. You can increase this to 500 or 1000 to obtain greater precision. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Mixed Models procedure window by clicking on Means, then 
Mixed Models, then Mixed Models. You may then follow along here by making the appropriate 
entries as listed below or load the completed template Example2 from the Template tab on the 
procedure window. 

Option Value 
Data – Effect Size Tab 

Sample Size 
n (Subjects Per Group) ........................... 31 
=n’s .......................................................... checked  
Alpha ....................................................... 0.05 
Simulations .............................................. 100 

Effect Size 
Specify Effects Using .............................. Effects Patterns, etc. 

Factors Separating Subjects into Groups (Between) 
Levels (A) ................................................ 2 
Effects Pattern (A) ................................... Linear Up 
Detectable Difference (A) ........................ 5 

Factors with Multiple Levels Within a Subject (Within) 
Levels (C) ................................................ 4 
Effects Pattern (C) ................................... Linear Up 
Detectable Difference (C) ........................ 5 

Interactions 
AC ........................................................... Unchecked 
Baseline Mean ........................................ 93 

Data - Covariance Tab 

G (Covariance of Random Effects) 
Include G ................................................. Unchecked 
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R (Covariance of Residuals) 
Specify R Using ....................................... Variances and Autocorrelations 
Times....................................................... STEP 0 1 
Variance Pattern ..................................... Constant in σ² for R  
σ² for R .................................................... 76 
Autocorrelation Pattern ........................... Constant in ρ 
ρ .............................................................. 0.53 
If Time > .................................................. 100  
Then ρ = .................................................. 0  

Data - Fitting Tab 

Fitted V(Y) Model 
G Estimation ............................................ G (Random Effects for Subjects) 
Groups .................................................... None 
R Estimation ............................................ Diagonal 
Groups .................................................... None 

Solution Options 
Likelihood Type ....................................... REML  
Solution Method ...................................... Newton-Raphson  

Reports Tab 
Simulation Alpha ..................................... 0.05 

Output 
Click the Run button to perform the calculations and generate the following output. 

Power Report for Each Design 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.7900 0.6971 0.8651 31 62 5.00 0.0500 100 Linear Up 
C (4) 0.9800 0.9296 0.9976 31 62 5.00 0.0500 100 Linear Up 
 
Simulation Time: 2.18 minutes. 

 

Note that for just a 100 simulations, the power 0.79 has come out remarkably close to the actual 
value of 0.80 given by Brown and Prescott. The confidence interval, 0.70 to 0.87, is wide and 
could be run with a larger number of simulations to obtain a more precise answer. 
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Example 3 – Validation using Repeated Measures 
ANOVA 
For balanced designs, LMM and Repeated Measures ANOVA can be used to analyze the same 
data. Although they both produce F-tests, the values of the F-test are different for the two tests. It 
is instructive to compare the power of these competing procedures.  

In this example, we will determine the power for group sizes of 3, 9, and 15 when the random 
effects (subject) variance is 2, the residual variance is 2, the minimum detectable differences of 
all three terms is 1.0, the number of repeated measurements is 2, and the significance level is 
0.05. A random effects model will be fit. The number of simulation samples will be set to 500. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Mixed Models procedure window by clicking on Means, then 
Mixed Models, then Mixed Models. You may then follow along here by making the appropriate 
entries as listed below or load the completed template Example3 from the Template tab on the 
procedure window. 

Option Value 
Data – Effect Size Tab 

Sample Size 
n (Subjects Per Group) ........................... 3 9 15 
=n’s .......................................................... checked  
Alpha ....................................................... 0.05 
Simulations .............................................. 500 

Effect Size 
Specify Effects Using .............................. Effects Patterns, etc. 

Factors Separating Subjects into Groups (Between) 
Levels (A) ................................................ 2 
Effects Pattern (A) ................................... Linear Up 
Detectable Difference (A) ........................ 1 

Factors with Multiple Levels Within a Subject (Within) 
Levels (C) ................................................ 2 
Effects Pattern (C) ................................... Linear Up 
Detectable Difference (C) ........................ 1 

Interactions 
AC ........................................................... checked 
Detectable Difference (AC) ..................... 1 
Baseline Mean ........................................ 0 
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Data - Covariance Tab 

G (Covariance of Random Effects) 
Include G ................................................. Checked 
g (Subject σ²) .......................................... 2  

R (Covariance of Residuals) 
Specify R Using ....................................... Variances Only 
Times....................................................... STEP 0 1 
Variance Pattern ..................................... Constant in σ² for R  
σ² for R .................................................... 2  

Data - Fitting Tab 

Fitted V(Y) Model 
G Estimation ............................................ G (Random Effects for Subjects) 
Groups .................................................... None 
R Estimation ............................................ Diagonal 
Groups .................................................... None 

Solution Options 
Likelihood Type ....................................... REML  
Solution Method ...................................... Newton-Raphson  

Reports Tab 
Simulation Alpha ..................................... 0.05 
  

Output 
Click the Run button to perform the calculations and generate the following output. 

Power Report for Each Design 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.0500 0.0326 0.0729 3 6 1.00 0.0500 500 Linear Up 
C (2) 0.1440 0.1144 0.1779 3 6 1.00 0.0500 500 Linear Up 
AC 0.1640 0.1326 0.1994 3 6 1.00 0.0500 500  
 
A (2) 0.2220 0.1863 0.2610 9 18 1.00 0.0500 500 Linear Up 
C (2) 0.4860 0.4414 0.5308 9 18 1.00 0.0500 500 Linear Up 
AC 0.4920 0.4473 0.5368 9 18 1.00 0.0500 500  
 
A (2) 0.3440 0.3024 0.3875 15 30 1.00 0.0500 500 Linear Up 
C (2) 0.7540 0.7138 0.7912 15 30 1.00 0.0500 500 Linear Up 
AC 0.7320 0.6909 0.7704 15 30 1.00 0.0500 500  
 
Simulation Time: 5.54 minutes. 

 

Next, we will run this same design through the Repeated Measures ANOVA procedure. To make 
it comparable, set both the between and within factors (B and W) to have two levels each with 
Sm set to 0.5. The covariance is set with SD1 equal to 2 and R1 equal to 0.5. 

The results of this run are presented next. 
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Power Report for RMANOVA 
 

Power Using RMANOVA 
     Multiply SD of Standard 
     Means Effects Deviation Effect 
Term Test Power n N By (Sm) (Sigma) Size Alpha Beta 
B(2) F 0.0859 3 6 1.00 0.50 1.73 0.29 0.0500 0.9141 
W(2) F 0.1588 3 6 1.00 0.50 1.00 0.50 0.0500 0.8412 
BW F 0.1588 3 6 1.00 0.50 1.00 0.50 0.0500 0.8412 
 
B(2) F 0.2105 9 18 1.00 0.50 1.73 0.29 0.0500 0.7895 
W(2) F 0.5134 9 18 1.00 0.50 1.00 0.50 0.0500 0.4866 
BW F 0.5134 9 18 1.00 0.50 1.00 0.50 0.0500 0.4866 
 
B(2) F 0.3328 15 30 1.00 0.50 1.73 0.29 0.0500 0.6672 
W(2) F 0.7529 15 30 1.00 0.50 1.00 0.50 0.0500 0.2471 
BW F 0.7529 15 30 1.00 0.50 1.00 0.50 0.0500 0.2471 

 

The above results are summarized in the following table. 
Comparing LMM and RMANOVA Power 

  Lower Upper       
  95% 95%  
Model  C.L. of C.L. of RMANOVA 
Term Power Power Power Power N(1)  
A (2) 0.0500 0.0326 0.0729 0.0859 3  
C (2) 0.1440 0.1144 0.1779 0.1588 3  
AC 0.1640 0.1326 0.1994 0.1588 3   
 
A (2) 0.2220 0.1863 0.2610 0.2105 9  
C (2) 0.4860 0.4414 0.5308 0.5134 9  
AC 0.4920 0.4473 0.5368 0.5134 9   
 
A (2) 0.3440 0.3024 0.3875 0.3328 15  
C (2) 0.7540 0.7138 0.7912 0.7529 15 
AC 0.7320 0.6909 0.7704 0.7529 15 
  

By studying the values in this table, we see that two procedures agree very well for group sample 
sizes of 9 and 15. However, when the group sample size is 3, the power of RMANOVA is higher. 
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Example 4 – Repeated Measures with Heterogeneous 
Variances 
One of the features offered by LMM is the ability to specify unequal group variances. This 
example will look at how to do this.  

In this example, we will determine the power for group sizes of 6 when the random effects 
(subject) variance is 2 when A =1 and 4 with A=2, the residual variance is 2 when A=1 and 4 
when A = 2, the minimum detectable differences of all three terms is 1.0, the number of repeated 
measurements is 2, and the significance level is 0.05. A random effects model will be fit. The 
number of simulation samples will be set to 100. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Mixed Models procedure window by clicking on Means, then 
Mixed Models, then Mixed Models. You may then follow along here by making the appropriate 
entries as listed below or load the completed template Example4 from the Template tab on the 
procedure window. 

Option Value 
Data – Effect Size Tab 

Sample Size 
n (Subjects Per Group) ........................... 6 
=n’s .......................................................... checked  
Alpha ....................................................... 0.05 
Simulations .............................................. 100 

Effect Size 
Specify Effects Using .............................. Effects Patterns, etc. 

Factors Separating Subjects into Groups (Between) 
Levels (A) ................................................ 2 
Effects Pattern (A) ................................... Linear Up 
Detectable Difference (A) ........................ 1 

Factors with Multiple Levels Within a Subject (Within) 
Levels (C) ................................................ 2 
Effects Pattern (C) ................................... Linear Up 
Detectable Difference (C)........................ 1 

Interactions 
AC ........................................................... checked 
Detectable Difference (AC) ..................... 1 
Baseline Mean ........................................ 0 

Data - Covariance Tab 

Group Option 
Grouping Factor ...................................... A 
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G (Covariance of Random Effects) 
Include G ................................................. Checked 
g (Subject σ²) .......................................... 2 4 

R (Covariance of Residuals) 
Specify R Using ....................................... Variances Only 
Times ....................................................... STEP 0 1 
Variance Pattern ..................................... Constant in σ² for R  
σ² for R .................................................... 2 4  

Data - Fitting Tab 

Fitted V(Y) Model 
G Estimation ............................................ G (Random Effects for Subjects) 
Groups ..................................................... A 
R Estimation ............................................ Diagonal 
Groups ..................................................... A 

Solution Options 
Likelihood Type ....................................... REML  
Solution Method ...................................... Newton-Raphson  

Reports Tab 
Simulation Alpha ..................................... 0.05 
 

Output 
Click the Run button to perform the calculations and generate the following output. 

Power Report for Each Design 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.1500 0.0865 0.2353 6 12 1.00 0.0500 100 Linear Up 
C (2) 0.2200 0.1433 0.3139 6 12 1.00 0.0500 100 Linear Up 
AC 0.2800 0.1948 0.3787 6 12 1.00 0.0500 100 

 
Variance-Covariance Matrix 
Factors C1 C2 
A1C1 4.00 2.00 Note that now there are two variance-covariance matrices displayed. 
A1C2 2.00 4.00 
A2C1 8.00 4.00 
A2C2 4.00 8.00 
 
Variances and Autocorrelations 
Factors C1 C2 
A1C1 4.00 0.50 
A1C2 0.50 4.00 
A2C1 8.00 0.50 
A2C2 0.50 8.00 

  

Notice how easy it is to obtain a power analysis for the case of unequal variances. 
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Example 5 – T-Test with Heterogeneous Variances 
(Searching for n) 
This example will show how to determine the power of a design that is usually analyzed with a t-
test. However, in this example, the variances of the two groups are known to be very different.  

In this example, the variance of the first group is 4, the variance of the second group is 9, the 
minimum detectable difference is set to 1.0, the significance level is 0.05, and the number of 
simulation samples is 100. There are no repeated measurements. Since a sample size search 
capability is not available in this routine, we will conduct a manual search by calculating the 
power for group sample sizes of 10, 20, 30, 40, 50, 60, 70, 80, 90, and 100. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Mixed Models procedure window by clicking on Means, then 
Mixed Models, then Mixed Models. You may then follow along here by making the appropriate 
entries as listed below or load the completed template Example5 from the Template tab on the 
procedure window. 

Option Value 
Data – Effect Size Tab 

Sample Size 
n (Subjects Per Group) ........................... 10 20 30 40 50 60 70 80 90 100 
=n’s .......................................................... checked  
Alpha ....................................................... 0.05 
Simulations .............................................. 100 

Effect Size 
Specify Effects Using .............................. Effects Patterns, etc. 

Factors Separating Subjects into Groups (Between) 
Levels (A) ................................................ 2 
Effects Pattern (A) ................................... Linear Up 
Detectable Difference (A) ........................ 1 

Factors with Multiple Levels Within a Subject (Within) 
Levels (C) ................................................ 0 

Interactions 
Baseline Mean ........................................ 0 

Data - Covariance Tab 

Group Option 
Grouping Factor ...................................... A 

G (Covariance of Random Effects) 
Include G ................................................. Unchecked 
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R (Covariance of Residuals) 
Specify R Using ....................................... Variances Only 
Times ....................................................... STEP 0 1 
Variance Pattern ..................................... Constant in σ² for R  
σ² for R .................................................... 4  9  

Data - Fitting Tab 

Fitted V(Y) Model 
G Estimation ............................................ None 
R Estimation ............................................ Diagonal 
Groups ..................................................... A 

Solution Options 
Likelihood Type ....................................... REML  
Solution Method ...................................... Newton-Raphson  

Reports Tab 
Simulation Alpha ..................................... 0.05 
 

Output 
Click the Run button to perform the calculations and generate the following output. 

Power Report for 10, 20, 30, 40, 50, 60, 70, 80, 90, 100 – Simulations = 100 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.2200 0.1433 0.3139 10 20 1.00 0.0500 100 Linear Up 
A (2) 0.4000 0.3033 0.5028 20 40 1.00 0.0500 100 Linear Up 
A (2) 0.4500 0.3503 0.5527 30 60 1.00 0.0500 100 Linear Up 
A (2) 0.6200 0.5175 0.7152 40 80 1.00 0.0500 100 Linear Up 
A (2) 0.6500 0.5482 0.7427 50 100 1.00 0.0500 100 Linear Up 
A (2) 0.7500 0.6534 0.8312 60 120 1.00 0.0500 100 Linear Up 
A (2) 0.8600 0.7763 0.9213 70 140 1.00 0.0500 100 Linear Up 
A (2) 0.8500 0.7647 0.9135 80 160 1.00 0.0500 100 Linear Up 
A (2) 0.9000 0.8238 0.9510 90 180 1.00 0.0500 100 Linear Up 
A (2) 0.9800 0.9296 0.9976 100 200 1.00 0.0500 100 Linear Up 

  

If our goal is to achieve 90% power, it appears that we should investigate group sample sizes of 
70, 75, 80, 85, and 90 using a larger simulation size, say 500.  Putting these values in for n and 
running gives the following results. 
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Power Report for 70, 75, 80, 85, 90 – Simulations = 500 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.8680 0.8351 0.8964 70 140 1.00 0.0500 500 Linear Up 
A (2) 0.8640 0.8308 0.8928 75 150 1.00 0.0500 500 Linear Up 
A (2) 0.8840 0.8526 0.9107 80 160 1.00 0.0500 500 Linear Up 
A (2) 0.9040 0.8747 0.9284 85 170 1.00 0.0500 500 Linear Up 
A (2) 0.9240 0.8972 0.9457 90 180 1.00 0.0500 500 Linear Up 
 

It appears that a group sample size of 90 will give us a power of 90%. 

Power Report for 90  – Simulations = 2000 
 

Power by Design 
  Lower Upper       
  95% 95%   Minimum  Number of  
Model  C.L. of C.L. of   Detectable  Simulation Factor 
Term Power Power Power N(1) N Difference Alpha Samples Pattern 
A (2) 0.9185 0.9056 0.9301 90 180 1.00 0.0500 2000 Linear Up 
 
 

It appears that a group sample size of 90 will give us a power of 90%.  
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Chapter 575 

Multiple 
Comparisons 
Introduction 
This module computes sample sizes for multiple comparison procedures. The term “multiple 
comparison” refers to the individual comparison of two means selected from a larger set of 
means. The module emphasizes one-way analysis of variance designs that use one of three 
multiple-comparison methods: Tukey’s all pairs (MCA), comparisons with the best (MCB), or 
Dunnett’s all versus a control (MCC). Because these sample sizes may be substantially different 
from those required for the usual F test, a separate module is provided to compute them. 

There are only a few articles in the statistical literature on the computation of sample sizes for 
multiple comparison designs. This module is based almost entirely on the book by Hsu (1996). 
We can give only a brief outline of the subject here. Users who want more details are referred to 
Hsu’s book. 

Although this module is capable of computing sample sizes for unbalanced designs, it emphasizes 
balanced designs. 

Technical Details 

The One-Way Analysis of Variance Design 
The summarized discussion that follows is based on the common, one-way analysis of variance 
design. Suppose the responses  in k groups each follow a normal distribution with respective 

means,

Yij

μ μ μ1 2, , ,L k , and unknown variance, . Let  denote the number of 
subjects in each group.  

σ 2 n n nk1 2, , ,L

The analysis of these responses is based on the sample means 

$μi i
j=1

n
ij

i

 Y  
Y
n

i

= = ∑  

and the pooled sample variance 
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The F test is the usual method for analyzing such a design, and tests whether all of the means are 
equal. However, a significant F test does not indicate which of the groups are different, only that 
at least one is different. The analyst is left with the problem of determining which group(s) is(are) 
different and by how much.  

The probability statement associated with the F test is simple, straightforward, and easy to 
interpret. However, when several simultaneous comparisons are made among the group means, 
the interpretation of individual probability statements becomes much more complex. This is 
called the problem of multiplicity. Multiplicity here refers to the fact that the probability of 
making at least one incorrect decision increases as the number of statistical tests increases. The 
method of multiple comparisons has been developed to account for such multiplicity. 

Power Calculations for Multiple Comparisons 
For technical reasons, the definition of power in the case of multiple comparisons is different 
from the usual definition. Following Hsu (1996) page 237, power is defined as follows.  

Using a 1− α  simultaneous confidence interval multiple comparison method, power is the 
probability that the confidence intervals cover the true parameter values and are sufficiently 
narrow. Power is still defined to be 1− β . Note that 1 1− < −β α . Here, narrow refers to the 
width of the confidence intervals. The definition says that the confidence intervals should be as 
narrow as possible while still including the true parameter values. This definition may be restated 
as the probability that the simultaneous confidence intervals are correct and useful. 

The parameter ω  represents the maximum width of any of the individual confidence intervals in 
the set of simultaneous confidence intervals. Thus, ω  is used to specify the narrowness of the 
confidence intervals. 

Multiple Comparisons with a Control (MCC) 
A common experimental design compares one or more treatment groups with a control group. 
The control group may receive a placebo, the standard treatment, or even an experimental 
treatment. The distinguishing feature is that the mean response of each of the other groups is to be 
compared with this control group.  

We arbitrarily assume that the last group (group k), is the control group. The k-1 parameters of 
primary interest are 

δ μ μ
δ μ μ

δ μ μ

δ μ

1 1

2 2

1 1 μ
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In this situation, Dunnett’s method provides simultaneous, one- or two-sided confidence intervals 
for all of these parameters.  

The one-sided confidence intervals, δ δ1, ,L k−1 , are specified as follows: 

Pr $ $ $ , ,, , , ,δ μ μ σα λ λi i k df
i k

q
n n

for i k
k

> − − + = −
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n
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and q, found by numerical integration, is the solution to 
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where  is the standard normal distribution function and ( )Φ z ( )γ z  is the density of $ /σ σ . 

The two-sided confidence intervals for δ δ1, ,L k−1  are specified as follows: 
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and |q|, found by numerical integration, is the solution to 
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where  is the standard normal distribution function and ( )Φ z ( )γ z  is the density of $ /σ σ . 

Interpretation of Dunnett’s Simultaneous Confidence Intervals 
There is a specific interpretation given for Dunnett’s method. It provides a set of confidence 
intervals calculated so that, if the normality and equal-variance assumptions are valid, the 
probability that all of the k-1 confidence intervals enclose the true values of δ δ1 1, ,L k−  is 1− α . 
The presentation below is for the two-sided case. The one-sided case is the same as for the MCB 
case.  
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Sample Size and Power – Balanced Case 
Using the modified definition of power, the two-sided case is outlined as follows. 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 

want to detect, the group sample size, n, the power, 1− β , the significance level, α , and the 
within-group standard deviation, σ . 

Sample Size and Power – Unbalanced Case 
Using the modified definition of power, the unbalanced case is outlined as follows. 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 

want to detect, the group sample sizes, , the power, 1n n nk1 2, , ,L − β , the significance level, 
α , and the within-group standard deviation, σ . 
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Multiple Comparisons with the Best (MCB) 
The method of multiple comparisons with the best (champion) is used in situations in which the 
best group (we will assume the best is the largest, but it could just as well be the smallest) is 
desired. Because of sampling variation, the group with the largest sample mean may not actually 
be the group with the largest population mean. The following methodology has been developed to 
analyze data in this situation.  

Perhaps the most obvious way to define the parameters in this situation is as follows 

max , , ,
, ,j k j i for i k

=
− =

1
1

L
Lμ μ  

Obviously, the group for which all of these values are positive will correspond to the group with 
the largest mean.  

Another way of looking at this, which has some advantages, is to use the parameters 

θ μ μi i i j j for i k= − =
≠

max , , ,1L  

since, if θi > 0 , group i is the best.  

Hsu (1996) recommends using constrained MCB inference in which the intervals are constrained 
to include zero. Hsu recommends this because inferences about which group is best are sharper. 
For example, a confidence interval for θi  whose lower limit is 0 indicates that group i is the best. 
Similarly, a confidence interval for θi  whose upper limit is 0 indicates that group i is not the best. 

Hsu (1996) shows that ( )100 1− α %  simultaneous confidence intervals for θi  are given by 
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where  is found using Dunnett’s one-sided procedure discussed above assuming that group i is 
the control group. 
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Sample Size and Power – Balanced Case  
Using the modified definition of power, the balanced case is outlined as follows 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 

want to detect, the group sample size, n, the power, 1− β , the significance level, α , and the 
within-group standard deviation, σ . 

Sample Size and Power – Unbalanced Case 
Using the modified definition of power, the unbalanced case is outlined as follows 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 

want to detect, the group sample sizes, , the power, 1n n nk1 2, , ,L − β , the significance level, 
α , and the within-group standard deviation, σ . 
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All-Pairwise Comparisons (MCA) 
In this case you are interested in all possible pairwise comparisons of the group means. There are 
k(k-1)/2 such comparisons. A popular method in this case is that developed by Tukey.  

Balanced Case  
The Tukey method provides simultaneous, two-sided confidence intervals. They are specified as 
follows 

Pr $ $ * $μ μ μ μ σi j i k q
n
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When all the sample sizes are equal, q* may be found by numerical integration as the solution to 
the equation 
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where  is the standard normal distribution function and ( )Φ z ( )γ z  is the density of $ /σ σ . Note 

that ′ =q q2 *  is the critical value of the Studentized range distribution. 

Sample Size and Power  
Using the modified definition of power, the balanced case is outlined as follows 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 
want to detect, the group sample size, n, the power, 1− β , the significance level, α , and the 
within-group standard deviation, σ . 
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Unbalanced Case 
The simultaneous, two-sided confidence intervals are specified as follows 
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Unfortunately, qe  cannot be calculated as a double integral as in previous cases. Instead, the 

Tukey-Kramer approximate solution is used. Their proposal is to use q *  in place of qe .  

Sample Size and Power  
Using the modified definition of power, the unbalanced case is outlined as follows 
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This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of ω μ μ= −i j  that you 

want to detect, the group sample sizes, , the power, 1n n nk1 2, , ,L − β , the significance level, 
α , and the within-group standard deviation, σ . 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for using the other parameters. Under most 
situations you will select either Power and Beta for a power analysis or n for sample size 
determination. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. In the 
case of multiple comparisons, power is the probability that the confidence intervals will cover the 
true parameter values and be sufficiently narrow to be useful. This is a modified definition of 
power; since beta equals 1-power, it is has a modified definition as well. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject 
the null hypothesis of equal means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 
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Sample Size / Groups – Sample Size 
Multiplier 

n (Sample Size Multiplier) 
This is the base, per-group sample size. One or more values separated by blanks or commas may 
be entered. A separate analysis is performed for each value listed here. 

The group samples sizes are determined by multiplying this number by each of the Group Sample 
Size Pattern numbers. If the Group Sample Size Pattern numbers are represented by m1, m2, m3, 
…, mk and this value is represented by n, the group sample sizes N1, N2, N3, ..., Nk are calculated 
as follows: 

N1=[n(m1)] 

N2=[n(m2)] 

N3=[n(m3)] 

etc. 

where the operator, [X] means the next integer after X, e.g. [3.1]=4. 

For example, suppose there are three groups and the Group Sample Size Pattern is set to 1,2,3. If 
n is 5, the resulting sample sizes will be 5, 10, and 15. If n is 50, the resulting group sample sizes 
will be 50, 100, and 150. If n is set to 2,4,6,8,10, five sets of group sample sizes will be generated 
and an analysis run for each. These sets are: 

2 4 6 
4 8 12 
6 12 18 
8 16 24 
10 20 30 

As a second example, suppose there are three groups and the Group Sample Size Pattern is 
0.2,0.3,0.5. When the fractional Pattern values sum to one, n can be interpreted as the total 
sample size of all groups and the Pattern values as the proportion of the total in each group.  

If n is 10, the three group sample sizes would be 2, 3, and 5. 

If n is 20, the three group sample sizes would be 4, 6, and 10. 

If n is 12, the three group sample sizes would be 

(0.2)12 = 2.4 which is rounded up to the next whole integer, 3. 

(0.3)12 = 3.6 which is rounded up to the next whole integer, 4. 

(0.5)12 = 6.  

Note that in this case, 3+4+6 does not equal n (which is 12). This can happen because of 
rounding. 

Sample Size / Groups – Groups 

k (Number of Groups) 
This is the number of group means being compared. It must be greater than or equal to three.  

You can enter a list of values, in which case a separate analysis will be calculated for each value. 
Commas or blanks may separate the numbers. A TO-BY list may also be used. 
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Note that the number of items used in the Hypothesized Means box and the Group Sample Size 
Pattern box is controlled by this number. 

Examples: 

3,4,5 

4 5 6 

3 to 11 by 2 

Group Sample Size Pattern 
A set of positive, numeric values (one for each group) is entered here. The sample size of group i 
is found by multiplying the ith number from this list times the value of n and rounding up to the 
next whole number. The number of values must match the number of groups, k. When too few 
numbers are entered, 1’s are added. When too many numbers are entered, the extras are ignored. 

Note that in the case of Dunnett’s test, the last group corresponds to the control group. Thus, if 
you want to study the implications of having a group with a different sample size for the control 
group, you should specify that sample size in the last position. 

• Equal 
If all sample sizes are to be equal, enter “Equal” here and the desired sample size in n. A set 
of k 1's will be used. This will result in N1 = N2 = N3 = n. That is, all sample sizes are equal 
to n.  

Effect Size 

Minimum Detectable Difference 
Specify one or more values of the minimum detectable difference. This is the smallest difference 
between any two group means that is to be detectable by the experiment. Note that this is a 
positive amount. This value is set by the researcher to represent the smallest difference between 
two means that will be of practical significance to other researchers. Note that in the case of 
Dunnett’s test, this is the maximum difference between each treatment and the control.  

Examples: 

3 

3 4 5 

10 to 20 by 2 

S (Standard Deviation of Subjects) 
This option refers to σ , the standard deviation within a group. It represents the variability from 
subject to subject that occurs when the subjects are treated identically. It is assumed to be the 
same for all groups. This value is approximated in an analysis of variance table by the square root 
of the mean square error. 

Since they are positive square roots, the numbers must be strictly greater than zero. You can press 
the SD button to obtain further help on estimating the standard deviation. 

Note that if you are using this procedure to test a factor (such as an interaction) from a more 
complex design, the value of standard deviation is estimated by the square root of the mean 
square of the term that is used as the denominator in the F test.  
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You can enter a list of values separated by blanks or commas, in which case a separate analysis 
will be calculated for each value. 

Examples of valid entries: 

1,4,7,10 

1 4 7 10 

1 to 10 by 3 

Test 

Type of Multiple Comparison 
Specify the type of multiple comparison test to be analyzed. The tests available are 

• All Pairs - Tukey Kramer 
All possible paired comparisons. 

• With Best - Hsu 
Constrained comparisons with the best. 

• With Control - Dunnett 
Two-sided versus a control group. 

Iterations/Precision Tab 
The Iterations/Precision tab contains parameters that control the progress and termination of the 
iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the criterion of interest is 
aborted. When the maximum number of iterations is reached without convergence, the criterion is 
left blank. 

Precision 

Search Precision 
Specify the precision to be used in the routines that search for the value of the minimum 
detectable difference. Note that the closer this value is to zero, the longer a search will take. 
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Example 1 – Calculating Power 
An experiment is being designed to compare the means of four groups using the Tukey-Kramer 
pairwise multiple comparison test with a significance level of 0.05. Previous studies indicate that 
the standard deviation is 5.3. The typical mean response level is 63.4. The researcher believes that 
a 25% increase in the mean will be of interest to others. Since 0.25(63.4) = 15.85, this is the 
number that will be used as the minimum detectable difference.   

To better understand the relationship between power and sample size, the researcher wants to 
compute the power for several group sample sizes between 2 and 14. The sample sizes will be 
equal across all groups.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons procedure window by expanding 
Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on Multiple 
Comparisons. You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 2 to 14 by 2 
k (Number of Groups) ............................. 4 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference .............. 15.85 
S (Standard Deviation of Subjects) ......... 5.3 
Type of Multiple Comparison .................. All Pairs - Tukey Kramer 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results Report 
 

Numeric Results for Multiple Comparison Test: Tukey-Kramer (Pairwise) 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.0113 2.00 4 8 0.0500 0.9887 15.85 5.30 2.9906 
0.0666 4.00 4 16 0.0500 0.9334 15.85 5.30 2.9906 
0.3171 6.00 4 24 0.0500 0.6829 15.85 5.30 2.9906 
0.7371 8.00 4 32 0.0500 0.2629 15.85 5.30 2.9906 
0.9301 10.00 4 40 0.0500 0.0699 15.85 5.30 2.9906 
0.9497 12.00 4 48 0.0500 0.0503 15.85 5.30 2.9906 
0.9500 14.00 4 56 0.0500 0.0500 15.85 5.30 2.9906 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
n is the average group sample size. 
k is the number of groups. 
Total N is the total sample size of all groups. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
The Minimum Detectable Difference between any two group means. 
S is the within group standard deviation. 
The Diff / S is the ratio of Min. Detect. Diff. to standard deviation. 
 
Summary Statements 
In a single factor ANOVA study, sample sizes of 2, 2, 2, and 2 are obtained from the 4 groups 
whose means are to be compared. The total sample of 8 subjects achieves 1% power to detect a 
difference of at least 15.85 using the Tukey-Kramer (Pairwise) multiple comparison test at a 
0.0500 significance level. The common standard deviation within a group is assumed to be 5.30. 
 

This report shows the numeric results of this power study. Following are the definitions of the 
columns of the report. 

Power 
This is the probability that the confidence intervals will cover the true parameter values and be 
sufficiently narrow to be useful. 

Average n 
The average of the group sample sizes. 

k 
The number of groups. 

Total N 
The total sample size of the study. 

Alpha 
The probability of rejecting a true null hypothesis. This is often called the significance level. 

Beta 
Equal to 1- power. Note the definition of power above. 

Minimum Detectable Difference 
This is the value of the minimum detectable difference. This is the minimum difference between 
two means that is thought to be of practical importance. Note that in the case of Dunnett’s test, 
this is the minimum difference between a treatment mean and the control mean that is of practical 
importance. 

Standard Deviation (S) 
This is the within-group standard deviation. It was set in the Data window. 

Diff / S 
This is an index of relative difference between the means standardized by dividing by the 
standard deviation. This value can be used to make comparisons among studies. 
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Detailed Results Report 
 

Tukey-Kramer Test Details   
  Percent   Minimum  
  n of   Detectable Standard 
Group n Total N Alpha Power Difference Deviation 
1 2 25.00 0.0500 0.0113 15.85 5.30 
2 2 25.00     
3 2 25.00     
4 2 25.00     
Total 8 100.00 
 

This report shows the details of each row of the previous report. 

Group 
The group identification number is shown on each line. The second to the last line represents the 
last group. When Dunnett’s test has been selected, this line represents the control group. 

The last line, labeled Total, gives the total for all the groups. 

n 
This is the sample size of each group. This column is especially useful when the sample sizes are 
unequal. 

Percent n of Total N 
This is the percentage of the total sample that is allocated to each group. 

Alpha 
The probability of rejecting a true null hypothesis. This is often called the significance level. 

Power 
This is the probability that the confidence intervals will cover the true parameter values and be 
sufficiently narrow to be useful. 

Minimum Detectable Difference 
This is the value of the minimum detectable difference. This is the minimum difference between 
two means that is thought to be of practical importance. Note that in the case of Dunnett’s test, 
this is the minimum difference between a treatment mean and the control mean that is of practical 
importance. 

Standard Deviation (S) 
This is the within-group standard deviation. It was set in the Data window. 
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Plots Section 
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This plot gives a visual presentation to the results in the Numeric Report. We can see the impact 
on the power of increasing the sample size. 

When you create one of these plots, it is important to use trial and error to find an appropriate 
range for the horizontal variable so that you have results with both low and high power. 

Example 2 – Power after Dunnett’s Test 
This example covers the situation in which you are calculating the power of Dunnett’s test on 
data that have already been collected and analyzed. 

An experiment included a control group and two treatment groups. Each group had seven 
individuals. A single response was measured for each individual and recorded in the following 
table. 
 

Control T1 T2 
554 774 786 
447 465 536 
356 759 653 
452 646 685 
674 547 658 
654 665 669 

 

When analyzed using the one-way analysis of variance procedure in NCSS, the following results 
were obtained.  
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 Analysis of Variance Table  
   
 Source  Sum of Mean  Prob 
 Term DF Squares Square F-Ratio Level  
 A ( ... ) 2 75629.8 37814.9 3.28 0.061 
 S(A) 18 207743.4 11541.3 
 Total (Adjusted) 20 283373.3 
 Total 21 
 

Dunnett's Simultaneous Confidence Intervals for Treatment vs. Control 
Response: Control,T1,T2 
Term A:  
Control Group: Control 
Alpha=0.050  Error Term=S(A)  DF=18  MSE=11541.3 Critical Value=2.3987 
 
Treatment   Lower 95.0% Difference Upper 95.0% Test 
Group Count Mean Simult.C.I. With Control Simult.C.I. Result 
T1 7 660.43 -5.17 132.57 270.31  
T2 7 649.14 -16.46 121.29 259.03 

 

The significance level (Prob Level) was only 0.061—not enough for statistical significance. Since 
the lower confidence limits are negative and the upper confidence limits are positive, Dunnett’s 
two-sided test did not find a significant difference between either treatment and the control group. 
The researcher had hoped to show that the treatment groups had higher response levels than the 
control group. He could see that the group means followed this pattern since the mean for T1 was 
about 25% higher than the control mean and the mean for T2 was about 23% higher than the 
control mean. He decided to calculate the power of the experiment. 

Setup 
The data entry for this problem is simple. The only entry that is not straight forward is finding an 
appropriate value for the standard deviation. Since the standard deviation is estimated by the 
square root of the mean square error, it is calculated as 11541.3 = 107 4304. . 

This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons procedure window by expanding 
Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on Multiple 
Comparisons. You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 7 
k (Number of Groups) ............................. 3 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference .............. 133 
S (Standard Deviation of Subjects) ......... 107.4304 
Type of Multiple Comparison .................. With Control - Dunnett 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.0002 7.00 3 21 0.0500 0.9998 133.00 107.43 1.2380 

 

The power is only 0.0002. Hence, there was little chance of detecting a difference of 133 between 
a treatment and a control group.  
It was of interest to the researcher to determine how large of a sample was needed if the power 
was to be 0.90. Setting Beta equal to 0.90 and ‘Find/Solve For’ to n resulted in the following 
report. 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9042 33.00 3 99 0.0500 0.0958 133.00 107.43 1.2380 

 

We see that instead of 7 per group, 33 per group were needed. 
It was also of interest to the research to determine how large of a difference between the means 
could have been detected. Setting ‘Find’ to Min Detectable Difference resulted in the following 
report. 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9000 7.00 3 21 0.0500 0.1000 348.81 107.43 3.2468 

 

We see that a study of this size with these parameters could only detect a difference of 348.8. 
This explains why the results were not significant. 

Example 3 – Using Unequal Sample Sizes 
It is usually advisable to design experiments with equal sample sizes in each group. In some 
cases, however, it may be necessary to allocate subjects unequally across the groups. This may 
occur when the group variances are unequal, the costs per subject are different, or the dropout 
rates are different. This module can be used to study the power of unbalanced experiments. 

In this example which will use Dunnett’s test, the minimum detectable difference is 2.0, the 
standard deviation is 1.0, alpha is 0.05, and k is 3. The sample sizes are 7, 7, and 14. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons procedure window by expanding 
Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on Multiple 
Comparisons. You may then make the appropriate entries as listed below, or open Example 3a 
by going to the File menu and choosing Open Example Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 1 
k (Number of Groups) ............................. 3 
Group Sample Size Pattern .................... 7 7 14 
Minimum Detectable Difference .............. 2 
S (Standard Deviation of Subjects) ......... 1 
Type of Multiple Comparison .................. With Control - Dunnett 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.2726 9.33 3 28 0.0500 0.7274 2.00 1.00 2.0000 
 

Alternatively, this problem could have been set up as follows (Example3b template): 

Option Value 
Data Tab 
n (Sample Size Multiplier) ....................... 7 
Group Sample Size Pattern .................... 1 1 2 
 

The advantage of this method is that you can try several values of n while keeping the same 
allocation ratios.  

Example 4 – Validation using Hsu 
Hsu (1996) page 241 presents an example of determining the sample size in an experiment with 8 
groups. The minimum detectable difference is 10,000 psi. The standard deviation is 3,000 psi. 
Alpha is 0.05 and beta is 0.10. He finds a sample size of 10 per group for the Tukey-Kramer test, 
a sample size of 6 for Hsu’s test, and a sample size of 8 for Dunnett’s test.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons procedure window by expanding 
Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on Multiple 
Comparisons. You may then make the appropriate entries as listed below, or open Example4, 
Example4b, or Example4c by going to the File menu and choosing Open Example Template.  
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Option Value 
Data Tab 
Find (Solve For) ...................................... n 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... Ignored since this is the Find setting 
k (Number of Groups) ............................. 8 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference .............. 10000 
S (Standard Deviation of Subjects) ......... 3000 
Type of Multiple Comparison .................. All Pairs - Tukey Kramer 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results for Tukey-Kramer Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9397 10.00 8 80 0.0500 0.0603 10000.00 3000.00 3.3333 

 
PASS also found n = 10.  

Numeric Results for Hsu’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9087 6.00 8 48 0.0500 0.0913 10000.00 3000.00 3.3333 
 

PASS also found n = 6.  

Numeric Results for Dunnett’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9434 8.00 8 64 0.0500 0.0566 10000.00 3000.00 3.3333 

 
PASS found n = 8.  
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Example 5 – Validation using Pan and Kupper 
Pan and Kupper (1999, page 1481) present examples of determining the sample size using 
alternative methods. It is interesting to compare the method of Hsu (1996) with theirs. Although 
the results are not exactly the same, they are very close. 

In the example of Pan and Kupper, the minimum detectable difference is 0.50. The standard 
deviation is 0.50. Alpha is 0.05, and beta is 0.10. They find a sample size of 51 per group for 
Dunnett’s test and a sample size of 60 for the Tukey-Kramer test. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons procedure window by expanding 
Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on Multiple 
Comparisons. You may then make the appropriate entries as listed below, or open Example5a or 
Example 5b by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... n 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... Ignored since this is the Find setting 
k (Number of Groups) ............................. 4 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference .............. 0.50 
S (Standard Deviation of Subjects) ......... 0.50 
Type of Multiple Comparison .................. With Control - Dunnett 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results for Dunnett’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9146 53.00 4 212 0.0500 0.0854 0.50 0.50 1.0000 
 

PASS found n = 53. This is very close to the 51 that Pan and Kupper found using a slightly 
different method. 



575-22  Multiple Comparisons 

Numeric Results for Tukey-Kramer Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9057 62.00 4 248 0.0500 0.0943 0.50 0.50 1.0000 
 

PASS also found n = 62. This is very close to the 60 that Pan and Kupper found using a slightly 
different method. 
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Chapter 580 

Pair-Wise Multiple 
Comparisons 
(Simulation) 
Introduction 
This procedure uses simulation analyze the power and significance level of three pair-wise multiple-
comparison procedures: Tukey-Kramer, Kruskal-Wallis, and Games-Howell. For each scenario, 
two simulations are run: one estimates the significance level and the other estimates the power.  

The term multiple comparisons refers to a set of two or more statistical hypothesis tests. The term 
pair-wise multiple comparisons refers to the set of all pairs of means that can be generated among 
the means of k groups. For example, suppose the levels of a factor with five groups are labeled A, 
B, C, D, and E. The ten possible paired-comparisons that could be made among the five groups are 
A-B, A-C, A-D, A-E, B-C, B-D, B-E, C-D, C-E, and D-E.  

As the number of groups increases, the number of comparisons (pairs) increases dramatically. For 
example, a 5 group design has 10 pairs, a 10 group design has 45 pairs, and a 20 group design has 
190 pairs. When several comparisons are made among the group means, the determination of the 
significance level of each individual comparison is much more complex because of the problem 
of multiplicity. Multiplicity here refers to the fact that the chances of making at least one incorrect 
decision increases as the number of statistical tests increases. The method of multiple 
comparisons has been developed to account for this multiplicity.  

Error Rates 
When dealing with several simultaneous statistical tests, both individual-wise and experiment 
wise error rates should be considered.      

1. Comparison-wise error rate. This is the probability of a type-I error (rejecting a true 
H0) for a particular test. In the case of the five-group design, there are ten possible 
comparison-wise error rates, one for each of the ten possible pairs. We will denote this 
error rate αc . 

2. Experiment-wise (or family-wise) error rate. This is the probability of making one or 
more type-I errors in the set (family) of comparisons. We will denote this error rate α f .  
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The relationship between these two error rates when the tests are independent is given by 

α αf c
C= − −1 1( )  

where C is the total number of comparisons in the family. For example, if αc is 0.05 and C is 10, 
α f is 0.401. There is about a 40% chance that at least one of the ten pairs will be concluded to be 
different when in fact they are all the same. When the tests are correlated, as they are among a set 
of pair-wise comparisons, the above formula provides an upper bound to the family-wise error 
rate. 

The techniques described below provide control for α f  rather than αc . 

Technical Details 

The One-Way Analysis of Variance Design 
The discussion that follows is based on the common one-way analysis of variance design which 
may be summarized as follows. Suppose the responses Y  in k groups each follow a normal 

distribution with means
ij
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The F test is the usual method of analysis of the data from such a design, testing whether all of 
the means are equal. However, a significant F test does not indicate which of the groups are 
different, only that at least one is different. The analyst is left with the problem of determining 
which of the groups are different and by how much.  

The Tukey-Kramer procedure, the Kruskal-Wallis procedure, and the Games-Howell procedure 
are the pair-wise multiple-comparison procedures that have been developed for this situation. The 
calculation of each of these tests is given next. 
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Tukey-Kramer 
This test is referenced in Kirk (1982). It uses the critical values from the studentized-range 
distribution. For each pair of groups, the significance test between any two groups i and j is 
calculated by rejecting the null hypothesis of mean equality if 
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Kruskal-Wallis 
This test is attributed to Dunn (1964) and is referenced in Gibbons (1976). It is a nonparametric, 
or distribution-free, test for which the assumption of normality is not necessary. It tests whether 
pairs of medians are equal using a rank test. Sample sizes of at least five (but preferably larger) 
for each treatment are recommended for use of this test. The error rate is adjusted on a 
comparison-wise basis to give the experiment-wise error rate, αf. Instead of using means, it uses 
average ranks, as the following formula indicates, with ( )( )α α= f k k/ −1 . For each pair of 
groups, i and j, the null hypothesis of equality is rejected if  
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Note that, when necessary, the usual adjustment for ties is made. 

Games-Howell 
This test is referenced in Kirk (1982) page 120. It was developed for the case when the individual 
group variances cannot be assumed to be equal. It also uses critical values from the studentized-
range distribution. For each pair of groups, i and j, the null hypothesis of equality is rejected if 

Y Y

n n

qi j

i

i

j

j

k vf

−

+
⎛

⎝
⎜⎜

⎞

⎠
⎟⎟

≥
1
2

2 2$ $
, , '

σ σ
α  



580-4  Pair-Wise Multiple Comparisons (Simulation) 
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Definition of Power for Multiple Comparisons 
The notion of the power of a test is well-defined for individual tests. Power is the probability of 
rejecting a false null hypothesis. However, this definition does not extend easily when there are a 
number of simultaneous tests.  

To understand the problem, consider an experiment with three groups labeled, A, B, and C. There 
are three paired comparisons in this experiment: A-B, A-C, and B-C. How do we define power 
for these three tests? One approach would be to calculate the power of each of the three tests, 
ignoring the other two. However, this ignores the interdependence among the three tests. Other 
definitions of the power of the set of tests might be the probability of detecting at least one of the 
differing pairs, exactly one of the differing pairs, at least two of the differing pairs, and so on. As 
the number of pairs increases, the number of possible definitions of power also increases. The 
two definitions that we emphasize in PASS were recommended by Ramsey (1978). They are any-
pair power and all-pairs power. Other design characteristics, such as average-comparison power 
and false-discovery rate, are important to consider. However, our review of the statistical 
literature resulted in our focus on these two definitions of power.  

Any-Pair Power 
Any-pair power is the probability of detecting at least one of the pairs that are actually different.  

All-Pairs Power 
All-pairs power is the probability of detecting all of the pairs that are actually different.  
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Simulation Details 
Computer simulation allows us to estimate the power and significance level that is actually achieved 
by a test procedure in situations that are not mathematically tractable. Computer simulation was 
once limited to mainframe computers. But, in recent years, as computer speeds have increased, 
simulation studies can be completed on desktop and laptop computers in a reasonable period of 
time.  

The steps to a simulation study are  

1. Specify how each test is to be carried out. This includes indicating how the test statistic is 
calculated and how the significance level is specified. 

2. Generate random samples from the distributions specified by the alternative hypothesis. 
Calculate the test statistics from the simulated data and determine if the null hypothesis is 
accepted or rejected. The number rejected is used to calculate the power of each test.  

3. Generate random samples from the distributions specified by the null hypothesis. Calculate 
each test statistic from the simulated data and determine if the null hypothesis is accepted or 
rejected. The number rejected is used to calculate the significance level of each test.  

4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated 
data leads to a rejection of the null hypothesis. The power is the proportion of simulated 
samples in step 2 that lead to rejection. The significance level is the proportion of simulated 
samples in step 3 that lead to rejection. 

Generating Random Distributions 
Two methods are available in PASS to simulate random samples. The first method generates the 
random variates directly, one value at a time. The second method generates a large pool (over 
10,000) of random values and then draws the random numbers from this pool. This second method 
can cut the running time of the simulation by 70%! 

As mentioned above, the second method begins by generating a large pool of random numbers from 
the specified distributions. Each of these pools is evaluated to determine if its mean is within a small 
relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of the 
target mean, individual members of the population are replaced with new random numbers if the 
new random number moves the mean towards its target. Only a few hundred such swaps are 
required to bring the actual mean to within tolerance of the target mean. This population is then 
sampled with replacement using the uniform distribution. We have found that this method works 
well as long as the size of the pool is the maximum of twice the number of simulated samples 
desired and 10,000.  
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Reports, and Options tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data 1 Tab 
The Data 1 tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for: power or sample size (n). If you choose to 
solve for n, you must choose the type of power you want to solve for: any-pair power or all-pairs 
power. The value of the option Power will then represent this type of power. 

Any-pair power is the probability of detecting at least one pair from among those that are actually 
different. All-pairs power is the probability of detecting all pairs that are actually different. 

Note that the search for n may take several minutes because a separate simulation must be run for 
each trial value of n. You may find it quicker and more informative to solve for the Power for a 
range of sample sizes. 

Error Rates 

Power or Beta 
This option is only used when Find (Solve For) is set to n (All-Pairs) or n (Any-Pair).   

Power is defined differently with multiple comparisons. Although many definitions are possible, 
two are adopted here. Any-pair power is the probability of detecting at least one pair of the means 
that are different. All-pairs power is the probability of detecting all pairs of means that are truly 
different. As the number of groups is increased, these power probabilities will decrease because 
more tests are being conducted. 

Since this is a probability, the range is between 0 and 1. Most researchers would like to have the 
power at least at 0.8. However, this may require extremely large sample sizes when the number of 
tests is large.  

FWER (Alpha) 
This option specifies one or more values of the family-wise error rate (FWER) which is the 
analog of alpha for multiple comparisons. FWER is the probability of falsely detecting 
(concluding that the means are different) at least one comparison for which the true means are the 
same. For independent tests, the relationship between the individual-comparison error rate 
(ICER) and FWER is given by the formulas 

FWER = 1 - (1 - ICER)^C 

or 

ICER = 1 - (1 - FWER)^(1/C) 
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where '^' represents exponentiation (as in 4^2 = 16) and C represents the number of comparisons. 
For example, if C = 5 and FWER = 0.05, then ICER = 0.0102. Thus, the individual comparison 
tests must be conducted using a Type-1 error rate of 0.0102, which is much lower than the 
family-wise rate of 0.05. 

The popular value for FWER remains at 0.05. However, if you have a large number of 
comparisons, you might decide that a larger value, such as 0.10, is appropriate. 

Sample Size 

n (Sample Size Multiplier) 
This is the base, per group, sample size. One or more values separated by blanks or commas may 
be entered. A separate analysis is performed for each value listed here. 

The group samples sizes are determined by multiplying this number by each of the Group Sample 
Size Pattern numbers. If the Group Sample Size Pattern numbers are represented by m1, m2, m3, 
…, mk and this value is represented by n, the group sample sizes N1, N2, N3, ..., Nk are calculated 
as follows: 

N1=[n(m1)] 

N2=[n(m2)] 

N3=[n(m3)] 

etc. 

where the operator, [X] means the next integer after X, e.g. [3.1]=4. 

For example, suppose there are three groups and the Group Sample Size Pattern is set to 1,2,3. If 
n is 5, the resulting sample sizes will be 5, 10, and 15. If n is 50, the resulting group sample sizes 
will be 50, 100, and 150. If n is set to 2,4,6,8,10, five sets of group sample sizes will be generated 
and an analysis run for each. These sets are: 

2 4 6 
4 8 12 
6 12 18 
8 16 24 
10 20 30 

As a second example, suppose there are three groups and the Group Sample Size Pattern is 
0.2,0.3,0.5. When the fractional Pattern values sum to one, n can be interpreted as the total 
sample size of all groups and the Pattern values as the proportion of the total in each group.  

If n is 10, the three group sample sizes would be 2, 3, and 5. 

If n is 20, the three group sample sizes would be 4, 6, and 10. 

If n is 12, the three group sample sizes would be 

(0.2)12 = 2.4 which is rounded up to the next whole integer, 3. 

(0.3)12 = 3.6 which is rounded up to the next whole integer, 4. 

(0.5)12 = 6.  

Note that in this case, 3+4+6 does not equal n (which is 12). This can happen because of 
rounding. 
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Group Sample Size Pattern 
The purpose of the group sample size pattern is to allow several groups with the same sample size 
to be generated without having to type each individually. 

A set of positive, numeric values (one for each row of distributions) is entered here. Each item 
specified in this list applies to the whole row of distributions. For example, suppose the entry is 1 
2 1 and Grps 1 = 3, Grps 2 = 1, Grps 3 = 2. The sample size pattern used would be 1 1 1 2 1 1. 

The sample size of group i is found by multiplying the ith number from this list by the value of n 
and rounding up to the next whole number. The number of values must match the number of 
groups, g. When too few numbers are entered, 1’s are added. When too many numbers are 
entered, the extras are ignored. 

• Equal 
If all sample sizes are to be equal, enter Equal here and the desired sample size in n. A set of 
g 1's will be used. This will result in n1 = n2 = … = ng = n. That is, all sample sizes are equal 
to n.  

Effect Size 
These options specify the distributions to be used in the two simulations, one set per row. The 
first option specifies the number of groups represented by the two distributions that follow. The 
second option specifies the distribution to be used in simulating the null hypothesis to determine 
the significance level (alpha). The third option specifies the distribution to be used in simulating 
the alternative hypothesis to determine the power.  

Grps [1 – 3] (Grps 4 – 9 are found on the Data 2 tab) 
This value specifies the number of groups specified by the H0 and H1 distribution statements to 
the right. Usually, you will enter ‘1’ to specify a single H0 and a single H1 distribution, or you 
will enter ‘0’ to indicate that the distributions specified on this line are to be ignored. This option 
lets you easily specify many identical distributions with a single phrase. 

The total number of groups g is equal to the sum of the values for the three rows of distributions 
shown under the Data1 tab and the six rows of distributions shown under the Data2 tab. 

Note that each item specified in the Group Sample Size Pattern option applies to the whole row 
of entries here. For example, suppose the Group Sample Size Pattern was 1 2 1 and Grps 1 = 3, 
Grps 2 = 1, and Grps 3 = 2. The sample size pattern would be 1 1 1 2 1 1.  

Note that since the first group is the control group, the value for Grps 1 is usually set to one. 

Group Distribution(s)|H0 
This entry specifies the distribution of one or more groups under the null hypothesis, H0. The 
magnitude of the differences of the means of these distributions, which is often summarized as 
the standard deviation of the means, represents the magnitude of the mean differences specified 
under H0. Usually, the means are assumed to be equal under H0, so their standard deviation 
should be zero except for rounding.  

These distributions are used in the simulations that estimate the actual significance level. They 
also specify the value of the mean under the null hypothesis, H0. Usually, these distributions will 
be identical. The parameters of each distribution are specified using numbers or letters. If letters 
are used, their values are specified in the boxes below. The value M0 is reserved for the value of 
the mean under the null hypothesis.  
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Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean is entered 
first. 

Beta=A(M0,A,B,Minimum) 
Binomial=B(M0,N) 
Cauchy=C(M0,Scale) 
Constant=K(Value) 
Exponential=E(M0) 
F=F(M0,DF1) 
Gamma=G(M0,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M0,SD) 
Poisson=P(M0) 
Student's T=T(M0,D) 
Tukey's Lambda=L(M0,S,Skewness,Elongation) 
Uniform=U(M0,Minimum) 
Weibull=W(M0,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Finding the Value of the Mean of a Specified Distribution 
Except for the multinomial distribution, the distributions have been parameterized in terms of 
their means since this is the parameter being tested. The mean of a distribution created as a linear 
combination of other distributions is found by applying the linear combination to the individual 
means. However, the mean of a distribution created by multiplying or dividing other distributions 
is not necessarily equal to applying the same function to the individual means. For example, the 
mean of 4N(4, 5) + 2N(5, 6) is 4*4 + 2*5 = 26, but the mean of 4N(4, 5) * 2N(5, 6) is not exactly 
4*4*2*5 = 160 (although it is close). 

Group Distribution(s)|H1 
Specify the distribution of this group under the alternative hypothesis, H1. This distribution is 
used in the simulation that determines the power. A fundamental quantity in a power analysis is 
the amount of variation among the group means. In fact, classical power analysis formulas, this 
variation is summarized as the standard deviation of the means.  

The important point to realize is that you must pay particular attention to the values you give to 
the means of these distributions because they are fundamental to the interpretation of the 
simulation. 

For convenience in specifying a range of values, the parameters of the distribution can be 
specified using numbers or letters. If letters are used, their values are specified in the boxes 
below. The value M1 is reserved for the value of the mean under the alternative hypothesis.  

Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean, M1, is 
entered first. 

Beta=A(M1,A,B,Minimum) 
Binomial=B(M1,N) 
Cauchy=C(M1,Scale) 
Constant=K(Value) 
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Exponential=E(M1) 
F=F(M1,DF1) 
Gamma=G(M1,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M1,SD) 
Poisson=P(M1) 
Student's T=T(M1,D) 
Tukey's Lambda=L(M1,S,Skewness,Elongation) 
Uniform=U(M1,Minimum) 
Weibull=W(M1,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Equivalence Margin 
Specify the largest difference for which means from different groups will be considered equal. 
When specifying group distributions, it is possible to end up with scenarios where some means 
are slightly different from each other, even though they are intended to be equivalent. This often 
happens when specifying distributions of different forms (e.g. normal and gamma) for different 
groups, where the means are intended to be the same. The parameters used to specify different 
distributions do not always result in means that are EXACTLY equal. This value lets you control 
how different means can be and still be considered equal. 

This value is not used to specify the hypothesized mean differences of interest. The hypothesized 
differences are specified using the means (or parameters used to calculate means) for the null and 
alternative distributions. 

This value should be MUCH smaller than the hypothesized mean differences. 

Effect Size – Distribution Parameters 

M0 (Mean|H0) 
These values are substituted for M0 in the distribution specifications given above. M0 is intended 
to be the value of the mean hypothesized by the null hypothesis, H0. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 

M1 (Mean|H1) 
These values are substituted for M1 in the distribution specifications given above. Although it can 
be used wherever you want, M1 is intended to be the value of the mean hypothesized by the 
alternative hypothesis, H1. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 

Parameter Values (S, A, B, C) 
Enter the numeric value(s) of the parameters listed above. These values are substituted for the 
corresponding letter in all four distribution specifications. 

You can enter a list of values for each letter using the syntax 0 1 2 3 or 0 to 3 by 1. 

You can also change the letter that is used as the name of this parameter using the pull-down 
menu to the side. 
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Test 

MC Procedure 
Specify which pair-wise multiple comparison procedure is to be reported from the simulations. 
The choices are 

• Tukey-Kramer 
This is the most popular and the most often recommended. 

• Kruskal-Wallis 
This is recommended when a nonparametric procedure is wanted. 

• Games-Howell 
This is recommended when the variances of the groups are unequal. 

Simulations 

Simulations 
This option specifies the number of iterations, M, used in the simulation. As the number of 
iterations is increased, the running time and accuracy are increased as well. 

The precision of the simulated power estimates are calculated using the binomial distribution. 
Thus, confidence intervals may be constructed for various power values. The following table 
gives an estimate of the precision that is achieved for various simulation sizes when the power is 
either 0.50 or 0.95. The table values are interpreted as follows: a 95% confidence interval of the 
true power is given by the power reported by the simulation plus and minus the ‘Precision’ 
amount given in the table. 
  

  
Simulation  Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
   

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power 
is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a small 
amount of additional accuracy achieved.  



580-12  Pair-Wise Multiple Comparisons (Simulation) 

Reports Tab 
The Reports tab contains settings about the format of the output. 

Select Output – Numeric Reports 

Show Various Reports & Plots 
These options let you specify whether you want to generate the standard reports and plots. 

Show Inc’s & 95% C.I. 
Checking this option causes an additional line to be printed showing a 95% confidence interval 
for both the power and actual alpha and half the width of the confidence interval (the increment). 

Select Output – Plots 

Show Comparative Reports & Plots 
These options let you specify whether you want to generate reports and plots that compare the test 
statistics that are available. 

Options Tab 
The Options tab contains limits on the number of iterations and various options about individual 
tests. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the sample size is aborted. When 
the maximum number of iterations is reached without convergence, the sample size is left blank. 
We recommend a value of at least 500. 

Random Numbers 

Random Number Pool Size 
This is the size of the pool of values from which the random samples will be drawn. Pools should 
be at least the maximum of 10,000 and twice the number of simulations. You can enter Automatic 
and an appropriate value will be calculated. 

If you do not want to draw numbers from a pool, enter 0 here. 
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Example 1 – Power at Various Sample Sizes 
An experiment is being designed to investigate the variety of response when an experiment is 
replicated under five different conditions. Previous studies have shown that the standard deviation 
within a group is 3.0. Researchers want to detect a shift in the mean of 3.0 or more. To 
accomplish this, they set the means of the first four groups to zero and the mean of the fifth group 
to 3.0. They want to investigate sample sizes of 5, 10, 15, and 20 subjects per group.   

Although they will conduct an F-test on the data, their primary analysis will be a set of Tukey-
Kramer multiple comparison tests. They set the FWER to 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Pair-Wise Multiple Comparisons (Simulation) procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Pair-Wise Multiple Comparisons (Simulation). You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 5 10 15 20 
Group Sample Size Pattern .................... Equal 
Grps 1...................................................... 4 
Group 1 Distribution(s) | H0 .................... N(M0 S) 
Group 1 Distribution(s) | H1 .................... N(M0 S) 
Grps 2...................................................... 1 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.5 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 3 
S .............................................................. 3 
MC Procedure ......................................... Tukey-Kramer 
Simulations .............................................. 2000 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Simulation Summary Report  
 

Summary of Simulations of 5 Groups 
MC Procedure: Tukey-Kramer M.C. Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Pairs Size Size Pairs Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.251 5.0 25 0.014 1.2 3.0 0.043 0.050 0.0 3.0 3.0    
 (0.019) [0.232 0.269] (0.005) [0.008 0.019] (0.009) [0.034 0.051]     
 
2 0.562 10.0 50 0.077 1.2 3.0 0.052 0.050 0.0 3.0 3.0    
 (0.022) [0.540 0.583] (0.012) [0.065 0.088] (0.010) [0.042 0.062]     
 
3 0.770 15.0 75 0.200 1.2 3.0 0.057 0.050 0.0 3.0 3.0    
 (0.018) [0.751 0.788] (0.018) [0.182 0.217] (0.010) [0.046 0.067]     
 
4 0.898 20.0 100 0.356 1.2 3.0 0.060 0.050 0.0 3.0 3.0    
 (0.013) [0.884 0.911] (0.021) [0.335 0.377] (0.010) [0.049 0.070]     
 
 
Pool Size: 10000. Simulations: 2000. Run Time: 26.45 seconds. 
 
Summary of Simulations Report Definitions 
H0: the null hypothesis that each pair of group means are equal. 
H1: the alternative hypothesis that at least one pair of group means are not equal. 
All-Pairs Power: the estimated probability of detecting all unequal pairs. 
Any-Pairs Power: the estimated probability of detecting at least one unequal pair. 
n: the average of the group sample sizes. 
N: the combined sample size of all groups. 
Family-Wise Error Rate (FWER): the probability of detecting at least one equal pair assuming H0.  
Target FWER: the user-specified FWER.  
Actual FWER: the FWER estimated by the alpha simulation.  
Sm|H1: the standard deviation of the group means under H1. 
SD|H1: the pooled, within-group standard deviation under H1. 
Second Row: provides the precision and a confidence interval based on the size of the simulation for  
Any-Pairs Power, All-Pairs Power, and FWER. The format is (Precision) [95% LCL and UCL Alpha]. 
 
Summary Statements 
A one-way design with 5 groups has an average group sample size of 5.0 for a total sample size 
of 25. This design achieved an any-pair power of 0.2505 and an all-pair power of 0.0135 using 
the Tukey-Kramer M.C. Test with a target family-wise error rate of 0.050 and an actual target 
family-wise error rate 0.043. The average within group standard deviation assuming the 
alternative distribution is 3.0. These results are based on 2000 Monte Carlo samples from the 
null distributions: N(M0 S); N(M0 S); N(M0 S); N(M0 S); and N(M0 S) and the alternative 
distributions: N(M0 S); N(M0 S); N(M0 S); N(M0 S); and N(M1 S). Other parameters used in the 
simulation were: M0 = 0.0, M1 = 3.0, and S = 3.0. 
 

This report shows the estimated any-pairs power, all-pairs power, and FWER for each scenario. 
The second row shows three 95% confidence intervals in brackets: the first for the any-pairs 
power, the second for the all-pairs power, and the third for the FWER. Half the width of each 
confidence interval is given in parentheses as a fundamental measure of the precision of the 
simulation. As the number of simulations is increased, the width of the confidence intervals will 
decrease. 
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Any-Pairs Power 
This is the probability of detecting any of the significant pairs. This value is estimated by the 
simulation using the H1 distributions. 

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the estimated power. 

All-Pairs Power 
This is the probability of detecting all of the significant pairs. This value is estimated by the 
simulation using the H1 distributions. 

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the estimated power. 

Group Sample Size n 
This is the average of the individual group sample sizes. 

Total Sample Size N 
This is the total sample size of the study. 

S.D. of Means Sm|H1 
This is the standard deviation of the hypothesized means of the alternative distributions. Under 
the null hypothesis, this value is zero. This value represents the magnitude of the difference 
among the means that is being tested. It is roughly equal to the average difference between the 
group means and the overall mean.  

Note that the effect size is the ratio of Sm|H1 and SD|H1. 

S.D. of Data SD|H1 
This is the within-group standard deviation calculated from samples from the alternative 
distributions.  

Actual FWER 
This is the value of FWER (family-wise error rate) estimated by the simulation using the H0 
distributions. It should be compared with the Target FWER to determine if the test procedure is 
accurate.  

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the Actual FWER. 

Target FWER 
This is the target value of FWER that was set by the user. 

M0 
This is the value entered for M0, the group means under H0. 

M1 
This is the value entered for M1, the group means under H1. 

S 
This is the value entered for S, the standard deviation. 
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Error-Rate Summary for H0 Simulation  
 

Error Rate Summary from H0 (Alpha) Simulation of 5 Groups 
MC Procedure: Tukey-Kramer M.C. Test 
    Prop.     
    (No. of     
  Mean  Type-1     
 No. of No. of Prop. Errors  Mean Min Max 
Sim. Equal Type-1 Type-1 > 0) Target Pairs Pairs Pairs 
No. Pairs Errors Errors FWER FWER Alpha Alpha Alpha 
1 10 0.057 0.006 0.043 0.050 0.006 0.005 0.007 
2 10 0.072 0.007 0.052 0.050 0.007 0.005 0.011 
3 10 0.075 0.008 0.057 0.050 0.008 0.006 0.011 
4 10 0.075 0.008 0.060 0.050 0.008 0.004 0.010 
 

This report shows the results of the H0 simulation. This simulation uses the H0 settings for each 
group. Its main purpose is to provide an estimate of the FWER. 

No. of Equal Pairs 
Since under H0 all means are equal, this is the number of unique pairs of the groups. Thus, this is 
the number of pair-wise multiple comparisons. 

Mean No. of Type-1 Errors 
This is the average number of type-1 errors (false detections) per set (family). 

Prop. Type-1 Errors 
This is the proportion of type-1 errors (false detections) among all tests that were conducted. 

Prop. (No. of Type-1 Errors>0) FWER 
This is the proportion of the H0 simulations in which at least one type-1 error occurred. This is 
called the family-wise error rate. 

Target FWER 
This is the target value of FWER that was set by the user. 

Mean Pairs Alpha 
Alpha is the probability of rejecting H0 when H0 is true. It is a characteristic of an individual test. 
This is the average alpha value over all of the tests in the family. 

Min Pairs Alpha 
This is the minimum of all of the individual comparison alphas. 

Max Pairs Alpha 
This is the maximum of all of the individual comparison alphas. 
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Error-Rate Summary for H1 Simulation  
 

Error Rate Summary from H1 (Power) Simulation of 5 Groups 
MC Procedure: Tukey-Kramer M.C. Test 
       (FDR)       
     Prop. Prop. Prop. Prop.      
 No. of Mean Mean  Equal Uneq. Detect. Undet. All Any    
 Equal/ No. of No. of  that that that that Uneq. Uneq. Mean Min Max 
Sim. Uneq. False False Prop. were were were were Pairs Pairs Pairs Pairs Pairs 
No. Pairs Pos. Neg. Errors Detect. Undet. Equal Uneq. Power Power Power Power Power 
1 6/4 0.04 3.58 0.362 0.007 0.896 0.091 0.375 0.014 0.251 0.046 0.004 0.109 
2 6/4 0.04 2.85 0.289 0.007 0.711 0.035 0.323 0.077 0.562 0.120 0.006 0.302 
3 6/4 0.03 2.11 0.214 0.006 0.527 0.017 0.261 0.200 0.770 0.192 0.002 0.478 
4 6/4 0.03 1.41 0.144 0.005 0.352 0.012 0.191 0.356 0.898 0.262 0.003 0.658 
 

This report shows the results of the H1 simulation. This simulation uses the H1 settings for each 
group. Its main purpose is to provide an estimate of the power. 

No. of Equal Pairs/Unequal Pairs 
The first value is the number of pairs for which the means were equal under H1. The second 
value is the number of pairs for which the means were different under H1. 

Mean No. False Positives 
This is the average number of equal pairs that were declared as being unequal by the testing 
procedure. A false positive is a type-1 (alpha) error. 

Mean No. False Negatives 
This is the average number of unequal pairs that were not declared as being unequal by the testing 
procedure. A false negative is a type-2 (beta) error. 

Prop. Errors 
This is the proportion of type-1 and type-2 errors. 

Prop. Equal that were Detect. 
This is the proportion of the equal pairs in the H1 simulations that were declared as unequal. 

Prop. Uneq. that were Undet. 
This is the proportion of the unequal pairs in the H1 simulations that were not declared as being 
unequal. 

Prop. Detect. that were Equal (FDR) 
This is the proportion of all detected pairs in the H1 simulations that were actually equal. This is 
often called the false discovery rate. 

Prop. Undet. that were Uneq. 
This is the proportion of undetected pairs in the H1 simulations that were actually unequal.  

All Uneq. Pairs Power 
This is the probability of detecting all of the pairs that were different in the H1 simulation. 

Any Uneq. Pairs Power 
This is the probability of detecting any of the pairs that were different in the H1 simulation. 
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Mean, Min, and Max Pairs Power 
These items give the average, the minimum, and the maximum of the individual comparison 
powers from the H1 simulation. 

Detail Model Report 
 

Detailed Model Report for Simulation No. 1 
Target FWER = 0.050, M0 = 0.0, M1 = 3.0, S = 3.0 
MC Procedure: Tukey-Kramer M.C. Test 
 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-4 A1-A4 5/25 0.0 2.9 N(M0 S) 
H0 5 B1 5/25 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-4 A1-A4 5/25 0.0 3.0 N(M0 S) 
H1 5 B1 5/25 3.0 3.0 N(M1 S) 
H1 All   Sm=1.2 3.0  
 
Detailed Model Report for Simulation No. 2 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-4 A1-A4 10/50 0.0 3.0 N(M0 S) 
H0 5 B1 10/50 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-4 A1-A4 10/50 0.0 3.0 N(M0 S) 
H1 5 B1 10/50 3.0 3.0 N(M1 S) 
H1 All   Sm=1.2 3.0  

 
Detailed Model Report for Simulation No. 3 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-4 A1-A4 15/75 0.0 3.0 N(M0 S) 
H0 5 B1 15/75 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-4 A1-A4 15/75 0.0 3.0 N(M0 S) 
H1 5 B1 15/75 3.0 3.0 N(M1 S) 
H1 All   Sm=1.2 3.0  
 
Detailed Model Report for Simulation No. 4 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-4 A1-A4 20/100 0.0 3.0 N(M0 S) 
H0 5 B1 20/100 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-4 A1-A4 20/100 0.0 3.0 N(M0 S) 
H1 5 B1 20/100 3.0 3.0 N(M1 S) 
H1 All   Sm=1.2 3.0  
 

This report shows details of each row of the previous reports. 

Hypo. Type 
This indicates which simulation is being reported on each row. H0 represents the null simulation 
and H1 represents the alternative simulation. 

Groups 
Each group in the simulation is assigned a number. This item shows the arbitrary group number 
that was assigned. 
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Group Labels 
These are the labels that were used in the individual alpha-level reports. 

n/N 
n is the average sample size of the groups. N is the total sample size across all groups. 

Group Mean 
These are the means of the individual groups as specified for the H0 and H1 simulations. 

Ave. S.D. 
This is the average standard deviation of all groups reported on each line. Note that it is 
calculated from the simulated data. 

Simulation Model 
This is the distribution that was used to simulate data for the groups reported on each line. 

Probability of Rejecting Equality  
 

Probability of Rejecting the Equality of Each Pair. Simulation No. 1 
 
Group Means A1 A2 A3 A4 B1 
A1 0.0  0.006 0.006 0.011 0.109* 
A2 0.0 0.006  0.006 0.004 0.106* 
A3 0.0 0.005 0.006  0.008 0.097* 
A4 0.0 0.005 0.007 0.007  0.107* 
B1 3.0 0.005 0.005 0.007 0.006  
 
Probability of Rejecting the Equality of Each Pair. Simulation No. 2 
 
Group Means A1 A2 A3 A4 B1 
A1 0.0  0.007 0.007 0.008 0.294* 
A2 0.0 0.006  0.007 0.006 0.280* 
A3 0.0 0.011 0.007  0.006 0.302* 
A4 0.0 0.005 0.007 0.005  0.281* 
B1 3.0 0.008 0.009 0.008 0.007  
 
Probability of Rejecting the Equality of Each Pair. Simulation No. 3 
 
Group Means A1 A2 A3 A4 B1 
A1 0.0  0.005 0.002 0.007 0.478* 
A2 0.0 0.006  0.006 0.007 0.477* 
A3 0.0 0.007 0.008  0.005 0.473* 
A4 0.0 0.009 0.008 0.007  0.465* 
B1 3.0 0.006 0.011 0.007 0.008 
  
Probability of Rejecting the Equality of Each Pair. Simulation No. 4 
 
Group Means A1 A2 A3 A4 B1 
A1 0.0  0.003 0.005 0.004 0.645* 
A2 0.0 0.008  0.008 0.007 0.650* 
A3 0.0 0.006 0.008  0.004 0.640* 
A4 0.0 0.010 0.007 0.009  0.658* 
B1 3.0 0.010 0.007 0.004 0.007  
 
Individual pairwise powers from the H1 (Power) simulation are shown in the upper-right section. 
Individual pairwise significance levels from the H0 (Alpha) simulation are shown in the lower-left section. 
* Starred values are the powers of pairs that are unequal under H1. 
 

This report shows the individual probabilities of rejecting each pair. When a pair was actually 
different, the value is the power of that test. These power values are starred.  
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The results shown on the upper-right section of each simulation report are from the H1 
simulation. The results shown on the lower-left section of the report are from the H0 simulation. 

Plots Section 
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These plots give a visual presentation of the all-pairs power values and the any-pair power values. 

Example 2 – Comparative Results 
Continuing with Example 1, the researchers want to study the characteristics of alternative 
multiple comparison procedures. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Pair-Wise Multiple Comparisons (Simulation) procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Pair-Wise Multiple Comparisons (Simulation). You may then make the appropriate 
entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 5 10 15 20 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 4 
Group 1 Distribution(s) | H0 .................... N(M0 S) 
Group 1 Distribution(s) | H1 .................... N(M0 S) 
Grps 2 ...................................................... 1 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
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Data Tab (continued) 
Equivalence Margin ................................. 0.5 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 3 
S .............................................................. 3 
MC Procedure ......................................... Tukey-Kramer 
Simulations .............................................. 2000 

Reports Tab 
Comparative Reports .............................. Checked 
Comparative Any-Pair Power Plot .......... Checked 
Comparative All-Pair Power Plot ............. Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Power Comparison for Testing the 5 Group Means 
 
   Tukey Kruskal Games Tukey Kruskal Games 
 Total  Kramer Wallis Howell Kramer Wallis Howell 
Sim. Sample Target All-Pair All-Pair All-Pair Any-Pair Any-Pair Any-Pair 
No. Size Alpha Power Power Power Power Power Power 
1 25 0.050 0.013 0.000 0.003 0.238 0.132 0.209     
2 50 0.050 0.076 0.010 0.055 0.555 0.456 0.523     
3 75 0.050 0.201 0.076 0.163 0.779 0.697 0.755     
4 100 0.050 0.350 0.197 0.318 0.890 0.842 0.883     
Pool Size: 10000. Simulations: 2000. Run Time: 33.82 seconds. 
 
Family-Wise FWER Comparison for Testing the 5 Group Means 
 
 Total  Tukey Kruskal Games   
Sim. Sample Target Kramer Wallis Howell   
No. Size FWER FWER FWER FWER   
1 25 0.050 0.039 0.023 0.064        
2 50 0.050 0.050 0.039 0.059        
3 75 0.050 0.051 0.033 0.055        
4 100 0.050 0.051 0.040 0.058        
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These reports show the power and FWER of each of the three multiple comparison procedures. In 
these simulations of groups from the normal distributions with equal variances, we see that the 
Tukey-Kramer procedure is the champion. 

Example 3 – Validation using Ramsey 
Ramsey (1978) presents the results of a simulation study that compared the all-pair power of 
several different multiple comparison procedures. On page 483 of this article, he presents the 
results of a simulation in which there were four groups: two with means of -0.7 and two with 
means of 0.7.  The standard deviation was 1.0 and the FWER was 0.05. Tukey’s multiple 
comparison procedure was used in the simulation. The sample size was 16 per group. Using a 
simulation of 1000 iterations, the all-pairs power was calculated as 0.723. Note that a confidence 
interval for this estimated all-pairs power is (0.703 to 0.759).   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Pair-Wise Multiple Comparisons (Simulation) procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Pair-Wise Multiple Comparisons (Simulation). You may then make the appropriate 
entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 16 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 2 
Group 1 Distribution(s) | H0 .................... N(M0 S) 
Group 1 Distribution(s) | H1 .................... N(M0 S) 
Grps 2 ...................................................... 2 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.1 
M0 (Mean|H0) ......................................... -0.7 
M1 (Mean|H1) ......................................... 0.7 
S .............................................................. 1 
MC Procedure ......................................... Tukey-Kramer 
Simulations .............................................. 2000 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Summary of Simulations of 5 Groups 
MC Procedure: Tukey-Kramer M.C. Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Pairs Size Size Pairs Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.996 16.0 64 0.729 0.7 1.0 0.052 0.050 -0.7 0.7 1.0    
 (0.004) [0.992 1.000] (0.028) [0.701 0.757] (0.014) [0.038 0.066]     
 
Pool Size: 10000. Simulations: 1000. Run Time: 4.28 seconds. 

 

Note that the value found by PASS of 0.729 is very close to the value of 0.723 found by Ramsey 
(1978). More importantly, the value found by PASS is inside the confidence limits of Ramsey’s 
study. 
We ran the simulation five more times and obtained 0.727, 0.723, 0.714, 0.740, and 0.732. We 
also ran the simulation with 10,000 iterations and obtained a power of 0.736 with a confidence 
interval of (0.727 to 0.745). 

Example 4 – Selecting a Multiple Comparison Procedure 
when the Data Contain Outliers 
This example will investigate the impact of outliers on the power and precision of the various 
multiple comparison procedures when there are five groups. 

A mixture of two normal distributions will be used to randomly generate outliers. The mixture 
will draw 95% of the data from a normal distribution with mean zero and variance one. The other 
5% of the data will come from a normal distribution with mean zero and variance that ranges 
from one to ten. In the alternative distributions, two will have means of zero and the other three 
will have means of one. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Pair-Wise Multiple Comparisons (Simulation) procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Pair-Wise Multiple Comparisons (Simulation). You may then make the appropriate 
entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
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Data Tab (continued) 
n (Sample Size Multiplier) ....................... 16 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 2 
Group 1 Distribution(s) | H0 .................... N(M0 S)[95];N(M0 A)[5] 
Group 1 Distribution(s) | H1 .................... N(M0 S)[95];N(M0 A)[5] 
Grps 2 ...................................................... 3 
Group 2 Distribution(s) | H0 .................... N(M0 S)[95];N(M0 A)[5] 
Group 2 Distribution(s) | H1 .................... N(M1 S)[95];N(M1 A)[5] 
Equivalence Margin ................................. 0.5 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 1 
S .............................................................. 1 
A .............................................................. 1 5 10 
Multiple Comparison Procedure .............. Tukey Kramer 
Simulations .............................................. 2000 

Reports Tab 
Show Comparative Reports .................... Checked 
Show Comparative Plots ......................... Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Power Comparison for Testing the 5 Group Means 
 
   Tukey Kruskal Games Tukey Kruskal Games 
 Total  Kramer Wallis Howell Kramer Wallis Howell 
Sim. Sample Target All-Pair All-Pair All-Pair Any-Pair Any-Pair Any-Pair 
No. Size Alpha Power Power Power Power Power Power 
1 80 0.050 0.131 0.043 0.098 0.892 0.837 0.890     
2 80 0.050 0.019 0.017 0.016 0.592 0.751 0.701     
3 80 0.050 0.006 0.022 0.005 0.341 0.759 0.577     
Pool Size: 10000. Simulations: 2000. Run Time: 33.82 seconds. 
 
Family-Wise Error-Rate Comparison for Testing the 5 Group Means 
 
 Total  Tukey Kruskal Games   
Sim. Sample Target Kramer Wallis Howell   
No. Size FWER FWER FWER FWER   
1 80 0.050 0.046 0.036 0.049        
2 80 0.050 0.044 0.044 0.040        
3 80 0.050 0.033 0.038 0.025        
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These reports show the power and FWER of each of the three multiple comparison procedures. 
We note that when the variances are equal (A = 1), the Tukey-Kramer procedure performs only 
slightly better than the others. However, as the number of outliers is increased, the Kruskal-
Wallis procedure emerges as the better choice. Also note that in the case with many outliers 
(Simulation 3), the FWER of all procedures is below the target value. 
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Chapter 585 

Multiple 
Comparisons of 
Treatments vs. a 
Control 
(Simulation) 
Introduction 
This procedure uses simulation to analyze the power and significance level of two multiple-
comparison procedures that perform two-sided hypothesis tests of each treatment group mean 
versus the control group mean using simulation. These are Dunnett’s test and the Kruskal-Wallis 
test. For each scenario, two simulations are run: one estimates the significance level and the other 
estimates the power.  

The term multiple comparisons of treatments versus a control refers to the set of comparisons of 
each treatment group to a control group. If there are k groups of which k-1 are treatment groups, 
there will be k-1 tests.  

When several comparisons are made among the group means, the interpretation for each 
comparison becomes more complex because of the problem of multiplicity. Multiplicity here 
refers to the fact that the chances of making at least one incorrect decision increases as the 
number of statistical tests increases. The method of multiple comparisons has been developed to 
account for this multiplicity. 
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Error Rates 
When dealing with several simultaneous statistical tests, both individual-wise and experiment 
wise error rates should be considered.      

1. Comparison-wise error rate. This is the probability of a type-I error (rejecting a true 
H0) for a particular test. In the case of the five-group design, there are ten possible 
comparison-wise error rates, one for each of the ten possible pairs. We will denote this 
error rate αc . 

2. Experiment-wise (or family-wise) error rate. This is the probability of making one or 
more type-I errors in the set (family) of comparisons. We will denote this error rate α f .  

The relationship between these two error rates when the tests are independent is given by 

α αf c
C= − −1 1( )  

where C is the total number of comparisons in the family. For example, if αc is 0.05 and C is 10, 
α f is 0.401. There is about a 40% chance that at least one of the ten pairs will be concluded to be 
different when in fact they are all the same. When the tests are correlated, as they are among a set 
of pair-wise comparisons, the above formula provides an upper bound to the family-wise error 
rate. 

The techniques described below provide control for α f  rather than αc . 

Technical Details 

The One-Way Analysis of Variance Design 
The discussion that follows is based on the common one-way analysis of variance design which 
may be summarized as follows. Suppose the responses Y  in k groups each follow a normal 

distribution with means
ij

μ μ μ1 2, , ,L k  and unknown variance . Let n n  denote the 
number of subjects in each group. The control group is assumed to be group one. 
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The F test is the usual method of analysis of the data from such a design, testing whether all of 
the means are equal. However, a significant F test does not indicate which of the groups are 
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different, only that at least one is different. The analyst is left with the problem of determining 
which of the groups are different and by how much.  

The Dunnett procedure and a special version of the Kruskal-Wallis procedure have been 
developed for this situation. The calculation of each of these tests is given next. 

Dunnett’s Test 
Dunnett (1955) developed a test procedure for simultaneously comparing each treatment with a 
control group. It uses the critical values of a special t distribution given in Dunnett (1955). For 
each treatment and control pair, the significance test is calculated by rejecting the null hypothesis 
of mean equality if 

Y Y
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Kruskal-Wallis Test 
This test is attributed to Dunn (1964) and is referenced in Gibbons (1976). It is a nonparametric, 
or distribution-free, test which means that normality is not assumed. It tests whether the medians 
of each treatment-control pair are equal using a rank test. Sample sizes of at least five (but 
preferably larger) for each treatment are recommended for the use of this test. The error rate is 
adjusted on a comparison-wise basis to give the experiment-wise error rate, αf. Instead of using 
means, it uses average ranks as the following formula indicates, with . For 
each treatment and control pair, the significance test is calculated by rejecting the null hypothesis 
of median equality if 
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Note that, when necessary, the usual adjustment for ties is made. 

Definition of Power for Multiple Comparisons 
The notion of the power of a test is well-defined for individual tests. Power is the probability of 
rejecting a false null hypothesis. However, this definition does not extend easily when there are a 
number of simultaneous tests.  

To understand the problem, consider an experiment with four groups labeled, C, A, B, and D. 
Suppose C is the control group. There are three paired comparisons in this experiment: A-C, B-C, 
and D-C. How do we define power for these three tests? One approach would be to calculate the 
power of each of the three tests, ignoring the other two. However, this ignores the 
interdependence among the three tests. Other definitions of the power of the set of tests might be 
the probability of detecting at least one of the differing pairs, exactly one of the differing pairs, at 
least two of the differing pairs, and so on. As the number of pairs increases, the number of 
possible definitions of power also increases. The two definitions that we emphasize in PASS were 
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recommended by Ramsey (1978). They are any-pair power and all-pairs power. Other design 
characteristics, such as average-comparison power and false-discovery rate, are important to 
consider. However, our review of the statistical literature resulted in our focus on these two 
definitions of power.  

Any-Pair Power 
Any-pair power is the probability of detecting at least one of the pairs that are actually different.  

All-Pairs Power 
All-pairs power is the probability of detecting all of the pairs that are actually different.  

Simulation Details 
Computer simulation allows us to estimate the power and significance level that is actually achieved 
by a test procedure in situations that are not mathematically tractable. Computer simulation was 
once limited to mainframe computers. But, in recent years, as computer speeds have increased, 
simulation studies can be completed on desktop and laptop computers in a reasonable period of 
time.  

The steps to a simulation study are  

1. Specify how each test is to be carried out. This includes indicating how the test statistic is 
calculated and how the significance level is specified. 

2. Generate random samples from the distributions specified by the alternative hypothesis. 
Calculate the test statistics from the simulated data and determine if the null hypothesis is 
accepted or rejected. The number rejected is used to calculate the power of each test.  

3. Generate random samples from the distributions specified by the null hypothesis. Calculate 
each test statistic from the simulated data and determine if the null hypothesis is accepted or 
rejected. The number rejected is used to calculate the significance level of each test.  

4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated 
data leads to a rejection of the null hypothesis. The power is the proportion of simulated 
samples in step 2 that lead to rejection. The significance level is the proportion of simulated 
samples in step 3 that lead to rejection. 

Generating Random Distributions 
Two methods are available in PASS to simulate random samples. The first method generates the 
random variates directly, one value at a time. The second method generates a large pool (over 
10,000) of random values and then draws the random numbers from this pool. This second method 
can cut the running time of the simulation by 70%! 

As mentioned above, the second method begins by generating a large pool of random numbers from 
the specified distributions. Each of these pools is evaluated to determine if its mean is within a small 
relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of the 
target mean, individual members of the population are replaced with new random numbers if the 
new random number moves the mean towards its target. Only a few hundred such swaps are 
required to bring the actual mean to within tolerance of the target mean. This population is then 
sampled with replacement using the uniform distribution. We have found that this method works 
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well as long as the size of the pool is the maximum of twice the number of simulated samples 
desired and 10,000.  

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Reports, and Options tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data 1 Tab 
The Data 1 tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for: power or sample size (n). If you choose to 
solve for n, you must choose the type of power you want to solve for: any-pair power or all-pairs 
power. The value of the option Power will then represent this type of power. 

Any-pair power is the probability of detecting at least one pair from among those that are actually 
different. All-pairs power is the probability of detecting all pairs that are actually different. 

Note that the search for n may take several minutes because a separate simulation must be run for 
each trial value of n. You may find it quicker and more informative to solve for the Power for a 
range of sample sizes. 

Error Rates 

Power or Beta 
This option is only used when Find (Solve For) is set to n (All-Pairs) or n (Any-Pair).   

Power is defined differently with multiple comparisons. Although many definitions are possible, 
two are adopted here. Any-pair power is the probability of detecting at least one pair of the means 
that are different. All-pairs power is the probability of detecting all pairs of means that are truly 
different. As the number of groups is increased, these power probabilities will decrease because 
more tests are being conducted. 

Since this is a probability, the range is between 0 and 1. Most researchers would like to have the 
power at least at 0.8. However, this may require extremely large sample sizes when the number of 
tests is large.  

FWER (Alpha) 
This option specifies one or more values of the family-wise error rate (FWER) which is the 
analog of alpha for multiple comparisons. FWER is the probability of falsely detecting 
(concluding that the means are different) at least one comparison for which the true means are the 
same. For independent tests, the relationship between the individual-comparison error rate 
(ICER) and FWER is given by the formulas 

FWER = 1 - (1 - ICER)^C 
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or 

ICER = 1 - (1 - FWER)^(1/C) 

where '^' represents exponentiation (as in 4^2 = 16) and C represents the number of comparisons. 
For example, if C = 5 and FWER = 0.05, then ICER = 0.0102. Thus, the individual comparison 
tests must be conducted using a Type-1 error rate of 0.0102, which is much lower than the 
family-wise rate of 0.05. 

The popular value for FWER remains at 0.05. However, if you have a large number of 
comparisons, you might decide that a larger value, such as 0.10, is appropriate. 

Sample Size 

n (Sample Size Multiplier) 
This is the base, per group, sample size. One or more values separated by blanks or commas may 
be entered. A separate analysis is performed for each value listed here. 

The group samples sizes are determined by multiplying this number by each of the Group Sample 
Size Pattern numbers. If the Group Sample Size Pattern numbers are represented by m1, m2, m3, 
…, mk and this value is represented by n, the group sample sizes N1, N2, N3, ..., Nk are calculated 
as follows: 

N1=[n(m1)] 

N2=[n(m2)] 

N3=[n(m3)] 

etc. 

where the operator, [X] means the next integer after X, e.g. [3.1]=4. 

For example, suppose there are three groups and the Group Sample Size Pattern is set to 1,2,3. If 
n is 5, the resulting sample sizes will be 5, 10, and 15. If n is 50, the resulting group sample sizes 
will be 50, 100, and 150. If n is set to 2,4,6,8,10, five sets of group sample sizes will be generated 
and an analysis run for each. These sets are: 

2 4 6 
4 8 12 
6 12 18 
8 16 24 
10 20 30 

As a second example, suppose there are three groups and the Group Sample Size Pattern is 
0.2,0.3,0.5. When the fractional Pattern values sum to one, n can be interpreted as the total 
sample size of all groups and the Pattern values as the proportion of the total in each group.  

If n is 10, the three group sample sizes would be 2, 3, and 5. 

If n is 20, the three group sample sizes would be 4, 6, and 10. 

If n is 12, the three group sample sizes would be 

(0.2)12 = 2.4 which is rounded up to the next whole integer, 3. 

(0.3)12 = 3.6 which is rounded up to the next whole integer, 4. 

(0.5)12 = 6.  
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Note that in this case, 3+4+6 does not equal n (which is 12). This can happen because of 
rounding. 

Group Sample Size Pattern 
The purpose of the group sample size pattern is to allow several groups with the same sample size 
to be generated without having to type each individually. 

A set of positive, numeric values (one for each row of distributions) is entered here. Each item 
specified in this list applies to the whole row of distributions. For example, suppose the entry is 1 
2 1 and Grps 1 = 3, Grps 2 = 1, Grps 3 = 2. The sample size pattern used would be 1 1 1 2 1 1. 

The sample size of group i is found by multiplying the ith number from this list by the value of n 
and rounding up to the next whole number. The number of values must match the number of 
groups, g. When too few numbers are entered, 1’s are added. When too many numbers are 
entered, the extras are ignored. 

• Equal 
If all sample sizes are to be equal, enter Equal here and the desired sample size in n. A set of 
g 1's will be used. This will result in n1 = n2 = … = ng = n. That is, all sample sizes are equal 
to n.  

Effect Size 
These options specify the distributions to be used in the two simulations, one set per row. The 
first option specifies the number of groups represented by the two distributions that follow. The 
second option specifies the distribution to be used in simulating the null hypothesis to determine 
the significance level (alpha). The third option specifies the distribution to be used in simulating 
the alternative hypothesis to determine the power.  

Note that group number one is the control group. 

Grps [1 – 3] (Grps 4 – 9 are found on the Data 2 tab) 
This value specifies the number of groups specified by the H0 and H1 distribution statements to 
the right. Usually, you will enter ‘1’ to specify a single H0 and a single H1 distribution, or you 
will enter ‘0’ to indicate that the distributions specified on this line are to be ignored. This option 
lets you easily specify many identical distributions with a single phrase. 

The total number of groups g is equal to the sum of the values for the three rows of distributions 
shown under the Data1 tab and the six rows of distributions shown under the Data2 tab. 

Note that each item specified in the Group Sample Size Pattern option applies to the whole row 
of entries here. For example, suppose the Group Sample Size Pattern was 1 2 1 and Grps 1 = 3, 
Grps 2 = 1, and Grps 3 = 2. The sample size pattern would be 1 1 1 2 1 1.  

Note that since the first group is the control group, the value for Grps 1 is usually set to one. 

Group Distribution(s)|H0 
This entry specifies the distribution of one or more groups under the null hypothesis, H0. The 
magnitude of the differences of the means of these distributions, which is often summarized as 
the standard deviation of the means, represents the magnitude of the mean differences specified 
under H0. Usually, the means are assumed to be equal under H0, so their standard deviation 
should be zero except for rounding.  
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These distributions are used in the simulations that estimate the actual significance level. They 
also specify the value of the mean under the null hypothesis, H0. Usually, these distributions will 
be identical. The parameters of each distribution are specified using numbers or letters. If letters 
are used, their values are specified in the boxes below. The value M0 is reserved for the value of 
the mean under the null hypothesis.  

Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean is entered 
first. 

Beta=A(M0,A,B,Minimum) 
Binomial=B(M0,N) 
Cauchy=C(M0,Scale) 
Constant=K(Value) 
Exponential=E(M0) 
F=F(M0,DF1) 
Gamma=G(M0,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M0,SD) 
Poisson=P(M0) 
Student's T=T(M0,D) 
Tukey's Lambda=L(M0,S,Skewness,Elongation) 
Uniform=U(M0,Minimum) 
Weibull=W(M0,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Finding the Value of the Mean of a Specified Distribution 
Except for the multinomial distribution, the distributions have been parameterized in terms of 
their means since this is the parameter being tested. The mean of a distribution created as a linear 
combination of other distributions is found by applying the linear combination to the individual 
means. However, the mean of a distribution created by multiplying or dividing other distributions 
is not necessarily equal to applying the same function to the individual means. For example, the 
mean of 4N(4, 5) + 2N(5, 6) is 4*4 + 2*5 = 26, but the mean of 4N(4, 5) * 2N(5, 6) is not exactly 
4*4*2*5 = 160 (although it is close). 

Group Distribution(s)|H1 
Specify the distribution of this group under the alternative hypothesis, H1. This distribution is 
used in the simulation that determines the power. A fundamental quantity in a power analysis is 
the amount of variation among the group means. In fact, classical power analysis formulas, this 
variation is summarized as the standard deviation of the means.  

The important point to realize is that you must pay particular attention to the values you give to 
the means of these distributions because they are fundamental to the interpretation of the 
simulation. 

For convenience in specifying a range of values, the parameters of the distribution can be 
specified using numbers or letters. If letters are used, their values are specified in the boxes 
below. The value M1 is reserved for the value of the mean under the alternative hypothesis.  
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Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean, M1, is 
entered first. 

Beta=A(M1,A,B,Minimum) 
Binomial=B(M1,N) 
Cauchy=C(M1,Scale) 
Constant=K(Value) 
Exponential=E(M1) 
F=F(M1,DF1) 
Gamma=G(M1,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M1,SD) 
Poisson=P(M1) 
Student's T=T(M1,D) 
Tukey's Lambda=L(M1,S,Skewness,Elongation) 
Uniform=U(M1,Minimum) 
Weibull=W(M1,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Equivalence Margin 
Specify the largest difference for which means from different groups will be considered equal. 
When specifying group distributions, it is possible to end up with scenarios where some means 
are slightly different from each other, even though they are intended to be equivalent. This often 
happens when specifying distributions of different forms (e.g. normal and gamma) for different 
groups, where the means are intended to be the same. The parameters used to specify different 
distributions do not always result in means that are EXACTLY equal. This value lets you control 
how different means can be and still be considered equal. 

This value is not used to specify the hypothesized mean differences of interest. The hypothesized 
differences are specified using the means (or parameters used to calculate means) for the null and 
alternative distributions. 

This value should be MUCH smaller than the hypothesized mean differences. 

Effect Size – Distribution Parameters 

M0 (Mean|H0) 
These values are substituted for M0 in the distribution specifications given above. M0 is intended 
to be the value of the mean hypothesized by the null hypothesis, H0. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 

M1 (Mean|H1) 
These values are substituted for M1 in the distribution specifications given above. Although it can 
be used wherever you want, M1 is intended to be the value of the mean hypothesized by the 
alternative hypothesis, H1. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 
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Parameter Values (S, A, B, C) 
Enter the numeric value(s) of the parameters listed above. These values are substituted for the 
corresponding letter in all four distribution specifications. 

You can enter a list of values for each letter using the syntax 0 1 2 3 or 0 to 3 by 1. 

You can also change the letter that is used as the name of this parameter using the pull-down 
menu to the side. 

Test 

MC Procedure 
Specify which pair-wise multiple comparison procedure is to be reported from the simulations. 
The choices are 

• Dunnett Test 
This is the most popular and the most often recommended. 

• Kruskal-Wallis 
This is recommended when a nonparametric procedure is wanted. 

Simulations 

Simulations 
This option specifies the number of iterations, M, used in the simulation. As the number of 
iterations is increased, the running time and accuracy are increased as well. 

The precision of the simulated power estimates are calculated using the binomial distribution. 
Thus, confidence intervals may be constructed for various power values. The following table 
gives an estimate of the precision that is achieved for various simulation sizes when the power is 
either 0.50 or 0.95. The table values are interpreted as follows: a 95% confidence interval of the 
true power is given by the power reported by the simulation plus and minus the ‘Precision’ 
amount given in the table. 
  

 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
   

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power 
is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a small 
amount of additional accuracy achieved.  
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Reports Tab 
The Reports tab contains settings about the format of the output. 

Select Output – Numeric Reports 

Show Various Reports & Plots 
These options let you specify whether you want to generate the standard reports and plots. 

Show Inc’s & 95% C.I. 
Checking this option causes an additional line to be printed showing a 95% confidence interval 
for both the power and actual alpha and half the width of the confidence interval (the increment). 

Select Output – Plots 

Show Comparative Reports & Plots 
These options let you specify whether you want to generate reports and plots that compare the test 
statistics that are available. 

Options Tab 
The Options tab contains limits on the number of iterations and various options about individual 
tests. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the sample size is aborted. When 
the maximum number of iterations is reached without convergence, the sample size is left blank. 
We recommend a value of at least 500. 

Random Numbers 

Random Number Pool Size 
This is the size of the pool of values from which the random samples will be drawn. Pools should 
be at least the maximum of 10,000 and twice the number of simulations. You can enter Automatic 
and an appropriate value will be calculated. 

If you do not want to draw numbers from a pool, enter 0 here. 
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Example 1 – Power at Various Sample Sizes 
An experiment is being designed to compare the responses of three different treatments to a 
control. Previous studies have shown that the standard deviation within a group is 3.0. 
Researchers want to detect a shift in the mean of at least 2.0. To accomplish this, they set the 
mean of the control group to zero and the three treatment means to 2.0. They want to investigate 
sample sizes of 5, 10, 15, and 20 subjects per group.   

Their primary analysis will be a set of Dunnett multiple comparison tests. They set the FWER to 
0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons of Treatments vs. a Control 
(Simulation) procedure window by expanding Means, then ANOVA, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons of Treatments vs. a Control 
(Simulation). You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 5 10 15 20 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 1 
Control Distribution | H0 .......................... N(M0 S) 
Control Distribution | H1 .......................... N(M0 S) 
Grps 2 ...................................................... 3 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.1 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 2 
S .............................................................. 3 
MC Procedure ......................................... Dunnett 
Simulations .............................................. 2000 

Report Tab 
All reports except Comparative ............... checked 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Simulation Summary Report  
 

Summary of Simulations of the Control Group and the 3 Treatment Groups 
MC Procedure: Dunnett’s M.C. Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Pairs Size Size Pairs Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.187 5.0 20 0.016 0.9 3.0 0.055 0.050 0.0 2.0 3.0    
 (0.017) [0.170 0.204] (0.005) [0.010 0.021] (0.010) [0.045 0.064]     
 
2 0.358 10.0 40 0.045 0.9 3.0 0.050 0.050 0.0 2.0 3.0    
 (0.021) [0.337 0.379] (0.009) [0.036 0.054] (0.010) [0.040 0.059]     
 
3 0.507 15.0 60 0.098 0.9 3.0 0.042 0.050 0.0 2.0 3.0    
 (0.022) [0.485 0.529] (0.013) [0.085 0.111] (0.009) [0.033 0.051]     
 
4 0.623 20.0 80 0.162 0.9 3.0 0.045 0.050 0.0 2.0 3.0    
 (0.021) [0.602 0.644] (0.016) [0.145 0.178] (0.009) [0.035 0.054]     
 
Pool Size: 10000. Simulations: 2000. Run Time: 26.45 seconds. 
 
Summary of Simulations Report Definitions 
H0: the null hypothesis that each treatment mean is equal to the control mean. 
H1: the alternative hypothesis that at least one treatment mean differs from the control mean. 
Pair: each comparison of a treatment mean and a control mean is a 'pair'. 
All-Pairs Power: the estimated probability of detecting all unequal pairs. 
Any-Pairs Power: the estimated probability of detecting at least one unequal pair. 
n: the average of the group sample sizes. 
N: the combined sample size of all groups. 
Family-Wise Error Rate (FWER): the probability of detecting at least one equal pair assuming H0.  
Target FWER: the user-specified FWE.  
Actual FWER: the FWER estimated by the alpha simulation.  
Sm|H1: the standard deviation of the group means under H1. 
SD|H1: the pooled, within-group standard deviation under H1. 
Second Row: provides the precision and aconfidence interval based on the size of the simulation for  
Any-Pairs Power, All-Pairs Power, and FWER. The format is (Precision) [95% LCL and UCL Alpha]. 
 
Summary Statements 
A one-way design with 3 treatment groups and one control group has an average group sample size 
of 5.0 for a total sample size of 20. This design achieved an any-pair power of 0.187 and an 
all-pair power of 0.0155 using the Dunnett's Test procedure for comparing each treatment mean 
with the control mean. The target family-wise error rate was 0.050 and the actual family-wise 
error rate was 0.055. The average within group standard deviation assuming the alternative 
distribution is 3.0. These results are based on 2000 Monte Carlo samples from the null 
distributions: N(M0 S); N(M0 S); N(M0 S); and N(M0 S) and the alternative distributions: N(M0 
S); N(M1 S); N(M1 S); and N(M1 S). Other parameters used in the simulation were: M0 = 0.0, M1 = 
2.0, and S = 3.0. 
 

This report shows the estimated any-pairs power, all-pairs power, and FWER for each scenario. 
The second row shows three 95% confidence intervals in brackets: the first for the any-pairs 
power, the second for the all-pairs power, and the third for the FWER. Half the width of each 
confidence interval is given in parentheses as a fundamental measure of the precision of the 
simulation. As the number of simulations is increased, the width of the confidence intervals will 
decrease. 
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Any-Pairs Power 
This is the probability of detecting any of the significant pairs. This value is estimated by the 
simulation using the H1 distributions. 

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the estimated power. 

All-Pairs Power 
This is the probability of detecting all of the significant pairs. This value is estimated by the 
simulation using the H1 distributions. 

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the estimated power. 

Group Sample Size n 
This is the average of the individual group sample sizes. 

Total Sample Size N 
This is the total sample size of the study. 

S.D. of Means Sm|H1 
This is the standard deviation of the hypothesized means of the alternative distributions. Under 
the null hypothesis, this value is zero. This value represents the magnitude of the difference 
among the means that is being tested. It is roughly equal to the average difference between the 
group means and the overall mean.  

Note that the effect size is the ratio of Sm|H1 and SD|H1 

S.D. of Data SD|H1 
This is the within-group standard deviation calculated from samples from the alternative 
distributions.  

Actual FWER 
This is the value of FWER (family-wise error rate) estimated by the simulation using the H0 
distributions. It should be compared with the Target FWER to determine if the test procedure is 
accurate.  

Note that a precision value (half the width of its confidence interval) and a confidence interval are 
shown on the line below this row. These values provide the precision of the Actual FWER. 

Target FWER 
The target value of FWER.  

M0 
This is the value entered for M0, the group means under H0.  

M1 
This is the value entered for M1, the group means under H1. 

S 
This is the value entered for S, the standard deviation. 



Multiple Comparisons of Treatments vs. a Control (Simulation)  585-15 
 

Error-Rate Summary for H0 Simulation  
 

Error Rate Summary from H0 (Alpha) Simulation of 4 Groups 
MC Procedure: Dunnett’s M.C. Test 
    Prop.     
    (No. of     
  Mean  Type-1     
 No. of No. of Prop. Errors  Mean Min Max 
Sim. Equal Type-1 Type-1 > 0) Target Pairs Pairs Pairs 
No. Pairs Errors Errors FWER FWER Alpha Alpha Alpha 
1 3 0.067 0.022 0.055 0.050 0.022 0.020 0.025 
2 3 0.060 0.020 0.050 0.050 0.020 0.017 0.023 
3 3 0.048 0.016 0.042 0.050 0.016 0.016 0.017 
4 3 0.055 0.018 0.045 0.050 0.018 0.018 0.019 
 

This report shows the results of the H0 simulation. This simulation uses the H0 settings for each 
group. Its main purpose is to provide an estimate of the FWER. 

No. of Equal Pairs 
Since under H0 all means are equal, this is the number of unique pairs of the groups. Thus, this is 
the number of treatment groups. 

Mean No. of Type-1 Errors 
This is the average number of type-1 errors (false detections) per set (family). 

Prop. Type-1 Errors 
This is the proportion of type-1 errors (false detections) among all tests that were conducted. 

Prop. (No. of Type-1 Errors>0) FWER 
This is the proportion of the H0 simulations in which at least one type-1 error occurred. This is 
called the family-wise error rate. 

Target FWER 
This is the target value of FWER that was set by the user. 

Mean Pairs Alpha 
Alpha is the probability of rejecting H0 when H0 is true. It is a characteristic of an individual test. 
This is the average alpha value over all of the tests in the family. 

Min Pairs Alpha 
This is the minimum of all of the individual comparison alphas. 

Max Pairs Alpha 
This is the maximum of all of the individual comparison alphas. 
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Error-Rate Summary for H1 Simulation  
 

Error Rate Summary from H1 (Power) Simulation of 4 Groups 
MC Procedure: Dunnett’s M.C. Test 
       (FDR)       
     Prop. Prop. Prop. Prop.      
 No. of Mean Mean  Equal Uneq. Detect. Undet. All Any    
 Equal/ No. of No. of  that that that that Uneq. Uneq. Mean Min Max 
Sim. Uneq. False False Prop. were were were were Pairs Pairs Pairs Pairs Pairs 
No. Pairs Pos. Neg. Errors Detect. Undet. Equal Uneq. Power Power Power Power Power 
1 0/3 0.00 2.74 0.913 0.000 0.913 0.000 1.000 0.016 0.187 0.088 0.082 0.092 
2 0/3 0.00 2.45 0.816 0.000 0.816 0.000 1.000 0.045 0.358 0.184 0.182 0.188 
3 0/3 0.00 2.13 0.711 0.000 0.711 0.000 1.000 0.098 0.507 0.289 0.286 0.292 
4 0/3 0.00 1.84 0.613 0.000 0.613 0.000 1.000 0.162 0.623 0.388 0.380 0.392 
 

This report shows the results of the H1 simulation. This simulation uses the H1 settings for each 
group. Its main purpose is to provide an estimate of the power. 

No. of Equal Pairs/Unequal Pairs 
The first value is the number of pairs for which the control mean and the treatment mean were 
equal under H1. The second value is the number of pairs for which the means were different 
under H1. 

Mean No. False Positives 
This is the average number of equal pairs that were declared as being unequal by the testing 
procedure. A false positive is a type-1 (alpha) error. 

Mean No. False Negatives 
This is the average number of unequal pairs that were not declared as being unequal by the testing 
procedure. A false negative is a type-2 (beta) error. 

Prop. Errors 
This is the proportion of type-1 and type-2 errors. 

Prop. Equal that were Detect. 
This is the proportion of the equal pairs in the H1 simulations that were declared as unequal. 

Prop. Uneq. that were Undet. 
This is the proportion of the unequal pairs in the H1 simulations that were not declared as being 
unequal. 

Prop. Detect. that were Equal (FDR) 
This is the proportion of detected pairs in the H1 simulations that were actually equal. This is 
often called the false discovery rate. 

Prop. Undet. that were Uneq. 
This is the proportion of undetected pairs in the H1 simulations that were actually unequal.  

All Uneq. Pairs Power 
This is the probability of detecting all of the pairs that were different in the H1 simulation. 

Any Uneq. Pairs Power 
This is the probability of detecting any of the pairs that were different in the H1 simulation. 
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Mean, Min, and Max Pairs Power 
These items give the average, the minimum, and the maximum of the individual comparison 
powers from the H1 simulation. 

Detail Model Report 
 

Detailed Model Report for Simulation No. 1 
Target FWER = 0.050, M0 = 0.0, M1 = 2.0, S = 3.0 
MC Procedure: Dunnett’s M.C. Test 
 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1 Cntl 5/20 0.0 3.0 N(M0 S) 
H0 2-4 B1-B3 5/20 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1 Cntl 5/20 0.0 3.0 N(M0 S) 
H1 2-4 B1-B3 5/20 2.0 3.0 N(M1 S) 
H1 All   Sm=0.9 3.0  
 
Detailed Model Report for Simulation No. 2 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1 Cntl 10/40 0.0 3.0 N(M0 S) 
H0 2-4 B1-B3 10/40 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1 Cntl 10/40 0.0 3.0 N(M0 S) 
H1 2-4 B1-B3 10/40 2.0 3.0 N(M1 S) 
H1 All   Sm=0.9 3.0  
 
Detailed Model Report for Simulation No. 3 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1 Cntl 15/60 0.0 3.0 N(M0 S) 
H0 2-4 B1-B3 15/60 0.0 3.1 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1 Cntl 15/60 0.0 2.9 N(M0 S) 
H1 2-4 B1-B3 15/60 2.0 3.0 N(M1 S) 
H1 All   Sm=0.9 3.0  
 
Detailed Model Report for Simulation No. 4 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1 Cntl 20/80 0.0 3.0 N(M0 S) 
H0 2-4 B1-B3 20/80 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1 Cntl 20/80 0.0 3.0 N(M0 S) 
H1 2-4 B1-B3 20/80 2.0 3.0 N(M1 S) 
H1 All   Sm=0.9 3.0  
 

This report shows details of each row of the previous reports. 

Hypo. Type 
This indicates which simulation is being reported on each row. H0 represents the null simulation 
and H1 represents the alternative simulation. 

Groups 
Each group in the simulation is assigned a number. This item shows the arbitrary group number 
that was assigned. 



585-18  Multiple Comparisons of Treatments vs. a Control (Simulation) 

Group Labels 
These are the labels that were used in the individual alpha-level reports. Note that the control 
group is labeled ‘Cntl’. 

n/N 
n is the average sample size of the groups. N is the total sample size across all groups. 

Group Mean 
These are the means of the individual groups as specified for the H0 and H1 simulations. 

Ave. S.D. 
This is the average standard deviation of all groups reported on each line. Note that it is 
calculated from the simulated data. 

Simulation Model 
This is the distribution that was used to simulate data for the groups reported on each line. 

Probability of Rejecting Equality  
 

Probability of Rejecting the Equality of Each Pair. Simulation No. 1 
 
Group Means Cntl B1 B2 B3 
Cntl 0.0  0.082* 0.092* 0.090* 
B1 2.0 0.025    
B2 2.0 0.020    
B3 2.0 0.022 
 
Probability of Rejecting the Equality of Each Pair. Simulation No. 2 
 
Group Means Cntl B1 B2 B3 
Cntl 0.0  0.188* 0.184* 0.182* 
B1 2.0 0.023    
B2 2.0 0.020    
B3 2.0 0.017    
 
Probability of Rejecting the Equality of Each Pair. Simulation No. 3 
 
Group Means Cntl B1 B2 B3 
Cntl 0.0  0.292* 0.286* 0.289* 
B1 2.0 0.016    
B2 2.0 0.016    
B3 2.0 0.017    
  
Probability of Rejecting the Equality of Each Pair. Simulation No. 4 
 
Group Means Cntl B1 B2 B3 
Cntl 0.0  0.392* 0.380* 0.392* 
B1 2.0 0.019    
B2 2.0 0.018    
B3 2.0 0.018    
 
Individual pairwise powers from the H1 (Power) simulation are shown in the upper-right section. 
Individual pairwise significance levels from the H0 (Alpha) simulation are shown in the lower-left section. 
* Starred values are the powers of pairs that are unequal under H1. 
 

This report shows the individual probabilities of rejecting each pair. When a pair was actually 
different, the value is the power of that test. These power values are starred.  
The results shown on the upper-right section of each simulation report are from the H1 
simulation. The results shown on the lower-left section of the report are from the H0 simulation. 



Multiple Comparisons of Treatments vs. a Control (Simulation)  585-19 
 

Plots Section 
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These plots give a visual presentation of the all-pairs power values and the any-pair power values. 

Example 2 – Comparative Results 
Continuing with Example 1, the researchers want to study the characteristics of alternative 
multiple comparison procedures.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons of Treatments vs. a Control 
(Simulation) procedure window by expanding Means, then ANOVA, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons of Treatments vs. a Control 
(Simulation). You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 5 10 15 20 
Group Sample Size Pattern .................... Equal 
Grps 1...................................................... 1 
Control Distribution | H0 .......................... N(M0 S) 
Control Distribution | H1 .......................... N(M0 S) 
Grps 2...................................................... 3 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.1 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 2 
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Data Tab (continued) 
S .............................................................. 3 
MC Procedure ......................................... Dunnett 
Simulations .............................................. 2000 

Reports Tab 
Comparative Reports .............................. Checked 
Comparative Any-Pair Power Plot .......... Checked 
Comparative All-Pair Power Plot ............. Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Power Comparison for Testing the Control Group Versus the 3 Treatment Groups 
 
    Kruskal  Kruskal   
 Total  Dunnett Wallis Dunnett Wallis   
Sim. Sample Target All-Pair All-Pair All-Pair Any-Pair   
No. Size Alpha Power Power Power Power   
1 20 0.050 0.016 0.002 0.187 0.155       
2 40 0.050 0.045 0.018 0.358 0.309       
3 60 0.050 0.098 0.056 0.507 0.474       
4 80 0.050 0.162 0.117 0.623 0.581       
Pool Size: 10000. Simulations: 2000. Run Time: 26.18 seconds. 
 
Family-Wise FWER Comparison for Testing the Control Group Versus the 3 Treatment Groups 
 
 Total   Kruskal    
Sim. Sample Target Dunnett Wallis    
No. Size FWER FWER FWER    
1 20 0.050 0.055 0.044         
2 40 0.050 0.050 0.040         
3 60 0.050 0.042 0.034         
4 80 0.050 0.045 0.038         
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These reports show the power and FWER of both of the multiple comparison procedures. In these 
simulations of groups from the normal distributions with equal variances, we see that the 
Dunnett’s procedure is the champion. 
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Example 3 – Validation using Dunnett 
Murkerjee, Robertson, and Wright (1987) page 909 present an example of a sample size 
calculation which was first discussed on page 1116 of Dunnett (1955). In this example there are 
five treatments and one control. The control mean and four of the treatment means are the same, 
while the fifth treatment mean is different.   

The value of the within-group standard deviation is 1.0. Four treatment means and the control 
mean are -0.182574 and the fifth treatment mean is 0.912871. The FWER is 0.05 in the article, 
but this is for a one-sided test. Since PASS is finding the power for two-sided tests, we set FWER 
at 0.10. When the per-group sample size is 16, the all-pairs power is 0.80. When the per-group 
sample size is 21, the all-pairs power is 0.90. Note that since there is only one treatment that is 
different from the control, the all-pairs power is equal to the any-pairs power.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Comparisons of Treatments vs. a Control 
(Simulation) procedure window by expanding Means, then ANOVA, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons of Treatments vs. a Control 
(Simulation). You may then make the appropriate entries as listed below, or open Example 3 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.10 
n (Sample Size Multiplier) ....................... 16 21 
Group Sample Size Pattern .................... Equal 
Grps 1...................................................... 1 
Control Distribution(s) | H0 ...................... N(M0 S) 
Control Distribution(s) | H1 ...................... N(M0 S) 
Grps 2...................................................... 1 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Grps 3...................................................... 4 
Group 3 Distribution(s) | H0 .................... N(M0 S) 
Group 3 Distribution(s) | H1 .................... N(M0 S) 
Equivalence Margin ................................. 0.01 
M0 (Mean|H0) ......................................... -0.182574 
M1 (Mean|H1) ......................................... 0.912871 
S .............................................................. 1.0 
MC Procedure ......................................... Dunnett 
Simulations .............................................. 2000 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Summary of Simulations of the Control Group and the 5 Treatment Groups 
MC Procedure: Dunnett’s M.C. Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Pairs Size Size Pairs Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.795 16.0 96 0.795 0.4 1.0 0.095 0.100 -0.2 0.9 1.0    
 (0.018) [0.777 0.812] (0.018) [0.777 0.812] (0.013) [0.082 0.107]     
 
2 0.894 21.0 126 0.894 0.4 1.0 0.112 0.100 -0.2 0.9 1.0    
 (0.014) [0.880 0.907] (0.014) [0.880 0.907] (0.014) [0.098 0.125]     
 
Pool Size: 10000. Simulations: 1000. Run Time: 4.28 seconds. 

 
For the first case when n = 16, PASS obtained a power of 0.795 which is very close to the value 
of 0.80 found by Muterjee et al. (1987). Indeed, 0.80 is within the confidence limits of 0.777 to 
0.812. Similarly, the power for the second case when n = 21 is found as 0.894 which is very close 
to the article’s value of 0.90. 
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Chapter 590 

Multiple Contrasts 
(Simulation) 
Introduction 
This procedure uses simulation to analyze the power and significance level of two multiple-
comparison procedures that perform two-sided hypothesis tests of contrasts of the group means. 
These are the Dunn-Bonferroni test and the Dunn-Welch test. For each scenario, two simulations 
are run: one estimates the significance level and the other estimates the power.  

The term contrast refers to a user-defined comparison of the group means. The term multiple 
contrasts refers to a set of such comparisons. An additional restriction imposed is that the contrast 
coefficients to sum to zero. 

When several contrasts are tested, the interpretation of the results is more complex because of the 
problem of multiplicity. Multiplicity here refers to the fact that the probability of making at least 
one incorrect decision increases as the number of statistical tests increases. Methods for testing 
multiple contrasts have been developed to account for this multiplicity.  

Error Rates 
When dealing with several simultaneous statistical tests, both individual-wise and experiment 
wise error rates should be considered.      

1. Comparison-wise error rate. This is the probability of a type-I error (rejecting a true 
H0) for a particular test. In the case of the five-group design, there are ten possible 
comparison-wise error rates, one for each of the ten possible pairs. We will denote this 
error rate αc . 

2. Experiment-wise (or family-wise) error rate. This is the probability of making one or 
more type-I errors in the set (family) of comparisons. We will denote this error rate α f .  

The relationship between these two error rates when the tests are independent is given by 

α αf c
C= − −1 1( )  

where C is the total number of contrasts. For example, if αc is 0.05 and C is 10, α f is 0.401. 
There is about a 40% chance that at least one of the ten contrasts will be concluded to be non-zero 
when in fact they are not. When the tests are correlated, as they might be among a set of contrasts, 
the above formula provides an upper bound to the family-wise error rate. 

The techniques described below provide control for α f  rather than αc . 
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Technical Details 

The One-Way Analysis of Variance Design 
The discussion that follows is based on the common one-way analysis of variance design which 
may be summarized as follows. Suppose the responses Y  in k groups each follow a normal 

distribution with means
ij

μ μ μ1 2, , ,L k  and unknown variance . Let n n  denote the 
number of subjects in each group. The control group is assumed to be group one. 
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The F test is the usual method of analysis of the data from such a design, testing whether all of 
the means are equal. However, a significant F test does not indicate which of the groups are 
different, only that at least one is different. The analyst is left with the problem of determining 
which of the groups are different and by how much.  

To determine the mean differences that are most importance, the researcher may specify a set of 
contrasts. These contrasts, called a priori, or, planned, contrasts should be specified before the 
experimental results are viewed.  

The Dunn-Bonferroni procedure and the Dunn-Welch procedure have been developed to test 
these planned contrasts. The calculations associated with each of these tests are given below. 

Contrasts 
A contrast of the means is a stated difference among the means. The difference is constructed so 
that it represents a useful hypothesis. For example, suppose there are four groups, the first of 
which is a control group. It might be of interest to determine which treatments are statistically 
different from the control. That is, the differences μ μ2 1− , μ μ3 1− , and μ μ4 1−  would be 
tested to determine if they are non-zero.  

Contrasts are often simple differences between two means. However, they may involve more than 
just two means. For example, suppose the first two groups receive one treatment and the second 
two groups receive another treatment. The contrast (difference) that would be tested is 
( ) ( )μ μ μ μ1 2 3 4+ − + .  

Every contrast can be represented by the list of contrast coefficients: the values by which the  
means are multiplied. Here are some examples of contrasts that might be of interest when the 
experiment involves four groups. 
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Difference Coefficients 
μ μ2 1−  -1, 1, 0, 0 
μ μ3 1−  -1, 0, 1, 0 
( ) ( )μ μ μ μ1 2 3 4+ − +  1, 1, -1, -1 

( ) ( )μ μ μ μ μ μ1 1 1 2 3 4+ + − + +  3, -1, -1, -1 

( ) ( )μ μ μ μ4 4 2 3+ − +  0, -1, -1, 2 
 

Note that in each case, the coefficients sum to zero. This makes it possible to test whether the 
quantity is different from zero. 

A lot is written about orthogonal contrasts which have the property that the sum of the products 
of corresponding coefficients is zero. For example, the sum of the products of the last two 
contrasts given above is 0(3) + (-1)(-1) + (-1)(-1) + (2)(-1) = 0 + 1 + 1 – 2 = 0, so these two 
contrasts are orthogonal. However, the first two contrasts are not orthogonal since (-1)(-1) + 
(1)(0) + (0)(1) + (0)(0) = 1 + 0 + 0 + 0 = 1 (not zero). Orthogonal contrasts have nice properties 
when the sample sizes are equal. Unfortunately, they lose those properties when the group sample 
sizes are unequal or when the data are not normally distributed. 

The procedures described in this chapter do not require that the contrasts be orthogonal. Instead, 
you should focus on defining a set of contrasts that answer the research questions of interest.  

Dunn-Bonferroni Test 
Dunn (1964) developed a procedure for simultaneously testing several contrasts. This method is 
also discussed in Kirk (1982) pages 106 to 109. The method consists of testing each contrast with 
Student’s t distribution with degrees of freedom equal to N-k with a Bonferroni adjustment of the 
alpha value. That is, the alpha value is divided by C, the number of contrasts simultaneously 
tested.  

The test rejects H0 if  
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Dunn-Welch Test 
Dunn (1964) developed a procedure for simultaneously testing several contrasts. This method, 
using Welch’s (1947) modification for the unequal variances, is discussed in Kirk (1982) pages 
100, 101, 106 - 109. The method consists of testing each contrast with Student’s t distribution 
with degrees of freedom given below with a Bonferroni adjustment of the alpha value. That is, the 
alpha value is divided by C, the number of contrasts simultaneously tested. 
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The two-sided test statistic rejects H0 if  
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Definition of Power for Multiple Contrasts 
The notion of power is well-defined for individual tests. Power is the probability of rejecting a 
false null hypothesis. However, this definition does not extend directly when there are a number 
of simultaneous tests. The two definitions that we emphasize in PASS where recommended by 
Ramsey (1978). They are any-contrast power and all-contrasts power. Other design 
characteristics, such as average-contrast power and false-discovery rate, are important to 
consider. However, our review of the statistical literature resulted in our focus on these two 
definitions of power.  

Any-Contrast Power 
Any-contrast power is the probability of detecting at least one of the contrasts that are actually 
non-zero.  

All-Contrasts Power 
All-contrast power is the probability of detecting all of the contrasts that are actually non-zero.  

Simulation Details 
Computer simulation allows us to estimate the power and significance level that is actually achieved 
by a test procedure in situations that are not mathematically tractable. Computer simulation was 
once limited to mainframe computers. But, in recent years, as computer speeds have increased, 
simulation studies can be completed on desktop and laptop computers in a reasonable period of 
time.  

The steps to a simulation study are  

1. Specify how each test is to be carried out. This includes indicating how the test statistic is 
calculated and how the significance level is specified. 

2. Generate random samples from the distributions specified by the alternative hypothesis. 
Calculate the test statistics from the simulated data and determine if the null hypothesis is 
accepted or rejected. The number rejected is used to calculate the power of each test.  
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3. Generate random samples from the distributions specified by the null hypothesis. Calculate 
each test statistic from the simulated data and determine if the null hypothesis is accepted or 
rejected. The number rejected is used to calculate the significance level of each test.  

4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated 
data leads to a rejection of the null hypothesis. The power is the proportion of simulated 
samples in step 2 that lead to rejection. The significance level is the proportion of simulated 
samples in step 3 that lead to rejection. 

Generating Random Distributions 
Two methods are available in PASS to simulate random samples. The first method generates the 
random variates directly, one value at a time. The second method generates a large pool (over 
10,000) of random values and then draws the random numbers from this pool. This second method 
can cut the running time of the simulation by 70%! 

As mentioned above, the second method begins by generating a large pool of random numbers from 
the specified distributions. Each of these pools is evaluated to determine if its mean is within a small 
relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of the 
target mean, individual members of the population are replaced with new random numbers if the 
new random number moves the mean towards its target. Only a few hundred such swaps are 
required to bring the actual mean to within tolerance of the target mean. This population is then 
sampled with replacement using the uniform distribution. We have found that this method works 
well as long as the size of the pool is the maximum of twice the number of simulated samples 
desired and 10,000.  

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Reports, and Options tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data 1 Tab 
The Data 1 tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for: power or sample size (n). If you choose to 
solve for n, you must choose the type of power you want to solve for: any-contrast power or all-
contrasts power. The value of the option Power will then represent this type of power. 

Any-contrast power is the probability of detecting at least one of the non-zero contrasts. All-
contrast power is the probability of detecting all non-zero contrasts. 

Note that the search for n may take several minutes because a separate simulation must be run for 
each trial value of n. You may find it quicker and more informative to solve for the Power for a 
range of sample sizes. 
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Error Rates 

Power or Beta 
This option is only used when Find (Solve For) is set to n (All-Contrast) or n (Any-Contrast).   

Power is defined differently with multiple contrasts. Although many definitions are possible, two 
are adopted here. Any-contrast power is the probability of detecting at least one non-zero contrast. 
All-contrasts power is the probability of detecting all non-zero contrasts. As the number of 
contrasts is increased, these power probabilities will decrease because more tests are being 
conducted. 

Since this is a probability, the range is between 0 and 1. Most researchers would like to have the 
power at least at 0.8. However, this may require extremely large sample sizes when the number of 
tests is large.  

FWER (Alpha) 
This option specifies one or more values of the family-wise error rate (FWER) which is the 
analog of alpha for multiple contrasts. FWER is the probability of falsely detecting (concluding 
that the means are different) at least one comparison for which the true means are the same. For 
independent tests, the relationship between the individual-comparison error rate (ICER) and 
FWER is given by the formulas 

FWER = 1 - (1 - ICER)^C 

or 

ICER = 1 - (1 - FWER)^(1/C) 

where '^' represents exponentiation (as in 4^2 = 16) and C represents the number of comparisons. 
For example, if C = 5 and FWER = 0.05, then ICER = 0.0102. Thus, the individual comparison 
tests must be conducted using a Type-1 error rate of 0.0102, which is much lower than the 
family-wise rate of 0.05. 

The popular value for FWER remains at 0.05. However, if you have a large number of 
comparisons, you might decide that a larger value, such as 0.10, is appropriate. 

Sample Size 

n (Sample Size Multiplier) 
This is the base, per group, sample size. One or more values separated by blanks or commas may 
be entered. A separate analysis is performed for each value listed here. 

The group samples sizes are determined by multiplying this number by each of the Group Sample 
Size Pattern numbers. If the Group Sample Size Pattern numbers are represented by m1, m2, m3, 
…, mk and this value is represented by n, the group sample sizes N1, N2, N3, ..., Nk are calculated 
as follows: 

N1=[n(m1)] 

N2=[n(m2)] 

N3=[n(m3)] 

etc. 

where the operator, [X] means the next integer after X, e.g. [3.1]=4. 
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For example, suppose there are three groups and the Group Sample Size Pattern is set to 1,2,3. If 
n is 5, the resulting sample sizes will be 5, 10, and 15. If n is 50, the resulting group sample sizes 
will be 50, 100, and 150. If n is set to 2,4,6,8,10, five sets of group sample sizes will be generated 
and an analysis run for each. These sets are: 

2 4 6 
4 8 12 
6 12 18 
8 16 24 
10 20 30 

As a second example, suppose there are three groups and the Group Sample Size Pattern is 
0.2,0.3,0.5. When the fractional Pattern values sum to one, n can be interpreted as the total 
sample size of all groups and the Pattern values as the proportion of the total in each group.  

If n is 10, the three group sample sizes would be 2, 3, and 5. 

If n is 20, the three group sample sizes would be 4, 6, and 10. 

If n is 12, the three group sample sizes would be 

(0.2)12 = 2.4 which is rounded up to the next whole integer, 3. 

(0.3)12 = 3.6 which is rounded up to the next whole integer, 4. 

(0.5)12 = 6.  

Note that in this case, 3+4+6 does not equal n (which is 12). This can happen because of 
rounding. 

Group Sample Size Pattern 
The purpose of the group sample size pattern is to allow several groups with the same sample size 
to be generated without having to type each individually. 

A set of positive, numeric values (one for each row of distributions) is entered here. Each item 
specified in this list applies to the whole row of distributions. For example, suppose the entry is 1 
2 1 and Grps 1 = 3, Grps 2 = 1, Grps 3 = 2. The sample size pattern used would be 1 1 1 2 1 1. 

The sample size of group i is found by multiplying the ith number from this list by the value of n 
and rounding up to the next whole number. The number of values must match the number of 
groups, g. When too few numbers are entered, 1’s are added. When too many numbers are 
entered, the extras are ignored. 

• Equal 
If all sample sizes are to be equal, enter Equal here and the desired sample size in n. A set of 
g 1's will be used. This will result in n1 = n2 = … = ng = n. That is, all sample sizes are equal 
to n.  

Effect Size 
These options specify the distributions to be used in the two simulations. The first option 
specifies the number of groups represented by the two distributions that follow. The second 
option specifies the distribution to be used in simulating the null hypothesis to determine the 
significance level (alpha). The third option specifies the distribution to be used in simulating the 
alternative hypothesis to determine the power.  



590-8  Multiple Contrasts (Simulation) 

Grps [1 – 3] (Grps 4 – 9 are found on the Data 2 tab) 
This value specifies the number of groups specified by the H0 and H1 distribution statements to 
the right. Usually, you will enter ‘1’ to specify a single H0 and a single H1 distribution, or you 
will enter ‘0’ to indicate that the distributions specified on this line are to be ignored. This option 
lets you easily specify many identical distributions with a single phrase. 

The total number of groups g is equal to the sum of the values for the three rows of distributions 
shown under the Data1 tab and the six rows of distributions shown under the Data2 tab. 

Note that each item specified in the Group Sample Size Pattern option applies to the whole row 
of entries here. For example, suppose the Group Sample Size Pattern was 1 2 1 and Grps 1 = 3, 
Grps 2 = 1, and Grps 3 = 2. The sample size pattern would be 1 1 1 2 1 1.  

Group Distribution(s)|H0 
This entry specifies the distribution of one or more groups under the null hypothesis, H0. The 
magnitude of the differences of the means of these distributions, which is often summarized as 
the standard deviation of the means, represents the magnitude of the mean differences specified 
under H0. Usually, the means are assumed to be equal under H0, so their standard deviation 
should be zero except for rounding.  

These distributions are used in the simulations that estimate the actual significance level. They 
also specify the value of the mean under the null hypothesis, H0. Usually, these distributions will 
be identical. The parameters of each distribution are specified using numbers or letters. If letters 
are used, their values are specified in the boxes below. The value M0 is reserved for the value of 
the mean under the null hypothesis.  

Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean is entered 
first. 

Beta=A(M0,A,B,Minimum) 
Binomial=B(M0,N) 
Cauchy=C(M0,Scale) 
Constant=K(Value) 
Exponential=E(M0) 
F=F(M0,DF1) 
Gamma=G(M0,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M0,SD) 
Poisson=P(M0) 
Student's T=T(M0,D) 
Tukey's Lambda=L(M0,S,Skewness,Elongation) 
Uniform=U(M0,Minimum) 
Weibull=W(M0,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Finding the Value of the Mean of a Specified Distribution 
Except for the multinomial distribution, the distributions have been parameterized in terms of 
their means since this is the parameter being tested. The mean of a distribution created as a linear 
combination of other distributions is found by applying the linear combination to the individual 
means. However, the mean of a distribution created by multiplying or dividing other distributions 
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is not necessarily equal to applying the same function to the individual means. For example, the 
mean of 4N(4, 5) + 2N(5, 6) is 4*4 + 2*5 = 26, but the mean of 4N(4, 5) * 2N(5, 6) is not exactly 
4*4*2*5 = 160 (although it is close). 

Group Distribution(s)|H1 
Specify the distribution of this group under the alternative hypothesis, H1. This distribution is 
used in the simulation that determines the power. A fundamental quantity in a power analysis is 
the amount of variation among the group means. In fact, classical power analysis formulas, this 
variation is summarized as the standard deviation of the means.  

The important point to realize is that you must pay particular attention to the values you give to 
the means of these distributions because they are fundamental to the interpretation of the 
simulation. 

For convenience in specifying a range of values, the parameters of the distribution can be 
specified using numbers or letters. If letters are used, their values are specified in the boxes 
below. The value M1 is reserved for the value of the mean under the alternative hypothesis.  

Following is a list of the distributions that are available and the syntax used to specify them. Note 
that, except for the multinomial, the distributions are parameterized so that the mean, M1, is 
entered first. 

Beta=A(M1,A,B,Minimum) 
Binomial=B(M1,N) 
Cauchy=C(M1,Scale) 
Constant=K(Value) 
Exponential=E(M1) 
F=F(M1,DF1) 
Gamma=G(M1,A) 
Multinomial=M(P1,P2,…,Pk) 
Normal=N(M1,SD) 
Poisson=P(M1) 
Student's T=T(M1,D) 
Tukey's Lambda=L(M1,S,Skewness,Elongation) 
Uniform=U(M1,Minimum) 
Weibull=W(M1,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Equivalence Margin 
Specify the largest difference for which means from different groups will be considered equal. 
When specifying group distributions, it is possible to end up with scenarios where some means 
are slightly different from each other, even though they are intended to be equivalent. This often 
happens when specifying distributions of different forms (e.g. normal and gamma) for different 
groups, where the means are intended to be the same. The parameters used to specify different 
distributions do not always result in means that are EXACTLY equal. This value lets you control 
how different means can be and still be considered equal. 

This value is not used to specify the hypothesized mean differences of interest. The hypothesized 
differences are specified using the means (or parameters used to calculate means) for the null and 
alternative distributions. 

This value should be MUCH smaller than the hypothesized mean differences. 
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Effect Size – Distribution Parameters 

M0 (Mean|H0) 
These values are substituted for M0 in the distribution specifications given above. M0 is intended 
to be the value of the mean hypothesized by the null hypothesis, H0. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 

M1 (Mean|H1) 
These values are substituted for M1 in the distribution specifications given above. Although it can 
be used wherever you want, M1 is intended to be the value of the mean hypothesized by the 
alternative hypothesis, H1. 

You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1. 

Parameter Values (S, A, B, C) 
Enter the numeric value(s) of the parameters listed above. These values are substituted for the 
corresponding letter in all four distribution specifications. 

You can enter a list of values for each letter using the syntax 0 1 2 3 or 0 to 3 by 1. 

You can also change the letter that is used as the name of this parameter using the pull-down 
menu to the side. 

Test 

MC Procedure 
Specify which multiple contrast procedure is to be reported from the simulations. The choices are 

• Dunn-Bonferroni Test 
This is the most popular and most often recommended. 

• Dunn-Welch Test 
This is recommended when the group variances are very different. 

Simulations 

Simulations 
This option specifies the number of iterations, M, used in the simulation. As the number of 
iterations is increased, the running time and accuracy are increased as well. 

The precision of the simulated power estimates are calculated using the binomial distribution. 
Thus, confidence intervals may be constructed for various power values. The following table 
gives an estimate of the precision that is achieved for various simulation sizes when the power is 
either 0.50 or 0.95. The table values are interpreted as follows: a 95% confidence interval of the 
true power is given by the power reported by the simulation plus and minus the ‘Precision’ 
amount given in the table. 
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 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
   

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power 
is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a small 
amount of additional accuracy achieved.  

Contrasts Tab 

Contrasts 

Contrasts 
These options specify the contrasts. You can specify as many contrasts as are necessary, but a 
penalty is paid in terms of reduced power for each additional contrast. Thus, the number of 
contrasts should be limited to those that are most important to the study.  

A contrast is a weighted average of the k (k = number of groups) group means in which the 
weights (coefficients) sum to zero. Each successive coefficient is applied to the corresponding 
group mean. For example, suppose k = 3 and the first group is a control group. Two contrasts that 
might be of interest are -1 1 0 and -1 0 1. These are interpreted as (-1)Mean1 + (1)Mean2 + 
(0)Mean3 and (-1)Mean1 + (0)Mean2 + (1)Mean3, respectively. Notice that the coefficients in 
each set sum to zero.  

Several predefined sets of contrasts are available or you can specify your own. There is no set 
number of contrasts that must (or may) be specified, but fewer contrasts result in higher power 
and smaller required samples sizes.  

Possible entries are given next. 

• Individual Contrasts  
Enter a set of numbers, separated by blanks. One coefficient must be entered for each group 
with one set per box. Examples of valid contrasts are 

-1 1 
-1 0 1 
0 1 -2 1 
-4 1 1 2   
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• Each With First 
This option generates k-1 contrasts appropriate for comparing each of the remaining groups 
with the first group. This might be used when the first group is a control group. If k = 4, the 3 
contrasts are 

-1 1 0 0   
-1 0 1 0   
-1 0 0 1  

• Each With Last 
This option generates k-1 contrasts appropriate for comparing each of the first k-1 groups 
with the last group. This might be used when the last group is a control group. If k = 4, the 3 
contrasts are 

-1 0 0 1   
0 -1 0 1   
0 0 -1 1   

• Each With Next 
This option generates k-1 contrasts appropriate for comparing each group with the next 
group. If k = 4, the 3 contrasts are 

-1 1 0 0   
0 -1 1 0   
0 0 -1 1   

• Each With Remaining 
Each group mean is compared with the average of those remaining to the right. Suppose k=4, 
the 3 contrasts are 

-3 1 1 1  
0 -2 1 1  
0 0 -1 1  

• Each With All Others 
Each group mean is compared with the average of the other groups. Suppose k=4, the 4 
contrasts are 

-3 1 1 1  
1 -3 1 1  
1 1 -3 1 
1 1 1 -3 

• Progressive Split 
The first groups are compared to the last groups. The dividing point moves from left to right. 
Suppose k=5, the 4 contrasts are 

-4 1 1 1 1 
-3 -3 2 2 2  
-2 -2 -2 3 3 
-1 -1 -1 -1 4. 
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Reports Tab 
The Reports tab contains settings about the format of the output. 

Select Output – Numeric Reports 

Show Various Reports & Plots 
These options let you specify whether you want to generate the standard reports and plots. 

Show Inc’s & 95% C.I. 
Checking this option causes an additional line to be printed showing a 95% confidence interval 
for both the power and actual alpha and half the width of the confidence interval (the increment). 

Select Output – Plots 

Show Comparative Reports & Plots 
These options let you specify whether you want to generate reports and plots that compare the test 
statistics that are available. 

Options Tab 
The Options tab contains limits on the number of iterations and various options about individual 
tests. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the sample size is aborted. When 
the maximum number of iterations is reached without convergence, the sample size is left blank. 
We recommend a value of at least 500. 

Random Numbers 

Random Number Pool Size 
This is the size of the pool of values from which the random samples will be drawn. Pools should 
be at least the maximum of 10,000 and twice the number of simulations. You can enter Automatic 
and an appropriate value will be calculated. 

If you do not want to draw numbers from a pool, enter 0 here. 
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Example 1 – Power at Various Sample Sizes 
A study is being planned to find the threshold level of a certain drug. Below this threshold level, 
the response has little change. Once the threshold level is reached, there is a sizeable jump in the 
mean response rate. Little change in the response occurs as the drug level is increased above the 
threshold. Scientists believe that the threshold level is between 3 and 7—their best estimate, 
based on previous studies, is 5. Previous studies have shown that the standard deviation within a 
group is 3.0.   

In order to find the threshold, they design a study with five levels: 3.0, 4.0, 5.0, 6.0, and 7.0. 
Since there is no trend in the mean value (only a sudden shift) as the dose level is increased, they 
decide to test the following hypotheses:  
 

Difference Coefficients 
μ μ2 1−  -1, 1, 0, 0, 0 
μ μ3 2−  0, -1, 1, 0, 0 
μ μ4 3−  0, 0, -1, 1, 0 
μ μ5 4−  0, 0, 0, -1, 1 

 

Notice that this set of hypotheses answers the question directly. An overall F-test would test the 
hypothesis that at least one mean is different, but it would not indicate which is different. The 
question might be settled by considering all possible pairs, but there are ten pairs, so ten 
hypothesis tests would have to be considered instead of only four—decreasing the power.  

Researchers want to detect a shift in the mean as small as 2.0. Hence, they want to study the 
power when the means are 0.0, 0.0, 2.0, 2.0, 2.0. They want to investigate sample sizes of 10, 30, 
50, and 70 subjects per group. 

They have no reason to assume that the variance will change a great deal from group to group, so 
they decide to analyze the data using the Dunn-Bonferroni procedure. They set the FWER to 
0.05. Note that, based on these means, only the second of the four contrasts will be significant, so 
the any-contrast power will be the same as the all-contrast power. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Contrasts (Simulation) procedure window by 
expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on 
Multiple Contrasts (Simulation). You may then make the appropriate entries as listed below, or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
FWER (Alpha) ......................................... 0.05 
n (Sample Size Multiplier) ....................... 10 30 50 70 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 2 
Control Distribution | H0 .......................... N(M0 S) 
Control Distribution | H1 .......................... N(M0 S) 
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Data Tab (continued) 
Grps 2...................................................... 3 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.1 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 2 
S .............................................................. 3 
MC Procedure ......................................... Dunn-Bonferroni 
Simulations .............................................. 2000 

Contrasts Tab 
Contrasts ................................................. Each With Next 

Reports Tab 
All reports except Comparative ............... checked 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Simulation Summary Report  
 

Summary of Simulations for Testing Multiple Contrasts of 5 Groups 
MC Procedure: Dunn-Bonferroni Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Cont. Size Size Cont. Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.136 10.0 50 0.136 1.0 3.0 0.048 0.050 0.0 2.0 3.0    
 (0.015) [0.121 0.151] (0.015) [0.121 0.151] (0.009) [0.038 0.057]     
 
2 0.509 30.0 150 0.509 1.0 3.0 0.038 0.050 0.0 2.0 3.0    
 (0.022) [0.487 0.530] (0.022) [0.487 0.530] (0.008) [0.030 0.046]     
 
3 0.796 50.0 250 0.796 1.0 3.0 0.048 0.050 0.0 2.0 3.0    
 (0.018) [0.778 0.813] (0.018) [0.778 0.813] (0.009) [0.038 0.057]     
 
4 0.924 70.0 350 0.924 1.0 3.0 0.041 0.050 0.0 2.0 3.0    
 (0.012) [0.912 0.936] (0.012) [0.912 0.936] (0.009) [0.032 0.050]     
Pool Size: 10000. Simulations: 2000. Run Time: 56.58 seconds. 
 
Summary of Simulations Report Definitions 
H0: the null hypothesis that the contrast of the means is zero. 
H1: the alternative hypothesis that the contrast of the means is not zero. 
Cont.: abbreviates 'Contrast'. Refers to a weighted average of the means whose weights sum to zero. 
All-Cont. Power: the estimated probability of detecting all unequal contrasts. 
Any-Cont. Power: the estimated probability of detecting at least one unequal contrasts. 
n: the average of the group sample sizes. 
N: the combined sample size of all groups. 
Family-Wise Error Rate (FWER): the probability of detecting at least one zero contrast assuming H0.  
Target FWER: the user-specified FWE.  
Actual FWER: the FWER estimated by the alpha simulation.  
Sm|H1: the standard deviation of the group means under H1. 
SD|H1: the pooled, within-group standard deviation under H1. 
Second Row: provides the precision and a confidence interval based on the size of the simulation for  
Any-Contrast Power, All-Contrasts Power, and FWER. The format is (Precision) [95% LCL and UCL Alpha]. 
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Summary Statements 
A one-way design with 5 groups has an average group sample size of 10.0 for a total sample size 
of 50. This design achieved an any-contrast power of 0.136 and an all-contrast power of 0.136 
using the Dunn-Bonferroni Test procedure for comparing each contrast of the group means with 
zero. The target family-wise error rate was 0.050 and the actual family-wise error rate was 
0.048. The average within group standard deviation assuming the alternative distribution is 
3.0. These results are based on 2000 Monte Carlo samples from the null distributions: N(M0 S); 
N(M0 S); N(M0 S); N(M0 S); and N(M0 S) and the alternative distributions: N(M0 S); N(M0 S); 
N(M1 S); N(M1 S); and N(M1 S). Other parameters used in the simulation were: M0 = 0.0, M1 = 
2.0, and S = 3.0. 
 

This report shows that a group sample size of about 50 will be needed to achieve 80% power or 
about 70 for 90% power. 

Any-Cont. Power 
This is the probability of detecting any of the significant contrasts. This value is estimated by the 

g the H1 distributions. 

 and a confidence interval are 
shown on the line below this row. These values provide the precision of the estimated power. 

simulation usin

Note that a precision value (half the width of its confidence interval)

All- Cont. Power 
This is the probability of detecting all of the significant contrasts. This value is estimated by the 
simulation using the H1 distributions. 

dth of its confidence interval) and a confidence interval are 
hown on the line below this row. These values provide the precision of the estimated power. 

G
T

T
T

S
T
th
m nd  o
mean.  

N

S
T amples from the alternative 
di

A
T ise error rate) estimated by the simulation using the H0 
di rocedure is 
ac

N idence interval) and a confidence interval are 
sh WER. 

Note that a precision value (half the wi
s

roup Sample Size n 
his is the verage of the individual group sample sizes. a

otal Sample e N Siz  
his is the total sample size of the study. 

.D. of Means Sm|H1 
his is the standard deviation of the hypothesized means of the alternative distributions. Under 
e null hypothesis this value is zero. It represents the magnitude of the difference among the 
eans. It is roughly equal to the average difference between the group means a  the verall 

ote that the effect size is the ratio of Sm|H1 and SD|H1. 

.D. of Data SD|H1 
his is the within-group standard deviation calculated from s
stributions.  

ctual FWER 
his is the value of FWER (family-w
stributions. It should be compared with the Target FWER to determine if the test p
curate.  

ote that a precision value (half the width of its conf
own on the line below this row. These values provide the precision of the Actual F
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Target FWER 
T

M
T

M
This is the value entered for M1, the group means under H1. 

r S, the standard deviation. 

his is the target value of FWER that was set by the user. 

0 
his is the value entered for M0, the group means under H0. 

1 

S 
This is the value entered fo

Error-Rate Summary for H0 Simulation  
 

Error Rate Summary from H0 (Alpha) Simulation of 5 Groups 
MC Procedure: Dunn-Bonferroni Test 
    Prop.     
    (No. of     
  Mean  Type-1     
 No. of No. of Prop. Errors  Mean Min Max 
Sim. Zero Type-1 Type-1 > 0) Target Cont. Cont. Cont. 
No. Cont. Errors Errors FWER FWER Alpha Alpha Alpha 
1 4 0.053 0.013 0.048 0.050 0.013 0.010 0.016 
2 4 0.042 0.010 0.038 0.050 0.010 0.009 0.012 
3 4 0.056 0.014 0.048 0.050 0.014 0.012 0.016 
4 4 0.047 0.012 0.041 0.050 0.012 0.010 0.014 
 

This report shows the results of the H0 simulation. This simulation uses the H0 settings for each 
ER. 

 the number of contrasts.  

rors 

This is the proportion of the H0 simulations in which at least one type-1 error occurred. This is 
rror rate. 

This is the target value of FWER that was set by the user. 

. 
average individual alpha value over all of the contrasts. 

group. Its main purpose is to provide an estimate of the FW

No. of Zero Cont. 
Since under H0 all means are equal, this is

Mean No. of Type-1 Er
This is the average number of type-1 errors (false detections) per set (family). 

Prop. Type-1 Errors 
This is the proportion of type-1 errors (false detections) among all tests that were conducted. 

Prop. (No. of Type-1 Errors>0) FWER 

called the family-wise e

Target FWER 

Mean Cont. Alpha 
Alpha is the probability of rejecting H0 when H0 is true. It is a characteristic of an individual test
This is the 

Min Cont. Alpha 
This is the minimum of all contrast alphas. 
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Max Cont. Alpha 
This is the maximum of all contrast alphas. 

Error-Rate Summary for H1 Simulation  
 

Error-Rate Summary from H1 (Power) Simulation of 5 Groups 
MC Procedure: Dunn-Bonferroni Test 
       (FDR)       
     Prop. Prop. Prop. Prop.      
 No. of Mean Mean  Zero Non-0. Detect. Undet. All Any    
 Zero/ No. of No. of  that that that that Non-0 Non-0 Mean Min Max 
Sim. Non-0 False False Prop. were were were were Cont. Cont. Cont. Cont. Cont. 
No. Cont. Pos. Neg. Errors Detect. Undet. Zero Non-0 Power Power Power Power Power 
1 3/1 0.04 0.86 0.226 0.013 0.864 0.223 0.226 0.136 0.136 0.044 0.010 0.136 
2 3/1 0.03 0.49 0.131 0.011 0.492 0.061 0.142 0.509 0.509 0.135 0.009 0.509 
3 3/1 0.04 0.20 0.062 0.014 0.205 0.050 0.065 0.796 0.796 0.209 0.009 0.796 
4 3/1 0.03 0.08 0.027 0.010 0.076 0.031 0.025 0.924 0.924 0.239 0.008 0.924 
 

T  settings for each 
gr

N
T cond value is the 
nu

M No.
This is the average number of zero contrasts that were declared as being non-zero by the testing 

Mean No. False Negatives 
mber of non-zero contrasts that were not declared as being non-zero by the 

 Detect. 
ro. 

 

hat were Zero (FDR) 
ulations that were actually zero. This 

covery rate. 

 that were actually non-zero.  

ower 

his repor hows the results of the H1 simulation. This simulation uses the H1t s
oup. Its main purpose is to provide an estimate of the power. 

o  Zero on-0 ont. . of /N C
he first value is the number of contrasts that were zero under H1. The se
mber of contrasts that were non-zero under H1. 

ean  False Positives 

procedure. A false positive is a type-1 (alpha) error. 

This is the average nu
testing procedure. A false negative is a type-2 (beta) error. 

Prop. Errors 
This is the proportion of type-1 and type-2 errors. 

Prop. Equal that were
This is the proportion of the zero contrasts in the H1 simulations that were declared as non-ze

Prop. Uneq. that were Undet. 
This is the proportion of non-zero contrasts in the H1 simulations that were not declared as being
non-zero. 

Prop. Detect. t
This is the proportion of all detected contrasts in the H1 sim
is often called the false dis

Prop. Undet. that were Non-0. 
This is the proportion of undetected contrasts in the H1 simulations

All Non-0 Cont. P
This is the probability of detecting all non-zero contrasts in the H1 simulation. 



Multiple Contrasts (Simulation)  590-19 

Any Non-0 Cont. Power 
This is the probability of detecting any non-zero contrasts in the H1 simulation. 

 maximum of the contrast powers from the 

D o

Mean, Min, and Max Cont. Power 
These items give the average, the minimum, and the
H1 simulation. 

etail M del Report 
 

Detailed Model Report for Simulation No. 1 
Targe  FWER 0.050, M0 = 0.0, M1 = 2.0, S = 3.0 t = 
MC Procedure: Dunn-Bonferroni Test 
 
Hypo  Group  Group Ave. Simulation . 
Type Groups Labels n/N Mean S.D. Model  
H0 1-2 A1-A2 10/50 0.0 3.1 N(M0 S) 
H0 3-5 B1-B3 10/50 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-2 A1-A2 10/50 0.0 3.0 N(M0 S) 
H1 3-5 B1-B3 10/50 2.0 3.0 N(M1 S) 
H1 All   Sm=1.0 3.0  
 
Detailed Model Report for Simulation No. 2 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-2 A1-A2 30/150 0.0 3.0 N(M0 S) 
H0 3-5 B1-B3 30/150 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-2 A1-A2 30/150 0.0 3.0 N(M0 S) 
H1 3-5 B1-B3 30/150 2.0 3.0 N(M1 S) 
H1 All   Sm=1.0 3.0  
 
Detailed Model Report for Simulation No. 3 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-2 A1-A2 30/150 0.0 3.0 N(M0 S) 
H0 3-5 B1-B3 30/150 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-2 A1-A2 30/150 0.0 3.0 N(M0 S) 
H1 3-5 B1-B3 30/150 2.0 3.0 N(M1 S) 
H1 All   Sm=1.0 3.0  
 
Detailed Model Report for Simulation No. 4 
Hypo.  Group  Group Ave. Simulation 
Type Groups Labels n/N Mean S.D. Model 
H0 1-2 A1-A2 70/350 0.0 3.0 N(M0 S) 
H0 3-5 B1-B3 70/350 0.0 3.0 N(M0 S) 
H0 All   Sm=0.0 3.0  
 
H1 1-2 A1-A2 70/350 0.0 3.0 N(M0 S) 
H1 3-5 B1-B3 70/350 2.0 3.0 N(M1 S) 
H1 All   Sm=1.0 3.0  
 

 of the previous reports. 

Hypo. Type 
tion is being reported on each row. H0 represents the null simulation 

This report shows details of each row

This indicates which simula
and H1 represents the alternative simulation. 
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Groups 
Each group in the simulation is assigned a number. This item shows the arbitrary group number 

els that were used in the individual alpha-level reports.  

 of the groups. N is the total sample size across all groups. 

G
T al groups as specified for the H0 and H1 simulations. 

A
T each line. Note that it is 
ca

S
T ups reported on each line. 

L ntra ffic

that was assigned. 

Group Labels 
These are the lab

n/N 
n is the average sample size

roup Mean 
hese are the means of the individu

ve. S.D. 
his is the average standard deviation of all groups reported on 
lculated from the sim data. ulated 

imulation Model 
his is the distri ution s used to simulate data forb  that wa  the gro

ist of Co st Coe ients 
 

List of Contrast Coefficients 
 
 Grou      ps
Contrasts A1 A2 B1 B2 B3 
Con1 -1.0 1.0 0.0 0.0 0.0 
Con2 0.0 -1.0 1.0 0.0 0.0 
Con3 0.0 -1.0 1.0 0.0 0.0 
Con4 0.0 0.0 0.0 -1.0 1.0 
The contras hown dow row . The grou wn across the cts are s n the s ps are sho olumns. 
The coefficients (weights) are shown as the body of he table.  t
 

T  double-check that they are what 
w

P   

his report shows values of the cont ast coefficients so you canr
s intended. a

robability of Rejecting Individual Contrasts
 

Probability cting Ind ntrasts.  S mulation No. 1  of Reje ividual Co i
 
Contrasts Alpha Power 
Con1 0.013 0.010 
Con2 0.016 0.1 36 
Con3 0.010 0.016 
Con4 0.014 0.014 
Alpha: probability of rejecting hypothesis that contrast is zero under alpha (H0) simulation. 
Power: probability f rejec thesis that contrast is zero unde o ting hypo r power (H1) simulation. 
 
Probability of Rejecting Individual Contrasts.  Simulation No. 2 
 
Contrasts Alpha Power 
Con1 0.010 0.009 
Con2 0.011 0.509 
Con3 0.012 0.013 
Con4 0.009 0.012 
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Probability of Rejecting Individual Contrasts.  Simulation No. 3 
 
Contrasts Alpha Power 
Con1 0.013 0.014 
Con2 0.015 0.796 
Con3 0.016 0.019 
Con4 0.012 0.009 
  
Probability of Rejecting Individual Contrasts.  Simulation No. 4 
 
Contrasts Alpha Power 
Con1 0.010 0.012 
Con2 0.014 0.924 
Con3 0.011 0.011 
Con4 0.012 0.008 
 

This report shows alpha and individual power for each contrast for each simulation that was run.   
 large In this example, only the second contrast was non-zero, so that is the only one which has

values for the power. 

Plots Section 
 

All-Contrast Power vs n

  

M0=0.0 M1=2.0 S=3.0 Alpha=0.05 Dunn Test

n

Al
l-C

on
tra

st
 P

ow
er

10 20 30 40 50 60 70
0.10

1.00

0.85

0.70
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0.40

0.55

A
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tra
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These plots give a visual presentation of the all-contrasts power values and the any-contrast 
power values. 
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E  xample 2 – Comparative Results
C  1, the researchers want to study the characteristics of alternative 
m

S

ontinuing with Example
ultiple contrast procedures.  

etup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Contrasts (Simulation) procedure window by 
ex A, then clicking on Multiple Comparisons, and then clicking on 
Multiple Contrasts (Simulation). You may then make the appropriate entries as listed below, or 
open Example 2 by going to the File menu and choosing Open Example Template. 

panding Means, then ANOV

Option Value 
Data Tab 
Find (Solve For) ................................................... Power 

Ignored since this is the Find setting 
................................................ 0.05 

 (Sample Size Multiplier) .................................... 10 30 50 70 
Group Sample Size Pattern ................................. Equal 
Grps 1 ................................................................... 2 
Control Distribution | H0 ....................................... N(M0 S) 
Control Distribution | H1 ....................................... N(M0 S) 
Grps 2 ................................................................... 3 
Group 2 Distribution(s) | H0 ................................. N(M0 S) 
Group 2 Distribution(s) | H1 ................................. N(M1 S) 
Equivalence Margin .............................................. 0.1 
M0 (Mean|H0) ...................................................... 0 
M1 (Mean|H1) ...................................................... 2 
S ........................................................................... 3 
MC Procedure ...................................................... Dunn-Bonferroni 
Simulations ........................................................... 2000 

Contrasts Tab 
Contrasts ............................................................ Next 
R orts Tab 

ny-Contrast Power Plot ................ Checked 
Comparative All-Contrast Power Plot .................. Checked 

Power ................................................................... 
FWER (Alpha) ......
n

.. Each With 
ep

Comparative Reports ........................................... Checked 
Comparative A
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Power Comparison for Simultaneously Testing Multiple Contrasts of 5 Groups 
   Dunn Dunn Dunn Dunn   
 Total  Bonferroni Welch Bonferroni Welch   
Sim. Sample Target All-Cont. All-Cont. Any-Cont. Any-Cont.   
No. Size Alpha Power Power Power Power   
1 50 0.050 0.145 0.129 0.145 0.129   
2 150 0.050 0.535 0.519 0.535 0.519   
3 250 0.050 0.806 0.785 0.806 0.785   
4 350 0.050 0.928 0.924 0.928 0.924   
Pool Size : 5.53 minu: 10000. Simulations: 2000. Run Time tes. 
 
Family-Wise Error-Rate Comparison for Simultaneously Testing Multiple Contrasts of 5 Groups 
 
 Total  Dunn Dunn 
Sim. Sample Target Bonferroni Welch 
No. Size FWER FWER FWER 
1 50 0.050 0.039 0.039 
2 150 0.050 0.041 0.046 
3 250 0.050 0.050 0.047 
4 350 0.050 0.051 0.044 
 

All-Pair Power vs n by Test
M0=0.0 M1=2.0 S=3.0 Alpha=0.05

n

10 20 30 40 50 60 70
0.10

0.25

0.40

0.55

0.70

0.85

1.00

Test
Dunn
Welch

     
 

These reports show the power and FWER of both multiple contrast procedures. In these 
ances, there is little difference 

f the two procedures. 
simulations of groups from the normal distributions with equal vari
in the power o
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Example 3 – Validation 
We could not find an article that gives power values for this test, so we decided to validate the 
procedure by comparing its results to those of the one-way ANOVA procedure which allows a 

e settings of Example 1 and using the contrast ‘0, -1, 1, 0, 0’, 
85, 0.7274, 0.9131, and 0.9758.   

S

single contrast to be tested. Using th
we obtained the following powers: 0.30

etup 
T  
th o
ex
M
open Example 3 by going to the File menu and choosing Open Example Template. 

Option

his section resents the values of each of the parameters needed to run this example. First, from p
e PASS H me window, load the Multiple Contrasts (Simulation) procedure window by 
panding Means, then ANOVA, then clicking on Multiple Comparisons, and then clicking on 

ke the appropriate entries as listed below, or ultiple Contrasts (Simulation). You may then ma

 Value 
D
F F
P ... etting 
F h
n (Sample Size Multiplier) ....................... 10 30 50 70 
Group Sample Size Pattern .................... Equal 
Grps 1 ...................................................... 2 
Control Distribution | H0 .......................... N(M0 S) 
Control Distribution | H1 .......................... N(M0 S) 
Grps 2 ...................................................... 3 
Group 2 Distribution(s) | H0 .................... N(M0 S) 
Group 2 Distribution(s) | H1 .................... N(M1 S) 
Equivalence Margin ................................. 0.1 
M0 (Mean|H0) ......................................... 0 
M1 (Mean|H1) ......................................... 2 
S .............................................................. 
MC Procedure .........................................  

Contrasts ................................................. 0 -1 1 0 0 

ata Tab 
ind (Solve r) ...................................... Power  o
ower ....... ............................................ Ignored since this is the Find s
WER (Alp a) ......................................... 0.05 

3 
Dunn-Bonferroni

Simulations .............................................. 2000 

Contrasts Tab 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Summary of Simulations for Testing Multiple Contrasts of 5 Groups 
MC Procedure: Dunn-Bonferroni Test 
 
  Group Total       
 Any- Smpl. Smpl. All- S.D. of S.D. of    
Sim. Cont. Size Size Cont. Means Data Actual Target  
No. Power n N Power Sm|H1 SD|H1 FWER  FWER  M0 M1 S    
1 0.297 10.0 50 0.297 1.0 3.0 0.050 0.050 0.0 2.0 3.0    
 (0.020) [0.276 0.317] (0.020) [0.276 0.317] (0.010) [0.040 0.059]     
 
2 0.741 30.0 150 0.741 1.0 3.0 0.050 0.050 0.0 2.0 3.0    
 (0.019) [0.721 0.760] (0.019) [0.721 0.760] (0.010) [0.040 0.060]     
 
3 0. 1.0 914 50.0 250 0.914 3.0 0.061 0.050 0.0 2.0 3.0    
 (0.012) [0.901 0.926] (0.012) [0.901 0.926] (0.010) [0.050 0.071]     
 
4 0.974 70.0 350 0.974 1.0 3.0 0.055 0.050 0.0 2.0 3.0    
 (0.007) [0.967 0.981] (0.007) [0.967 0.981] (0.010) [0.045 0.065]     
 
Pool Size: 10000. Simulations: 2000. Run Time: 56.58 seconds. 

 
 actuIn each case, the confidence interval includes the

60, 
al value. That is, 0.3085 is between 0.276 

0.9131 is between 0.901 and 0.926, and 0.9758 is 
ure. 

and 0.317, 0.7274 is between 0.721 and 0.7
between 0.967 and 0.981. This validates the proced
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Chapter 595 

Williams Test for 
the Minimum 
Effective Dose 
Introduction 
The biological activity (i.e. toxicity) of a substance may be investigated by experiments in which 
the treatments are a series of monotonically increasing (or decreasing) doses of the substance. One 
of the aims of such a study is to determine the minimum effective dose (the lowest dose at which 
there is activity). Williams (1971, 1972) describes such a test. Chow et al. (2008) give the details of 
performing a power analysis and sample size calculation of this test.  

Test Procedure 
This section will summarize the Williams’ test procedure. Those needing more details should look 
at Williams (1971, 1972). 

Suppose that a set of treatments are comprised of a control (treatment 0) and K dose levels of 
substance of interest (treatments i  = 1, …, K). All treatment groups have the same sample size n. 
Assume that the effect of the substance is to increase the mean response and that the mean response 
is proportional to the size of the dose. That is, assume that 

μ ≤ μ ≤ μ ≤ ≤ Kμ . L210

KH

The statistical hypothesis that is tested by the Williams’ test is 

μμμ === L100: KiiiaH μ = μ = = μ < μ ≤ μ ≤≤ μ+− LL 1110: .  vs. 

The test statistic is given by  

0

ˆ

nn

X

i

−μ 0

11s
T i

i

+
=  

where s is an unbiased estimate of σ , the within group standard deviation that is statistically 
independent of the iX , and iμ̂  is the maximum likelihood estimate of iμ  given by 
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The hull hypothesis of no treatment difference is rejected and the fact that the ith dose level is the 
minimum effective dose is concluded if 

α,jj tT > i for all j ≥

α,jt j

 

where  is the upper αth percentile of the distribution of T . These critical values were 
tabulated by Williams (1972) and they are available in PASS using special interpolation routines. 
The only values of α that are available are 0.05, 0.025, 0.01, and 0.005. 

Technical Details 

Computing Power 
The following approximate function for power is given by Chow et al. (2008) page 288. 

⎟
⎠
⎞

⎜
⎝
⎛ Δ

−Φ−=−
n

tK /2
11 , σ

β α

Δ ( ) ( )∫
∞−

=Φ
z

Normalz 1,0

  

where is the clinically meaningful minimal difference and .  

This can be rearranged to obtain the following expression for n 

[ ]2,
22

2Δ
+ βασ ztK=n . 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 
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Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated from the values of the other parameters. 
Under most conditions, you would select either Power and Beta or n. 

Select n when you want to determine the sample size needed to achieve a given power and alpha 
error level.  

Select Power and Beta when you want to calculate the power of an experiment that has already 
been run.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for 
power. Now, 0.90 (beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies a value for the probability of a type-I error. A type-I error occurs when a 
true null hypothesis is rejected.  

Only four values are available: 0.05, 0.025, 0.01, 0.005.  

Sample Size 

G (Number of Groups) 
Select the number of groups in the study (including the control group). Since the experiment 
compares K doses to a single control (zero dose), there are actually K+1 groups. Values from 3 to 
11 are available. 

For example, suppose an experiment includes three doses and a control group, you would enter 
‘4’ as the total number of groups.  

n (Sample Size per Group) 
Enter one or more values for the group sample size (n). This is the number of individuals in each 
group. The Williams' design assumes that the number of subjects in each group is constant. The 
total number of subjects is N = n(G). 

You may enter a list of values such as 

10 20 30 40 50 

or 

10 to 100 by 10. 
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Effect Size – Means 

∆ (Minimum Detectable Difference) 
 

Enter a value (or range of values) for the minimum difference between the control mean and each 
of the treatment means that is clinically meaningful. The goal of the study is to find the minimum 
dose that will cause this difference in response to occur. 

Note that this is NOT the difference that you think will occur. It is the minimum that you want to 
detect. 

Range 

These values should be positive. You can enter one or more values in a list using the usual syntax. 
For example, you could enter 

1 1.2 1.4 

or 

1 to 5 by 0.5. 

σ (Standard Deviation) 
 

Enter a value (or range of values) for the standard deviation of the responses within a group. The 
analysis assumes that this standard deviation is constant across all groups. These values must be 
positive.  

You can enter one or more values in a list using the usual syntax. For example, you could enter 

1 2 3 4 5 

or 

1 to 5 by 1. 

Example 1 – Finding the Sample Size 
A pharmaceutical company needs to determine the minimum dose of a drug used to treat asthma. 
A 5-arm design including a placebo control and four active dose levels (0, 10mg, 20mg, 30mg, 
and 40 mg) of the test drug is planned. The response variable is percent change from baseline 
FEV1. Previous studies have found that σ = 25%. Determine the sample size required to detect a 
change of at least 10%, 15%, 20%, 30%, 40%, and 50% assuming 90% power and α = 0.05.    

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Williams’ Test for the Minimum Effective Dose procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Williams’ Test for the Minimum Effective Dose. You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing 
Open Example Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... n (Sample Size) 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 5 
n (Sample Size per Group) ..................... Ignored since this is the search parameter. 
∆ (Minimum Detectable Difference) ........ 10 15 20 30 40 50 
σ (Standard Deviation) ............................ 25 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Williams' Test 
Null Hypothesis: μ[0] = μ[1] = ... = μ[K] 
Alternative Hypothesis: μ[0] = μ[1] = ... = μ[i-1] < μ[i] ≤ μ[i+1] ≤ ... ≤ μ[K] 
 
 Number  Group Total   Minimum 
 of Sample Sample   Detectable Standard 
 Groups Size Size   Difference Deviation 
Power (G) (n) (N) Alpha Beta (∆) (σ) 
0.9021 5 116 580 0.0500 0.0979 10.00 25.00 
0.9036 5  52 260 0.0500 0.0964 15.00 25.00 
0.9003 5 29 145 0.0500 0.0997 20.00 25.00 
0.9187 5 14 70 0.0500 0.0813 30.00 25.00 
0.9186 5 8 40 0.0500 0.0814 40.00 25.00 
0.9057 5 5 25 0.0500 0.0943 50.00 25.00 
 
References 
Chow, S.C.; Shao, J.; Wang, H. 2008. Sample Size Calculations in Clinical Research, Second Edition. Chapman & 
   Hall. New York. Pages 287 - 293. 
Williams, D.A. 1971. 'A Test for Differences between Treatment Means When Several Dose Levels are Compared 
   with a Zero Dose Control', Biometrics, Volume 27, No. 1, pages 103-117. 
Williams, D.A. 1972. 'The Comparison of Several Dose Levels with a Zero Dose Control', Biometrics, Volume 28, 
   No. 1, pages 519-531. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
G is the number of groups. 
n is the sample size of each dose level group. 
N is the total sample size which is equal to n(G). 
Alpha is the probability of rejecting a true null hypothesis. 
Beta is the probability of accepting a false null hypothesis. 
∆ (delta) is the minimum difference between a treatment mean and the control mean that is to be detected by 
   the study. 
σ (sigma) is the standard deviation within each group. 
 
Summary Statements 
A total sample size of 580 (or 116 in each of the 5 groups) achieves 90% power to detect a 
minimal difference of 10.00 between the zero-dose mean and a treatment mean with a significance 
level (alpha) of 0.0500 and a standard deviation of 25.00 using Williams' Test. 

 

This report shows the values of each of the parameters, one scenario per row. The values of 
power and beta were calculated from the other parameters. 



595-6  Williams Test for the Minimum Effective Dose 

Power 
Power is the probability of rejecting a false null hypothesis. 

G 
G is the number of groups in the study including a zero-dose control group. 

n 
n is the sample size of each dose level group. 

N 
N is the total sample size which is equal to n(G). 

Alpha 
Alpha is the probability of rejecting a true null hypothesis. 

Beta 
Beta is the probability of accepting a false null hypothesis. 

∆ (Minimum Detectable Difference) 
∆ (delta) is the minimum difference between a treatment mean and the control mean that is to be 
detected by the study. 

σ (Standard Deviation) 
σ (sigma) is the standard deviation within each group. 

Plots Section 
 

                
   

This plot shows the relationship between the group sample size and the minimal difference.  
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Example 2 – Validation using Chow 
Chow et al. (2008) page 288 presents an example that we will use to validate this procedure. In 
this example,  ∆=11, σ = 22, G = 4, power = 80%, and α = 0.05. Using the formula described 
earlier, they obtain a group sample size of 53 (actually, 53.7).    

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Williams’ Test for the Minimum Effective Dose procedure 
window by expanding Means, then ANOVA, then clicking on Multiple Comparisons, and then 
clicking on Williams’ Test for the Minimum Effective Dose. You may then make the 
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... n (Sample Size) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 4 
n (Sample Size per Group) ..................... Ignored since this is the search parameter. 
∆ (Minimum Detectable Difference) ........ 11 
σ (Standard Deviation) ............................ 22 
Annotated Output 

Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Williams' Test 
Null Hypothesis: μ[0] = μ[1] = ... = μ[K] 
Alternative Hypothesis: μ[0] = μ[1] = ... = μ[i-1] < μ[i] ≤ μ[i+1] ≤ ... ≤ μ[K] 
 
 Number  Group Total   Minimum 
 of Sample Sample   Detectable Standard 
 Groups Size Size   Difference Deviation 
Power (G) (n) (N) Alpha Beta (∆) (σ) 
0.8025 4 54 216 0.0500 0.1975 11.00 22.00 
 

 

Note that PASS has rounded up to the next integer, while Chow rounded down. Thus, n = 54 
guarantees a power of at least 80%. 
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Chapter 600 

Hotelling’s T2 
Introduction 
This module calculates power for Hotelling’s one-group, and two-group, T-squared (T2) test 
statistics. Hotelling’s T2 is an extension of the univariate t-tests in which the number of response 
variables is greater than one. In the two-group case, these results may also be obtained using 
PASS’s MANOVA test. 

Assumptions 
The following assumptions are made when using Hotelling’s T2 to analyze one or two groups of 
data.  

1.  The response variables are continuous. 

2.  The residuals follow the multivariate normal probability distribution with mean zero and 
constant variance-covariance matrix. 

3.  The subjects are independent. 

Technical Details 
The formulas used to perform a Hotelling’s T2 power analysis provide exact answers if the above 
assumptions are met. These formulas can be found in many places. We use the results in Rencher 
(1998). We refer you to that reference for more details. 

One-Group Case 
In this case, a set of N observations is available on p response variables. We assume that all N 
observations have the same multivariate normal distribution with mean vector μ and variance 
covariance matrix Σ  and that Hotelling’s T2 is used for testing the null hypothesis that μ μ= 0  
versus the alternative that μ μ= A where at least one component of  μA  is different from the 
corresponding component of μ0 . Usually, the vector μ0  is a vector of zeros.  

The value of T2 is computed using the formula 

( ) ( )T N y S yp N, −
−= − ′ −1

2
0

1
0μ μ  

where y  is the vector of sample means and S is the sample variance-covariance matrix. 
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To calculate power we need the non-centrality parameter for this distribution. This non-centrality 
parameter is defined as follows 

( ) (λ μ μ μ μ= − )′ −

=

−N

N
A A0

1
0

2

Σ

Δ
 

where 

( ) ( )Δ Σ= − ′ −−μ μ μ μA A0
1

0  
We define Δ  as effect size because it provides a expression for the magnitude of the standardized 
difference between the null and alternative means. 

Using this non-centrality parameter, the power of the Hotelling’s T2 may be calculated for any 
value of the means and standard deviations. Since there is a simple relationship between the non-
central T2 and the non-central F, calculations are actually based on the non-central F using the 
formula 

( )β α λ= ′ < ′Pr , , ,F F df df1 2  

where 

df p
df N p

1
2
=
= −  

Two-Group Case 
In this case, sets of N1 observations from group 1 and N2 observations from group 2 are available 
on p response variables. We assume that all observations have the multivariate normal 
distribution with common variance covariance matrix Σ . The mean vectors of the two groups are 
assumed to be μ1 and μ2 under the alternative hypothesis. Under the null hypothesis, these mean 
vectors are assumed to be equal. 

The value of T2 is computed using the formula 

( ) ( )T N N
N N

y y S y yp N N sp, 1 2 2
2

1 2
1

1 2
1 2

1 2+ −
−=

+
− ′ −  

where y1  and y2  are the vectors sample mean vectors of the two groups and  is the pooled 
sample variance-covariance matrix. 

Spl

To calculate power we need the non-centrality parameter for this distribution. This non-centrality 
parameter is defined as follows 

( ) ( )λ μ μ μ=
+

− μ′ −

=
+

−N N
N N
N N

N N

1 2
1 2
1 2

1 2

1 2
1

1 2

2

Σ

Δ
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where 

( ) ( )Δ Σ= − ′ −−μ μ μ μ1 2
1

1 2  
We define Δ  as effect size because it provides a expression for the magnitude of the standardized 
difference between the null and alternative means. 

Using this non-centrality parameter, the power of the Hotelling’s T2 may be calculated for any 
value of the means and standard deviations. Since there is a simple relationship between the non-
central T2 and the non-central F, calculations are actually based on the non-central F using the 
formula 

( )β α λ= ′ < ′Pr , , ,F F df df1 2  

where 

df p
df N N p

1
2 1 2
=
= + − −1

 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data and Covariance tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data Tab 
The Data tab contains many of the options that you will be primarily concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for.  

When you choose to solve for N (one-group) or N1 (two-group), the program searches for the 
lowest sample size that meets the alpha and power criterion you have specified.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means 
when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 
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A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject 
the null hypothesis of equal means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N1 (Sample Size Group 1) 
Enter a value (or range of values) for the sample size of group one. For the one-group case, this is 
the value of N. For the two-group case, this is the value of N1.  

You may enter a range of values such as ‘10 to 100 by 10’. 

N2 (Sample Size Group 2) 
In the two-group case, enter the value (or range of values) for the sample size of group two. In the 
one-group case, this value is ignored. 

• Use R 
Enter ‘Use R’ if you want N2 to be calculated using the formula: N2=[R x N1] where R is the 
Sample Allocation Ratio and [Y] is the first integer >= Y. For example, if you want N1=N2, 
select ‘Use R’ here and set R equal to one. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between sample sizes. This value is 
only used when N2 is set to 'Use R'. When used, N2 is calculated from N1 using the formula: 
N2=[R x N1] where [Y] is the next integer >= Y. Note that setting R = 1.0 forces N2 = N1. 

Note that this value is only used in the two-group case. 

Groups 

Number of Groups 
Specify whether the analysis is for one group or two groups. If ‘1’ is selected, N1 is used as the 
sample size (N) and the values of N2 and R are ignored. 

Effect Size – Response Variables 

Number of Response Variables 
Enter the number of response (dependent or Y) variables. For a true multivariate test, this value 
will be greater than one. 
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The number of mean differences entered in the Mean Differences box or in the Means column 
must equal this value. If you read-in the covariance matrix from the spreadsheet, the number of 
columns specified must equal this value. 

Effect Size – Mean Differences 

Mean Differences (= # of Response Vars) 
Enter a list of values representing the mean differences under the alternative hypothesis. Under 
the null hypothesis, these values are all zero. The values entered here represent the differences 
that you want the experiment (study) to be able to detect. 

Note that the number of values must match the number of Response Variables. 

If you like, you can enter these values in a column on the spreadsheet. This column is specified 
using the ‘Means Column’ option. When that option is specified, any values entered here are 
ignored. 

Means Differences Column 
Use this option to specify the spreadsheet column containing the hypothesized mean differences. 
The response variables are represented down the rows. The number of rows with data must equal 
the number of response variables. When this option is used, the 'Mean Differences' box is 
ignored. 

You can obtain the spreadsheet by selecting ‘Window’, then ‘Data’, from the menus. 

Effect Size – Mean Multiplier 

K (Means Multipliers) 
These values are multiplied times the mean differences to give you various effect sizes. A 
separate power calculation is generated for each value of K. If you want to ignore this setting, 
enter ‘1’. 

Covariance Tab 
This tab specifies the covariance matrix. 

Covariance Matrix Specification 

Specify Which Covariance Matrix Input Method to Use 
This option specifies which method will be used to define the covariance matrix. 

• Standard Deviation and Correlation 
This option generates a covariance matrix based on the settings for the standard deviation 
(SD) and the pattern of correlations as specified in the Correlation Pattern and R options. 

• Covariance Matrix Variables 
When this option is selected, the covariance matrix is read in from the columns of the 
spreadsheet. This is the most flexible method, but specifying a covariance matrix is tedious. 
You will usually only use this method when a specific covariance is given to you.  
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Note that the spreadsheet is shown by selecting the menus: ‘Window’ and then ‘Data’. 

Covariance Matrix Specification- 
Input Method = ‘Standard Deviation 
and Correlation’ 
The parameters in this section provide a flexible way to specify Σ , the covariance matrix. 
Because the covariance matrix is symmetric, it can be represented as 

Σ =
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where p is the number of response variables. 

Thus, the covariance matrix can be represented with complete generality by specifying the 
standard deviations σ σ σ1 2, , ,L p  and the correlation matrix 

R

p

p

p p
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SD (Common Standard Deviation) 
This value is used to generate the covariance matrix. This option specifies a single standard 
deviation to be used for all response variables. The square of this value becomes the diagonal 
elements of the covariance matrix. Since this is a standard deviation, it must be greater than zero. 

This option is only used when the first Covariance Matrix Input Method is selected. 

R (Correlation) 
Specify a correlation to be used in calculating the off-diagonal elements of the covariance matrix. 
Since this is a correlation, it must be between -1 and 1. This option is only used when the first 
Covariance Matrix Input Method is selected. 
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Specify Correlation Pattern 
This option specifies the pattern of the correlations in the variance-covariance matrix. Two 
options are available: 

• Constant 
The value of R is used as the constant correlation. For example, if R = 0.6 and p = 6, the 
correlation matrix would appear as 

R =

⎡

⎣

⎢
⎢
⎢
⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥
⎥
⎥
⎥

1 0 600 0 600 0 600 0 600 0 600
0 600 1 0 600 0 600 0 600 0 600
0 600 0 600 1 0 600 0 600 0 600
0 600 0 600 0 600 1 0 600 0 600
0 600 0 600 0 600 0 600 1 0 600
0 600 0 600 0 600 0 600 0 600 1

. . . . .
. . . . .
. . . . .
. . . . .
. . . . .
. . . . .

 

• 1st-Order Autocorrelation 
The value of R is used as the base autocorrelation in a first-order, serial correlation pattern. 
For example, R = 0.6 and p = 6, the correlation matrix would appear as 

R =

⎡

⎣

⎢
⎢
⎢
⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥
⎥
⎥
⎥

1 0 600 0 360 0 216 0130 0 078
0 600 1 0 600 0 360 0 216 0130
0 360 0 600 1 0 600 0 360 0 216
0 216 0 360 0 600 1 0 600 0 360
0130 0 216 0 360 0 600 1 0 600
0 078 0130 0 216 0 360 0 600 1

. . . . .
. . . .
. . . . .
. . . . .
. . . . .
. . . . .

.

 

This pattern is often chosen as the most realistic when little is known about the correlation 
pattern and the responses variables are measured across time. 

Covariance Matrix Specification- 
Input Method = ‘Covariance Matrix 
Variables’ 
This option instructs the program to read the covariance matrix from the spreadsheet. 

Spreadsheet Columns Containing the Covariance Matrix 
This option designates the columns on the current spreadsheet holding the covariance matrix. It is 
used when the ‘Specify Which Covariance Matrix Input Method to Use’ option is set to 
Covariance Matrix Variables. The number of columns and number of rows must match the 
number of response variable at which the subjects are measured. 
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Example 1 – Power in the One-Group Case and 
Validation 
Rencher (1998) page 106 presents an example of power calculations for the one-group case in 
which the mean differences are both 1.88 and the covariance matrix is 

Σ =
⎡

⎣
⎢

⎤

⎦
⎥

56 78 1198
1198 2928

. .

. .
 

When N is 25 and the significance level is 0.05, Rencher calculated the power to be 0.3397.  

To allow for a nice chart, we will calculate the power for several samples sizes and for K equal 
1.0 and 1.5.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Hotelling’s T2 procedure window by expanding Means, then 
Multivariate Means, then clicking on Hotelling’s T2, and then clicking on Hotelling’s T2. You 
may then make the appropriate entries as listed below, or open Example 1 by going to the File 
menu and choosing Open Example Template. You can see that the values have been loaded into 
the spreadsheet by clicking on the spreadsheet button. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta  
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N1 (Sample Size Group 1) ...................... 5 15 25 35 50 75 100 150 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Number of Groups ................................... 1  
Number of Response Variables .............. 2 
Mean Differences .................................... 1.88 1.88 
Mean Differences Column ....................... blank  
K (Means Multiplier) ................................ 1.0 1.5 

Covariance Tab 
Specify Covariance Method .................... 2) Covariance Matrix Variables  
Spreadsheet Columns ............................. VC1-VC2 
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Reports Tab 
Show Numeric Reports ........................... Checked 
Show Means Matrix ................................. Checked 
Show Covariance Matrix ......................... Checked 
Show Definitions ..................................... Checked 
Show Summary Statements ................... 1 
Show Plot ................................................ Checked 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Report 
 

  Multiply    Number  
  Means   Effect of Y's  
Power N By Alpha Beta Size (DF1) DF2 
0.0737 5 1.0000 0.0500 0.9263 0.38 2 3 
0.1996 15 1.0000 0.0500 0.8004 0.38 2 13 
0.3379 25 1.0000 0.0500 0.6621 0.38 2 23 
0.4707 35 1.0000 0.0500 0.5293 0.38 2 33 
0.6409 50 1.0000 0.0500 0.3591 0.38 2 48 
0.8311 75 1.0000 0.0500 0.1689 0.38 2 73 
0.9282 100 1.0000 0.0500 0.0718 0.38 2 98 
0.9895 150 1.0000 0.0500 0.0105 0.38 2 148 
0.1040 5 1.5000 0.0500 0.8960 0.38 2 3 
0.4033 15 1.5000 0.0500 0.5967 0.38 2 13 
0.6635 25 1.5000 0.0500 0.3365 0.38 2 23 
0.8302 35 1.5000 0.0500 0.1698 0.38 2 33 
0.9475 50 1.5000 0.0500 0.0525 0.38 2 48 
0.9943 75 1.5000 0.0500 0.0057 0.38 2 73 
0.9995 100 1.5000 0.0500 0.0005 0.38 2 98 
1.0000 150 1.5000 0.0500 0.0000 0.38 2 148 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Note that Power = 1 - Beta. 
N is the sample size, the number of subjects in the experiment or study. 
K is a constant by which all means are multiplied. 
Alpha is the probability of rejecting a true null hypothesis. 
Beta is the probability of accepting a false null hypothesis. Note that Beta = 1 - Power. 
Effect Size is a standardized version of T2 under the alternative hypothesis. 
DF1 is the first degrees of freedom of T2. It is the number of response variables. 
DF2 is the second degrees of freedom of T2. 
 
Summary Statements 
A sample size of 5 achieves 7% power to detect an effect size of 0.38 which represents the 
differences between the null and alternative means of the 2 response variables, adjusted by the 
variance-covariance matrix. The one-sample Hotelling's T-squared test statistic is used with a 
significance level of 0.0500. 
  

This report gives the power for each value of N and K. Notice that the power for K = 1 and N = 25 
is 0.3379. This is slightly different than the 0.3397 obtained by interpolation by Rencher.  
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Means Section 
 

Means Section 
Name Mean 
Y1 1.8800 
Y2 1.8800 
 

This report shows the mean differences that were read in. When a Means Multiplier, K, is used, 
each value of K is multiplied times each of these values. 

Variance-Covariance Matrix Section 
 

Variance-Covariance Matrix Section 
 

Response Y1 Y2 
Y1 7.5353 0.2938 
Y2 0.2938 5.4111 

 

This report shows the variance-covariance matrix that was read in from the spreadsheet or 
generated by the settings of on the Covariance tab. The standard deviations are given on the 
diagonal and the correlations are given off the diagonal. 

Chart Section 
 

Power vs N1 by K
Alpha=0.05

N1

0 40 80 120 160
0.0

0.2

0.4

0.6

0.8

1.0

K
1.00
1.50

  
 

This chart shows the relationship between power and N for each value of K.  
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Example 2 – Power in the Two-Group Case and 
Validation 
Rencher (1998) pages 107-108 presents an example of power calculations for the two-group case 
in which the mean differences and covariance matrix are 

μ μ1 2

3
2

3
− = −

⎡

⎣

⎢
⎢
⎢

⎤

⎦

⎥
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,  Σ =
−

− −
−
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⎣
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⎢
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⎥
⎥
⎥

6 3 3
3 5 6

3 6 9
 

When N1 = N2 =  10, 12, 14, 16 and the significance level is 0.05, Rencher calculated the power 
to be 0.6438, 0.7520, 0.8329, 0.8936, respectively.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Hotelling’s T2 procedure window by expanding Means, then 
Multivariate Means, then clicking on Hotelling’s T2, and then clicking on Hotelling’s T2. You 
may then make the appropriate entries as listed below, or open Example 2 by going to the File 
menu and choosing Open Example Template. You can see that the values have been loaded into 
the spreadsheet by clicking on the spreadsheet button. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta  
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N1 (Sample Size Group 1) ...................... 10 12 14 16 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Number of Groups ................................... 2  
Number of Response Variables .............. 3 
Mean Differences .................................... blank 
Mean Differences Column ...................... Differences  
K (Means Multiplier) ................................ 1.0 

Covariance Tab 
Specify Covariance Method .................... 2) Covariance Matrix Variables  
Spreadsheet Columns ............................. VC_1-VC_3 
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Reports Tab 
Show Numeric Results ............................ Checked 
Show Means Matrix ................................. Checked 
Show Covariance Matrix ......................... Checked 
Show Definitions ..................................... Checked 
Show Summary Statements.................... 1 
Show Plot ................................................ Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Report 
 

   Multiply    Number  
   Means   Effect of Y's  
Power N1 N2 By (K) Alpha Beta Size (DF1) DF2 
0.6442 10 10 1.0000 0.0500 0.3558 1.41 3 16 
0.7546 12 12 1.0000 0.0500 0.2454 1.41 3 20 
0.8361 14 14 1.0000 0.0500 0.1639 1.41 3 24 
0.8936 16 16 1.0000 0.0500 0.1064 1.41 3 28 
  

Note that the power values obtained here are very close to those obtained by Rencher. We feel 
that our results are more accurate since Rencher’s results were obtained by interpolation from 
Tang’s tables.  
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Chapter 605 

Multivariate 
Analysis of 
Variance 
(MANOVA) 
Introduction 
This module calculates power for multivariate analysis of variance (MANOVA) designs having 
up to three factors. It computes power for three MANOVA test statistics: Wilks’ lambda, Pillai-
Bartlett trace, and Hotelling-Lawley trace.   

MANOVA is an extension of common analysis of variance (ANOVA). In ANOVA, differences 
among various group means on a single-response variable are studied. In MANOVA, the number 
of response variables is increased to two or more. The hypothesis concerns a comparison of 
vectors of group means. The multivariate extension of the F-test is not completely direct. Instead, 
several test statistics are available. The actual distributions of these statistics are difficult to 
calculate, so we rely on approximations based on the F-distribution. 

Assumptions 
The following assumptions are made when using MANOVA to analyze a factorial experimental 
design.  

1.  The response variables are continuous. 

2.  The residuals follow the multivariate normal probability distribution with mean zero and 
constant variance-covariance matrix. 

3.  The subjects are independent. 
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Technical Details 

General Linear Multivariate Model 
This section provides the technical details of the MANOVA designs that can be analyzed by 
PASS. The approximate power calculations outlined in Muller, LaVange, Ramey, and Ramey 
(1992) are used. Using their notation, for N subjects, the usual general linear multivariate model 
is 

( ) ( ) ( )
Y XM R

N p N q p N p× × × ×
= +  

where each row of the residual matrix R is distributed as a multivariate normal 

( ) ( )row R Nk p~ ,0 Σ  

Note that p is the number of response variables and q is the number of design variables, Y is the 
matrix of responses, X is the design matrix, M is the matrix of regression parameters (means), and 
R is the matrix of residuals. 

Hypotheses about various sets of regression parameters are tested using  

H
a p0 0: Θ Θ
×
=  

CM
a q p× ×

=Θ  

where C is an orthonormal contrast matrix and Θ0  is a matrix of hypothesized values, usually 
zeros. Note that C defines contrasts among the factor levels. Tests of the various main effects and 
interactions may be constructed with suitable choices of C. These tests are based on  

( )$ ' 'M X X=

$ $Θ = CM

X Y−

( )

 

 

( )[ ] ( )X X C
p p×

−
= −H C −′

−$ ' ' $Θ Θ Θ Θ0

1

0  

( )r
p p×

−E N= ⋅$Σ  

T H E
p p×

= +  

where r is the rank of X.  

Wilks’ Lambda Approximate F Test 
The hypothesis  may be tested using Wilks’ likelihood ratio statistic W. This statistic 
is computed using 

H0 0:Θ Θ=

W ET= −1  
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An F approximation to the distribution of W is given by 

( )
F df

dfdf df1 2

1

21,
/

/
=

−
η
η

 

where 

λ = df F

( ) ( )[ ]

df df1 1 2,

η = −1 1W g/

 

 

df ap1=  

( )N r p a ap2 1 2 2 2= − − − + − −/ /df g  

g a p
a p+ −⎝ ⎠5

=
−⎛

⎜
⎞
⎟

2 2

2 2

1
24

H0 0:Θ Θ=

 

Pillai-Bartlett Trace Approximate F Test 
The hypothesis  may be tested using the Pillai-Bartlett Trace. This statistic is 
computed using 

( )T tr HTPB =
−1

PB

 

A noncentral F approximation to the distribution of T  is given by 

( )
F df

2

/
dfdf df1 2

1

1, /
=

−
η
η

 

where 

λ = df Fdf df1 1 2,  

η =
T
s
PB

( )s a p= min ,

( )[ ]N r p s= − − +

0 0Θ Θ=

 

 
df ap1=  

df s2  

Hotelling-Lawley Trace Approximate F Test 
The hypothesis  may be tested using the Hotelling-Lawley Trace. This statistic is 
computed using 

H :

( )T tr HEHL =
−1  
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An F approximation to the distribution of T  is given by HL

( )
F df

dfdf df1 2

1

21,
/

/
=

−
η
η

 

where 

λ = df Fdf df1 1 2,  
T

η =
+

s
T

s

HL

HL1

( )s a p= min ,

( )[ ]N r p s= − − +

 

 
df ap1=  

df s2  

M (Mean) Matrix 
In the general linear multivariate model presented above, M represents a matrix of regression 
coefficients. Although other structures and interpretations of M are possible, in this module we 
assume that the elements of M are the cell means. The rows of M represent the factor categories 
and the columns of M represent the response variables. (Note that this is just the opposite of the 
orientation used when entering M into the spreadsheet.)  

The q rows of M represent the q groups into which the subjects can be classified. For example, if 
a design includes three factors with 2, 3, and 4 categories, the matrix M would have 2 x 3 x 4 = 24 
rows. That is, q = 24. 

Consider now an example in which q = 3 and p = 4. That is, there are three groups into which 
subjects can be placed. Each subject has four made. The matrix M would appear as follows. 

M =
⎡

⎣

⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥

μ μ μ μ
μ μ μ μ
μ μ μ μ

11 12 13 14

21 22 23 24

31 32 33 34

 

μFor example, the element 12  is the mean of the second response of subjects in the first group. To 
calculate the power of this design, you would need to specify appropriate values of all twelve 
means. 

C Matrix – Contrasts 
The C matrix is comprised of contrasts that are applied to the rows of M. You do not have to 
specify these contrasts. They are generated for you. You should understand that a different C 
matrix is generated for each term in the model.  
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Generating the C Matrix when there are Multiple Between Factors 
Generating the C matrix when there is more than one factor is more difficult. We use the method 
of O’Brien and Kaiser (1985) which we briefly summarize here. 

Step 1. Write a complete set of contrasts suitable for testing each factor separately. For example, 
if you have three factors with 2, 3, and 4 categories, you might use 

&& 1 1−⎡ ⎤CB1 2 2
=
⎣⎢ ⎦⎥

, &&CB2
6 6 6

0 1
2

1
2

= −

⎣

⎢
⎢
⎢
⎢ ⎦

⎥
⎥
⎥
⎥

2 1 1−⎡ ⎤

, and &&CB3 0 2
6

1
6

1
6

0 0 1
2

1
2

=
−

−

⎣

⎢
⎢
⎢
⎢
⎢

⎦

⎥
⎥
⎥
⎥
⎥

3
12

1
12

1
12

1
12

−⎡
⎢

⎤
⎥

Jk

. 

Step 2. Define appropriate  matrices corresponding to each factor. These matrices comprised 
of one row and k columns whose equal element is chosen so that the sum of its elements squared 
is one. In this example, we use 

J2
1
2 2

= ⎡

⎣⎢ ⎦⎥
1 ⎤ , J3

1
3

1
3

1
3

= ⎡

⎣⎢
⎤

⎦⎥
, J4

1
4

1
4

1
4

1
4

= ⎡

⎣⎢
⎤

⎦⎥

&&CBi

1 2
3 4

1
0 2 0

⎡

⎣
⎢

⎤

⎦
⎥ ⊗

−

−

⎡
⎢
⎢
⎢

⎤
⎥
⎥
⎥

 

Step 3. Create the appropriate contrast matrix using a direct (Kronecker) product of either the  
matrix if the factor is included in the term or the  matrix when the factor is not in the term. 
Remember that the direct product is formed by multiplying each element of the second matrix by 
all members of the first matrix. Here is an example 

Ji

1 0

1 0 3

1 2 0 0 1 2
3 4 0 0 3 4
0 0 2 4 0 0
0 0 6 8 0 0
1 2 0 0 3 6
3 4 0 0 9 12

⎣ ⎦

=

− −
− −

− −
− −

⎡

⎣

⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥

C J C JB B2 2 2 4= ⊗ ⊗&&

 

As an example, we will compute the C matrix suitable for testing factor B2 
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Expanding the direct product results in 
C J C JB B2 2 2 4

1
2

1
2

2
6

1
6

1
6

0 1
2

1
2

1
4

1
4

1
4

1
4

2
12

2
12

1
12

1
12

1
12

1
12

0 0 1
4

1
4

1
4

1
4

1
4

1
4

1
4

1
4

2
48

2
48

1
48

1
48

1
48

1
48

2
48

2
48

1
48

1
48

1
48

1
48

2

= ⊗ ⊗

= ⎡

⎣⎢
⎤

⎦⎥
⊗

−

−

⎡

⎣

⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥

⊗ ⎡

⎣⎢
⎤

⎦⎥

=

− −

− −

⎡

⎣

⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥

⊗ ⎡

⎣⎢
⎤

⎦⎥

=

− − − − −

&&

48
2

48
1
48

1
48

1
48

1
48

2
48

2
48

1
48

1
48

1
48

1
48

0 0 1
16

1
16

1
16

1
16

0 0 1
16

1
16

1
16

1
16

0 0 1
16

1
16

1
16

1
16

0 0 1
16

1
16

1
16

1
16

− − −

− − − − − − − −

⎡

⎣

⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥

 

Similarly, the C matrix suitable for testing interaction B2B3 is 

C J C CB B B B2 3 2 2 3= ⊗ ⊗&& &&  

We leave the expansion of this matrix PASS, but we think you have the idea. 

Power Calculations 
To calculate statistical power, we must determine distribution of the test statistic under the 
alternative hypothesis which specifies a different value for the regression parameter matrix B. The 
distribution theory in this case has not been worked out, so approximations must be used. We use 
the approximations given by Muller and Barton (1989) and Muller, LaVange, Ramey, and Ramey 
(1992). These approximations state that under the alternative hypothesis,  is distributed as a 
noncentral F random variable with degrees of freedom and noncentrality shown above. The 
calculation of the power of a particular test may be summarized as follows. 

FU

X M C, , ,1.  Specify values of ,Σ Θand 0 . 

( )f dfF FINV dcrit2.  Determine the critical value using = −1 1 2α , , , where FINV( ) is the 
inverse of the central F distribution and α is the significance level.  

3.  Compute the noncentrality parameter λ . 

4.  Compute the power as  

( )NCFPROB F df dfcritPower = −1 1, , ,2 λ  

where NCFPROB( ) is the noncentral F distribution.  
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data and Covariance tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data Tab 
The Data tab contains many of the options that you will be primarily concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for. If you choose to solve for n (sample size), 
you must also specify which test statistic you want to use. 

When you choose to solve for n, the program searches for the lowest sample size that meets the 
alpha and beta criterion you have specified for each of the terms. If you do not want a term to be 
used in the search, set its alpha and beta values to 0.99. 

Also, when the ‘= n’s’ box is not checked, the search is made using unequal group sample sizes. 
The relative proportion of the sample in each group is set by the values of n given in the Subjects 
Per Group box. For example, if your design has three groups and you entered ‘1 1 2’ in the 
Subjects Per Group box, the search will only consider designs in which the size of the last group 
is twice the rest. That is, it will consider ‘2 2 4’, ‘3 3 6’, ‘4 4 8’, etc. 

Note: no plots are generated when you solve for n. 

Sample Size 

n (Subjects Per Group) 
Specify one or more values for the number of subjects per group. The total sample size is the sum 
of the individual group sizes across all groups. 

You can specify a list like ‘2 4 6’. The items in the list may be separated with commas or blanks. 
The interpretation of the list depends on the =n's check box. When the =n's box is checked, a 
separate analysis is calculated for each value of n. When the =n's box is not checked, PASS uses 
the n’s as the actual group sizes. In this case, the number of items entered must match the number 
of groups in the design. 

When you choose to solve for n and the = n’s box is not checked, the search is made using 
unequal group sample sizes. The relative proportion of the sample in each group is set by the 
values of n given in this box. For example, if your design has three groups and you enter ‘1 1 2’ 
here, the search will only consider designs in which the size of the last group is twice the rest. 
That is, it will consider ‘2 2 4’, ‘3 3 6’, ‘4 4 8’, etc. 

= n’s 
This option controls whether the number of subjects per group is to be equal for all groups or not. 
When checked, the number of subjects per group is equal for all groups. A list of values such as 
‘5 10 15’ represents three designs: one with five per group, one with ten per group, and one with 
fifteen per group.  
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When this option is not checked, the n’s are assumed to be unequal. A list of values represents the 
size of the individual groups. For example, ‘5 10 15’ represents a single, three-group design with 
five in the first group, ten in the second group, and fifteen in the third group. 

Effect Size – Response Variables 

Number of Response Variables 
Enter the number of response variables in your design. For a true MANOVA, this value must be 
greater than one. The number of rows in the means matrix must equal this value. If you specify a 
covariance matrix, the number of columns specified must equal this value. 

Effect Size – Means 

Means Matrix 
Use this option to the specify spreadsheet columns containing a hypothesized means matrix that is 
used to specify the alternative hypothesis. You can obtain the spreadsheet by selecting ‘Window’, 
then ‘Data’, from the menus. 

The factors are represented across the columns of the spreadsheet and the response variables are 
represented down the rows. The number of columns specified must equal the number of groups. 
The number of rows with data in these columns must equal the number of response variables. For 
example, suppose you are designing an experiment that is to have two factors (A and B) and two 
response variables (Y1 and Y2). Suppose each of the factors has two levels. The four columns of 
the spreadsheet would represent 

A1B1 A1B2 A2B1 A2B2. 

The two rows of the spreadsheet would represent 

Y1 

Y2 

K (Means Multipliers) 
These values are multiplied times the means matrix to give you various effect sizes. A separate 
power calculation is generated for each value of K. These values become the horizontal axis in 
the second power chart. If you want to ignore this setting, enter ‘1’. 

Effect Size – Main Effects & 
Interactions 

Labels 
Specify a label for this factor. Although we suggest that only a single letter be used, the label can 
consist of several letters. When several letters are used, the labels for the interactions may be 
extra long and confusing. Of course, you must be careful not to use the same label for two factors. 

One of the easiest sets of labels is to use A, B, and C for the factors. 

Levels 
Specify the number of levels (categories) in this factor. Typical values are from 2 to 8. Set this to 
a blank (or 0) to ignore the factor in the design. 
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Alpha 
These options specify the probability of a type-I error (alpha) for each factor and interaction. A 
type-I error occurs when you reject the null hypothesis of zero effects when in fact they are zero. 
Since they are probabilities, alpha values must be between zero and one. Historically, the value of 
0.05 has been used for alpha. This value may be interpreted as meaning that about one test in 
twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You can specify different alpha values for different terms. For example, although you have three 
terms in an experiment, you might be mainly interested in only one of them. Hence, you could 
increase the alpha level of the tests of the other terms and thereby increase their power. Also, you 
may want to increase the alpha level of the interaction terms, as these will often have poor power 
otherwise. 

Power or Beta 
These options specify the power or for beta (depending on the chosen setting) for each factor and 
interaction.   

Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means 
when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Covariance Tab 
This tab specifies the covariance matrix. 

Covariance Matrix Specification 

Specify Which Covariance Matrix Input Method to Use 
This option specifies which method will be used to define the covariance matrix. 

• Standard Deviation and Correlation 
This option generates a covariance matrix based on the settings for the standard deviation 
(SD) and the pattern of correlations as specified in the Correlation Pattern and R options. 

• Covariance Matrix Variables 
When this option is selected, the covariance matrix is read in from the columns of the 
spreadsheet. This is the most flexible method, but specifying a covariance matrix is tedious. 
You will usually only use this method when a specific covariance is given to you.  

Note that the spreadsheet is shown by selecting the menus: ‘Window’ and then ‘Data’. 
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Covariance Matrix Specification- 
Input Method = ‘Standard Deviation 
and Correlation’ 
The parameters in this section provide a flexible way to specify Σ , the covariance matrix. 
Because the covariance matrix is symmetric, it can be represented as 

Σ =

⎡
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⎥
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where p is the number of response variables. 

Thus, the covariance matrix can be represented with complete generality by specifying the 
standard deviations σ σ σ1 2, , ,L p

p⎡ ⎤1 12 1ρ ρL

 and the correlation matrix 

R p

p p

=

⎣

⎢
⎢
⎢
⎢

⎦

⎥
⎥
⎥
⎥

1

1

12 2

1 2

ρ ρ

ρ ρ

L

M M O M

L

. 

SD (Standard Deviation) 
This value is used to generate the covariance matrix. This option specifies a standard deviation to 
be used for all response variables. The square of this value becomes the diagonal elements of the 
covariance matrix. Since this is a standard deviation, it must be greater than zero. 

This option is only used when the first Covariance Matrix Input Method is selected. 

R (Correlation) 
Specify a correlation to be used in calculating the off-diagonal elements of the covariance matrix. 
Since this is a correlation, it must be between -1 and 1. This option is only used when the first 
Covariance Matrix Input Method is selected. 

Specify Correlation Pattern 
This option specifies the pattern of the correlations in the variance-covariance matrix. Two 
options are available: 
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• Constant 
The value of R is used as the constant correlation. For example, if R = 0.6 and p = 6, the 
correlation matrix would appear as 

R =

⎣

⎢
⎢
⎢
⎢
⎢
⎢
⎢

⎦

⎥
⎥
⎥
⎥
⎥
⎥
⎥

0 600 1 0 600 0 600 0 600 0 600
0 600 0 600 1 0 600 0 600 0 600
0 600 0 600 0 600 1 0 600 0 600
0 600 0 600 0 600 0 600 1 0 600
0 600 0 600 0 600 0 600 0 600 1

. . . . .

. . . . .

. . . . .

. . . . .

. . . . .

⎡ ⎤1 0 600 0 600 0 600 0 600 0 600. . . . .

⎡
⎢
⎢
⎢

⎤
⎥
⎥
⎥

1 0 600 0 360 0 216 0130 0 078
0 600 1 0 600 0 360 0 216 0130
0 360 0 600 1 0 600 0 360 0 216

. . . . .
. . . . .
. . . . .

 

• 1st Order Autocorrelation 
The value of R is used as the base autocorrelation in a first-order, serial correlation pattern. 
For example, R = 0.6 and p = 6, the correlation matrix would appear as 

R =

⎣

⎢
⎢
⎢
⎢

⎦

⎥
⎥
⎥
⎥

0 216 0 360 0 600 1 0 600 0 360
0130 0 216 0 360 0 600 1 0 600
0 078 0130 0 216 0 360 0 600 1

. . . . .

. . . . .

. . . . .

 

This pattern is often chosen as the most realistic when little is known about the correlation 
pattern and the responses variables are measured across time. 

Covariance Matrix Specification- 
Input Method = ‘Covariance Matrix 
Variables’ 
This option instructs the program to read the covariance matrix from the spreadsheet. 

Spreadsheet Columns Containing the Covariance Matrix 
This option designates the columns on the current spreadsheet holding the covariance matrix. It is 
used when the ‘Specify Which Covariance Matrix Input Method to Use’ option is set to 
Covariance Matrix Variables. The number of columns and number of rows must match the 
number of response variable at which the subjects are measured. 

Reports Tab 
This tab specifies which reports and graphs are displayed as well as their format. 

Select Output – Numeric Reports 

Test in Summary Statement(s) 
Indicate the test that is to be reported on in the Summary Statements. 



605-12  Multivariate Analysis of Variance (MANOVA) 

Report Options 

Maximum Term-Order Reported 
Indicate the maximum order of terms to be reported on. Occasionally, higher-order interactions 
are of little interest and so they may be omitted. For example, enter a ‘2’ to limit output to 
individual factors and two-way interactions. 

Skip Line After 
The names of the terms can be too long to fit in the space provided. If the name contains more 
characters than this, the rest of the output is placed on a separate line. Enter ‘1’ when you want 
every term’s results printed on two lines. Enter ‘100’ when you want every variable’s results 
printed on one line. 

Example 1 – Determining Power 
Researchers are planning a study of the impact of a drug. They want to evaluate the differences in 
heart rate and blood pressure among three age groups: 20-40, 41-60, and over 60. They want to be 
able to detect a 10% change in heart rate and in blood pressure among the age groups. They plan 
to analyze the data using Wilks’ lambda.   

Previous studies have found an average heart rate of 93 with a standard deviation of 4 and an 
average blood pressure of 130 with a standard deviation of 5. The correlation between the two 
responses will be set at 0.7.  

From a heart rate of 93, a 10% reduction gives 84. They want to be able to detect age-group 
heart-rate means the range from 93 to 84. From a blood pressure of 130, a 10% reduction gives 
117. The want to be able to detect age-group blood-pressure means that range from 130 to 117. 
Hence, the means matrix that they will use is 

C1 C2 C3 
93 88 84 
130 124 117 

Base on the standard deviation settings that they chose to use, the covariance matrix will be 

C4 C5  
16 14  
14 25  

In order to understand the relationship between power and sample size, they decide to calculate 
power values for sample sizes between 2 and 12, using a 0.05 significance level.  

For your convenience, the Means Matrix and Covariance Matrix have been stored in a 
spreadsheet called PASSMANOVA1.S0. You can enter the above values yourself or you can 
open that spreadsheet. 
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multivariate Analysis of Variance (MANOVA) procedure 
window by expanding Means, then Multivariate Means, then clicking on MANOVA, and then 
clicking on Multivariate Analysis of Variance (MANOVA). You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing 
Open Example Template. You can see that the values have been loaded into the spreadsheet by 
clicking on the spreadsheet button. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta  
n (Subjects Per Group) ........................... 2 4 6 8 10 12 
=n’s .......................................................... Checked  
Number of Response Variables .............. 2 
Means Matrix ........................................... C1-C3  
K (Means Multipliers) .............................. 0.5 1 1.5 
For Factor F1 
Label........................................................ A 
Levels ...................................................... 3 
Alpha ....................................................... 0.05 
Power ...................................................... Ignored since this is the Find setting 

Covariance Tab 
Specify Covariance Method .................... 2) Covariance Matrix Variables  
Spreadsheet Columns ............................. C4-C5 

Reports Tab 
Numeric Results by Term........................ Checked 
Numeric Results by Design ..................... Not Checked  
Wilks’ Lambda ......................................... Checked 
Pillai-Bartlett ............................................ Not checked 
Hotelling-Lawley ...................................... Not checked 
Means Matrix ........................................... Checked 
Covariance Matrix ................................... Checked 
Test in Summary Statement ................... Wilks Lambda 
Show Plot 1 ............................................. Checked 
Show Plot 2 ............................................. Checked 
Test That is Plotted ................................. Wilks Lambda 
Max Term-Order Plotted ......................... 2 
Max Term-Order Reported ...................... 2 



605-14  Multivariate Analysis of Variance (MANOVA) 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Term Report 
 

Results for Factor A (Levels = 3) 
    Multiply  Approx. 
    Means Test F  
Test Power n N By Statistic Statistic DF1|DF2 Alpha Beta  
Wilks 0.0729 2 6 0.50 0.2115 0.27 4|4 0.0500 0.9271  
Wilks 0.1291 2 6 1.00 0.4654 0.87 4|4 0.0500 0.8709  
Wilks 0.2046 2 6 1.50 0.6185 1.62 4|4 0.0500 0.7954  
Wilks 0.1888 4 12 0.50 0.1562 0.74 4|16 0.0500 0.8112  
Wilks 0.5749 4 12 1.00 0.3853 2.51 4|16 0.0500 0.4251  
Wilks 0.8722 4 12 1.50 0.5443 4.78 4|16 0.0500 0.1278  
Wilks 0.3191 6 18 0.50 0.1437 1.17 4|28 0.0500 0.6809  
Wilks 0.8548 6 18 1.00 0.3648 4.02 4|28 0.0500 0.1452  
Wilks 0.9916 6 18 1.50 0.5241 7.71 4|28 0.0500 0.0084  
Wilks 0.4488 8 24 0.50 0.1382 1.60 4|40 0.0500 0.5512  
Wilks 0.9603 8 24 1.00 0.3554 5.51 4|40 0.0500 0.0397  
Wilks 0.9997 8 24 1.50 0.5147 10.61 4|40 0.0500 0.0003  
Wilks 0.5678 10 30 0.50 0.1351 2.03 4|52 0.0500 0.4322  
Wilks 0.9907 10 30 1.00 0.3500 7.00 4|52 0.0500 0.0093  
Wilks 1.0000 10 30 1.50 0.5092 13.49 4|52 0.0500 0.0000  
Wilks 0.6704 12 36 0.50 0.1331 2.46 4|64 0.0500 0.3296  
Wilks 0.9981 12 36 1.00 0.3465 8.48 4|64 0.0500 0.0019  
Wilks 1.0000 12 36 1.50 0.5057 16.37 4|64 0.0500 0.0000 
 
Summary Statements 
A MANOVA design with 1 factor and 2 response variables has 3 groups with 2 subjects each for a 
total of 6 subjects. This design achieves 7% power to test factor A if a Wilks' Lambda 
Approximate F Test is used with a 5% significance level. 
  

This report gives the power for each value of n and K. It is useful when you want to compare the 
powers of the terms in the design at a specific sample size. 

In this example, for K = 1, the design goal of 0.95 power is achieved for n = 8. 

The definitions of each of the columns of the report are as follows. 

Test 
This column identifies the test statistic. Since the power depends on the test statistic, you should 
make sure that this is the test statistic that you will use in your analysis. 

Power 
This is the computed power for the term. 

n 
The value of n is the number of subjects per group. 

N 
The value of N is the total number of subjects in the study. 

Multiply Means By 
This is the value of the means multiplier, K.  
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Test Statistic 
This is the value of the test statistic computed at the hypothesized values. The name of the 
statistic is identified in the Test column. Possible values are Wilks’ lambda, Pillai-Bartlett trace, 
or Hotelling-Lawley trace. The actual formulas used were given earlier in the Technical Details 
section. 

Approx. F Statistic 
This is the value of the F statistic that is used to compute the probability levels. This value is 
calculated using the hypothesized values. The actual formulas used were given earlier in the 
Technical Details section. 

DF1|DF2 
These are the numerator and denominator degrees of freedom of the approximating F distribution. 

Alpha 
Alpha is the significance level of the test. 

Beta 
Beta is the probability of failing to reject the null hypothesis when the alternative hypothesis is 
true. 

Means Matrix 
 

Means Matrix Section 
Name A1 A2 A3 
Y1 93.00 88.00 84.00 
Y2 130.00 124.00 117.00 
 

This report shows the means matrix that was read in. It may be used to get an impression of the 
magnitude of the difference among the means that is being studied. When a Means Multiplier, K, 
is used, each value of K is multiplied times each value of this matrix. 

Variance-Covariance Matrix Section 
 

Variance-Covariance Matrix Section 
 

Response Y1 Y2 
Y1 4.00 0.70 
Y2 0.70 5.00 

 

This report shows the variance-covariance matrix that was read in from the spreadsheet or 
generated by the settings of on the Covariance tab. The standard deviations are given on the 
diagonal and the correlations are given off the diagonal. 
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Plots Section 
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These charts show the relationship between power and n for each value of K. Note that high-order 
interactions may be omitted from the plot by reducing the Maximum Term-Order Plotted option 
on the Reports tab. 
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These charts show the relationship between power and K for each value of n. Remember that K is 
the mean multiplier. It changes the effect size. 
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Example 2 – Validation 
In this example, we will set p = 2, q = 3, alpha = 0.05, and n = 4. The mean and covariance 
matrices are  
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The X’X  matrix is  
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The matrix Θ  is 
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The matrix H is 
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The matrix E is 
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T H E= +

=
⎡
⎢

⎤
⎥

44 13

⎣ ⎦13 38 2
3  



605-18  Multivariate Analysis of Variance (MANOVA) 

Using these matrices, we can calculate the values of the test statistics. We will only calculate the 
results for Wilks’ lambda. We have 
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For an F with 4 and 16 degrees of freedom, the 5% critical value is 3.0069172799. Finally, 
compute the power using a noncentral F with 4 and 16 degrees of freedom and noncentrality 
parameter 

( )Power f F df df= > = = =

=

Pr | , , .
.

1 24 16 196836120
01370631884

λ
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In order to run this example in PASS, the values of the means and the covariance matrix (given 
above) must be entered on a spreadsheet. The instructions below assume that the means are in 
columns C1-C3, while the covariance matrix is in columns C4-C5.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multivariate Analysis of Variance (MANOVA) procedure 
window by expanding Means, then Multivariate Means, then clicking on MANOVA, and then 
clicking on Multivariate Analysis of Variance (MANOVA). You may then make the 
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing 
Open Example Template. You can see that the values have been loaded into the spreadsheet by 
clicking on the spreadsheet button. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta  
n (Subjects Per Group) ........................... 4 
=n’s .......................................................... Checked  
Number of Response Variables .............. 2 
Means Matrix ........................................... C1-C3  
K (Means Multipliers) .............................. 1 
For Factor F1 
Label........................................................ A 
Levels ...................................................... 3 
Alpha ....................................................... 0.05 
Power ...................................................... Ignored since this is the Find setting 

Covariance Tab 
Specify Covariance Method .................... 2) Covariance Matrix Variables  
Spreadsheet Columns ............................. C4-C5 

Reports Tab 
Numeric Results by Term........................ Checked 
Numeric Results by Design ..................... Not Checked  
Wilks’ Lambda ......................................... Checked 
Pillai-Bartlett ............................................ Not checked 
Hotelling-Lawley ...................................... Not checked 
Means Matrix ........................................... Checked 
Covariance Matrix ................................... Checked 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Term Report 
 

Results for Factor A (Levels = 3) 
    Multiply  Approx. 
    Means Test F  
Test Power n N By Statistic Statistic DF1|DF2 Alpha Beta  
Wilks 0.1371 4 12 1.0000 0.7929 0.4921 4|16 0.0500 0.8629  
  

As you can see, the power computed here matches the results we computed manually. 
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Chapter 610 

One-Sample or 
Paired T-Test for 
Microarray Data 
Introduction 
This chapter describes how to estimate power and sample size (number of arrays) for paired and 
one sample microarray studies using the PASS: One-Sample or Paired T-Test for Microarray 
Data procedure. False discovery rate and experiment-wise error rate control methods are available 
in this procedure. Values that can be varied in this procedure are power, false discovery rate and 
experiment-wise error rate, sample size (number of arrays), the minimum mean difference 
detected, the standard deviation, and in the case of false discovery rate control, the number of 
genes with minimum mean difference.  

Paired Design (Two-Channel Arrays) 
The paired design is often used in two-channel experiments when the gene expression 
comparison to be made involves a natural pairing of experimental units.  

As an example, suppose 6 cell samples will be available for comparison. A portion of each of the 
6 cell samples (before treatment) is to be reserved as a control. The same treatment will then be 
given to each of the 6 remaining portions of the samples. It is of interest to determine the genes 
that are differentially expressed when the treatment is given. In this scenario there is a natural 
before/after treatment pairing for each sample. The reserved control portions of each sample will 
be labeled with Cyanine 3 (Cy3, green) dye, while the treatment portions are to be labeled with 
Cyanine 5 (Cy5, red) dye. From each sample, the labeled control and the labeled treatment 
portions will be mixed and exposed to an array. The control and treatment portions compete to 
bind at each spot. The expression of treatment and control samples for each gene will be 
measured with laser scanning. A pre-processing procedure is then used to obtain expression 
difference values for each gene. In this example, the result will be 6 relative expression values 
(e.g., Log2(Post / Pre)) for each gene represented on the arrays. 
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Paired Design, Six Arrays 
Channel 1:    
Cyanine 5     
(Cy5, red) 

Channel 2:      
Cyanine 3       

(Cy3, green) 

Sample 1 

Post-
Treatment 

Pre-
Treatment 

Sample 2

Post-
Treatment 

Pre-
Treatment 

Sample 3 

Post-
Treatment 

Pre-
Treatment 

Sample 4 

Post-
Treatment 

Pre-
Treatment 

Sample 5

Post-
Treatment 

Pre-
Treatment 

Sample 6 

Post-
Treatment 

Pre-
Treatment 

 

Null and Alternative Hypotheses 
The paired test null hypothesis for each gene is H0: μdiff  = μ0, where μdiff is the true mean 
difference in expression for a particular gene, and μ0  is the hypothesized difference in expression. 
The alternative hypothesis may be any one of the following: Ha: μdiff  < μ0, Ha: μdiff  > μ0, or Ha: 
μdiff  ≠ μ0. The choice of the alternative hypothesis depends upon the goals of the research. For 
example, if the goal of the experiment is to determine which genes are differentially expressed, 
without regard to direction, the alternative hypothesis would be Ha: μdiff  ≠ μ0. If, however, the 
goal is to identify only genes which have increased expression after the treatment is applied, the 
alternative hypothesis would be Ha: μdiff  > μ0. A common value for μ0  in a paired sample 
experiment is 0. 

T-Test Formula 
For testing the hypothesis H0: μdiff  = μ0, the formula for the paired T-statistic is: 

n
s

 - x
 =T

paired

opaired
paired

μ
 

where pairedx  is mean difference in expression of n replicates for a given gene, μ0 is the 
hypothesized mean, and spaired is standard deviation of the differences of the n replicates. If the 
assumptions (described below) of the test are met, the distribution of Tpaired is the standard t 
distribution with n – 1 degrees of freedom. P-values are obtained from Tpaired by finding the 
proportion of the t distribution that is more extreme than Tpaired . 
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Assumptions 
The assumptions of the paired t-test are: 

1. The data are continuous (not discrete). Because of the large range of possible intensities, 
microarray expression values can be considered continuous. 

2. The data, i.e., the expression differences for the pairs, follow a normal probability 
distribution. This assumption can be examined in microarray data only if the number of 
arrays in the experiment is reasonably large (>100). 

3. The sample of pairs is a simple random sample from its population. Each individual in 
the population has an equal probability of being selected in the sample. If the samples 
used in the microarray experiment are not random, bias may easily be introduced into the 
results. 

One-Sample Design 
The one-sample design is the simplest of all designs. A single mRNA or cDNA sample is 
obtained from each experimental unit of a single group. Each sample is exposed to a single 
microarray, resulting in a single expression value for each gene for each unit of the group. The 
goal is to determine for each gene whether there is evidence that the expression is different from 
some null value. This design may be useful for determining whether or not each gene is expressed 
at all, or for comparing expression of each gene to a hypothesized expression level. 

Null and Alternative Hypotheses 
The one-sample null hypothesis for each gene is H0: μ  = μ0, where μ is the true mean expression 
for that particular gene, and μ0  is the hypothesized mean, or the mean to be compared against. 
The alternative hypothesis may be any one of the following: Ha: μ  < μ0, Ha: μ  > μ0, or Ha: μ  ≠ 
μ0. The choice of the alternative hypothesis depends upon the goals of the research. For example, 
if the goal of the experiment is to determine which genes are expressed above a certain level, the 
alternative hypothesis would be Ha: μ  > μ0. 

T-Test Formula 
For testing the hypothesis H0: μ  = μ0, the formula for the one-sample T-statistic is: 

n
s
 - x

 =T oμ
 

where x  is mean expression of n replicates for a given gene, μ0 is the hypothesized mean, and s 
is standard deviation of the n replicates. If the assumptions (described below) of the test are met, 
the distribution of T is the standard t distribution with n – 1 degrees of freedom. P-values are 
obtained from T by finding the proportion of the t distribution that is more extreme than T. 
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Assumptions 
The assumptions of the one-sample T-test are: 

1. The data are continuous (not discrete). Because of the large range of possible intensities, 
microarray expression values can be considered continuous. 

2. The data follow the normal probability distribution. This assumption can be examined in 
microarray data only if the number of arrays in the experiment is reasonably large (>300). 

3. The sample is a simple random sample from its population. Each individual in the 
population has an equal probability of being selected in the sample. If the samples used in 
the microarray experiment are not random, bias may easily be introduced into the results. 

Technical Details 

Multiple Testing Adjustment 
When a one-sample/paired T-test is run for a replicated microarray experiment, the result is a list 
of P-values (Probability Level) that reflect the evidence of difference in expression. When 
hundreds or thousands of genes are investigated at the same time, many ‘small’ P-values will 
occur by chance, due to the natural variability of the process. It is therefore requisite to make an 
appropriate adjustment to the P-value (Probability Level), such that the likelihood of a false 
conclusion is controlled.  

False Discovery Rate Table 
The following table (adapted to the subject of microarray data) is found in Benjamini and 
Hochberg’s (1995) false discovery rate article. In the table, m is the total number of tests, m0 is 
the number of tests for which there is no difference in expression, R is the number of tests for 
which a difference is declared, and U, V, T, and S are defined by the combination of the 
declaration of the test and whether or not a difference exists, in truth. 
 

           Declared       Declared 
       Not Different       Different       Total 

     A true difference in  
expression does not exist  U  V         m0 

     There exists a true  
difference in expression  T  S      m – m0  

    Total         m – R  R         m 

 
In the table, the m is the total number of hypotheses tested (or total number of genes) and is 
assumed to be known in advance. Of the m null hypotheses tested, m0 is the number of tests for 
which there is no difference in expression, R is the number of tests for which a difference is 
declared, and U, V, T, and S are defined by the combination of the declaration of the test and 
whether or not a difference exists, in truth. The random variables U, V, T, and S are unobservable. 
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Need for Multiple Testing Adjustment 
Following the calculation of a raw P-value (Probability Level) for each test, P-value adjustments 
need be made to account in some way for multiplicity of tests. It is desirable that these 
adjustments minimize the number of genes that are falsely declared different (V) while 
maximizing the number of genes that are correctly declared different (S). To address this issue the 
researcher must know the comparative value of finding a gene to the price of a false positive. If a 
false positive is very expensive, a method that focuses on minimizing V should be employed. If 
the value of finding a gene is much higher than the cost of additional false positives, a method 
that focuses on maximizing S should be used.  

Error Rates – P-Value Adjustment Techniques 
Below is a brief description of three common error rates that are used for control of false positive 
declarations. The commonly used P-value adjustment technique for controlling each error rate is 
also described.  

Per-Comparison Error Rate (PCER) – No Multiple Testing Adjustment 
The per-comparison error rate (PCER) is defined as 

PCER ( ) /E V m= , 

where E(V) is the expected number of genes that are falsely declared different, and m is the total 
number of tests. Preserving the PCER is tantamount to ignoring multiple testing altogether. If a 
method is used which controls a PCER of 0.05 for 1,000 tests, approximately 50 out of 1,000 
tests will falsely be declared significant. Using a method that controls the PCER will produce a 
list of genes that includes most of the genes for which there exists a true difference in expression 
(i.e., maximizes S), but it will also include a very large number of genes which are falsely 
declared to have a true difference in expression (i.e., does not appropriately minimize V). 
Controlling the PCER should be viewed as overly weak control of Type I error. 

To obtain P-values (Probability Levels) that control the PCER, no adjustment is made to the P-
value. To determine significance, the P-value is simply compared to the designated alpha. 

Experiment-Wise Error Rate (EWER) 
The experiment-wise error rate (EWER) is defined as 

EWER = Pr(V > 0), 

where V is the number of genes that are falsely declared different. Controlling EWER is 
controlling the probability that a single null hypothesis is falsely rejected. If a method is used 
which controls a EWER of 0.05 for 1,000 tests, the probability that any of the 1,000 tests 
(collectively) is falsely rejected is 0.05. Using a method that controls the EWER will produce a 
list of genes that includes a small (depending also on sample size) number of the genes for which 
there exists a true difference in expression (i.e., limits S, unless the sample size is very large). 
However, the list of genes will include very few or no genes that are falsely declared to have a 
true difference in expression (i.e., stringently minimizes V). Controlling the EWER should be 
considered very strong control of Type I error. 

Assuming the tests are independent, the well-known Bonferroni P-value adjustment produces 
adjusted P-values (Probability Levels) for which the EWER is controlled. The Bonferroni 
adjustment is applied to all m unadjusted P-values ( jp ) as 

min( ,1)j jp mp=% . 
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That is, each P-value (Probability Level) is multiplied by the number of tests, and if the result is 
greater than one, it is set to the maximum possible P-value of one. 

False Discovery Rate (FDR) 
The false discovery rate (FDR) (Benjamini and Hochberg, 1995) is defined as 

{ 0}FDR ( 1 ) ( | 0) Pr( 0)R
V VE E R R
R R>= = > > , 

where R is the number of genes that are declared significantly different, and V is the number of 
genes that are falsely declared different. Controlling FDR is controlling the expected proportion 
of falsely declared differences (false discoveries) to declared differences (true and false 
discoveries, together). If a method is used which controls a FDR of 0.05 for 1,000 tests, and 40 
genes are declared different, it is expected that 40*0.05 = 2 of the 40 declarations are false 
declarations (false discoveries). Using a method that controls the FDR will produce a list of genes 
that includes an intermediate (depending also on sample size) number of genes for which there 
exists a true difference in expression (i.e., moderate to large S). However, the list of genes will 
include a small number of genes that are falsely declared to have a true difference in expression 
(i.e., moderately minimizes V). Controlling the FDR should be considered intermediate control of 
Type I error. 

Multiple Testing Adjustment Comparison 
The following table gives a summary of the multiple testing adjustment procedures and error rate 
control. The power to detect differences also depends heavily on sample size.  
 

 Common  
Adjustment Error Rate   Control of        Power to 
Technique Controlled Type I Error Detect Differences 

    None        PCER    Minimal           High 

Bonferroni    EWER     Strict                      Low 

          Benjamini and     FDR   Moderate            Moderate/High 
 Hochberg 

 

Type I Error: Rejection of a null hypothesis that is true. 

Calculating Power  
When the standard deviation is unknown, the power is calculated as follows for a directional 
alternative (one-tailed test) in which Diff > 0. Additional details of calculating power in the one-
sample/paired scenario are found in the PASS chapter for One Mean. 

1. Find tα  such that , where ( )1− =T tdf α α ( )T tdf α  is the area under a central-t curve to 
the left of x and df = n - 1. 

2. Calculate: .
n

t=xa
σ

α  
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3. Calculate the non-centrality parameter: .

n

Diff=a σλ  

4. Calculate: .+

n

Diff-x=t a
a

a λσ  

5. Calculate: Power = ( )1− ′T tdf a,λ , where ( )′T xdf ,λ  is the area under a noncentral-t curve 
with degrees of freedom df and noncentrality parameter λ  to the left of x. 

Adjusting Alpha 

Experiment-wise Error Rate 
When the Bonferroni method will be used to control the experiment-wise error rate, EWERα , of all 
tests, the adjusted α , ADJα , for each test is given by 

Tests ofNumber 
= EWER

ADJ
αα  

ADJα is the value that is used in the power and sample size calculations. 

False Discovery Rate 
When a false discovery rate controlling method will be used to control the false discovery rate for 
the experiment, fdr, the adjusted α , ADJα , for each test is given by Jung (2005) and Chow, 
Shao, and Wang (2008): 

( )( )( )
( )( )fdrKN

fdrK=
T

ADJ −−
−

1
1 βα  

where K is the number of genes with differential expression, β is the probability of a Type II error 
(not declaring a gene significant when it is), and NT  is the total number of tests. 

ADJα is the value that is used in the power and sample size calculations. Because ADJα  depends 
on β, ADJα  must be solved iteratively when the calculation of power is desired. 



610-8  One-Sample or Paired T-Test for Microarray Data 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Options, and Reports tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data Tab 
The Data tab contains most of the parameters and options involved in the power and sample size 
calculations. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated from the values of the other parameters. 
Under most conditions, you would select either Power and Beta or N. 

Select N when you want to determine the sample size needed to achieve a given power and false 
discovery rate (or alpha) error level.  

Select Power and Beta when you want to calculate the power of an experiment.  

Error Rates 

Power for each Gene 
Power is the probability of rejecting each null hypothesis when it is false. Power is equal to 1-
Beta. 

The POWER for each gene represents that probability of detecting differential expression when it 
exists. 

RANGE: The valid range is from 0 to 1. 

RECOMMENDED: Popular values for power are 0.8 and 0.9. 

NOTES: You can enter a range of values such as .70 .80 .90 or .70 to .95 by .05. 

False Discovery (Alpha) Method 
A type I error is declaring a gene to be differentially expressed when it is not. The two most 
common methods for controlling type I error in microarray expression studies are false discovery 
rate (FDR) control and Experiment-wise Error Rate (EWER) control. 

• FDR 
Controlling the false discovery rate (FDR) controls the PROPORTION of genes that are 
falsely declared differentially expressed. For example, suppose that an FDR of 0.05 is used 
for 10000 tests (on 10000 genes). If differential expression is declared for 100 of the 10000 
genes, 5 of the 100 genes are expected to be false discoveries. 
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• EWER 
Controlling the experiment-wise error rate (EWER) controls the PROBABILITY of ANY 
false declarations of differential expression, across all tests. For example, suppose that an 
EWER of 0.05 is used for 10000 tests (on 10000 genes). If differential expression is declared 
for 100 of the 10000 genes, the probability that even one of the 100 declarations is false is 
0.05. 

Recommendation: For exploratory studies where a list of candidate genes for further study is the 
goal, FDR is the recommended Type I error control method, because of its higher power. 

For confirmatory studies where final determination of differential expression is the goal, EWER 
is the recommended Type I error control method, because of its strict control of false discoveries. 

FDR or EWER Value 
Specify the value for the False Discovery (Alpha) Method selected above.  

RANGE: These levels are bounded by 0 and 1. Commonly, the chosen level is between 0.001 and 
0.250 

RECOMMENDED: FDR or EWER is often set to 0.05 for two-sided tests and to 0.025 for one-
sided tests. 

NOTE: You can enter a list of values such as .05 .10 .15 or .05 to .15 by .01. 

Sample Size 

N (Number of Arrays) 
Enter a value for the sample size (N). This is the number of arrays in the experiment. For two-
channel paired experiments, this is the number of arrays, not the number of samples. You may 
enter a range such as 10 to 100 by 10 or a list of values separated by commas or blanks.  

Effect Size 

D (Minimum Mean Difference Detected) 
Specify the true mean difference in expression (D) such that genes with true mean difference 
above D will be detected at the given power and corresponding sample size. 

In paired expression studies, it is very common that the difference in expression is measured on 
the log scale (e.g., log2(A) – log2(B)). Values of D should reflect the differences that will be used 
in testing. For example, if log2 differences are used, D = 1 implies a two-fold difference in 
expression, while D = 2 implies a four-fold difference in expression. 

When D is large, the resulting sample size will only detect the genes with extreme differential 
expression. 

When D is small, a larger sample size is required to have power sufficient to detect these small 
differences in expression. 

You can enter a range of values such as 1 2 3 or 0.2 to 2 by 0.1. 
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S (Standard Deviation of Paired Differences in Expression) 
Specify the standard deviation of paired differences. This standard deviation is assumed for all 
tests. 

S should be on the same scale as D. 

To obtain the standard deviation of paired differences from the standard deviation of expression, 
use SDpaired = (sqrt(2))*(SDexpression). 

Because the true variation in paired differences will vary from gene to gene, it is recommended 
that a range of values be entered here. 

You can enter a range of values such as 1 2 3 4 5 or 0.2 to 2 by 0.1. 

Number of Genes 

Number of Genes Tested 
Specify the number of genes for which hypothesis tests will be made. 

This number will usually be the number of genes summarized on each array minus the number of 
housekeeping genes. 

Only one number may be entered in this box. 

Number of Genes – FDR Only 

K (Number of Genes with Mean Difference > D) 
Specify the number of genes for which a true mean difference in expression greater than D is 
expected. 

K for EWER 
The choice of K has no direct effect on the calculation of power or sample size when the False 
Discovery (Alpha) Method is set to EWER. K is not used when False Discovery (Alpha) method 
is set to EWER. 

K for FDR 
The choice of K has direct effect on the calculation of power or sample size when the False 
Discovery (Alpha) Method is set to FDR. 

You can enter a range of values such as 10 20 30 40 50 or 20 to 100 by 10.  

Test 

Alternative 
Specify whether the hypothesis test for each gene is one-sided (directional) or two-sided (non-
directional). 

Recommendation: In most paired experiments, differential expression in either direction (up-
regulation or down-regulation) is of interest. Such experiments should have the Two-Sided 
alternative hypothesis. 
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For experiments for determining whether there is expression above some threshold, a One-Sided 
alternative hypothesis is recommended. Often regulations dictate that the FDR or EWER level be 
divided by 2 for One-Sided alternative tests. 

Test Type 
Select the type of test that will be used when the analysis of the gene expression data is carried 
out. 

• T 
The T-Test assumes the paired differences come from a normal distribution with 
UNKNOWN standard deviation (i.e., a standard deviation that will be estimated from the 
data). 

• Z 
The Z-Test assumes the paired differences come from a normal distribution with KNOWN 
standard deviation. 

Recommendation: Because it very rare to know the true standard deviation of paired differences 
in advance, T is the recommended test statistic. 

Options Tab 
The Options tab contains convergence and iteration options that are rarely changed. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the criterion of interest is 
aborted. When the maximum number of iterations is reached without convergence, the criterion is 
left blank.  

RECOMMENDED: 500 (or more) 

Convergence Options 

FDR Power Convergence 
When FDR is selected for False Discovery (Alpha) Method, and Find (Solve For) is set to Power, 
the corresponding search algorithm will converge when the search criteria is below this value. 

This value will rarely be changed from the default value. 

RECOMMENDED: 0.0000000001  
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Example 1 – Finding Power 
This example examines the power to detect differential expression for an experiment that 
involved 22 two-channel arrays. Two samples were obtained from each of 22 individuals. One of 
the two samples was randomly assigned the treatment and the other remained as the control. 
Following treatment, the two samples were exposed to a single microarray. Each microarray 
produced intensity information for 10,000 genes. The 22 arrays were pre-processed by subtracting 
the control intensity (Log2) from the treatment intensity for each gene on each array. Thus, a 
positive value implies upward expression in the treatment, while a negative value implies down-
regulation in the treatment. In this example, the paired T-test was used to determine which genes 
were differentially expressed (upward or downward) following exposure to the treatment.   

The researchers found very few differentially expressed genes, and wish to examine the power of 
the experiment to detect two-fold differential expression (Log2-scale difference of 1). Typical 
standard deviations of the Log2 paired differences ranged from 0.2 to 2.0. 

The researchers guess the number of genes with at least 2-fold differential expression to be 
around 50, but will examine the effect of this estimate on power by trying 10 and 100 genes as 
well. A false discovery rate of 0.05 was used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power for each Gene .............................. Ignored since this is the Find setting 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N (Number of Arrays) .............................. 22 
D (Difference) .......................................... 1.0 
S (Standard Deviation) ............................ 0.2 to 2 by .2 
Number of Genes Tested ........................ 10000 
K (Number > D) ....................................... 10 50 100 
Alternative Hypothesis ............................ Two-Sided 
Test Type ................................................ T 

Reports Tab 
Numeric Reports ..................................... All Checked 
Show Summary Statements.................... 1 
Show Plots .............................................. Checked 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations should take a few moments. 

Numeric Results 
 
 Numeric Results for One-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 Number of Genes Tested: 10000 
 
   Minimum Std.  Number False  
  Number Mean Dev. Effect Genes Discovery  
  of Arrays Difference of Diff. Size To Detect Rate  
 Power (N) (D) (S) (ES) (K) (FDR) Beta 
 1.00000 22 1.0 0.2 5.000 10 0.0500 0.00000 
 1.00000 22 1.0 0.2 5.000 50 0.0500 0.00000 
 1.00000 22 1.0 0.2 5.000 100 0.0500 0.00000 
 1.00000 22 1.0 0.4 2.500 10 0.0500 0.00000 
 1.00000 22 1.0 0.4 2.500 50 0.0500 0.00000 
 1.00000 22 1.0 0.4 2.500 100 0.0500 0.00000 
 0.98617 22 1.0 0.6 1.667 10 0.0500 0.01383 
 0.99793 22 1.0 0.6 1.667 50 0.0500 0.00207 
 0.99924 22 1.0 0.6 1.667 100 0.0500 0.00076 
 0.71696 22 1.0 0.8 1.250 10 0.0500 0.28304 
 0.89092 22 1.0 0.8 1.250 50 0.0500 0.10908 
 0.93538 22 1.0 0.8 1.250 100 0.0500 0.06462 
 . . . . . . . . 
 . . . . . . . . 
 . . . . . . . . 
 
 References 
 Jung, S.-H. 2005. Sample size for FDR-control in microarray data analysis. Bioinformatics: Vol. 21 no. 14, pp. 
 3097-3104. Oxford University Press. 
 Machin, D., Campbell, M., Fayers, P., and Pinol, A. 1997. Sample Size Tables for Clinical Studies, 2nd 
 Edition. Blackwell Science. Malden, MA. 
 Zar, Jerrold H. 1984. Biostatistical Analysis (Second Edition). Prentice-Hall. Englewood Cliffs, New Jersey. 
 
 Report Definitions 
 Power is the individual probability of detecting each gene with true mean difference > D. 
 N is the number of arrays required to achieve the corresponding power. 
 D is the smallest difference in expression for which this power and sample size are valid. 
 S is the standard deviation estimate for the paired differences used in each test. 
 ES, or D/S, is the relative magnitude of the true mean expression difference for the genes with true mean 
 difference > D. 
 K is the number of genes with true mean difference > D. 
 FDR is the expected proportion of false declarations of differential expression to total declarations of 
 differential expression. 
 Beta is the individual probability of failing to detect each gene with true mean difference > D. 
 
 Summary Statements 
 A sample size of 22 achieves 100.00% power for each gene to detect a true difference in 
 expression of at least 1.0 with an estimated standard deviation of 0.2 with a false discovery 
 rate of 0.0500 using a two-sided one-sample T-Test. Of the 10 genes with anticipated true mean 
 difference in expression > 1.0, 9 are expected to be detected. 
 

This report shows the values of each of the parameters, one scenario per row. The values of 
power and beta were calculated from the other parameters. 
The definitions of each column are given in the Report Definitions section. 
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Additional Numeric Result Detail 
 
 Additional Numeric Result Detail for One-Sample T-Test 
 Number of Genes To Be Tested: 10000 
 
   Minimum Std. Number False   
  Number Mean Dev. Genes Discovery Single Prob To 
  of Arrays Difference of Diff. To Detect Rate Gene Detect 
 Power (N) (D) (S) (K) (FDR) Alpha All K 
 1.00000 22 1.0 0.2 10 0.0500 0.0000527 1.00000 
 1.00000 22 1.0 0.2 50 0.0500 0.0002645 1.00000 
 1.00000 22 1.0 0.2 100 0.0500 0.0005316 1.00000 
 1.00000 22 1.0 0.4 10 0.0500 0.0000527 1.00000 
 1.00000 22 1.0 0.4 50 0.0500 0.0002645 1.00000 
 1.00000 22 1.0 0.4 100 0.0500 0.0005316 1.00000 
 0.98617 22 1.0 0.6 10 0.0500 0.0000520 0.86996 
 0.99793 22 1.0 0.6 50 0.0500 0.0002639 0.90158 
 0.99924 22 1.0 0.6 100 0.0500 0.0005312 0.92649 
 0.71696 22 1.0 0.8 10 0.0500 0.0000378 0.03589 
 . . . . . . . . 
 . . . . . . . . 
 . . . . . . . . 
  
 Report Definitions 
 Power is the individual probability of detecting each gene with true mean difference > D. 
 N is the number of arrays required to achieve the corresponding power. 
 D is the smallest difference in expression for which this power and sample size are valid. 
 S is the standard deviation estimate for the paired differences used in each test. 
 K is the number of genes with true mean difference > D. 
 FDR is the expected proportion of false declarations of differential expression to total declarations of 
 differential expression. 
 Single Gene Alpha is the probability of falsely declaring differential expression for an individual gene. 
 Prob to Detect All K is the probability of declaring differential expression for all K genes that have true 
 mean difference > D. 
 

This report shows additionally the single gene alpha and the probability of detecting all K 
differentially expressed genes. 
The definitions of each column are given in the Report Definitions section. 

Plots Section 
 

 

Power vs S by K
D=1.0 FDR=0.05 N=22 T-Test

S

Po
w

er

0.2 0.5 0.8 1.1 1.4 1.7 2.0
0.0

0.2

0.4

0.6

0.8

1.0

K
10
50
100

               
   

This plot shows the relationship between power and the standard deviation of the differences for 
various three values of K.  
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Example 2 – Finding the Sample Size 
This example determines the number of two-channel arrays needed to achieve 80% power to 
detect differential expression for each gene. Two samples will be obtained from each of the 
sampled individuals. One of the two samples will be randomly assigned the treatment and the 
other will remain as the control. Following treatment, the two samples will be exposed to a single 
microarray. Each microarray will produce intensity information for 12,682 genes. The arrays will 
be pre-processed by subtracting the control intensity (Log2) from the treatment intensity for each 
gene on each array. Thus, a positive value implies upward expression in the treatment, while a 
negative value implies down-regulation in the treatment. The paired T-test will be used to 
determine which genes are differentially expressed (upward or downward) following exposure to 
the treatment. 

The researchers wish to detect differential expression that is two-fold or greater (Log2-scale 
difference of 1). Typical standard deviations of the Log2 paired differences for this experiment 
are expected to range from 0.2 to 2.0. 

The researchers guess the number of genes with at least 2-fold differential expression to be 
around 50, but will examine the effect of this estimate on sample size by trying 10 and 100 genes 
as well. A false discovery rate of 0.05 will be used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Power for each Gene .............................. 0.80 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N (Number of Arrays) .............................. Ignored since this is the Find setting 
D (Difference) .......................................... 1 
S (Standard Deviation) ............................ 0.2 to 2 by .2 
Number of Genes Tested ........................ 12682 
K (Number > D) ....................................... 10 50 100 
Alternative Hypothesis ............................ Two-Sided 
Test Type ................................................ T 

Reports Tab 
Numeric Reports ..................................... All Checked but Numeric Report Detail 
Show Plots .............................................. Checked 
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Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations may take a few moments. 

Numeric Results 
 
 Numeric Results for One-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 Number of Genes Tested: 12682 
 
   Minimum Std.  Number False  
  Number Mean Dev. Effect Genes Discovery  
  of Arrays Difference of Diff. Size To Detect Rate  
 Power (N) (D) (S) (ES) (K) (FDR) Beta 
 0.96741 8 1.0 0.2 5.000 10 0.0500 0.03259 
 0.97509 7 1.0 0.2 5.000 50 0.0500 0.02491 
 0.91190 6 1.0 0.2 5.000 100 0.0500 0.08810 
 0.88530 12 1.0 0.4 2.500 10 0.0500 0.11470 
 0.86231 10 1.0 0.4 2.500 50 0.0500 0.13769 
 0.83278 9 1.0 0.4 2.500 100 0.0500 0.16722 
 0.81531 17 1.0 0.6 1.667 10 0.0500 0.18469 
 0.85472 15 1.0 0.6 1.667 50 0.0500 0.14528 
 0.86398 14 1.0 0.6 1.667 100 0.0500 0.13602 
 0.83661 25 1.0 0.8 1.250 10 0.0500 0.16339 
 0.82805 21 1.0 0.8 1.250 50 0.0500 0.17195 
 . . . . . . . . 
 . . . . . . . . 
 . . . . . . . . 
 

This report shows the values of each of the parameters, one scenario per row. The sample size 
(number of arrays) estimates were calculated from the other parameters. The power is the actual 
power produced by the given sample size. 

Plots Section 
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This plot shows the relationship between sample size and the standard deviation of the differences 
for three values of K.  
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Example 3 – Finding the Minimum Detectable Difference 
This example finds the minimum difference in expression that can be detected with 90% power 
from a microarray experiment with 14 two-channel arrays. The 14 arrays permit tests on 5,438 
genes. The arrays will be pre-processed by subtracting the control intensity (Log2) from the 
treatment intensity for each gene on each array. Thus, a positive value implies upward expression 
in the treatment, while a negative value implies down-regulation in the treatment. The paired T-
test will be used to determine which genes are differentially expressed (upward or downward) 
following exposure to the treatment. Standard deviations of the Log2 paired differences for this 
experiment range from 0.2 to 1.8. 

In this example we will examine a range for K (the number of genes with mean difference greater 
than the minimum detectable difference), since this should vary with the mean difference chosen. 
A false discovery rate of 0.05 will be used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 3 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Mean Difference 
Power for each Gene .............................. 0.90 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N (Number of Arrays) .............................. 14 
D (Difference) .......................................... Ignored since this is the Find setting 
S (Standard Deviation) ............................ 0.2 to 1.8 by .4 
Number of Genes Tested ........................ 5438 
K (Number > D) ....................................... 10 to 50 by 10 
Alternative Hypothesis ............................ Two-Sided 
Test Type ................................................ T 

Reports Tab 
Numeric Reports ..................................... All Checked but Numeric Report Detail 
Show Plots .............................................. Checked 
Mean Difference and SD Decimals ......... 4 

Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations may take a few moments. 
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Numeric Results 
 
 Numeric Results for One-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 Number of Genes Tested: 5438 
 
   Minimum Std.  Number False  
  Number Mean Dev. Effect Genes Discovery  
  of Arrays Difference of Diff. Size To Detect Rate  
 Power (N) (D) (S) (ES) (K) (FDR) Beta 
 0.90000 14 0.3951 0.2000 1.976 10 0.0500 0.10000 
 0.90000 14 0.3699 0.2000 1.849 20 0.0500 0.10000 
 0.90000 14 0.3555 0.2000 1.777 30 0.0500 0.10000 
 0.90000 14 0.3454 0.2000 1.727 40 0.0500 0.10000 
 0.90000 14 0.3377 0.2000 1.689 50 0.0500 0.10000 
 0.90000 14 1.1854 0.6000 1.976 10 0.0500 0.10000 
 0.90000 14 1.1096 0.6000 1.849 20 0.0500 0.10000 
 0.90000 14 1.0664 0.6000 1.777 30 0.0500 0.10000 
 0.90000 14 1.0363 0.6000 1.727 40 0.0500 0.10000 
 0.90000 14 1.0132 0.6000 1.689 50 0.0500 0.10000 
 0.90000 14 1.9756 1.0000 1.976 10 0.0500 0.10000 
 0.90000 14 1.8493 1.0000 1.849 20 0.0500 0.10000 
 0.90000 14 1.7774 1.0000 1.777 30 0.0500 0.10000 
 0.90000 14 1.7272 1.0000 1.727 40 0.0500 0.10000 
 0.90000 14 1.6887 1.0000 1.689 50 0.0500 0.10000 
 0.90000 14 2.7658 1.4000 1.976 10 0.0500 0.10000 
 0.90000 14 2.5890 1.4000 1.849 20 0.0500 0.10000 
 0.90000 14 2.4884 1.4000 1.777 30 0.0500 0.10000 
 0.90000 14 2.4181 1.4000 1.727 40 0.0500 0.10000 
 0.90000 14 2.3642 1.4000 1.689 50 0.0500 0.10000 
 0.90000 14 3.5561 1.8000 1.976 10 0.0500 0.10000 
 0.90000 14 3.3287 1.8000 1.849 20 0.0500 0.10000 
 0.90000 14 3.1993 1.8000 1.777 30 0.0500 0.10000 
 0.90000 14 3.1090 1.8000 1.727 40 0.0500 0.10000 
 0.90000 14 3.0397 1.8000 1.689 50 0.0500 0.10000 
 

This report shows the values of each of the parameters, one scenario per row. The Minimum 
Mean Difference (D) estimates were calculated from the other parameters. 

Plots Section 
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This plot shows the relationship between D (the minimum detectable difference on the Log2 
scale) and the standard deviation of the differences for five values of K.  
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Example 4 – Validation (EWER) using Stekel 
Stekel (2003), pp. 226-228, gives an example in which N = 20, D = 1, and S = 0.68 for a two-
sided paired T-Test. The number of genes tested is 6500. The control of false discoveries is “no 
more than one false positive.” This corresponds to an EWER value of 0.975. The power obtained 
for this example is 0.94.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 4 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power for each Gene .............................. Ignored since this is the Find setting 
False Discovery (Alpha) Method ............. EWER (Experiment-wise Error Rate) 
FDR or EWER Value ............................... 0.975 
N (Number of Arrays) .............................. 20 
D (Difference) .......................................... 1 
S (Standard Deviation) ............................ 0.68 
Number of Genes Tested ........................ 6500 
K (Number > D) ....................................... Ignored since EWER is used 
Alternative Hypothesis ............................ Two-Sided 
Test Type ................................................ T 

Reports Tab 
Reports .................................................... All Checked but Numeric Report Detail 
Mean Difference and SD Decimals ......... 2 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for One-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 Number of Genes Tested: 6500 
 
   Minimum Std.  Experiment   
  Number Mean Dev. Effect -Wise Single  
  of Arrays Difference of Diff. Size Error Rate Gene  
 Power (N) (D) (S) (ES) (EWER) Alpha Beta 
 0.93591 20 1.00 0.68 1.471 0.9750 0.0001500 0.06409 
 

The power of 0.93591 matches Stekel’s result. 
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Example 5 – Validation (EWER) using Lee 
Lee (2004), pp. 218-220, gives an example in which Power = 0.90, D = 1.0 1.5 2.0 2.5 and S = 
1.0 for a two-sided paired Z-Test. The number of genes tested is 1000. The control of false 
discoveries is 0.5. This corresponds to an EWER value of 0.5. This setup corresponds to the 
upper left corner of Table 14.3 on page 219. The sample sizes obtained for this setup are 23, 11, 
6, and 4, respectively. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 5 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Power for each Gene .............................. 0.90 
False Discovery (Alpha) Method ............. EWER (Experiment-wise Error Rate) 
FDR or EWER Value ............................... 0.5 
N (Number of Arrays) .............................. Ignored since this is the Find setting  
D (Difference) .......................................... 1.0 1.5 2.0 2.5 
S (Standard Deviation) ............................ 1.0 
Number of Genes Tested ........................ 1000 
K (Number > D) ....................................... Ignored since EWER is used 
Alternative Hypothesis ............................ Two-Sided 
Test Type ................................................ Z 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for One-Sample Z-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 Number of Genes Tested: 1000 
 
   Minimum Std.  Experiment   
  Number Mean Dev. Effect -Wise Single  
  of Arrays Difference of Diff. Size Error Rate Gene  
 Power (N) (D) (S) (ES) (EWER) Alpha Beta 
 0.90576 23 1.00 1.00 1.000 0.5000 0.0005000 0.09424 
 0.93244 11 1.50 1.00 1.500 0.5000 0.0005000 0.06756 
 0.92194 6 2.00 1.00 2.000 0.5000 0.0005000 0.07806 
 0.93565 4 2.50 1.00 2.500 0.5000 0.0005000 0.06435 
 

Sample sizes of 23, 11, 6, and 4 match the results shown in Lee (2004). 
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Example 6 – Validation (FDR) using Jung 
Jung (2005), page 3100, gives an example for the sample size needed to control FDR in a two-
sample Z-Test. This example is repeated in Chow, Shao, and Wang (2008). We adapt the effect 
size in this validation to correspond to a one-sample test. Namely, the effect size is reduced by 
one half. In the example, Power = 0.60 (from 24/40), D = 1.0, and S = 1.0 for a one-sided two-
sample Z-Test. We use S = 2.0 to correspond to the equivalent in the one-sample test. The 
number of genes tested is 4000. The FDR level is 1%. This setup corresponds to Example 1 on 
page 3100. The required sample size obtained for this setup is 68. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the One-Sample or Paired T-Test for Microarray Data 
procedure window by expanding Means, then One Mean, then clicking on Microarray, and then 
clicking on One-Sample or Paired T-Test for Microarray Data. You may then make the 
appropriate entries as listed below, or open Example 6 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Power for each Gene .............................. 0.60 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.01 
N (Number of Arrays) .............................. Ignored since this is the Find setting  
D (Difference) .......................................... 1.0 
S (Standard Deviation) ............................ 2.0 
Number of Genes Tested ........................ 4000 
K (Number > D) ....................................... 40 
Alternative Hypothesis ............................ One-Sided 
Test Type ................................................ Z 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for One-Sample Z-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff > 0 
 Number of Genes Tested: 4000 
 
   Minimum Std.  Number False  
  Number Mean Dev. Effect Genes Discovery  
  of Arrays Difference of Diff. Size To Detect Rate  
 Power (N) (D) (S) (ES) (K) (FDR) Beta 
 0.61099 68 0.50 1.00 0.500 40 0.0100 0.38901 
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A sample size of 68 matches the result shown in Jung (2005). For Example 3 in Jung (2005), the 
alternative hypothesis is two-sided and results in a sample size of 73. This result may be validated 
in PASS by changing Alternative to Two-Sided in this example. 
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Chapter 615 

Two-Sample T-Test 
for Microarray 
Data 
Introduction 
This chapter describes how to estimate power and sample size (number of arrays) for 2 group 
(two-sample) microarray studies using the PASS: Two-Sample T-Test for Microarray Data 
procedure. False discovery rate and experiment-wise error rate control methods are available in 
this procedure. Values that can be varied in this procedure are power, false discovery rate and 
experiment-wise error rate, sample sizes (numbers of arrays) in each group, the minimum mean 
difference detected, the standard deviations in each group, and in the case of false discovery rate 
control, the number of genes with minimum mean difference.  

Two-Sample Design 
In a two-sample design, two groups are compared, which we will call Treatment 1 and Treatment 
2. Several experimental units are randomly assigned to each of the two treatment groups. A single 
mRNA or cDNA sample is obtained from each experimental unit of both groups. Each sample is 
exposed to a single microarray, resulting in a single expression value for each gene for each unit 
of each treatment group.  The goal is to determine for each gene whether there is evidence that 
the expression is different between the two groups. 

Null and Alternative Hypotheses 
The two-sample null and alternative hypotheses are described here in terms of treatment groups: 
Treatment 1 and Treatment 2. These groups could equally be labeled Treatment A and Treatment 
B, Control and Treatment, etc. The two-sample null hypothesis for each gene is H0: μ1  = 
μ2, where μ1 is the true mean expression for that particular gene in the Treatment 1 environment, 
and μ2  is the true mean expression for that particular gene following Treatment 2. The alternative 
hypothesis may be any one of the following: Ha: μ1  < μ2, Ha: μ1  > μ2, or Ha: μ1  ≠ μ2. The choice 
of the alternative hypothesis depends upon the goals of the research. For example, if the goal of 
the experiment is only to determine which genes are up-regulated (increase in expression) over 
Treatment 1 when Treatment 2 is imposed, the alternative hypothesis would be Ha: μ1  > μ2. If the 
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goal instead is to determine which genes are differentially expressed (up-regulated or down-
regulated) when compared to the other treatment, the alternative hypothesis is Ha: μ1  ≠ μ2. 

Assumptions 
The following assumptions are made when using the two-sample T-test or the Mann-Whitney U 
test. One of the reasons for the popularity of the T-test is its robustness in the face of assumption 
violation. However, if an assumption is not met even approximately, the significance levels and 
the power of the T-test are unknown. You should take the appropriate steps to check the 
assumptions before you make important decisions based on these tests.  

Two-Sample T-Test Assumptions 
The assumptions of the two-sample T-test are: 

1. The data are continuous (not discrete). 

2. The data follow the normal probability distribution. 

3. The variances of the two populations are equal. (If not, the Aspin-Welch Unequal-
Variance test is used.) 

4. The two samples are independent. There is no relationship between the individuals in one 
sample as compared to the other (as there is in the paired T-test).  

5. Both samples are simple random samples from their respective populations. Each 
individual in the population has an equal probability of being selected in the sample.  

Mann-Whitney U Test Assumptions 
The assumptions of the Mann-Whitney U test for difference in means are:  

1. The variable of interest is continuous (not discrete). The measurement scale is at least 
ordinal.  

2. The probability distributions of the two populations are identical, except for location. 
That is, the variances are equal.  

3. The two samples are independent. 

4. Both samples are simple random samples from their respective populations. Each 
individual in the population has an equal probability of being selected in the sample.  

Technical Details 

Multiple Testing Adjustment 
When the two-sample T-test is run for a replicated microarray experiment, the result is a list of P-
values (Probability Levels) that reflect the evidence of difference in expression. When hundreds 
or thousands of genes are investigated at the same time, many ‘small’ P-values will occur by 
chance, due to the natural variability of the process. It is therefore requisite to make an 
appropriate adjustment to the P-value (Probability Level), such that the likelihood of a false 
conclusion is controlled.  
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Benjamini and Hochberg’s (1995) False Discovery Rate Table 
The following table (adapted to the subject of microarray data) is found in Benjamini and 
Hochberg’s (1995) false discovery rate article. In the table, m is the total number of tests, m0 is 
the number of tests for which there is no difference in expression, R is the number of tests for 
which a difference is declared, and U, V, T, and S are defined by the combination of the 
declaration of the test and whether or not a difference exists, in truth. 
 

           Declared       Declared 
       Not Different       Different       Total 

     A true difference in  
expression does not exist  U  V         m0 

     There exists a true  
difference in expression  T  S      m – m0 

    Total         m – R  R         m 

 
In the table, the m is the total number of hypotheses tested (or total number of genes) and is 
assumed to be known in advance. Of the m null hypotheses tested, m0 is the number of tests for 
which there is no difference in expression, R is the number of tests for which a difference is 
declared, and U, V, T, and S are defined by the combination of the declaration of the test and 
whether or not a difference exists, in truth. The random variables U, V, T, and S are unobservable. 

Need for Multiple Testing Adjustment 
Following the calculation of a raw P-value (Probability Level) for each test, P-value adjustments 
need be made to account in some way for multiplicity of tests. It is desirable that these 
adjustments minimize the number of genes that are falsely declared different (V) while 
maximizing the number of genes that are correctly declared different (S). To address this issue the 
researcher must know the comparative value of finding a gene to the price of a false positive. If a 
false positive is very expensive, a method that focuses on minimizing V should be employed. If 
the value of finding a gene is much higher than the cost of additional false positives, a method 
that focuses on maximizing S should be used.  

Error Rates – P-Value Adjustment Techniques 
Below is a brief description of three common error rates that are used for control of false positive 
declarations. The commonly used P-value adjustment technique for controlling each error rate is 
also described.  

Per-Comparison Error Rate (PCER) – No Multiple Testing Adjustment 
The per-comparison error rate (PCER) is defined as 

PCER ( ) /E V m= , 

where E(V) is the expected number of genes that are falsely declared different, and m is the total 
number of tests. Preserving the PCER is tantamount to ignoring multiple testing altogether. If a 
method is used which controls a PCER of 0.05 for 1,000 tests, approximately 50 out of 1,000 
tests will falsely be declared significant. Using a method that controls the PCER will produce a 
list of genes that includes most of the genes for which there exists a true difference in expression 
(i.e., maximizes S), but it will also include a very large number of genes which are falsely 
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declared to have a true difference in expression (i.e., does not appropriately minimize V). 
Controlling the PCER should be viewed as overly weak control of Type I error. 

To obtain P-values (Probability Levels) that control the PCER, no adjustment is made to the P-
value. To determine significance, the P-value is simply compared to the designated alpha. 

Experiment-Wise Error Rate (EWER) 
The experiment-wise error rate (EWER) is defined as 

EWER = Pr(V > 0), 

where V is the number of genes that are falsely declared different. Controlling EWER is 
controlling the probability that a single null hypothesis is falsely rejected. If a method is used 
which controls a EWER of 0.05 for 1,000 tests, the probability that any of the 1,000 tests 
(collectively) is falsely rejected is 0.05. Using a method that controls the EWER will produce a 
list of genes that includes a small (depending also on sample size) number of the genes for which 
there exists a true difference in expression (i.e., limits S, unless the sample size is very large). 
However, the list of genes will include very few or no genes that are falsely declared to have a 
true difference in expression (i.e., stringently minimizes V). Controlling the EWER should be 
considered very strong control of Type I error. 

Assuming the tests are independent, the well-known Bonferroni P-value adjustment produces 
adjusted P-values (Probability Levels) for which the EWER is controlled. The Bonferroni 
adjustment is applied to all m unadjusted P-values ( jp ) as 

min( ,1)j jp mp=% . 

That is, each P-value (Probability Level) is multiplied by the number of tests, and if the result is 
greater than one, it is set to the maximum possible P-value of one. 

False Discovery Rate (FDR)  
The false discovery rate (FDR) (Benjamini and Hochberg, 1995) is defined as 

{ 0}FDR ( 1 ) ( | 0) Pr( 0)R
V VE E R R
R R>= = > > , 

where R is the number of genes that are declared significantly different, and V is the number of 
genes that are falsely declared different. Controlling FDR is controlling the expected proportion 
of falsely declared differences (false discoveries) to declared differences (true and false 
discoveries, together). If a method is used which controls a FDR of 0.05 for 1,000 tests, and 40 
genes are declared different, it is expected that 40*0.05 = 2 of the 40 declarations are false 
declarations (false discoveries). Using a method that controls the FDR will produce a list of genes 
that includes an intermediate (depending also on sample size) number of genes for which there 
exists a true difference in expression (i.e., moderate to large S). However, the list of genes will 
include a small number of genes that are falsely declared to have a true difference in expression 
(i.e., moderately minimizes V). Controlling the FDR should be considered intermediate control of 
Type I error. 

Assuming the tests are independent, the Benjamini and Hochberg P-value adjustment produces 
adjusted P-values (Probability Levels) for which the FDR is controlled. These adjusted P-values 
are found as 

,...,
min {min( ,1)}

i kr rk i m

mp p
k=

=% , 
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where 
1 2 mr r rp p≤ ≤ ≤L p are the observed ordered unadjusted P-values. The procedure is 

defined in Benjamini and Hochberg (1995). The corresponding adjusted P-value definition given 
here is found in Dudoit, Shaffer, and Boldrick (2003). 

Multiple Testing Adjustment Comparison 
The following table gives a summary of the multiple testing adjustment procedures and error rate 
control. The power to detect differences also depends heavily on sample size.  
 

 Common  
Adjustment Error Rate   Control of        Power to 
Technique Controlled Type I Error Detect Differences 

    None        PCER    Minimal           High 

Bonferroni    EWER     Strict                      Low 

          Benjamini and     FDR   Moderate            Moderate/High 
 Hochberg 

 

Type I Error: Rejection of a null hypothesis that is true. 

Calculating Power  
Additional details of calculating power in the two-group scenario are found in the PASS chapter 
for Two Means. 

There are four separate situations, each requiring different formulas. Let the means of the two 
populations be represented by μ1  and μ2 . The difference between these means will be 
represented by d. Let the standard deviations of the two populations be represented as σ1  and 
σ2 . 

Case 1 – Standard Deviations Known and Equal (Z) 
When σ σ σ1 2= =  and are known, the power of the t test is calculated as follows for a 
directional alternative (one-tailed test) in which d > 0. 

1. Find zα   such that ( )1− =Φ zα α , where ( )Φ x  is the area under the standardized 
normal curve to the left of x. 

2. Calculate: σ σx
1 2

= 1
N

+ 1
N

 

3. Calculate: p
x

x
z = z -α dσ

σ
 

4. Calculate:   Power = ( )1− Φ zp  
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Case 2 – Standard Deviations Known and Unequal (Z) 
When σ σ1 ≠ 2 and are known, the power is calculated as follows for a directional alternative 
(one-tailed test) in which d > 0.  

1. Find zα   such that , where ( )1− =Φ zα α ( )Φ x  is the area under the standardized 
normal curve to the left of x. 

2. Calculate: σ
σ σ

x
1
2

1

2
2

2
=

N
+

N
 

3. Calculate: p
x

x
z =

z -α dσ
σ

 

4. Calculate:   Power =  ( )1− Φ zp

Case 3 – Standard Deviations Unknown and Equal 
When σ σ σ1 2= =  and are unknown, the power of the T-Test is calculated as follows for a 
directional alternative (one-tailed test) in which d > 0.  

1.  Find tα  such that ( )1 , where − =T tdf α α ( )T tdf α  is the area under a central-t curve to 
the left of x and df N N= + −1 2 2 . 

2. Calculate: σ σx
1 2

= 1
N

+ 1
N

 

3. Calculate the noncentrality parameter: λ
σ

=
d

x
 

4. Calculate: p
x

x
t =

t - d
+ασ

σ
λ  

5. Calculate: Power = , where ( )1− ′T tdf p,λ ( )′T xdf ,λ  is the area under a noncentral-t curve 

with degrees of freedom df and noncentrality parameter λ  to the left of x. 

Case 4 – Standard Deviations Unknown and Unequal 
When σ σ1 ≠ 2  and are unknown, the power is calculated as follows for a directional alternative 
(one-tailed test) in which d > 0. Note that in this case, an approximate T-Test is used.  

1. Calculate: σ σ σ
x

1
2

1

2
2

2
=

N
+

N
. 
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2. Calculate: f =

N ( N +1)
+

N ( N +1)

- 2x

1
4

1
2

1

2
4

2
2

2

σ
σ σ

4

 

which is the adjusted degrees of freedom. Often, this is rounded to the next highest 
integer. 

3.  Find tα  such that ( )1 , where − =T tf α α ( )T tf α  is the area to the left of x under a 
central-t curve with f degrees of freedom. 

4. Calculate: λ
σ

=
d

,
x

1 the noncentrality parameter. 

5. Calculate: p
x

x
t =

t - d
+ασ

σ
λ  

6.   Calculate: Power = ( )1− ′T tf p,λ , where ( )′T xf ,λ  is the area to the left of x under a 

noncentral-t curve with degrees of freedom f and noncentrality parameter λ . 

Adjusting Alpha 

Experiment-wise Error Rate 
When the Bonferroni method will be used to control the experiment-wise error rate, EWERα , of all 
tests, the adjusted α , ADJα , for each test is given by 

Tests ofNumber 
= EWER

ADJ
αα  

ADJα is the value that is used in the power and sample size calculations. 

False Discovery Rate 
When a false discovery rate controlling method will be used to control the false discovery rate for 
the experiment, fdr, the adjusted α , ADJα , for each test is given by Jung (2005) and Chow, 
Shao, and Wang (2008): 

( )( )( )
( )( )fdrKN

fdrK=
T

ADJ −−
−

1
1 βα  

where K is the number of genes with differential expression, β is the probability of a Type II error 
(not declaring a gene significant when it is), and NT  is the total number of tests. 

ADJα is the value that is used in the power and sample size calculations. Because ADJα  depends 
on β, ADJα  must be solved iteratively when the calculation of power is desired. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Options, and Reports tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data Tab 
The Data tab contains most of the parameters and options involved in the power and sample size 
calculations. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated from the values of the other parameters. 
Under most conditions, you would select either Beta and Power or N1. 

Select N1 when you want to determine the sample sizes needed in each group to achieve a given 
power and false discovery rate (or alpha) error level.  

Select Beta and Power when you want to calculate the power of an experiment.  

Error Rates 

Power for each Gene 
Power is the probability of rejecting each null hypothesis when it is false. Power is equal to 1-
Beta. 

The POWER for each gene represents that probability of detecting differential expression when it 
exists. 

RANGE: The valid range is from 0 to 1. 

RECOMMENDED: Popular values for power are 0.8 and 0.9. 

NOTES: You can enter a range of values such as .70 .80 .90 or .70 to .95 by .05. 

False Discovery (Alpha) Method 
A type I error is declaring a gene to be differentially expressed when it is not. The two most 
common methods for controlling type I error in microarray expression studies are false discovery 
rate (FDR) control and Experiment-wise Error Rate (EWER) control. 

• FDR 
Controlling the false discovery rate (FDR) controls the PROPORTION of genes that are 
falsely declared differentially expressed. For example, suppose that an FDR of 0.05 is used 
for 10000 tests (on 10000 genes). If differential expression is declared for 100 of the 10000 
genes, 5 of the 100 genes are expected to be false discoveries. 
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• EWER 
Controlling the experiment-wise error rate (EWER) controls the PROBABILITY of ANY 
false declarations of differential expression, across all tests. For example, suppose that an 
EWER of 0.05 is used for 10000 tests (on 10000 genes). If differential expression is declared 
for 100 of the 10000 genes, the probability that even one of the 100 declarations is false is 
0.05. 

Recommendation: For exploratory studies where a list of candidate genes for further study is the 
goal, FDR is the recommended Type I error control method, because of its higher power. 

For confirmatory studies where final determination of differential expression is the goal, EWER 
is the recommended Type I error control method, because of its strict control of false discoveries. 

FDR or EWER Value 
Specify the value for the False Discovery (Alpha) Method selected above.  

RANGE: These levels are bounded by 0 and 1. Commonly, the chosen level is between 0.001 and 
0.250 

RECOMMENDED: FDR or EWER is often set to 0.05 for two-sided tests and to 0.025 for one-
sided tests. 

NOTE: You can enter a list of values such as .05 .10 .15 or .05 to .15 by .01. 

Sample Size 

N1 (Number of Arrays, Group 1) 
Enter a value (or range of values) for the sample size of this group 1. Note that these values are 
ignored when you are solving for N1. You may enter a range of values such as 10 to 100 by 10. 

N2 (Number of Arrays, Group 2) 
Enter a value (or range of values) for the sample size of group 2 or enter Use R to base N2 on the 
value of N1. You may enter a range of values such as 10 to 100 by 10. 

• Use R 
When Use R is entered here, N2 is calculated using the formula  

N2 = [R(N1)] 

where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or 
equal to Y. For example, if you want N1 = N2, select Use R and set R = 1. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only 
used when N2 is set to Use R.  

When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next 
integer greater than or equal to Y. Note that setting R = 1.0 forces N2 = N1. 



615-10  Two-Sample T-Test for Microarray Data 

Effect Size 

D (Minimum Mean Difference Detected) 
Specify the true mean difference in expression (D) such that genes with true mean difference 
above D will be detected at the given power and corresponding sample size. 

In expression studies, it is very common that the expressions are measured on the log scale. 
Values of D should reflect the differences that will be used in testing. For example, if the log2 
scale is used, D = 1 implies a two-fold difference in expression, while D = 2 implies a four-fold 
difference in expression. 

When D is large, the resulting sample size will only detect the genes with extreme differential 
expression. 

When D is small, a larger sample size is required to have power sufficient to detect these small 
differences in expression. 

You can enter a range of values such as '1 2 3' or 0.2 to 2 by 0.1. 

S1 (Standard Deviation Group 1) 
Specify the standard deviation of expression in group 1. This standard deviation is assumed for all 
tests. 

S1 and S2 should be on the the same scale as D. 

To obtain the standard deviation of expression from the standard deviation of paired differences, 
use SDexpression = SDpaired/(sqrt(2)). 

Because the true variation in paired differences will vary from gene to gene, it is recommended 
that a range of values be entered here. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

S2 (Standard Deviation Group 2) 
Enter an estimate of the standard deviation of group 2. The standard deviation must be a positive 
number.  

Enter S1 if you want to use the same value(s) as those for group 1. 

Press the Standard Deviation Estimator button to obtain help on estimating the standard deviation. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

Number of Genes 

Number of Genes Tested 
Specify the number of genes for which hypothesis tests will be made. 

This number will usually be the number of genes summarized on each array minus the number of 
housekeeping genes. 

Only one number may be entered in this box. 
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Number of Genes – FDR Only 

K (Number of Genes with Mean Difference > D) 
Specify the number of genes for which a true mean difference in expression greater than D is 
expected. 

K for EWER 
The choice of K has no direct effect on the calculation of power or sample size when the False 
Discovery (Alpha) Method is set to EWER. K is not used when False Discovery (Alpha) method 
is set to EWER. 

K for FDR 
The choice of K has direct effect on the calculation of power or sample size when the False 
Discovery (Alpha) Method is set to FDR. 

You can enter a range of values such as 10 20 30 40 50 or 20 to 100 by 10.  

Test 

Alternative 
Specify whether the hypothesis test for each gene is one-sided (directional) or two-sided (non-
directional). 

Recommendation: In most two-group experiments, differential expression in either direction (up-
regulation or down-regulation) is of interest. Such experiments should have the Two-Sided 
alternative hypothesis. 

For experiments for determining only whether expression has increased (or only decreased), a 
One-Sided alternative hypothesis is recommended. Often regulations dictate that the FDR or 
EWER level be divided by 2 for One-Sided alternative tests. 

Test Type 
Select the Test Statistic that will be used when the analysis of the gene expression data is carried 
out. 

• T 
The T-Test assumes the expression values come from a normal distribution with 
UNKNOWN standard deviation (i.e., a standard deviation that will be estimated from the 
data). 

• Z 
The Z-Test assumes the expression values come from a normal distribution with KNOWN 
standard deviation. 

Recommendation: Because it very rare to know the true standard deviation of expression values 
in advance, T is the recommended test statistic. 

Nonparametric Adjustment 
Specify whether to make an adjustment for the Wilcoxon or Mann-Whitney (nonparametric) test.  

The size of the adjustment depends on the assumed distribution. Select a distribution similar in 
shape to that of your data. 
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Options Tab 
The Options tab contains convergence and iteration options that are rarely changed. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the criterion of interest is 
aborted. When the maximum number of iterations is reached without convergence, the criterion is 
left blank.  

RECOMMENDED: 500 (or more) 

Convergence Options 

FDR Power Convergence 
When FDR is selected for False Discovery (Alpha) Method, and Find (Solve For) is set to Power, 
the corresponding search algorithm will converge when the search criteria is below this value. 

This value will rarely be changed from the default value. 

RECOMMENDED: 0.0000000001  

Example 1 – Finding Power 
This example examines the power to detect differential expression for an experiment comparing a 
treatment group to a control group. There were 16 arrays used in each group. Each microarray 
produced intensity information for 5,000 genes. The 32 arrays were pre-processed by converting 
each expression value to the Log2 scale. In this example, the 2 Group T-Test was used to 
determine which genes were differentially expressed (upward or downward) when comparing the 
treatment group to the control group.   

The researchers found very few differentially expressed genes, and wish to examine the power of 
the experiment to detect two-fold differential expression (Log2-scale difference of 1). Typical 
standard deviations in each group ranged from 0.2 to 2.0. 

The researchers guess the number of genes with at least 2-fold differential expression to be 
around 50, but will examine the effect of this estimate on power by trying 10 and 100 genes as 
well. A false discovery rate of 0.05 was used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 



Two-Sample T-Test for Microarray Data  615-13 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N1 (Number of Arrays, Group 1) ............. 16 
N2 (Number of Arrays, Group 2) ............. Use R 
R (Sample Allocation Ratio) .................... 1.0 
D (Difference) .......................................... 1.0 
S1 (Standard Deviation Group 1) ............ 0.2 to 2 by .2 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 5000 
K .............................................................. 10 50 100 
Alternative Hypothesis ............................ Two-Sided 
Test Statistic ............................................ T 
Nonparametric Adjustment ..................... Ignore 

Reports Tab 
Numeric Reports ..................................... All Checked 
Show Summary Statements ................... 1 
Show Plots .............................................. Checked 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations should take a few moments. 

Numeric Results 
 
 Numeric Results for Microarray Two-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 The standard deviations were assumed to be unknown and equal. 
 Number of Genes Tested: 5000 
 
        Single Prob To  
        Gene Detect  
 Power N1/N2 D S1 S2 K FDR Alpha All K Beta 
 1.00000 16/16 1.0 0.2 0.2 10 0.0500 0.0001055 1.00000 0.00000 
 1.00000 16/16 1.0 0.2 0.2 50 0.0500 0.0005316 1.00000 0.00000 
 1.00000 16/16 1.0 0.2 0.2 100 0.0500 0.0010741 1.00000 0.00000 
 0.98866 16/16 1.0 0.4 0.4 10 0.0500 0.0001043 0.89217 0.01134 
 0.99795 16/16 1.0 0.4 0.4 50 0.0500 0.0005305 0.90250 0.00205 
 0.99916 16/16 1.0 0.4 0.4 100 0.0500 0.0010732 0.91949 0.00084 
 0.52073 16/16 1.0 0.6 0.6 10 0.0500 0.0000549 0.00147 0.47927 
 0.75206 16/16 1.0 0.6 0.6 50 0.0500 0.0003998 0.00000 0.24794 
 0.83005 16/16 1.0 0.6 0.6 100 0.0500 0.0008916 0.00000 0.16995 
 0.06242 16/16 1.0 0.8 0.8 10 0.0500 0.0000066 0.00000 0.93758 
 0.23537 16/16 1.0 0.8 0.8 50 0.0500 0.0001251 0.00000 0.76463 
 0.34928 16/16 1.0 0.8 0.8 100 0.0500 0.0003752 0.00000 0.65072 
 . . . . . . . . . . 
 . . . . . . . . . . 
 . . . . . . . . . . 
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 Report Definitions 
 Power is the individual probability of detecting each gene with true mean difference > D. 
 N1 and N2 are the number of arrays in groups 1 and 2 required to achieve the corresponding power. 
 D is the smallest difference in expression for which this power and sample size are valid. 
 S1 and S2 are the standard deviations for groups 1 and 2 used in each test. 
 K is the number of genes with true mean difference > D. 
 FDR is the expected proportion of false declarations of differential expression to total declarations of 
 differential expression. 
 Single Gene Alpha is the probability of falsely declaring differential expression for an individual gene. 
 Prob to Detect All K is the probability of declaring differential expression for all K genes that have true 
 mean difference > D. 
 Beta is the individual probability of failing to detect each gene with true mean difference > D. 
 
 Summary Statements 
 Group sample sizes of 16 and 16 achieve 100% power for each gene to detect a true difference in 
 expression of at least 1.0 with estimated group standard deviations of 0.2 and 0.2 and with a 
 false discovery rate (FDR) of 0.0500 using a two-sided two-sample T-Test. For a single test, 
 the individual test alpha is 0.0001055. The probability of detecting all 10 genes with true 
 mean difference in expression > 1.0, is 1.00000. 
 

This report shows the values of each of the parameters, one scenario per row. The values of 
power and beta were calculated from the other parameters. 
The definitions of each column are given in the Report Definitions section. 

Plots Section 
 

                
   

This plot shows the relationship between power and the standard deviation of the differences for 
various three values of K. When the standard deviation within each group is greater than 1.0, the 
tests have very little power to detect 2-fold differences. 
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Example 2 – Finding the Sample Size 
This example determines the number of arrays needed to achieve 80% power to detect differential 
expression for each gene. Each microarray will produce intensity information for 22,452 genes. 
The arrays will be pre-processed by converting each expression value to the Log2 scale. The two-
sample T-test will be used to determine which genes are differentially expressed (upward or 
downward) following exposure to the treatment. 

The researchers wish to detect differential expression that is two-fold or greater (Log2-scale 
difference of 1). Typical standard deviations in each group are expected to range from 0.2 to 2.0. 

The researchers guess the number of genes with at least 2-fold differential expression to be 
around 50, but will examine the effect of this estimate on sample size by trying 10 and 100 genes 
as well. A false discovery rate of 0.05 will be used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 (Group 1 Sample Size) 
Power ...................................................... 0.80 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N1 (Number of Arrays, Group 1) ............. Ignored since this is the Find setting 
N2 (Number of Arrays, Group 2) ............. Use R 
R (Sample Allocation Ratio) .................... 1.0 
D (Difference) .......................................... 1.0 
S1 (Standard Deviation Group 1) ............ 0.2 to 2 by .2 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 22452 
K .............................................................. 10 50 100 
Alternative Hypothesis ............................ Two-Sided 
Test Statistic ............................................ T 
Nonparametric Adjustment ..................... Ignore 

Reports Tab 
Numeric Reports ..................................... All Checked 
Number of Summary Statements ............ 1 
Show Plots .............................................. Checked 
Interactive Format ................................... Unchecked 
Show Beta as Power ............................... Checked 
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Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations may take a few moments. 

Numeric Results 
 
 Numeric Results for Microarray Two-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 The standard deviations were assumed to be unknown and equal. 
 Number of Genes Tested: 22452 
 
        Single Prob To  
        Gene Detect  
 Power N1/N2 D S1 S2 K FDR Alpha All K Beta 
 0.93967 7/7 1.0 0.2 0.2 10 0.0500 0.0000188 0.53673 0.06033 
 0.92971 6/6 1.0 0.2 0.2 50 0.0500 0.0000940 0.02615 0.07029 
 0.80449 5/5 1.0 0.2 0.2 100 0.0500 0.0001884 0.00000 0.19551 
 0.81237 13/13 1.0 0.4 0.4 10 0.0500 0.0000188 0.12518 0.18763 
 0.80047 11/11 1.0 0.4 0.4 50 0.0500 0.0000940 0.00001 0.19953 
 0.86440 11/11 1.0 0.4 0.4 100 0.0500 0.0001884 0.00000 0.13560 
 0.82116 24/24 1.0 0.6 0.6 10 0.0500 0.0000188 0.13940 0.17884 
 0.83607 21/21 1.0 0.6 0.6 50 0.0500 0.0000940 0.00013 0.16393 
 0.81695 19/19 1.0 0.6 0.6 100 0.0500 0.0001884 0.00000 0.18305 
 0.81806 39/39 1.0 0.8 0.8 10 0.0500 0.0000188 0.13424 0.18194 
 0.80753 33/33 1.0 0.8 0.8 50 0.0500 0.0000940 0.00002 0.19247 
 0.81606 31/31 1.0 0.8 0.8 100 0.0500 0.0001884 0.00000 0.18394 
 . . . . . . . . . . 
 . . . . . . . . . . 
 . . . . . . . . . . 
 

This report shows the values of each of the parameters, one scenario per row. The sample size 
(number of arrays) estimates were calculated from the other parameters. The power is the actual 
power produced by the given sample size. 

Plots Section 
 

                
   

This plot shows the relationship between sample size and the standard deviations within each 
group for three values of K.  
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Example 3 – Finding the Minimum Detectable Difference 
This example finds the minimum difference in expression that can be detected with 90% power 
from a microarray experiment with two groups of 9 arrays in each group. The 9 arrays permit 
tests on 7,228 genes. The arrays will be pre-processed by converting each expression value to the 
Log2 scale. The two-sample T-test will be used to determine which genes are differentially 
expressed (upward or downward) following exposure to the treatment. Typical standard 
deviations in each group for this experiment range from 0.2 to 1.8. 

In this example we will examine a range for K (the number of genes with mean difference greater 
than the minimum detectable difference), since this should vary with the mean difference chosen. 
A false discovery rate of 0.05 will be used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Mean Difference 
Power ...................................................... 0.90 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.05 
N1 (Number of Arrays, Group 1) ............. 9 
N2 (Number of Arrays, Group 2) ............. Use R 
R (Sample Allocation Ratio) .................... 1.0 
D (Difference) .......................................... Ignored since this is the Find setting 
S1 (Standard Deviation Group 1) ............ 0.2 to 1.8 by .4 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 7228 
K .............................................................. 10 to 50 by 10 
Alternative Hypothesis ............................ Two-Sided 
Test Statistic ............................................ T 
Nonparametric Adjustment ..................... Ignore 

Reports Tab 
Numeric Reports ..................................... All Checked 
Number of Summary Statements ............ 1 
Show Plots .............................................. Checked 
Interactive Format ................................... Unchecked 
Show Beta as Power ............................... Checked 
Mean Difference and SD Decimals ......... 4 
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Output 
Click the Run button to perform the calculations and generate the following output. The 
calculations may take a few moments. 

Numeric Results 
 
 Numeric Results for Microarray Two-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 The standard deviations were assumed to be unknown and equal. 
 Number of Genes Tested: 7228 
 
        Single Prob To  
        Gene Detect  
 Power N1/N2 D S1 S2 K FDR Alpha All K Beta 
 0.90000 9/9 0.6626 0.2000 0.2000 10 0.0500 0.0000656 0.34868 0.10000 
 0.90000 9/9 0.6253 0.2000 0.2000 20 0.0500 0.0001314 0.12158 0.10000 
 0.90000 9/9 0.6038 0.2000 0.2000 30 0.0500 0.0001974 0.04239 0.10000 
 0.90000 9/9 0.5888 0.2000 0.2000 40 0.0500 0.0002636 0.01478 0.10000 
 0.90000 9/9 0.5772 0.2000 0.2000 50 0.0500 0.0003300 0.00515 0.10000 
 0.90000 9/9 1.9879 0.6000 0.6000 10 0.0500 0.0000656 0.34868 0.10000 
 0.90000 9/9 1.8759 0.6000 0.6000 20 0.0500 0.0001314 0.12158 0.10000 
 0.90000 9/9 1.8115 0.6000 0.6000 30 0.0500 0.0001974 0.04239 0.10000 
 0.90000 9/9 1.7663 0.6000 0.6000 40 0.0500 0.0002636 0.01478 0.10000 
 0.90000 9/9 1.7315 0.6000 0.6000 50 0.0500 0.0003300 0.00515 0.10000 
 0.90000 9/9 3.3132 1.0000 1.0000 10 0.0500 0.0000656 0.34868 0.10000 
 0.90000 9/9 3.1265 1.0000 1.0000 20 0.0500 0.0001314 0.12158 0.10000 
 0.90000 9/9 3.0192 1.0000 1.0000 30 0.0500 0.0001974 0.04239 0.10000 
 . . . . . . . . . . 
 . . . . . . . . . . 
 . . . . . . . . . . 
 

This report shows the values of each of the parameters, one scenario per row. The Minimum 
Mean Difference (D) estimates were calculated from the other parameters. 

Plots Section 
 

 

D

               
   

This plot shows the relationship between D (the minimum detectable difference on the Log2 
scale) and the standard deviations within each group for five values of K.  
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Example 4 – Validation (EWER) using Stekel 
Stekel (2003), page 228, gives an example in which Power = 0.95, D = 1, and S1 = S2 = 0.68 for 
a two-sided two-sample T-Test. The number of genes tested is 10000. The control of false 
discoveries is “at most one false positive result.” This corresponds to an EWER value of 1.0. The 
sample sizes obtained for this example are 33 per group.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 (Group 1 Sample Size) 
Power ...................................................... 0.95 
False Discovery (Alpha) Method ............. EWER (Experiment-Wise Error Rate) 
FDR or EWER Value ............................... 1.0 
N1 (Number of Arrays, Group 1) ............. Ignored since this is the Find setting 
N2 (Number of Arrays, Group 2) ............. Use R 
R (Sample Allocation Ratio) .................... 1.0 
D (Difference) .......................................... 1.0 
S1 (Standard Deviation Group 1) ............ 0.68 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 10000 
K .............................................................. Ignored since EWER is used 
Alternative Hypothesis ............................ Two-Sided 
Test Statistic ............................................ T 
Nonparametric Adjustment ..................... Ignore 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for Microarray Two-Sample T-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 The standard deviations were assumed to be unknown and equal. 
 Number of Genes Tested: 10000 
       Single  
       Gene  
 Power N1/N2 D S1 S2 EWER Alpha Beta 
 0.95785 33/33 1.00 0.68 0.68 1.0000 0.0001000 0.04215 
 

The sample sizes of 33 per group match Stekel’s result. 
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Example 5 – Validation (EWER) using Lee 
Lee (2004), pp. 218-220, gives an example in which Power = 0.90, D = 1.0 1.5 2.0 2.5 and S = 
1.0 for a two-sided Z-Test. The corresponding S1 and S2 for a two-sample design is 2/0.1 = 
0.707107. The number of genes tested is 1000. The control of false discoveries is 0.5. This 
corresponds to an EWER value of 0.5. This setup corresponds to the upper left corner of Table 
14.3 on page 219. The sample sizes obtained for this setup are 23, 11, 6, and 4, respectively. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 5 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 (Group 1 Sample Size) 
Power ...................................................... 0.90 
False Discovery (Alpha) Method ............. EWER (Experiment-Wise Error Rate) 
FDR or EWER Value ............................... 0.5 
N1 (Number of Arrays, Group 1) ............. Ignored since this is the Find setting 
N2 (Number of Arrays, Group 2) ............. Use R 
R (Sample Allocation Ratio) .................... 1.0 
D (Difference) .......................................... 1.0 1.5 2.0 2.5 
S1 (Standard Deviation Group 1) ............ 0.707107 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 1000 
K .............................................................. Ignored since EWER is used 
Alternative Hypothesis ............................ Two-Sided 
Test Statistic ............................................ Z 
Nonparametric Adjustment ...................... Ignore 



Two-Sample T-Test for Microarray Data  615-21 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for Microarray Two-Sample Z-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff <> 0 
 The standard deviations were assumed to be known and equal. 
 Number of Genes Tested: 1000 
 
       Single  
       Gene  
 Power N1/N2 D S1 S2 EWER Alpha Beta 
 0.90576 23/23 1.000000 0.707107 0.707107 0.5000 0.0005000 0.09424 
 0.93244 11/11 1.500000 0.707107 0.707107 0.5000 0.0005000 0.06756 
 0.92194 6/6 2.000000 0.707107 0.707107 0.5000 0.0005000 0.07806 
 0.93565 4/4 2.500000 0.707107 0.707107 0.5000 0.0005000 0.06435 
 

Sample sizes of 23, 11, 6, and 4 per group match the results shown in Lee (2004). 

Example 6 – Validation (FDR) using Jung 
Jung (2005), page 3100, gives an example for the sample size needed to control FDR in a two-
sample Z-Test. This example is repeated in Chow, Shao, and Wang (2008). In the example, 
Power = 0.60 (from 24/40), D = 1.0, and S = 1.0 for a one-sided two-sample Z-Test. The number 
of genes tested is 4000. The FDR level is 1%. This setup corresponds to Example 1 on page 3100. 
The required sample size obtained in each group for this setup is 34. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Sample T-Test for Microarray Data procedure window 
by expanding Means, then Two Independent Means, then clicking on Microarray, and then 
clicking on Two-Sample T-Test for Microarray Data. You may then make the appropriate 
entries as listed below, or open Example 6 by going to the File menu and choosing Open 
Example Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... N1 (Group 1 Sample Size) 
Power ...................................................... 0.60 
False Discovery (Alpha) Method ............. FDR (False Discovery Rate) 
FDR or EWER Value ............................... 0.01 
N (Number of Arrays) .............................. Ignored since this is the Find setting  
D (Difference) .......................................... 1.0 
S1 (Standard Deviation Group 1) ............ 1.0 
S2 (Standard Deviation Group 2) ............ S1 
Number of Genes Tested ........................ 4000 
K .............................................................. 40 
Alternative Hypothesis ............................ One-Sided 
Test Statistic ............................................ Z 

Output 
Click the Run button to perform the calculations and generate the following output.  

Numeric Results 
 
 Numeric Results for Microarray Two-Sample Z-Test 
 Null Hypothesis: MeanDiff = 0     Alternative Hypothesis: MeanDiff > 0 
 The standard deviations were assumed to be known and equal. 
 Number of Genes Tested: 4000 
 
        Single Prob To  
        Gene Detect  
 Power N1/N2 D S1 S2 K FDR Alpha All K Beta 
 0.61099 34/34 1.0000 1.0000 1.0000 40 0.0100 0.0000612 0.00000 0.38901 
 

A group sample size of 34 matches the result shown in Jung (2005). For Example 3 in Jung 
(2005), the alternative hypothesis is two-sided and results in a sample size of 73. This result may 
be validated in PASS by changing Alternative to Two-Sided in this example. 
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Chapter 640 

Confidence 
Intervals for One 
Standard Deviation 
Using Standard 
Deviation 
Introduction 
This routine calculates the sample size necessary to achieve a specified interval width or distance 
from the standard deviation to the confidence limit at a stated confidence level for a confidence 
interval about the standard deviation when the underlying data distribution is normal.  

Caution: This procedure assumes that the standard deviation of the future sample will be the same 
as the standard deviation that is specified. If the standard deviation to be used in the procedure is 
estimated from a previous sample or represents the population standard deviation, the Confidence 
Intervals for One Standard Deviation with Tolerance Probability procedure should be considered. 
That procedure controls the probability that the width or distance from the standard deviation to 
the confidence limit will be less than or equal to the value specified. The Confidence Intervals for 
One Standard Deviation using Relative Error controls the width or distance from the standard 
deviation to the limit by controlling the distance as a percent of the true standard deviation.  

Technical Details 
For a single standard deviation from a normal distribution with unknown mean, a two-sided, 
100(1 – α)% confidence interval is calculated by  
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A one-sided 100(1 – α)% upper confidence limit is calculated by 
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Similarly, the one-sided 100(1 – α)% lower confidence limit is 
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For two-sided intervals, the distance from the standard deviation to each of the limits is different. 
Thus, instead of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been specified 
is 

21

2
121

21

2
12

11
/

,/

/

,/ ⎭
⎬
⎫

⎩
⎨
⎧ −

−
⎭
⎬
⎫

⎩
⎨
⎧ −

=
−−− nn

nsnsW
αα χχ

 

For one-sided intervals, the distance from the standard deviation to limits, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 
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The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 
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These equations can be solved for any of the unknown quantities in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population standard 
deviation is 1 – α. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population standard 
deviation is 1 – α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. The distance 
from the standard deviation to the lower and upper limits is not equal. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Distance from SD to Limit (One-Sided) 
This is the distance from the standard deviation to the lower or upper limit of the confidence 
interval, depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  
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Standard Deviation 

S (Standard Deviation) 
Enter an estimate of the standard deviation (must be positive). The sample size and width 
calculations assume that the value entered here is the standard deviation estimate that is obtained 
from the sample. If the sample standard deviation is different from the one specified here, the 
width may be narrower or wider than specified. 

For controlling the probability that the width is less than the value specified, see the procedure 
'Confidence Intervals for One Standard Deviation with Tolerance Probability'. 

For confidence intervals with widths that are specified in terms of a percentage of relative error, 
see the procedure 'Confidence Intervals for One Standard Deviation using Relative Error'. 

One common method for estimating the standard deviation is the range divided by 4, 5, or 6. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% 
confidence interval for the standard deviation such that the width of the interval is no wider than 
20 units. The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The 
standard deviation estimate, based on the range of data values, is 34. Instead of examining only 
the interval width of 20, a series of widths from 16 to 24 will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation using 
Standard Deviation procedure window by expanding Variances, then Standard Deviations, 
then clicking on Confidence Interval, and then clicking on Confidence Intervals for One 
Standard Deviation using Standard Deviation. You may then make the appropriate entries as 
listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 0.99 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 16 to 24 by 1 
S (Standard Deviation) ............................ 34 
Interval Type ........................................... Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample   Standard   
Confidence Size Target Actual Deviation Lower Upper 
Level (N) Width Width (S) Limit Limit 
0.950 40 16.000 15.806 34.000 27.851 43.657 
0.990 67 16.000 15.873 34.000 27.715 43.588 
0.950 36 17.000 16.774 34.000 27.577 44.351 
0.990 60 17.000 16.870 34.000 27.420 44.289 
0.950 32 18.000 17.944 34.000 27.258 45.202 
0.990 54 18.000 17.891 34.000 27.128 45.019 
0.950 30 19.000 18.629 34.000 27.078 45.707 
0.990 49 19.000 18.900 34.000 26.850 45.750 
0.950 27 20.000 19.819 34.000 26.776 46.595 
0.990 45 20.000 19.842 34.000 26.599 46.441 
0.950 25 21.000 20.751 34.000 26.548 47.299 
0.990 41 21.000 20.939 34.000 26.317 47.256 
0.950 23 22.000 21.827 34.000 26.295 48.122 
0.990 38 22.000 21.892 34.000 26.080 47.972 
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0.950 22 23.000 22.430 34.000 26.158 48.588 
0.990 35 23.000 22.986 34.000 25.818 48.804 
0.950 20 24.000 23.803 34.000 25.857 49.659 
0.990 33 24.000 23.813 34.000 25.627 49.440 
 
References 
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York. 
 
Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the population standard deviation. 
N is the size of the sample drawn from the population. 
Width is distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
Standard Deviation (S) is the assumed sample standard deviation. 
Lower Limit is the lower limit of the confidence interval. 
Upper Limit is the upper limit of the confidence interval. 
 
Summary Statements 
A sample size of 40 produces a two-sided 95% confidence interval with a width equal to 15.806 
when the standard deviation is 34.000. 
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

 

N vs C.I. Width by C.L.
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This plot shows the sample size versus the confidence interval width for the two confidence 
levels. 
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Example 2 – Validation using Hahn and Meeker 
Hahn and Meeker (1991) page 56 give an example of a calculation for a confidence interval on 
the standard deviation when the confidence level is 95%, the standard deviation is 1.31, and the 
interval width is 2.9795. The necessary sample size is 5.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation using 
Standard Deviation procedure window by expanding Variances, then Standard Deviations, 
then clicking on Confidence Interval, and then clicking on Confidence Intervals for One 
Standard Deviation using Standard Deviation. You may then make the appropriate entries as 
listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 2.9795 
S (Standard Deviation) ............................ 1.31 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

 Sample   Standard   
Confidence Size Target Actual Deviation Lower Upper 
Level (N) Width Width (S) Limit Limit 
0.950 5 2.980 2.979 1.310 0.785 3.764 
 

PASS also calculated the necessary sample size to be 5.  
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Chapter 641 

Confidence 
Intervals for One 
Standard Deviation 
with Tolerance 
Probability 
Introduction 
This procedure calculates the sample size necessary to achieve a specified width (or in the case of 
one-sided intervals, the distance from the standard deviation to the confidence limit) with a given 
tolerance probability at a stated confidence level for a confidence interval about a single standard 
deviation when the underlying data distribution is normal.  

Technical Details 
For a single standard deviation from a normal distribution with unknown mean, a two-sided, 
100(1 – α)% confidence interval is calculated by  
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A one-sided 100(1 – α)% upper confidence limit is calculated by 
21/

⎫⎧
2

1

1

, ⎭
⎬

⎩
⎨

−

−n

ns
αχ

 



641-2  Confidence Intervals for One Standard Deviation with Tolerance Probability 

Similarly, the one-sided 100(1 – α)% lower confidence limit is 
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For two-sided intervals, the distance from the standard deviation to each of the limits is different. 
Thus, instead of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been specified 
is 
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For one-sided intervals, the distance from the standard deviation to limits, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 
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The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 
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These equations can be solved for any of the unknown quantities in terms of the others. 

There is an additional subtlety that arises when the standard deviation is to be chosen for estimating 
sample size. The sample sizes determined from the formulas above produce confidence intervals 
with the specified widths only when the future sample has a sample standard deviation that is no 
greater than the value specified. 

As an example, suppose that 15 individuals are sampled in a pilot study, and a standard deviation 
estimate of 3.5 is obtained from the sample. The purpose of a later study is to estimate the standard 
deviation with a confidence interval with width no greater than 1.3 units. Suppose further that the 
sample size needed is calculated to be 105 using the formula above with 3.5 as the estimate for the 
standard deviation. The sample of size 105 is then obtained from the population, but the standard 
deviation of the 105 individuals turns out to be 3.9 rather than 3.5. The confidence interval is 
computed and the width of the interval is greater than 1.3 units. 

This example illustrates the need for an adjustment to adjust the sample size such that the width or 
distance from the standard deviation to the confidence limits will be below the specified value with 
known probability. 

Such an adjustment for situations where a previous sample is used to estimate the standard 
deviation is derived for the case of confidence intervals for a mean by Harris, Horvitz, and Mood 
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(1948) and discussed in Zar (1984) and Hahn and Meeker (1991). The adjustment is made by 
replacing s with 

111 −−−= mnFs ,;γσ  

where 1 – γ  is the probability that the width or distance from the standard deviation to the 
confidence limit will be below the specified value, and m is the sample size in the previous sample 
that was used to estimate the standard deviation. 

The corresponding adjustment when no previous sample is available is discussed in Kupper and 
Hafner (1989) and Hahn and Meeker (1991). The adjustment in this case is  
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where, again, 1 – γ  is the probability that the width or distance from the standard deviation to the 
confidence limit will be below the specified value. 

Each of these adjustments accounts for the variability in a future estimate of the standard deviation. 
In the first adjustment formula (Harris, Horvitz, and Mood, 1948), the distribution of the standard 
deviation is based on the estimate from a previous sample. In the second adjustment formula, the 
distribution of the standard deviation is based on a specified value that is assumed to be the 
population standard deviation.  

For this procedure, both adjustments are adapted from the case of a one-sample confidence interval 
for a single mean to the case of a one-sample confidence interval for a single standard deviation. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population standard 
deviation is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  
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Confidence and Tolerance 

Confidence Level (1 – Alpha) 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population standard 
deviation is 1 – α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Tolerance Probability 
This is the probability that a future interval with sample size N and the specified confidence level 
will have a width or distance from the standard deviation to the limit that is less than or equal to the 
width or distance specified. 

If a tolerance probability is not used, as in the 'Confidence Intervals for One Standard Deviation 
using Standard Deviation' procedure, the sample size is calculated for the expected width or 
distance from the SD to the limit, which assumes that the future standard deviation will also be the 
one specified. 

Using a tolerance probability implies that the standard deviation of the future sample will not be 
known in advance, and therefore, an adjustment is made to the sample size formula to account for 
the variability in the standard deviation. Use of a tolerance probability is similar to using an upper 
bound for the standard deviation in the 'Confidence Intervals for One Standard Deviation using 
Standard Deviation' procedure. 

Values between 0 and 1 can be entered. The choice of the tolerance probability depends upon how 
important it is that the width distance from the interval limits to the standard deviation is at most the 
value specified. 

You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.95 by 0.05. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 
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Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. The distance 
from the standard deviation to the lower and upper limits is not equal. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Distance from SD to Limit (One-Sided) 
This is the distance from the standard deviation to the lower or upper limit of the confidence 
interval, depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Standard Deviation 

Standard Deviation Source 
This procedure permits two sources for estimates of the standard deviation: 

• S is a Population Standard Deviation 
This option should be selected if there is no previous sample that can be used to obtain an 
estimate of the standard deviation. In this case, the algorithm assumes that future sample 
obtained will be from a population with standard deviation S. 

• S from a Previous Sample 
This option should be selected if the estimate of the standard deviation is obtained from a 
previous random sample from the same distribution as the one to be sampled. The sample 
size of the previous sample must also be entered under 'Sample Size of Previous Sample'. 

Standard Deviation – S is a 
Population Standard Deviation 

S (Standard Deviation) 
Enter an estimate of the standard deviation (must be positive). In this case, the algorithm assumes 
that future samples obtained will be from a population with standard deviation S. 

One common method for estimating the standard deviation is the range divided by 4, 5, or 6. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  

Standard Deviation – S from a 
Previous Sample 

S (SD Estimated from a Previous Sample) 
Enter an estimate of the standard deviation from a previous (or pilot) study. This value must be 
positive. 

A range of values may be entered. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  
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Sample Size of Previous Sample 
Enter the sample size that was used to estimate the standard deviation entered in S (SD Estimated 
from a Previous Sample). 

This value is entered only when 'Standard Deviation Source:' is set to 'S from a Previous Sample'.  

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Sample Size 
A researcher would like to estimate the standard deviation of a population with 95% confidence. 
It is very important that the interval width is less than 5 grams.  Data available from a previous 
study are used to provide an estimate of the standard deviation. The estimate of the standard 
deviation is 25.4 grams, from a sample of size 12.  
The goal is to determine the sample size necessary to obtain a two-sided confidence interval such 
that the width of the interval is less than 5 grams. Tolerance probabilities of 0.70 to 0.95 will be 
examined. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation with 
Tolerance Probability procedure window by expanding Variances, then Standard Deviations, 
then clicking on Confidence Interval, and then clicking on Confidence Intervals for One 
Standard Deviation with Tolerance Probability. You may then make the appropriate entries as 
listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
Tolerance Probability .............................. 0.70 to 0.95 by 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width ....................... 5 
Standard Deviation Source ..................... S from a Previous Sample 
S .............................................................. 25.4 
Sample Size of Previous Sample ............ 12 
Interval Type ........................................... Two-Sided 
 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample   Standard  
Confidence Size Target Actual Deviation Tolerance 
Level (N) Width Width (S) Probability 
0.950 273 5.000 4.997 25.400 0.700 
0.950 293 5.000 4.998 25.400 0.750 
0.950 318 5.000 4.997 25.400 0.800 
0.950 351 5.000 4.993 25.400 0.850 
0.950 398 5.000 4.995 25.400 0.900 
0.950 484 5.000 4.997 25.400 0.950 
 
Sample size for estimate of S from previous sample = 12.  
 
References 
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York. 
Zar, J. H. 1984. Biostatistical Analysis. Second Edition. Prentice-Hall. Englewood Cliffs, New Jersey. 
Harris, M., Horvitz, D. J., and Mood, A. M. 1948. 'On the Determination of Sample Sizes in Designing 
     Experiments', Journal of the American Statistical Association, Volume 43, No. 243, pp. 391-402. 
 
Report Definitions 
Confidence Level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the population standard deviation. 
N is the size of the sample drawn from the population. 
Width is the distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
Standard Deviation (S) is the estimated standard deviation based on a previous sample. 
Tolerance Probability is the probability that a future interval with sample size N and corresponding 
     confidence level will have a width that is less than or equal to the specified width. 
 
Summary Statements 
The probability is 0.700 that a sample size of 273 will produce a two-sided 95% confidence 
interval with a width that is less than or equal to 4.997 if the population standard deviation 
is estimated to be 25.400 by a previous sample of size 12. 
 

This report shows the calculated sample size for each of the scenarios.  
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Plots Section 
 

  
 

This plot shows the sample size versus the tolerance probability. 

 

Example 2 – Validation using Simulation 
We could not find a published result for confidence intervals for a standard deviation with 
tolerance probability. This procedure is validated using a simulation. A simulation was run with a 
confidence level of 95%, sample size of 100, a specified confidence interval width of 6, and 
assumed population standard deviation of 20. 
The number of simulations was 100,000. The proportion of intervals with width less than 6 
(tolerance probability) was 0.80168.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation with 
Tolerance Probability procedure window by expanding Variances, then Standard Deviations, 
then clicking on Confidence Interval, and then clicking on Confidence Intervals for One 
Standard Deviation with Tolerance Probability. You may then make the appropriate entries as 
listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... Tolerance Probability 
Confidence Level .................................... 0.95 
Tolerance Probability .............................. Ignored since this is the Find setting 
N (Sample Size) ...................................... 100 
Confidence Interval Width ....................... 6 
Standard Deviation Source ..................... S is a Population Standard Deviation 
S .............................................................. 20 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample   Standard  
Confidence Size Target Actual Deviation Tolerance 
Level (N) Width Width (S) Probability 
0.950 100 6.000 6.000 20.000 0.802 
 

PASS calculated the tolerance probability to be 0.802, which is well within the simulation error 
of the simulation estimate of 0.80168.  
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Chapter 642 

Confidence 
Intervals for One 
Standard Deviation 
using Relative 
Error 
Introduction 
This routine calculates the necessary sample size such that a sample standard deviation estimate 
will achieve a specified relative distance from the true population standard deviation at a stated 
confidence level when the underlying data distribution is normal.  

Caution: This procedure controls the relative width of the interval as a proportion of the true 
population standard deviation. For controlling the absolute width of the interval see the 
procedures Confidence Intervals for One Standard Deviation using Standard Deviation and 
Confidence Intervals for One Standard Deviation with Tolerance Probability.  

Technical Details 
Following the results of Desu and Raghavarao (1990) and Greenwood and Sandomire (1950), let 
s be the standard deviation estimate based on a sample from a normal distribution with unknown 
μ and unknown σ. Let r be the proportion of σ such that s is within rσ of σ with desired 
confidence. If 

( ) ( ))1(PrPr1 rsrsp = > σ + σ = > σ +  

and 

( ) ( ))1(PrPr2 rsrsp = < −σ σ = < σ −  
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The confidence level for estimating σ within proportion r is 1 – p1 – p2. 

Since 2
12

2

~)1(
−

−
n

sn χ
σ

, it is useful to rewrite p1 and p2 as 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+−>

−
= 2

2

2

1 )1)(1()1(Pr rnsnp
σ

 

and 

⎟⎟
⎠

⎜⎜
⎝

−−<= 22 )1)(1(Pr rnp
σ

⎞⎛ − 2
2)1( sn  

Using the chi-square distribution, these equations can be solved for any of the unknown quantities 
(n, r, p1 + p2) in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and the standard deviation estimates are 
obtained from each sample, the proportion of those estimates that are within rσ of σ is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and the standard deviation estimates are 
obtained from each sample, the proportion of those estimates that are within rσ of σ is 1 – α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 
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Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Relative Error 
This is the distance from the true standard deviation as a proportion of the true standard deviation. 

You can enter a single value or a list of values. The value(s) must be between 0 and 100000. 

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

In each case the limits are based on the relative error of the true population standard deviation. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to be 95% confident that estimated 
standard deviation is within 10% of the true population standard deviation. In addition to 10% 
relative error, 5%, 15%, 20% and 25% will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation using 
Relative Error procedure window by expanding Variances, then Standard Deviations, then 
clicking on Confidence Interval, and then clicking on Confidence Intervals for One Standard 
Deviation using Relative Error. You may then make the appropriate entries as listed below, or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Relative Error .......................................... 0.05 to 0.25 by 0.05 
Interval Type ........................................... Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Relative Error Confidence Intervals 
 
Target Actual Sample  
Confidence Confidence Size Relative 
Level Level (N) Error 
0.950 0.950 769 0.050 
0.950 0.950 193 0.100 
0.950 0.951 87 0.150 
0.950 0.951 49 0.200 
0.950 0.952 32 0.250 
 
References 
Greenwood, J. A. and Sandomire, M. M. 1950. 'Sample Size Required for Estimating the Standard Deviation as a 
     Per Cent of its True Value', Journal of the American Statistical Association, Vol. 45, No. 250, pp. 257-260. 
Desu, M. M. and Raghavarao, D. 1990. Sample Size Methodology. Academic Press. New York. 
 
Report Definitions 
Confidence Level is the proportion of standard deviation estimates that will be within the relative error of 
     the true standard deviation. 
Target Confidence Level is the value of the confidence level that is entered into the procedure. 
Actual Confidence Level is the value of the confidence level that is obtained from the procedure. 
Sample Size (N) is the size of the sample drawn from the population. 
Relative Error is the distance from the true standard deviation as a proportion of the true standard 
     deviation. 
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Summary Statements 
With a sample size of 769, the probability is 0.950 (95% confidence) that the estimate of the 
standard deviation will be within 5% of the true population standard deviation. 
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

  
 

This plot shows the sample size versus the relative error. 
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Example 2 – Validation using Greenwood and 
Sandomire 
Greenwood and Sandomire (1950) page 259 give an example of a calculation in which the 
desired confidence level is 80% and the relative error is 10%. The necessary sample size is 84.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Standard Deviation using 
Relative Error procedure window by expanding Variances, then Standard Deviations, then 
clicking on Confidence Interval, and then clicking on Confidence Intervals for One Standard 
Deviation using Relative Error. You may then make the appropriate entries as listed below, or 
open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.80 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Relative Error .......................................... 0.1 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Target Actual Sample  
Confidence Confidence Size Relative 
Level Level (N) Error 
0.800 0.802 84 0.100 
 

PASS also calculated the necessary sample size to be 84.  
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Chapter 650 

Inequality Tests 
for One Variance 
Introduction 
Occasionally, researchers are interested in the estimation of the variance (or standard deviation) 
rather than the mean. This module calculates the sample size and performs power analysis for 
hypothesis tests concerning a single variance.  

Technical Details 
Assuming that a variable X is normally distributed with mean μ and variance , the sample 
variance is distributed as a Chi-square random variable with N - 1 degrees of freedom, where N is 
the sample size. That is,  
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The power or sample size of a hypothesis test about the variance can be calculated using the 
appropriate one of the following three formulas from Ostle (1988) page 130. 
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Case 3:  H versus Ha0 1
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered. 

If your only interest is in determining the appropriate sample size for a confidence interval, set 
power or beta to 0.5. 

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 
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Sample Size 

N (Sample Size) 
This is the number of observations in the study.  

Effect Size 

Scale 
Specify whether V0 and V1 are variances or standard deviations. 

V0 (Baseline Variance) 
Enter one or more value(s) of the baseline variance. This variance will be compared to the 
alternative variance. It must be greater than zero. 

Actually, only the ratio of the two variances (or standard deviations) is used, so you can enter a 
one here and enter the ratio value in the V1 box. 

If Scale is Standard Deviation this value is treated as a standard deviation rather than a variance. 

V1 (Alternative Variance) 
Enter one or more value(s) of the alternative variance. This variance will be compared to the 
baseline variance. It must be greater than zero. 

Actually, only the ratio of the two variances (or standard deviations) is used, so you can enter a 
one for V0 and enter a ratio value here. 

If Scale is Standard Deviation this value is treated as a standard deviation rather than a variance. 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the 
hypothesis test. The null hypothesis is always . H0 0

2
1
2:σ σ=

Note that the alternative hypothesis enters into power calculations by specifying the rejection 
region of the hypothesis test. Its accuracy is critical.  

Possible selections are: 

• Ha: V0 <> V1 
This selection yields a two-tailed test. Use this option when you are testing whether the 
variances are different but you do not want to specify beforehand which variance is larger. 

• Ha: V0 > V1 
The options yields a one-tailed test. Use it when you are only interested in the case in which 
V1 is less than V0. 

• Ha: V0 < V1 
This option yields a one-tailed test. Use it when you are only interested in the case in which 
V1 is greater than V0. 
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Known Mean 
The degrees of freedom of the Chi-square test is N - 1 if the mean is calculated from the data (this 
is usually the case) or it is N if the mean is known. Check this box if the mean is known. This will 
cause an increase of the sample size by one.  

Iterations Tab 
This tab sets the option used in the iterative procedure. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating the Power 
A machine used to perform a particular analysis is to be replaced with a new type of machine if 
the new machine reduces the variation in the output. The current machine has been tested 
repeatedly and found to have an output variance of 42.5. The new machine will be cost effective 
if it can reduce the variance by 30% to 29.75. If the significance level is set to 0.05, calculate the 
power for sample sizes of 10, 50, 90, 130, 170, 210, and 250.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Variance procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
One Variance. You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 10 50 90 130 170 210 250 
Scale ....................................................... Variance 
V0 (Baseline Variance) ........................... 42.5 
V1 (Alternative Variance) ........................ 29.75 
Alternative Hypothesis ............................ Ha: V0 > V1 
Known Mean ........................................... Not checked 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V0 = V1 versus Ha: V0>V1 
Power N V0 V1 Alpha Beta 
0.144479 10 42.5000 29.7500 0.050000 0.855521 
0.505556 50 42.5000 29.7500 0.050000 0.494444 
0.747747 90 42.5000 29.7500 0.050000 0.252253 
0.881740 130 42.5000 29.7500 0.050000 0.118260 
0.947851 170 42.5000 29.7500 0.050000 0.052149 
0.978059 210 42.5000 29.7500 0.050000 0.021941 
0.991108 250 42.5000 29.7500 0.050000 0.008892 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. 
V0 is the value of the population variance under the null hypothesis. 
V1 is the value of the population variance under the alternative hypothesis. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
 
Summary Statements 
A sample size of 10 achieves 14% power to detect a difference of 12.7500 between the null 
hypothesis variance of 42.5000 and the alternative hypothesis variance of 29.7500 using a 
one-sided, Chi-square hypothesis test with a significance level (alpha) of 0.050000. 
 

This report shows the calculated power for each scenario.  

Plots Section 
 

  
 

This plot shows the power versus the sample size. We see that a sample size of about 150 is 
necessary to achieve a power of 0.90. 



650-6  Inequality Tests for One Variance 

Example 2 – Calculating Sample Size 
Continuing with the previous example, the analyst wants to find the necessary sample sizes to 
achieve a power of 0.9, for two significance levels, 0.01 and 0.05, and for several variance values. 
To make interpreting the output easier, the analyst decides to switch from the absolute scale to a 
ratio scale. To accomplish this, the baseline variance is set at 1.0 and the alternative variances of 
0.2, 0.3, 0.4, 0.5, 0.6, and 0.7 are tried. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Variance procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
One Variance. You may then make the appropriate entries as listed below, or open Example 2 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.01 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Scale ....................................................... Variance 
V0 (Baseline Variance) ........................... 1.0 
V1 (Alternative Variance) ........................ 0.2 to 0.7 by 0.1 
Alternative Hypothesis ............................ Ha: V0 > V1 
Known Mean ........................................... Not checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V0 = V1 versus Ha: V0>V1 
Power N V0 V1 Alpha Beta 
0.917341 14 1.0000 0.2000 0.010000 0.082659 
0.909022 9 1.0000 0.2000 0.050000 0.090978 
0.900907 22 1.0000 0.3000 0.010000 0.099093 
0.919352 15 1.0000 0.3000 0.050000 0.080648 
0.903675 36 1.0000 0.4000 0.010000 0.096325 
0.900670 23 1.0000 0.4000 0.050000 0.099330 
0.901634 60 1.0000 0.5000 0.010000 0.098366 
0.904235 39 1.0000 0.5000 0.050000 0.095765 
0.901264 107 1.0000 0.6000 0.010000 0.098736 
0.900775 69 1.0000 0.6000 0.050000 0.099225 
0.900601 214 1.0000 0.7000 0.010000 0.099399 
0.901171 139 1.0000 0.7000 0.050000 0.098829 
 

This report shows the necessary sample size for each scenario.  
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Plots Section 
 

  
 

This plot shows the necessary sample size for various values of V1. Note that as V1 gets farther 
from zero, the required sample size increases. 

Example 3 – Validation using Zar 
Zar (1994) page 117 presents an example with V0 = 1.5, V1 = 2.6898, N = 40, Alpha = 0.05, and 
Power = 0.84. We will run this example through PASS.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Variance procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
One Variance. You may then make the appropriate entries as listed below, or open Example 3 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 40 
Scale ....................................................... Variance 
V0 (Baseline Variance) ........................... 1.5 
V1 (Alternative Variance) ........................ 2.6898 
Alternative Hypothesis ............................ Ha: V0 < V1 
Known Mean ........................................... Not checked 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V0 = V1 versus Ha: V0<V1 
Power N V0 V1 Alpha Beta 
0.835167 40 1.5000 2.6898 0.050000 0.164833 
 

PASS calculated the power at 0.835167 which matches Zar’s result of 0.84 within rounding.  

Example 4 – Validation using Davies 
Davies (1971) page 40 presents an example of determining N when (in the standard deviation 
scale) V0 = 0.04, V1 = 0.10, Alpha = 0.05, and Power = 0.99. Davies calculates N to be 13. We 
will run this example through PASS. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Variance procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
One Variance. You may then make the appropriate entries as listed below, or open Example 4 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.99 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Scale ....................................................... Standard Deviation 
V0 (Baseline Variance) ........................... 0.04 
V1 (Alternative Variance) ........................ 0.10 
Alternative Hypothesis ............................ Ha: V0 < V1 
Known Mean ........................................... Not checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: S0 = S1 versus Ha: S0<S1 
Power N S0 S1 Alpha Beta 
0.992381 13 0.0400 0.1000 0.050000 0.007619 
 

PASS calculated an N of 13 which matches Davies’ result.  
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Chapter 651 

Confidence 
Intervals for One 
Variance using 
Variance 
Introduction 
This routine calculates the sample size necessary to achieve a specified interval width or distance 
from the variance to the confidence limit at a stated confidence level for a confidence interval 
about the variance when the underlying data distribution is normal.  

Caution: This procedure assumes that the variance of the future sample will be the same as the 
variance that is specified. If the variance to be used in the procedure is estimated from a previous 
sample or represents the population variance, the Confidence Intervals for One Variance with 
Tolerance Probability procedure should be considered. That procedure controls the probability 
that the width or the distance from the variance to the confidence limits will be less than or equal 
to the value specified. The Confidence Intervals for One Variance using Relative Error controls 
the width or distance from the variance to the limits by controlling the width or distance as a 
percent of the true variance.  

Technical Details 
For a single variance from a normal distribution with unknown mean, a two-sided, 100(1 - α)% 
confidence interval is calculated by  
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Similarly, the one-sided 100(1 – α)% lower confidence limit is 
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For two-sided intervals, the distance from the variance to each of the limits is different. Thus, 
instead of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been specified 
is 
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For one-sided intervals, the distance from the variance to limits, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 
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The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 
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These equations can be solved for any of the unknown quantities in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population variance is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  
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Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population variance is 1 - α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. The distance 
from the variance to the lower and upper limits is not equal. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Distance from Var to Limit (One-Sided) 
This is the distance from the variance to the lower or upper limit of the confidence interval, 
depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Variance 

Variance 
Enter an estimate of the variance (must be positive). The sample size and width calculations 
assume that the value entered here is the variance estimate that is obtained from the sample. If the 
sample variance is different from the one specified here, the width may be narrower or wider than 
specified. 

For controlling the probability that the width is less than the value specified, see the procedure 
'Confidence Intervals for One Variance with Tolerance Probability'. 

For confidence intervals with widths that are specified in terms of a percentage of relative error, 
see the procedure 'Confidence Intervals for One Variance using Relative Error'. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  
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One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% 
confidence interval for the variance such that the width of the interval is no wider than 40 units. 
The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The variance 
estimate, based on the range of data values, is 24. Instead of examining only the interval width of 
40, a series of widths from 30 to 50 will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance using Variance 
procedure window by expanding Variances, then Variances, then clicking on Confidence 
Interval, and then clicking on Confidence Intervals for One Variance using Variance. You 
may then make the appropriate entries as listed below, or open Example 1 by going to the File 
menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 0.99 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 30 to 50 by 5 
Variance .................................................. 24 
Interval Type ........................................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample      
Confidence Size Target Actual  Lower Upper 
Level (N) Width Width Variance Limit Limit 
0.950 28 30.000 29.463 24.000 15.002 44.465 
0.990 46 30.000 29.663 24.000 14.761 44.424 
0.950 22 35.000 34.808 24.000 14.206 49.013 
0.990 36 35.000 34.924 24.000 13.936 48.860 
0.950 19 40.000 38.783 24.000 13.703 52.486 
0.990 30 40.000 39.745 24.000 13.299 53.044 
0.950 16 45.000 44.392 24.000 13.096 57.488 
0.990 26 45.000 44.251 24.000 12.786 57.036 
0.950 14 50.000 49.678 24.000 12.613 62.291 
0.990 23 50.000 48.754 24.000 12.338 61.092 
 
References 
Zar, Jerrold H. 1984. Biostatistical Analysis. Second Edition. Prentice-Hall. Englewood Cliffs, New Jersey. 
 
Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the population variance. 
N is the size of the sample drawn from the population. 
Width is the distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
Variance is the assumed sample variance. 
Lower Limit is the lower limit of the confidence interval. 
Upper Limit is the upper limit of the confidence interval. 
 
Summary Statements 
A sample size of 28 produces a two-sided 95% confidence interval with a width equal to 29.463 
when the sample variance is 24.000. 
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

 

N

 
 

This plot shows the sample size vs. the confidence interval width for the two confidence levels. 
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Example 2 – Validation using Zar 
Zar (1984) page 115 give an example of a calculation for a confidence interval on the variance 
when the confidence level is 95%, the variance is 18.0388, and the interval width is 23.91244. 
The necessary sample size is 25.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance using Variance 
procedure window by expanding Variances, then Variances, then clicking on Confidence 
Interval, and then clicking on Confidence Intervals for One Variance using Variance. You 
may then make the appropriate entries as listed below, or open Example 2 by going to the File 
menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 23.91244 
Variance .................................................. 18.0388 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

 Sample      
Confidence Size Target Actual  Lower Upper 
Level (N) Width Width Variance Limit Limit 
0.950 25 23.912 23.912 18.039 10.998 34.911 
 

PASS also calculated the necessary sample size to be 25.  
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Chapter 652 

Confidence 
Intervals for One 
Variance with 
Tolerance 
Probability 
Introduction 
This procedure calculates the sample size necessary to achieve a specified width (or in the case of 
one-sided intervals, the distance from the variance to the confidence limit) with a given tolerance 
probability at a stated confidence level for a confidence interval about a single variance when the 
underlying data distribution is normal.  

Technical Details 
For a single variance from a normal distribution with unknown mean, a two-sided, 100(1 - α)% 
confidence interval is calculated by  
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A one-sided 100(1 – α)% upper confidence limit is calculated by 
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Similarly, the one-sided 100(1 – α)% lower confidence limit is 
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For two-sided intervals, the distance from the variance to each of the limits is different. Thus, 
instead of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been specified 
is 
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For one-sided intervals, the distance from the variance to limits, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 
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The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 
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These equations can be solved for any of the unknown quantities in terms of the others. 

There is an additional subtlety that arises when the variance is to be chosen for estimating sample 
size. The sample sizes determined from the formulas above produce confidence intervals with the 
specified widths only when the future sample has a sample variance that is no greater than the value 
specified. 

As an example, suppose that 15 individuals are sampled in a pilot study, and a variance estimate of 
6.5 is obtained from the sample. The purpose of a later study is to estimate the variance with a 
confidence interval with width no greater than 3 units. Suppose further that the sample size needed 
is calculated to be 105 using the formula above with 6.5 as the estimate for the variance. The 
sample of size 105 is then obtained from the population, but the variance of the 105 individuals 
turns out to be 7.2 rather than 6.5. The confidence interval is computed and the width of the interval 
is greater than 3 units. 

This example illustrates the need for an adjustment to adjust the sample size such that the width or 
distance from the variance to the confidence limits will be below the specified value with known 
probability. 

Such an adjustment for situations where a previous sample is used to estimate the variance is 
derived for the case of confidence intervals for a mean by Harris, Horvitz, and Mood (1948) and 
discussed in Zar (1984) and Hahn and Meeker (1991). The adjustment is made by replacing s2 with 

1,1;1
22

−−−= mnFs γσ  

where 1 – γ  is the probability that the width or distance from the variance to the confidence limit 
will be below the specified value, and m is the sample size in the previous sample that was used to 
estimate the variance. 
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The corresponding adjustment when no previous sample is available is discussed in Kupper and 
Hafner (1989) and Hahn and Meeker (1991). The adjustment in this case is  

1

2
1,122

−
= −−

n
s nγχ

σ  

where, again, 1 – γ  is the probability that the width or distance from the variance to the confidence 
limit will be below the specified value. 

Each of these adjustments accounts for the variability in a future estimate of the variance. In the first 
adjustment formula (Harris, Horvitz, and Mood, 1948), the distribution of the variance is based on 
the estimate from a previous sample. In the second adjustment formula, the distribution of the 
variance is based on a specified value that is assumed to be the population variance.  

For this procedure, both adjustments are adapted from the case of a one-sample confidence interval 
for a single mean to the case of a one-sample confidence interval for a single variance. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population variance is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence and Tolerance 

Confidence Level (1 – Alpha) 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population variance is 1 - α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 
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Tolerance Probability 
This is the probability that a future interval with sample size N and the specified confidence level 
will have a width or distance from the variance to the limit that is less than or equal to the width or 
distance specified. 

If a tolerance probability is not used, as in the 'Confidence Intervals for One Variance using 
Variance' procedure, the sample size is calculated for the expected width or distance from the 
variance to the limit, which assumes that the future variance will also be the one specified. 

Using a tolerance probability implies that the variance of the future sample will not be known in 
advance, and therefore, an adjustment is made to the sample size formula to account for the 
variability in the variance. Use of a tolerance probability is similar to using an upper bound for the 
variance in the 'Confidence Intervals for One Variance using Variance' procedure. 

Values between 0 and 1 can be entered. The choice of the tolerance probability depends upon how 
important it is that the width or distance from the interval limits to the variance is at most the value 
specified. 

You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.95 by 0.05. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. The distance 
from the variance to the lower and upper limits is not equal. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Distance from Var to Limit (One-Sided) 
This is the distance from the variance to the lower or upper limit of the confidence interval, 
depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  
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Variance 

Variance Source 
This procedure permits two sources for estimates of the variance: 

• V is a Population Variance 
This option should be selected if there is no previous sample that can be used to obtain an 
estimate of the variance. In this case, the algorithm assumes that the future sample obtained 
will be from a population with variance V. 

• V from a Previous Sample 
This option should be selected if the estimate of the variance is obtained from a previous 
random sample from the same distribution as the one to be sampled. The sample size of the 
previous sample must also be entered under 'Sample Size of Previous Sample'. 

Variance – V is a Population Variance 

V (Variance) 
Enter an estimate of the variance (must be positive). In this case, the algorithm assumes that 
future samples obtained will be from a population with variance V. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  

Variance – V from a Previous Sample 

V (Var Estimated from a Previous Sample) 
Enter an estimate of the variance from a previous (or pilot) study. This value must be positive. 

A range of values may be entered. 

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.  

Sample Size of Previous Sample 
Enter the sample size that was used to estimate the variance entered in V (Var Estimated from a 
Previous Sample). 

This value is entered only when 'Variance Source:' is set to 'V from a Previous Sample'.  

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 
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Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

 

Example 1 – Calculating Sample Size 
A researcher would like to estimate the variance of a population with 95% confidence. It is very 
important that the interval width is less than 10 grams.  Data available from a previous study are 
used to provide an estimate of the variance. The estimate of the variance is 35.4 grams, from a 
sample of size 16.  
The goal is to determine the sample size necessary to obtain a two-sided confidence interval such 
that the width of the interval is less than 10 grams. Tolerance probabilities of 0.70 to 0.95 will be 
examined. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance with Tolerance 
Probability procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for One Variance with 
Tolerance Probability. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
Tolerance Probability .............................. 0.70 to 0.95 by 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width ....................... 10 
Variance Source ...................................... V from a Previous Sample 
V .............................................................. 35.4 
Sample Size of Previous Sample ............ 16 
Interval Type ........................................... Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 
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Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample     
Confidence Size Target Actual  Tolerance 
Level (N) Width Width Variance Probability 
0.950 641 10.000 9.995 35.400 0.700 
0.950 722 10.000 9.998 35.400 0.750 
0.950 827 10.000 9.998 35.400 0.800 
0.950 973 10.000 9.995 35.400 0.850 
0.950 1200 10.000 9.996 35.400 0.900 
0.950 1658 10.000 9.999 35.400 0.950 
 
Sample size for estimate of the variance from previous sample = 16.  
 
References 
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York. 
Zar, J. H. 1984. Biostatistical Analysis. Second Edition. Prentice-Hall. Englewood Cliffs, New Jersey. 
Harris, M., Horvitz, D. J., and Mood, A. M. 1948. 'On the Determination of Sample Sizes in Designing 
     Experiments', Journal of the American Statistical Association, Volume 43, No. 243, pp. 391-402. 
 
Report Definitions 
Confidence Level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the population variance. 
N is the size of the sample drawn from the population. 
Width is the distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
Variance is the estimated variance based on a previous sample. 
Tolerance Probability is the probability that a future interval with sample size N and corresponding 
     confidence level will have a width that is less than or equal to the specified width. 
 
Summary Statements 
The probability is 0.700 that a sample size of 641 will produce a two-sided 95% confidence 
interval with a width that is less than or equal to 9.995 if the population variance is 
estimated to be 35.400 by a previous sample of size 16. 
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

 

N vs Tol. Prob.
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This plot shows the sample size versus the tolerance probability. 
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Example 2 – Validation using Simulation 
We could not find a published result for confidence intervals for a variance with tolerance 
probability. This procedure is validated using a simulation. A simulation was run with a 
confidence level of 95%, sample size of 57, a specified confidence interval width of 0.989, and 
assumed population variance of 1.  
The number of simulations was 100,000. The proportion of intervals with width less than 0.989 
(tolerance probability) was 0.90009.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance with Tolerance 
Probability procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for One Variance with 
Tolerance Probability. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Tolerance Probability 
Confidence Level .................................... 0.95 
Tolerance Probability .............................. Ignored since this is the Find setting 
N (Sample Size) ...................................... 57 
Confidence Interval Width ....................... 0.989 
Variance Source ...................................... V is a Population Variance 
V .............................................................. 1 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals 
 
 Sample     
Confidence Size Target Actual  Tolerance 
Level (N) Width Width Variance Probability 
0.950 57 0.989 0.989 1.000 0.900 
 

PASS calculated the tolerance probability to be 0.900, which is well within the simulation error 
of the simulation estimate of 0.90009.  
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Chapter 653 

Confidence 
Intervals for One 
Variance using 
Relative Error 
Introduction 
This routine calculates the necessary sample size such that a sample variance estimate will 
achieve a specified relative distance from the true population variance at a stated confidence level 
when the underlying data distribution is normal.  

Caution: This procedure controls the relative width of the interval as a proportion of the true 
population variance. For controlling the absolute width of the interval see the procedures 
Confidence Intervals for One Variance using Variance and Confidence Intervals for One 
Variance with Tolerance Probability.  

Technical Details 
Following the results of Desu and Raghavarao (1990) and Greenwood and Sandomire (1950), let 
s2 be the variance estimate based on a sample from a normal distribution with unknown μ and 
unknown σ2. Let r be the proportion of σ2 such that s2 is within rσ2 of σ2 with desired confidence. 
If 

( ) ( ))1(PrPr 22222
1 rsrsp +>=+>= σσσ  

and 

( ) ( ))1(PrPr 22222
2 rsrsp −<=−<= σσσ  

The confidence level for estimating σ2 within proportion r is 1 – p1 – p2. 
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Using the chi-square distribution, these equations can be solved for any of the unknown quantities 
(n, r, p1 + p2) in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and the variance estimates are obtained 
from each sample, the proportion of those estimates that are within rσ2 of σ2 is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of  n items are 
drawn from a population using simple random sampling and the variance estimates are obtained 
from each sample, the proportion of those estimates that are within rσ2 of σ2 is 1 – α. 

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 
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Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Relative Error 
This is the distance from the true variance as a proportion of the true variance. 

You can enter a single value or a list of values. The value(s) must be between 0 and 100000. 

 Iterations Tab 

This tab sets an option used in the iterative procedures. 

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

In each case the limits are based on the relative error of the true population variance. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to be 95% confident that estimated 
variance is within 10% of the true population variance. In addition to 10% relative error, 5%, 
15%, 20% and 25% will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance using Relative 
Error procedure window by expanding Variances, then Variances, then clicking on Confidence 
Interval, and then clicking on Confidence Intervals for One Variance using Relative Error. 
You may then make the appropriate entries as listed below, or open Example 1 by going to the 
File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Relative Error .......................................... 0.05 to 0.25 by 0.05 
Interval Type ........................................... Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Relative Error Confidence Intervals 
 
Target Actual Sample  
Confidence Confidence Size Relative 
Level Level (N) Error 
0.950 0.950 3074 0.050 
0.950 0.950 769 0.100 
0.950 0.950 342 0.150 
0.950 0.950 192 0.200 
0.950 0.950 123 0.250 
 
References 
Desu, M. M. and Raghavarao, D. 1990. Sample Size Methodology. Academic Press. New York. 
Greenwood, J. A. and Sandomire, M. M. 1950. 'Sample Size Required for Estimating the Standard Deviation as a 
     Per Cent of its True Value', Journal of the American Statistical Association, Vol. 45, No. 250, pp. 257-260. 
 
Report Definitions 
Confidence Level is the proportion of variance estimates that will be within the relative error of the true 
     variance. 
Target Confidence Level is the value of the confidence level that is entered into the procedure. 
Actual Confidence Level is the value of the confidence level that is obtained from the procedure. 
Sample Size (N) is the size of the sample drawn from the population. 
Relative Error is the distance from the true variance as a proportion of the true variance. 
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Summary Statements 
With a sample size of 3074, the probability is 0.950 (95% confidence) that the estimate of the 
variance will be within 5% of the true population variance. 

 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

  
 

This plot shows the sample size versus the relative error. 
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Example 2 – Validation using Desu and Raghavarao 
Desu and Raghavarao (1990) page 6 give an example of a calculation in which the desired 
confidence level is 95% and the relative error is 20%. This calculation is based on a large sample 
approximation formula. The necessary sample size is 194.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Variance using Relative 
Error procedure window by clicking on Confidence Intervals, then Variances, then One 
Variance using Relative Error. You may then make the appropriate entries as listed below, or 
open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Relative Error .......................................... 0.2 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Target Actual Sample  
Confidence Confidence Size Relative 
Level Level (N) Error 
0.950 0.950 192 0.200 
 

PASS calculated the necessary sample size to be 192, but did not use the approximation formulas.  

Using direct calculation with the non-approximate chi-square formulas with a sample size of 194, 
the confidence level is 1 – (0.0300164564 + 0.0188126383) = 0.951171. 

Using direct calculation with the non-approximate chi-square formulas with a sample size of 192, 
the confidence level is 1 – (0.0306634808 + 0.0193315700) = 0.950005, which is closer to the 
prescribed confidence level. Thus, 192 is the correct value. 
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Chapter 655 

Inequality Tests 
for Two Variances 
Introduction 
Occasionally, researchers are interested in comparing the variances (or standard deviations) of 
two groups rather than their means. This module calculates the sample sizes and performs power 
analyses for hypothesis tests concerning two variances.  

Technical Details 
Assuming that variables X1 and X2 are normally distributed variances and (the means are 
ignored), the distribution of the ratio of the sample variances follows the F distribution. That is,  
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The power or sample size of a hypothesis test about the variance can be calculated using the 
appropriate one of the following three formulas: 
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2

2
2

1
2

2
2: :σ σ σ σ= <

β σ
σ α= <

⎛
⎝
⎜

⎞
⎠
⎟− − −P F F N N

1
2

2
2 1 1 1 2 1, ,  

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data and Iterations tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Error Rates 

Power or Beta 
his option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered. 

If your only interest is in determining the appropriate sample size for a confidence interval, set 
power or beta to 0.5. 

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 
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Sample Size 

N1 (Sample Size Group 1) 
Enter a value (or range of values) for the sample size of this group. Note that these values are 
ignored when you are solving for N1. You may enter a range of values such as 10 to 100 by 10. 

N2 (Sample Size Group 2) 
Enter a value (or range of values) for the sample size of group 2 or enter Use R to base N2 on the 
value of N1. You may enter a range of values such as 10 to 100 by 10. 

• Use R 
When Use R is entered, N2 is calculated using the formula  

N2 = [R N1] 

where R is the Sample Allocation Ratio and [Y] is the first integer greater than or equal to Y. 
For example, if you want N1 = N2, select Use R here and set R = 1. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only 
used when N2 is set to Use R. 

When used, N2 is calculated from N1 using the formula: N2=[R N1] where [Y] is the next integer 
greater than or equal to Y. Note that setting R = 1.0 forces N2 = N1. 

Effect Size 

Scale 
Specify whether V1 and V2 are variances or standard deviations. 

V1 and V2 
Enter one or more value(s) for the variances of the groups, and . All entries must be greater 
than zero. 

σ1
2 σ2

2

Note that since the ratio of these variances is all that is used in the power equations, you can 
specify the problem in terms of the variance ratio instead of the two variances. To do this, enter 
1.0 for V2 and enter the desired variance ratio in V1. 

If Scale is Standard Deviation this value is the standard deviation rather than the variance. 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the 
hypothesis test. The null hypothesis is always H V V0 1 2: = . 

Note that the alternative hypothesis enters into power calculations by specifying the rejection 
region of the hypothesis test. Its accuracy is critical. 
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Possible selections are: 

• Ha: V1 <> V2 
This selection yields a two-tailed test. Use this option when you are testing whether the 
variances are different but you do not want to specify beforehand which variance is larger. 

• Ha: V1 > V2 
The options yields a one-tailed test. Use it when you are only interested in the case in which 
V2 is less than V1. 

• Ha: V1 < V2 
This option yields a one-tailed test. Use it when you are only interested in the case in which 
V2 is greater than V1. 

Iterations Tab 
This tab sets the option used in the iterative procedure. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating the Power 
A machine used to perform a particular analysis is to be replaced with a new type of machine if 
the new machine reduces the variance in the output by 50%. If the significance level is set to 
0.05, calculate the power for sample sizes of 5, 10, 20, 35, 50, 90, 130, and 200.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Variances procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
Two Variances. You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.01 0.05 
N1 (Sample Size Group 1) ...................... 5 10 20 35 50 90 130 200 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
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Data Tab (continued) 
Scale ....................................................... Variance 
V1 (Variance of Group 1) ........................ 1.0 
V2 (Variance of Group 2) ........................ 0.5 
Alternative Hypothesis ............................ Ha: V1 > V2 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V1 = V2 versus Ha: V1>V2 
Power N1 N2 V1 V2 Alpha Beta 
0.034378 5 5 1.0000 0.5000 0.010000 0.965622 
0.079391 10 10 1.0000 0.5000 0.010000 0.920609 
0.187122 20 20 1.0000 0.5000 0.010000 0.812878 
0.362650 35 35 1.0000 0.5000 0.010000 0.637350 
0.526210 50 50 1.0000 0.5000 0.010000 0.473790 
0.821599 90 90 1.0000 0.5000 0.010000 0.178401 
0.944261 130 130 1.0000 0.5000 0.010000 0.055739 
0.994526 200 200 1.0000 0.5000 0.010000 0.005474 
0.143437 5 5 1.0000 0.5000 0.050000 0.856563 
0.250418 10 10 1.0000 0.5000 0.050000 0.749582 
0.431043 20 20 1.0000 0.5000 0.050000 0.568957 
0.636863 35 35 1.0000 0.5000 0.050000 0.363137 
0.776507 50 50 1.0000 0.5000 0.050000 0.223493 
0.946023 90 90 1.0000 0.5000 0.050000 0.053977 
0.988497 130 130 1.0000 0.5000 0.050000 0.011503 
0.999364 200 200 1.0000 0.5000 0.050000 0.000636 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N1 is the size of the sample drawn from the population 1. 
N2 is the size of the sample drawn from the population 2. 
V1 is the value of the population variance of group 1. 
V2 is the value of the population variance of group 2. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
Summary Statements 
Group sample sizes of 5 and 5 achieve 3% power to detect a ratio of 2.0000 between the group 
one variance of 1.0000 and the group two variance of 0.5000 using a one-sided F test with a 
significance level (alpha) of 0.010000. 
 

This report shows the calculated power for each scenario.  
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Plots Section 
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This plot shows the power versus the sample size for the two significance levels. It is now easy to 
determine an appropriate sample size to meet both the alpha and beta objectives of the study. 

Example 2 – Calculating Sample Size 
Continuing with the previous example, the analyst wants to find the necessary sample sizes to 
achieve a power of 0.9 for two significance levels, 0.01 and 0.05, and for several variance ratio 
values of 0.2, 0.3, 0.4, 0.5, 0.6, and 0.7. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Variances procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
Two Variances. You may then make the appropriate entries as listed below, or open Example 2 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Power ...................................................... 0.90 
Alpha ....................................................... 0.01 0.05 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Scale ....................................................... Variance 
V1 (Variance of Group 1) ........................ 1.0 
V2 (Variance of Group 2) ........................ 0.2 to 0.7 by 0.1 
Alternative Hypothesis ............................ Ha: V1 > V2 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V1 = V2 versus Ha: V1>V2 
Power N1 N2 V1 V2 Alpha Beta 
0.911109 23 23 1.0000 0.2000 0.010000 0.088891 
0.916243 16 16 1.0000 0.2000 0.050000 0.083757 
0.907774 39 39 1.0000 0.3000 0.010000 0.092226 
0.905324 26 26 1.0000 0.3000 0.050000 0.094676 
0.904075 65 65 1.0000 0.4000 0.010000 0.095925 
0.902069 43 43 1.0000 0.4000 0.050000 0.097931 
0.901318 111 111 1.0000 0.5000 0.010000 0.098682 
0.902949 74 74 1.0000 0.5000 0.050000 0.097051 
0.900454 202 202 1.0000 0.6000 0.010000 0.099546 
0.901654 134 134 1.0000 0.6000 0.050000 0.098346 
0.900417 412 412 1.0000 0.7000 0.010000 0.099583 
0.900817 272 272 1.0000 0.7000 0.050000 0.099183 
 

This report shows the necessary sample size for each scenario.  

Plot Section 
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This plot shows the necessary sample size for various values of V2. Note that as V2 nears V1, the 
sample size is increased. 
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Example 3 – Validation using Davies 
Davies (1971) page 41 presents an example with V1 = 4, V1 = 1, Alpha = 0.05, and Power = 0.99 
in which the sample sizes, N1 and N2, are calculated to be 36. We will run this example through 
PASS.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Variances procedure window by expanding 
Variances, then Variances, then clicking on Test (Inequality), and then clicking on Tests for 
Two Variances. You may then make the appropriate entries as listed below, or open Example 3 
by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Power ...................................................... 0.99 
Alpha ....................................................... 0.05 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Scale ....................................................... Variance 
V1 (Variance of Group 1) ........................ 4 
V2 (Variance of Group 2) ........................ 1 
Alternative Hypothesis ............................ Ha: V1 > V2 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H0: V1 = V2 versus Ha: V1>V2 
Power N1 N2 V1 V2 Alpha Beta 
0.991423 36 36 4.0000 1.0000 0.050000 0.008577 
 

PASS calculated the N1 and N2 to be 36 which matches Davies’ result.  
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Chapter 656 

Confidence 
Intervals for the 
Ratio of Two 
Variances using 
Variances 
Introduction 
This routine calculates the group sample sizes necessary to achieve a specified interval width or 
distance from the variance ratio to the confidence limit at a stated confidence level for a 
confidence interval about the variance ratio when the underlying data distribution is normal.  

Caution: This procedure assumes that the variances of the future samples will be the same as the 
variances that are specified. The Confidence Intervals for the Ratio of Two Variances using 
Relative Error controls the width or distance from the variance ratio to the limits by controlling 
the width or distance as a percent of the true variance ratio.  

Technical Details 
For a ratio of two variances from normal distributions, a two-sided, 100(1 – α)% confidence 
interval is calculated by  
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A one-sided 100(1 – α)% upper confidence limit is calculated by 
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Similarly, the one-sided 100(1 – α)% lower confidence limit is 
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For two-sided intervals, the distance from the variance ratio to each of the limits is different. 
Thus, instead of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been 
specified is 
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For one-sided intervals, the distance from the variance ratio to limit, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 
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The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 
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These equations can be solved for any of the unknown quantities in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of random samples of 
size n1 and n2 are drawn from populations 1 and 2, respectively, and a confidence interval for the 
variance ratio is calculated for each pair of samples, the proportion of those intervals that will 
include the true variance ratio is 1 – α. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of random samples of 
size n1 and n2 are drawn from populations 1 and 2, respectively, and a confidence interval for the 
variance ratio is calculated for each pair of samples, the proportion of those intervals that will 
include the true variance ratio is 1 – α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Sample Size 

N1 (Sample Size Group 1) 
Enter a value (or range of values) for the sample size of this group. Note that these values are 
ignored when you are solving for N1. You may enter a range of values such as 10 to 100 by 10. 

N2 (Sample Size Group 2) 
Enter a value (or range of values) for the sample size of group 2 or enter Use R to base N2 on the 
value of N1. You may enter a range of values such as 10 to 100 by 10. 

• Use R 
When Use R is entered here, N2 is calculated using the formula  

N2 = [R(N1)] 

where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or 
equal to Y. For example, if you want N1 = N2, select Use R and set R = 1. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only 
used when N2 is set to Use R.  

When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next 
integer greater than or equal to Y. Note that setting R = 1.0 forces N2 = N1. 
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Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. The distance 
from the variance ratio to the lower and upper limits is not equal. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Distance from Ratio to Limit (One-Sided) 
This is the distance from the variance ratio to the lower or upper limit of the confidence interval, 
depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Variances for Variance Ratio (V1/V2) 

V1 (Variance Group 1) 
Enter an estimate of the variance for group 1 (must be positive). The sample size and width 
calculations assume that the value entered here is the variance estimate that is obtained from the 
sample. If the sample variance is different from the one specified here, the width may be narrower 
or wider than specified. 

For confidence intervals with widths that are specified in terms of a percentage of relative error, 
see the procedure 'Confidence Intervals for the Ratio of Two Variances using Relative Error'. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1.  

V2 (Variance Group 2) 
Enter an estimate of the variance for group 2 (must be positive). The sample size and width 
calculations assume that the value entered here is the variance estimate that is obtained from the 
sample. If the sample variance is different from the one specified here, the width may be narrower 
or wider than specified. 

For confidence intervals with widths that are specified in terms of a percentage of relative error, 
see the procedure 'Confidence Intervals for the Ratio of Two Variances using Relative Error'. 

You can enter a range of values such as 1 2 3 or 1 to 10 by 1.  

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 
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Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% 
confidence interval for the variance ratio such that the width of the interval is no wider than 0.5. 
The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The variance 
estimates to be used are 5 for Group 1, and 10 for Group 2. Instead of examining only the interval 
width of 0.5, a series of widths from 0.2 to 0.8 will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for the Ratio of Two Variances using 
Variances procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for the Ratio of Two 
Variances using Variances. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Confidence Level .................................... 0.95 0.99 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Confidence Interval Width (Two-Sided) .. 0.2 to 0.8 by 0.1 
V1 ............................................................ 5 
V2 ............................................................ 10 
Interval Type ........................................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for the Variance Ratio 
 
Confidence   Allocation Target Actual   Lower Upper 
Level N1 N2 Ratio Width Width V1 V2 Limit Limit 
0.950 392 392 1.000 0.200 0.200 5.00 10.00 0.41 0.61 
0.950 178 178 1.000 0.300 0.300 5.00 10.00 0.37 0.67 
0.950 104 104 1.000 0.400 0.398 5.00 10.00 0.34 0.74 
0.950 69 69 1.000 0.500 0.498 5.00 10.00 0.31 0.81 
0.950 50 50 1.000 0.600 0.597 5.00 10.00 0.28 0.88 
0.950 39 39 1.000 0.700 0.691 5.00 10.00 0.26 0.95 
0.950 31 31 1.000 0.800 0.796 5.00 10.00 0.24 1.04 
0.990 675 675 1.000 0.200 0.200 5.00 10.00 0.41 0.61 
0.990 307 307 1.000 0.300 0.300 5.00 10.00 0.37 0.67 
0.990 178 178 1.000 0.400 0.399 5.00 10.00 0.34 0.74 
0.990 118 118 1.000 0.500 0.498 5.00 10.00 0.31 0.81 
0.990 85 85 1.000 0.600 0.598 5.00 10.00 0.28 0.88 
0.990 65 65 1.000 0.700 0.699 5.00 10.00 0.26 0.96 
0.990 53 53 1.000 0.800 0.791 5.00 10.00 0.24 1.03 
 
References 
Ostle, B. and Malone, L.C. 1988. Statistics in Research. Iowa State University Press. Ames, Iowa. 
Zar, Jerrold H. 1984. Biostatistical Analysis (Second Edition). Prentice-Hall. Englewood Cliffs, New Jersey. 
 
Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the true variance ratio. 
N1 and N2 are the sample sizes drawn from the two populations. 
Allocation Ratio is the ratio of the sample sizes, N2/N1. 
Width is the distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
V1 and V2 are the assumed sample variances upon which the width calculations are based. 
Lower Limit is the lower limit of the confidence interval. 
Upper Limit is the upper limit of the confidence interval. 
 
Summary Statements 
Group sample sizes of 392 and 392 produce a two-sided 95% confidence interval with a width that 
is equal to 0.200 when the estimated numerator variance is 5.00 and the estimated denominator 
variance is 10.00. 
 

This report shows the calculated sample size for each of the scenarios.  
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Plots Section 
 

  
 

This plot shows the group sample size versus the confidence interval width for the two 
confidence levels. 
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Example 2 – Validation using Sachs 
Sachs (1984) page 261 gives an example of a calculation for a confidence interval for the 
variance ratio when the confidence level is 90%, the variances are 8 and 3, and the interval width 
is 4.56. The necessary sample size is 20 per group.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for the Ratio of Two Variances using 
Variances procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for the Ratio of Two 
Variances using Variances. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Confidence Level .................................... 0.90 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Confidence Interval Width (Two-Sided) .. 4.56 
V1 ............................................................ 8 
V2 ............................................................ 3 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Confidence   Allocation Target Actual   Lower Upper 
Level N1 N2 Ratio Width Width V1 V2 Limit Limit 
0.900 20 20 1.000 4.560 4.552 8.00 3.00 1.23 5.78 
 

PASS also calculated the necessary sample size to be 20 per group.  
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Chapter 657 

Confidence 
Intervals for the 
Ratio of Two 
Variances using 
Relative Error 
Introduction 
This routine calculates the necessary sample size such that a variance ratio estimate from two 
independent samples will achieve a specified relative distance from the true variance ratio at a 
stated confidence level when the underlying data distributions are normal.  

Caution: This procedure controls the relative width of the interval as a proportion of the true 
variance ratio. For controlling the absolute width of the interval see the procedure Confidence 
Intervals for the Ratio of Two Variances using Variances.  

Technical Details 
Following the results of Desu and Raghavarao (1990), let s1

2 be the variance estimate based on a 
sample from a normal distribution with unknown μ1 and unknown σ1

2. Let s2
2 be the variance 

estimate based on a sample from a normal distribution with unknown μ2 and unknown σ2
2. Let r 

be the proportion of σ1
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which can also be written as 
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which simplifies to 
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If is the distribution function of , then probability statement can be rewritten as (.),1 dfdfG ),( 21 dfdfF
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This equation can be solved for any of the unknown quantities (df1, df2, r, α) in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of random samples of 
size n1 and n2  are drawn from populations 1 and 2, respectively, and a variance ratio is calculated 
for each pair of samples, the proportion of those estimates that are within rσ1

2/σ2
2 of σ1

2/σ2
2 is 1 – 

α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of random samples of 
size n1 and n2  are drawn from populations 1 and 2, respectively, and a variance ratio is calculated 
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for each pair of samples, the proportion of those estimates that are within rσ1
2/σ2

2 of σ1
2/σ2

2 is 1 – 
α. 

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Sample Size 

N1 (Sample Size Group 1) 
Enter a value (or range of values) for the sample size of this group. Note that these values are 
ignored when you are solving for N1. You may enter a range of values such as 10 to 100 by 10. 

N2 (Sample Size Group 2) 
Enter a value (or range of values) for the sample size of group 2 or enter Use R to base N2 on the 
value of N1. You may enter a range of values such as 10 to 100 by 10. 

• Use R 
When Use R is entered here, N2 is calculated using the formula  

N2 = [R(N1)] 

where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or 
equal to Y. For example, if you want N1 = N2, select Use R and set R = 1. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only 
used when N2 is set to Use R.  

When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next 
integer greater than or equal to Y. Note that setting R = 1.0 forces N2 = N1. 

Precision 

Relative Error 
This is the distance from the true variance ratio as a proportion of the true variance ratio. 

You can enter a single value or a list of values. The value(s) must be between 0 and 100000. 

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

In each case the limits are based on the relative error of the true population variance. 
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Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to be 95% confident that estimated 
variance ratio is within 10% of the true variance ratio. In addition to 10% relative error, 5%, 15%, 
20% and 25% will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for the Ratio of Two Variances using 
Relative Error procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for the Ratio of Two 
Variances using Relative Error. You may then make the appropriate entries as listed below, or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Confidence Level .................................... 0.95 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Relative Error .......................................... 0.05 to 0.25 by 0.05 
Interval Type ........................................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Relative Error Confidence Intervals for the Variance Ratio 
 
Target Actual     
Confidence Confidence   Allocation Relative 
Level Level N1 N2 Ratio Error 
0.950 0.950 6154 6154 1.000 0.050 
0.950 0.950 1544 1544 1.000 0.100 
0.950 0.950 690 690 1.000 0.150 
0.950 0.950 392 392 1.000 0.200 
0.950 0.950 253 253 1.000 0.250 
 
References 
Desu, M. M. and Raghavarao, D. 1990. Sample Size Methodology. Academic Press. New York. 
 
Report Definitions 
Confidence Level is the proportion of variance ratio estimates that will be within the relative error of the 
     true variance ratio. 
Target Confidence Level is the value of the confidence level that is entered into the procedure. 
Actual Confidence Level is the value of the confidence level that is obtained from the procedure. 
N1 and N2 are the sample sizes drawn from the two populations. 
Allocation Ratio is the ratio of the sample sizes, N2/N1. 
Relative Error is the distance from the true variance ratio as a proportion of the true variance ratio. 
 
Summary Statements 
With group sample sizes of 6154 and 6154, the probability is 0.950 (95% confidence) that the 
estimate of the variance ratio will be within 5% of the true variance ratio. 

 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

  
 

This plot shows the sample size versus the relative error. 
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Example 2 – Validation using Direct Calculation 
Suppose a study is planned in which the researcher wishes to be confident that estimated variance 
ratio is within 20% of the true variance ratio. For sample sizes of 200 per group, the resulting 
confidence level is 0.9003379878 - 0.0581710981 = 0.8421668897.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for the Ratio of Two Variances using 
Relative Error procedure window by expanding Variances, then Variances, then clicking on 
Confidence Interval, and then clicking on Confidence Intervals for the Ratio of Two 
Variances using Relative Error. You may then make the appropriate entries as listed below, or 
open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Confidence Level .................................... 0.8421668897 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
Relative Error .......................................... 0.2 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Target Actual     
Confidence Confidence   Allocation Relative 
Level Level N1 N2 Ratio Error 
0.842 0.842 200 200 1.000 0.200 
 

PASS calculated the necessary sample size to be 200 per group, which is the same as the direct 
calculation sample size. 
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Chapter 670 

Normality Tests 
(Simulation) 
Introduction 
This procedure allows you to study the power and sample size of eight statistical tests of normality. 
Since there are no formulas that allow the calculation of power directly, simulation is used. This 
gives you the ability to compare the adequacy of each test under a wide variety of solutions.  

The reason there are so many different normality tests is that there are many different forms of 
normality. Thode (2002) presents that following recommendations concerning which tests to use for 
each situation. Note that the details of each test will be presented later. 

Normal vs. Long-Tailed Symmetric Alternative Distributions 
The Shapiro-Wilk and the kurtosis tests have been found to be best for normality testing against 
long-tailed symmetric alternatives. 

Normal vs. Short-Tailed Symmetric Alternative Distributions 
The Shapiro-Wilk and the range tests have been found to be best for normality testing against short-
tailed symmetric alternatives. 

Normal vs. Asymmetric Alternative Distributions 
The Shapiro-Wilk and the skewness tests have been found to be best for normality testing against 
asymmetric alternatives. 

Technical Details 
Computer simulation allows one to estimate the power and significance level that is actually 
achieved by a test procedure in situations that are not mathematically tractable. Computer 
simulation was once limited to mainframe computers. Currently, due to increased computer speeds, 
simulation studies can be completed on desktop and laptop computers in a reasonable period of 
time.  

The steps to a simulation study are as follows. 

1. Specify which the normality test is to be used. This includes specifying the significance 
level. 
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2. Generate a random sample, , from the distribution specified by the X X Xn1 2, , ,K
alternative hypothesis. Calculate the test statistic from the simulated data and determine if 
the null hypothesis is accepted or rejected. Each of these samples is used to calculate the 
power of the test. Note that if the alternative distribution is set to normal, the power is the 
significance level of the test. 

3. Repeat step 2 several hundred times, tabulating the number of times the simulated data lead 
to a rejection of the null hypothesis. The power is the proportion of simulation samples in 
step 2 that lead to rejection.  

Data Distributions 
A wide variety of distributions may be studied. These distributions can vary in skewness, 
elongation, or other features such as bimodality. A detailed discussion of the distributions that may 
be used in the simulation is provided in the chapter ‘Data Simulator’.  

Test Statistics 
This section describes the test statistics that are available of study in this procedure. 

Anderson-Darling Test 
This test, developed by Anderson and Darling (1954), is a popular normality test based on EDF 
statistics. In some situations, it has been found to be as powerful as the Shapiro-Wilk test. This 
test is available when n is greater than or equal to 8.  

Kolmogorov-Smirnov 
This test for normality is based on the maximum difference between the observed distribution and 
expected cumulative-normal distribution. Since it uses the sample mean and standard deviation to 
calculate the expected normal distribution, the Lilliefors’ adjustment is used. The Lilliefors’ 
adjusted critical values used are those given by Dallal (1986).  

This test is available when n is greater than or equal to 3. 

This test has been shown to be less powerful than the other tests in most situations. It is included 
because of its historical popularity. 

Kurtosis 
D’Agostino (1990) describes a normality test based on the kurtosis coefficient, b2. Recall that for 
the normal distribution, the theoretical value of b2 is 3. Hence, a test can be developed to 
determine if the value of b2 is significantly different from 3. If it is, the data are obviously 
nonnormal. The statistic, zk, is, under the null hypothesis of normality, approximately normally 
distributed for sample sizes n>20. This test is available when n is greater than or equal to 8.  
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The calculation of this test proceeds as follows: 
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Martinez-Iglewicz 
This test for normality, developed by Martinez and Iglewicz (1981), is based on the median and a 
robust estimator of dispersion. They have shown that this test is very powerful for heavy-tailed 
symmetric distributions as well as a variety of other situations. A value of the test statistic that is 
close to one indicates that the distribution is normal. This test is recommended for exploratory 
data analysis by Hoaglin (1983). The formula for this test is:  
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where sbi
2 is a biweight estimator of scale. 

This test is available when n is greater than or equal to 3. 

Omnibus 
D’Agostino (1990) describes a normality test that combines the tests for skewness and kurtosis. 
The statistic, K2, is approximately distributed as a chi-square with two degrees of freedom.  

After calculating zs and zk, calculate K2 as follows:  

K z zs k
2 2= + 2  

This test is available when n is greater than or equal to 8. 
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Range Test 
The range test, u, was created to test for normality when the alternative distribution is actually the 
uniform distribution. It is calculated by dividing the range by the standard deviation. Tables of 
critical values of the range test are given in Pearson and Hartley (1976) for n equal 3 to 1000.  

Shapiro-Wilk W Test 
This test for normality, developed by Shapiro and Wilk (1965), has been found to be the most 
powerful test in most situations. It is the ratio of two estimates of the variance of a normal 
distribution based on a random sample of n observations. The numerator is proportional to the 
square of the best linear estimator of the standard deviation. The denominator is the sum of 
squares of the observations about the sample mean. W may be written as the square of the Pearson 
correlation coefficient between the ordered observations and a set of weights which are used to 
calculate the numerator. Since these weights are asymptotically proportional to the corresponding 
expected normal order statistics, W is roughly a measure of the straightness of the normal 
quantile-quantile plot. Hence, the closer W is to one, the more normal the sample.  

The probability values for W are valid for samples in the range of 3 to 5000. 

Skewness 
D’Agostino (1990) describes a normality test based on the skewness coefficient, b1 . Recall that 
because the normal distribution is symmetrical, b1  is equal to zero for normal data. Hence, a 
test can be developed to determine if the value of b1  is significantly different from zero. If it is, 
the data are obviously nonnormal. The statistic, zs, is, under the null hypothesis of normality, 
approximately normally distributed. The computation of this statistic, which is restricted to 
sample sizes n>8, is  
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated using the values of the other parameters. 
Under most conditions, you would select either Power or N. 

Select Power when you want to estimate the power for a specific scenario.  

Select N when you want to determine the sample size needed to achieve a given power and alpha 
error level. This option can be very computationally intensive, and may take considerable time to 
complete. 

Search/Report Test 
Specify the specific normality test to be used for searching (if Find = 'N') and reporting. Note that 
each test was developed for a specific situation and that no one test is best in all situations. 
Apparently, if you have no other information, you would choose the Shapiro-Wilk test. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  
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Sample Size 

N (Sample Size) 
This option specifies one or more values of the sample size, the number of individuals in the 
study. This value must be an integer greater than one. Note that you may enter a list of values 
using the syntax 50 100 150 200 250 or 50 to 250 by 50.  

Effect Size 

Data Distribution 
This option specifies distribution that is being compared to normality. That is, this is the actual 
(true) distribution of the data from which the power is computed. Usually, the mean is specified 
by entering ‘M1’ for the mean parameter in the distribution expression and then entering values 
for the M1 parameter below. All of the distributions are parameterized so that the mean is entered 
first.  

The parameters of each distribution are specified using numbers or letters. If letters are used, their 
values are specified in the boxes below. The values ‘M0’ and ‘M1’ are usually used to specify the 
value of the mean.  

Following is a list of the distributions that are available and the syntax used to specify them: 
Beta=A(M1,A,B,Minimum) 
Binomial=B(M1,N) 
Cauchy=C(M1,Scale) 
Constant=K(Value) 
Exponential=E(M1) 
F=F(M1,DF1) 
Gamma=G(M1,A) 
Multinomial=M(P1,P2,P3,…,Pk) 
Normal=N(M1,SD) 
Poisson=P(M1) 
Student's T=T(M1,D) 
Tukey's Lambda=L(M1,S,Skewness,Elongation) 
Uniform=U(M1,Minimum) 
Weibull=W(M1,B) 

Details of writing mixture distributions, combined distributions, and compound distributions are 
found in the chapter on Data Simulation and will not be repeated here. 

Effect Size – Distribution Parameters 

M0 and M1 
These values are substituted for the M0 and M1 in the distribution specifications given above. M0 
is intended to be the value of the mean. 

You can enter a list of values using syntax such as 0 1 2 3 or 0 to 3 by 1. 

Parameter Values (S, A, B, C) 
Enter the numeric value(s) of parameter listed above. These values are substituted for the 
corresponding letter in the Data Distribution specifications. 
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You can enter a list of values using syntax such as 0 1 2 3 or 0 to 3 by 1. 

You can also change the letter that is used as the name of this parameter. 

Simulations 

Simulations 
This option specifies the number of iterations, M, used in the simulation. Larger numbers of 
iterations result in longer running time and more accurate results. 

The precision of the simulated power estimates can be determined by recognizing that they follow 
the binomial distribution. Thus, confidence intervals may be constructed for power estimates. The 
following table gives an estimate of the precision that is achieved for various simulation sizes 
when the power is either 0.50 or 0.95. The table values are interpreted as follows: a 95% 
confidence interval of the true power is given by the power reported by the simulation plus and 
minus the ‘Precision’ amount given in the table. 
  

 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
  

Notice that a simulation size of 1000 gives a precision of plus or minus 0.014 when the true 
power is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a 
small amount of additional precision achieved.  

Iterations Tab 
The Iterations tab contains limits on the number of iterations and various options about individual 
tests. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations before the search for the sample size, N, is aborted. 
When the maximum number of iterations is reached without convergence, the sample size is not 
reported. We recommend a value of at least 500. 
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Example 1 – Power at Various Sample Sizes 
A researcher is planning an experiment to test whether a certain data distribution is reasonably 
close to normality. He will begin his research by generating data from the exponential 
distribution. The researcher is particularly interested in the Shapiro-Wilk normality test, but he 
wants to see the power of various other choices when the data actually come from an exponential 
distribution. Alpha is set to 0.05. He wants to compute the power at various sample sizes from 5 
to 40. Since this is an exploratory analysis, he sets the number of simulation iterations to 1000.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Normality Tests (Simulation) procedure window by clicking 
on Normality, and then clicking on Normality Tests (Simulation). You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Search/Report Test ................................. Shapiro-Wilk 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 5 10 15 20 30 40 
Data Distribution ...................................... E(M1) 
M1 ........................................................... 1 
Simulations .............................................. 1000 

Reports Tab 
Show Numeric Report ............................. Checked 
Show Comparative Report ...................... Checked 
Show Confidence Interval for Power ....... Checked 
Show Definitions ..................................... Checked 
Show Plots .............................................. Checked 
Show Summary Statements.................... 1 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for the Shapiro-Wilk Normality Test 
Actual Distribution: Expo(M1) 
 
 Lower Upper 
 95% 95% 
 C.L. of C.L. of 
Power Power Power N Alpha Beta M1 No.      
0.175 0.152 0.200 5 0.050 0.825 1.0 1     
0.442 0.411 0.473 10 0.050 0.558 1.0 2     
0.690 0.660 0.719 15 0.050 0.310 1.0 3     
0.840 0.816 0.862 20 0.050 0.160 1.0 4     
0.968 0.955 0.978 30 0.050 0.032 1.0 5     
0.996 0.990 0.999 40 0.050 0.004 1.0 6     
 
Notes 
Simulations: 1000. Run Time: 12.28 seconds. 
 
References 
Henry C. Thode, Jr. 2002. Testing for Normality. Marcel Dekker. New York. 
Devroye, Luc. 1986. Non-Uniform Random Variate Generation. Springer-Verlag. New York. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
Lower/Upper 95% C.L. are the boundaries of an exact binomial confidence interval for power. 
N is the size of the sample drawn from the population. 
Alpha is the probability of rejecting when the distribution is normal. 
Beta is the probability of concluding normality when the distribution is actually the one stated. 
No. is the sequence number of this combination of parameter values. 
 
Summary Statements 
A sample size of 5 achieves 18% power to detect non-normality using the Shapiro-Wilk test when 
the significance level is 0.050 and the actual distribution is Expo(M1). These results are 
based on 1000 Monte Carlo samples from this distribution. 
 
 

This report shows the estimated power with its confidence interval (using the binomial 
distribution) for each combination of parameter values. Note that because these are results of a 
simulation study, the computed power and alpha will vary from run to run. Thus, another report 
obtained using the same input parameters will be slightly different from the one above. 
If the researcher wants 80% power, he will need an N of 20. To achieve 90% power, he will need 
an N of 30. 

Comparative Results 
 

Power of Various Normality Tests 
Actual Distribution: Expo(M1) 
 
Sequence  Anderson Kolmo'v Kur- Martinez Omni- Range Shapiro Skew- Any 
No. N Darling Smirnov tosis Iglewicz bus /SD Wilk ness Test 
1 5  0.124  0.225  0.076 0.175  0.290   
 Lower 95% C.L.  0.104  0.199  0.060 0.152 0.000 0.262   
 Upper 95% C.L.  0.146  0.252  0.094 0.200 0.000 0.319   
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2 10 0.401 0.297 0.215 0.311 0.315 0.062 0.442 0.366 0.549   
 Lower 95% C.L. 0.370 0.269 0.190 0.282 0.286 0.048 0.411 0.336 0.518   
 Upper 95% C.L. 0.432 0.326 0.242 0.341 0.345 0.079 0.473 0.397 0.580   
 
3 15 0.627 0.448 0.290 0.456 0.474 0.068 0.690 0.562 0.750   
 Lower 95% C.L. 0.596 0.417 0.262 0.425 0.443 0.053 0.660 0.531 0.722   
 Upper 95% C.L. 0.657 0.479 0.319 0.487 0.505 0.085 0.719 0.593 0.777 
 
4 20 0.784 0.597 0.349 0.598 0.607 0.074 0.840 0.713 0.871   
 Lower 95% C.L. 0.757 0.566 0.319 0.567 0.576 0.059 0.816 0.684 0.849   
 Upper 95% C.L. 0.809 0.628 0.379 0.629 0.637 0.092 0.862 0.741 0.891   
 
5 30 0.937 0.775 0.485 0.735 0.777 0.131 0.968 0.895 0.975   
 Lower 95% C.L. 0.920 0.748 0.454 0.706 0.750 0.111 0.955 0.874 0.963   
 Upper 95% C.L. 0.951 0.801 0.516 0.762 0.802 0.154 0.978 0.913 0.984   
 
6 40 0.987 0.886 0.588 0.839 0.894 0.142 0.996 0.958 0.998   
 Lower 95% C.L. 0.978 0.865 0.557 0.815 0.873 0.121 0.990 0.944 0.993   
 Upper 95% C.L. 0.993 0.905 0.619 0.861 0.912 0.165 0.999 0.970 1.000   
 

This report shows the estimated power with its confidence interval (using the binomial 
distribution) for each combination each of the normality tests. The last test, called Any Test, is 
calculated by combining the results of the eight normality tests into a single test. 

Note the variation in the power values. In this case, the Martinez-Iglewicz is the champion for N 
= 5, but the Shapiro-Wilk test has greater power for N = 10. 

Plots Section 
 

 

Power vs N
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This plot shows the relationship between sample size and power.  
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Power vs N by Test
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This plot shows performance of each of the normality tests. The champion is the Shapiro-Wilk 
test. The range test, which was designed for uniform alternatives, does very poorly with 
exponential alternatives.   

Example 2 – Validation using the Normal Distribution 
We will validate this procedure by setting the normal distribution as the alternative distribution. 
In this case, the power should be equal to the alpha value. Alpha is set to 0.05. The sample sizes 
will be set to 10, 30, and 50. The number of simulation iterations to 10,000.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Normality Tests (Simulation) procedure window by clicking 
on Normality, and then clicking on Normality Tests (Simulation). You may then make the 
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power 
Search/Report Test ................................. Shapiro-Wilk 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 10 30 50 
Data Distribution ...................................... N(M1 S) 
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Data Tab (continued) 
M1 ........................................................... 1 
S .............................................................. 1 
Simulations .............................................. 10000 

Reports Tab 
Show Numeric Report ............................. Checked 
Show Comparative Report ...................... Checked 
Show Confidence Interval for Power ....... Checked 
Show Definitions ..................................... Checked 
Show Plots .............................................. Checked 
Number of Summary Statements ............ 1 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for the Shapiro-Wilk Normality Test 
Actual Distribution: N(M1 S) 
 
 Lower Upper 
 95% 95% 
 C.L. of C.L. of 
Power Power Power N Alpha Beta M1 S No.     
0.052 0.047 0.056 10 0.050 0.948 1.0 1.0 1    
0.047 0.043 0.051 30 0.050 0.953 1.0 1.0 2    
0.053 0.048 0.057 50 0.050 0.948 1.0 1.0 3 
 
 
Power of Various Normality Tests 
Actual Distribution: N(M1 S) 
 
Sequence  Anderson Kolmo'v Kur- Martinez Omni- Range Shapiro Skew- Any 
No. N Darling Smirnov tosis Iglewicz bus /SD Wilk ness Test 
1 10 0.053 0.027 0.043 0.051 0.058 0.049 0.052 0.052 0.142   
 Lower 95% C.L. 0.048 0.024 0.039 0.046 0.053 0.045 0.047 0.048 0.135   
 Upper 95% C.L. 0.057 0.030 0.047 0.055 0.062 0.053 0.056 0.057 0.148   
 
2 30 0.048 0.029 0.053 0.049 0.053 0.053 0.047 0.047 0.151   
 Lower 95% C.L. 0.044 0.026 0.049 0.045 0.048 0.049 0.043 0.043 0.145   
 Upper 95% C.L. 0.053 0.033 0.058 0.054 0.057 0.058 0.051 0.052 0.159   
 
3 50 0.052 0.032 0.055 0.049 0.057 0.054 0.053 0.048 0.159   
 Lower 95% C.L. 0.048 0.028 0.050 0.045 0.052 0.050 0.048 0.044 0.152   
 Upper 95% C.L. 0.056 0.035 0.059 0.053 0.061 0.059 0.057 0.053 0.167   
 
Simulations: 10000. Run Time: 77.42 seconds. 
 

This report confirms that the simulation results are quite accurate. Most of the power values are 
very close to 0.05. The Kolmogorov-Smirnov test appears to be low and the skewness, kurtosis, 
and omnibus appear to be high. Perhaps this is the reason that the Shapiro-Wilk and the 
Anderson-Darling tests are usually recommended for general normality testing. 
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Chapter 700 

Logrank Tests 
(Freedman) 
Introduction 
This module allows the sample size and power of the logrank test to be analyzed under the 
assumption of proportional hazards. Time periods are not stated. Rather, it is assumed that 
enough time elapses to allow for a reasonable proportion of responses to occur. If you want to 
study the impact of accrual and follow-up time, you should use the one of the other logrank 
modules also contained in PASS. The formulas used in this module come from Machin et al. 
(1997).  

A clinical trial is often employed to test the equality of survival distributions for two treatment 
groups. For example, a researcher might wish to determine if Beta-Blocker A enhances the 
survival of newly diagnosed myocardial infarction patients over that of the standard Beta-Blocker 
B. The question being considered is whether the pattern of survival is different. 

The two-sample t-test is not appropriate for two reasons. First, the data consist of the length of 
survival (time to failure), which is often highly skewed, so the usual normality assumption cannot 
be validated. Second, since the purpose of the treatment is to increase survival time, it is likely 
(and desirable) that some of the individuals in the study will survive longer than the planned 
duration of the study. The survival times of these individuals are then said to be censored. These 
times provide valuable information, but they are not the actual survival times. Hence, special 
methods have to be employed which use both regular and censored survival times. 

The logrank test is one of the most popular tests for comparing two survival distributions. It is 
easy to apply and is usually more powerful than an analysis based simply on proportions. It 
compares survival across the whole spectrum of time, not at just one or two points.  

The power calculations used here assume an underlying exponential distribution. However, we 
are rarely in a position to assume exponential survival times in an actual clinical trial. How do we 
justify the exponential survival time assumption? First, the logrank test and the test derived using 
the exponential distribution have nearly the same power when the data are in fact exponentially 
distributed. Second, under the proportional hazards model (which is assumed by the logrank test), 
the survival distribution can be transformed to be exponential and the logrank test remains the 
same under monotonic transformations. 



700-2  Logrank Tests (Freedman) 

Technical Details 
In order to define the input parameters, we will present below some rather complicated looking 
formulas. You need not understand the formulas. However, you should understand the individual 
parameters used in these formulas. 

We assume that a study is to be made comparing the survival of an existing (control) group with 
an experimental group. The control group consists of patients that will receive the existing 
treatment. In cases where no existing treatment exists, the control group consists of patients that 
will receive a placebo. This group is arbitrarily called group one. The experimental group will 
receive the new treatment. It is called group two. 

We assume that the critical event of interest is death and that two treatments have survival 
distributions with instantaneous death (hazard) rates, λ1 and λ2 . These hazard rates are an 
subject’s probability of death in a short period of time. We want to test hypotheses about these 
hazard rates.  

Hazard Ratio 
There are several ways to express the difference between two hazard rates. One way is to 
calculate the difference,λ λ1 − 2 . Another way is to form the hazard ratio (HR): 

HR =
λ
λ

2

1

. 

Note that since HR is formed by dividing the hazard rate of the experimental group by that of the 
control group, a treatment that does better than the control will have a hazard ratio that is less 
than one. 

The hazard ratio may be formulated in other ways. If the proportions surviving during the study 
are called S1 and S2 for the control and experimental groups, the hazard ratio is given by 

HR Log S
Log S

=
( )
( )

2
1

. 

 

Furthermore, if the median survival times of the two groups are M1 and M2, the hazard ratio is 
given by 

HR M
M

=
1
2

. 

Each of these expressions for the difference between hazards rates is useful in some situations. 
There is no one best way, so you will have to be a little flexible. 
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Logrank Test 
We assume that the logrank test will be used to analyze the data once they are collected. Basing 
the power calculations on the logrank test, we arrive at the following formula that gives the power 
based on several other parameters: 

( ) ( ) ( )[ ] ( )
( )

z
HR N w S S

HR
z k1 1

1 1 1 1 1 2 1
1− −=

− − − + − +

+
−β α

ϕ ϕ ϕ

ϕ

/
/  

where k is 1 for a one-sided hypothesis test or 2 for a two-sided test, α and β  are the error rates 
defined as usual, the z’s are the usual points from the standard normal distribution, w is the 
proportion that are lost to follow up, and ϕ  represents the sample size ratio between the two 
groups. That is, is p1 is the proportion of the total sample size that is in the control group, ϕ  is 
given by 

ϕ =
−1 1

1
p

p
 

Note that the hypothesis being tested is that the hazard rates are equal: 

H0 1 2:λ λ=  

This formulation assumes that the hazard rates are proportional. It does not assume that the failure 
times are exponentially distributed. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are Proportion Surviving 1, Proportion Surviving 2, N, Alpha, or Power and 
Beta. Under most situations, you will select either Power and Beta or N. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment that has already 
been run.  

If you select Survive 1, the search is made for values that are less then S2. Likewise, if you select 
Survive 2, the search is made for values that are greater than S1. 
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal survival 
curves when in fact the curves are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis of equal survival curves when in fact the curves are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size – Total Sample Size 

N (Total Sample Size) 
The combined sample size of both groups. 

Sample Size – Sample Proportions 

Proportion in Group 1 
The proportion of the sample size (N) that is assigned to the first group. The rest of the patients 
are assigned to the second group. When exact values are not available, the number in group one is 
found by rounding up to the next integer. The number in group two is found by subtraction. 

Proportion Lost During Follow Up 
This is the proportion of patients in the trial that are lost to follow-up. Since they are lost, you can 
never obtain their outcome. The sample size is inflated to account for this loss using the formula: 

N(adjusted) = N/(1-p) 

where p is the proportion lost. 

Effect Size 

S1 (Proportion Surviving in Group 1) 
S1 is the proportion of patients belonging to group 1 (controls) that are expected to survive during 
the study. Since S1 is a proportion, it must be between zero and one. A value for S1 must be 
determined either from a pilot study or from previous studies. 
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S2 (Proportion Surviving in Group 2) 
S2 is the proportion of patients belonging to group 2 (experimental) that are expected to survive 
during the study. Since S2 is a proportion, it must be between zero and one. 

This value is not necessarily the expected survival proportion under the treatment. Rather, you 
may set it to that value that, if achieved, would be of special interest. Values below this amount 
would not be of interest. 

For example, if the standard 1-year survival proportion is 0.2 and the new treatment raises this 
proportion to 0.3 (a 50% increase in the proportion surviving), others may be interested in using 
it. 

Sometimes, researchers wish to state the alternative hypothesis in terms of the hazard ratio, HR, 
rather than the value of S2. Using the fact that 

HR = Log(S2)/Log(S1) 

we can solve for S2 to obtain 

S2 = Exp(Log(S1)HR).  

Using this equation, you can determine an appropriate value for S2 from a value for HR.  

For example, suppose S1 is 0.4 and you have determined that if the hazard rate is reduced by half, 
the improvement is sufficient to justify a change in treatment. The appropriate value for S2 is 
Exp(Log(0.4)(0.5)) = 0.632. 

When you do not have an anticipated value for HR, you can find an estimate base on the Median 
Survival Times (M1 and M2) since HR = M1/M2. 

Test 

One-Sided Test 
Specify whether the test is one-sided (checked) or two-sided (unchecked). When a two-sided test 
is selected, the value of alpha is divided by two. 

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Finding the Power 
An experiment has been conducted to test the effectiveness of a new treatment on a total of 100 
patients. The current treatment for this disease achieves 50% survival after two years. The 
proportion in the treatment group that survived two years was 0.70. Testing was done at the 0.05 
significance level. Even though there was an increase of 0.20 for 0.50 to 0.70, the logrank test did 
not reject the hypothesis of equal hazard rates for the two treatments. Study the power of this test.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Freedman) procedure window by expanding 
Survival, then Logrank, then clicking on Freedman, and then clicking on Logrank Tests 
(Freedman). You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 0.10 
N (Total Sample Size) ............................. 50 to 300 by 50 
Proportion in Group 1 .............................. 0.5 
Proportion Lost During Follow Up ........... 0 
S1 (Proportion Surviving in Group 1) ...... 0.5 
S2 (Proportion Surviving in Group 2) ...... 0.7 
One-Sided Test ....................................... Not Checked 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
      Hazard Two-Sided 
Power N N1 N2 S1 S2 Ratio Alpha Beta 
0.2992 50 25 25 0.5000 0.7000 0.5000 0.0500 0.7008 
0.4162 50 25 25 0.5000 0.7000 0.5000 0.1000 0.5838 
0.5267 100 50 50 0.5000 0.7000 0.5000 0.0500 0.4733 
0.6488 100 50 50 0.5000 0.7000 0.5000 0.1000 0.3512 
0.6994 150 75 75 0.5000 0.7000 0.5000 0.0500 0.3006 
0.7989 150 75 75 0.5000 0.7000 0.5000 0.1000 0.2011 
0.8177 200 100 100 0.5000 0.7000 0.5000 0.0500 0.1823 
0.8891 200 100 100 0.5000 0.7000 0.5000 0.1000 0.1109 
0.8934 250 125 125 0.5000 0.7000 0.5000 0.0500 0.1066 
0.9406 250 125 125 0.5000 0.7000 0.5000 0.1000 0.0594 
0.9395 300 150 150 0.5000 0.7000 0.5000 0.0500 0.0605 
0.9690 300 150 150 0.5000 0.7000 0.5000 0.1000 0.0310 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N is the combined sample size. 
N1 sample size in group 1. 
N2 sample size in group 2. 
S1 is the proportion surviving in group 1 
S2 is the proportion surviving in group 2 
The Hazard Ratio is the ratio of hazard2 and hazard1. It is Log(S2)/Log(S1). 
Alpha is the probability of rejecting a true null hypothesis. 
Beta is the probability of accepting a false null hypothesis. 
 
Summary Statements 
A two-sided log rank test with an overall sample size of 50 subjects (of which 25 are in group 
1 and 25 are in group 2) achieves 30% power at a 0.0500 significance level to detect a 
difference of 0.2000 between 0.5000 and 0.7000--the proportions surviving in groups 1 and 2, 
respectively. This corresponds to a hazard ratio of 0.5000. The proportion of patients lost 
during follow up was 0.0000. These results are based on the assumption that the hazard rates 
are proportional. 
 

This report shows the values of each of the parameters, one scenario per row. The values from 
this table are in the chart below.  

Plots Section 
 

 

Power vs N by Alpha
S1=0.50 S2=0.70 P1=0.50 Log Rank Test

N

50 100 150 200 250 300
0.25

0.40

0.55

0.70

0.85

1.00

Alpha
0.05
0.10

 
 

This plot shows the relationship between alpha and power in this example. We notice that for 
alpha = 0.05, a power of 0.80 is reached when the sample size is about 200. A power of 90% is 
reached when the sample size is 250. Hence, we realize that this study should have had at least 
twice the number of patients that it had. 
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Example 2 – Finding the Sample Size 
Continuing with our example, the researcher decides that he wants to do it right this time. He 
believes that if the survival proportion of the treatment group is 0.6 or better, people will begin to 
use his treatment. He wants to know how many subjects he needs. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Freedman) procedure window by expanding 
Survival, then Logrank, then clicking on Freedman, and then clicking on Logrank Tests 
(Freedman). You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.70 to 0.95 by 0.05 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Group 1 .............................. 0.5 
Proportion Lost During Follow Up ........... 0 
S1 (Proportion Surviving in Group 1) ...... 0.5 
S2 (Proportion Surviving in Group 2) ...... 0.60 0.62 0.64  
One-Sided Test ....................................... Not Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Plots Section 
 

 
 

We will consider the chart since that allows us to understand the patterns more quickly. We note 
that changing S2 from 0.60 (the top line) to 0.62 (the middle line) decreases the sample size 
requirements by almost half. Our researcher decides to take a sample of 500 patients. This will 
achieve almost 80% power in detecting a shift from 0.50 to 0.62 in survivability. 
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Example 3 – Validation using Machin 
Machin et al. (1997) page 180 gives an example in which S1 is 0.25, S2 is 0.50, the one-sided 
significance level is 0.05, and the power is 90%. The total sample size is 124. We will now run 
this example through PASS.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Freedman) procedure window by expanding 
Survival, then Logrank, then clicking on Freedman, and then clicking on Logrank Tests 
(Freedman). You may then make the appropriate entries as listed below, or open Example 3 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Group 1 .............................. 0.5 
Proportion Lost During Follow Up ........... 0 
S1 (Proportion Surviving in Group 1) ...... 0.25 
S2 (Proportion Surviving in Group 2) ...... 0.50  
One-Sided Test ....................................... Checked 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
      Hazard One-Sided 
Power N N1 N2 S1 S2 Ratio Alpha Beta 
0.9014 124 62 62 0.2500 0.5000 0.5000 0.0500 0.0986 
 

PASS also calculated the total sample size to be 124. 
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Chapter 705 

Logrank Tests 
(Lachin and 
Foulkes) 
Introduction 
This module computes the sample size and power of the logrank test for equality (or non-
inferiority) of survival distributions under the assumption of proportional hazards. Accrual time 
and follow-up time are included among the parameters to be set.  

A clinical trial is often employed to test the equality of survival distributions for two treatment 
groups. For example, a researcher might wish to determine if Beta-Blocker A enhances the 
survival of newly diagnosed myocardial infarction patients over that of the standard Beta-Blocker 
B. The question being considered is whether the pattern of survival is different. 

The two-sample t-test is not appropriate for two reasons. First, the data consist of the length of 
survival (time to failure), which is often highly skewed, so the usual normality assumption cannot 
be validated. Second, since the purpose of the treatment is to increase survival time, it is likely 
(and desirable) that some of the individuals in the study will survive longer than the planned 
duration of the study. The survival times of these individuals are then said to be censored. These 
times provide valuable information, but they are not the actual survival times. Hence, special 
methods have to be employed which use both regular and censored survival times. 

The logrank test is one of the most popular tests for comparing two survival distributions. It is 
easy to apply and is usually more powerful than an analysis based simply on proportions. It 
compares survival across the whole spectrum of time, not just at one or two points. This module 
allows the sample size and power of the logrank test to be analyzed under very general 
conditions. 

Power and sample size calculations for the logrank test have been studied by several authors. 
PASS uses the methods of Lachin and Foulkes (1986) because of their generality. Although small 
differences among methods can be found depending upon which assumptions are adopted, there 
is little practical difference between the techniques.  

The power calculations used here assume an underlying exponential distribution. However, this 
assumption is rarely accurate in an actual clinical trial. How is this assumption justified? First, the 
logrank test and the test derived using the exponential distribution have nearly the same power 
when the data are in fact exponentially distributed. Second, under the proportional hazards model 



705-2  Logrank Tests (Lachin and Foulkes) 

(which is assumed by the logrank test), the survival distribution can be transformed to 
exponential and the logrank test remains the same under monotonic transformations. 

Technical Details 
Some rather complicated formulas are used to define the input parameters. You need not 
understand the formulas. However, you should understand the individual parameters used in these 
formulas. 

Basic Model 
Suppose a clinical trial consists of two independent treatment groups labeled “1” and “2” (you 
could designate group one as the control group and group two as the treatment group). If the total 
sample size is N, the sizes of the two groups are  and . Usually, you would plan to have 

. Define the proportion of the total sample in each group as 
n1 n2

n n1 = 2

i
iQ  =  n

N
,   i =1,2  

Individuals are recruited during an accrual period of R years (or months or days). They are 
followed for an additional period of time until a total of T years is reached. Hence, the follow-up 
period is T-R years. At the end of the study, the logrank test is conducted at significance level α  
with power 1− β . 

If we assume an exponential model with hazard rates λ1  and λ2  for the two groups, Lachin and 
Foulkes (1986, Eq. 2.1) establish the following equation relating N and power: 

( ) ( ) ( )N| - | =  Z
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Q
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where 

λ λ =  Q Q1 1 2 2+ λ  

( ) ( )φ λ σ λ=  N 2 $  

( )Z  =  θ θΦ 1−  

( )Φ z  is the area to the left of z under the standard normal density,  is the maximum likelihood 

estimate of 

$λ

λ , and that  represents the variance of  ( )σ λ2 $ $ .λ
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Exponential Distribution 
The hazard rate from the exponential distribution, λ , is usually estimated using maximum 
likelihood techniques. In the planning stages, you have to obtain an estimate of this parameter. To 
see how to accomplish this, let’s briefly review the exponential distribution. The density function 
of the exponential is defined as 

f(t) =  e    t 0, > 0.tλ λλ− ≥,  

The cumulative survival distribution function is 

( )S t  =  e    t 0.t− ≥λ ,  

Solving this for λ  yields 

( )( )λ =  -
S t
t

log
 

Note that S(t) gives the probability of surviving t years. To obtain a planning estimate of λ , you 
need only know the proportion surviving during a particular time period. You can then use the 
above equation to calculate λ . 

Patient Entry 
Patients are enrolled during the accrual period. PASS lets you specify the pattern in which 
subjects are enrolled. Suppose patient entry times are distributed as g(t) where  is the entry time 
of the ith individual and 0 ≤  ≤ R. Let g(t)1 follow the truncated exponential distribution with 
parameter A, which has the density 
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Note that R is accrual time. The corresponding cumulative distribution function is 
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A is interpreted as follows.  

A > 0 results in a convex (faster than expected) entry distribution. 

A < 0 results in a concave (slower than expected) entry distribution. 

A = 0 results in the uniform entry distribution in which g(t) =1/R.  

Rather than specify A directly, PASS has you enter the percentage of the accrual time that will be 
needed to enroll 50% of the subjects. Using an iterative search, the value of A corresponding to 
this percentage is calculated and used in the calculations. 
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Losses to Follow-Up 
The staggered patient entry over the accrual period results in censoring times ranging from T - R 
to T years during the follow-up period. This is often referred to as administrative censoring, since 
it is caused by the conclusion of the study rather than by some random factor working on an 
individual. To model the losses to follow-up which come from other causes, we use the 
exponential distribution with hazard rates η1  and η2 . Since these rates are difficult and confusing 
to define directly, PASS lets you input the proportion lost due to other causes over a specified 
period of time and uses the following equation to determine the hazard rates:  

( )( )η =  -
P t

t
log 1−

 

General Model 
Combining all these parameters into the model results in  
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This expression may then be used in an equation that relates these parameters to sample size and 
power 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are Proportion Surviving 1, Proportion Surviving 2, Accrual, Follow-Up, 
Alpha, Beta, and N. Under most situations, you will select either Power and Beta or N. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power.  
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal survival 
curves when in fact the curves are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis of equal survival curves when in fact the curves are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size – Total Sample Size 

N (Total Sample Size) 
This is the combined sample size of both groups. This amount is divided between the two groups 
using the value of the Proportion in Group 1.  

Sample Size – Sample Proportion 

Proportion in Group 1 
This is the proportion of N in group one. If this value is labeled , the sample size of group one 
is  and the sample size of group two is 

p1

Np1 N Np− 1 . Note that the value of  is rounded to 
the nearest integer. 

Np1

Sample Size – Proportions Lost to 
Follow-Up 

Group 1 and Group 2 
This is the proportion in this group that is lost to follow-up during the Fixed Time Period, T0. 
Using this value, the lost-to-follow-up hazard rate is calculated using the exponential distribution 
as it is with S(t). The equation used to convert these proportions into η1  and η2  is: 

( )( )ηi
i =  -

P T0
T0

log 1−
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Here P(T0) is the proportion lost to follow up from the beginning of the study until T0. So if T0 is 
3 years and 10% of the patients in group one are lost to follow-up 

η1 10 01 3
0 03512

= − −
=

log( . . ) /
.

  

Values between zero and one are valid. Zero is used to indicate no loss to follow-up. 

Effect Size 

S1 and S2 (Proportion Surviving Past T0) 
Specify the proportion of patients in each group that survive until after T0. These quantities are 
called S1 and S2. The value of T0 is given in the Fixed Time Point box. For example, if the Fixed 
Time parameter is 3 and this value is set to 0.7, then 70% of the patients survive at least 3 years. 
Note that since this is a proportion, values must be between zero and one. 

These quantities are used as a convenient method of entering the hazard rates λ1  and λ2 . The 
first group is arbitrarily designated as the control group and the second group is arbitrarily 
designated as the treatment group.  

The hazard rates are calculated from the proportions surviving using the formulas 

( )λ1
1

 =  -
S

T0
log

 and 
( )λ2

2
 =  -

S
T0

log
 

If your sample size problem is cast in terms of hazard rates, the proportions surviving are 
calculated using the formula 

(S t1 1= )−exp λ  and ( )S t2 2= −exp λ  

T0 (Fixed Time Point) 
This is the time period used to convert the proportions given in Proportion Surviving 1, 
Proportion Surviving 2, Follow-Up Loss1, and Follow-Up Loss2 into hazard rates. If you enter 
0.4 in Proportion Survive1 and a 3 here, you are indicating that 40% survive longer than 3 years. 

Duration 

R (Accrual Time) 
The accrual time is the length of time during which patients enter the study. It is the value of R.  

% Time Until 50% Accrual 
This specifies the percentage of the accrual time needed to enroll 50% of the patients. This value 
is converted into a value for A, the patient entry parameter. Use this option to indicate how 
subjects are enrolled during the accrual period. For example, in one study, it may be possible to 
enroll a number of patients early on, while in another study, most of the subjects will be enrolled 
near the end of the accrual period. 

Values between 1 and 97 may be entered. 

If you expect uniform patient entry, enter 50. Unless you know that patient enrollment will not be 
uniform during the accrual period, you should use this amount. 
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If you expect more patients to enter during the early part of the accrual period, enter an amount 
less than 50 such as 30. A 30 here means that 50% of the patients will have been enrolled when 
30% of the accrual time has elapsed. 

If you expect more patients to enter during the later part of the accrual period, enter an amount 
greater than 50 such as 70. A 70 here means that 50% of the patients will have been enrolled 
when 70% of the accrual time has elapsed. 

PASS assumes that patient entry times follow the truncated exponential distribution. This 
parameter controls the shape and scale of that distribution.  

Follow-Up Time, T-R 
The follow-up time is the length of time between the entry of the last individual into the study and 
the end of the study. Since T is the total length of the study and R is the accrual time, the follow-
up time is T-R. 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis in terms of the proportion surviving in each 
group. This implicitly specifies the direction of the hypothesis test. The null hypothesis is always 

. H S S0 1 2: =

Note that the alternative hypothesis enters into power calculations by specifying the rejection 
region of the hypothesis test. Its accuracy is critical. 

Possible selections are: 

• Ha: S1 <> S2 
This is the usual selection. It yields the two-tailed t-test. Use this option when you are testing 
whether the survival curves are different, but you do not want to specify beforehand which 
curve is better. 

• Ha: S1 < S2 
This option yields a one-tailed test. Use it when you are only interested in the case in which 
the survival in group one is less than that for group two. 

• Ha: S1 > S2 
This option yields a one-tailed test. Use it when you are only interested in the case in which 
the survival in group one is greater than that for group two. 
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Example 1 – Finding the Power 
A researcher is planning a clinical trial using a parallel, two-group, equal sample allocation 
design to compare the survivability of a new treatment with that of the current treatment. The 
proportion surviving one-year after the current treatment is 0.50. The new treatment will be 
adopted if the proportion surviving after one year increases to 0.75.   

The trial will include a recruitment period of one-year after which participants will be followed 
for an additional two-years. It is assumed that patients will enter the study uniformly over the 
accrual period. The researcher estimates a loss-to-follow rate of 15% during the first year in both 
the control and the experimental groups.  

The researcher decides to investigate various sample sizes between 10 and 250 at both the 0.01 
and 0.05 significance levels.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lachin and Foulkes) procedure window by 
expanding Survival, then Logrank, then clicking on Lachin and Foulkes, and then clicking on 
Logrank Tests (Lachin and Foulkes). You may then make the appropriate entries as listed 
below, or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.01 0.05 
N (Total Sample Size) ............................. 10 25 50 100 150 200 250 
Proportion in Group 1 .............................. 0.5 
Proportion Lost to Follow-Up 1 ............... 0.15 
Proportion Lost to Follow-Up 2 ............... 0.15 
S1 (Proportion Surviving in Group 1) ...... 0.50 
S2 (Proportion Surviving in Group 2) ...... 0.75 
T0 (Fixed Time Point) .............................. 1 
R (Accrual Time) ..................................... 1 
% Time Until 50% Accrual ....................... 50 
Follow-Up Time, T-R ............................... 2 
Alternative Hypothesis ............................ Ha: S1 ≠ S2 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results with Ha: S1<>S2 
 
  Surviving Surviving Accrual Follow Up Prop in 
Power N Group 1 Group 2 Time Time Group 1 Alpha Beta 
0.06718 10 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.93282 
0.18406 10 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.81594 
0.17527 25 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.82473 
0.36633 25 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.63367 
0.38357 50 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.61643 
0.61606 50 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.38394 
0.72756 100 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.27244 
0.88428 100 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.11572 
0.90273 150 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.09727 
0.97052 150 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.02948 
0.96998 200 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.03002 
0.99328 200 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.00672 
0.99167 250 0.50000 0.75000 1.00 2.00 0.50000 0.01000 0.00833 
0.99858 250 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.00142 
 
Base Time 1.00 
Proportion loss to follow up in group 1 0.15000 
Proportion loss to follow up in group 2 0.15000 
Percent of accrual time until 50% enrollment is reached: 50.00% 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Power should be close to one. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
 
Summary Statements 
A two-sided log rank test with an overall sample size of 10 subjects (of which 5 are in group 1 
and 5 are in group 2) achieves 7% power at a 0.01000 significance level to detect a difference 
of 0.25000 between 0.50000 and 0.75000--the proportions surviving in groups 1 and 2 after 1.00 
time periods. Patients entered the study during an accrual period of 2.00 time periods. 50% of 
the enrollment was complete when 50.00% of the accrual time had past. A follow-up period of 
1.00 time periods had a 15.0% loss from group 1 and a 15.0% loss from group 2. 
 

This report shows the values of each of the parameters, one scenario per row. Note that 
approximately 100 patients, 50 per group, will be needed to achieve about 90% power at the 0.05 
significance level. 
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Plots Section 
 

                
   

This plot shows the relationship between sample size and power for the two significance levels.  

Example 2 – Finding the Sample Size 
Continuing with the previous example, the researcher wants to investigate the sample size 
necessary to achieve 80% or 90% power for various values of the proportion surviving in the 
treatment group from 0.55 to 0.80 at the 0.05 significance level. All other parameters will remain 
the same. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lachin and Foulkes) procedure window by 
expanding Survival, then Logrank, then clicking on Lachin and Foulkes, and then clicking on 
Logrank Tests (Lachin and Foulkes). You may then make the appropriate entries as listed 
below, or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... 0.80 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Group 1 .............................. 0.5 
Proportion Lost to Follow-Up 1 ............... 0.15 
Proportion Lost to Follow-Up 2 ............... 0.15 
S1 (Proportion Surviving in Group 1) ...... 0.5 
S2 (Proportion Surviving in Group 2) ...... 0.55 to 0.80 by 0.05 
T0 (Fixed Time Point) .............................. 1 
R (Accrual Time) ..................................... 1 
% Time Until 50% Accrual ....................... 50 
Follow-Up Time, T-R ............................... 2 
Alternative Hypothesis ............................ Ha: S1 ≠ S2 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

Numeric Results with Ha: S1<>S2 
 
  Surviving Surviving Accrual Follow Up Prop in 
Power N Group 1 Group 2 Time Time Group 1 Alpha Beta 
0.90004 2798 0.50000 0.55000 1.00 2.00 0.50000 0.05000 0.09996 
0.80017 2090 0.50000 0.55000 1.00 2.00 0.50000 0.05000 0.19983 
0.90024 690 0.50000 0.60000 1.00 2.00 0.50000 0.05000 0.09976 
0.80050 515 0.50000 0.60000 1.00 2.00 0.50000 0.05000 0.19950 
0.90001 302 0.50000 0.65000 1.00 2.00 0.50000 0.05000 0.09999 
0.80010 225 0.50000 0.65000 1.00 2.00 0.50000 0.05000 0.19990 
0.90098 168 0.50000 0.70000 1.00 2.00 0.50000 0.05000 0.09902 
0.80177 125 0.50000 0.70000 1.00 2.00 0.50000 0.05000 0.19823 
0.90107 106 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.09893 
0.80357 79 0.50000 0.75000 1.00 2.00 0.50000 0.05000 0.19643 
0.90274 73 0.50000 0.80000 1.00 2.00 0.50000 0.05000 0.09726 
0.80432 54 0.50000 0.80000 1.00 2.00 0.50000 0.05000 0.19568 
 
Base Time1.00 
Proportion loss to follow up in group 10.15000 
Proportion loss to follow up in group 20.15000 
Percent of accrual time until 50% enrollment is reached: 50.00% 
 
 

N

 
 

This study shows the huge increase in sample size necessary to detect values of S2 below 0.65. It 
also shows that roughly 35% more participants are required for 90% power than for 80% power 
in this situation. 
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Example 3 – Validation using Lachin and Foulkes 
Lachin and Foulkes (1986), the developers of formulas used in this routine, give an example on 
page 509 in which λ1 030= . , λ2 0 20= . , N = 378 , α = 0 05.  (one-sided), R = 3, T = 3 , and 
β = 010. . There is no loss to follow up and uniform patient entry is assumed.   

The first step is to determine the proportion surviving at the end of one year for each group using 
the formula: 

  S(t) =  e t−λ

For group 1 we have 

( )S e1
0 31

0 74081822
=

=

− . (1)

.
 

For group 2 we have 

( )S e2
0 21

0 81873075
=

=

− . (1)

.
 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lachin and Foulkes) procedure window by 
expanding Survival, then Logrank, then clicking on Lachin and Foulkes, and then clicking on 
Logrank Tests (Lachin and Foulkes). You may then make the appropriate entries as listed 
below, or open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find Setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 378 
Proportion in Group 1 .............................. 0.5 
Proportion Lost to Follow-Up 1 ............... 0.0 
Proportion Lost to Follow-Up 2 ............... 0.0 
S1 (Proportion Surviving in Group 1) ...... 0.74081822 
S2 (Proportion Surviving in Group 2) ...... 0.81873075 
T0 (Fixed Time Point) .............................. 1 
R (Accrual Time) ..................................... 3 
% Time Until 50% Accrual ....................... 50 
Follow-Up Time, T-R ............................... 2 
Alternative Hypothesis ............................ Ha: S1 < S2 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results with Ha: S1<S2 
 
  Surviving Surviving Accrual Follow Up Prop in 
Power N Group 1 Group 2 Time Time Group 1 Alpha Beta 
0.90123 378 0.74082 0.81873 3.00 2.00 0.50000 0.05000 0.09877 
 
Base Time1.00 
Proportion loss to follow up in group 1 during the base time: 0.00000 
Proportion loss to follow up in group 2 during the base time: 0.00000 
Percent of accrual time until 50% enrollment is reached: 50.00% 
 

The power of 0.90 matches the value published in Lachin’s article.  

Example 4 – Non-Inferiority Test 
This example will show how to use this module to calculate power and sample size for non-
inferiority trials. Remember that non-inferiority is established by showing that the new treatment 
is no worse than the standard treatment, except for a small amount called the margin of 
equivalence.  

Consider the following example. Suppose the median survival time of the standard drug is 15 
months. Unfortunately, this drug has serious side effects. A promising new drug has been 
developed that has much milder side effects. A non-inferiority trial is to be designed to show that 
the new drug is not inferior to the standard drug. The margin of equivalence is set at 3 months, so, 
to establish non-inferiority, the study has to conclude that the median survival time of the new 
drug is at least 12 months.  

The trial will accept subjects for 18 months. It will continue for an additional 6 months after the 
accrual period. Although the study planners anticipate some dropout, they want to begin their 
analysis without considering dropout. They set the significance level at 0.05. They want to 
determine the necessary sample size to achieve 80% and 90% power. The calculations proceed as 
follows. 

Use the Survival Parameter Conversion Tool to convert the “median survival rates” to 
“proportions surviving” so that they can be entered into the panel. Press the Survival Parameter 
Conversion Tool button that is next to the S1 box to display this window. Enter 24 for T0, 12 for 
Median Survival Time (T1), and 15 for Median Survival Time (T2). The screen will appear as 
follows. 
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This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lachin and Foulkes) procedure window by 
expanding Survival, then Logrank, then clicking on Lachin and Foulkes, and then clicking on 
Logrank Tests (Lachin and Foulkes). You may then make the appropriate entries as listed 
below, or open Example 4 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.80 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find Setting 
Proportion in Group 1 .............................. 0.5 
Proportion Lost to Follow-Up 1 ............... 0.0 
Proportion Lost to Follow-Up 2 ............... 0.0 
S1 (Proportion Surviving in Group 1) ...... 0.25 
S2 (Proportion Surviving in Group 2) ...... 0.329876977693224 
T0 (Fixed Time Point) .............................. 24 
R (Accrual Time) ..................................... 18 
% Time Until 50% Accrual ....................... 50 
Follow-Up Time, T-R ............................... 6 
Alternative Hypothesis ............................ Ha: S1 < S2 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

  Surviving Surviving Accrual Follow Up Prop in 
Power N Group 1 Group 2 Time Time Group 1 Alpha Beta 
0.90018 1326 0.25000 0.32988 18.00 6.00 0.50000 0.05000 0.09982 
0.80030 957 0.25000 0.32988 18.00 6.00 0.50000 0.05000 0.19970 
 

Thus, a sample size of about 663 per group would be needed for 90% power, and a sample of 479 
per group would be needed for 80% power.  
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Chapter 706 

Logrank Tests for 
Non-Inferiority 
Introduction 
This module computes the sample size and power for non-inferiority tests under the assumption 
of proportional hazards. Accrual time and follow-up time are included among the parameters to 
be set. The non-inferiority logrank test is used for data analysis. 

Sometimes, the objective of a study is to show that an experimental therapy is not inferior to (no 
worse than) the standard therapy. The experimental therapy may be cheaper, less toxic, or have 
fewer side effects. Such studies are often called non-inferiority trials and have a one-sided 
hypothesis. 

Power and sample size calculations for the non-inferiority logrank test have been developed by 
Jung et al. (2005), and we use their results. These calculations assume an underlying exponential 
survival distribution with a uniform patient accrual pattern during the accrual period.  

Technical Details 

Test Statistic 
Suppose a clinical trial consists of two independent groups. Designate group one as the standard 
group with hazard rate h1 and sample size n1. Designate group two as the experimental group with 
hazard rate h2 and sample size n2. The total sample size is N =  + . Usually, you would plan 
to have  = .  

n1 n2

n1 n2

Define the proportion of the total sample in each group as 

i
iQ  =  n

N
,   i =1,2  

Individuals are recruited during an accrual period of R years (or months or days). They are 
followed for an additional period of time until a total of T years is reached. Hence, the follow-up 
period is T-R years. At the end of the study, the non-inferiority logrank test is conducted at 
significance level α  with power 1− β . Under the proportion hazards assumption, the hazard 
ratio HR = h2 / h1 is constant across time.  
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For a given non-inferiority margin HR0 (>1) (the maximum ratio of clinical insignificance), the 
statistical hypotheses tested are 

0100 :.: HRHRHvsHRHRH <≥  

Define the partial score function as 
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where  is the minimum of the survival time, and the censoring time,kiX kiδ ,is an event indicator 
taking 1 if there was an event or 0 otherwise, and I(.) is an indicator function. Note that W(1) is 
the standard logrank test statistic. 

Under , 0H ( ) ( 00 / HRHRW N )σ  is asymptotically normal with mean 0 and variance 1. Reject 
in favor of  if  0H 1H ( )0 /HRW ( )0HRNσ >  with one-sided type I error probability α−1z α . 

The partial MLE, RĤ , is obtained by solving ( ) 0=HRW . Let  denote the true value of 

HR. It can be shown that 

*HR
RĤ  is asymptotically normal with mean  and variance 

. 
*HR

( )*2 HRN
−σ

An asymptotic ( )%1100 α−  confidence interval for HR is ( )RHzRH N
ˆˆ 1

2/1
−

−± σα . 

Power Calculations 
Jung (2005) shows that the power of the non-inferiority logrank test can be expressed as 

( )
⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛

+
−−

Φ=− −

021

01210 1
1

HRQQ
HRzQDQHR αβ  

where D is the observed number of deaths (events). The total sample size N is obtained by 
inflating D according to the relationship E(d)N = D, where E(d) is the expected death rate for the 
trial. 

Following the proposal of Yateman and Skene (1992) and the results of Lakatos (1988), we 
compute E(d) using the Markov Model given in chapter 715 as 

( ) 2,222,11 SQSQdE +=  
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where S1,2 and S2,2 are the occupancy probabilities for the event state for the standard and 
experimental groups, respectively. This formulation allows the inclusion of loss to follow-up, 
noncompliance, and drop-in along with various accrual patterns. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are Power and Beta or N. Select N when you want to calculate the sample 
size needed to achieve a given power and alpha level. Select Power and Beta when you want to 
calculate the power.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you do not reject the null hypothesis that the hazard 
ratio is greater than HR0 when in fact it is. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis that the hazard ratio is greater than HR0 when in fact it is not. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  
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Sample Size 

N (Total Sample Size) 
This is the combined sample size of both groups. This amount is divided between the two groups 
using the value of the Proportion in Reference Group.  

Proportion in Reference Group 
This is the proportion of N in the reference (control) group. If this value is labeled , the sample 
size of group one is  and the sample size of group two is 

1Q

1NQ 1NQN − . Note that the value of 
 is rounded to the nearest integer. 1NQ

Effect Size 

HR0 (Equivalence) 
This is the maximum value of the hazard ratio that still results in the conclusion of equivalence. It 
is referred to as HR0 in this documentation. Assuming that events are bad (such as death), then 
this number should be > one. 

For example, if you enter 1.20 here, you are saying that hazard ratios < 1.20 will result in the 
conclusion of non-inferiority when H0 is rejected. In other words, hazard ratios up to 1.20 
indicate that the treatment group is no worse than the reference group. Estimates of the hazard 
ratio may be obtained from median survival times, hazard rates, or from the proportion surviving 
past a certain time point. Pressing the Parameter Conversion button will load a tool for doing this. 

h1 (Hazard Rate of Reference Group) 
Specify one or more hazard rates (instantaneous failure rate) for the reference group. For an 
exponential distribution, the hazard rate is the inverse of the mean survival time. An estimate of 
the hazard rate may be obtained from the median survival time or from the proportion surviving 
to a certain time point. This calculation is automated by pressing the Parameter Conversion 
button. 

Hazard rates must be greater than zero. Constant hazard rates are specified by entering them 
directly. Variable hazard rates are specified as columns of the spreadsheet. When you want to 
specify different hazard rates for different time periods, you would enter those rates into a column 
of the spreadsheet, one row per time period. You specify the column (or columns) by beginning 
the entry with an equals sign. For example, if you have entered the hazard rates in column 2, you 
would enter =2 here.    

Duration 

Accrual Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) during which 
subjects are entered into the study. The total duration of the study is equal to the Accrual Time 
plus the Follow-Up Time. These values must be integers. 

Accrual times can range from 0 to the Total Time. That is, the accrual time must be less than or 
equal to the Total Time. Otherwise, the scenario is skipped. 

Enter 0 when all subjects begin the study together. 
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Accrual Pattern 
This contains the pattern of accrual (patient entry). Two types of entries are possible: 

• Uniform 
If you want to specify a uniform accrual rate for all time periods, enter Equal here. 

• Non-Uniform 
When you want to specify accrual patterns with different accrual proportions per time period, 
you would enter the pattern into a column of the spreadsheet, one row per time period and 
specify the column, or columns, here, beginning your entry with an equals sign. For example, 
if you have entered accrual patterns in columns 4 and 5, you would enter =C4 C5. 

Note that these values are standardized to sum to one. Thus, the accrual pattern 0.25 0.50 0.25 
would result in the same accrual pattern as 1 2 1 or 25 50 25. 

Total Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) in the study. The 
follow-up time is equal to the Total Time minus the Accrual Time. These values must be integers. 

Proportion Lost or Switching Groups 

Reference (or Treatment) Lost 
This is the proportion of subjects in the reference (treatment) group that disappear from the study 
during a single time period (month, year, etc.). Multiple entries, such as 0.01 0.03 0.05, are 
allowed. 

When you want to specify different proportions for different time periods, you would enter those 
rates into a column of the spreadsheet, one row per time period. You specify the column of the 
spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 5, you would enter =C5 here. 

Reference Switching to Treatment 
This is the proportion of subjects in the reference group that change to a treatment regime similar 
in efficacy to the treatment group during a single time period (month, year, etc.). This is 
sometimes referred to as drop in. Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter those 
values into a column of the spreadsheet, one row per time period. You specify the column of the 
spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 1, you would enter =C1 here. 

Treatment Switching to Reference 
This is the proportion of subjects in the treatment group that change to a treatment regime similar 
in efficacy to the reference group during a single time period (month, year, etc.). This is 
sometimes referred to as noncompliance. Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter those 
values into a column of the spreadsheet, one row per time period. You specify the column of the 
spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 2, you would enter =C2 here. 
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Reports Tab 
The Reports tab contains additional settings for this procedure.  

Report Column Width 

Report Column Width 
This option sets the width of the each column of the numeric report. 

The numeric report for this option necessarily contains many columns, so the maximum number 
of decimal places that can be displayed is four. If you try to increase that number, the numbers 
may run together. You can increase the width of each column using this option. 

The recommended report column width for scenarios without large numbers of decimal places or 
extremely large sample sizes is 0.49. 

Options Tab 
The Options tab contains additional settings for this procedure.  

Options 

Number of Intervals within a Time Period 
The algorithm requires that each time period be partitioned into a number of equal-width 
intervals. Each of these subintervals is assumed to follow an exponential distribution. This option 
controls the number of subintervals. All parameters such as hazard rates, loss to follow-up rates, 
and noncompliance rates are assumed to be constant within a subinterval. 

Lakatos (1988) gives little input as to how the number of subintervals should be chosen. In a 
private communication, he indicated that 100 ought to be adequate. This seems to work when the 
hazard rate is less than 1.0.  

As the hazard rate increases above 1.0, this number must increase. A value of 2000 should be 
sufficient as long as the hazard rates (h1 and h2) are less than 10. When the hazard rates are 
greater than 10, you may want to increase this value to 5000 or even 10000. 
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Example 1 – Finding the Power 
A non-inferiority trial is planned in which the primary analysis will use the non-inferiority 
logrank test. After extensive discussion, the researchers have decided that the upper bound on 
non-inferiority is 1.3.  

The trial will include a recruitment period of two-years after which participants will be followed 
for three more years. It is assumed that patients will enter the study uniformly over the accrual 
period. The researcher estimates a loss-to-follow rate of 5% per year in both the reference and 
experimental groups. Past experience leads to a base line hazard rate of 0.04. An equal sample 
allocation design will be used with a target power of 0.90 and significance level of 0.05.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests for Non-Inferiority procedure window by 
expanding Survival, then Logrank, then clicking on Non-Inferiority, and then clicking on 
Logrank Tests for Non-Inferiority. You may then make the appropriate entries as listed below, 
or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 1000 to 5000 by 1000 
Proportion in Reference Group ............... 0.5 
HR0 ......................................................... 1.3 
h1 ............................................................ 0.04 
Accrual Time ........................................... 2 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 5 
Proportion Lost - Reference .................... 0.05 
Proportion Lost - Treatment .................... 0.0 

Reports Tab 
Show Detail Numeric Reports ................. Checked 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size 
        Acc-       
    Equiv Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N (HR0) (HR) (h1) Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.4665 500 500 1000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.5335 
0.7111 1000 1000 2000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.2889 
0.8528 1500 1500 3000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.1472 
0.9282 2000 2000 4000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0718 
0.9662 2500 2500 5000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0338 
 
References 
Jung,Sin-Ho; Kang, Sun J.; McCall, Linda M.; Blumenstein, Brent. 2005. 'Sample Sizes Computation for 
     Two-Sample Noninferiority Log-Rank Test', J. of Biopharmaceutical Statistics, Volume 15, pages 969-979. 
Lakatos, Edward. 1988. 'Sample Sizes Based on the Log-Rank Statistic in Complex Clinical Trials', Biometrics, 
     Volume 44, March, pages 229-241. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Power should be close to one. 
N1|N2|N are the sample sizes of the reference group, treatment group, and both groups, respectively. 
E1|E2|E are the number of events in the reference group, the treatment group, and both groups, respectively. 
Equivalence Haz Ratio (HR0) is the upper bound for the hazard ratio that still leads to the conclusion of 
     non-inferiority. 
Actual Haz Ratio (HR) is assumed to be the actual value of the hazard ratio. 
Ref Haz Rate is the hazard (instantaneous failure) rate of the reference group. Its scale is events per time period. 
Accrual Time is the number of time periods (years or months) during which accrual takes place. 
Total Time is the total number of time periods in the study. Follow-up time = (Total Time) - (Accrual Time). 
Ref Loss is the proportion of the reference group that is lost (drop out) during a single time period (year or month). 
Trt Loss is the proportion of the treatment group that is lost (drop out) during a single time period (year or month). 
Ref to Trt (drop in) is the proportion of the reference group that switch to a group with a hazard rate equal to the 
     treatment group. 
Trt to Ref (noncompliance) is the proportion of the treatment group that switch to a group with a hazard rate equal to 
     the reference group. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 

 

This report shows the values of each of the parameters, one scenario per row. We see that almost 
4000 subjects will be required for this study. 
Next, a report displaying the number of required events rather than the sample size is displayed. 

 
Numeric Results in Terms of Events 
        Acc-       
    Equiv Actual Ref  rual       
 Ref Trt Total Haz Haz Haz Acc- Time/   Ref Trt   
 Evts Evts Evts Ratio Ratio Rate rual Total Ref Trt to to   
Power E1 E2 E (HR0) (HR) (h1) Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.4665 66.8 73.8 140.6 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.5335 
0.7111 133.6 147.6 281.3 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.2889 
0.8528 200.4 221.5 421.9 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.1472 
0.9282 267.3 295.3 562.5 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0718 
0.9662 334.1 369.1 703.2 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0338 
 

Most of this report is identical to the last report, except that the sample sizes are replaced by the 
number of required events. 
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Next, reports displaying the individual settings year-by-year for each scenario are displayed. 
 
Detailed Input when Power=.4510  HR0=1.30  HR=1.00  N=1000  Alpha=.0500  Accrual/Total Time=2 / 5 
 
 Reference     Switch Switch 
 Hazard  Percent   Reference Treatment 
 Rate Percent Admin.Reference Treatment to to 
Time (H1) Accrual Censored Loss Loss Treatment Reference 
Period (.0400) (Equal) (Calc.) (.0500) (.0500) (.0000) (.0000) 
1 .0400 50.00 .00 .0500 .0500 .0000 .0000 
2 .0400 50.00 .00 .0500 .0500 .0000 .0000 
3 .0400 .00 .00 .0500 .0500 .0000 .0000 
4 .0400 .00 50.00 .0500 .0500 .0000 .0000 
5 .0400 .00 100.00 .0500 .0500 .0000 .0000 
 

This report shows the individual settings for each time period (year). It becomes very useful when 
you want to document a study in which these parameters vary from year to year. 
Next, summary statements are displayed. 

 
Summary Statements 
A non-inferiority logrank test with an overall sample size of 1000 subjects (500 in the 
reference group and 500 in the treatment group) achieves 45.1% power at a 0.050 significance 
level to detect an equivalence hazard ratio of 1.30 when the actual hazard ratio is an 
equivalence hazard ratio of 1.00 and the reference group hazard rate is 0.0400. The study lasts 
for 5 time periods of which subject accrual (entry) occurs in the first 2 time periods. The 
accrual pattern across time periods is uniform (all periods equal). The proportion dropping out 
of the reference group is 0.0500. The proportion dropping out of the treatment group is 0.0500. 
The proportion switching from the reference group to another group with a hazard rate equal to 
the treatment group is 0.0000. The proportion switching from the treatment group to another 
group with a hazard rate equal to the reference group is 0.0000. 
 

Finally, a scatter plot of the results is displayed. 

Plots Section 
 

 

Pwr vs N
h1=0.04 AT=2 T=5 P1=0.50 A=0.05 E=U LR=0.05 HR0=1.30 Logrank Test

Total N

1000 2000 3000 4000 5000
0.45

0.56

0.67

0.78

0.89

1.00

               
   

This plot shows the relationship between sample size and. Note that for 90% power, a total 
sample size of about 4000 is required. The exact number will be found in Example 2.  
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Example 2 – Finding the Sample Size 
Continuing with the previous example, the researcher wants to investigate the sample sizes 
necessary to achieve 80% and 90% power. All other parameters will remain the same as in 
Example 1. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests for Non-Inferiority procedure window by 
expanding Survival, then Logrank, then clicking on Non-Inferiority, and then clicking on 
Logrank Tests for Non-Inferiority. You may then make the appropriate entries as listed below, 
or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.80 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Reference Group ............... 0.5 
HR0 ......................................................... 1.3 
h1 ............................................................ 0.04 
Accrual Time ........................................... 2 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 5 
Proportion Lost - Reference .................... 0.05 
Proportion Lost - Treatment .................... 0.05 
 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size 
        Acc-       
    Equiv Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N (HR0) (HR) (h1) Pat'n Time Loss Loss Trt Ref Alpha Beta 
.9000 1865 1866 3731 1.30 1.00 .0400 Equal 2 / 5 .0500 .0500 .0000 .0000 .0500 .1000 
.8000 1344 1345 2689 1.30 1.00 .0400 Equal 2 / 5 .0500 .0500 .0000 .0000 .0500 .2000 
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Example 3 – Validation using Jung 
Jung et al. (2005) pages 974-975 present an example that will be used to validate this procedure. 
In this article, an 8.8-year trial is presented in which patient accrual occurs the first 3.8 years. The 
baseline hazard rate is 0.0446. The value of HR0 is 1.3 and the value of HR is 1.0. Equal 
allocation between groups is used and uniform accrual is assumed. The significance level is 0.05 
and the desired power is 0.90. Given these values, the number of events is found to be 499 and 
the sample size is 1891. 

Since this procedure using integer values for the accrual and trial time, the accrual time and total 
time will be set to 4 and 9 years, respectively.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests for Non-Inferiority procedure window by 
expanding Survival, then Logrank, then clicking on Non-Inferiority, and then clicking on 
Logrank Tests for Non-Inferiority. You may then make the appropriate entries as listed below, 
or open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Reference Group ............... 0.5 
HR0 ......................................................... 1.3 
h1 ............................................................ 0.0446 
Accrual Time ........................................... 4 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 9 
Proportion Lost - Reference .................... 0 
Proportion Lost - Treatment .................... 0 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size 
        Acc-       
    Equiv Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N (HR0) (HR) (h1) Pat'n Time Loss Loss Trt Ref Alpha Beta 
.9000 933 933 1866 1.30 1.00 .0446 Equal 4 / 9 .0000 .0000 .0000 .0000 .0500 .1000 
 
Numeric Results in Terms of Events 
        Acc-       
    Equiv Actual Ref  rual       
 Ref Trt Total Haz Haz Haz Acc- Time/   Ref Trt   
 Evts Evts Evts Ratio Ratio Rate rual Total Ref Trt to to   
Power E1 E2 E (HR0) (HR) (h1) Pat'n Time Loss Loss Trt Ref Alpha Beta 
.9000 249.3 249.3 498.6 1.30 1.00 .0446 Equal 4 / 9 .0000 .0000 .0000 .0000 .0500 .1000 
 

Note that the number of events (499) matches Jung’s results exactly. The sample size of 1866 is 
slightly less than Jung’s 1891. This difference occurs because these results were obtained for 4 
years of accrual, not 3.8, and because we used Lakatos’ method for transforming the number of 
events into the sample size. 

Example 4 – Inputting Time-Dependent Hazard Rates 
from a Spreadsheet  
Time-dependent parameters (hazard rates, losses to follow-up, etc) may be entered. Example 4 of 
Chapter 715 presents an extensive example of how this is done for the logrank test, so we will not 
duplicate that documentation here. 
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Chapter 710 

Group-Sequential 
Logrank Tests 
Introduction 
Clinical trials are longitudinal. They accumulate data sequentially through time. The participants 
cannot be enrolled and randomized on the same day. Instead, they are enrolled as they enter the 
study. It may take several years to enroll enough patients to meet sample size requirements. 
Because clinical trials are long term studies, it is in the interest of both the participants and the 
researchers to monitor the accumulating information for early convincing evidence of either harm 
or benefit. This permits early termination of the trial.  

Group sequential methods allow statistical tests to be performed on accumulating data while a 
phase III clinical trial is ongoing. Statistical theory and practical experience with these designs 
have shown that making four or five interim analyses is almost as effective in detecting large 
differences between treatment groups as performing a new analysis after each new data value. 
Besides saving time and resources, such a strategy can reduce the experimental subject’s 
exposure to an inferior treatment and make superior treatments available sooner.  

When repeated significance testing occurs on the same data, adjustments have to be made to the 
hypothesis testing procedure to maintain overall significance and power levels. The landmark 
paper of Lan & DeMets (1983) provided the theory behind the alpha spending function approach 
to group sequential testing. This paper built upon the earlier work of Armitage, McPherson, & 
Rowe (1969), Pocock (1977), and O’Brien & Fleming (1979). PASS implements the methods 
given in Reboussin, DeMets, Kim, & Lan (1992) to calculate the power and sample sizes of 
various group sequential designs. 

This module calculates sample size and power for group sequential designs used to compare two 
survival curves. Other modules perform similar analyses for the comparison of means and 
proportions. The program allows you to vary number and times of interim tests, type of alpha 
spending function, and test boundaries. It also gives you complete flexibility in solving for power, 
significance level, sample size, or effect size. The results are displayed in both numeric reports 
and informative graphics.  
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Technical Details 
In many clinical trials, patients are recruited and randomized to receive a particular treatment, 
either experimental or control, and then monitored until either a critical event occurs or the study 
is ended. The length of time the patient is monitored until the critical event occurs is called the 
follow-up time. After the study is ended, the follow-up times of the patients in the two groups are 
compared using the logrank test in what is often called a survival analysis.  

When the critical event does not occur for a patient by the time the study is ended, the follow-up 
time is said to have been censored. Although the actual event time is not known for this patient, it 
is known that the event time will be greater than the follow-up time. Hence, some information is 
gleaned from these participants. Because of this censoring, the usual tests of means or proportions 
cannot be used. The logrank test was developed to provide a statistical test comparing the efficacy 
of the two treatments. 

The Hazard Ratio (HR) 
Suppose the critical event is death. The survival distribution of each treatment can be 
characterized by the instantaneous death rates, λ λ1 and 2 . An instantaneous death rate, often 
called the hazard, is the probability of death in a short interval of time. The comparison of the 
efficacies of the two treatments is often formalized by considering the ratio of the hazard, or 
hazard ratio (HR).  

λHR =
λ

2

1

 

Although the logrank test concerns the ratio of the hazard rates of the two groups, when planning 
a study, it may be easier to obtain information about the expected proportion surviving during the 
trial. It turns out that the hazard ratio can be computed from the survival proportions, S1 and S2, 
using the equation 

( )
( )

HR
S
S

=
log
log

2
1

 

when the hazard ratio is constant through time. 

Assuming that group one is the control group, it may be easiest during the planning stages of a 
study to find S1 and state the minimum value of HR that would make the experimental treatment 
useful. The last equation can then be manipulated to calculate a value for S2 as follows 

{ ( ( ))}S HR S2 1= exp log . 

Sometimes it is more convenient to state hazard ratio in terms of the median survival times. In 
this case, the hazard ratio is estimated using 

HR M
M

= 1

2

 

when the hazard ratio is constant for different times. 
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The Logrank Statistic 
The following results are excerpted from Reboussin (1992). The logrank statistic is given by the 
equation 

( )L d x r
r r
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where d is the number of events, is 1 if the event at time is in the control group and 0 if it is 
in the treatment group, r is the number of patients in the control group at risk just be before , 
and is the corresponding number of patients at risk in the treatment group.  
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≈If r and HR is close to 1, then the sequential logrank statistic is (approximately) 
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The subscript k indicates that the computations use all data that are available at the time of the kth 
interim analysis or kth look (k goes from 1 to K).  

Spending Functions 
( )αLan and DeMets (1983) introduced alpha spending functions, τ , that determine a set of 

boundaries for the sequence of test statistics . These boundaries are the 
critical values of the sequential hypothesis tests. That is, after each interim test, the trial is 
continued as long as 

b b bK1 2, , ,L z z zK1 2, , ,L

z bk k< z bk k≥. When , the hypothesis of equal means is rejected and the 
trial is stopped early.  

τThe time argument either represents the proportion of elapsed time to the maximum duration of 
the trial or the proportion of the sample that has been collected. When elapsed time is used, it is 
referred to as calendar time. When time is measured in terms of the sample, it is referred to as 
information time. Since it is a proportion,τ can only vary between zero and one. 

Alpha spending functions have the characteristics: 

( )
( )

α

α α

0 0

1

=

=
 

α  level when the trial is complete. That is,  The last characteristic guarantees a fixed 

( ) ( )Pr z b or z b or or z bk k1 1 2 2≥ ≥ ≥ =L α τ  

This methodology is very flexible since neither the times nor the number of analyses must be 
specified in advance. Only the functional form of ( )α τ  must be specified.  

PASS provides five popular spending functions plus the ability to enter and analyze your own 
boundaries. These are calculated as follows: 



710-4  Group-Sequential Logrank Tests 
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4.  Alpha * time^1.5     ατ 3 2/  
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5.  Alpha * time^2      ατ 2
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6.  User Supplied 

A custom set of boundaries may be entered. 

The O’Brien-Fleming boundaries are commonly used because they do not significantly increase 
the overall sample size and because they are conservative early in the trial. Conservative in the 
sense that the means must be extremely different before statistical significance is indicated. The 
Pocock boundaries are nearly equal for all times. The Alpha*t boundaries use equal amounts of 
alpha when the looks are equally spaced. You can enter your own set of boundaries using the 
User Supplied option. 

Sequential Theory 
A detailed account of the methodology is contained in Lan & DeMets (1983), DeMets & Lan 
(1984), Lan & Zucker (1993), and DeMets & Lan (1994). A brief summary of the theoretical 
basis of the method will be presented here.  

Group sequential procedures for interim analysis are based on their equivalence to discrete 
boundary crossing of a Brownian motion process with drift parameter θ . The test statistics  

follow the multivariate normal distribution with means 

zk

θ τ k j k≤ and, for , covariances 

τ τk j/

( )

. The drift is related to the parameters of the z-test through one of the equations 

θ =
log HR dk

2
  (exponential survival) or 

( )
θ =

− d
HR

k

+
1

1
HR

  (proportional hazards). 
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These equations may be solved for , the required number of events, giving dk

( )[ ]
d

HR
k =

4 2

2
θ

log
 (exponential survival) or 

( )d
HR
HRk =

+
−

⎛

⎝
⎜

⎞

⎠
⎟

1
1

2
θ

 (proportional hazards). 

In survival analysis, the size of a sample is measured in terms of number of events rather than 
number of patients because it is probable that many of the patients will be censored—their event 
times are not known. In order to ensure that the sample size produces the required number of 
events, it must be inflated by the event rates.  

The expected number of events can be computed from the proportion surviving using the 
equation 

( ) ( )d
N S N S

=
− + −1 11 2

k 2
 

where N is the total sample size (assumed to be split evenly between groups). This can be solved 
for N to give the sample size as 

N d
S S

k=
− −

2
2 1 2

. 

Hence, the algorithm is as follows: 

1.  Compute boundary values based on a specified spending function and alpha value. 

2.  Calculate the drift parameter based on those boundary values and a specified power 
value. 

3.  Use the drift parameter and the above equation to calculate the appropriate event size per 
group dk . 

4.  Use the event size to compute the appropriate sample size, N. 

Procedure Tabs 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains the parameters associated with the z-test such as the survival rates, sample 
sizes, alpha, and power. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are S1, S2, Alpha, Power and Beta, or N. Under most situations, you will 
select either Power and Beta or N. 
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Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal survival 
curves when in fact the curves are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis of equal survival curves when in fact the curves are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N (Total Sample Size) 
Enter a value (or range of values) for the total sample size. Each group is assumed to have a 
sample size of N/2. You may enter a range of values such as 100 to 1000 by 100.  

Note that the sample size is based implicitly on the length of the study since we used the equation 

N d
S S

k=
− −

2
2 1 2

 

to estimate the necessary sample size. 

Effect Size 

S1 (Proportion Surviving 1) 
S1 is the proportion of patients belonging to group 1 (controls) that are expected to survive during 
the study. Since S1 is a proportion, it must be between zero and one. In many studies, this is the 
proportion surviving in the regular population with the standard treatment. 

You may enter a range of values such as 0.1, 0.2, 0.3 or 0.1 to 0.9 by 0.2. 
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S2 (Proportion Surviving 2) 
S2 is the proportion of patients in the experimental group that survive during the study. This is not 
necessarily the expected proportion. Rather, you may set it to that proportion that, if achieved, 
would be of special interest. Values below (or above) this amount would not be of interest. For 
example, if the standard one-year survival proportion is 0.2 and the new treatment raises this 
proportion to 0.3 (a 50% increase in the proportion surviving), others may be interested in 
adopting this new treatment. 

Sometimes, researchers wish to state the alternative hypothesis in terms of the hazard ratio, HR, 
rather than the value of S2. Using the fact that 

( )
( )

HR
S

=
log 2

Slog 1
, 

An appropriate value for S2 may be calculated from S1 and HR using the equation 

{ ( ( ))}S HR S2 1= exp log . 

Sometimes it is more convenient to state hazard ratio in terms of the median survival times. In 
this case, the hazard ratio is estimated using 

HR M
M

= 1

2

 

and the above equation is used to find S2. 

Since S2 is a proportion, it must remain between zero and one. You may enter a range of values 
such as 0.1, 0.2, 0.3 or 0.1 to 0.9 by 0.2. 

Look Details 
The Sequential tab contains the parameters associated with Group Sequential Design such as the 
type of spending function, the times, and so on. 

Number of Looks 
This is the number of interim analyses (including the final analysis). For example, a five here 
means that four interim analyses will be run in addition to the final analysis. 

Boundary Truncation 
You can truncate the boundary values at a specified value. For example, you might decide that no 
boundaries should be larger than 4.0. If you want to implement a boundary limit, enter the value 
here.  

If you do not want a boundary limit, enter None here. 

Spending Function 
Specify which alpha spending function to use. The most popular is the O'Brien-Fleming boundary 
that makes early tests very conservative. Select User Specified if you want to enter your own set 
of boundaries. 
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Max Time 
This is the total running time of the trial. It is used to convert the values in the Times box to 
fractions. The units (months or years) do not matter, as long as they are consistent with those 
entered in the Times box. 

For example, suppose Max Time = 3 and Times = 1, 2, 3. Interim analyses would be assumed to 
have occurred at 0.33, 0.67, and 1.00. 

Times 
Enter a list of time values here at which the interim analyses will occur. These values are scaled 
according to the value of the Max Time option. 

For example, suppose a 48-month trial calls for interim analyses at 12, 24, 36, and 48 months. 
You could set Max Time to 48 and enter 12,24,36,48 here or you could set Max Time to 1.0 and 
enter 0.25,0.50,0.75,1.00 here.  

The number of times entered here must match the value of the Number of Looks. 

• Equally Spaced 
If you are planning to conduct the interim analyses at equally spaced points in time, you can 
enter Equally Spaced and the program will generate the appropriate time values for you. 

Informations 
You can weight the interim analyses on the amount of information obtained at each time point 
rather than on actual calendar time. If you would like to do this, enter the information amounts 
here. Usually, these values are the sample sizes obtained up to the time of the analysis. 

For example, you might enter 50, 76, 103, 150 to indicate that 50 individuals where included in 
the first interim analysis, 76 in the second, and so on. 

Upper and Lower Boundaries (Spending = User) 
If the Spending Function is set to User Supplied you can enter a set of lower test boundaries, one 
for each interim analysis. The lower boundaries should be negative and the upper boundaries 
should be positive. Typical entries are 4,3,3,3,2 and 4,3,2,2,2. 

• Symmetric 
If you only want to enter the upper boundaries and have them copied with a change in sign to 
the lower boundaries, enter Symmetric for the lower boundaries. 

Test 

Alternative Hypothesis 
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the 
value of alpha is halved. Everything else remains the same. 

Note that the accepted procedure is to use Two-Sided unless you can justify using a one-sided 
test.  

Survival Time Assumption 
Calculations can be based on the assumption of exponential survival times or proportional 
hazards. The proportional hazards assumption is the less restrictive and the one that is 
recommended. 
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• Exponential Survival 
The survival curves follow exponential distributions. This is the most restrictive assumption. 

• Proportional Hazards 
The hazards of the two groups are proportional. 

Options Tab 
The Options tab controls the convergence of the various iterative algorithms used in the 
calculations. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations to be run before the search for the criterion of interest 
(Alpha, Beta, etc.) is aborted. When the maximum number of iterations is reached without 
convergence, the criterion is left blank.  

Recommended: 500 (or more). 

Maximum Iterations (Lan-Demets algorithm) 
This is the maximum number of iterations used in the Lan-DeMets algorithm during its search 
routine. We recommend a value of at least 200. 

Tolerance 

Probability Tolerance 
During the calculation of the probabilities associated with a set of boundary values, probabilities 
less than this are assumed to be zero. 

We suggest a value of 0.00000000001. 

Power Tolerance 
This is the convergence level for the search for the spending function values that achieve a certain 
power. Once the iteration changes are less than this amount, convergence is assumed. We suggest 
a value of 0.0000001. 

If the search is too time consuming, you might try increasing this value. 

Alpha Tolerance 
This is the convergence level for the search for a given alpha value. Once the changes in the 
computed alpha value are less than this amount, convergence is assumed and iterations stop. We 
suggest a value of 0.0001. 

This option is only used when you are searching for alpha. 

If the search is too time consuming, you may try increasing this value. 
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Example 1 – Finding the Sample Size 
A clinical trial is to be conducted over a two-year period to compare the hazard rate of a new 
treatment to that of the current treatment. The proportion surviving for two years using the current 
treatment is 0.3. The health community will be interested in the new treatment if the proportion 
surviving is increased to 0.45, a 50% increase. So that the sample size requirements for several 
survival proportions can be compared, it is also of interest to compute the sample size at response 
rates of 0.30, 0.35, 0.40, and 0.50. Assume the survival times are exponential.  

Testing will be done at the 0.05 significance level and the power should be set to 0.10. A total of 
four tests are going to be performed on the data as they are obtained. The O’Brien-Fleming 
boundaries will be used.  

Find the necessary sample sizes and test boundaries assuming equal sample sizes for each arm 
and two-sided hypothesis tests. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests procedure window by 
expanding Survival, then Logrank, then clicking on Group-Sequential, and then clicking on 
Group-Sequential Logrank Tests. You may then make the appropriate entries as listed below, 
or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
S1 (Proportion Surviving 1) ..................... 0.3 
S2 (Proportion Surviving 2) ..................... 0.35 0.40 0.45 0.50 
Number of Looks ..................................... 4 
Spending Function .................................. O’Brien-Fleming 
Max Time ................................................ 2 
Times....................................................... Equally Spaced 
Alternative Hypothesis ............................ Two-Sided 
Survival Time Assumption....................... Exponential Survival 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Two-Sided LogRank Test (Assuming Exponential Survival) 
 
 Total Total 
 Sample Required   Proportion Proportion Hazard 
Power Size (N) Events Alpha Beta Surv. (S1) Surv. (S2) Ratio 
0.900003 3378 2280 0.050000 0.099997 0.3000 0.3500 0.8720 
0.900267 884 575 0.050000 0.099733 0.3000 0.4000 0.7611 
0.900626 407 254 0.050000 0.099374 0.3000 0.4500 0.6632 
0.900018 234 140 0.050000 0.099982 0.3000 0.5000 0.5757 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Power should be close to one. 
N is the number of items sampled from each group. 
Events is the number of events that must occur in each group. 
Alpha is the probability of rejecting a true null hypothesis in at least one of the sequential tests. 
Beta is the probability of accepting a false null hypothesis at the conclusion of all tests. 
S1 is the proportion surviving in group 1. 
S2 is the proportion surviving in group 2. 
HR is the hazard ratio. It is calculated using Log(S2)/Log(S1). 
 
Summary Statements 
A total sample size of 3378 (split equally between the two groups), or 2280 events, achieves 
90% power to detect a hazard rate of 0.8720 when the proportions surviving in each group are 
0.3000 and 0.3500 at a significance level (alpha) of 0.050000 using a two-sided log rank test. 
These results assume that 4 sequential tests are made using the O'Brien-Fleming spending 
function to determine the test boundaries and that the survival times are exponential. 
 

This report shows the values of each of the parameters, one scenario per row. Note that 254 
events are required when S2 = 0.45. Based on the expected survival proportions, this many events 
will occur if the overall sample size is 407.  

Total Sample Size (N) 
This is the estimated sample size that is needed to obtain the necessary number of events. 

Total Required Events 
This is the number of events (deaths, etc.) that are required to achieve the desired power levels. 
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Plots Section 
  

 

N

               
   

This plot shows that an increase in sample size from under 1000 to well over 3000 is necessary 
when the detectable proportion surviving is reduced from 0.4 to 0.35. 

Details Section 
 
Details when Spending = O'Brien-Fleming, N = 407, d = 254, S1 = 0.3000, S2 = 0.4500 
  Lower Upper Nominal Inc Total Inc Total 
Look Time Bndry Bndry Alpha Alpha Alpha Power Power 
1 0.5000 -4.33263 4.33263 0.000015 0.000015 0.000015 0.003516 0.003516  
2 1.0000 -2.96311 2.96311 0.003045 0.003036 0.003051 0.255183 0.258699  
3 1.5000 -2.35902 2.35902 0.018323 0.016248 0.019299 0.427665 0.686364  
4 2.0000 -2.01406 2.01406 0.044003 0.030701 0.050000 0.214262 0.900626  
Drift 3.27466 
 

This report shows information about the individual interim tests. One report is generated for each 
scenario. 

Look 
These are the sequence numbers of the interim tests. 

Time 
These are the time points at which the interim tests are conducted. Since the Max Time was set to 
2 (for two years), these time values are in years. Hence, the first interim test is at half a year, the 
second at one year, and so on. 

We could have set Max Time to 24 so that the time scale was in months. 

Lower and Upper Boundary 
These are the test boundaries. If the computed value of the test statistic z is between these values, 
the trial should continue. Otherwise, the trial can be stopped.  

Nominal Alpha 
This is the value of alpha for these boundaries if they were used for a single, standalone, test. 
Hence, this is the significance level that must be found for this look in a standard statistical 
package that does not adjust for multiple looks. 
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Inc Alpha 
This is the amount of alpha that is spent by this interim test. It is close to, but not equal to, the 
value of alpha that would be achieved if only a single test was conducted. For example, if we 
lookup the third value, 2.35902, in normal probability tables, we find that this corresponds to a 
(two-sided) alpha of 0.018323. However, the entry is 0.016248. The difference is due to the 
correction that must be made for multiple tests. 

Total Alpha 
This is the total amount of alpha that is used up to and including the current test.  

Inc Power 
These are the amounts that are added to the total power at each interim test. They are often called 
the exit probabilities because they give the probability that significance is found and the trial is 
stopped, given the alternative hypothesis.  

Total Power 
These are the cumulative power values. They are also the cumulative exit probabilities. That is, 
they are the probability that the trial is stopped at or before the corresponding time. 

Drift 
This is the value of the Brownian motion drift parameter. 

Boundary Plots 
 

Z 
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This plot shows the interim boundaries for each look. This plot shows very dramatically that the 
results must be extremely significant at early looks, but that they are near the single test boundary 
(1.96 and -1.96) at the last look. 

Example 2 – Finding the Power 
Continuing the scenario began in Example1, the researcher wishes to calculate the power of the 
design at sample sizes 50, 250, 450, 650, and 850. Testing will be done at the 0.01, 0.05, 0.10 
significance levels and the overall power will be set to 0.10. Find the power of these sample sizes 
and test boundaries assuming equal sample sizes per arm and two-sided hypothesis tests. 

Proceeding as in Example1, we decide to translate the mean and standard deviation into a percent 
of mean scale. 
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests procedure window by 
expanding Survival, then Logrank, then clicking on Group-Sequential, and then clicking on 
Group-Sequential Logrank Tests. You may then make the appropriate entries as listed below, 
or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.01 0.05 0.10 
N (Total Sample Size) ............................. 50 to 850 by 200 
S1 (Proportion Surviving 1) ..................... 0.3 
S2 (Proportion Surviving 2) ..................... 0.45 
Number of Looks ..................................... 4 
Spending Function .................................. O’Brien-Fleming 
Max Time ................................................ 2 
Times....................................................... Equally Spaced 
Alternative Hypothesis ............................ Two-Sided 
Survival Time Assumption....................... Exponential Survival 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Two-Sided LogRank Test (Assuming Exponential Survival) 
 
 Total Total 
 Sample Required   Proportion Proportion Hazard 
Power Size (N) Events Alpha Beta Surv. (S1) Surv. (S2) Ratio 
0.075632 50 31 0.010000 0.924368 0.3000 0.4500 0.6632 
0.491011 250 156 0.010000 0.508989 0.3000 0.4500 0.6632 
0.802921 450 281 0.010000 0.197079 0.3000 0.4500 0.6632 
0.938923 650 406 0.010000 0.061077 0.3000 0.4500 0.6632 
0.983780 850 531 0.010000 0.016220 0.3000 0.4500 0.6632 
0.205032 50 31 0.050000 0.794968 0.3000 0.4500 0.6632 
0.719225 250 156 0.050000 0.280775 0.3000 0.4500 0.6632 
0.926894 450 281 0.050000 0.073106 0.3000 0.4500 0.6632 
0.984044 650 406 0.050000 0.015956 0.3000 0.4500 0.6632 
0.996907 850 531 0.050000 0.003093 0.3000 0.4500 0.6632 
0.305105 50 31 0.100000 0.694895 0.3000 0.4500 0.6632 
0.812103 250 156 0.100000 0.187897 0.3000 0.4500 0.6632 
0.960490 450 281 0.100000 0.039510 0.3000 0.4500 0.6632 
0.992807 650 406 0.100000 0.007193 0.3000 0.4500 0.6632 
0.998800 850 531 0.100000 0.001200 0.3000 0.4500 0.6632 
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These data show the power for various sample sizes and alphas. It is interesting to note that once 
the sample size is greater than about 450, the value of alpha has comparatively little difference on 
the value of power. 

Example 3 – Effect of Number of Looks 
Continuing with examples one and two, it is interesting to determine the impact of the number of 
looks on power. PASS allows only one value for the Number of Looks parameter per run, so it 
will be necessary to run several analyses. To conduct this study, set alpha to 0.05, N to 407, and 
leave the other parameters as before. Run the analysis with Number of Looks equal to 1, 2, 3, 4, 
6, 8, 10, and 20. Record the power for each run. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests procedure window by 
expanding Survival, then Logrank, then clicking on Group-Sequential, and then clicking on 
Group-Sequential Logrank Tests. You may then make the appropriate entries as listed below, 
or open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 407 
S1 (Proportion Surviving 1) ..................... 0.3 
S2 (Proportion Surviving 2) ..................... 0.45 
Number of Looks ..................................... 1 (Also run with 2, 3, 4, 6, 8, 10, and 20) 
Spending Function .................................. O’Brien-Fleming 
Max Time ................................................. 2 
Times ....................................................... Equally Spaced 
Alternative Hypothesis ............................ Two-Sided 
Survival Time Assumption ....................... Exponential Survival 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival) 
 
Power N Events Alpha Beta S1 S2 Looks 
0.905693 407 254 0.050000 0.094307 0.3000 0.4500 1 
0.904719 407 254 0.050000 0.095281 0.3000 0.4500 2 
0.902412 407 254 0.050000 0.097588 0.3000 0.4500 3 
0.900626 407 254 0.050000 0.099374 0.3000 0.4500 4 
0.898243 407 254 0.050000 0.101757 0.3000 0.4500 6 
0.896763 407 254 0.050000 0.103237 0.3000 0.4500 8 
0.895758 407 254 0.050001 0.104242 0.3000 0.4500 10 
0.893398 407 254 0.050001 0.106602 0.3000 0.4500 20 
 

This analysis shows how little the number of looks impacts the power of the design. The power of 
a study with no interim looks is 0.905693. When twenty interim looks are made, the power falls 
to 0.893398—a very small change. 

Example 4 – Studying a Boundary Set 
Continuing with the previous examples, suppose that you are presented with a set of boundaries 
and want to find the quality of the design (as measured by alpha and power). This is easy to do 
with PASS. Suppose that the analysis is to be run with five interim looks at equally spaced time 
points. The upper boundaries to be studied are 3.5, 3.5, 3.0, 2.5, 2.0. The lower boundaries are 
symmetric. The analysis would be run as follows. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests procedure window by 
expanding Survival, then Logrank, then clicking on Group-Sequential, and then clicking on 
Group-Sequential Logrank Tests. You may then make the appropriate entries as listed below, 
or open Example 4 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 (will be calculated from boundaries) 
N (Total Sample Size) ............................. 407 
S1 (Proportion Surviving 1) ..................... 0.30 
S2 (Proportion Surviving 2) ..................... 0.45 
Number of Looks ..................................... 5 
Spending Function .................................. User Supplied 
Max Time ................................................ 2 
Times....................................................... Equally Spaced 
Upper Boundaries ................................... 3.5 3.5 3.0 2.5 2.0 
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Data Tab (continued) 
Lower Boundaries ................................... Symmetric 
Alternative Hypothesis ............................ Two-Sided 
Survival Time Assumption ....................... Exponential Survival 
 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival) 
 
 Total Total 
 Sample Required   Proportion Proportion Hazard 
Power Size (N) Events Alpha Beta Surv. (S1) Surv. (S2) Ratio 
0.900746 407 254 0.048157 0.099254 0.3000 0.4500 0.6632 

 
Details when Spending = User Supplied, N = 407, d=254, S1 = 0.3000, S2 = 0.4500 
  Lower Upper Nominal Inc Total Inc Total 
Look Time Bndry Bndry Alpha Alpha Alpha Power Power 
1 0.4000 -3.50000 3.50000 0.000465 0.000465 0.000465 0.020899 0.020899  
2 0.8000 -3.50000 3.50000 0.000465 0.000408 0.000874 0.063132 0.084031  
3 1.2000 -3.00000 3.00000 0.002700 0.002410 0.003284 0.243522 0.327553  
4 1.6000 -2.50000 2.50000 0.012419 0.010331 0.013615 0.343072 0.670625  
5 2.0000 -2.00000 2.00000 0.045500 0.034542 0.048157 0.230122 0.900746  
Drift 3.27466 
 

The power for this design is about 0.90. This value depends on both the boundaries and the 
sample size. The alpha level is about 0.048. This value only depends on the boundaries. 

Example 5 – Validation using O’Brien-Fleming 
Boundaries 
Reboussin (1992) presents an example for binomial distributed data for a design with two-sided 
O’Brien-Fleming boundaries, looks = 3, alpha = 0.05, beta = 0.10, S1 = 0.30, S2 = 0.786 (which 
gives a hazard ratio of 0.20). They compute a drift of 3.261 and the number of events at 16.42. 
The upper boundaries are: 4.8769, 3.3569, 2.6803, 2.2898, 2.0310.  

To test that PASS provides the same result, enter the following. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests procedure window by 
expanding Survival, then Logrank, then clicking on Group-Sequential, and then clicking on 
Group-Sequential Logrank Tests. You may then make the appropriate entries as listed below, 
or open Example 5 by going to the File menu and choosing Open Example Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. Ignored since this is the Find setting 
S1 (Proportion Surviving 1) ..................... 0.30 
S2 (Proportion Surviving 2) ..................... 0.786 
Number of Looks ..................................... 5 
Spending Function .................................. O’Brien-Fleming 
Max Time ................................................ 1 
Times....................................................... Equally Spaced 
Alternative Hypothesis ............................ Two-Sided 
Survival Time Assumption....................... Exponential Survival 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival) 
 
 Total Total 
 Sample Required   Proportion Proportion Hazard 
Power Size (N) Events Alpha Beta Surv. (S1) Surv. (S2) Ratio 
0.905173 37 17 0.050000 0.094827 0.3000 0.7860 0.2000 
 
Details when Spending = O'Brien-Fleming, N = 37, d = 17, S1 = 0.3000, S2 = 0.7860 
  Lower Upper Nominal Inc Total Inc Total 
Look Time Bndry Bndry Alpha Alpha Alpha Power Power 
1 0.2000 -4.87688 4.87688 0.000001 0.000001 0.000001 0.000341 0.000341  
2 0.4000 -3.35695 3.35695 0.000788 0.000787 0.000788 0.102760 0.103101  
3 0.6000 -2.68026 2.68026 0.007357 0.006828 0.007616 0.352450 0.455551  
4 0.8000 -2.28979 2.28979 0.022034 0.016807 0.024424 0.298953 0.754504  
5 1.0000 -2.03100 2.03100 0.042255 0.025576 0.050000 0.150669 0.905173  
Drift 3.30902 
 

The number of events, rounded to 17, matches the 16.42 reported in Reboussin (1992). 
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Chapter 711 

Group-Sequential 
Logrank Tests 
(Simulation) 
Introduction 
This procedure can be used to determine power, sample size and/or boundaries for group sequential 
tests comparing two survival curves. The tests that can be simulated in this procedure are the 
common logrank test, the Gehan-Wilcoxon test, the Tarone-Ware test, the Peto-Peto and Modified 
Peto-Peto tests, and the Fleming-Harrington tests with user specified p and q.  

Survival rates (hazard rates, median survival times, proportion surviving, or mortality) can be piece-
wise customized to specify proportional hazard scenarios or non-proportional hazard scenarios. The 
treatment group survival rates can be specified directly or based on hazard ratios (or mortality 
ratios).  

Loss-to-follow-up and noncompliance proportions can be entered with piece-wise flexibility. 
Noncompliance survival rates can be specified directly or can be set to the opposite treatment group 
survival rate. 

Accrual times and accrual patterns are completely flexible. 

For two-sided tests, significance (efficacy) boundaries can be generated. For one-sided tests, 
significance and futility boundaries can be produced. The spacing of the looks can be equal or 
custom specified. Boundaries can be computed based on popular alpha- and beta-spending 
functions (O’Brien-Fleming, Pocock, Hwang-Shih-DeCani Gamma family, linear) or custom 
spending functions. Boundaries can also be input directly to verify alpha- and/or beta-spending 
properties. Futility boundaries can be binding or non-binding. Maximum and average (expected) 
sample sizes are reported as well as the alpha and/or beta spent and incremental power at each look. 
Corresponding P-Value boundaries are also given for each boundary statistic. Plots of boundaries 
are also produced. 

Four Procedures Documented Here 
There are four procedures in the menus that use the program module described in this chapter. 
These procedures are identical except for the type of parameterization. The parameterization can 
be in terms of hazard rates, median survival times, proportions surviving a given time period, or 
mortality during a given time period. Each of these options is listed separately on the menus. 
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When median survival times, proportions surviving, or mortality are used, the values are 
converted to the corresponding hazard rates before the simulation process begins. 

Hazard Rate Parameterization 
In this case, the hazard rates for the control and treatment groups are specified directly.  

Median Survival Time Parameterization 
Here, the median survival time is specified. These are transformed to hazard rates using the 
relationship h = ln(2) / MST.  

Proportion Surviving Parameterization 
In this case, the proportion surviving until a given time T0 is specified. These are transformed to 
hazard rates using the relationship h = –ln(S(T0)) / T0. When separate proportions surviving are 
given for each time period, T0 is taken to be the time period unit.  

Mortality Parameterization 
Here, the mortality until a given time T0 is specified. These are transformed to hazard rates using 
the relationship h = –ln(1 – M(T0)) / T0. When separate mortalities are given for each time 
period, T0 is taken to be the time period unit.  

Technical Details 
This section outlines many of the technical details of the techniques used in this procedure including 
the simulation summary, the test statistic details, and the use of spending functions.  

An excellent text for the background and details of many group-sequential methods is Jennison and 
Turnbull (2000). 

Simulation Procedure 
In this procedure, a large number of simulations are used to calculate boundaries and power using 
the following steps:  

1. The total sample size is divided into the control and treatment group sample sizes (N1 and 
N2) according to the proportion in control group given. 

2. Based on the specified survival rates, and noncompliance proportions and survival rates, a 
hazard rate function is generated for each subject of each group. The hazard rate function is 
used to generate a random survival time and the loss proportion is used to determine 
whether the simulated subject is right censored due to loss before the event. Each subject is 
simulated as though the final look is reached. 

3. A starting time for each subject is generated based on the accrual time and the accrual 
pattern. 

4. For each sample (of N1 + N2 subjects), a test statistic for each look is produced. Subjects 
for which the start time exceeds the look time are excluded at that look. Subjects with 
survival times or loss times after the look time are right-censored at that look. For example, 
suppose the study length is 5 years with 5 looks, one at each year, and the accrual time is 2 
years. Suppose a subject is given a start time of 0.3689 and a survival time of 2.541 years 
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with no loss-to-follow-up. That subject would be used in all 5 looks. At the first look, the 
subject would be right-censored with a survival time of 1 – 0.3689. At the second look, the 
subject would be right-censored with a survival time of 2 – 0.3689. At the third look, the 
subject would be right-censored with a survival time of 3 – 0.3689. At the fourth look, the 
subject would not be right-censored with a survival time of 2.541 (since 2.541 < 4 – 
0.3689). At the final look, the subject would again not be right-censored with a survival 
time of 2.541.  

5. To generate the first significance boundary, the null distribution statistics of the first look 
(e.g., at Time = 1 year) are ordered and the percent of alpha to be spent at the first look is 
determined (using either the alpha-spending function or the input value). The statistic for 
which the percent of statistics above (or below, as the case may be) that value is equal to 
the percent of alpha to be spent at the first look is the boundary statistic. It is seen here how 
important a large number of simulations is to the precision of the boundary estimates. 

6. All null distribution samples that are outside the first significance boundary at the first look 
are removed from consideration for the second look. If binding futility boundaries are also 
being computed, all null distribution samples with statistics that are outside the first futility 
boundary are also removed from consideration for the second look. If non-binding futility 
boundaries are being computed, null distribution samples with statistics outside the first 
futility boundary are not removed. 

7. To generate the second significance boundary, the remaining null distribution statistics of 
the second look (e.g., at Time = 2 years) are ordered and the percent of alpha to be spent at 
the second look is determined (again, using either the alpha-spending function or the input 
value). The percent of alpha to be spent at the second look is multiplied by the total number 
of simulations to determine the number of the statistic that is to be the second boundary 
statistic. The statistic for which that number of statistics is above it (or below, as the case 
may be) is the second boundary statistic. For example, suppose there are initially 1000 
simulated samples, with 10 removed at the first look (from, say, alpha spent at Look 1 
equal to 0.01), leaving 990 samples considered for the second look. Suppose further that the 
alpha to be spent at the second look is 0.02. This is multiplied by 1000 to give 20. The 990 
still-considered statistics are ordered and the 970th (20 in from 990) statistic is the second 
boundary. 

8. All null distribution samples that are outside the second significance boundary and the 
second futility boundary, if binding, at the second look are removed from consideration for 
the third look (e.g., leaving 970 statistics computed at N1 = N2 = 60 to be considered at the 
third look). Steps 4 and 5 are repeated until the final look is reached. 

Futility boundaries are computed in a similar manner using the desired beta-spending function 
or custom beta-spending values and the alternative hypothesis simulated statistics at each look. 
For both binding and non-binding futility boundaries, samples for which alternative hypothesis 
statistics are outside either the significance or futility boundaries of the previous look are 
excluded from current and future looks. 

Because the final futility and significance boundaries are required to be the same, futility 
boundaries are computed beginning at a small value of beta (e.g., 0.0001) and incrementing 
beta by that amount until the futility and significance boundaries meet. 

When boundaries are entered directly, this procedure uses the null hypothesis and alternative 
hypothesis simulations to determine the number of test statistics that are outside the boundaries 
at each look. The cumulative proportion of alternative hypothesis statistics that are outside the 
significance boundaries is the overall power of the study.  
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Small Sample Considerations 
When the sample size is small, say 100 or fewer per group, the discrete nature of the number of 
possible combinations of ranks in each group comes into play. This simulation procedure is based 
on the ordering of the sample statistics in the simulation. The boundaries are determined by the 
spending function alphas. Thus, if a test used happens to be conservative in the single-look 
traditional sense, the boundaries chosen in the simulation results of this procedure will generally 
remove the conservative nature of the test. This makes comparisons to the one-look case surprising 
in some small-sample cases.  

Test Statistics 
This section presents methods for testing that the survival curves, and thus the hazard rates, of 
two or more populations are equal. The specific hypothesis set that is being tested is 

( ) ( )ThThH 210 : τ≤  =  for all t 

( ) ( )ThThH 211 : τ≤  ≠  for some t 

In words, the null hypothesis is that the hazard rates of the two populations are equal at all times 
less than the maximum observed time and the alternative hypothesis is that the two hazard rates 
differ at some time less than the observed maximum time. 

The general form of the test statistic is 
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where 

D is the number of distinct event times 

 is the weight function at time  it

it is the number at risk in the Group 1 sample at time  

 is the combined number at risk at time t  

 is the number of events in the Group 1 sample at time  

id  is the combined number of events at time t  

 

Details of the above formulas can be found in Klein and Moeschberger (1997), pages 191-202 
and Andersen, Borgan, Gill, and Keiding (1992), pages 345-356. 

Six different choices for the weight function, W(T), with the flexible p and q for the Fleming-
Harrington weight function, result in a variety tests that are available in this procedure. The most 
commonly used test is the logrank test which has equal weighting. The other tests shift the 
heaviest weighting to the beginning or end of the trial. This may be appropriate in some studies, 
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but the use of one of these other weighting schemes should be designated before the data have 
been seen. Because of the different weighting patterns, they will often give quite different results.  

The following table describes each of these tests.  

 
Test Weight Comments 
Logrank 1 This is the most commonly used test 

and the one we recommend. Equal 
weights across all times. This test has 
optimum power when the hazard rates 
of the K populations are proportional to 
each other. 

Gehan  Places very heavy weight on hazards at 
the beginning of the study. 

iY

Tarone-Ware iY  Places heavy weight on hazards at the 
beginning of the study. 

( )itS~  Places a little more weight on hazards at 
the beginning of the study. 

Peto-Peto 

( ) ( )1+iii YYtS /~
 Places a little more weight on hazards at 

the beginning of the study. 
Modified Peto-Peto 

( )ˆ
11 −− itS  Places heavy weight on hazards at the 

end of the study. 
Fleming-Harrington (0,0) 

( )ˆ
1−itS  Places almost equal weight at all times. Fleming-Harrington (1,0) 

Fleming-Harrington (1,1) ( ) ( )( )11 −− ii 1tŜ − tŜ

( ) ( )

 Places heavy weight on hazards at the 
end of the study. 

( )11 1 −− − ii tStS ˆˆ

( )

 Places a little more weight on hazards at 
the end of the study. 

Fleming-Harrington (0.5,0.5) 

( ) ( )11 −− ii

2
1− tStS ˆˆ

( )

 Places very heavy weight on hazards at 
the end of the study. 

Fleming-Harrington (0.5,2) 

This table uses the following definitions. 

∏ ⎟
⎞

⎜
⎛
−= idtS 1ˆ

( )

≤
⎟
⎠

⎜
⎝tt ii

Y
 

∏ ⎟⎟
⎞

⎜⎜
⎛
−= idtS 1~

≤ ⎠⎝ +tt ii
Y 1

 

 



711-6  Group-Sequential Logrank Tests (Simulation) 

Spending Functions 
Spending functions can be used in this procedure to specify the proportion of alpha or beta that is 
spent at each look without having to specify the proportion directly.  

Spending functions have the characteristics that they are increasing and that 
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α α

0 0

1

=
 

=

The last characteristic guarantees a fixed α  level when the trial is complete. This methodology is 
very flexible since neither the times nor the number of analyses must be specified in advance. 
Only the functional form of ( )α τ  must be specified.  

PASS provides several popular spending functions plus the ability to enter and analyze your own 
percents of alpha or beta spent. These are calculated as follows (beta may be substituted for alpha 
for beta-spending functions): 
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3.  Pocock Analog     ( )( )te 11ln −+⋅α  
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6.  Alpha * time^2      2t⋅α
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7.  Alpha * time^C     Ct⋅α  
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8.  User Supplied Percents 

A custom set of percents of alpha to be spent at each look may be input directly. 

The O'Brien-Fleming Analog spends very little alpha or beta at the beginning and much more at 
the final looks. The Pocock Analog and (Alpha or Beta)(Time) spending functions spend alpha or 
beta more evenly across the looks. The Hwang-Shih-DeCani (C) (gamma family) spending 
functions and (Alpha or Beta)(Time^C) spending functions are flexible spending functions that 
can be used to spend more alpha or beta early or late or evenly, depending on the choice of C. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data, Looks & Boundaries, Enter Boundaries, and Options tabs. For more information about the 
options of other tabs, go to the Procedure Window chapter. 

Data Tab 
The Data tab contains most of the parameters and options for the general setup of the procedure. 
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Solve For 

Find (Solve For) 
Solve for either power, sample size, or enter the boundaries directly and solve for power and 
alpha. When solving for power or sample size, the look and boundary details are specified on the 
"Looks & Boundaries" tab and the "Enter Boundaries" tab is ignored. When entering the 
boundaries directly and solving for power and alpha, the boundaries are input on the "Enter 
Boundaries" tab and the "Looks & Boundaries" tab is ignored. 

When solving for power or N1, the early-stopping boundaries are also calculated. High accuracy 
for early-stopping boundaries requires a very large number of simulations (Recommended 
100,000 to 10,000,000). 

The parameter selected here is the parameter displayed on the vertical axis of the plot. 

Because this is a simulation based procedure, the search for the sample size may take several 
minutes or hours to complete. You may find it quicker and more informative to solve for Power 
for a range of sample sizes. 

Error Rates 

Power or Beta 
Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1-Beta, 
so specifying power implicitly specifies beta. 

Beta is the probability obtaining a false negative on the statistical test. That is, it is the probability 
of accepting a false null hypothesis. 

In the context of simulated group sequential trials, the power is the proportion of the alternative 
hypothesis simulations that cross any one of the significance (efficacy) boundaries. 

The valid range is between 0 and 1. 

Different disciplines and protocols have different standards for setting power. A common choice 
is 0.90, but 0.80 is also popular. 

You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.90 by 0.1. 

Alpha (Significance Level) 
Alpha is the probability of obtaining a false positive on the statistical test. That is, it is the 
probability of rejecting a true null hypothesis. 

The null hypothesis is usually that the parameters (the means, proportions, etc.) are all equal. 

In the context of simulated group sequential trials, alpha is the proportion of the null hypothesis 
simulations that cross any one of the significance (efficacy) boundaries. 

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.250. 

Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests. 

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N (Total Sample Size) 
This is the total sample size of both groups. 
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This value is split between the control and treatment groups using the "Proportion in Control 
Group" value. 

Proportion in Control Group 
This is the proportion of the total sample size (N) that is assigned to the control group. 

The value of "0.5" results in equal sample sizes per group. 

The following table shows the result of various choices for this parameter, assuming that N = 
100. 

Entry  N1(Control)  N2(Treatment) 

0.50      50               50 

0.33      33               67 

0.67      67               33 

0.25      25               75 

0.75      75               25 

Effect Size – Hazard Rate 

h1 (Hazard rate of Control Group) 
Specify one or more values for the hazard rate of the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric hazard rate values is entered directly, each represents the 
hazard rate assuming an exponential survival distribution. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the hazard rate for a unit of the total time. The number 
of rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

1.3 

1.7 

1.9 

1.5 

If the time is years, the hazard rate for the first year would be 1.3, the hazard rate for the second 
year would be 1.7, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

Treatment Group Parameter 
Specify whether the hazard rate of the treatment group will be entered directly or based on the 
Hazard Ratio (h2/h1). 
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h2 (Hazard Rate of Treatment Group) 
Specify one or more values for the hazard rate of the Treatment group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric hazard rate values is entered directly, each represents the 
hazard rate assuming an exponential survival distribution. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the hazard rate for a unit of the total time. The number 
of rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

1.3 

1.7 

1.9 

1.5 

If the time is years, the hazard rate for the first year would be 1.3, the hazard rate for the second 
year would be 1.7, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

HR (Hazard Ratio = h2/h1) 
Specify one or more values for the hazard ratio of the Treatment group to the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric hazard ratio values is entered directly, each represents the 
hazard ratio for a treatment subject at risk to a control subject. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the hazard ratio for a unit of the total time. The number 
of rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.9 

0.8 

0.7 

0.8 

If the time is years, the hazard ratio for the first year would be 0.9, the hazard ratio for the second 
year would be 0.8, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 
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Effect Size – Median Survival Time 

T1 (Median Survival Time, Control) 
Specify one or more values for the median survival time of the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric median survival time values is entered directly, each 
represents the median time to an event assuming an exponential survival distribution. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the median survival time for a unit of the total time. 
The number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

2.3 

2.7 

2.9 

3.5 

If the time is years, the median survival time for the first year would be 2.3, the median survival 
time for the second year would be 2.7, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

Treatment Group Parameter 
Specify whether the median survival time of the treatment group will be entered directly or based 
on the Hazard Ratio (T1/T2 = h2/h1). 

T2 (Median Survival Time, Treatment) 
Specify one or more values for the median survival time of the Treatment group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric median survival time values is entered directly, each 
represents the median time to an event assuming an exponential survival distribution. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the median survival time for a unit of the total time. 
The number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

2.3 

2.7 

2.9 

3.5 
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If the time is years, the median survival time for the first year would be 2.3, the median survival 
time for the second year would be 2.7, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

HR (Hazard Ratio = T1/T2 = h2/h1) 
Specify one or more values for the hazard ratio of the Treatment group to the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric hazard ratio values is entered directly, each represents the 
hazard ratio for a treatment subject at risk to a control subject. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the hazard ratio for a unit of the total time. The number 
of rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.9 

0.8 

0.7 

0.8 

If the time is years, the hazard ratio for the first year would be 0.9, the hazard ratio for the second 
year would be 0.8, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

Effect Size – Proportion Surviving 

S1 (Proportion Surviving, Control) 
Specify one or more values for the proportion surviving (proportion without events during the 
corresponding time) of the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric proportion surviving values is entered directly, each 
represents the probability that no event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the proportion surviving for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 
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For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.89 

0.91 

0.77 

0.85 

If the time is years, the proportion surviving for the first year would be 0.89, the proportion 
surviving for the second year would be 0.91, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

Treatment Group Parameter 
Specify whether the hazard rate of the treatment group will be entered directly or based on the 
Hazard Ratio (h2/h1). 

S2 (Proportion Surviving, Treatment) 
Specify one or more values for the proportion surviving (proportion without events during the 
corresponding time) of the Treatment group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric proportion surviving values is entered directly, each 
represents the probability that no event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the proportion surviving for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.89 

0.91 

0.77 

0.85 

If the time is years, the proportion surviving for the first year would be 0.89, the proportion 
surviving for the second year would be 0.91, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

HR (Hazard Ratio = h2/h1) 
Specify one or more values for the hazard ratio of the Treatment group to the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric hazard ratio values is entered directly, each represents the 
hazard ratio for a treatment subject at risk during the time T0 to a control subject during the same 
period. 
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Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the hazard ratio for a unit of the total time. The number 
of rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.9 

0.8 

0.7 

0.8 

If the time is years, the hazard ratio for the first year would be 0.9, the hazard ratio for the second 
year would be 0.8, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

T0 (Proportion Surviving Time) 
Specify the time that corresponds to the proportion surviving values S1, S2, NCS1, and NCS2 if 
they are entered directly. When columns are used, T0 is ignored. 

Effect Size – Mortality 

M1 (Mortality of Control Group) 
Specify one or more values for the mortality (proportion with events during the corresponding 
time) of the Control group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric mortality values is entered directly, each represents the 
probability that an event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the mortality for a unit of the total time. The number of 
rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.11 

0.09 

0.23 

0.15 

If the time is years, the mortality for the first year would be 0.11, the mortality for the second year 
would be 0.09, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 



711-16  Group-Sequential Logrank Tests (Simulation) 

Treatment Group Parameter 
Specify whether the mortality of the treatment group will be entered directly or based on the 
Mortality Ratio (M2/M1). 

M2 (Mortality of Treatment Group) 
Specify one or more values for the mortality (proportion with events during the corresponding 
time) of the Treatment group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric mortality values is entered directly, each represents the 
probability that an event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the mortality for a unit of the total time. The number of 
rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.11 

0.09 

0.23 

0.15 

If the time is years, the mortality for the first year would be 0.11, the mortality for the second year 
would be 0.09, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

MR (Mortality Ratio = M2/M1) 
Specify one or more values for the mortality ratio of the TREATMENT group to the CONTROL 
group. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric mortality ratio values is entered directly, each represents 
the ratio of the mortality for a treatment subject at risk during the time T0 to a control subject 
during the same period. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the mortality ratio for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.9 

0.8 

0.7 

0.8 
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If the time is years, the mortality ratio for the first year would be 0.9, the mortality ratio for the 
second year would be 0.8, and so on. 

Range: Numeric values must be greater than zero. Columns may be specified by name or number, 
and the values in the columns must be greater than zero. 

T0 (Mortality Time) 
Specify the time that corresponds to the mortality values M1, M2, NCM1, and NCM2 if they are 
entered directly. When columns are used, T0 is ignored. 

Test and Simulations 

Alternative Hypothesis 
Specify the direction of the alternative hypothesis for the comparison of hazard rates. 

For one-sided tests, the direction should be consistent with the direct specified under the Effect 
Size. 

Test Type 
Specify the hypothesis test that will be calculated in the simulations. Details for the tests are 
given in the Test Statistics section above. 

The most common test for comparing hazard rates is the logrank test. 

Simulations 
Specify the number of Monte Carlo iterations, M. 

The following table gives an estimate of the precision that is achieved for various simulation sizes 
when the power is near 0.50 and 0.95. The values in the table are the "Precision" amounts that are 
added and subtracted to form a 95% confidence interval. 
  

 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
   

However, when solving for Power or N1, the simulations are used to calculate the look 
boundaries. To obtain precise boundary estimates, the number of simulations needs to be high. 
However, this consideration competes with the length of time to complete the simulation. When 
solving for power, a large number of simulations (100,000 or 1,000,000) will finish in several 
minutes. When solving for N1, perhaps 10,000 simulations can be run for each iteration. Then, a 
final run with the resulting N1 solving for power can be run with more simulations. 



711-18  Group-Sequential Logrank Tests (Simulation) 

Proportion Lost (Per Time Period) 

Controls Lost 
Specify one or more values for the proportion of Controls that are lost-to-follow-up (right-
censored) during each time period of the total time. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric loss values is entered directly, each represents the 
probability that an at-risk subject will be lost-to-follow-up during each time period of the total 
time. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the loss proportion for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.05 

0.05 

0.10 

0.15 

If the time is years, the loss proportion for the first year would be 0.05, the loss proportion for the 
second year would be 0.05, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

Treatments Lost 
Specify one or more values for the proportion of Treatments that are lost-to-follow-up (right-
censored) during each time period of the total time. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric loss values is entered directly, each represents the 
probability that an at-risk subject will be lost-to-follow-up during each time period of the total 
time. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the loss proportion for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.05 

0.05 

0.10 

0.15 
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If the time is years, the loss proportion for the first year would be 0.05, the loss proportion for the 
second year would be 0.05, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

For Treatments Lost under H0, Use 
Specify whether the simulations of the treatment subjects under the Null hypothesis should use 
the loss values specified under "Controls Lost:" or the values specified under "Treatments Lost:". 

Noncompliance (Per Time Period) 

Noncompliance Proportion (Control) 
Specify one or more values for the proportion of Controls that are noncompliant (change 
treatment structure from that of other controls) during each time period of the total time. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric noncompliance values is entered directly, each represents 
the probability that an at-risk subject will become noncompliant during each time period of the 
total time. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the loss proportion for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.05 

0.05 

0.10 

0.15 

If the time is years, the noncompliance proportion for the first year would be 0.05, the 
noncompliance proportion for the second year would be 0.05, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

NCM1 (Noncompliance Mortality, Control) 
Specify one or more values for the noncompliance mortality (proportion with events during the 
corresponding time) of the Control group. 

Values can be entered by number directly, by spreadsheet column, or by specifying a switch to 
M2 mortality. 

Numeric Entry: If one or more numeric noncompliance mortality values is entered directly, each 
represents the probability that an event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the mortality for a unit of the total time. The number of 
rows with values in the column should match the number of time periods entered under "Total 
Time". 
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For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.11 

0.09 

0.23 

0.15 

If the time is years, the noncompliance mortality for the first year would be 0.11, the 
noncompliance mortality for the second year would be 0.09, and so on. 

M2: If M2 is entered, the value(s) entered for M2 will be used for the mortality of M1 when 
noncompliant. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

At time of noncompliance, start NCM1 at 
At the time of noncompliance, the simulated subjects" mortalities can switch to the beginning of 
the specified noncompliance mortality or the specified noncompliance mortality at the time of 
noncompliance. 

Noncompliance Proportion (Treatment) 
Specify one or more values for the proportion of Treatments that are noncompliant (change 
treatment structure from that of other treatment subjects) during each time period of the total 
time. 

Values can be entered by number directly or by spreadsheet column. 

Numeric Entry: If one or more numeric noncompliance values is entered directly, each represents 
the probability that an at-risk subject will become noncompliant during each time period of the 
total time. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the loss proportion for a unit of the total time. The 
number of rows with values in the column should match the number of time periods entered 
under "Total Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.05 

0.05 

0.10 

0.15 

If the time is years, the noncompliance proportion for the first year would be 0.05, the 
noncompliance proportion for the second year would be 0.05, and so on. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

NCM2 (Noncompliance Mortality, Treatment) 
Specify one or more values for the noncompliance mortality (proportion with events during the 
corresponding time) of the Treatment group. 
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Values can be entered by number directly, by spreadsheet column, or by specifying a switch to 
M1 mortality. 

Numeric Entry: If one or more numeric noncompliance mortality values is entered directly, each 
represents the probability that an event occurs for a subject at risk during the time T0. 

Column Entry: Enter columns by beginning the entry with an equals sign (as in "=C1" or "=1 2 
3"). Each row of the spreadsheet contains the mortality for a unit of the total time. The number of 
rows with values in the column should match the number of time periods entered under "Total 
Time". 

For example, if the Total Time is set to "4" and you enter "=1" here, the indicated column could 
contain: 

0.11 

0.09 

0.23 

0.15 

If the time is years, the noncompliance mortality for the first year would be 0.11, the 
noncompliance mortality for the second year would be 0.09, and so on. 

M1: If M1 is entered, the value(s) entered for M1 will be used for the mortality of M2 when 
noncompliant. 

Range: Numeric values must be between zero and one. Columns may be specified by name or 
number, and the values in the columns must be between zero and one. 

At time of noncompliance, start NCM2 at 
At the time of noncompliance, the simulated subjects" mortalities can switch to the beginning of 
the specified noncompliance mortality or the specified noncompliance mortality at the time of 
noncompliance. 

For Treatment Noncompliance under H0, use 
Specify whether the simulations of the treatment subjects under the Null hypothesis should use 
the noncompliance values specified under Control Noncompliance or the values specified under 
Treatment Noncompliance. 

Duration (Number of Time Periods) 

Accrual Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) during which 
subjects are entered into the study. 

The total duration of the study is equal to the Accrual Time plus the Follow-Up Time. 

These values must be integers. 

Range: Accrual times can range from 0 to the Total Time. That is, the accrual time must be less 
than or equal to the Total Time. 

Enter "0" when all subjects begin the study together. 

Accrual Pattern 
This contains the pattern(s) of accrual (subject entry) during the Accrual Time. 
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Four types of entries can be entered here: 

Equal (Uniform): A uniform accrual rate for all time periods. 

Linear Up: The probability of accrual increases linearly during the accrual time. This is used to 
specify slow early recruitment and heavy late recruitment. 

Linear Down: The probability of accrual decreases linearly during the accrual time. This is used 
to specify heavy early recruitment and slow late recruitment. 

Column Entry for Non-Uniform Accrual: Enter columns by beginning the entry with an equals 
sign (as in "=C1" or "=1 2 3"). Each row of the spreadsheet contains the accrual for a unit of the 
accrual time. The number of rows with values in the column should match the number of time 
periods entered under "Accrual Time". 

For example, if the Accrual Time is set to "3" and you enter "=1" here, the indicated column 
could contain: 

25 

50 

25 

If the time is years, the proportion of subjects accrued during the first year would be 0.25, the 
proportion accrued during the second year would be 0.50, and the proportion accrued during the 
third year would be 0.25. 

Note that these values are standardized so that they sum to one. Thus, the accrual pattern 

".25 .50 .25" would result in the same accrual pattern as "1 2 1" or "25 50 25". 

Total Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) in the study. 

The follow-up time is equal to the Total Time minus the Accrual Time. 

These values must be integers. 

Range: Total times must be integers, 1 or greater. 

Looks & Boundaries Tab 
The Data tab contains most of the parameters and options for the general setup of the procedure. 

Looks and Boundaries 

Specification of Looks and Boundaries 
Choose whether spending functions will be used to divide alpha and beta for each look (Simple 
Specification), or whether the percents of alpha and beta to be spent at each look will be specified 
directly (Custom Specification). 

Under Simple Specification, the looks are automatically considered to be equally spaced. Under 
Custom Specification, the looks may be equally spaced or custom defined based on the percent of 
accumulated information. 
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Looks and Boundaries – Simple 
Specification 

Number of Equally Spaced Looks 
Select the total number of looks that will be used if the study is not stopped early for the crossing 
of a boundary.  

Alpha Spending Function 
Specify the type of alpha spending function to use. 

The O'Brien-Fleming Analog spends very little alpha at the beginning and much more at the final 
looks. The Pocock Analog and (Alpha)(Time) spending functions spend alpha more evenly across 
the looks. The Hwang-Shih-DeCani (C) (sometimes called the gamma family) spending functions 
and (Alpha)(Time^C) spending functions are flexible spending functions that can be used to 
spend more alpha early or late or evenly, depending on the choice of C.  

C (Alpha Spending) 
C is used to define the Hwang-Shih-DeCani (C) or (Alpha)(Time^C) spending functions. 

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of alpha at 
later looks, values near 0 spend alpha evenly, and positive values of C spend more of alpha at 
earlier looks. 

For the (Alpha)(Time^C) spending function, only positive values for C are permitted. Values of C 
near zero spend more of alpha at earlier looks, values near 1 spend alpha evenly, and larger 
values of C spend more of alpha at later looks.  

Type of Futility Boundary 
This option determines whether or not futility boundaries will be created, and if so, whether they 
are binding or non-binding. 

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of 
H0. 

Binding futility boundaries are computed in concert with significance boundaries. They are called 
binding because they require the stopping of a trial if they are crossed. If the trial is not stopped, 
the probability of a false positive will exceed alpha. 

When non-binding futility boundaries are computed, the significance boundaries are first 
computed, ignoring the futility boundaries. The futility boundaries are then computed. These 
futility boundaries are non-binding because continuing the trial after they are crossed will not 
affect the overall probability of a false positive declaration.  

Number of Skipped Futility Looks 
In some trials it may be desirable to wait a number of looks before examining the trial for futility. 
This option allows the beta to begin being spent after a specified number of looks. 

The Number of Skipped Futility Looks should be less than the number of looks.  

Beta Spending Function 
Specify the type of beta spending function to use. 

The O'Brien-Fleming Analog spends very little beta at the beginning and much more at the final 
looks. The Pocock Analog and (Beta)(Time) spending functions spend beta more evenly across 
the looks. The Hwang-Shih-DeCani (C) (sometimes called the gamma family) spending functions 
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and (Beta)(Time^C) spending functions are flexible spending functions that can be used to spend 
more beta early or late or evenly, depending on the choice of C.  

C (Beta Spending) 
C is used to define the Hwang-Shih-DeCani (C) or (Beta)(Time^C) spending functions. 

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of beta at 
later looks, values near 0 spend beta evenly, and positive values of C spend more of beta at earlier 
looks. 

For the (Beta)(Time^C) spending function, only positive values for C are permitted. Values of C 
near zero spend more of beta at earlier looks, values near 1 spend beta evenly, and larger values 
of C spend more of beta at later looks.  

Looks and Boundaries – Custom 
Specification 

Number of Looks 
This is the total number of looks of either type (significance or futility or both).  

Equally Spaced 
If this box is checked, the Accumulated Information boxes are ignored and the accumulated 
information is evenly spaced.  

Type of Futility Boundary 
This option determines whether or not futility boundaries will be created, and if so, whether they 
are binding or non-binding. 

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of 
H0. 

Binding futility boundaries are computed in concert with significance boundaries. They are called 
binding because they require the stopping of a trial if they are crossed. If the trial is not stopped, 
the probability of a false positive will exceed alpha. 
 

When Non-binding futility boundaries are computed, the significance boundaries are first 
computed, ignoring the futility boundaries. The futility boundaries are then computed. These 
futility boundaries are non-binding because continuing the trial after they are crossed will not 
affect the overall probability of a false positive declaration.  

Accumulated Information 
The accumulated information at each look defines the proportion or percent of the sample size 
that is used at that look. 

These values are accumulated information values so they must be increasing. 

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes 
will be divided by the value at the final look to create an accumulated information proportion for 
each look.  

Percent of Alpha Spent 
This is the percent of the total alpha that is spent at the corresponding look. It is not the 
cumulative value. 
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Percents, proportions, or alphas may be entered here. Each of the values is divided by the sum of 
the values to obtain the proportion of alpha that is used at the corresponding look.  

Percent of Beta Spent 
This is the percent of the total beta (1-power) that is spent at the corresponding look. It is not the 
cumulative value. 

Percents, proportions, or betas may be entered here. Each of the values is divided by the sum of 
the values to obtain the proportion of beta that is used at the corresponding look.  

Enter Boundaries Tab 
The Data tab contains most of the parameters and options for the general setup of the procedure. 

Looks and Boundaries 

Number of Looks 
This is the total number of looks of either type (significance or futility or both).  

Equally Spaced 
If this box is checked, the Accumulated Information boxes are ignored and the accumulated 
information is evenly spaced.  

Types of Boundaries 
This option determines whether or not futility boundaries will be entered. 

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of 
H0.  

Accumulated Information 
The accumulated information at each look defines the proportion or percent of the sample size 
that is used at that look. 

These values are accumulated information values so they must be increasing. 

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes 
will be divided by the value at the final look to create an accumulated information proportion for 
each look.  

Significance Boundary 
Enter the value of the significance boundary corresponding to the chosen test statistic. These are 
sometimes called efficacy boundaries.  

Futility Boundary 
Enter the value of the futility boundary corresponding to the chosen test statistic.  

Options Tab 
The Options tab contains limits on the number of iterations and various options about individual 
tests. 
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Maximum Iterations  

Maximum N1 Before Search Termination 
Specify the maximum N1 before the search for N1 is aborted. 

Since simulations for large sample sizes are very computationally intensive and hence time-
consuming, this value can be used to stop searches when N1 is larger than reasonable sample 
sizes for the study. 

This applies only when "Find (Solve For)" is set to N1. 

The procedure uses a binary search when searching for N1. If a value for N1 is tried that exceeds 
this value, and the power is not reached, a warning message will be shown on the output 
indicating the desired power was not reached. 

We recommend a value of at least 20000. 

Matching Boundaries at Final Look 

Beta Search Increment 
For each simulation, when futility bounds are computed, the appropriate beta is found by 
searching from 0 to 1 by this increment. Smaller increments are more refined, but the search takes 
longer. 

We recommend 0.001 or 0.0001. 

Zero Count Adjustment 

Zero Count Adjustment Method 
Zero cell counts cause many calculation problems. To compensate for this, a small value (called 
the Zero Count Adjustment Value) may be added either to all cells or to all cells with zero counts. 
This option specifies whether you want to use the adjustment and which type of adjustment you 
want to use. 

Adding a small value is controversial, but may be necessary. Some statisticians recommend 
adding 0.5 while others recommend 0.25. We have found that adding values as small as 0.0001 
seems to work well. 

Zero Count Adjustment Value 
Zero cell counts cause many calculation problems. To compensate for this, a small value may be 
added either to all cells or to all zero cells. This is the amount that is added. 

Some statisticians recommend that the value of 0.5 be added to all cells (both zero and non-zero). 
Others recommend 0.25. We have found that even a value as small as 0.0001 works well. 
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Example 1 – Power and Output 
A clinical trial is to be conducted over a five year period to compare the survival distribution of a 
new treatment to that of the current treatment. The hazard rate of the current treatment is 1.4. 
Although the researchers do not know the true hazard rate of the new treatment, they would like 
to examine the power that is achieved if the hazard rate under the new treatment is 1.0. The 
sample size at the final look is to be 200 per group. Testing will be done at the 0.05 significance 
level. A total of five tests at one year intervals are going to be performed on the data as they are 
obtained. All enrollees are enlisted at the beginning of the study. The O’Brien-Fleming (Analog) 
boundaries will be used. .  

Find the power and test boundaries assuming equal sample sizes per arm and two-sided 
hypothesis tests. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate] procedure window by expanding Survival, then Logrank, then clicking on Group-
Sequential, and then clicking on Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate]. You may then make the appropriate entries as listed below, or open Example 1 by going 
to the File menu and choosing Open Example Template. 

Option Value 
Data 1 Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 200 
Proportion in Control Group .................... 0.5 
h1 ............................................................ 1.4 
Treatment Group Parameter ................... h2 (Hazard Rate) 
h2 ............................................................ 1.0 
Alternative Hypothesis ............................ H1: Hazard1 ≠ Hazard2 
Test Type ................................................ Logrank 
Simulations .............................................. 10000 

Data 2 Tab 
Controls Lost ........................................... 0 
Treatments Lost ...................................... 0 
Noncompliance Proportion (Control) ....... 0 
Noncompliance Proportion (Treatment) .. 0 
Accrual Time ........................................... 0 
Total Time ............................................... 5 

Looks and Boundaries Tab 
Specification of Looks and Boundaries ... Simple 
Number of Equally Spaced Looks ........... 5 
Alpha Spending Function ........................ O’Brien-Fleming Analog 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Scenario 1 Numeric Results for Group Sequential Testing Hazard 1 = Hazard 2. 
Hypotheses: H0: Hazard1=Hazard2; H1: Hazard1<>Hazard2 
Test Statistic: Logrank Test 
Alpha-Spending Function: O'Brien-Fleming Analog 
Beta-Spending Function: None 
Futility Boundary Type: None 
Number of Looks: 5 
Simulations: 10000 
 
 
Numeric Summary for Scenario 1 
 
------------------ Power -------------------      -------------------------- Alpha ---------------------------- 
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta 
0.644 0.635 0.654 0.050 0.052 0.048 0.057 0.356 
 
     Accrual Accrual Total 
N1 N2 HR h1 h2 Time Pattern Time 
100 100 0.714 1.400 1.000 0.0 Equal 5.0 
 
                                       ----------------- Noncompliance ----------------- 
Loss1 Loss2 Prop 1 h1 Prop 2 h2 
0.000 0.000 0.000 1.000 0.000 1.000 
 
Whole Study Averages 
 
                                         ------------ Cum. Subject Time ------------ 
--- Study Length ---        --------- H0 ---------        --------- H1 --------- 
H0 H1 G1 G2 G1 G2 
5.0 3.9 71.4 71.3 70.2 95.8 
 
------------------- Sample Size -------------------       --------------------- Events --------------------- 
----------- H0 -----------        --------- H1 ---------       --------- H0 ---------        --------- H1 --------- 
G1 G2 G1 G2 G1 G2 G1 G2 
100.0 100.0 100.0 100.0 99.9 99.9 98.3 95.7 
 
 
References 
Klein, J.P.; Moeschberger, M.L.. 1997. Survival Analysis. Springer-Verlag. New York. 
Piantadosi, S.. 2005. Clinical Trials, A Methodologic Perspective, 2nd Ed. John Wiley & Sons, Inc. New Jersey. 
Devroye, Luc. 1986. Non-Uniform Random Variate Generation. Springer-Verlag. New York. 
Matsumoto, M. and Nishimura,T. 1998. 'Mersenne twister: A 623-dimensionally equidistributed uniform 
   pseudorandom number generator.' ACM Trans. On Modeling and Computer Simulations. 
Jennison, C.; Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman & 
   Hall. Boca Raton, FL. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis at one of the looks. It is the total proportion 
   of alternative hypothesis simulations that are outside the significance boundaries. 
Power 95% LCL and UCL are the lower and upper confidence limits for the power estimate. The width of the 
   interval is based on the number of simulations. 
Target Alpha is the user-specified probability of rejecting a true null hypothesis. It is the total alpha 
   spent. 
Actual Alpha is the alpha level that was actually achieved by the experiment. It is the total proportion of 
   the null hypothesis simulations that are outside the significance boundaries. 
Alpha 95% LCL and UCL are the lower and upper confidence limits for the actual alpha estimate. The width of 
   the interval is based on the number of simulations. 
Beta is the probability of accepting a false null hypothesis. It is the total proportion of alternative 
   hypothesis simulations that do not cross the significance boundaries. 
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N1 and N2 are the sample sizes of each group if the study reaches the final look. 
HR is the hazard ratio h2/h1 at which power is computed. 
h1 is the hazard rate of the control group. It is the hazard rate that is simulated for both groups under H0, 
   and for group 1 under H1. 
h2 is the hazard rate of the treatment group. It is the hazard rate that is simulated for group 2 under H1. 
Accrual Time is the time during which subjects are enlisted into the study. It is sometimes known as the 
   enlistment period or recruitment period. 
Accrual Pattern describes the distribution of accrual accross the Accrual Time. 
Total Time is the total length of the study. It is the sum of the accrual time and the follow-up time. 
Loss1 and Loss2 are the loss rates (lost to follow-up and right censored) for the control and treatment 
   groups, respectively. 
Noncompliance Proportion 1 and Noncompliance Proportion 2 are the proportion noncompliant in each time period 
   for the control and treatment groups, respectively. 
Noncompliance h1 and Noncompliance h2 are the noncompliance hazard rates for the control and treatment groups, 
   respectively. 
For Whole Study Averages, H0 and H1 refer to the simulations under the null and altervative hypotheses, 
   respectively. 
G1 and G2 refer to the simulations for Groups 1 and 2, respectively. 
Study Length is the average length of the study across all simulations. This length includes accrual time and 
   follow-up time. 
Cumulative Subject Time is the average total time of subject involvement. It is the average sum of survival 
   times, including event survival times and censored survival times. 
Sample size is the average number of subjects entering the study before study termination. If looks are made 
   only after the full accrual period, these values will equal N1 and N2. 
Events is the average number of events in the study before study termination. 
 
Summary Statements 
Group sequential trials with group sample sizes of 100 and 100 at the final look achieve 64% 
power to detect a hazard ratio of 0.714 at the 0.052 significance level (alpha) using a 
two-sided Logrank Test. 
 
 
Detailed Input 
  Control Trt   NComp NComp NComp NComp 
  Hazard Hazard Control Trt Prop Hazard Prop Hazard 
Time Accrual Rate Rate Loss Loss Control Control Trt Trt 
Period Pattern h1 h2 Ls1 Ls2 NCP1 NCh1 NCP2 NCh2 
1 100% Accrual 1.400 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
2 100% Accrual 1.400 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
3 100% Accrual 1.400 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
4 100% Accrual 1.400 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
5 100% Accrual 1.400 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
 
Look Details for Scenario 1 
 
                               ---- Sample Size ----    ----------------------- Events ----------------------   -- Cum. Subject Time -- 
Look Time Group 1 Group 2 Group 1 % of S.S. Group 2 % of S.S. Group 1 Group 2 
1 1.0 100.0 100.0 75.4 75.4 63.2 75.4 53.8 63.2 
2 2.0 100.0 100.0 93.9 93.9 86.5 93.9 67.1 86.5 
3 3.0 100.0 100.0 98.5 98.5 95.0 98.5 70.4 95.1 
4 4.0 100.0 100.0 99.6 99.6 98.2 99.6 71.2 98.3 
5 5.0 100.0 100.0 99.9 99.9 99.3 99.9 71.4 99.4 
 
Look Details Definitions (Averages are across all simulations) 
Look is the number of the look. 
Time is the Time of the look from the beginning of the study (i.e., the beginning of the accrual period). 
Sample Size Group 1 is average number of individuals in the control group that have entered the study by the 
   corresponding look. If looks are made only after the full accrual period, these values will equal N1. 
Sample Size Group 2 is average number of individuals in the treatment group that have entered the study by the 
   corresponding look. If looks are made only after the full accrual period, these values will equal N2. 
Events Group 1 is the average number of events in the control group up to the corresponding look. 
% of S.S. is the average percent of the control group sample size for which an event has occurred up to the 
   corresponding look. It is Group 1 Events / Group 1 Sample Size. 
Events Group 2 is the average number of events in the treatment group up to the corresponding look. 
% of S.S. is the average percent of the treatment group sample size for which an event has occurred up to the 
   corresponding look. It is Group 2 Events / Group 2 Sample Size. 
Cumulative Subject Time is the average total time of subject involvement up to the corresponding look for the 
   control and treatment groups. It is the average sum of survival times, including event survival times and 
   censored survival times. 
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Boundaries for Scenario 1 
 
               -- Significance Boundary -- 
 Z-Value P-Value 
Look Scale Scale 
1 +/- 4.101 0.000 
2 +/- 3.290 0.001 
3 +/- 2.644 0.008 
4 +/- 2.245 0.025 
5 +/- 1.982 0.047 
 
Boundaries Definitions 
Look is the number of the look. 
Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the 
   corresponding look indicate termination of the study and rejection of the null hypothesis. They are 
   sometimes called efficacy boundaries. 
Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding 
   look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to 
   the Z-Value Boundary and is sometimes called the nominal alpha. 
 
 
Boundary Plot 
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Boundary Plot - P-Value 
 

 
 
 
Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1 
 
                  --------- Z-Value Boundary ---------    --------- P-Value Boundary --------- 
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL 
1 +/- 4.101   0.000   
2 +/- 3.290 3.146 3.690 0.001 0.000 0.002 
3 +/- 2.644 2.597 2.809 0.008 0.005 0.009 
4 +/- 2.245 2.208 2.301 0.025 0.021 0.027 
5 +/- 1.982 1.943 2.013 0.047 0.044 0.052 
 
 
Significance Boundary Confidence Limit Definitions 
Look is the number of the look. 
Z-Value Boundary Value is the value such that statistics outside this boundary at the corresponding look 
   indicate termination of the study and rejection of the null hypothesis. They are sometimes called efficacy 
   boundaries. 
P-Value Boundary Value is the value such that P-Values outside this boundary at the corresponding look 
   indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to the 
   Z-Value Boundary and is sometimes called the nominal alpha. 
95% LCL and UCL are the lower and upper confidence limits for the boundary at the given look. The width of the 
   interval is based on the number of simulations. 
 
Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1 
 
                                                         --------- Target ---------   --------- Actual ----------  Proportion          Cum. 
    Cum.   H1 Sims H1 Sims 
 --- Signif. Boundary--- Spending Spending  Cum. Outside Outside 
 Z-Value P-Value Function Function Alpha Alpha Signif. Signif. 
Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary 
1 +/- 4.101 0.000 0.000 0.000 0.000 0.000 0.020 0.020 
2 +/- 3.290 0.001 0.001 0.001 0.001 0.001 0.137 0.156 
3 +/- 2.644 0.008 0.007 0.008 0.008 0.009 0.217 0.373 
4 +/- 2.245 0.025 0.017 0.024 0.017 0.026 0.171 0.544 
5 +/- 1.982 0.047 0.026 0.050 0.026 0.052 0.101 0.644 
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Alpha-Spending Details Definitions 
Look is the number of the look. 
Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the 
   corresponding look indicate termination of the study and rejection of the null hypothesis. They are 
   sometimes called efficacy boundaries. 
Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding 
   look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to 
   the Significance Z-Value Boundary and is sometimes called the nominal alpha. 
Spending Function Alpha is the intended portion of alpha allocated to the particular look based on the 
   alpha-spending function. 
Cumulative Spending Function Alpha is the intended accumulated alpha allocated to the particular look. It is 
   the sum of the Spending Function Alpha up to the corresponding look. 
Alpha Spent is the proportion of the null hypothesis simulations resulting in statistics outside the 
   Significance Boundary at this look. 
Cumulative Alpha Spent is the proportion of the null hypothesis simulations resulting in Significance Boundary 
   termination up to and including this look. It is the sum of the Alpha Spent up to the corresponding look. 
Proportion H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations 
   resulting in statistics outside the Significance Boundary at this look. It may be thought of as the 
   incremental power. 
Cumulative H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations 
   resulting in Significance Boundary termination up to and including this look. It is the sum of the 
   Proportion H1 Sims Outside Significance Boundary up to the corresponding look. 
 
Run Time: 3.73 minutes. 
 

The values obtained from any given run of this example will vary slightly due to the variation in 
simulations. 

Example 2 – Power for One-Sided Test with Futility 
Boundaries 
Suppose researchers would like to compare two treatments with a one-sided test at each look. 
Further, suppose they would like to terminate the study early when it can be deemed highly 
unlikely that the new treatment is better than the standard. Suppose the control group hazard rate 
is 1.49. The researchers wish to know the power of the test if the treatment group hazard rate is 
1.0. The sample size at the final look is to be 200 per group. Testing will be done at the 0.025 
significance level. A total of five tests are going to be performed on the data as they are obtained. 
The O’Brien-Fleming (Analog) boundaries will be used for both significance and futility 
boundaries.  

Find the power and test boundaries assuming equal sample sizes per arm and one-sided 
hypothesis tests. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate] procedure window by expanding Survival, then Logrank, then clicking on Group-
Sequential, and then clicking on Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate]. You may then make the appropriate entries as listed below, or open Example 2 by going 
to the File menu and choosing Open Example Template. 
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Option Value 
Data 1 Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.025 
N (Total Sample Size) ............................. 200 
Proportion in Control Group .................... 0.5 
h1 ............................................................ 1.49 
Treatment Group Parameter ................... h2 (Hazard Rate) 
h2 ............................................................ 1.0 
Alternative Hypothesis ............................ H1: Hazard1 > Hazard2 
Test Type ................................................ Logrank 
Simulations .............................................. 10000 

Data 2 Tab 
Controls Lost ........................................... 0 
Treatments Lost ...................................... 0 
Noncompliance Proportion (Control) ....... 0 
Noncompliance Proportion (Treatment) .. 0 
Accrual Time ........................................... 0 
Total Time ............................................... 5 

Looks and Boundaries Tab 
Specification of Looks and Boundaries ... Simple 
Number of Equally Spaced Looks ........... 5 
Alpha Spending Function ........................ O’Brien-Fleming Analog 
Type of Futility Boundary ........................ Non-Binding 
Number of Skipped Futility Looks ........... 0 
Beta Spending Function .......................... O’Brien-Fleming Analog 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Scenario 1 Numeric Results for Group Sequential Testing Hazard 1 = Hazard 2. 
Hypotheses: H0: Hazard1=Hazard2; H1: Hazard1>Hazard2 
Test Statistic: Logrank Test 
Alpha-Spending Function: O'Brien-Fleming Analog 
Beta-Spending Function: O'Brien-Fleming Analog 
Futility Boundary Type: Non-binding 
Number of Looks: 5 
Simulations: 10000 
 
Numeric Summary for Scenario 1 
 
------------------ Power -------------------      -------------------------- Alpha ---------------------------- 
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta 
0.779 0.771 0.788 0.025 0.025 0.022 0.028 0.221 
 
     Accrual Accrual Total 
N1 N2 HR h1 h2 Time Pattern Time 
100 100 0.671 1.490 1.000 0.0 Equal 5.0 



711-34  Group-Sequential Logrank Tests (Simulation) 

 
                                       ----------------- Noncompliance ----------------- 
Loss1 Loss2 Prop 1 h1 Prop 2 h2 
0.000 0.000 0.000 1.000 0.000 1.000 
 
Whole Study Averages 
 
                                         ------------ Cum. Subject Time ------------ 
--- Study Length ---        --------- H0 ---------        --------- H1 --------- 
H0 H1 G1 G2 G1 G2 
1.8 3.1 59.1 59.0 64.6 91.6 
 
------------------- Sample Size -------------------       --------------------- Events --------------------- 
----------- H0 -----------        --------- H1 ---------       --------- H0 ---------        --------- H1 --------- 
G1 G2 G1 G2 G1 G2 G1 G2 
100.0 100.0 100.0 100.0 88.0 88.0 96.4 91.5 
 

 
Detailed Input 
  Control Trt   NComp NComp NComp NComp 
  Hazard Hazard Control Trt Prop Hazard Prop Hazard 
Time Accrual Rate Rate Loss Loss Control Control Trt Trt 
Period Pattern h1 h2 Ls1 Ls2 NCP1 NCh1 NCP2 NCh2 
1 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
2 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
3 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
4 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
5 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
 
Look Details for Scenario 1 
 
                               ---- Sample Size ----    ----------------------- Events ----------------------   -- Cum. Subject Time -- 
Look Time Group 1 Group 2 Group 1 % of S.S. Group 2 % of S.S. Group 1 Group 2 
1 1.0 100.0 100.0 77.5 77.5 63.2 77.5 52.0 63.2 
2 2.0 100.0 100.0 94.9 94.9 86.4 94.9 63.6 86.5 
3 3.0 100.0 100.0 98.9 98.9 95.0 98.9 66.3 95.1 
4 4.0 100.0 100.0 99.7 99.7 98.2 99.7 66.9 98.3 
5 5.0 100.0 100.0 99.9 99.9 99.3 99.9 67.0 99.4 
 
 
               -- Significance Boundary --       ----- Futility Boundary ----- 
 Z-Value P-Value Z-Value P-Value 
Look Scale Scale Scale Scale 
1 3.768 0.000 -0.183 0.573 
2 3.318 0.000 1.070 0.142 
3 2.757 0.003 1.576 0.058 
4 2.268 0.012 1.833 0.033 
5 2.008 0.022 2.008 0.022 



Group-Sequential Logrank Tests (Simulation)  711-35 

 
Boundary Plot 
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Boundary Plot - P-Value 
 

Boundary Plot

Look

1 2 3 4 5
0.0

0.1

0.2

0.3

0.4

0.5

Boundary Type
Sig. Boundary
Fut. Boundary

 
 
 
Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1 
 
                  --------- Z-Value Boundary ---------    --------- P-Value Boundary --------- 
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL 
1 3.768   0.000   
2 3.318 3.208 3.649 0.000 0.000 0.001 
3 2.757 2.643 2.884 0.003 0.002 0.004 
4 2.268 2.236 2.343 0.012 0.010 0.013 
5 2.008 1.965 2.051 0.022 0.020 0.025 
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Futility Boundaries with 95% Simulation Confidence Intervals for Scenario 1 
 
                  --------- Z-Value Boundary ---------    --------- P-Value Boundary --------- 
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL 
1 -0.183 -0.254 -0.068 0.573   
2 1.070 1.026 1.108 0.142 0.134 0.152 
3 1.576 1.549 1.601 0.058 0.055 0.061 
4 1.833 1.820 1.848 0.033 0.032 0.034 
5 2.008 2.000 2.021 0.022 0.022 0.023 
 
 
Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1 
 
                                                         --------- Target ---------   --------- Actual ----------  Proportion          Cum. 
    Cum.   H0 Sims H0 Sims 
 --- Signif. Boundary--- Spending Spending  Cum. Outside Outside 
 Z-Value P-Value Function Function Alpha Alpha Futility Futility 
Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary 
1 3.768 0.000 0.000 0.000 0.000 0.000 0.431 0.431 
2 3.318 0.000 0.000 0.000 0.000 0.000 0.428 0.859 
3 2.757 0.003 0.003 0.004 0.003 0.004 0.082 0.941 
4 2.268 0.012 0.008 0.012 0.008 0.012 0.024 0.965 
5 2.008 0.022 0.013 0.025 0.013 0.025 0.010 0.975 
 
 
Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1 
 
                                                         --------- Target ---------   --------- Actual ----------  Proportion          Cum. 
    Cum.   H1 Sims H1 Sims 
 -- Futility  Boundary-- Spending Spending  Cum. Outside Outside 
 Z-Value P-Value Function Function Beta Beta Signif. Signif. 
Look Scale Scale Beta Beta Spent Spent Boundary Boundary 
1 -0.183 0.573 0.006 0.006 0.006 0.006 0.083 0.083 
2 1.070 0.142 0.047 0.053 0.047 0.053 0.187 0.270 
3 1.576 0.058 0.061 0.114 0.061 0.114 0.235 0.505 
4 1.833 0.033 0.057 0.171 0.057 0.171 0.191 0.696 
5 2.008 0.022 0.050 0.221 0.049 0.221 0.083 0.779 
 
Run Time: 3.76 minutes. 
 

The values obtained from any given run of this example will vary slightly due to the variation in 
simulations. 
 

Example 3 – Enter Boundaries 
With a set-up similar to Example 2, suppose we wish to investigate the properties of a set of 
significance (3, 3, 3, 2, 1) and futility (-2, -1, 0, 0, 1) boundaries. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate] procedure window by expanding Survival, then Logrank, then clicking on Group-
Sequential, and then clicking on Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate]. You may then make the appropriate entries as listed below, or open Example 3 by going 
to the File menu and choosing Open Example Template. 
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Option Value 
Data 1 Tab 
Find (Solve For) ...................................... Alpha and Power (Enter Boundaries) 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... Ignored since this is the Find setting 
N (Total Sample Size) ............................. 200 
Proportion in Control Group .................... 0.5 
h1 ............................................................ 1.49 
Treatment Group Parameter ................... h2 (Hazard Rate) 
h2 ............................................................ 1.0 
Alternative Hypothesis ............................ H1: Hazard1 > Hazard2 
Test Type ................................................ Logrank 
Simulations .............................................. 10000 

Data 2 Tab 
Controls Lost ........................................... 0 
Treatments Lost ...................................... 0 
Noncompliance Proportion (Control) ....... 0 
Noncompliance Proportion (Treatment) .. 0 
Accrual Time ........................................... 0 
Total Time ............................................... 5 

Enter Boundaries Tab 
Number of Looks ..................................... 5 
Types of Boundaries ............................... Significance and Futility Boundaries 
Significance Boundary ............................ 3 3 3 2 1 (for looks 1 through 5) 
Futility Boundary ..................................... -2 -1 0 0 1 (for looks 1 through 5) 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Scenario 1 Numeric Results for Group Sequential Testing Hazard 1 = Hazard 2. 
Hypotheses: H0: Hazard1=Hazard2; H1: Hazard1>Hazard2 
Test Statistic: Logrank Test 
Type of Boundaries: Significance and Futility Boundaries 
Number of Looks: 5 
Simulations: 10000 
 
Numeric Summary for Scenario 1 
 
------------------ Power -------------------      -------------------------- Alpha ---------------------------- 
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta 
0.964 0.960 0.967 0.164 0.157 0.172 0.036 
 
     Accrual Accrual Total 
N1 N2 HR h1 h2 Time Pattern Time 
100 100 0.671 1.490 1.000 0.0 Equal 5.0 
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                                       ----------------- Noncompliance ----------------- 
Loss1 Loss2 Prop 1 h1 Prop 2 h2 
0.000 0.000 0.000 1.000 0.000 1.000 
 
 
Whole Study Averages 
 
                                         ------------ Cum. Subject Time ------------ 
--- Study Length ---        --------- H0 ---------        --------- H1 --------- 
H0 H1 G1 G2 G1 G2 
3.8 3.1 66.0 66.0 62.5 87.6 
 
 
------------------- Sample Size -------------------       --------------------- Events --------------------- 
----------- H0 -----------        --------- H1 ---------       --------- H0 ---------        --------- H1 --------- 
G1 G2 G1 G2 G1 G2 G1 G2 
100.0 100.0 100.0 100.0 98.3 98.3 93.2 87.5 
 

 
Detailed Input 
  Control Trt   NComp NComp NComp NComp 
  Hazard Hazard Control Trt Prop Hazard Prop Hazard 
Time Accrual Rate Rate Loss Loss Control Control Trt Trt 
Period Pattern h1 h2 Ls1 Ls2 NCP1 NCh1 NCP2 NCh2 
1 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
2 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
3 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
4 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
5 100% Accrual 1.490 1.000 0.000 0.000 0.000 1.000 0.000 1.000 
 
 
Look Details for Scenario 1 
 
                               ---- Sample Size ----    ----------------------- Events ----------------------   -- Cum. Subject Time -- 
Look Time Group 1 Group 2 Group 1 % of S.S. Group 2 % of S.S. Group 1 Group 2 
1 1.0 100.0 100.0 77.5 77.5 63.2 77.5 51.9 63.2 
2 2.0 100.0 100.0 94.9 94.9 86.4 94.9 63.7 86.5 
3 3.0 100.0 100.0 98.9 98.9 95.0 98.9 66.3 95.1 
4 4.0 100.0 100.0 99.7 99.7 98.2 99.7 66.9 98.3 
5 5.0 100.0 100.0 99.9 99.9 99.3 99.9 67.0 99.5 
 
 
 
               -- Significance Boundary --       ----- Futility Boundary ----- 
 Z-Value P-Value Z-Value P-Value 
Look Scale Scale Scale Scale 
1 3.000 0.001 -2.000 0.977 
2 3.000 0.001 -1.000 0.841 
3 3.000 0.001 0.000 0.500 
4 2.000 0.023 0.000 0.500 
5 1.000 0.159 1.000 0.159 
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Boundary Plot 
 

 
 
 

 
Boundary Plot - P-Value 
 

 
 
 
 
Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1 
 
     Proportion Cum. 
     H0 Sims H0 Sims 
 --- Signif. Boundary---  Cum. Outside Outside 
 Z-Value P-Value Alpha Alpha Futility Futility 
Look Scale Scale Spent Spent Boundary Boundary 
1 3.000 0.001 0.001 0.001 0.024 0.024 
2 3.000 0.001 0.001 0.002 0.133 0.157 
3 3.000 0.001 0.001 0.002 0.341 0.498 
4 2.000 0.023 0.019 0.022 0.008 0.506 
5 1.000 0.159 0.143 0.164 0.329 0.836 
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Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1 
 
     Proportion Cum. 
     H1 Sims H1 Sims 
 -- Futility  Boundary--  Cum. Outside Outside 
 Z-Value P-Value Beta Beta Signif. Signif. 
Look Scale Scale Spent Spent Boundary Boundary 
1 -2.000 0.977 0.000 0.000 0.262 0.262 
2 -1.000 0.841 0.000 0.000 0.142 0.403 
3 0.000 0.500 0.003 0.003 0.042 0.445 
4 0.000 0.500 0.000 0.003 0.343 0.788 
5 1.000 0.159 0.033 0.036 0.176 0.964 
 
Run Time: 3.84 minutes. 
 

The values obtained from any given run of this example will vary slightly due to the variation in 
simulations. 
 

Example 4 – Validation Using Simulation 
With a set-up similar to Example 1, we examine the power and alpha generated by the set of two-
sided significance boundaries (+/- 4.101, +/- 3.290, +/- 2.644, +/- 2.245, +/- 1.982).  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate] procedure window by expanding Survival, then Logrank, then clicking on Group-
Sequential, and then clicking on Group-Sequential Logrank Tests (Simulation) [Hazard 
Rate]. You may then make the appropriate entries as listed below, or open Example 4 by going 
to the File menu and choosing Open Example Template. 

Option Value 
Data 1 Tab 
Find (Solve For) ...................................... Alpha and Power (Enter Boundaries) 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... Ignored since this is the Find setting 
N (Total Sample Size) ............................. 200 
Proportion in Control Group .................... 0.5 
h1 ............................................................ 1.4 
Treatment Group Parameter ................... h2 (Hazard Rate) 
h2 ............................................................ 1.0 
Alternative Hypothesis ............................ H1: Hazard1 ≠ Hazard2 
Test Type ................................................ Logrank 
Simulations .............................................. 10000 

Data 2 Tab 
Controls Lost ........................................... 0 
Treatments Lost ...................................... 0 
Noncompliance Proportion (Control) ....... 0 
Noncompliance Proportion (Treatment) .. 0 
Accrual Time ........................................... 0 
Total Time ............................................... 5 
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Enter Boundaries Tab 
Number of Looks ..................................... 5 
Types of Boundaries ............................... Significance Boundaries 
Significance Boundary ............................  4.101, 3.290, 2.644, 2.245, 1.982 (looks 1 through 5) 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Numeric Summary for Scenario 1 
 
------------------ Power -------------------      -------------------------- Alpha ---------------------------- 
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL  
0.642 0.633 0.652 0.045 0.041 0.049 0.358 
 
     Accrual Accrual Total 
N1 N2 HR h1 h2 Time Pattern Time 
100 100 0.714 1.400 1.000 0.0 Equal 5.0 
 
                                       ----------------- Noncompliance ----------------- 
Loss1 Loss2 Prop 1 h1 Prop 2 h2 
0.000 0.000 0.000 1.000 0.000 1.000 
 
Whole Study Averages 
 
                                         ------------ Cum. Subject Time ------------ 
--- Study Length ---        --------- H0 ---------        --------- H1 --------- 
H0 H1 G1 G2 G1 G2 
5.0 3.9 71.3 71.3 70.3 95.8 
 
 
------------------- Sample Size -------------------       --------------------- Events --------------------- 
----------- H0 -----------        --------- H1 ---------       --------- H0 ---------        --------- H1 --------- 
G1 G2 G1 G2 G1 G2 G1 G2 
100.0 100.0 100.0 100.0 99.9 99.9 98.3 95.8 
 

The values obtained from any given run of this example will vary slightly due to the variation in 
simulations. The power and alpha generated with these boundaries are very close to the values of 
Example 1. 



711-42  Group-Sequential Logrank Tests (Simulation) 

Example 5 – Validation Using Lakatos 
Lakatos (2002), page 1983, presents an example of a one-sided complex group sequential 
survival trial.  The total time of the trial is 5 years, and the setup is specified in terms of months. 
The accrual period is two years, but the accrual pattern varies according to month. The 
noncompliance pattern changes after the first year from 5% to 10%. Survival is represented in 
terms of mortality, and varies across time. The treatment group mortality is 0.775 times the yearly 
control group mortality. With alpha equal to 0.025 and a sample size of 1244, the power for 10 
looks with O’Brien-Fleming boundaries is 0.90. The O’Brien-Fleming alpha values are input 
directly in this example since they differ slightly from the O’Brien-Fleming analog values. All 
yearly rates in this example are converted to monthly rates for consistency. 
Warning: the time to run this example is around 10 to 15 hours at current computer speeds. 
 
Accrual Percent: months 1 to 3 (10), months 4 to 6 (20), months 7 to 9 (40), months 10 to 12 (60), 
months 13 to 15 (80), months 16 to 24 (100). 
 

Noncompliance Control: 0.00427 / month 
 

Noncompliance Treatment: months 1 to 12 (0.00874 / month), months 13 to 60 (0.00427 / month) 
 

Mortality Control: months 1 to 3 (0.0403 / month), months 4 to 6 (0.0248 / month), months 7 to 
12 (0.0237 / month), months 13 to 24 (0.0215 / month), months 25 to 60 (0.0184 / month). 
 

Mortality Treatment: months 1 to 3 (0.0295 / month), months 4 to 6 (0.0186 / month), months 7 
to 12 (0.0178 / month), months 13 to 24 (0.0162 / month), months 25 to 60 (0.0139 / month). 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Group-Sequential Logrank Tests (Simulation) [Mortality] 
procedure window by expanding Survival, then Logrank, then clicking on Group-Sequential, 
and then clicking on Group-Sequential Logrank Tests (Simulation) [Mortality]. You may 
open Example 5 by going to the File menu and choosing Open Example Template. 

Option Value 
Data 1 Tab 
Find (Solve For) ...................................... Power 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.025 
N (Total Sample Size) ............................. 1244 
Proportion in Control Group .................... 0.5 
M1 ........................................................... =pC 
Treatment Group Parameter ................... M2 (Mortality) 
M2 ........................................................... =pE 
T0 ............................................................ 1.0 
Alternative Hypothesis ............................ H1: Hazard1 > Hazard2 
Test Type ................................................ Logrank 
Simulations .............................................. 200000 



Group-Sequential Logrank Tests (Simulation)  711-43 

Data 2 Tab 
Controls Lost ........................................... 0 
Treatments Lost ...................................... 0 
Noncompliance Proportion (Control) ....... =dropin 
NCM1 ...................................................... M2 
At noncompliance, start NCM1 at ........... Current time 
Noncompliance Proportion (Treatment) .. =NonComp 
NCM2 ...................................................... M1 
At noncompliance, start NCM2 at ........... Current time 
For Trt Noncomp under H0, use ............. Control Noncompliance 
Accrual Time ........................................... 24 
Accrual Pattern ........................................ =Accrual 
Total Time ............................................... 60 

Looks and Boundaries Tab 
Specification ............................................ Custom 
Number of Looks ..................................... 10 
Equally Spaced ....................................... Checked 
Type of Futility Boundary ........................ None 
Percent of Alpha Spent ........................... 0, 0, 0, 0.00036, 0.00248, 0.00415, 0.00474, 0.00465,  
                                                                 0.00442, 0.00420 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Numeric Summary for Scenario 1 
 
------------------ Power -------------------      -------------------------- Alpha ---------------------------- 
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta 
0.89508 0.89374 0.89642 0.02500 0.02500 0.02432 0.02568 0.10492 
 
     Accrual Accrual Total 
N1 N2 HR h1 h2 Time Pattern Time 
622 622 Calc. pC pE 1.0 24.0 Accrual60.0 
 
                                       ----------------- Noncompliance ----------------- 
Loss1 Loss2 Prop 1 h1 Prop 2 h2 
0.00000 0.00000 dropin h2 NonComp h1 
 
 
Whole Study Averages 
 
                                         ------------ Cum. Subject Time ------------ 
--- Study Length ---        --------- H0 ---------        --------- H1 --------- 
H0 H1 G1 G2 G1 G2 
59.6 38.3 16554.6 16554.8 9877.8 10686.6 
 
 
------------------- Sample Size -------------------       --------------------- Events --------------------- 
----------- H0 -----------        --------- H1 ---------       --------- H0 ---------        --------- H1 --------- 
G1 G2 G1 G2 G1 G2 G1 G2 
622.0 622.0 621.8 621.8 381.2 381.2 252.2 208.1 
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Look Details for Scenario 1 
 
                               ---- Sample Size ----    ----------------------- Events ----------------------   -- Cum. Subject Time -- 
Look Time Group 1 Group 2 Group 1 % of S.S. Group 2 % of S.S. Group 1 Group 2 
1 6.0 37.0 37.0 3.2 8.7 2.4 8.7 84.4 86.0 
2 12.0 159.0 159.0 19.9 12.5 15.1 12.5 574.2 590.3 
3 18.0 378.0 378.0 61.7 16.3 47.5 16.3 1918.1 1988.1 
4 24.0 622.0 622.0 131.3 21.1 102.5 21.1 4351.3 4548.0 
5 30.0 622.0 622.0 197.2 31.7 157.3 31.7 7086.0 7492.5 
6 36.0 622.0 622.0 248.6 40.0 202.4 40.0 9475.6 10141.9 
7 42.0 622.0 622.0 290.9 46.8 241.1 46.8 11585.2 12540.8 
8 48.0 622.0 622.0 326.1 52.4 274.4 52.4 13463.0 14723.9 
9 54.0 622.0 622.0 356.2 57.3 303.9 57.3 15146.4 16719.7 
10 60.0 622.0 622.0 383.1 61.6 331.1 61.6 16658.9 18545.7 
 
 
Boundaries for Scenario 1 
 
               -- Significance Boundary -- 
 Z-Value P-Value 
Look Scale Scale 
1 3.41264 0.00032 
2 4.43292 0.00000 
3 4.81688 0.00000 
4 3.37535 0.00037 
5 2.78612 0.00267 
6 2.50579 0.00611 
7 2.35888 0.00916 
8 2.25193 0.01216 
9 2.18130 0.01458 
10 2.12776 0.01668 
 

 
Boundary Plot 
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Boundary Plot - P-Value 
 

 
 
 
Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1 
 
                  --------- Z-Value Boundary ---------    --------- P-Value Boundary --------- 
Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL 
1 3.41264   0.00032   
2 4.43292   0.00000   
3 4.81688   0.00000   
4 3.37535 3.28706 3.43887 0.00037 0.00029 0.00051 
5 2.78612 2.76076 2.80458 0.00267 0.00252 0.00288 
6 2.50579 2.48677 2.52154 0.00611 0.00584 0.00645 
7 2.35888 2.34004 2.37485 0.00916 0.00878 0.00964 
8 2.25193 2.23824 2.26422 0.01216 0.01178 0.01260 
9 2.18130 2.16893 2.19663 0.01458 0.01402 0.01504 
10 2.12776 2.11619 2.14044 0.01668 0.01616 0.01716 
 
 
Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1 
 
                                                         --------- Target ---------   --------- Actual ----------  Proportion          Cum. 
    Cum.   H1 Sims H1 Sims 
 --- Signif. Boundary--- Spending Spending  Cum. Outside Outside 
 Z-Value P-Value Function Function Alpha Alpha Signif. Signif. 
Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary 
1 3.41264 0.00032 0.00000 0.00000 0.00000 0.00000 0.00006 0.00006 
2 4.43292 0.00000 0.00000 0.00000 0.00000 0.00000 0.00006 0.00012 
3 4.81688 0.00000 0.00000 0.00000 0.00000 0.00000 0.00045 0.00057 
4 3.37535 0.00037 0.00036 0.00036 0.00036 0.00036 0.11145 0.11202 
5 2.78612 0.00267 0.00248 0.00284 0.00248 0.00284 0.31104 0.42305 
6 2.50579 0.00611 0.00415 0.00699 0.00415 0.00699 0.21382 0.63687 
7 2.35888 0.00916 0.00474 0.01173 0.00474 0.01173 0.11818 0.75505 
8 2.25193 0.01216 0.00465 0.01638 0.00465 0.01638 0.06987 0.82491 
9 2.18130 0.01458 0.00442 0.02080 0.00442 0.02080 0.04274 0.86765 
10 2.12776 0.01668 0.00420 0.02500 0.00420 0.02500 0.02744 0.89508 
 

The values obtained from any given run of this example will vary slightly due to the variation in 
simulations. The power generated for this example is 0.89508, very close to the value in Lakatos 
(2008), although 0.90 is not in the simulation confidence interval. Also, the first two boundary 
values are not as extreme as they should be because there were not enough simulations to obtain 
extreme boundary values. The first three boundary values in Lakatos (2002) were set to 5.0. 
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Chapter 715 

Logrank Tests 
(Lakatos) 
Introduction 
This module computes the sample size and power of the logrank test for equality of survival 
distributions under very general assumptions. Accrual time, follow-up time, loss during follow 
up, noncompliance, and time-dependent hazard rates are parameters that can be set.  

A clinical trial is often employed to test the equality of survival distributions for two treatment 
groups. For example, a researcher might wish to determine if Beta-Blocker A enhances the 
survival of newly diagnosed myocardial infarction patients over that of the standard Beta-Blocker 
B. The question being considered is whether the pattern of survival is different. 

The two-sample t-test is not appropriate for two reasons. First, the data consist of the length of 
survival (time to failure), which is often highly skewed, so the usual normality assumption cannot 
be validated. Second, since the purpose of the treatment is to increase survival time, it is likely 
(and desirable) that some of the individuals in the study will survive longer than the planned 
duration of the study. The survival times of these individuals are then said to be censored. These 
times provide valuable information, but they are not the actual survival times. Hence, special 
methods have to be employed which use both regular and censored survival times.  

The logrank test is one of the most popular tests for comparing two survival distributions. It is 
easy to apply and is usually more powerful than an analysis based simply on proportions. It 
compares survival across the whole spectrum of time, not just at one or two points. This module 
allows the sample size and power of the logrank test to be analyzed under very general 
conditions. 

Power and sample size calculations for the logrank test have been studied by several authors. This 
PASS module uses the method of Lakatos (1988) because of its generality. This method is based 
on a Markov model that yields the asymptotic mean and variance of the logrank statistic under 
very general conditions. 

Four Procedures Documented Here 
There are four closely-related procedures that are documented in this chapter. These procedures 
are identical except for the parameterization of the effect size. The parameterization can be in 
terms of hazard rates, median survival time, proportion surviving, and mortality (proportion 
dying). Each of these options is listed separately. 

The Markov process methodology divides the total study time into K equal-length intervals. The 
value of K is large enough so that the distribution within an interval can be assumed to follow the 
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exponential distribution. The next section presents pertinent results for the exponential 
distribution. 

Exponential Distribution 
The density function of the exponential is defined as 

( ) hthe =tf −  

The probability of surviving the first t years is  

( ) hte = tS −  

The mortality (probability of dying during the first t years) is  

( ) e = t −−1 htM  

For an exponential distribution, the mean survival is 1/h and the median is ln(2)/h. 

Notice that it is easy to translate between the hazard rate, the proportion surviving, the mortality, 
and the median survival time. The choice of which parameterization is used is arbitrary and is 
selected according to the convenience of the user. 

Hazard Rate Parameterization 
In this case, the hazard rates for the control and treatment groups are specified directly.  

Median Survival Time Parameterization 
Here, the median survival time is specified. These are transformed to hazard rates using the 
relationship h = ln(2) / MST.  

Proportion Surviving Parameterization 
In this case, the proportion surviving until a given time T0 is specified. These are transformed to 
hazard rates using the relationship h = –ln(S(T0)) / T0. Note that when separate proportions 
surviving are given for each time period, T0 is taken to be the time period number.  

Mortality Parameterization 
Here, the mortality until a given time T0 is specified. These are transformed to hazard rates using 
the relationship h = –ln(1 – M(T0)) / T0. Note that when separate mortalities are given for each 
time period, T0 is taken to be the time period number.  
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Comparison of Lakatos Procedures to the other PASS 
Logrank Procedures 
The follow chart lists the capabilities and assumptions of each of the logrank procedures available 
in PASS.  
 
 Algorithm 

Feature/Capability 
Simple 

(Freedman) Advanced (Lachin) 
Markov Process 

(Lakatos) 
Test Statistic Logrank statistic Mean hazard difference* Logrank statistic 

Hazard Ratio Constant Constant Any pattern including 
time-dependent 

Basic Time Distribution Constant hazard 
ratio** 

Constant hazard ratio 
(exponential) Any distribution 

Loss to Follow Up 
Parameters Yes Yes Yes 

Accrual Parameters No Yes Yes 
Drop In Parameters No No Yes 
Noncompliance Parameters No No Yes 
Duration Parameters No Yes Yes 
Input Hazard Ratios No No Yes 
Input Median Survival Times No No Yes 
Input Proportion Surviving Yes Yes Yes 
Input Mortality Rates No No Yes 

 

*Simulation shows power similar to logrank statistic 
**Not necessarily exponential 

Comparison of Results 
It is informative to calculate sample sizes for various scenarios using several of the methods. The 
scenario used to compare the various methods was S1 = 0.5, S2 = 0.7, T0 = 4, Loss to Follow Up 
= 0.05, Accrual Time = 2, Total Time = 4, and N = 200. Note that the Freedman method in PASS 
does not allow the input of T0, Accrual Time, or Total Time, so it is much less comparable. The 
Lachin/Foulkes and Lakatos values are very similar. 
 

 
Computation Method S1 S2 T0 

Loss to 
Follow 

Up 
Accrual 

Time 
Total 
Time N Power 

PASS (Freedman) 0.5 0.7 ? 0.05 0 ? 200 0.7979 
PASS (Lachin/Foulkes) 0.5 0.7 4 0.05 2 4 200 0.7219 
PASS (Lakatos) 0.5 0.7 4 0.05 2 4 200 0.7144 
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Technical Details 
The logrank statistic L is defined as 
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where Xi is an indicator for the control group, n1i is the number at risk in the experimental group 
just before the ith  event (death), and n2i is the number at risk in the control group just before the ith  
event (death). 

Following Freedman (1982) and Lakatos (1988), the trial is partitioned into K equal intervals. The 
distribution of L is asymptotically normal with mean E and variance V given by 

 

( )
2
1

1 1
2

1 1

1

11

⎥
⎦

⎤
⎢
⎣

⎡

+

⎟
⎠

⎜
⎝ ++

=

∑∑
= =

= =

K

k

d

i ki

ki

k i kikiki

k

E

φ
φ

φθφ
⎟
⎞

⎜
⎛

−∑∑
K d

kikiki
k φθφ

( )

 

 

( )∑∑
= =

= =

+

= K

k

d

i ki

ki

k i kiki
k

V

1 1
2

1 1

1

1

φ
φ

∑∑ +

K d
kiki

i

2θφ
θφ

 

where  

ki

ki
ki n

n

2

1=φ , 
ki

ki
ki h

h

2

1=θ

kd

kki

 

and  and h  are the hazards of dying in the treatment and control groups respectively, just 
before the ith death in the kth interval.  is the number of deaths in the kth interval. 

kih1 2ki

Next, assume that the intervals are short enough so that the parameters are constant within an 
interval. That is, so that 

, h kki h11 kki hh 22φ= kφ , ki θθ = = , =  
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The values of E and V then reduce to 
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and kρ  is the proportion of the events (deaths) that occur in interval k. 

The intervals mentioned above are constructed to correspond to a non-stationary Markov process, 
one for each group. This Markov process is defined as follows 

1,11,,1,1 −−= kkkk STS

kS ,1

1,,1 −kkT

⎥
⎤

⎢
⎡

2,,1

1,,1

k

k

s
s

⎥
⎤

⎢
⎡

2,,2

1,,2

k

k

s
s

 

where  is a vector giving the occupancy probabilities for each of the four possible states of 

the process: lost, dead, active complier, or active non-complier and  is the transition matrix 
constructed so that each element gives the probability of transferring from state j1 to state j2 in 
the treatment group. A similar formulation is defined for the control group.  

At each iteration 
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At the beginning of the trial 

where q1 is the control proportion of the total sample.  

The transition matrices may be different for each group, but this does not need to be so. Its 
elements are as follows (the first row and colu  contains labels which are not part of the actual 
matrix). 

⎥
⎤⎡ − complierNonComplierEventLostStates

where csum

eters of the population such as event rates, loss to follow-up rates, 

The parameters k

⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢

⎣

⎡

=

0

0
0

1
0,1 q

S , 

⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢

⎣

⎡

−

=

1

0,2

1
0
0
0

q

S  

mn

⎥

⎥

⎦⎢⎣ −− nknoncomp

klosskloss

sumpcomplierNon

pp

100 ,

,,

 and nsum  represent the sum of the other elements of their columns. 

⎥
⎥
⎥

⎢
⎢
⎢

−
=

−

−

kindropc

keventkeventkk

psumComplier
ppEventT

100
10

,

,2,11,,1  
⎢
⎢ Lost 01

These values 
and recruitment rates. 

represent param

φ  , kθ , and kd  are estimated from the occupancy probabilities as follows 

Events (deaths) 

2,1,12,,1,1 −−= kkk ssd  

2,1,22,,2,2 −−= kkk ssd  

Censored 

− 1,1,11,,1,1 −= kki

1,1,21,,2,2 −

ssc  

−= kki ssc  

At Risk 

( )4,1,13,1,1,1 −− += kkk ssa  

( )4,1,23,1,2,2 −− += kkk ssa  

Hazard 

kkk adh ,1,1,1 /=  

kkk adh ,2,2,2 /=  
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Finally, the interval parameters are given by 

4,1,23,1,2

4,1,13,1,1

−−

−−

+
+

=
kk

kk
k ss

ss
φ  

3,,2

3,,1

k

k
k h

h
=θ  

kkk ,2,1 ddd +=  

Power Calculation 
( )1− =Φ zα α , where ( )1. Find zα  such that Φ x  is the area under the standardized normal 

curve to the left of x. 

2. 0E and ng the two transition matrices are the same (H0). Also, 

1E and 1V different (H1) 

3. Calculate: 0Vzα+=  

4. Calculate: 

 Calculate 
calculate 

0V assumi
assuming the two transition matrices are 

0EXα

1Vβ
1E−

=  

5. 

Xαz

( )Calculate beta and power: βzβ = Φ . 

Procedure Options 
This section describes the fic to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 

options that are speci

The Data tab contains most of the parameters and options that you will be concerned with. This 
chapter covers four procedures, each of which has different effect size options. However, many of 
the options are common to all four procedures. These common options will be displayed first, 
followed by the various effect size options. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are Power and Beta, N, and {effect size}. Note that the effect size 
corresponds to the parameterization that is chosen. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  
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Select Power and Beta when you want to calculate the power.  

Error Rates 

Power (1 – Beta) 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal survival 
curves when in fact the curves are different. 

 and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
0) is also commonly used. 

A single value red here or a ra alues
entered

Alp
This op -I error occurs 
when you reject the null hypothesis of equal survival curves when in fact the curves are equal.  

Val d one. Historically, the value of 0.05 has been used for a 
two-sided test and 0.025 has been used for a one-sided test. You should pick a value for alpha that 
represents the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

Values must be between zero
power. Now, 0.90 (Beta = 0.1

may be ente nge of v  such as 0.8 to 0.95 by 0.05 may be 
.  

ha 
tion specifies one or more values for the probability of a type-I error. A type

ues of alpha must be between zero an

N (Total Sample Size) 
This is the combined sample size of both groups. This amount is divided between the two groups 

Proportion in Control Group 
ore values for the proportion of N in the control group. If this value is labeled p1 , 
 of the control group is Np1  and the sample size of treatment group is N Np− 1 . 

Effect Size (Hazard Rate) 

using the value of the Proportion in Control Group. You can enter a single value or a list of 
Sample Sizes such as 50 100 150 or 50 to 450 by 100. 

Enter one or m
the sample size
Note that the value of Np1  is rounded to the nearest integer. 

The value of 0.5 results in equal sample sizes per group. 

h1 (Hazard Rate – Control Group) 
 hazard rates (instantaneous failure rate) for the control group. For an 

 by pressing the Parameter C

Specify one or more
exponential distribution, the hazard rate is the inverse of the mean survival time. An estimate of
the hazard rate may be obtained from the median survival time or from the proportion surviving
to a certain time point. This calculation is automated

 
 

 onversion
button. 
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Hazard rates must be greater than zero. Constant hazard rates are specified by entering them 
directly. Variable hazard rates are specified as columns of the spreadsheet. When you want to 

 hazard rates for different time periods, you would enter those rates into a column 
et, one row per time period. You specify the column (or columns) by beginning 

als sign. For example, if you have entered the hazard rates in column 2, you 

0.173 

Specify one or more hazard rates (instantaneous failure rate) for the treatment group. An estimate 
may be obtained from the median survival time or from the proportion 

tain time point. This calculation is automated by pressing the Parameter 

n 
 the column (or columns) by beginning 

xample, if you have entered the hazard rates in column 3, you 

Hazard ratios must be greater than 
pical values of the hazard ratio are from 

 entering them directly. Variable hazard ratios are specified 

btained from the median survival times, from the hazard 

e 
 

 beginning your entry with an equals sign. 

For example, if you have entered the hazard ratios in column 3, you would enter =3 here. 

specify different
of the spreadshe
the entry with an equ
would enter =2 here.    

The following examples assume an exponential survival distribution. 
 

Median Survival Time Hazard Rate 

0.5 1.386 

1.0  0.693 

2.0  0.347 

3.0  0.231 

4.0  

5.0  0.139 

 

Treatment Group Parameter 
Specify which of the parameters below will be used to specify the treatment group hazard rate. 

h2 (Hazard Rate – Treatment Group) 

of the hazard rate 
surviving to a cer
Conversion button. 

Hazard rates must be greater than zero. Constant hazard rates are specified by entering them 
directly. Variable hazard rates are specified as columns of the spreadsheet. When you want to 
specify different hazard rates for different time periods, you would enter those rates into a colum
of the spreadsheet, one row per time period. You specify
the entry with an equals sign. For e
would enter =3 here.    

HR (Hazard Ratio = h2/h1) 
Specify one or more values for the hazard ratio, HR = h2/h1. 
zero. The null hypothesis is that the hazard ratio is 1.0. Ty
0.25 to 4.0. 

Constant hazard ratios are specified by
as columns of the spreadsheet. 

An estimate of the hazard ratio may be o
rates, or from the proportion surviving past a certain time point by pressing the Parameter 
Conversion button. 

When you want to specify different hazard ratios for different time periods, you would enter thos
values into a column of the spreadsheet, one row per time period. You specify the column (or
columns) by
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Effect Size (Median Survival Time) 

T1 (Median Survival Time – Control) 
Specify one or more median survival times for the control group. These values must be greater 
than zero. 

Constant median survival times are specified by entering them directly. Variable median survival 
pecify different median 

es for different time periods, you would enter those times into a column of the 
 time period. You specify the column (or columns) by beginning the 

he median survival times in column 

g examples assu val distribution. 

an Survival Time  Rate 

.0     0.347 

 

ns of the spreadsheet. When you want to specify different median 
 periods, you would enter those times into a column of the 

the hazard ratio, HR = T1/T2 = h2/h1. Hazard ratios must be 

s are specified by entering them directly. Variable hazard ratios are specified 

rd 
e point by pressing the Parameter 

times are specified as columns of the spreadsheet. When you want to s
survival tim
spreadsheet, one row per
entry with an equals sign. For example, if you have entered t
2, you would enter =2 here.    

The followin me an exponential survi
 

Medi Hazard

0.5 1.386 

1.0  0.693 

2

3.0  0.231

4.0  0.173 

5.0  0.139 

 

Treatment Group Parameter 
Specify which of the parameters below will be used to specify the treatment group median 
survival time. 

T2 (Median Survival Time – Treatment) 
Specify one or more median survival times for the treatment group. These values must be greater 
than zero. 

Constant median survival times are specified by entering them directly. Variable median survival 
times are specified as colum
survival times for different time
spreadsheet, one row per time period. You specify the column (or columns) by beginning the 
entry with an equals sign. For example, if you have entered the median survival times in column 
1, you would enter =1 here. 

HR (Hazard Ratio = T1/T2) 
Specify one or more values for 
greater than zero. The null hypothesis is that the hazard ratio is 1.0. Typical values of the hazard 
ratio are from 0.25 to 4.0. 

Constant hazard ratio
as columns of the spreadsheet. 

An estimate of the hazard ratio may be obtained from the median survival times, from the haza
rates, or from the proportion surviving past a certain tim
Conversion button. 
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When you want to specify different hazard rat
values into a column of the spreadsheet, one ro

ios for different time periods, you would enter those 
w per time period. You specify the column (or 

quals sign. columns) by beginning your entry with an e

For example, if you have entered the hazard ratios in column 3, you would enter =3 here. 

Effect Size (Proportion Surviving) 

S1 (Proportion Surviving – Control) 
Specify one or more proportions surviving for the control group. These values must be between 
zero and one. Constant proportions surviving are specified by entering them directly. The values 
represent the proportions surviving until time T0. 

heet. When you want to 
 different median survival times for different time periods, you would enter those times 

ads er time period. You specify the column (or columns) 
ou have entered the median survival 

n 2, you would enter =2 here.    

ent Group Param
ify which of the parameters below will be used to specify the proportion surviving in the 

ent group. 

roportion Surviving atment) 
 one or more proportions surviving for the treatment group. These values must be between 

ero and one. Constant proportions surviving are specified by entering them directly. The values 
ntil time T0. 

 to 
ortions surviving for different time periods, you would enter those times 

me period. You specify the column (or columns) 
 example, if you have entered the proportions 

m 

 
t. 

ay be obtained from the median survival times, from the hazard 

different hazard ratios for different time periods, you would enter those 

sponding to the proportions surviving. It must be a value greater than zero. 

Variable proportions surviving are specified as columns of the spreads
specify
into a column of the spre heet, one row p
by beginning the entry with an equals sign. For example, if y
times in colum

Treatm eter 
Spec
treatm

S2 (P  – Tre
Specify
z
represent the proportions surviving u

Variable proportions surviving are specified as columns of the spreadsheet. When you want
specify different prop
into a column of the spreadsheet, one row per ti
by beginning the entry with an equals sign. For
surviving in column 3, you would enter =3 here.    

HR (Hazard Ratio) 
Specify one or more values for the hazard ratio, HR = h2/h1. Hazard ratios must be greater than 
zero. The null hypothesis is that the hazard ratio is 1.0. Typical values of the hazard ratio are fro
0.25 to 4.0. 

Constant hazard ratios are specified by entering them directly. Variable hazard ratios are specified
as columns of the spreadshee

An estimate of the hazard ratio m
rates, or from the proportion surviving past a certain time point by pressing the Parameter 
Conversion button. 

When you want to specify 
values into a column of the spreadsheet, one row per time period. You specify the column (or 
columns) by beginning your entry with an equals sign. 

For example, if you have entered the hazard ratios in column 3, you would enter =3 here.  

T0 (Survival Time) 
This is the time corre
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When you say 0.40 survive, you must indicate the number of time periods (years) to which they 
survive. That is, you must say 40% survive over five years. For example, a value of 3 here and
proportion surviving of 0.4 means that 40% survive ove

 
r three years. 

ortion 
surviving is entered as a column because, in that case, the time period is different for each row. 
This value is only used when S1 and S2 are entered as numbers. It is not used when a prop

Effect Size (Mortality) 

M1 (Mortality – Control) 
Specify one or more mortality values for the control group. These values must be between zero 
and one. Constant mortalities are specified by entering them directly. The values represent the 

ave entered the mortalities in column 2, you 

the parameters below will be used to specify the proportion dying in the 

specified by entering them directly. The values 

entered the mortalities in column 3, you 

e null hypothesis is that the mortality ratio is 1.0. Typical values of the mortality 

ecified by entering them directly. Variable mortality ratios are 

 rates, 
ns surviving past a certain time point by pressing the Parameter Conversion 

er time period. You specify the column 

azard ratios in column 3, you would enter =3 here.  

proportions dying until time T0. 

Variable mortalities are specified as columns of the spreadsheet. When you want to specify 
different mortalities for different time periods, you would enter those times into a column of the 
spreadsheet, one row per time period. You specify the column (or columns) by beginning the 
entry with an equals sign. For example, if you h
would enter =2 here.    

Treatment Group Parameter 
Specify which of 
treatment group. 

M2 (Mortality – Treatment) 
Specify one or more mortalities (proportions dying) for the treatment group. These values must 
be between zero and one. Constant mortalities are 
represent the mortalities until time T0. 

Variable mortalities are specified as columns of the spreadsheet. When you want to specify 
different mortalities for different time periods, you would enter those times into a column of the 
spreadsheet, one row per time period. You specify the column (or columns) by beginning the 
entry with an equals sign. For example, if you have 
would enter =3 here.    

MR (Mortality Ratio = M2/M1) 
Specify one or more values for the mortality ratio, MR = M2/M1. Mortality ratios must be greater 
than zero. Th
ratio are from 0.25 to 4.0. 

Constant mortality ratios are sp
specified as columns of the spreadsheet. 

An estimate of the mortality ratio may be obtained from median survival times, from hazard
or from the proportio
button. 

When you want to specify different mortality ratios for different time periods, you would enter 
those values into a column of the spreadsheet, one row p
(or columns) by beginning your entry with an equals sign. 

For example, if you have entered the h
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T0 (Survival Time) 
This is the time corresponding to the mortality. It must be a value greater than zero. 

When you say 0.40 die, you must indicate the number of time periods (years) on which this is 

This value is only used when M1 and M2 are entered as numbers. It is not used when mortality is 
, the time period is different for each row. 

based. For example, a value of 3 here and mortality of 0.4 means that 40% die over the first three 
years. 

entered as a column because, in that case

Duration 

Accrual Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) during which 
subjects are entered into the study. The total duration of the study is equal to the Accrual Tim
plus the Follow-Up Time. These values must be integers. 

Accrual times can range from 0 to the Total Time. That is, the accrual time must be less than o
equal to the Total Time. Otherwise, the scenario is skipped. 

e 

r 

 study together. 

pattern of accrual (patient entry). Two types of entries are possible: 

riod, 

es are standardized to sum to one. Thus, the accrual pattern 0.25 0.50 0.25 
l pattern as 1 2 1 or 25 50 25. 

 
minus the Accrual Time. These values must be integers. 

Enter 0 when all subjects begin the

Accrual Pattern 
This contains the 

• Uniform 
If you want to specify a uniform accrual rate for all time periods, enter Equal here. 

• Non-Uniform 
When you want to specify accrual patterns with different accrual proportions per time pe
you would enter the pattern into a column of the spreadsheet, one row per time period and 
specify the column, or columns, here, beginning your entry with an equals sign. For example, 
if you have entered accrual patterns in columns 4 and 5, you would enter =C4 C5. 

Note that these valu
would result in the same accrua

Total Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) in the study. The
follow-up time is equal to the Total Time 

Proportion Lost or Switching Groups 

Controls (or Treatment) Lost 
This is the proportion of subjects in the control (treatment) group that disappear from the study 

t time periods, you would enter those 
 the 

spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 5, you would enter =C5 here. 

during a single time period (month, year, etc.). Multiple entries, such as 0.01 0.03 0.05, are 
allowed. 

When you want to specify different proportions for differen
rates into a column of the spreadsheet, one row per time period. You specify the column of



715-14  Logrank Tests (Lakatos) 

Controls Switching to Treatments 
e similar in 

s 

ou want to specify different proportions for different time periods, you would enter those 

 Switching to Controls 
oportion of subjects in the treatment group that change to a treatment regime similar 

ng a single time period (month, year, etc.). This is sometimes 

e 
period. You specify the column of the 

This is the proportion of subjects in the control group that change to a treatment regim
efficacy to the treatment group during a single time period (month, year, etc.). This is sometime
referred to as drop in. Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When y
values into a column of the spreadsheet, one row per time period. You specify the column of the 
spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 1, you would enter =C1 here. 

Treatments
This is the pr
in efficacy to the control group duri
referred to as noncompliance. Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter thos
values into a column of the spreadsheet, one row per time 
spreadsheet by beginning your entry with an equals sign. For example, if you have entered the 
proportions in column 2, you would enter =C2 here. 

Test 

Alternative 
Specify whether the statistical test is two-sided or one-sided.  

• 
This option tests whether the two hazards rates, median survival times, survival proportions, 

e different (H1: h1<>h2). This is the option that is usually selected. 

• 

azard rate 

ou should divide your alpha level by two. 

Two-Sided 

or mortalities ar

One-Sided 
When this option is used and the value of h1 is less than h2, rejecting the null hypothesis 
results in the conclusion that the control hazard rate (h1) is less than the treatment h
(h2). When h1 is greater than h2, rejecting the null hypothesis results in the conclusion that 
the control hazard rate (h1) is greater than the treatment hazard rate (h2).  

When you use a one-sided test, y

Reports Tab 
The Reports tab contains additional settings for this procedure.  

Report Column Width 

Report Column Width 
This option sets the width of the each column of the numeric report. 

The numeric report for this option necessarily contains many columns, so the maximum number 

r 

of decimal places that can be displayed is four. If you try to increase that number, the numbers 
may run together. You can increase the width of each column using this option. 

The recommended report column width for scenarios without large numbers of decimal places o
extremely large sample sizes is 0.49. 
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Options Tab 
The Options tab contains additional settings for this procedure.  

Options 

Number of Intervals within a Time Period 
The algorithm requires that each time period be partitioned into a number of equal-width 
intervals. Each of these subintervals is assumed to follow an exponential distribution. This option 

arameters such as hazard rates, loss to follow-up rates, 

rk when the 

o 5000 or even 10000. 

 

controls the number of subintervals. All p
and noncompliance rates are assumed to be constant within a subinterval. 

Lakatos (1988) gives little input as to how the number of subintervals should be chosen. In a 
private communication, he indicated that 100 ought to be adequate. This seems to wo
hazard is less than 1.0.  

As the hazard rate increases above 1.0, this number must increase. A value of 2000 should be 
sufficient as long as the hazard rates (h1 and h2) are less than 10. When the hazard rates are 
greater than 10, you may want to increase this value t

Example 1 – Finding the Power using Proportion 
Surviving 
A researcher is planning a clinical trial usi
design to compar

ng a parallel, two-group, equal sample allocation 
e the survivability of a new treatment with that of the current treatment. The 

prop
ado rent 
treatment. The researcher wishes to determine the power of the logrank test to detect a difference 

 the true proportion surviving in the new treatment group at one year is 0.70. To 
obta er 
also

The
for ormly over the 
accr  in both the 

ental groups. Past experience has lead to estimates of noncompliance and 
%, respectively. 

en 50 and 250 at a significance 
level of 0.05.   

ortion surviving one-year after the current treatment is 0.50. The new treatment will be 
pted if the proportion surviving after one year can be shown to be higher than the cur

in survival when
in a better understanding of the relationship between power and survivability, the research
 wants to see the results when the proportion surviving is 0.65 and 0.75.   

 trial will include a recruitment period of one-year after which participants will be followed 
an additional two-years. It is assumed that patients will enter the study unif
ual period. The researcher estimates a loss-to-follow-up rate of 5% per year

control and the experim
drop in of 4% and 3

The researcher decides to investigate various sample sizes betwe
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lakatos) [Proportion Surviving] procedure 

xpanding Survival, then Logrank, then clicking on Lakatos, and then clicking on 
ests (Lakatos) [Proportion Surviving]. You may then make the appropriate entries 

e File menu and choosing Open Example 

window by e
Logrank T
as listed below, or open Example 1 by going to th
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 50 to 250 by 50 

2 ............................................................ 0.65 0.70 0.75 
0 ............................................................ 1 

.................................... 3 

Proportion in Control Group .................... 0.5 
S1 ............................................................ 0.50 
Treatment Group Parameter ................... S2 
S
T
Accrual Time ........................................... 1 
Accrual Pattern ........................................ Equal 
Total Time ...........
Proportion of Controls Lost ..................... 0.05 
Proportion of Treatment Lost .................. 0.05 
Proportion of Controls Switch ................. 0.03 
Proportion of Treatment Switch .............. 0.04 
Alternative Hypothesis ............................ Two-Sided 

Reports Tab 
Show Detail Numeric Reports ................. Checked 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results in Terms of Sample Size when the Test is Two-Sided and T0 is 1 
 
        Acc-       
 Trt      Ctrl rual       
    Haz Prop Prop  Time/   Ctrl Trt    Acc-
    Ratio Surv Surv rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (S1) (S2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.2608 25 25 50 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .7392 
.4615 50 50 100 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .5385 
.6262 75 75 150 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .3738 
.7500 100 100 200 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .2500 
.8378 125 125 250 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1622 
.4320 25 25 50 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .5680 
.7162 50 50 100 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .2838 
.8732 75 75 150 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1268 
.9477 100 100 200 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0523 
.9796 125 125 250 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0204 
.6293 25 25 50 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .3707 
.9010 50 50 100 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0990 
.9784 75 75 150 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0216 
.9959 100 100 200 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0041 
.9993 125 125 250 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0007 
 
References 
Lakatos, Edward. 1988. 'Sample Sizes Based on the Log-Rank Statistic in Complex Clinical Trials', Biometrics, 
Volume 44, March, pages 229-241. 
Lakatos, Edward. 2002. 'Designing Complex Group Sequential Survival Trials', Statistics in Medicine, Volume 
21, pages 1969-1989. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Power should be close to one. 
N1|N2|N are the sample sizes of the control grou oup, and both groups, respectively. p, treatment gr
E1|E2|E are the number of events in the control group, treatment group, and both groups, respectively. 
Hazard Ratio (HR) is the treatment group's hazard rate divided by the control group's hazard rate. 
Proportion Surviving is the proportion surviving past time T0. 
Accrual Time is the number of time periods (years or months) during which accrual takes place. 
Total Time is the total number of time periods in the study. Follow-up time = (Total Time) - (Accrual Time). 
Ctrl Loss is the proportion of the control group that is lost (drop out) during a single time period (year or 
month). 
Trt Loss is the proportion of the treatment group that is lost (drop out) during a single time period (year or 
month). 
Ctrl to Trt (drop in) is the proportion of the control group that switch to a group with a hazard rate equal 
to the treatment group. 
Trt to Ctrl (noncompliance) is the proportion of the treatment group that switch to a group with a hazard rate 
equal to the control group. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 

 

This report shows the values of each of the parameters, one scenario per row. In addition to the 
parameters that were set on the template, the hazard ratio is displayed. 
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Next, a report displaying the number of required events rather than the sample size is displayed. 
 
Numeric Results in Terms of Events when the Test is Two-Sided and T0 is 1 
        Acc-       
     Ctrl Trt  rual       
 Ctrl Trt Total Haz Prop Prop Acc- Time/   Ctrl Trt   
 Evts Evts Evts Ratio Surv Surv rual Total Ctrl Trt to to   
Power E1 E2 E (HR) (S1) (S2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.2608 19.5 15.8 35.2 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .7392 
.4615 31.6 70.5 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .5385 38.9 
.6262  47.4 105.7 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .3738 58.4
.7500  63.1 140.9 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .2500 77.8
.8378  78.9 176.2 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1622 97.3
.4320  14.2 33.6 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .5680 19.4
.7162 38.8 8.4 .2 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .2838 2 67
.8732 8.2 2.7 1 0.9 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1268 5 4 0
.9477 7.6 6.9 134.5 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0523 7 5
.9796 7.0 1.1 168.1 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0204 9 7
.6293 19.4 12.5 31.8 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .3707 
.9010 38.7 25.0 63.7 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0990 
.9784 8.1 7.5 5.5 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0216 5 3 9
.9959 7.4 9.9 127.4 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0041 7 4
.9993 6.8 2.4 159.2 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0007 9 6
 

M th p  i e 
nu
Next, reports display

ost of is re ort is dentical to the last report, except that the sample sizes are replaced by th
mber of required events. 

ing the individual settings year-by-year for each scenario are displayed. 
 
Detailed Input when Power=.2608  N1=25  N2=25  N=50  Alpha=.0500  Accrual/Total Time=1 / 3 
          
 Control Treatment Hazard  Percent   Control Treatment 
 Prop Prop Ratio Percent Admin. Control Treatment to to 
Time Surviving Surviving (HR) Accrual Censored Loss Loss Treatment Control 
Period (.5000) (.6500) (.6215) (Equal) (Calc.) (.0500) (.0500) (.0300) (.0400) 
1 .5000 .6500 .7692 100.00 .00 .0500 .0500 .0300 .0400 
2 .5000 .6500 .7692 .00 .00 .0500 .0500 .0300 .0400 
3 .5000 .6500 .7692 .00 100.00 .0500 .0500 .0300 .0400 
 

T e period (year). It becomes very useful when 
yo
O ame for 
ea ase as time 
passes. The reason that these stay the same is that this proportion surviving was entered as a 
si s 1.0), not 
th an be 
id

N

his report shows the individual settings for each tim
u want to document a study in which these parameters vary from year to year. 

ne subtle point should be mentioned here. Note that the proportion surviving is the s
ch of the three years. Obviously, if deaths occur, the proportion surviving must decre

ngle value. Hence, it is converted to a hazard rate using T0 (which in this example i
e row number. Since the power is based on the hazard rates, the proportions surviving c
entical. 

ext, summary statements are displayed. 
 
Summary Statements 
A two-sided logrank test with an overall sample size of 50 subjects (25 in the control group 
and 25 in the treatment group) achieves 26.1% power at a 0.050 significance level to detect a 
hazard ratio of 0.6215 when the proportion surviving in the control group is 0.5000. The study 
lasts for 3 time periods of which subject accrual (entry) occurs in the first time period. The 
proportion dropping out of the control group is 0.0500. The proportion dropping out of the 
treatment group is 0.0500. The proportion switching from the control group to another group 
with a hazard ratio equal to that of the treatment group is 0.0300. The proportion switching 
from the treatment group to another group with a hazard equal to that of the control group is 
is 0.0400. 
 



Logrank Tests (Lakatos)  715-19 

Finally, a scatter plot of the results is displayed. 

Plots S tion ec
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This plot shows the relationship between sample size and power for the three values of S2. Note 
nd 

in Example 2.  

E

that for 90% power, a total sample size of about 160 is required. The exact number will be fou

xample 2 – Finding the Sample Size 
C
necessary t
E 1.

ontinui with the previous example, the researcher wants to investigate the sample sizes ng 
o achieve 80% and 90% power. All other parameters will remain the same as in 

xample  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lakatos) [Proportion Surviving] procedure 
window by expanding Survival, then Logrank, then clicking on Lakatos, and then clicking on 
Logrank Tests (Lakatos) [Proportion Surviving]. You may then make the appropriate entries 
as listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 

Option Value 
D
F
P
A
N  
P
S
Treatment Group Parameter ................... S2 

ata Tab 
ind (Solve For) ...................................... N (Total Sample Size) 
ower ...................................................... 0.80 0.90 
lpha ....................................................... 0.05 
 (Total Sample Size) ............................. Ignored since this is the Find setting
roportion in Control Group .................... 0.5 
1 ............................................................ 0.50 
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Data Tab (continued) 
S2 ............................................................ 0.65 0.70 0.75 

................................... 1 

................................... 1 
crual Pattern ........................................ Equal 

Total Time ............................................... 3 
Proportion of Controls Lost ..................... 0.05 
Proportion of Treatment Lost .................. 0.05 
Proportion of Controls Switch ................. 0.03 
Proportion of Treatment Switch .............. 0.04 
Alternative Hypothesis ............................ Two-Sided 

Output 

T0 .........................
ccrual Time ........A

Ac

Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results in Terms of Sample Size when the Test is Two-Sided and T0 is 1 
 
        Acc-       
     Ctrl Trt  rual       
    Haz Prop Prop Acc- Time/   Ctrl Trt   
    Ratio Surv Surv rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (S1) (S2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.9002 151 152 303 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0998 
.8014 113 114 227 .6215 .5000 .6500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1986 
.9004 82 82 164 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0996 
.8019 61 62 123 .5146 .5000 .7000 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1981 
.9010 50 50 100 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .0990 
.8022 37 38 75 .4150 .5000 .7500 Equal 1 / 3 .0500 .0500 .0300 .0400 .0500 .1978 
 

To
ta

l N

 
 

The total sample size need to achieve 90% power when the proportion surviving with the new 
ize) increases, the treatment is 0.70, is 164. It is apparent that as the proportion surviving (effect s

sample size decreases. 
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Example 3 – Validation using Lakatos 
Lakatos (1988) pages 231-234 presents an example that will be used to validate this procedure. In 

. All subjects begin the trial together, so there is no 
or the control and treatment groups, respectively. 

 in both groups. Noncompliance and drop-in rates are 
ower is set to 90%. A two-sided logrank test with 

ample to both control and experiment 
f 139.   

this example, a two-year trial is investigated
accrual period. The hazard rates are 1.0 and 0.5 f
The yearly loss to follow-up is 3% per year
assumed to be 4% and 5%, respectively. The p
alpha set to 0.05 is assumed. Equal allocation of the s
groups is used. Lakatos obtains a sample size o

Setup 
This section presents the values of each 
the PASS H

of the parameters needed to run this example. First, from 
ome window, load the Logrank Tests (Lakatos) [Hazard Rate] procedure window 

on Logrank 
r 

open Example 3 by going to the File menu and choosing Open Example Template. 

by expanding Survival, then Logrank, then clicking on Lakatos, and then clicking 
Tests (Lakatos) [Hazard Rate]. You may then make the appropriate entries as listed below, o

Option Value 
D
F .....
P .....
A .....
N l
P
h1 .. ... .
T
h2 .. ... ..
A ........................................... 0 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 2 
Proportion of Controls Lost ..................... 0.03 
Proportion of Treatment Lost .................. 0.03 
Proportion of Controls Switch ................. 0.04 
Proportion of Treatment Switch .............. 0.05 
Alternative Hypothesis ............................ Two-Sided 

ata Tab 
ind ...... .............................................. N 
ower ... .............................................. 0.90 
lpha .... .............................................. 0.05 
 (Total Samp  Size ............................ Ignored since this is the Find setting e ) .
roportion in Control Group .................... 0.5 
 ......... ....... ....... ............................... 1.0 

reatment Group Parameter ................... h2 
 ......... ....... ....... .............................. 0.5 

ccrual Time 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results in Terms of Sample Size when the Test is Two-Sided and T0 is 1 
 
        Acc-       
     Ctrl Trt  rual       
    Haz Haz Haz Acc- Time/   Ctrl Trt   
    Ratio Rate Rate rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (h1) (h2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.9014 69 70 139 .5000 1.00 .5000 Equal 0 / 2 .0300 .0300 .0400 .0500 .0500 .0986 

 

The total sample size of 139 matches the value published in Lakatos’ article.  

Example 4 – Inputting Time-Dependent Hazard Rates 
from a Spreadsheet  

ple shows how time-dependent hazard rates and other parameters can be input directly 

ed treatment will cut the hazard rate in half, when 
g of the 

 sample size 
h 90% power. 

te immediately following either treatment (during the 
the second year, and then gradually increases. Fifty 
lled during the first year, followed by 25% each of 

e-dependent parameters for the 5-

This exam
from a spreadsheet.  

A pre-trial study indicates that a newly develop
compared to the current treatment. A 5-year trial is being designed to confirm the findin
pre-trial study. The goal for this portion of the study design is to determine the
needed to detect a decrease in hazard rate wit

The pre-trial study showed that the hazard ra
first year) is high, drops considerably during 

opercent of the study participants will be enr
the second and third years. The following table shows the tim
year trial, based on the pre-trial study. 
 

PRETRIAL dataset 

Year H1 Ls1 Ls2 NCom Acc 
1 0.08 0.04 0.06 0.04 50 
2 0.04 0.04 0.06 0.04 25 
3 0.05 0.05 0.07 0.05 25 
4 0.06 0.06 0.07 0.06  
5 0.07 0.07 0.08 0.07  

 

The column H1 refers to the anticipated hazard rates for each of the five years. Ls1 and Ls2 refer 
to the proportions lost to follow-up in the control group and the treatment group, respectively. 
The proportion that are noncompliant are also expected to increase after the second year 
according the proportions shown. The final column specifies the accrual rate as outlined in the 
previous paragraph. 

Following the 5-year trial, a two-sided logrank test with alpha equal to 0.05, will be used to 
determine the evidence of difference among the current and new treatments.  
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lakatos) [Hazard Rate] procedure window 

, then Logrank, then clicking on Lakatos, and then clicking on Logrank 
. You may then make the appropriate entries as listed below, or 

op  Template. You can see 
that the values have been loaded into the spreadsheet by clicking on the spreadsheet button. 

O

by expanding Survival
Tests (Lakatos) [Hazard Rate]

en Example 4 by going to the File menu and choosing Open Example

ption Value 
D  
F r

ower ...................................................... 0.90 

N (Total Sample Size) ............................. Ignored since this is the Find setting 
Proportion in Control Group .................... 0.5 

...... 0.5 

 

ata Tab
ind (So e Fo  ...................................... N lv )

P
Alpha ....................................................... 0.05 

h1 ............................................................ =H1 
Treatment Group Parameter ................... HR (Hazard Ratio = h2/h1) 
HR .....................................................
Accrual Time ........................................... 3 
Accrual Pattern ........................................ =Acc 
Total Time ............................................... 5
Proportion of Controls Lost ..................... =Ls1 
Proportion of Treatment Lost .................. =Ls2 
Proportion of Controls Switch ................. 0.02 
Proportion of Treatment Switch .............. =NCom 
Alternative Hypothesis ............................ Two-Sided 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results in Terms of Sample Size when the Test is Two-Sided 
Using Spreadsheet: C:\PASS2008\DATA\PRETRIAL.S0 
        Acc-       
 Trt      Ctrl rual       
    Haz Haz Haz  Time/   Ctrl Trt   Acc-
    Ratio Rate Rate rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (h1) (h2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.9001 418 419 837 .5000 H1 Calc. Acc 3 / 5 Ls1 Ls2 .0200 NCom .0500 .0999 
 
 
Numeric Results in Terms of Events when the Test is Two-Sided 
Using Spreadsheet: C:\PASS2008\DATA\PRETRIAL.S0 
        Acc-       
     Ctrl Trt  rual       
 Ctrl Trt Total Haz Haz Haz Acc- Time/   Ctrl Trt   
 Evts Evts Evts Ratio Rate Rate rual Total Ctrl Trt to to   
Power (E1) (E2) (E) (HR) (h1) (h2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.9001 74.4 41.2 115.6 .5000 H1 Calc. Acc 3 / 5 Ls1 Ls2 .0200 NCom .0500 .0999 
 
 
Detailed Input when Power=.9001  N1=418  N2=419  N=837  Alpha=.0500  Accrual/Total Time=3 / 5 
Using Spreadsheet: C:\PASS2008\DATA\PRETRIAL.S0 
 
 Control Treatment Hazard  Percent   Control Treatment 
 Hazard Hazard Ratio Percent Admin. Control Treatment to to 
Time Rate Rate (HR) Accrual Censored Loss Loss Treatment Control 
Period (H1) (Calc.) (.5000) (Acc) (Calc.) (Ls1) (Ls2) (.0200) (NCom) 
1 .0800 .0400 .5000 50.00 .00 .0400 .0600 .0200 .0400 
2 .0400 .0200 .5000 25.00 .00 .0400 .0600 .0200 .0400 
3 .0500 .0250 .5000 25.00 25.00 .0500 .0700 .0200 .0500 
4 .0600 .0300 .5000 .00 33.33 .0600 .0700 .0200 .0600 
5 .0700 .0350 .5000 .00 100.00 .0700 .0800 .0200 .0700 
 
Summary Statements 
A two-sided logrank test with an overall sample size of 837 subjects (418 in the control group 
and 419 in the treatment group) achieves 90.0% power at a 0.050 significance level to detect a 
hazard ratio of 0.5000 when the control group hazard rate is given in column H1. The study 
lasts for 5 time periods of which subject accrual (entry) occurs in the first 3 time periods. 
The accrual pattern across time periods is given in column Acc. The proportion dropping out of 
the control group is given in column Ls1. The proportion dropping out of the treatment group 
is given in column Ls2. The proportion switching from the control group to another group with 
a hazard rate equal to the treatment group is 0.0200. The proportion switching from the 
treatment group to another group with a hazard rate equal to the control group is given in 
column NCom. 
 

For the 5-year study, the total sample size needed to detect a change in hazard rate, if the true 
hazard ratio is 0.5, is 837 subjects.  
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Example 5 – Finding the Power using Median Survival 
Time 
A researcher is planning a clinical trial usi
design to compare the s

ng a parallel, two-group, equal sample allocation 
urvivability of a new treatment with that of the current treatment. The 

median survival time for the curre w treatment will be adopted if 
th rrent treatment. Because the true 
m
te tec
2.0, 2.5, or 3

T d 
for an additional two years. It is assumed that patients will enter the study uniformly over the 
ac te of 4% per year in both the control 
an ates of noncompliance and drop in 
of d 5

T
le

S

nt treatment is 1.6 years. The ne
er than the cue median survival time can be shown to be high

urvedian s ival time is unknown, the researcher wishes to determine the power of the logrank 
st to de t a difference in survival when the true median survival time for the new treatment is 

.0 years.  

he trial will clud  a recruitme t period of one y ar, af r wh h participants will be followe in e n e te ic

crual period. The researcher estimates a loss-to-follow ra
lead to estimd the experimental groups. Past experience has 

 6% an %, respectively. 

he researcher decides to investigate various sample sizes between 50 and 200 at a significance 
vel of 0.05.   

etup 
This section presents the values of each ters needed to run this example. First, from 
th
pr
cl
ap te
O am

O

of the parame
e PASS Home window, load the Logrank Tests (Lakatos) [Median Survival Time] 
ocedure window by expanding Survival, then Logrank, then clicking on Lakatos, and then 
icking on Logrank Tests (Lakatos) [Median Survival Time]. You may then make the 
propria  entries as listed below, or open Example 5 by going to the File menu and choosing 
pen Ex ple Template. 

ption Value 
D
F
P
A
N
P
T
T p Parameter ................... T2 
T2 ............................................................ 2.0 2.5 3.0 

....... Equal 
Total Time ............................................... 3 
Proportion of Controls Lost ..................... 0.04 
Proportion of Treatment Lost .................. 0.04 
Proportion of Controls Switch ................. 0.05 
Proportion of Treatment Switch .............. 0.06 
Alternative Hypothesis ............................ Two-Sided 

ata Tab 
ind (Solve For) ...................................... Power and Beta 
ower ...................................................... Ignored since this is the Find setting 
lpha ....................................................... 0.05 
 (Total Sample Size) ............................. 50 to 200 by 50 
roportion in Control Group .................... 0.5 
1 ............................................................ 1.6 
reatment Grou

Accrual Time ........................................... 1 
Accrual Pattern .................................
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
  

Numeric Results in Terms of Sample Size when the Test is Two-Sided 
 
     Ctrl Trt  Acc-       
     Med Med  rual       
    Haz Surv Surv Acc- Time/   Ctrl Trt   
    Ratio Time Time rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (M1) (M2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
0.0839 25 25 50 0.8000 1.60 2.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.9161 
0.1191 50 50 100 0.8000 1.60 2.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.8809 
0.1549 75 75 150 0.8000 1.60 2.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.8451 
0.1911 100 100 200 0.8000 1.60 2.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.8089 
0.1792 25 25 50 0.6400 1.60 2.50 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.8208 
0.3125 50 50 100 0.6400 1.60 2.50 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.6875 
0.4379 75 75 150 0.6400 1.60 2.50 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.5621 
0.5495 100 100 200 0.6400 1.60 2.50 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.4505 
0.2921 25 25 50 0.5333 1.60 3.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.7079 
0.5188 50 50 100 0.5333 1.60 3.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.4812 
0.6928 75 75 150 0.5333 1.60 3.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.3072 
0.8130 100 100 200 0.5333 1.60 3.00 Equal 1 / 3 0.0400 0.0400 0.0500 0.0600 0.0500 0.1870 
 
 
 

  
  

This plot shows the relationship between sample size and power for the three median survival 
times. 
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Example 6 – Finding the Power using Mortality 
A researcher is planning a clinical trial using a parallel, two-group, equal sample allocation 
design to compare the mortality rate of a new treatment with that of the current treatment. The 

urrent treatment is 0.40. The new treatment will be adopted if 
n to be lower than the current treatment. The 

re detect a difference in mortality 
when the true m

T wi
fo diti
ac  es l 
and the experim e p in 
of , r e

T a r d de i l ce 
le .   

Setup 

mortality rate at one-year after the c
lity rate after one year can be showthe morta

searcher wishes to determine the power of the logrank test to 
ortality rate in the new treatment group at one year is 0.20, 0.25, or 0.30.  

he trial ll include a recruitment period of one year, after which participants will be followed 
r an ad onal two years. It is assumed that patients will enter the study uniformly over the 
crual period. The r earcher estimates a loss-to-follow rate of 5% per year in both the contro

ental groups. Past experience has l ad to estimates of noncompliance and dro
 3% and 4% esp ctively. 

he rese rche eci s to invest gate various samp e sizes between 50 and 250 at a significan
vel of 0 05. 

T r s  o h rom 
the PASS Home window, load the Logrank Tests (Lakatos) [Mortality] procedure window by 
expanding Survival, then Logrank, then clicking on Lakatos, and then clicking on Logrank 
Tests (Lakatos) [Mortality]. You may then make the appropriate entries as listed below, or open 
Example 6 by going to the File menu and choosing Open Example Template. 

Option

his section p esent  the values f eac  of the parameters needed to run this example. First, f

 Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Total Sample Size) ............................. 50 to 250 by 50 
Proportion in Control Group .................... 0.5 
M1 ........................................................... 0.4 
Treatment Group Parameter ................... M2 
M2 ........................................................... 0.20 0.25 0.30 
T0 (Survival Time) ................................... 1 
Accrual Time ........................................... 1 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 3 

roportion of Controls Lost ..................... 0.05 
n of Treatment Lost .................. 0.05 

ion of Treatment Switch .............. 0.03 
Alternative Hypothesis ............................ Two-Sided 

P
Proportio
Proportion of Controls Switch ................. 0.04 
Proport
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

Numeric Results in Terms of Sample Size when the Test is Two-Sided and T0 is 1 
 
        Acc-       
        rual       
    Mort Ctrl Trt Acc- Time/   Ctrl Trt   
    Ratio Mort Mort rual Total Ctrl Trt to to   
Power N1 N2 N (MR) (M1) (M2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.5079 25 25 50 .5000 .4000 .2000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .4921 
.8044 50 50 100 .5000 .4000 .2000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .1956 
.9332 75 75 150 .5000 .4000 .2000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .0668 
.9794 100 100 200 .5000 .4000 .2000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .0206 
.9941 125 125 250 .5000 .4000 .2000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .0059 
.2988 25 25 50 .6250 .4000 .2500 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .7012 
.5281 50 50 100 .6250 .4000 .2500 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .4719 
.7021 75 75 150 .6250 .4000 .2500 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .2979 
.8207 100 100 200 .6250 .4000 .2500 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .1793 
.8961 125 125 250 .6250 .4000 .2500 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .1039 
.1529 25 25 50 .7500 .4000 .3000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .8471 
.2597 50 50 100 .7500 .4000 .3000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .7403 
.3635 75 75 150 .7500 .4000 .3000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .6365 
.4603 100 100 200 .7500 .4000 .3000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .5397 
.5479 125 125 250 .7500 .4000 .3000 Equal 1 / 3 .0500 .0500 .0400 .0300 .0500 .4521 
 

P
ow

er

  
 

This plot shows the relationship between sample size and power for the three mortality rates. 
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Example 7 – Converting Years to Months  
A researcher is planning a clinical trial using a parallel, two-group, equal sample allocation 
design to compare the hazard rate of a new treatment with that of the current treatment. The 

 is 0.14. The new treatment will be adopted if the hazard rate 
treatment. The researcher wishes to determine the 

po t of 0.4, 0.5, and 0.6.  

T wi
fo  fo
un  o
ye o
no l e 

T e 
le

B n g 
in o r s ing 
th s

 

hazard rate for the current treatment
fter can be shown to be lower than the current a

wer of the logrank test to detect true hazard ratios for the new treatmen

he trial ll include a recruitment period of four months, after which participants will be 
llowed r an additional year and 8 months. It is assumed that patients will enter the study 
iformly ver the accrual period. The researcher estimates a loss-to-follow proportion of 4% per 
ar in both the contr l and the experimental groups. Past experience has lead to estimates of 
ncomp ianc and drop in of 3% each. 

he researcher decides to investigate various sample sizes between 50 and 350 at a significanc
vel of 0.05. 

efore e terin the values into the Logrank Test (Hazard Ratio) window, the values stated above 
 terms f yea s mu t be converted to the corresponding monthly values. This can be done us
e Proportion  (Years to Months) tab of the Survival Parameter Conversion Tool. 
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The number of sub time units in one main time unit is 12, since there are 
yearly proportion 0.04 corresponding to the loss-to-follow 4% is converte

12 months in a year. The 
d to the monthly value 

early of 0.00339605319892 using the relationship P(annual) = 1-(1-P(monthly))12. Similarly, the y
noncompliance and drop in values of 3% are converted to the monthly value of 
0.00253504861384. The annual hazard rate of 0.14 is converted to the monthly hazard rate of 
0.01166666666667 using the relationship R(monthly) = R(annual)/12. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logrank Tests (Lakatos) [Hazard Rate] procedure windo
by expanding Survival, then Logrank, th

w 
en clicking on Lakatos, and then clicking on Logrank 

Tests (Lakatos) [Hazard Rate]. You may then make the appropriate entries as listed below, or 
open Example 7 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
P
Alpha ....................................................... 

ower ...................................................... Ignored since this is the Find setting 
0.05 

N (Total Sample Size) ............................. 50 to 350 by 50 
Proportion in Control Group .................... 0.5 
h1 ............................................................ 0.01166666666667 
Treatment Group Parameter ................... HR (Hazard Ratio = h2/h1) 
HR ........................................................... 0.4 0.5 0.6 
Accrual Time ........................................... 4 
Accrual Pattern ........................................ Equal 
Total Time ............................................... 24 
Proportion of Controls Lost ..................... 0.00339605319892 
Proportion of Treatment Lost .................. 0.00339605319892 
Proportion of Controls Switch ................. 0.00253504861384 
Proportion of Treatment Switch .............. 0.00253504861384 
Alternative Hypothesis ............................ Two-Sided 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 
Numeric Results in Terms of Sample Size when the Test is Two-Sided 
        Acc-       
     Ctrl Trt  rual       
    Haz Haz Haz Acc- Time/   Ctrl Trt   
    Ratio Rate Rate rual Total Ctrl Trt to to   
Power N1 N2 N (HR) (h1) (h2) Pat'n Time Loss Loss Trt Ctrl Alpha Beta 
.1922 25 25 50 .4000 .0117 .0047 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .8078 
.3610 50 50 100 .4000 .0117 .0047 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .6390 
.5157 75 75 150 .4000 .0117 .0047 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .4843 
.6453 100 100 200 .4000 .0117 .0047 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .3547 
.7474 125 125 250 .4000 .0117 .0047 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .2526 
.8243 150  Equal 4 150 300 .4000 .0117 .0047 / 24 .0034 .0034 .0025 .0025 .0500 .1757 
.8802 175 47 Equal 175 350 .4000 .0117 .00 4 / 24 .0034 .0034 .0025 .0025 .0500 .1198 
.1407 58 Equal 25 25 50 .5000 .0117 .00 4 / 24 .0034 .0034 .0025 .0025 .0500 .8593 
.2473 50 50 100 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .7527 
.3530 75 75 150 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .6470 
.4526 100 100 200 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .5474 
.5431 125 125 250 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .4569 
.6232 150 150 300 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .3768 
.6926 175 175 350 .5000 .0117 .0058 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .3074 
.1037 25 25 50 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .8963 
.1656 50 50 100 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .8344 
.2287 75 75 150 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .7713 
.2915 100 100 200 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .7085 
.3529 125 125 250 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .6471 
.4120 150 150 300 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .5880 
.4683 175 175 350 .6000 .0117 .0070 Equal 4 / 24 .0034 .0034 .0025 .0025 .0500 .5317 
 
 

  
 

This plot shows the relationship between sample size and power for the three hazard ratios. 
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Chapter 800 

Inequality Tests 
for One 
Correlation 
Introduction 
The correlation coefficient, ρ  (rho), is a popular statistic for describing the strength of the 
relationship between two variables. The correlation coefficient is the slope of the regression line 
between two variables when both variables have been standardized by subtracting their means 
and dividing by their standard deviations. The correlation ranges between plus and minus one.  

When ρ  is used as a descriptive statistic, no special distributional assumptions need to be made 
about the variables (Y and X) from which it is calculated. When hypothesis tests are made, you 
assume that the observations are independent and that the variables are distributed according to 
the bivariate-normal density function. However, as with the t-test, tests based on the correlation 
coefficient are robust to moderate departures from this normality assumption. 

The population correlation ρ  is estimated by the sample correlation coefficient r. Note we use 
the symbol R on the screens and printouts to represent the population correlation. 

Difference between Linear Regression and Correlation 
The correlation coefficient is used when both X and Y are from the normal distribution (in fact, 
the assumption actually is that X and Y follow a bivariate normal distribution). The point is, X is 
assumed to be a random variable whose distribution is normal. In the linear regression context, no 
statement is made about the distribution of X. In fact, X is not even a random variable. Instead, it 
is a set of fixed values such as 10, 20, 30 or -1, 0, 1. Because of this difference in definition, we 
have included both Linear Regression and Correlation algorithms. This module deals with the 
Correlation (random X) case.  

Test Procedure 
The testing procedure is as follows.  is the null hypothesis that the true correlation is a 
specific value, 

H0

ρ0  (usually, ρ0 0= ).  represents the alternative hypothesis that the actual HA

. Choose a value , based on the Rαcorrelation of the population is ρ1 , which is not equal to ρ0
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distribution of the sample correlation coefficient, so that the probability of rejecting H0  when 
H0  is true is equal to a specified value, α . Select a sample of n items from the popu on and

pute the sample correlation coefficient, rS . If r RS > α  reject the null hypothesis that 
lati  

com ρ ρ= 0

in favor of an alternative hypothesis that 
 

ρ ρ= 1 , where ρ ρ1 0> . The power is the probab  
rejecting H0  when the true correlation is 

ility of
ρ1 . 

All calcul ns are based on the algorithmatio  described by Guenther (1977) fo

Calculating the Power 

r calculating the 
cumulative correlation coefficient distribution. 

Let ( )R r N| ,ρ  represent the area under e to the left of r. N is the sample  a correlation density curv
ρ  issize and  the population correlation. The power of the significance test of ρ ρ1 0> is 

calculated as follows: 

1.  Find rα  such that

low for the t-test. First find the 

 1 R r Nα | ,( )0− =

N

ρ α

( )1ρ

the same pattern as 

. 

2.  Compute the power = | , . 1− R rα

Notice that the calculations fol rejection region 
by finding the critical value ( rα ) under the null hypothesis. Next, calculate the probability that a 
sample of size N drawn from e population defined by setting the correlation to th ρ1  is in this 
rejection region. This is the power. 

Procedure Options 
This section describes the options that a this procedure. These are lo

Data Tab 

re specific to cated on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

The Data tab contains most of the parameters u will be concerned with. 

Solve For 

 and options that yo

Find (Solve For) 
 the parameter to be calculated from the values of the other 

e a given po

and Beta when yo

This option specifies parame

wer a

ters. 

nd alpha 

Under most conditions, you would either select Power and Beta or N. 

Select N when you want to determine the sample size needed to achiev
error level.  

Select Power u want to calculate the power.  
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal 
correlations when in fact they are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis of equal correlations when in fact they are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N (Sample Size) 
The number of observations in the sample. Each observation is made up of two values: one for X 
and one for Y. 

Effect Size 

R0 (Baseline Correlation) 
Specify the value of ρ0 . Note that the range of the correlation is between plus and minus one. 
This value is usually set to zero. 

R1 (Alternative Correlation) 
Specify the value of 1ρ , the population correlation under the alternative hypothesis. Note that the 
range of the correlation is between plus and minus one. The difference between R0 and R1 is 
being tested by this significance test. 

You can enter a range of values separated by blanks or commas. 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the 
hypothesis test. The null hypothesis is 100 : ρρ =H . 
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Note that the alternative hypothesis enters into power calculations by specifying the rejection 
region of the hypothesis test. Its accuracy is critical. 

Possible selections are: 

• Ha: R0 <> R1 
This is the most common selection. It yields the two-tailed test. Use this option when you are 
testing whether the correlation values are different, but you do not want to specify beforehand 
which correlation is larger. 

• Ha: R0 < R1 
This option yields a one-tailed test. 

• Ha: R0 > R1 
This option also yields a one-tailed test. 

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Finding the Power 
Suppose a study will be run to test whether the correlation between forced vital capacity (X) and 
forced expiratory value (Y) in a particular population is 0.30. Find the power when alpha is 0.01, 
0.05, and 0.10 and the N = 20, 60, 100.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Correlation procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Tests 
for One Correlation. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.01 0.05 0.10 
N (Sample Size) ...................................... 20 60 100 
R0 (Baseline Correlation) ........................ 0.0 
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Data Tab (continued) 
R1 (Alternative Correlation) .................... 0.3 
Alternative Hypothesis ............................ Ha: R0 ≠ R1 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Ha: R0<>R1 
 
Power N Alpha Beta R0 R1 
0.09401 20 0.01000 0.90599 0.00000 0.30000 
0.40755 60 0.01000 0.59245 0.00000 0.30000 
0.68475 100 0.01000 0.31525 0.00000 0.30000 
0.25394 20 0.05000 0.74606 0.00000 0.30000 
0.65396 60 0.05000 0.34604 0.00000 0.30000 
0.86524 100 0.05000 0.13476 0.00000 0.30000 
0.37052 20 0.10000 0.62948 0.00000 0.30000 
0.76282 60 0.10000 0.23718 0.00000 0.30000 
0.92230 100 0.10000 0.07770 0.00000 0.30000 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. To conserve resources, it should be small. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
R0 is the value of the population correlation under the null hypothesis. 
R1 is the value of the population correlation under the alternative hypothesis. 
 
 
Summary Statements 
A sample size of 20 achieves 9% power to detect a difference of -0.30000 between the null 
hypothesis correlation of 0.00000 and the alternative hypothesis correlation of 0.30000 using a 
two-sided hypothesis test with a significance level of 0.01000. 
 

This report shows the values of each of the parameters, one scenario per row. The values from 
this table are plotted in the chart below.  

Plots Section 
 

 

Power vs Alpha by N
R0=0.00 R1=0.30 Corr Test
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Po
w

er
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This plot shows the relationship between alpha and power in this example.  
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Example 2 – Finding the Sample Size 
Continuing with the last example, find the sample size necessary to achieve a power of 90% with 
a 0.05 significance level. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Correlation procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Tests 
for One Correlation. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
R0 (Baseline Correlation) ........................ 0.0 
R1 (Alternative Correlation)..................... 0.3 
Alternative Hypothesis ............................ Ha: R0 ≠ R1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Ha: R0<>R1 
 
Power N Alpha Beta R0 Ra 
0.90081 112 0.05000 0.09919 0.00000 0.30000 
 

The required sample size is 112. You would now experiment with the parameters to find out how 
much varying each will influence the sample size.  
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Example 3 – Validation using Zar 
Zar (1984) page 312 presents an example in which the power of a correlation coefficient is 
calculated. If N = 12, alpha = 0.05, R0 = 0, and R1 = 0.866, Zar calculates a power of 98% for a 
two-sided test.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Correlation procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Tests 
for One Correlation. You may then make the appropriate entries as listed below, or open 
Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 12 
R0 (Baseline Correlation) ........................ 0.0 
R1 (Alternative Correlation) .................... 0.866 
Alternative Hypothesis ............................ Ha: R0 ≠ R1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Ha: R0<>R1 
 
Power N Alpha Beta R0 R1 
0.98398 12 0.05000 0.01602 0.00000 0.86600 
 

The power of 0.98 matches Zar’s results.  
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Example 4 – Validation using Graybill 
Graybill (1961) pages 211-212 presents an example in which the power of a correlation 
coefficient is calculated when the baseline correlation is different from zero. Let N = 24, alpha = 
0.05, and R0 = 0.5. Graybill calculates the power of a two-sided test when R1 = 0.2 and 0.3 to be 
0.363 and 0.193. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Correlation procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Tests 
for One Correlation. You may then make the appropriate entries as listed below, or open 
Example 4 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 24 
R0 (Baseline Correlation) ........................ 0.5 
R1 (Alternative Correlation)..................... 0.2 0.3 
Alternative Hypothesis ............................ Ha: R0 ≠ R1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Ha: R0<>R1 
 
Power N Alpha Beta R0 R1 
0.36583 24 0.05000 0.63417 0.50000 0.20000 
0.19950 24 0.05000 0.80050 0.50000 0.30000 
 

The power values match Graybill’s results to two decimal places.  
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Chapter 801 

Confidence 
Intervals for One 
Correlation 
Introduction 
This routine calculates the sample size necessary to achieve a specified interval width or distance 
from the sample correlation to the confidence limit at a stated confidence level for a confidence 
interval for one correlation.  

Caution: This procedure assumes that the correlation of the future sample will be the same as the 
correlation that is specified. If the sample correlation is different from the one specified when 
running this procedure, the interval width may be narrower or wider than specified.  

Technical Details 
Assuming a bivariate normal population with population correlation ρ, the transformation of the 
sample correlation, r, 
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is approximately normally distributed with variance 1/(n - 3) (Fisher, 1921). The lower and upper 
confidence limits for ρ  can be obtained by first computing 
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the inverse transformations 

1
1

2

2

+
−

=
L

L

z

z

L e
er  

and 

12 +
=

UzU e
r 12 −Uze

. 



801-2  Confidence Intervals for One Correlation 

One-sided limits may be obtained by replacing α/2 by α. 

For two-sided intervals, the distance from the sample correlation to each of the limits may be 
different. Thus, instead of specifying the distance to the limits we specify the width of the interval, 
W.  

The basic equation for determining sample size for a two-sided interval when W has been specified 
is 

LU rrW = −  

For one-sided intervals, the distance from the sample correlation to limit, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been 
specified is 

rrD U= −  

The basic equation for determining sample size for a one-sided lower limit when D has been 
specified is 

LrrD = −  

Each of these equations can be solved for any of the unknown quantities in terms of the others. 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population correlation is 1 – 
α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  



Confidence Intervals for One Correlation  801-3 

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are 
drawn from a population using simple random sampling and a confidence interval is calculated for 
each sample, the proportion of those intervals that will include the true population correlation is 1 – 
α. 

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. 

You can enter a single value or a list of values. The value(s) must be between 0 and 2.  

Distance from R to Limit (One-Sided) 
This is the distance from the sample correlation to the lower or upper limit of the confidence 
interval, depending on whether the Interval Type is set to Lower Limit or Upper Limit. 

You can enter a single value or a list of values. The value(s) must be between 0 and 2.  

Correlation 

R (Sample Correlation) 
Enter an estimate of the sample correlation. The sample size and width calculations assume that 
the value entered here is the correlation estimate that is obtained from the sample. If the sample 
correlation is different from the one specified here, the width may be narrower or wider than 
specified. 

The range of the values of the sample correlation that can be entered is -1 to 1. 

You can enter a range of values such as .1 .2 .3 or .1 to .5 by .1. 

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 
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Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% 
confidence interval for the population correlation such that the width of the interval is no wider 
than 0.08. The researcher would like to examine a large range of correlation values to determine 
the effect of the correlation estimate on necessary sample size. Instead of examining only the 
interval width of 0.08, widths of 0.06 and 0.10 will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Correlation procedure 
window by expanding Correlation, then Correlation, then clicking on Confidence Interval, and 
then clicking on Confidence Intervals for One Correlation. You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 0.06 0.08 0.10 
R (Sample Correlation) ........................... -0.9 to 0.9 by 0.1 
Interval Type ........................................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for One Correlation 
 
 Sample       
Confidence Size Target Actual Correlation Lower Upper Width if 
Level (N) Width Width (R) Limit Limit R = 0.0 
0.950 161 0.060 0.060 -0.900 -0.926 -0.866 0.309 
0.950 559 0.060 0.060 -0.800 -0.828 -0.768 0.166 
0.950 1115 0.060 0.060 -0.700 -0.729 -0.669 0.117 
0.950 1752 0.060 0.060 -0.600 -0.629 -0.569 0.094 
0.950 2404 0.060 0.060 -0.500 -0.529 -0.469 0.080 
0.950 3014 0.060 0.060 -0.400 -0.430 -0.370 0.071 
0.950 3536 0.060 0.060 -0.300 -0.330 -0.270 0.066 
0.950 3935 0.060 0.060 -0.200 -0.230 -0.170 0.062 
0.950 4184 0.060 0.060 -0.100 -0.130 -0.070 0.061 
0.950 4269 0.060 0.060 0.000 -0.030 0.030 0.060 
0.950 4184 0.060 0.060 0.100 0.070 0.130 0.061 
0.950 3935 0.060 0.060 0.200 0.170 0.230 0.062 
0.950 3536 0.060 0.060 0.300 0.270 0.330 0.066 
0.950 3014 0.060 0.060 0.400 0.370 0.430 0.071 
0.950 2404 0.060 0.060 0.500 0.469 0.529 0.080 
0.950 1752 0.060 0.060 0.600 0.569 0.629 0.094 
0.950 1115 0.060 0.060 0.700 0.669 0.729 0.117 
0.950 559 0.060 0.060 0.800 0.768 0.828 0.166 
0.950 161 0.060 0.060 0.900 0.866 0.926 0.309 
0.950 94 0.080 0.080 -0.900 -0.933 -0.853 0.405 
0.950 317 0.080 0.080 -0.800 -0.836 -0.757 0.220 
0.950 629 0.080 0.080 -0.700 -0.738 -0.658 0.156 
. . . . . . . . 
. . . . . . . . 
. . . . . . . . 
 
References 
Cook, R. D. and Weisburg, S. 1999. Applied Regression Including Computing and Graphics. John Wiley and Sons, 
     Inc. 
Ostle, B. and Malone, L.C. 1988. Statistics in Research. Iowa State University Press. Ames, Iowa. 
Zar, J. H. 1984. Biostatistical Analysis. Second Edition. Prentice-Hall. Englewood Cliffs, New Jersey. 
Fisher, R. A. 1921. 'On the probable error of a coefficient of correlation deduced from a small sample.' 
     Metron, i (4), 1-32. 
 
Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the true correlation. 
Sample Size (N) is the size of the sample drawn from the population. 
Width is the distance from the lower limit to the upper limit. 
Target Width is the value of the width that is entered into the procedure. 
Actual Width is the value of the width that is obtained from the procedure. 
Correlation (R) is the assumed sample correlation. 
Lower and Upper Limit are the lower and upper limits of the confidence interval. 
Width if R = 0.0 is the maximum width for a confidence interval with sample size N. 
 
Summary Statements 
A sample size of 161 produces a two-sided 95% confidence interval with a width equal to 0.060 
when the sample correlation is -0.900. 
 

This report shows the calculated sample size for each of the scenarios.  
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Plots Section 
 

  
 

This plot shows the sample size versus the sample correlation for the three confidence interval 
widths. 
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Example 2 – Validation using Cook and Weisberg 
Cook and Weisberg (1999), page 78, give an example of a calculation for an two-sided 
confidence interval for a single correlation when the confidence level is 95%, the sample 
correlation is -0.889, and the confidence interval width is 0.428. The sample size is 9.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for One Correlation procedure 
window by clicking on Confidence Intervals, then Correlation and Regression, then One 
Correlation. You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Confidence Interval Width (Two-Sided) .. 0.428 
R (Sample Correlation) ........................... -0.889 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

 Sample       
Confidence Size Target Actual Correlation Lower Upper Width if 
Level (N) Width Width (R) Limit Limit R = 0.0 
0.950 9 0.428 0.428 -0.889 -0.977 -0.549 1.328 
 

PASS also calculated the sample size to be 9.  
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Chapter 805 

Inequality Tests 
for Two 
Correlations 
Introduction 
The correlation coefficient (or correlation), ρ , is a popular parameter for describing the strength 
of the association between two variables. The correlation coefficient is the slope of the regression 
line between two variables when both variables have been standardized. It ranges between plus 
and minus one. This chapter covers the case in which you want to test the difference between two 
correlations, each coming from a separate sample.  

Since the correlation is the standardized slope between two variables, you could also apply this 
procedure to the case in which you want to test whether the slopes in two groups are equal. 

Test Procedure 
In the following discussion, ρ  is the population correlation coefficient and r is the value 
calculated from a sample. The testing procedure is as follows.  is the null hypothesis that H0

ρ ρ1 2= .  represents the alternative hypothesis that HA ρ ρ1 2≠  (one-tailed hypotheses are also 
available). To construct the hypothesis test, transform the correlations using the Fisher-z 
transformation. 
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This transformation is used because the combined distribution of r  and  is too difficult to work 
with, but the distributions of  and  are approximately normal. 

1 r2

z1 z2

Note that the reverse transformation is 
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Once the correlations have been converted into z values, the normal distribution may be used to 
conduct the test of . The standard deviation of the difference is given by Z Z1 − 2

σ z z  =  
N N1 2

1
3

1
31 2

− −
+

−
 

The test statistic is given by 

( ) ( )z =  
z z Z Z

z z

1 2 1 2

1 2

− − −

−σ
 

Note that the lower case z’s represent the values calculated from the two samples and the upper 
case Z’s represent the hypothesized population values. 

Calculating the Power 
1. Find zα  such that , where ( )1− =Φ zα α ( )Φ x is the area under the standardized normal 

curve to the left of x.  

2. Calculate: Z  =  1
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3. Calculate: Z  =  2
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4. Calculate: σ z z   
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5. Calculate: x  =  Z Z + za z1 2 1 2
− −α zσ  

6. Calculate: z = x
a

a

z z1 2−σ
 

7. Calculate:  ( )Power = −1 Φ za
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are R1, R2, N1, N2, Alpha, and Power and Beta. Under most situations, you 
will select either Power and Beta or N1. 

Select N1 when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal 
correlations when in fact they are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis of equal correlations when in fact they are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size 

N1 (Sample Size Group 1) 
Enter a value (or range of values) for the sample size of this group. Note that these values are 
ignored when you are solving for N1. You may enter a range of values such as 10 to 100 by 10.  
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N2 (Sample Size Group 2) 
Enter a value (or range of values) for the sample size of group 2 or enter Use R to base N2 on the 
value of N1. You may enter a range of values such as 10 to 100 by 10. 

• Use R 
When Use R is entered here, N2 is calculated using the formula  

N2 = [R( N1)] 

where R is the Sample Allocation Ratio and [Y] is the first integer greater than or equal to Y. 
For example, if you want N1 = N2, select Use R and set R = 1. 

R (Sample Allocation Ratio) 
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only 
used when N2 is set to Use R.  

When used, N2 is calculated from N1 using the formula: N2=[R( N1)] where [Y] is the next 
integer greater than or equal to Y. Note that setting R = 1.0 forces N2 = N1. 

Effect Size 

R1 (Correlation Group 1) 
Specify the value of the population correlation coefficient of group one. Possible values range 
between plus and minus one.  

You can enter a single value or a range of values separated by commas or blanks. 

Note that the power depends on the specific values of R1 and R2, not just their difference. Hence, 
R1 = 0 and R2 = 0.3 will have a different power from R1 = 0.3 and R2 = 0.6. 

R2 (Correlation Group 2) 
Specify the value of the population correlation coefficient from group two under the alternative 
hypothesis. Possible values range between plus and minus one. 

You can enter a single value or a range of values separated by commas or blanks. 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the 
hypothesis test. The null hypothesis is always H0 1 2: ρ ρ= . 

Possible selections are: 

• Ha: R1 <> R2 
This is the most common selection. It yields the two-tailed test. Use this option when you are 
testing whether the correlation values are different, but you do not want to specify beforehand 
which value is larger. 

• Ha: R1 < R2 
This option yields a one-tailed test. When you use this option, you should be careful to enter 
values for R1 and R2 that follow this relationship. 
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• Ha: R1 > R2 
This option yields a one-tailed test. When you use this option, you should be careful to enter 
values for R1 and R2 that follow this relationship. 

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Finding the Power 
A researcher wants to compare the relationship between weight and heart rate in males and 
females. If the correlation between weight and heart rate is 0.3 in a sample of 100 males and 0.5 
in a sample of 100 females, what is the power of a two sided test for the difference between 
correlations at the 0.01 and 0.05 significance levels? Also compute the power for samples of 20, 
200, 300, 400,  and 600.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Correlations procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Tests 
for Two Correlations. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting. 
Alpha ....................................................... 0.01 0.05 
N1 (Sample Size Group 1) ...................... 20 100 200 300 400 600 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
R1 (Correlation Group 1)......................... 0.3 
R2 (Correlation Group 2)......................... 0.5 
Alternative Hypothesis ............................ Ha: R1 ≠ R2 



805-6  Inequality Tests for Two Correlations 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when Ha: R1<>R2 
   Allocation   Difference   
Power N1 N2 Ratio R1 R2 (R1-R2) Alpha Beta 
0.03081 20 20 1.000 0.30000 0.50000 -0.20000 0.01000 0.96919 
0.18250 100 100 1.000 0.30000 0.50000 -0.20000 0.01000 0.81750 
0.42230 200 200 1.000 0.30000 0.50000 -0.20000 0.01000 0.57770 
0.63541 300 300 1.000 0.30000 0.50000 -0.20000 0.01000 0.36459 
0.78888 400 400 1.000 0.30000 0.50000 -0.20000 0.01000 0.21112 
0.94144 600 600 1.000 0.30000 0.50000 -0.20000 0.01000 0.05856 
0.10760 20 20 1.000 0.30000 0.50000 -0.20000 0.05000 0.89240 
0.38603 100 100 1.000 0.30000 0.50000 -0.20000 0.05000 0.61397 
0.66271 200 200 1.000 0.30000 0.50000 -0.20000 0.05000 0.33729 
0.83200 300 300 1.000 0.30000 0.50000 -0.20000 0.05000 0.16800 
0.92196 400 400 1.000 0.30000 0.50000 -0.20000 0.05000 0.07804 
0.98548 600 600 1.000 0.30000 0.50000 -0.20000 0.05000 0.01452 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N1 and N2 are the sizes of the samples drawn from the two populations. To conserve resources, it should be small. 
Allocation Ratio is N1/N2 so that N2 = N1 x R. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
R1 is the value of both correlations under the null hypothesis. 
R2 is the correlation in group two under the alternative hypothesis. 
 
 
Summary Statements 
Group sample sizes of 20 and 20 achieve 3% power to detect a difference of 0.20000 between the 
null hypothesis that both group correlations are 0.30000 and the alternative hypothesis that 
the correlation in group 2 is 0.50000 using a two-sided z test (which uses Fisher's 
z-transformation) with a significance level of 0.01000. 
 
 

This report shows the values of each of the parameters, one scenario per row. The definitions of 
each column are given in the Report Definitions section of the report, so they will not be repeated 
here. 
The values from this table are plotted in the chart below.  

Plots Section 
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This plot shows the relationship between alpha, power, and sample size in this example. 
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Example 2 – Finding the Sample Size 
Continuing with the previous example, suppose the researchers want to determine the exact 
sample size necessary to achieve 90% power at a 0.05 significance level. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Inequality Tests for Two Correlations procedure window by 
clicking on Correlation, then Two Correlations. You may then make the appropriate entries as 
listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N1 (Sample Size Group 1) ...................... Ignored since this is the Find setting 
N2 (Sample Size Group 2) ...................... Use R 
R (Sample Allocation Ratio) .................... 1.0 
R1 (Correlation Group 1)......................... 0.3 
R2 (Correlation Group 2)......................... 0.5 
Alternative Hypothesis ............................ Ha: R1 ≠ R2 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when Ha: R1<>R2 
   Allocation   Difference   
Power N1 N2 Ratio R1 R2 (R1-R2) Alpha Beta 
0.90040 369 369 1.000 0.30000 0.50000 -0.20000 0.05000 0.09960 
 

PASS has calculated the sample size as 369 per group. 
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Example 3 – Validation using Zar 
Zar (1984) page 314 presents an example of calculating the power for a test of two correlations. 
In his example, when N1 = 95, N2 = 98, R1 = 0.84, R2 = 0.78, and alpha = 0.05, the power is 
22% for a two-sided test.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Inequality Tests for Two Correlations procedure window by 
clicking on Correlation, then Two Correlations. You may then make the appropriate entries as 
listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N1 (Sample Size Group 1) ...................... 95 
N2 (Sample Size Group 2) ...................... 98 
R (Sample Allocation Ratio) .................... 1.0 
R1 (Correlation Group 1) ......................... 0.84 
R2 (Correlation Group 2) ......................... 0.78 
Alternative Hypothesis ............................ Ha: R1 ≠ R2 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when Ha: R1<>R2 
   Allocation   Difference   
Power N1 N2 Ratio R1 R2 (R1-R2) Alpha Beta 
0.22498 95 98 1.032 0.84000 0.78000 0.06000 0.05000 0.77502 
 

PASS has also calculated the power to be 22%. 
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Chapter 810 

Inequality Tests 
for Intraclass 
Correlation 
Introduction 
The intraclass correlation coefficient is often used as an index of reliability in a measurement 
study. In these studies, there are N observations made on each of K individuals. These individuals 
represent a factor observed at random. This design arises when K subjects are each rated by N 
raters.  

The intraclass correlation coefficient may be thought of as the correlation between any two 
observations made on the same subject. When this correlation is high, the observations on a 
subject tend to match, and the measurement reliability is ‘high.’  

Technical Details 
Our formulation comes from Walter, Eliasziw, and Donner (1998) and Winer (1991). Denote 
response j of subject i by , where i = 1, 2, …, K and j = 1, 2, …, N. The model for this situation 
is 

Yij

Y a eij i ij= +μ +  

where the random subject effects  are normally distributed with mean 0 and variance and the 
measurement errors,  are normally distributed with mean 0 and variance . We assume that the 
subject effects and the measurement errors are independent. The intraclass correlation is then 
defined as 

ai σa
2

eij σ e
2

ρ σ
= a

2

2 2σ σ+a e

H
H

0 0

1 1 0

:
:

 

The hypothesis test is stated formally as 
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This hypothesis is tested from the data of a one-way analysis of variance table using the value: 
MS
MS

a

e

. The critical value for the test statistic is 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are R0, R1, K, N, Alpha, and Power (or Beta).  

Under most situations, you will select either Power and Beta to calculate power or N to calculate 
sample size. 

Note that the value selected here always appears as the vertical axis on the charts. 

The program is set up to evaluate power directly. For the other parameters, a search is made using 
an iterative procedure until an appropriate value is found.  
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis when it is true. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size 

K (Number of Subjects) 
Enter a value (or range of values) for the number of subjects, K, that are measured. 

You may enter a range of values such as 50,150,250 or 50 to 300 by 50. 

N (Observations Per Subject) 
Enter a value (or range of values) for the number of observations, N, per subjects. In a reliability 
study, this is the number of raters (assuming each subject is rated by all raters). 

You may enter a range of values such as 2,3,4 or 2 to 12 by 2. 

Effect Size 

R0 (Intraclass Correlation 0) 
This is the value(s) of the intraclass correlation coefficient when the null hypothesis is true. You 
may enter a single value or a list of values. The range of R0 is between zero and R1. 

The intraclass correlation is calculated as V(A)/[V(A)+V(E)] where V(E) is the variation within a 
subject and V(A) is the variation between subjects. It is a measure of the extent to which the 
observations within a subject are similar (or dependent) relative to observations from other 
subjects. 

R1 (Intraclass Correlation 1) > R0 
This is the value(s) of the intraclass correlation coefficient when the alternative hypothesis is true. 
You may enter a single value or a list of values. The range of R1 is between R0 and one. 
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Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating Power 
Suppose that a study is to be conducted in which R0 = 0.2; R1 = 0.3; K = 50 to 250 by 100; Alpha 
= 0.05; and N = 2 to 5 by 1 and beta is to be calculated.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Intraclass Correlation procedure window by 
expanding Correlation, then clicking on Intraclass Correlation, and then clicking on Tests for 
Intraclass Correlation. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
K (Number of Subjects) ........................... 50 to 250 by 100 
N (Observations Per Subject) ................. 2 to 5 by 1 
R0 (Intraclass Correlation 0) ................... 0.2 
R1 (Intraclass Correlation 1) > R0 .......... 0.3 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results  
 Number of Observations Intraclass Intraclass 
Power Subjects Per Subject Correlation 0 Correlation 1 Alpha Beta 
0.18333 50 2 0.200 0.300 0.05000 0.81667   
0.29534 50 3 0.200 0.300 0.05000 0.70466   
0.38528 50 4 0.200 0.300 0.05000 0.61472   
0.45522 50 5 0.200 0.300 0.05000 0.54478   
0.36558 150 2 0.200 0.300 0.05000 0.63442   
0.60094 150 3 0.200 0.300 0.05000 0.39906   
0.74538 150 4 0.200 0.300 0.05000 0.25462   
0.83005 150 5 0.200 0.300 0.05000 0.16995   
0.51549 250 2 0.200 0.300 0.05000 0.48451   
0.78790 250 3 0.200 0.300 0.05000 0.21210   
0.90522 250 4 0.200 0.300 0.05000 0.09478   
0.95403 250 5 0.200 0.300 0.05000 0.04597   
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
K is the number of subjects. 
N is the number of observations per subject in the sample. 
R0 is intraclass correlation assuming the null hypothesis. 
R1 is intraclass correlation assuming the alternative hypothesis. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
Summary Statements 
A sample size of 50 subjects with 2 observations per subject achieves 18% power to detect an 
intraclass correlation of 0.300 under the alternative hypothesis when the intraclass 
correlation under the null hypothesis is 0.200 using an F-test with a significance level of 
0.05000. 
 

This report shows the power for each of the scenarios.  

Plots Section 
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This plot shows the relation between power, number of subjects (K), and observations per subject 
(N). 
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Example 2 – Validation using Walter 
Walter et al. (1998) page 106 give a table of sample sizes. When R0 is 0.2, R1 is 0.3, K is 544, N 
is 2, and Alpha is 0.05, Beta is 0.80.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Intraclass Correlation procedure window by 
expanding Correlation, then clicking on Intraclass Correlation, and then clicking on Tests for 
Intraclass Correlation. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
K (Number of Subjects) ........................... 544 
N (Observations Per Subject) ................. 2 
R0 (Intraclass Correlation 0) ................... 0.2 
R1 (Intraclass Correlation 1) > R0 .......... 0.3 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results  
 Number of Observations Intraclass Intraclass 
Power Subjects Per Subject Correlation 0 Correlation 1 Alpha Beta 
0.80033 544 2 0.200 0.300 0.05000 0.19967 
 

PASS has also calculated the power as 0.80.  
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Chapter 811 

Kappa Test for 
Agreement 
Between Two 
Raters 
Introduction 
This module computes power and sample size for the test of agreement between two raters using 
the kappa statistic. The power calculations are based on the results in Flack, Afifi, Lachenbruch, 
and Schouten (1988). Calculations are based on ratings for k categories from two raters or judges. 
You are able to vary category frequencies on a single run of the procedure to analyze a wide 
range of scenarios all at once. For further information about kappa analysis, see chapter 18 of 
Fleiss, Levin, and Paik (2003).  

Technical Details  
Suppose that N subjects are each assigned independently to one of k categories by two separate 
judges or raters. The results are placed in a k × k contingency table. Each  represents the 
proportion of subjects that Rater A classified in category i, but Rater B classified in category j, 
with i, j = 1, 2, …, k. The proportions and  are the frequencies or marginal probabilities of 
assignment into categories i and j for Rater A and Rater B, respectively. For each rater, the 
category frequencies sum to one. 

ijp

.ip jp.
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The proportions on gonal, , represent the proportion of subjects in each category for 
 a  

, 

and the overall proportion of agreement expected by chance is  

The overall value of kappa, which measures the degree of rater agreement, is then 
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A kappa value of 1 represents perfect agreement between the two raters. A kappa value of 0 

cing the observed and expected proportions by 

indicates no more rater agreement than that expected by chance. A kappa value of -1 would 
indicate perfect disagreement between the raters. 
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Again, an estimate of the standard error can be obtained by replacing the unknown values  by 
their sample estimates . 
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Hypothesis Tests 
One- and two-sided hypo hesis tests cant  be conducted using the test statistic 

( )κ
κκ
ˆ..

ˆ 0

es
z −
= , 

where 0κ  is the null hypothesized value of kappa, and the denominator is the estimated standard 
error. For a one-sided alternative, the test rejects H0 if αzz ≥ , where  is the value that leaves 
α per tail of the standard normal distribution. r a two-side ernative, the test rejects 

αz
d alt in the up Fo

H0 if 2/αzz . 

Power Calculation 

≥

The st rrandard e or for the kappa statistic is based on values , which are unknown prior to 
conducting a study. Therefore, the power is computed at the maximum standard error based on 

 marginal probabilities.  The following steps are taken to compute 

ry 
, 
l 

 Therefore, only one set of frequencies is needed. 

ijp

given category frequencies or
the power of the test.  

1. Determine the category assignment frequencies for both raters. In practice, the catego
frequencies may not be equivalent, but the standard error maximization method of Flack
Afifi, Lachenbruch, and Schouten (1988) assumes that the category frequencies are equa
for both raters.

2. Determine the maximum standard error under the null and alternative hypotheses for the 
given marginal frequencies. This is equivalent to finding the maximum ( )κτ ˆ  under the 
null and alternative hypotheses. 

3. Find the critical value using the standard normal distribution. The critical value, criticalz , is 
that value of z that leaves exactly the target value of alpha (or alpha/2) in the upper tail of
the standard normal distribution. For example, for an upper-tailed test with a target alpha
of 0.05, the critical value is 1.645. 

 
 

 

4. Without loss of generality, for a one-sided test of the alternative hypothesis that 0κκ > , 
compute the power at an alternative value of kappa, 1κ , as 

( )Hzz critical≥= |Pr 1

( )uΦ−=1
, 

where ()Φ  is the cumulative standard normal distribution and 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are Power and Beta, N (Sample Size), or K1. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means 
when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered. 

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject 
the null hypothesis of equal means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size / Groups – Sample Size 
Multiplier 

N (Sample Size) 
Enter a value for the sample size (N). This is the number of subjects rated by the two judges in the 
study. You may enter a range such as 10 to 100 by 10 or a list of values separated by commas or 
blanks such as 50 60 70. 
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Effect Size – Kappa 

K1 (Kappa|H1) 
This is the value of Kappa under the alternative hypothesis, H1. Values must be between -1 and 1. 
If a one-sided hypothesis is used, the alternative value(s) for Kappa in relation to the null 
value(s), K0, should match the direction of the alternative hypothesis. You can enter a list of 
values separated by blanks or commas such as 0.6 0.7 0.8 or 0.6 to 0.8 by 0.05. 

K0 (Kappa|H0) 
This is the value of Kappa under the null hypothesis, H0. Values must be between -1 and 1. If a 
one-sided hypothesis is used, the alternative value(s) for Kappa in relation to the null value(s), 
K0, should match the direction of the alternative hypothesis. You can enter a list of values 
separated by blanks or commas such as 0.2 0.3 0.4 or 0.2 to 0.4 by 0.05. 

Effect Size – Categories 

P (Category Frequencies) 
Specify two or more category frequencies, proportions, or marginal proportions. These are the 
proportions of subjects assigned to each category by the two raters or judges. In practice the 
proportions may not be exactly equal for the two raters, but the power calculations assume that 
the category frequencies are equal for the two raters. Each proportion set must sum to 1.  

Several sets of proportions can be entered by using the PASS spreadsheet. To launch the 
spreadsheet, click on the “Spreadsheet” button above the box. To select columns from the 
spreadsheet, click on the button with the arrow pointing down on the right of the box. Specify the 
column (or columns) to be used by beginning your entry with an equals sign, e.g. enter =C1-C3. 

List Input 
Specify a single set of proportions as a list. For example, with three groups you might enter 0.2 
0.3 0.5. 

Spreadsheet Column Input 
Specify more than one set of proportions using the column input syntax  

=[column 1] [column 2] etc.  

For example, if you have three proportion sets stored in the spreadsheet in columns C1, C2, and 
C3, you would enter =C1 C2 C3 in the P (Category Frequencies) box. 

Each column in the spreadsheet corresponds to a single set of proportions. The columns may 
contain different numbers of frequencies, but in all cases, the values in each column must sum to 
1. 

Test 

Alternative Hypothesis (H1) 
Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite, specifying 
the alternative is all that is needed. The alternative hypothesis determines how the alternative 
value(s) of Kappa (K1) should be entered. Usually, the two-sided option is selected.  

For a one-sided alternative hypothesis test of K1 > K0, all values for K1 should be greater than 
K0.  
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For a one-sided alternative hypothesis test of K1 < K0, all values for K1 should be less than K0.  

For a two-sided test, the values for K1 can be either greater than or less than K0. 

Example 1 – Finding the Power 
Suppose a study is being planned to measure the degree of inter-rater agreement for two 
psychiatrists. The two psychiatrists will independently classify each of a series of patients into 
one of three diagnostic categories: personality disorder, neurosis, or psychosis. The study will 
then determine how well the psychiatrists “agree” with a hypothesis test using the kappa statistic.  

Before the data are collected, the organizers would like to study the relationship between sample 
size and power. From previous experience, they have determined to use frequencies of 0.4, 0.5, 
and 0.1 for the personality disorder, neurosis, and psychosis diagnoses, respectively. They would 
like to determine the power for detecting alternative kappa values of 0.5, 0.6, and 0.7 when the 
null value is 0.4. A two-sided hypothesis test will be conducted at alpha = 0.05. What will be the 
power for a wide range of sample sizes?  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Kappa Test for Agreement Between Two Raters procedure 
window by expanding Correlation, then clicking on Kappa, and then clicking on Kappa Test 
for Agreement Between Two Raters. You may then make the appropriate entries as listed 
below, or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 30 to 200 by 10 
K1 ............................................................ 0.5 0.6 0.7 
K0 ............................................................ 0.4 
P (Category Frequencies) ....................... 0.4 0.5 0.1 
Alternative Hypothesis (H1) .................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
Test Type = Two-sided Z test. 
H0: Kappa = K0 vs. H1: Kappa <> K0. 
 
 Sample       
 Size Kappa|H0 Kappa|H1   - Rating Categories -  
Power N K0 K1 Alpha Beta k Frequencies 
0.07748 30 0.40 0.50 0.05000 0.92252 3 0.40, 0.50, 0.10 
0.19421 30 0.40 0.60 0.05000 0.80579 3 0.40, 0.50, 0.10 
0.43345 30 0.40 0.70 0.05000 0.56655 3 0.40, 0.50, 0.10 
0.09199 40 0.40 0.50 0.05000 0.90801 3 0.40, 0.50, 0.10 
0.26055 40 0.40 0.60 0.05000 0.73945 3 0.40, 0.50, 0.10 
0.58208 40 0.40 0.70 0.05000 0.41792 3 0.40, 0.50, 0.10 
0.10677 50 0.40 0.50 0.05000 0.89323 3 0.40, 0.50, 0.10 
0.32746 50 0.40 0.60 0.05000 0.67254 3 0.40, 0.50, 0.10 
0.70452 50 0.40 0.70 0.05000 0.29548 3 0.40, 0.50, 0.10 
0.12180 60 0.40 0.50 0.05000 0.87820 3 0.40, 0.50, 0.10 
0.39325 60 0.40 0.60 0.05000 0.60675 3 0.40, 0.50, 0.10 
0.79842 60 0.40 0.70 0.05000 0.20158 3 0.40, 0.50, 0.10 
0.13704 70 0.40 0.50 0.05000 0.86296 3 0.40, 0.50, 0.10 
0.45663 70 0.40 0.60 0.05000 0.54337 3 0.40, 0.50, 0.10 
0.86661 70 0.40 0.70 0.05000 0.13339 3 0.40, 0.50, 0.10 
0.15246 80 0.40 0.50 0.05000 0.84754 3 0.40, 0.50, 0.10 
0.51666 80 0.40 0.60 0.05000 0.48334 3 0.40, 0.50, 0.10 
0.91404 80 0.40 0.70 0.05000 0.08596 3 0.40, 0.50, 0.10 
. . . . . . . . 
. . . . . . . . 
. . . . . . . . 
(Report Continues) 
 
References 
Flack, V.F., Afifi, A.A., Lachenbruch, P.A., and Schouten, H.J.A. 1988. 'Sample Size Determinations for the 
     Two Rater Kappa Statistic'. Psychometrika 53, No. 3, 321-325. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the total sample size. 
K0 is the value of Kappa under the null hypothesis, H0. 
K1 is the value of Kappa under the alternative hypothesis, H1. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
k is the number of rating categories. 
Frequencies lists the rating category frequencies. The number of frequencies is equal to k. 
 
Summary Statements 
In a test for agreement between two raters using the Kappa statistic, a sample size of 30 
subjects achieves 8% power to detect a true Kappa value of 0.50 in a test of H0: Kappa = 0.40 
vs. H1: Kappa <> 0.40 when there are 3 categories with frequencies equal to 0.40, 0.50, and 
0.10. This power calculation is based on a significance level of 0.05000. 

 

This report shows the numeric results of this power study. Following are the definitions of the 
columns of the report. 

Power 
The probability of rejecting a false null hypothesis. 

N 
The total sample size for the study. 
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K0 
The value of kappa under the null hypothesis. 

K1 
The value of kappa under the alternative hypothesis. 

Alpha 
The probability of rejecting a true null hypothesis. This is often called the significance level. 

Beta 
The probability of accepting a false null hypothesis. 

k 
The number of rating categories. 

Frequencies 
The rating category frequencies used. 

Plots Section 
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This plot gives a visual presentation to the results in the Numeric Report. We can quickly see the 
impact on the power of increasing the sample size for the different values of K1. 
When you create one of these plots, it is important to use trial and error to find an appropriate 
range for the horizontal variable so that you have results with both low and high power. 
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Example 2 – Finding the Sample Size 
Continuing with the last example, we will determine how large the sample size would need to be 
for the three values of K1 to have the power at least 0.95 with an alpha level of 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Kappa Test for Agreement Between Two Raters procedure 
window by expanding Correlation, then clicking on Kappa, and then clicking on Kappa Test 
for Agreement Between Two Raters. You may then make the appropriate entries as listed 
below, or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Power ...................................................... 0.95 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
K1 ............................................................ 0.5 0.6 0.7 
K0 ............................................................ 0.4 
P (Category Frequencies) ....................... 0.4 0.5 0.1 
Alternative Hypothesis (H1) .................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
Test Type = Two-sided Z test. 
H0: Kappa = K0 vs. H1: Kappa <> K0. 
 
 Sample       
 Size Kappa|H0 Kappa|H1   - Rating Categories -  
Power N K0 K1 Alpha Beta k Frequencies 
0.95003 983 0.40 0.50 0.05000 0.04997 3 0.40, 0.50, 0.10 
0.95031 228 0.40 0.60 0.05000 0.04969 3 0.40, 0.50, 0.10 
0.95078 92 0.40 0.70 0.05000 0.04922 3 0.40, 0.50, 0.10 

 

The required sample sizes are 983, 228, and 92 for alternative kappa values of 0.5, 0.6, and 0.7, 
respectively. 
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Example 3 – Finding the Minimum Detectable Kappa 
Continuing with the last example, we will now determine what is the minimum value of kappa 
that can be detected with 100 subjects and power of 0.95. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Kappa Test for Agreement Between Two Raters procedure 
window by expanding Correlation, then clicking on Kappa, and then clicking on Kappa Test 
for Agreement Between Two Raters. You may then make the appropriate entries as listed 
below, or open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... K1 (K1 > K0) 
Power ...................................................... 0.95 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 200 
K1 ............................................................ Ignored since this is the Find setting 
K0 ............................................................ 0.4 
P (Category Frequencies) ....................... 0.4 0.5 0.1 
Alternative Hypothesis (H1) .................... Two-Sided 

Reports Tab 
Decimal Places - Kappa .......................... 4 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
Test Type = Two-sided Z test. 
H0: Kappa = K0 vs. H1: Kappa <> K0. 
 
 Sample       
 Size Kappa|H0 Kappa|H1   - Rating Categories -  
Power N K0 K1 Alpha Beta k Frequencies 
0.95000 200 0.4000 0.6122 0.05000 0.05000 3 0.40, 0.50, 0.10 

 

The test detects a kappa value of 0.6122 with 95% power. 
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Example 4 – Validation using Flack, Afifi, Lachenbruch, 
and Schouten (1988) 
Flack, Afifi, Lachenbruch, and Schouten (1988) page 324 presents a table (Table 2) of calculated 
sample sizes required for 80% power in a one-sided test of H1: Kappa > 0.4 vs. H1: Kappa = 0.4 
computed at K1 = 0.6 and alpha = 0.05. The sample sizes are computed for various sets of 
category frequencies. 
 

Table 2 
  

Frequencies Sample Size 
PD N PS for 80% Power 
0.50 0.26 0.24 93 
0.50 0.30 0.20 99 
0.55 0.30 0.15 109 
0.60 0.30 0.10 119 
0.60 0.21 0.19 107 

 
 
This example will replicate these results. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Kappa Test for Agreement Between Two Raters procedure 
window by expanding Correlation, then clicking on Kappa, and then clicking on Kappa Test 
for Agreement Between Two Raters. You may then make the appropriate entries as listed 
below, or open Example 4 by going to the File menu and choosing Open Example Template. 
You can see that the values have been loaded into the spreadsheet by clicking on the spreadsheet 
button. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
K1 ............................................................ 0.6 
K0 ............................................................ 0.4 
P (Category Frequencies) ....................... =C1-C5 
Alternative Hypothesis (H1) .................... One-Sided (H1: K1 > K0) 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
Test Type = One-sided Z test. 
H0: Kappa <= K0 vs. H1: Kappa > K0. 
 
 Sample       
 Size Kappa|H0 Kappa|H1   - Rating Categories -  
Power N K0 K1 Alpha Beta k Frequencies 
0.80218 93 0.40 0.60 0.05000 0.19782 3 0.50, 0.26, 0.24 
0.80143 99 0.40 0.60 0.05000 0.19857 3 0.50, 0.30, 0.20 
0.80253 109 0.40 0.60 0.05000 0.19747 3 0.55, 0.30, 0.15 
0.80286 120 0.40 0.60 0.05000 0.19714 3 0.60, 0.30, 0.10 
0.80259 106 0.40 0.60 0.05000 0.19741 3 0.60, 0.21, 0.19 
 

The sample sizes computed by PASS match those in Flack, Afifi, Lachenbruch, and Schouten 
(1988). Slight differences are due to rounding.  
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Chapter 815 

Inequality Tests 
for One 
Coefficient Alpha 
Introduction 
Coefficient alpha, or Cronbach’s alpha, is a measure of the reliability of a scale consisting of k 
parts. The k parts usually often represent k items on a questionnaire or k raters. This module 
calculates power and sample size for testing whether coefficient alpha, ρ , is different from a 
given value such as zero.   

Technical Details 
Feldt et al. (1987) has shown that if $ρ  is the estimated value of coefficient alpha computed from 
a sample of size N questionnaires with k items, the statistic W is distributed as an F ratio with 
degrees of freedom N-1 and (k-1)(N-1), where  

W =
−
−

1
1

0ρ
ρ$

 

and ρ0  is the value of ρ  assumed by the null hypothesis, H0. 

Calculating the Power 
Using the above definition of W, the power of the significance test of ρ ρ> 0 is calculated as 
follows: 

1.  Find Fα  such that ( )Prob F N k N1 1 1 1 1− − − − = −α α, ,( )( )  

2.  Compute ρC  = 
F

F
α

α

ρ+ −0 1
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3.  Compute W1  = 
1
1

1−
−
ρ
ρc

, where ρ1   is the value of ρ  at which the power is calculated. 

4.  Compute the power = 1  ( )1 1 1 1− > − − −Pr ,( )( )W FN k N

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated from the values of the other parameters. 
Under most conditions, you would either select Power and Beta or N. 

Select N when you want to determine the sample size needed to achieve a given power and alpha 
error level.  

Select Power and Beta when you want to calculate the power of an experiment.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis when in fact it is true.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  
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Sample Size 

N (Sample Size) 
Specify the number of observations in the sample. You may enter a range such as 10 to 100 by 10 
or a list of values separated by commas or blanks such as 20 50 100. 

K (Number of Items or Raters) 
K is the number of items or raters in the study. Since it is a count, it must be an integer greater 
than one. You may enter a list of values separated by blanks. 

Effect Size 

CA0 (Coefficient Alpha|H0) 
Specify the value of ρ0 , the value of coefficient alpha under the null hypothesis. Usually, this 
value will be zero, but any value between -1 and 1 is valid as long as it is not equal to CA1. 

You may enter a list of values separated by blanks such as 0 0.1 0.2. 

CA1 (Coefficient Alpha|H1) 
Specify the value of ρ1 , the value of coefficient alpha at which the power is computed. Usually, 
this value is positive, but any value between -1 and 1 is valid as long as it is not equal to CA0. 

You may enter a list of values separated by blanks such as 0.1 0.2 0.3. 

Test 

Alternative Hypothesis 
This option specifies whether the alternative hypothesis is one-sided or two-sided. It also 
specifies the direction of the hypothesis test. The null hypothesis is H0 0: ρ ρ= .The alternative 
hypothesis enters into power calculations by specifying the rejection region of the hypothesis test. 
Its accuracy is critical. 

Possible selections are: 

• H1: CA0 <> CA1 
This is the most common selection. It yields the two-tailed test. Use this option when you are 
testing whether values are different, but you do not want to specify beforehand which is 
larger. 

• H1: CA0 < CA1 
This option yields a one-tailed test. 

• H1: CA0 > CA1 
This option also yields a one-tailed test. 
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Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Finding the Power 
Suppose a study is being designed to test whether the coefficient alpha is 0.6 against the two-
sided alternative. Find the power when K = 20, alpha = 0.05, CA1 = 0.65 0.70  0.75, and N = 50  
100  200  300  500  700  1000  and 1400.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Coefficient Alpha procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for One Coefficient Alpha. You may then make the appropriate entries as listed below, or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 50 100 200 300 500 700 1000 1400 
K (Number of Items or Raters) ................ 20 
CA0 (Coefficient Alpha | H0) ................... 0.6 
CA1 (Coefficient Alpha | H1) ................... 0.65 0.70 0.75 
Alternative Hypothesis ............................ H1: CA0 ≠ CA1 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H1: CA0<>CA1 
 Sample Number Coefficient Coefficient Signif.  
 Size of Items Alpha|H1 Alpha|H0 Level  
Power (N) (K) (CA1) (CA0) (Alpha) Beta 
0.11084 50 20 0.65000 0.60000 0.05000 0.88916 
0.16444 100 20 0.65000 0.60000 0.05000 0.83556 
0.27111 200 20 0.65000 0.60000 0.05000 0.72889 
0.37314 300 20 0.65000 0.60000 0.05000 0.62686 
0.55224 500 20 0.65000 0.60000 0.05000 0.44776 
0.69191 700 20 0.65000 0.60000 0.05000 0.30809 
. . . . . . . 
. . . . . . . 
. . . . . . . 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N is the total sample size.  
K is the number of items or raters.  
CA1 is the value of coefficient alpha at which the power is computed. 
CA0 is the value of coefficient alpha under the null hypothesis. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
H0 is the null hypothesis that coefficient alpha equals CA0. 
H1 is the alternative hypothesis that coefficient alpha does not equal CA0. 
 
Summary Statements 
A sample of 50 subjects each responding to 20 items achieves 11% power to detect the difference 
between the coefficient alpha under the null hypothesis of 0.60000 and the coefficient alpha 
under the alternative hypothesis of 0.65000 using a two-sided F-test with a significance level 
of 0.05000. 
 

This report shows the values of each of the parameters, one scenario per row. The values from 
this table are plotted in the chart below.  

Plots Section 
 

 

P
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This plot shows the relationship between CA1, N, and power.  
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Example 2 – Finding the Sample Size 
Continuing with the last example, find the sample size necessary to achieve a power of 90% with 
a 0.05 significance level. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Coefficient Alpha procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for One Coefficient Alpha. You may then make the appropriate entries as listed below, or 
open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
K (Number of Items or Raters) ................ 20 
CA0 (Coefficient Alpha | H0) ................... 0.6 
CA1 (Coefficient Alpha | H1) ................... 0.65 0.70 0.75 
Alternative Hypothesis ............................ H1: CA0 ≠ CA1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H1: CA0<>CA1 
 
 Sample Number Coefficient Coefficient Signif.  
 Size of Items Alpha|H1 Alpha|H0 Level  
Power (N) (K) (CA1) (CA0) (Alpha) Beta 
0.90022 1233 20 0.65000 0.60000 0.05000 0.09978 
0.90073 265 20 0.70000 0.60000 0.05000 0.09927 
0.90261 100 20 0.75000 0.60000 0.05000 0.09739 
 

This report shows the dramatic increase in sample size that is needed to achieve the desired 
sample power as CA1 gets closer to CA0.  
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Example 3 – Validation using Bonett 
Bonett (2002) page 337 presents a table in which the sample sizes were calculated for several 
parameter configurations. When CA0 = 0, CA1 = 0.50, alpha = 0.10, beta = 0.05, and k = 2, 5, 10, 
and 100, he finds N to be 93, 59, 52, and 48, respectively.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for One Coefficient Alpha procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for One Coefficient Alpha. You may then make the appropriate entries as listed below, or 
open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.95 
Alpha ....................................................... 0.1 
N (Sample Size) ...................................... Ignored since this is the Find setting 
K (Number of Items or Raters) ................ 2 5 10 100 
CA0 (Coefficient Alpha | H0) ................... 0 
CA1 (Coefficient Alpha | H1) ................... 0.5 
Alternative Hypothesis ............................ H1: CA0 ≠ CA1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H1: CA0<>CA1 
 
 Sample Number Coefficient Coefficient Signif.  
 Size of Items Alpha|H1 Alpha|H0 Level  
Power (N) (K) (CA1) (CA0) (Alpha) Beta 
0.95176 93 2 0.50000 0.00000 0.10000 0.04824 
0.95253 59 5 0.50000 0.00000 0.10000 0.04747 
0.95047 52 10 0.50000 0.00000 0.10000 0.04953 
0.95213 48 100 0.50000 0.00000 0.10000 0.04787 
 

The sample sizes match Bonett’s results exactly.  
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Chapter 820 

Inequality Tests 
for Two Coefficient 
Alphas 
Introduction 
Coefficient alpha, or Cronbach’s alpha, is a popular measure of the reliability of a scale 
consisting of k parts. The k parts often represent k items on a questionnaire (scale) or k raters. 
This module calculates power and sample size for testing whether two coefficient alphas are 
different when the two samples are either dependent or independent.   

Technical Details 
Feldt et al. (1999) presents methods for testing one-, or two-, sided hypotheses about two 
coefficient alphas, which we label ρ1  and ρ2

N2

. The results assume that observations for each 
of items are available for one scale and observations for each of items are available for 
another scale. These sets of observations may either be from two independent groups of subjects 
(independent case) or two sets of observations on each subject (dependent case). In the dependent 
case,  and the correlation coefficient between the overall scores of each scale is 
represented by 

N1

k2k1

N N1 = 2

φ . For the independent case φ = 0 . 

Suppose $ρ1  and $ρ2  are the sample estimates of ρ1  and ρ2 , respectively. Hypothesis tests are 
based on the result that the test statistic,  
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is approximately distributed as a central F variable with degrees of freedom ν1  and ν2 . The 
values of ν1  and ν2  depend on , , , , and N1 N2 k1 k2 φ .  
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Also define 

( )( )c N k ii i i= − − =1 1 1, ,2  

Independent Case 
When the two scales are independent, there are two situations that must be considered separately. 
If c , the values of and ki >1000 25i > ν1  and ν2  are computed using  

ν1 1 1= −N  

ν2 2 1= −N  

otherwise, they are computed using 
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Dependent Case  
When the two scales are dependent, it follows that N N N1 2= = . There are two situations that 
must be considered separately. 

 If , the values of c and ki >1000 25i > ν1  and ν2  are computed using 
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Calculating the Power 
Let ρ20 be the value of coefficient alpha in the second set under H0, ρ21 be the value of coefficient 
alpha in the second set at which the power is calculated, andρ1

0 2:
be the value of coefficient alpha in 

the first set. The power of the one-sided hypothesis that H 0 1ρ ρ≤  versus the alternative that 
H 11 20:ρ ρ>  is calculated as follows: 

1.  Find Fα  such that ( )Prob F F< =α ν ν α, ,1 2  

2.  Compute ′δ  = 
1 1
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4.  Compute the power = ( )1 1 1− >Pr ,W Fν ν 2  

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options of interest for this procedure. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be calculated from the values of the other parameters. 
Under most conditions, you would either select Power and Beta or N1. 

Select N1 when you want to determine the sample size needed to achieve a given power and 
alpha error level.  

Select Power and Beta when you want to calculate the power of an experiment.  
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when you reject the null hypothesis when in fact it is true.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size – Set 1 

N1 (Sample Size in Set 1) 
N1 is the sample size (number of observations or subjects) in dataset one. Feldt (1999) states that 
it is ill-advised to use sample sizes less than 30. 

You may enter a list of values separated with blanks or a range of values. 

K1 (Items/Scale in Set 1) 
K1 is the number of items or raters in dataset one. Since it is a count, it must be an integer. K1 
must be greater than or equal to two. 

You may enter a list of values separated with blanks or a range of values. 

Sample Size – Set 1 

N2 (Sample Size in Set 2) 
N2 is the sample size (number of observations or subjects) in dataset two. Feldt (1999) states that 
it is ill-advised to use sample sizes less than 30. Note that if phi is non-zero, this value will be 
forced equal to N1 regardless of what is entered here. 

For ease of input, when phi is non-zero, you can enter multiples of N1. For example, all of the 
following entries are allowed: 

N1 2N1 0.5N1 

You may enter a list of values separated with blanks or a range of values. 
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K2 (Items/Scale in Set 2) 
K2 is the number of items or raters in dataset two. Since it is a count, it must be an integer greater 
than or equal to two.  

You may enter a list of values separated with blanks or a range of values. 

For ease of input, you can enter multiples of K1. For example, all of the following entries are 
allowed: 

K1 2K1 0.5K1 

Effect Size – Coefficient Alpha Set 1 

CA1 (Coefficient Alpha Set 1) 
Specify the value of ρ1 , the value of coefficient alpha, for dataset one. Often, this value will be 
zero, but any value between -1 and 1 is valid as long as it is not equal to CA21. 

You may enter a list of values separated with blanks or a range of values. 

Effect Size – Coefficient Alpha Set 2 

CA20 (Coefficient Alpha Set 2|H0) 
Enter the value of coefficient alpha in dataset two under the null hypothesis. The null hypothesis 
is H0: CA1=CA20, so often you will set this value equal to CA1. Any value between -1 and 1 
(non-inclusive) is valid as long as it is not equal to CA21.  

You may enter CA1 to indicate that you want the value of CA1 copied here. You may also enter a 
multiple of CA1 such as 1.5CA1. 

You may enter a list of values separated with blanks or a range of values. 

CA21 (Coefficient Alpha Set 2|H1) 
Enter the value of coefficient alpha in dataset two at which the power is computed. Any value 
between -1 and 1 (non-inclusive) is valid as long as it is not equal to CA20. The values of CA20 
and CA21 should match the direction set by the ‘Alternative Hypothesis’ option. 

You may enter a list of values separated with blanks or a range of values. 

Effect Size – Correlation 

Phi (Correlation Between Sets) 
This option implicitly specifies the two datasets as being either independent (datasets on different 
subjects) or dependent (both datasets on the same subjects). Suppose you calculate the average 
score for each subject for both dataset one and dataset two. This parameter is the correlation 
between those two averages over all subjects. If the correlation is zero, the two datasets are 
assumed to be independent. That is, it is assumed that they come from different sets of subjects. 

If the correlation is non-zero, the two datasets are assumed to be dependent. That is, it is assumed 
that both sets of items were measured on the same subjects. Typical values in this case are 
between 0.2 and 0.7. When the datasets are dependent, it is assumed that N1=N2. 

Since this is a correlation, the theoretical range is from -1 to 1. Typical values are 0.0 for 
independent designs and between 0.2 and 0.7 for dependent designs. 
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Test 

Alternative Hypothesis 
This option specifies whether the alternative hypothesis is one-sided or two-sided. It also 
specifies the direction of the hypothesis test. The null hypothesis is 210 : ρρ =H . The alternative 
hypothesis enters into power calculations by specifying the rejection region of the hypothesis test. 
Its accuracy is critical. 

Possible selections are: 

• H1: CA1 <> CA2 
This is the most common selection. It yields the two-tailed test. Use this option when you are 
testing whether values are different, but you do not want to specify beforehand which is 
larger. 

• H1: CA1 < CA2 
This option yields a one-tailed test. 

• H1: CA1 > CA2 
This option also yields a one-tailed test. 

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Finding the Power 
Suppose a study is being designed to compare the coefficient alphas of two scales. The 
researchers are going to use a two-sided F-test at a significance level of 0.05. Past experience has 
shown that CA1 is approximately 0.4. The researchers will use different subjects in each dataset. 
Find the power when K1 = K2 = 10, CA20 = CA1, N1 = 50, 100, 150, 200, 250, and 300, N2 = 
N1, and CA21 = 0.6 and 0.7.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Coefficient Alphas procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for Two Coefficient Alphas. You may then make the appropriate entries as listed below, 
or open Example 1 by going to the File menu and choosing Open Example Template. 
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Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N1 (Sample Size in Set 1) ....................... 50 to 300 by 50 
K1 (Items/Scale in Set 1) ........................ 10 
N2 (Sample Size in Set 2) ....................... N1 
K2 (Items/Scale in Set 2) ........................ K1 
CA1 (Coefficient Alpha Set 1) ................. 0.4 
CA20 (Coefficient Alpha Set 2|H0) ......... CA1 
CA21 (Coefficient Alpha Set 2|H1) ......... 0.60 0.70  
Phi (Correlation Between Sets) ............... 0 
Alternative Hypothesis (H1) .................... H1: CA1 ≠ CA2 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Comparing Two Coefficient Alphas 
H1: CA1 <> CA2 
 
   Coef. Coef. Coef.  Corr.  
 Sample Number Alpha Alpha Alpha Signif. Between  
 Sizes of Items Set 2|H1 Set 2|H0 Set 1 Level Datasets  
Power N1/N2 K1/K2 (CA21) (CA20) (CA1) (Alpha) (Phi) Beta 
0.2642 50/50 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.7358 
0.4775 100/100 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.5225 
0.6481 150/150 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.3519 
0.7725 200/200 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.2275 
0.8576 250/250 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.1424 
0.9132 300/300 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.0868 
0.6253 50/50 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.3747 
0.9026 100/100 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0974 
0.9793 150/150 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0207 
0.9961 200/200 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0039 
0.9993 250/250 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0007 
0.9999 300/300 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0001 
 
Report Definitions 
H0, H1 abbreviate the null and alternative hypotheses, respectively. 
Power is the probability of rejecting H0 when it is false. It should be close to one. 
N1 & N2 are the sample sizes of datasets one and two, respectively. 
K1 & K2 are the number of items in datasets one and two, respectively. 
CA21 is the coefficient alpha in dataset two at which the power is calculated.  
CA20 is the coefficient alpha in dataset two under H0.  
CA1 is the coefficient alpha in dataset one.  
Phi is the correlation between the average scores of each of the two datasets. 
Alpha is the probability of a type-I error: rejecting H0 when it is true. 
Beta is the probability of a type-II error: accepting H0 when it is false. Power = 1 - Beta. 
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Summary Statements 
Samples of 10 items on 50 subjects in dataset one and 10 items on 50 subjects in dataset two 
achieve 26% power to detect the difference between the coefficient alphas in the two datasets. 
Under the null hypothesis, the coefficient alphas in datasets one and two are 0.4000 and 
0.4000, respectively. The power is computed assuming that the coefficient alpha of dataset two 
is actually 0.6000. The test statistic used is the two-sided F-test. The significance level of 
the test was 0.0500. 
 

This report shows the values of each of the parameters, one scenario per row. The values from 
this table are plotted in the chart below.  

Plots Section 
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This plot shows the relationship between CA21, N1, and power.  
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Example 2 – Finding the Sample Size 
Continuing with the last example, find the sample size necessary to achieve a power of 90% at the 
0.05 significance level. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Coefficient Alphas procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for Two Coefficient Alphas. You may then make the appropriate entries as listed below, 
or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N1 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N1 (Sample Size in Set 1) ....................... Ignored since this is the Find setting 
K1 (Items/Scale in Set 1) ........................ 10 
N2 (Sample Size in Set 2) ....................... N1 
K2 (Items/Scale in Set 2) ........................ K1 
CA1 (Coefficient Alpha Set 1) ................. 0.4 
CA20 (Coefficient Alpha Set 2|H0) ......... CA1 
CA21 (Coefficient Alpha Set 2|H1) ......... 0.60 0.70  
Phi (Correlation Between Sets) ............... 0 
Alternative Hypothesis (H1) .................... H1: CA1 ≠ CA2 

Output 
Click the Run button to perform the calculations and generate the following output. 
 

Numeric Results for Comparing Two Coefficient Alphas 
H1: CA1 <> CA2 
 
   Coef. Coef. Coef.  Corr.  
 Sample Number Alpha Alpha Alpha Signif. Between  
 Sizes of Items Set 2|H1 Set 2|H0 Set 1 Level Datasets  
Power N1/N2 K1/K2 (CA21) (CA20) (CA1) (Alpha) (Phi) Beta 
0.9000 286/286 10/10 0.6000 0.4000 0.4000 0.0500 0.0000 0.1000 
0.9026 100/100 10/10 0.7000 0.4000 0.4000 0.0500 0.0000 0.0974 
 

This report shows that 286 subjects per dataset are needed when CA21 is 0.60 and 100 subjects 
per dataset are needed when CA21 is 0.70.  
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Example 3 – Validation using Feldt 
Feldt et al. (1999) presents an example in which CA1 = 0, CA20 = 0, CA21 = 0.5, alpha = 0.05, 
Phi = 0, N1 = N2 = 60,and k = 5. They find the power of a one-sided test to be 0.761.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Tests for Two Coefficient Alphas procedure window by 
expanding Correlation, then clicking on Coefficient (Cronbach’s) Alpha, and then clicking on 
Tests for Two Coefficient Alphas. You may then make the appropriate entries as listed below, 
or open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N1 (Sample Size in Set 1) ....................... 60 
K1 (Items/Scale in Set 1) ........................ 5 
N2 (Sample Size in Set 2) ....................... N1 
K2 (Items/Scale in Set 2) ........................ K1 
CA1 (Coefficient Alpha Set 1) ................. 0.0 
CA20 (Coefficient Alpha Set 2|H0).......... CA1 
CA21 (Coefficient Alpha Set 2|H1).......... 0.5  
Phi (Correlation Between Sets) ............... 0 
Alternative Hypothesis (H1) .................... H1: CA1 < CA2 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results when H1: CA0<>CA1 
 
   Coef. Coef. Coef.  Corr.  
 Sample Number Alpha Alpha Alpha Signif. Between  
 Sizes of Items Set 2|H1 Set 2|H0 Set 1 Level Datasets  
Power N1/N2 K1/K2 (CA21) (CA20) (CA1) (Alpha) (Phi) Beta 
0.7655 60/60 5/5 0.5000 0.0000 0.0000 0.0500 0.0000 0.2345 
 

Note that PASS’s result is slightly different from Feldt’s because PASS uses fractional degrees of 
freedom and Feldt rounds to the closest integer. Although the difference in power is small, 
allowing fractional degrees of freedom is more accurate. 
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Chapter 850 

Cox Regression 
Introduction 
Cox proportional hazards regression models the relationship between the hazard function ( )λ t X|  
of survival time and k covariates using the following formula 

( )
( )

log
|λ

λ
β β β

t X
t

=  X X Xk k
0

1 1 2 2

⎛

⎝
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⎞

⎠
⎟ + + +K  

where ( )λ0 t  is the baseline hazard. Note that the covariates may be discrete or continuous. 

This procedure calculates power and sample size for testing the hypothesis that β1 0=  versus the 
alternative that β1 = B . Note that β1  is the change in log hazards for a one-unit change in  
when the rest of the covariates are held constant. The procedure assumes that this hypothesis will 
be tested using the Wald (or score) statistic 

X1

( )
z =  

Var

$

$

β

β
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Power Calculations 
Suppose you want to test the null hypothesis that β1 0=  versus the alternative that β1 = B . 
Hsieh and Lavori (2000) gave a formula relating sample size, α , β , and B when  is normally 
distributed. The sample size formula is 

X1

( )
( )D =  
z z

R B
1 2 1

2

2 2 21
− −+

−
α β

σ
/  

where D is the number of events,  is the variance of , and σ 2 X1 R2  is the proportion of variance 
explained by the multiple regression of  on the remaining covariates. It is interesting to note 
that the number of censored observations does not enter in to the power calculations. To obtain a 
formula for the sample size, N, we inflate D by dividing by P, the proportion of subjects that fail. 

X1
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Thus, the formula for N is 

( )
( )N =  
z z

P R B
1 2 1

2

2 2 21
− −+

−
α β

σ
/  

This formula is an extension of an earlier formula for the case of a single, binary covariate 
derived by Schoenfeld (1983). Thus, it may be used with discrete or continuous covariates.  

Assumptions 
It is important to note that this formulation assumes that proportional hazards model with k 
covariates is valid. However, it does not assume exponential survival times. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. Under most 
situations, you will select either Power and Beta for a power analysis or N for sample size 
determination. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In 
this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal 
probabilities of the event of interest when in fact they are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  
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Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error (alpha). A type-I 
error occurs when you reject the null hypothesis of equal probabilities when in fact they are 
equal. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size 

N (Sample Size) 
This option specifies the total number of observations in the sample. You may enter a single 
value or a list of values.  

Note that when the Overall Event Rate is set to 1.0, the sample size becomes the number of 
events. 

P (Overall Event Rate) 
Enter one or more values for the event rate. The event rate is the proportion of subjects in which 
the event of interest occurs during the duration of the study. This is the proportion of non-
censored subjects. Since the values entered here are proportions, they must be in the range 

. 0 1< ≤P

Note that when this value is set to 1.0, the sample size is the number of events (deaths). 

Effect Size – Hazard Ratio 

B (Log Hazard Ratio) 
This procedure calculates power or sample size for testing the hypothesis that β1 0=  versus the 
alternative that β1 = B  in a Cox regression. Enter one or more values of B here. 

B is the predicted change in log (base e) hazards corresponding to a one unit change in X1 when 
the other covariates are held constant. Thus, if you want to detect a hazard ratio of 1.5, enter 
ln(1.5) = 0.4055. Although any non-zero value may be entered, common values are between -3 
and 3. 

Effect Size – Covariates (X1 is the 
Variable of Interest) 

R-Squared of X1 with Other X’s 
This is the R-Squared that is obtained when X1 is regressed on the other X’s (covariates) in the 
model. Use this to account for the influence on power and sample size of adding other covariates. 
Note that the number of additional variables does not matter in this formulation. Only their 
overall relationship with X1 through this R-Squared value is used.  

Of course, this value is restricted to being greater than or equal to zero and less than one. Use 
zero when there are no other covariates. 
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S (Standard Deviation of X1) 
Enter an estimate of the standard deviation of X1, the predictor variable of interest. The 
formulation used here assumes that X1 follows the normal distribution. However, you can obtain 
approximate results for non-normal variables by putting in the correct value here. For example, if 
X1 is binary, the standard deviation is given by ( )p p1−  where p is the proportion of either of 
the binary values in the population of X1.  

If you don’t have an estimate, you can press the SD button to obtain a window that will help you 
determine a rough estimate of the standard deviation. 

Test 

Alternative Hypothesis 
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the 
value of alpha is halved by PASS. Everything else remains the same. 

Note that the accepted procedure is to use the Two Sided option unless you can justify using a 
one-sided test.  

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Power for Several Sample Sizes 
Cox regression will be used to analyze the power of a survival time study. From past experience, 
the researchers want to evaluate the sample size needs for detecting regression coefficients of 0.2 
and 0.3 for the independent variable of interest. The variable has a standard deviation of 1.20. The 
R-squared of this variable with seven other covariates is 0.18.   

The event rate is thought to be 70% over the 3-year duration of the study. The researchers will 
test their hypothesis using a 5% significance level with a two-sided Wald test. They decide to 
calculate the power at sample sizes between 5 and 250. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Cox Regression procedure window by clicking on 
Regression, and then clicking on Cox Regression. You may then make the appropriate entries as 
listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 



Cox Regression  850-5 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 5 to 250 by 40 
P (Overall Event Rate) ............................ 0.70 
B (Log Hazard Ratio) .............................. 0.2 0.3 
R-Squared of X1 with Other X’s .............. 0.18 
S (Standard Deviation of X1) .................. 1.2 
Alternative Hypothesis ............................ Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
     R-Squared   
 Sample Reg. S.D. Event X1 vs Two-  
 Size Coef. of X1 Rate Other X's Sided  
Power (N) (B) (SD) (P) (R2) Alpha Beta 
0.06017 5 0.2000 1.2000 0.7000 0.1800 0.05000 0.93983 
0.22959 45 0.2000 1.2000 0.7000 0.1800 0.05000 0.77041 
0.38837 85 0.2000 1.2000 0.7000 0.1800 0.05000 0.61163 
0.52908 125 0.2000 1.2000 0.7000 0.1800 0.05000 0.47092 
0.64643 165 0.2000 1.2000 0.7000 0.1800 0.05000 0.35357 
0.74004 205 0.2000 1.2000 0.7000 0.1800 0.05000 0.25996 
0.81223 245 0.2000 1.2000 0.7000 0.1800 0.05000 0.18777 
0.08849 5 0.3000 1.2000 0.7000 0.1800 0.05000 0.91151 
0.44815 45 0.3000 1.2000 0.7000 0.1800 0.05000 0.55185 
0.71043 85 0.3000 1.2000 0.7000 0.1800 0.05000 0.28957 
0.86202 125 0.3000 1.2000 0.7000 0.1800 0.05000 0.13798 
0.93865 165 0.3000 1.2000 0.7000 0.1800 0.05000 0.06135 
0.97412 205 0.3000 1.2000 0.7000 0.1800 0.05000 0.02588 
0.98953 245 0.3000 1.2000 0.7000 0.1800 0.05000 0.01047 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. 
B is the size of the regression coefficent to be detected. 
SD is the standard deviation of X1. 
P is the event rate. 
R2 is the R-squared achieved when X1 is regressed on the other covariates. 
Alpha is the probability of rejecting a true null hypothesis. 
Beta is the probability of accepting a false null hypothesis. 
 
Summary Statements 
A Cox regression of the log hazard ratio on a covariate with a standard deviation of 1.2000 
based on a sample of 5 observations achieves 6% power at a 0.93983 significance level to detect 
a regression coefficient equal to 0.2000. The sample size was adjusted since a multiple 
regression of the variable of interest on the other covariates in the Cox regression is 
expected to have an R-Squared of 0.1800. The sample size was adjusted for an anticipated event 
rate of 0.7000. 
 

This report shows the power for each of the scenarios.  
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Example 2 – Validation using Hsieh 
Hsieh and Lavori (2000) present an example which we will use to validate this program. In this 
example, B = 1.0, S = 0.3126, R2 = 0.1837, P = 0.738, one-sided alpha = 0.05, and power = 0.80. 
They calculated N = 107.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Cox Regression procedure window by clicking on 
Regression, and then clicking on Cox Regression. You may then make the appropriate entries as 
listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
P (Overall Event Rate) ............................ 0.738 
B (Log Hazard Ratio) .............................. 1.0 
R-Squared of X1 with Other X’s .............. 0.1837 
S (Standard Deviation of X1) .................. 0.3126 
Alternative Hypothesis ............................ One-Sided 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
     R-Squared   
 Sample Reg. S.D. Event X1 vs One-  
 Size Coef. of X1 Rate Other X's Sided  
Power (N) (B) (SD) (P) (R2) Alpha Beta 
0.80321 106 1.000 0.313 0.738 0.184 0.05000 0.19679 
 

Note that PASS calculated 106 rather than the 107 calculated by Hsieh and Lavori (2000). The 
discrepancy is due to the intermediate rounding that they did. To show this, we will run a second 
example from Hsieh and Lavori in which R2 = 0 and P = 1.0. In this case, N = 64. 

Numeric Results with R2 = 0 and P = 1.0 
 
     R-Squared   
 Sample Reg. S.D. Event X1 vs One-  
 Size Coef. of X1 Rate Other X's Sided  
Power (N) (B) (SD) (P) (R2) Alpha Beta 
0.80399 64 1.000 0.313 1.000 0.000 0.05000 0.19601 
 

Note that PASS also calculated 64. Hsieh and Lavori obtained the 107 by adjusting this 64 for P 
first and then for R2. PASS does both adjustments at once, obtaining the 106. Thus, the difference 
is due to intermediate rounding. 

Example 3 – Validation for Binary X1 using Schoenfeld 
Schoenfeld (1983), page 502, presents an example for the case when X1 is binary. In this 
example, B = ln(1.5) = 0.4055, S = 0.5, R2 = 0.0, P = 0.71, one-sided alpha = 0.05, and power = 
0.80. Schoenfeld calculated N = 212. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Cox Regression procedure window by clicking on 
Regression, and then clicking on Cox Regression. You may then make the appropriate entries as 
listed below, or open Example 3 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
P (Overall Event Rate) ............................ 0.71 
B (Log Hazard Ratio) .............................. 0.4055 
R-Squared of X1 with Other X’s .............. 0.0 
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Data Tab (continued) 
S (Standard Deviation of X1) .................. 0.5 
Alternative Hypothesis ............................ One-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
     R-Squared   
 Sample Reg. S.D. Event X1 vs One-  
 Size Coef. of X1 Rate Other X's Sided  
Power (N) (B) (SD) (P) (R2) Alpha Beta 
0.80028 212 0.406 0.500 0.710 0.000 0.05000 0.19972 
 

Note that PASS also obtains N = 212.  
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Linear Regression 
Introduction 
Linear regression is a commonly used procedure in statistical analysis. One of the main objectives 
in linear regression analysis is to test hypotheses about the slope (sometimes called the regression 
coefficient) of the regression equation. This module calculates power and sample size for testing 
whether the slope is a value other than the value specified by the null hypothesis.  

Difference between Linear Regression and Correlation 
The correlation coefficient is used when both X and Y are from the normal distribution (in fact, 
the assumption actually is that X and Y follow a bivariate normal distribution). That is, X is 
assumed to be a random variable whose distribution is normal. In the linear regression context, no 
statement is made about the distribution of X. In fact, X is not even a random variable. Instead, it 
is a set of fixed values such as 10, 20, 30 or -1, 0, 1. Because of this difference in definition, we 
have included both Linear Regression and Correlation algorithms. They gave different results. 
This module deals with the Linear Regression (fixed X) case. 

Technical Details 
Suppose that the dependence of a variable Y on another variable X can be modeled using the 
simple linear equation 

Y = A + BX 

In this equation, A is the Y-intercept, B is the slope, Y is the dependent variable, and X is the 
independent variable.  

The nature of the relationship between Y and X is studied using a sample of N observations. Each 
observation consists of a data pair: the X value and the Y value. The values of A and B are 
estimated from these observations. Since the linear equation will not fit the observations exactly, 
estimated values of A and B must be used. These estimates are found using the method of least 
squares. Using these estimated values, each data pair may be modeled using the equation 

Y a bX ei i i= + +  

Note that a and b are the estimates of the population parameters A and B. The e values represent the 
discrepancies between the estimated values (a + bX) and the actual values Y. They are called the 
errors or residuals.  

If it is assumed that these e values are normally distributed, tests of hypotheses about A and B can 
be constructed. Specifically, we can employ an F ratio to test the null hypothesis that the slope is B0 
versus the alternative hypothesis that the slope is B (B not B0). The power function of this F test can 
be written 
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( )Power F F= >Pr α  

where  is the critical value based on the central-F distribution with 1 and N - 2 degrees of 
freedom and the significant level

Fα

α and F is distributed as a non-central F with degrees of 
freedom 1 and N - 2 and non-centrality parameterλ . The value of λ is  
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The values of each of the parameters α , β , , N, SX, and B can be determined from the others 
using the above formulation. 

σ 2

Note that the power for a one-sided test may be found by using 2α  for α in the above formulation. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. Under most 
situations, you will select either Power and Beta for a power analysis or N for sample size 
determination. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment.  

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  
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Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error (alpha). A type-I 
error occurs when you reject the null hypothesis when in fact it is true. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size 

N (Sample Size) 
This is the number of observations in the study. 

Effect Size – Slope 

B0 (Slope|H0) 
This is the value of the slope assumed by the null hypothesis. Often this value is set to zero, but 
this is not necessary. The alternative hypothesis is that the slope is not equal to this value. 

B1 (Slope|H1) 
This is the value of the slope at which the power is computed. The hypothesis being tested is that 
the slope is some value other than B0. 

Effect Size – Standard Deviation of 
X’s 

SX (Standard Deviation of X’s) 
This is the standard deviation of the X values in the sample. It is not necessarily the standard 
deviation of X in the population. For example, suppose the X values are five -1's and five 1's. The 
computed standard deviation of these values (dividing by N rather than N - 1) is 1.0.  

You will often want to compute the power or sample size for a specific set of X values. Instead of 
computing SX by hand, you can use the keyword XS (short for X’s) followed by the list of X 
values. For example, the phrase 

XS -1,1 

is translated into a 1.0 (which is the standard deviation of these two values). This calculation 
assumes that the sample is allocated equally to the two values. Hence, an N of 10 implies that five 
are assigned to -1 and five to 1. 

If you are planning a study involving two random variables, X and Y, that come from a bivariate 
normal population, you should enter the actual standard deviation of X here. 
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Effect Size – Residual Variance 
Calculation 

Residual Variance Method 
The standard deviation of the residuals is needed for the power and sample size calculations. 
These residuals are the e  in the regression model i

Y a bX ei i i= + +  

However, their standard deviation is not available until after the study is complete. PASS 
provides three methods for specifying the standard deviation of the residuals: Std Deviation of Y, 
Correlation, and specifying it directly.  

SY (Standard Deviation of Y) 
Enter an estimate of the standard deviation of Y. This standard deviation ignores X. An estimate 
of this value must be found from previous studies, pilot studies, or using your best guess. This 
option is used when 'Residual Variance Method' is set to 'SY'. 

When this value is used, the standard deviation of the residuals is computed using the relationship 

σ σ= −Y B SX2 2 2  

This value must be greater than zero. 

R (Correlation) 
Enter an estimate of the correlation between Y and the X values. An estimate of this correlation 
must be found from previous studies, pilot studies, or using your best guess. This value must be 
greater than zero and less than one—negative values are allowed. This option is used when 
'Residual Variance Method' is set to 'R'. 

When this method is used, the standard deviation of the residuals is computed using the 
relationship 

( )σ = −B SX R1 12/  

where R is the correlation. 

S (Standard Deviation of Residuals) 
Enter an estimate for the value of the standard deviation of the residuals. This option is used when 
'Residual Variance Method' is set to 'S'. 

Test 

Alternative Hypothesis 
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the 
value of alpha is halved by PASS. Everything else remains the same. 

Note that the accepted procedure is to use the Two Sided option unless you can justify using a 
one-sided test.  
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Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 

Example 1 – Calculating the Power 
Suppose a power analysis must be conducted for a linear regression study that will test the 
relationship between two variables, Y and X. The test will look at the power using two 
significance levels, 0.01 and 0.05 and several sample sizes between 5 and 85. Based on previous 
studies, the standard deviation of Y will be assumed to be 1.0. The standard deviation of the X’s in 
the sample will also be assumed as 1.0. The experimenter decides that unless the slope is at least 
0.5, the relationship between X and Y is too weak to be considered.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Linear Regression procedure window by clicking on 
Regression, and then clicking on Linear Regression. You may then make the appropriate entries 
as listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.01 0.05 
N (Sample Size) ...................................... 5 to 85 by 10 
B0 (Slope|H0) .......................................... 0.0 
B1 (Slope|H1) .......................................... 0.5 
SX (Standard Deviation of X’s) ............... 1 
Residual Variance Method ...................... SY (Std. Dev. of Y) 
SY (Standard Deviation of Y) .................. 1 
Alternative Hypothesis ............................ Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Testing of B=B0 where B0 = 0.00 
 
   Standard Standard Standard   
 Sample  Deviation Deviation Deviation   
 Size Slope of X of Y of Residuals   
Power (N) (B) (SX) (SY) (S) Alpha Beta 
0.03533 5 0.50 1.00 1.00 0.87 0.01000 0.96467 
0.15194 5 0.50 1.00 1.00 0.87 0.05000 0.84806 
0.26836 15 0.50 1.00 1.00 0.87 0.01000 0.73164 
0.54369 15 0.50 1.00 1.00 0.87 0.05000 0.45631 
0.54097 25 0.50 1.00 1.00 0.87 0.01000 0.45903 
0.78944 25 0.50 1.00 1.00 0.87 0.05000 0.21056 
0.74759 35 0.50 1.00 1.00 0.87 0.01000 0.25241 
0.91225 35 0.50 1.00 1.00 0.87 0.05000 0.08775 
0.87415 45 0.50 1.00 1.00 0.87 0.01000 0.12585 
0.96601 45 0.50 1.00 1.00 0.87 0.05000 0.03399 
0.94183 55 0.50 1.00 1.00 0.87 0.01000 0.05817 
0.98755 55 0.50 1.00 1.00 0.87 0.05000 0.01245 
0.97470 65 0.50 1.00 1.00 0.87 0.01000 0.02530 
0.99564 65 0.50 1.00 1.00 0.87 0.05000 0.00436 
0.98953 75 0.50 1.00 1.00 0.87 0.01000 0.01047 
0.99853 75 0.50 1.00 1.00 0.87 0.05000 0.00147 
0.99585 85 0.50 1.00 1.00 0.87 0.01000 0.00415 
0.99952 85 0.50 1.00 1.00 0.87 0.05000 0.00048 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. To conserve resources, it should be small. 
B0 is the slope under the null hypothesis. 
B is the slope at which the power is calculated. 
SX is the standard deviation of the X values. 
SY is the standard deviation of Y. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
Summary Statements 
A sample size of 5 achieves 4% power to detect a change in slope from 0.00 under the null 
hypothesis to 0.50 under the alternative hypothesis when the standard deviation of the X's is 
1.00, the standard deviation of Y is 1.00, and the two-sided significance level is 0.01000. 
 

This report shows the calculated sample size for each of the scenarios.  



Linear Regression  855-7 

Plots Section 
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This plot shows the power versus the sample size for the two values of alpha. 

Example 2 – Validation using Neter, Wasserman, and 
Kutner 
Neter, Wasserman, and Kutner (1983) pages 71 and 72 present a power analysis when N = 10, 
Slope = 0.25, alpha = 0.05, ( )SX = =3400 10 18 439/ . , and 

( ) ( )SY = + =10 0 25 3400 10 5590152. / . . They found the power to be approximately 0.97.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Linear Regression procedure window by clicking on 
Regression, and then clicking on Linear Regression. You may then make the appropriate entries 
as listed below, or open Example 2 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 10 
B0 (Slope|H0) .......................................... 0.00 
B1 (Slope|H1) .......................................... 0.25 
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Data Tab (continued) 
SX (Standard Deviation of X’s) ............... 18.439 
Residual Variance Method ...................... SY (Std. Dev. of Y) 
SY (Standard Deviation of Y) .................. 5.59015 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Testing of B=B0 where B0 = 0.00 
 
   Standard Standard Standard   
 Sample  Deviation Deviation Deviation   
 Size Slope of X of Y of Residuals   
Power (N) (B) (SX) (SY) (S) Alpha Beta 
0.97975 10 0.25 18.44 5.59 3.16 0.05000 0.02025 
 

The power of 0.97975 matches their result to two decimals. Note that they used interpolation 
from a table to obtain their answer.  
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Chapter 856 

Confidence 
Intervals for Linear 
Regression Slope 
Introduction 
This routine calculates the sample size necessary to achieve a specified distance from the slope to 
the confidence limit at a stated confidence level for a confidence interval about the slope in 
simple linear regression.  

Caution: This procedure assumes that the slope and standard deviation/correlation estimates of 
the future sample will be the same as the slope and standard deviation/correlation estimates that 
are specified. If the slope and standard deviation/correlation estimates are different from those 
specified when running this procedure, the interval width may be narrower or wider than 
specified. 

Technical Details 
For a single slope in simple linear regression analysis, a two-sided, 100(1 – α)% confidence 
interval is calculated by  

12,2/11 bn stb −−± α  

where b1 is the calculated slope and  is the estimated standard deviation of b1, or 
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The value s2 is often obtained from regression tables as MSE. 
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A one-sided 100(1 – α)% upper confidence limit is calculated by 

12,11 bn stb −−+ α  

Similarly, the one-sided 100(1 – α)% lower confidence limit is 

12,11 bn stb −−− α  

Each confidence interval is calculated using an estimate of the slope plus and/or minus a quantity 
that represents the distance from the mean to the edge of the interval. For two-sided confidence 
intervals, this distance is sometimes called the precision, margin of error, or half-width. We will 
label this distance, D.  

The basic equation for determining sample size when D has been specified is 

12,2/1 bn stD −−= α  

This equation can be solved for any of the unknown quantities in terms of the others. The value 
α / 2 is replaced by α  when a one-sided interval is used. 

In this procedure, the slope and the standard deviation of the X’s are entered as input, where 
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One of three different additional inputs can be used to calculate s. 

1. Standard deviation of the Y’s: 
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In this case s is generated using 
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  which is often obtained from regression tables as the square root of MSE.  

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items 
are drawn from a population using simple random sampling and a confidence interval is 
calculated for each sample, the proportion of those intervals that will include the true population 
slope is 1 – α. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters.  

Confidence 

Confidence Level 
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items 
are drawn from a population using simple random sampling and a confidence interval is 
calculated for each sample, the proportion of those intervals that will include the true population 
slope is 1 – α.  

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 
0.90, 0.95 or 0.90 to 0.99 by 0.01. 
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Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at 
random from the population to be in the study. 

N must be greater than or equal to 3. 

You can enter a single value or a range of values. 

Precision 

Distance from Slope to Limit(s) 
This is the distance from the confidence limit(s) to the sample slope. For two-sided intervals, it is 
also known as the precision, half-width, or margin of error. 

You can enter a single value or a list of values. The value(s) must be greater than zero.  

Regression – Slope 

B (Slope) 
Enter the magnitude of the sample slope. 

In the linear equation, Y=A+BX, B represents the slope of the line relating the dependent variable 
Y to the independent variable X.  

Caution: The sample size estimates for this procedure assume that the slope that is achieved when 
the confidence interval is produced is the same as the slope entered here. If the sample slope is 
different from the one specified here, the width of the interval may be narrower or wider than 
specified. 

You can enter a single value or a range of values such as 1,2,3. 

This value must be greater than zero.  

Regression – Standard Deviation of 
X’s 

SX (Standard Deviation of X’s) 
This is the standard deviation of the X values in the sample. 

Caution: The sample size estimates for this procedure assume that the SX that is achieved when 
the confidence interval is produced is the same as the SX entered here. If the sample SX is 
different from the one specified here, the width of the interval may be narrower or wider than 
specified. 

It is assumed that the standard deviation formula used in calculating SX uses the divisor N-1.  

The value must be greater than zero.  
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Regression – Residual Variance 
Calculation 

Residual Variance Method 
Three methods can be used to calculate the standard deviation of the residuals. This option 
specifies which method should be used. 

• SY 
This option specifies that the formula 

S = SQRT[SY^2 – (B*SX)^2] 

should be used to calculate the standard deviation of the residuals. Notice that this formula 
requires only SY, SX, and B (the correlation is not used). 

• R 
This option specifies that the formula 

S=B(SX)SQRT[1/R^2 – 1] 

should be used to calculate the standard deviation of the residuals. Notice that this formula 
requires only SX, B, and R (the value of SY is not used). 

• S 
This option specifies the value of S directly. The values of SY and R are not used. 

SY (Standard Deviation of Y) 
This is the standard deviation of the Y values in the sample. 

This value is only used when the Residual Variance Method is set to 'SY (Std. Dev. of Y)'. 

Caution: The sample size estimates for this procedure assume that the SY that is achieved when 
the confidence interval is produced is the same as the SY entered here. If the sample SY is 
different from the one specified here, the width of the interval may be narrower or wider than 
specified. 

It is assumed that the standard deviation formula used in calculating SY uses the divisor N-1.  

The value must be greater than zero. 

R (Correlation) 
This is an estimate of the correlation between Y and X. 

This value is only used when the Residual Variance Method is set to 'R (Correlation)'. 

Caution: The sample size estimates for this procedure assume that the correlation that is achieved 
when the confidence interval is produced is the same as the correlation entered here. If the sample 
correlation is different from the one specified here, the width of the interval may be narrower or 
wider than specified. 

Range: 0 < R < 1 

Note that R cannot be 0 or negative. 

S (Standard Deviation of Residuals) 
This is the standard deviation of the residuals from the regression of Y on X. 
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This value is only used when the Residual Variance Method is set to 'S (Std. Dev. of Residuals)'. 

Caution: The sample size estimates for this procedure assume that the S that is achieved when the 
confidence interval is produced is the same as the S entered here. If the sample S is different from 
the one specified here, the width of the interval may be narrower or wider than specified. 

It is assumed that the standard deviation formula used in calculating S is sqrt(MSE), which uses 
the divisor N-2. 

The value (or values) must be greater than zero. 

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the interval to be used will be a two-sided confidence interval, an interval that 
has only an upper limit, or an interval that has only a lower limit. 

Iterations Tab 
This tab sets an option used in the iterative procedures. 

Maximum Iterations  

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% 
confidence interval for the slope such that the distance from the slope to the limits is no more than 
1 unit. The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The 
estimated slope is 1.7 and the standard deviation of the X’s is 11.2. The standard deviation of the 
residuals estimate, based on the MSE from a similar study, is 48.6. Instead of examining only the 
interval width of 1, a series of widths from 0.5 to 1.5 will also be considered.  
The goal is to determine the necessary sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for Linear Regression Slope 
procedure window by clicking on Regression, and then clicking on Confidence Intervals for 
Linear Regression Slope. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 0.99 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Distance from Slope to Limits ................. 0.5 to 1.5 by 0.1 
B (Slope) ................................................. 1.7 
SX (Standard Deviation of X’s) ............... 11.2 
Residual Variance Method ...................... S (Std. Dev. of Residuals) 
S (Standard Deviation of Residuals) ....... 48.6 
Interval Type ........................................... Two-Sided 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for the Slope in Simple Linear Regression 
 
  Target Actual  Standard Standard 
 Sample Distance Distance  Deviation Deviation 
Confidence Size from Slope from Slope Slope of X of Residuals 
Level (N) to Limits to Limits (B) (SX) (S) 
0.950 293 0.500 0.500 1.70 11.20 48.60 
0.950 205 0.600 0.599 1.70 11.20 48.60 
0.950 152 0.700 0.698 1.70 11.20 48.60 
0.950 117 0.800 0.798 1.70 11.20 48.60 
0.950 93 0.900 0.899 1.70 11.20 48.60 
0.950 76 1.000 0.998 1.70 11.20 48.60 
0.950 64 1.100 1.093 1.70 11.20 48.60 
0.950 54 1.200 1.196 1.70 11.20 48.60 
0.950 47 1.300 1.289 1.70 11.20 48.60 
0.950 41 1.400 1.388 1.70 11.20 48.60 
0.950 36 1.500 1.491 1.70 11.20 48.60 
0.990 505 0.500 0.500 1.70 11.20 48.60 
0.990 352 0.600 0.600 1.70 11.20 48.60 
0.990 260 0.700 0.700 1.70 11.20 48.60 
0.990 201 0.800 0.798 1.70 11.20 48.60 
0.990 160 0.900 0.897 1.70 11.20 48.60 
0.990 130 1.000 0.999 1.70 11.20 48.60 
0.990 109 1.100 1.095 1.70 11.20 48.60 
0.990 92 1.200 1.197 1.70 11.20 48.60 
0.990 79 1.300 1.298 1.70 11.20 48.60 
0.990 69 1.400 1.395 1.70 11.20 48.60 
0.990 61 1.500 1.491 1.70 11.20 48.60 
 
References 
Ostle, B. and Malone, L.C. 1988. Statistics in Research. Iowa State University Press. Ames, Iowa. 
 
Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
     sample size, etc.) that would contain the true slope. 
N is the size of the sample drawn from the population. 
Distance from Slope to Limit is the distance from the confidence limit(s) to the sample slope. For two-sided 
     intervals, it is also know as the precision, half-width, or margin of error. 
Target Distance from Slope to Limit is the value of the distance that is entered into the procedure. 
Actual Distance from Slope to Limit is the value of the distance that is obtained from the procedure. 
B is the sample slope. 
SX is the sample standard deviation of the X values. 
S is the standard deviation of the sample residuals. 
 
Summary Statements 
A sample size of 293 produces a two-sided 95% confidence interval with a distance from the 
sample slope to the limits that is equal to 0.500 when the sample slope is 1.70, the standard 
deviation of the X's is 11.20, and the standard deviation of the residuals is 48.60. 
 

This report shows the calculated sample size for each of the scenarios.  
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Plots Section 
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This plot shows the sample size versus the distance from the sample slope to the limits for the two 
confidence levels. 
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Example 2 – Validation using Ostle and Malone 
Ostle and Malone (1988) page 234 give an example of a calculation for a confidence interval for 
the slope when the confidence level is 95%, the slope is 7.478, the standard deviation of the X’s 
is 3.8944, the standard deviation of the residuals is 5.369792, and the distance from the slope to 
the limits is 0.87608. The sample size is 13.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Confidence Intervals for Linear Regression Slope 
procedure window by clicking on Regression, and then clicking on Confidence Intervals for 
Linear Regression Slope. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N (Sample Size) 
Confidence Level .................................... 0.95 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Distance from Slope to Limits ................. 0.87608 
B (Slope) ................................................. 7.478 
SX (Standard Deviation of X’s) ............... 3.8944 
Residual Variance Method ...................... S (Std. Dev. of Residuals) 
S (Standard Deviation of Residuals) ....... 5.369792 
Interval Type ........................................... Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

  Target Actual  Standard Standard 
 Sample Distance Distance  Deviation Deviation 
Confidence Size from Slope from Slope Slope of X of Residuals 
Level (N) to Limits to Limits (B) (SX) (S) 
0.95000 13 0.87608 0.87608 7.48 3.89 5.37 
 

PASS also calculated the sample size to be 13.  



  860-1 

Chapter 860 

Logistic 
Regression 
Introduction 
Logistic regression expresses the relationship between a binary response variable and one or more 
independent variables called covariates. A covariate can be discrete or continuous.  

Consider a study of death from disease at various ages. This can be put in a logistic regression 
format as follows. Let a binary response variable Y be one if death has occurred and zero if not. 
Let X  be the individual’s age. Suppose a large group of various ages is followed for ten years and 
then both Y and X are recorded for each person. In order to study the pattern of death versus age, 
the age values are grouped into intervals and the proportions that have died in each age group are 
calculated. The results are displayed in the following plot. 
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As you would expect, as age increases, the proportion dying of disease increases. However, since 
the proportion dying is bounded below by zero and above by one, the relationship is 
approximated by an “S” shaped curve. Although a straight-line might be used to summarize the 
relationship between ages 40 and 60, it certainly could not be used for the young or the elderly.  

Under the logistic model, the proportion dying, P, at a given age can be calculated using the 
formula 

P =  e
e

X

X

β β

β β
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This formula can be rearranged so that it is linear in X as follows 

Log P
P

= X
1 0 1−
⎛
⎝⎜

⎞
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+β β  
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Note that the left side is the logarithm of the odds of death versus non-death and the right side is a 
linear equation for X. This is sometimes called the logit transformation of P. When the scale of 
the vertical axis of the plot is modified using the logit transformation, the following straight-line 
plot results.  
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In the logistic regression model, the influence of X on Y is measured by the value of the slope of 
X which we have calledβ1 . The hypothesis that β1 0=  versus the alternative that β1 0= ≠B  is 
of interest since if β1 = 0 , X is not related to Y.  

Under the alternative hypothesis that β1 = B , the logistic model becomes 

log P
- P

 =  BX1
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Under the null hypothesis, this reduces to 

log P
- P

 =  0

0
01

⎛
⎝
⎜

⎞
⎠
⎟ β  

To test whether the slope is zero at a given value of X, the difference between these to quantities 
is formed giving 
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where OR is odds ratio of  and . This relationship may be solved for OR giving P1 P0

OR eBX=  
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This shows that the odds ratio of  and  is directly related to the slope of the logistic 
regression equation. It also shows that the value of the odds ratio depends on the value of X. For a 
given value of X, testing that B is zero is equivalent to testing OR is one. Since OR is commonly 
used and well understood, it is used as a measure of effect size in power analysis and sample size 
calculations. 

P1 P0

Power Calculations 
Suppose you want to test the null hypothesis that β1 0=  versus the alternative that β1 = B . 
Hsieh, Block, and Larsen (1998) have presented formulae relating sample size, α , power, and B 
for two situations: when  is normally distributed and when  is binomially distributed. X1 X1

When  is normally distributed, the sample size formula is X1
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( )

N =  
z z

P P
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where  is the event rate (probability that Y = 1) at the mean of . Note that B is defined in 
terms of an increase of one standard deviation of  above the mean. 

P * X1

X1

When  is binomially distributed and  = 0 or 1, the sample size formula is X1 X1
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where  is the event rate at P0 X1 0=  and  is the event rate at P1 X1 1= , R is the proportion of the 
sample with , and X1 1= P  is the overall event rate given by 

( ) ( )P R P R= − +1 0 1P . 

Multiple Logistic Regression 
The multiple logistic regression model relates the probability distribution of Y to two or more 
covariates  by the formula X X Xk1 2, , ,L

log P
- P

 =  X ... Xk k1 0 1 1
⎛
⎝⎜

⎞
⎠⎟

+ + +β β β  

where P is the probability that Y = 1 given the values of the covariates. It is a simple extension of 
the simple logistic regression model that was just presented. In power analysis and sample size 
work, attention is placed on a single covariate while the influence of the other covariates is 
statistically removed by placing them at their mean values. 
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When there are multiple covariates, the following adjustment was given by Hsieh (1998) to give 
the total sample size,  Nm

N  =  N
1 -m 2ρ

 

where ρ  is the multiple correlation coefficient between  (the variable of interest) and the 
remaining covariates. Notice that the number of extra covariates does not matter in this 
approximation. 

X1

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are P1, N, Alpha, and Power and Beta. Under most situations, you will select 
either Power and Beta for a power analysis or N for sample size determination. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. A 
type-II error occurs when you fail to reject the null hypothesis of equal probabilities of the event 
of interest when in fact they are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  
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Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error (alpha). A type-I 
error occurs when you reject the null hypothesis of equal probabilities when in fact they are 
equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size 

N (Sample Size) 
This option specifies the total number of observations in the sample. You may enter a single 
value or a list of values. 

Effect Size – Baseline Probability 

P0 (Baseline Probability that Y=1) 
This option specifies one or more  values. The interpretation of  depends on whether  is 
binary or continuous. 

P0 P0 X1

Binomial Covariate 
When  is binary,  is the probability that Y = 1 when  = 0. All other covariates are 
assumed to be equal to their mean values. In this case, the logistic equation reduces to 

X1 P0 X1

log P
- P

 =  0

0
01

⎛
⎝
⎜

⎞
⎠
⎟ β  

so that  

P  =  e
e0

0

01

β

β+
 

Normal Covariate 
When  is normally distributed,  is the probability that Y = 1 when X1 P0 X X1 1

= μ , where μX1
is 

the mean of . That is,  is the baseline probability that Y = 1 when  is ignored. All other 
covariates are assumed to be equal to their mean values. In this case, the logistic equation reduces 
to 

X1 P0 X1

log P
- P

 =  X
0

0
0 11 1

⎛
⎝
⎜

⎞
⎠
⎟ +β β μ  

so that  

P  =  e
e

X

X0

0 1 1

0 1 11

β β μ

β β μ

+

++
 



860-6  Logistic Regression 

Effect Size – Alternative Probability 

Use P1 or Odds Ratio 
This option specifies the whether to specify P1 directly or to specify it by specifying the odds 
ratio. Since the relationship between the odds ration, P1, and P0 is given by 

( )
( )

OR
P - P
P - P

= 1 1

0 0

1
1

/
/

 

specifying OR and P0 implicitly specifies P1. 

This options lets you specify whether you want to state the alternative hypothesis in terms of P1 
or the odds ratio. 

P1 (Alternative Probability that Y=1) 
This option specifies the effect size to be detected by specifying . As was shown earlier,  the 
slope of the logistic regression can be expressed in terms of  and . Hence, by specifying , 
you are also specifying the slope. 

P1

P0 P1 P1

This option is only used when the User P1 or Odds Ratio option is set to P1. Its interpretation 
depends on whether  is binomial or normal. X1

Binomial Covariate 
When  is binary, P1 is the probability that Y = 1 when  = 1. All other covariates are 
assumed to be equal to their mean values. In this case, the logistic equation reduces to 

X1 X1

log P
- P

 =  1

1
0 11

⎛
⎝
⎜

⎞
⎠
⎟ +β β  

since  = 1. X1

Normal Covariate 
When  is normally distributed, P1 is the probability that Y = 1 when X1 X x1 1 x1

= +μ σ  . That is, 

when  is one standard deviation above the mean. All other covariates are assumed to be equal 
to their mean values. In this case, the logistic equation reduces to 

x1

log P
- P

 =  x1

1
0 11

⎛
⎝
⎜

⎞
⎠
⎟ +β β 1  

so that  

P =  e
e

x

x1

0 1 1

0 1 11

β β

β β

+

++
 

Odds Ratio (Odds1/Odds0) 
This option specifies the odds ratio to be detected by the study. As was shown earlier, the slope of 
the logistic regression can be expressed in terms of  and the odds ratio. Hence, by specifying 
OR, you are also specifying the slope. Using the formula 

P0
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( )
( )

P
OR P
P OR P1

0

0 01
=

− +
 

specifying OR and  implicitly specifies . P0 P1

This option is only used when the User P1 or Odds Ratio option is set to Odds Ratio. Its 
interpretation depends on whether  is binomial or normal. X1

Binomial Covariate 
When  is binary, this option gives the odds ratio of  and . All other covariates are 
assumed to be equal to their mean values. In this case, the logistic equation reduces to 

X1 P1 P0

log P
- P

 =  1

1
0 11

⎛
⎝
⎜

⎞
⎠
⎟ +β β  

since  = 1.  X1

This odds ratio compares the odds of obtaining Y = 1 when  = 1 to the odds of obtaining Y = 1 
when  = 0. 

X1

X1

Normal Covariate 
When  is normally distributed, this option gives the odds ratio of  and , where  is the 
probability that Y = 1 when 

X1 P1 P0 P1

X x1 1= , where is a value other than x1 μx1
. All other covariates are 

assumed to be equal to their mean values. In this case, the logistic equation reduces to 

log P
- P

 =  x1

1
0 11

⎛
⎝
⎜

⎞
⎠
⎟ +β β 1  

so that  

P =  e
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x

x1
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0 1 11

β β
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This odds ratio compares the odds of obtaining Y = 1 when  =  to the odds of obtaining Y 
when  = 

X1 x1

X1 μx1
. 

Effect Size – Covariates (X1 is the 
Variable of Interest) 

R-Squared of X1 with Other X’s 
This is the R-Squared that is obtained when  is regressed on the other X’s (covariates) in the 
model. Use this to study the influence on power and sample size of adding other covariates. Note 
that the number of additional variables does not matter in this formulation. Only their overall 
relationship with  through this R-Squared value is used.  

1X

1X

Of course, this value is restricted to being greater than or equal to zero and less than one. Use 
zero when there are no other covariates. 
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X1 (Independent Variable of Interest) 
This option specifies whether the covariate is binary (binomial) or continuous (normal). This is a 
very important distinction since the sample size required for a particular power level is much 
larger for a binary covariate than for a continuous covariate.  

This selection also changes the meaning of P0 and P1. 

Percent of N with X1 = 1 
When  is binary, this option specifies the proportion, R, of the sample in which  = 1. Note 
that the value is specified as a percentage.  

X1 X1

Test 

Alternative Hypothesis 
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the 
value of alpha is halved by PASS. Everything else remains the same. 

Note that the accepted procedure is to use the Two Sided option unless you can justify using a 
one-sided test.  

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Power for a Continuous Covariate 
A study is to be undertaken to study the relationship between post-traumatic stress disorder and 
heart rate after viewing video tapes containing violent sequences. Heart rate is assumed to be 
normally distributed. The event rate is thought to be 7% among soldiers. The researchers want a 
sample size large enough to detect an odds ratios of 1.5 or 2.0 with 90% power at the 0.05 
significance level with a two-sided test. They decide to calculate the power at level sample sizes 
between 20 and 1200.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 20 50 100 200 300 500 700 1000 1200 
P0 (Baseline Probability that Y=1) .......... 0.07 
Use P1 or Odds Ratio ............................. Odds Ratio 
Odds Ratio (Odds1/Odds0) .................... 1.5 2.0 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Continuous (Normal) 
Percent of N with X1=1 ........................... Ignored since X is continuous 
Alternative Hypothesis ............................ Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

    Odds R 
Power N P0 P1 Ratio Squared Alpha Beta 
0.06716 20 0.070 0.101 1.500 0.000 0.05000 0.93284 
0.10964 50 0.070 0.101 1.500 0.000 0.05000 0.89036 
0.17737 100 0.070 0.101 1.500 0.000 0.05000 0.82263 
0.30962 200 0.070 0.101 1.500 0.000 0.05000 0.69038 
0.43325 300 0.070 0.101 1.500 0.000 0.05000 0.56675 
0.63808 500 0.070 0.101 1.500 0.000 0.05000 0.36192 
0.78147 700 0.070 0.101 1.500 0.000 0.05000 0.21853 
0.90516 1000 0.070 0.101 1.500 0.000 0.05000 0.09484 
0.94779 1200 0.070 0.101 1.500 0.000 0.05000 0.05221 
0.12119 20 0.070 0.131 2.000 0.000 0.05000 0.87881 
0.23903 50 0.070 0.131 2.000 0.000 0.05000 0.76097 
0.42410 100 0.070 0.131 2.000 0.000 0.05000 0.57590 
0.70579 200 0.070 0.131 2.000 0.000 0.05000 0.29421 
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0.86504 300 0.070 0.131 2.000 0.000 0.05000 0.13496 
0.97696 500 0.070 0.131 2.000 0.000 0.05000 0.02304 
0.99673 700 0.070 0.131 2.000 0.000 0.05000 0.00327 
0.99986 1000 0.070 0.131 2.000 0.000 0.05000 0.00014 
0.99998 1200 0.070 0.131 2.000 0.000 0.05000 0.00002 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. 
P0 is the response probability at the mean of the covariate, X. 
P1 is the response probability when X is increased to one standard deviation above the mean. 
Odds Ratio is the odds ratio when P1 is on top. That is, it is [P1/(1-P1)]/[P0/(1-P0)]. 
R-Squared is the R2 achieved when X is regressed on the other independent variables in the regression. 
Alpha is the probability of rejecting a true null hypothesis. 
Beta is the probability of accepting a false null hypothesis. 
 
Summary Statements 
A logistic regression of a binary response variable (Y) on a continuous, normally distributed, 
independent variable (X) with a sample size of 20 observations achieves 7% power at a 0.050 
significance level to detect a change in Prob(Y=1) from the value of 0.070 at the mean of X to 0.101 when X 
is increased to one standard deviation above the mean.This change corresponds to an odds ratio of 1.500. 
 

This report shows the power for each of the scenarios. The report shows that a power of 90% is 
reached at a sample size of about 300 for an odds ratio of 2.0 and 1000 for an odds ratio of 1.5. 

Plot Section 
 

  
 

This plot shows the power versus the sample size for the two values of the odds ratio. 
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Example 2 – Sample Size for a Continuous Covariate 
Continuing with the previous study, determine the exact sample size necessary to attain a power 
of 90%.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
P0 (Baseline Probability that Y=1) .......... 0.07 
Use P1 or Odds Ratio ............................. Odds Ratio 
Odds Ratio (Odds1/Odds0) .................... 1.5 2.0 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Continuous (Normal) 
Percent of N with X1=1 ........................... Ignored since X is continuous 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

    Odds R 
Power N P0 P1 Ratio Squared Alpha Beta 
0.89978 981 0.070 0.101 1.500 0.000 0.05000 0.10022 
0.89920 335 0.070 0.131 2.000 0.000 0.05000 0.10080 
 

This report shows the power for each of the scenarios. The report shows that a power of 90% is 
achieved at a sample size of 335 for an odds ratio of 2.0 and 981 for an odds ratio of 1.5. 
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Example 3 – Effect Size for a Continuous Covariate 
Continuing the previous study, suppose the researchers can only afford a sample size of 500 
individuals. They want to determine if a meaningful odds ratio can be detected with this sample 
size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... P1>P0 or Odds Ratio>1 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 500 
P0 (Baseline Probability that Y=1) .......... 0.07 
Use P1 or Odds Ratio ............................. Ignored since this is the Find setting 
Odds Ratio (Odds1/Odds0)..................... Ignored since this is the Find setting 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Continuous (Normal) 
Percent of N with X1=1 ........................... Ignored since X is continuous 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

    Odds R 
Power N P0 P1 Ratio Squared Alpha Beta 
0.90000 500 0.070 0.117 1.765 0.000 0.05000 0.10000 
 

This report shows that this experimental design can detect an odds ratio of 1.765. That is, it can 
detect a shift in the event rate from 0.070 to 0.117. 
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Example 4 – Sample Size for a Binary Covariate 
A study is to be undertaken to study the relationship between post-traumatic stress disorder and 
gender. The event rate is thought to be 7% among males. The researchers want a sample size 
large enough to detect an odds ratio of 1.5 with 90% power at the 0.05 significance level with a 
two-sided test.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... N 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
P0 (Baseline Probability that Y=1) .......... 0.07 
Use P1 or Odds Ratio ............................. Odds Ratio 
Odds Ratio (Odds1/Odds0) .................... 1.5 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Binary (X=0 or 1) 
Percent of N with X1=1 ........................... 50 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

  Pcnt N   Odds R 
Power N X=1 P0 P1 Ratio Squared Alpha Beta 
0.89997 3326 50.000 0.070 0.101 1.500 0.000 0.05000 0.10003 
 

The sample size is estimated at 3326. This should be evenly divided among males and females. 
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Example 5 – Validation for a Continuous Covariate 
Hsieh (1998) page 1628 gives the power as 95% when N = 317, alpha = 0.05 (two-sided), P0 = 
0.5, and the odds ratio is 1.5. The covariate is assumed to be continuous.    

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 5 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 317 
P0 (Baseline Probability that Y=1) .......... 0.50 
Use P1 or Odds Ratio ............................. Odds Ratio 
Odds Ratio (Odds1/Odds0)..................... 1.5 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Continuous (Normal) 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

    Odds R 
Power N P0 P1 Ratio Squared Alpha Beta 
0.95049 317 0.500 0.600 1.500 0.000 0.05000 0.04951 
 

PASS calculates a power of 0.95049 which matches Hsieh. 
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Example 6 – Validation for a Binary Covariate 
Hsieh (1998) page 1626 gives the power as 95% when N = 1282 (equal sample sizes for both 
groups), alpha = 0.05 (two-sided), P0 = 0.4, and the P1 = 0.5. The covariate is assumed to be 
binary. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Logistic Regression procedure window by clicking on 
Regression, and then clicking on Logistic Regression. You may then make the appropriate 
entries as listed below, or open Example 6 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 1282 
P0 (Baseline Probability that Y=1) .......... 0.4 
Use P1 or Odds Ratio ............................. P1 
P1 (Alternative Probability that Y=1) ....... 0.5 
R-Squared of X1 with Other X’s .............. 0 
X1 (Independent Variable of Interest) ..... Binary (X=0 or 1) 
Percent of N with X1=1 ........................... 50 
Alternative Hypothesis ............................ Two-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

  Pcnt N   Odds R 
Power N X=1 P0 P1 Ratio Squared Alpha Beta 
0.95021 1282 50.000 0.400 0.500 1.500 0.000 0.05000 0.04979 
 

PASS calculates a power of 0.95021 which matches Hsieh. 
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Chapter 865 

Multiple 
Regression 
Introduction 
The Linear Regression chapter dealt with the regression of a dependent variable on a single 
independent variable. This module deals with the general case of multiple regression in which 
there are two or more independent variables.  

Instead of using the correlation coefficient as the index of interest, the square of the correlation 
coefficient, R2 , has been adopted, mainly because of its ease of interpretation and its ability to be 
partitioned among various subgroups of the independent variables. 2  ranges from zero to one.  R
When performing a regression analysis, a typical hypothesis involves testing the significance of a 
subgroup of the independent variables after considering a second, nonoverlapping, group of 
independent variables. For example, suppose you have five independent variables. One common 
hypothesis tests whether a certain variable is influential (has a nonzero coefficient in the 
regression equation) after considering the other four variables. To perform this test, you partition 
the 2  from fitting all five variables into the 2  of the first four variables and the R R R2  added by 
the fifth variable. An F-test is constructed that tests whether this second R2  value is significantly 
different from zero. If it is, the fifth variable is significant after adjusting for the other four 
variables. 

Definition of Terms 
Cohen (1988) provides a comprehensive discussion of this topic. We strongly suggest that you 
refer to the examples given there for a thorough understanding of this subject. We will provide a 
brief introduction, concentrating on defining the terms and statistics that are used. 

Consider a sample of N rows of data. Suppose each row consists of the value of a dependent 
variable, Y, followed by the values of k independent variables, . The multiple 
regression equation of Y on the X’s is 

X X Xk1 2, , ,L

Y  =  X X Xj j j k kj jβ β β β ε0 1 1 2 2+ + + + +  L

βThe 's

b b b bk0 1 2, , , ,L

 are called the population regression coefficients or beta weights. They represent the true 
values in the population from which the sample was taken. Their sample estimates, 

, are calculated from the data using least squares methodology. The estimated 
regression equation becomes 
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Y  =  b b X b X b X ej j j k0 1 1 2 2+ kj j+ + + +L  

Upon removing the residuals, , the predicted values are calculated as ej

$
k kjY  =  b b X b X b Xj j j0 1 1 2 2+ + + +L  

2R  is defined as the proportion of the variation of Y that is explained (accounted for) by the 
variation in the X’s. The equation for 2  is R
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Notice that the numerator sum of squares in the above equations depend on the X’s through Y . 
Therefore, each time you change the X’s included in the regression equation, you will obtain a 
different value of 2 . Hence, you need special notation to indicate on which X’s the particular R

2

R R RT C TC C|
2 2 2= −

 is based.  R

RLet C and T refer to subgroups of the X’s. Define  to be the 2

RC
2

 added when Y is 

regressed on the variables in set T after the variables in set C. Define  to be the R2  achieved 
when Y is regressed on those in set C ignoring the variables in set T. Define  to be the RTC

2 R2  
achieved when Y is regressed on the variables in both sets C and T. 

β 'sUsing the above notation, you can construct F-tests that will test whether the  corresponding 
to certain sets of X’s are simultaneously zero while controlling for other variables. For example, 
to test the significance of the X’s in set T while removing the influence of the X’s in set C from 
experimental error, you would use: 

( )
( )F  =  

R u

- R - R vu v
T C

C T C
,

|

|

/

/

2

2 21
 

where u is the number of variables in T, v = N-k-1, and k is the total number of variables in C and 
T.  Note that this formula includes the effect size, . f 2

f  =  
R

- R
T C

C T C

2
2

2 21
|

|

⎛

⎝
⎜

⎞

⎠
⎟  

- R

Most significance tests in regression analysis, correlation analysis, analysis of variance, and 
analysis of covariance may be constructed using these F-ratios.  
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For example, suppose the seven X’s available are dividing into two sets: set C includes variables 
 and set T includes . The above F-ratio tests the null hypothesis that X X X1 3, , 6 7X X X X2 4 5, , ,

β β β β2 = =4 5 7 0= =  after adjusting for . X X X1 3, , 6

Calculating the Power 
The calculation of the power of a particular test proceeds as follows: 

1. Determine the critical value,   where u is the numerator degrees of freedom, v is the 
denominator degrees of freedom, and 

Fu v, ,α

α  is the probability of a type-I error. 

2. Calculate the noncentrality parameter λ  using the formula: 

( )λ =  
R

- R - R
T C

C T C

|

|

2

2 21
N  

3.  Compute the power as the probability of being greater than Fu v, ,α  on a noncentral-F 
distribution with noncentrality parameter λ . 

Note that the formula for λ  is different from that used in PASS 6.0. The algorithm used in PASS 
6.0 was based on formula (9.3.1) in Cohen (1988) which gives approximate answers. This version 
of PASS using an algorithm that gives exact answers. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. The parameters 
that may be selected are R2, N, Alpha, and Power and Beta. Under most situations, you will select 
either Power and Beta or N. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level.  

Select Power and Beta when you want to calculate the power of an experiment.  
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Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be 
entered.  

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error (alpha). A type-I 
error occurs when you reject the null hypothesis when in fact it is true. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for 
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should 
pick a value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N (Sample Size) 
This option specifies the value(s) for N, the sample size. Note that this value must be at least one 
greater than the total number of variables specified in sets C and T. 

Effect Size – C: Variables Controlled 
These options refer to the independent variables (X’s) to be controlled (adjusted) for (these are the 
variables in set C). That is, the influence of these variables is statistically removed. These are 
variables that are included in the regression equation but are not being tested for statistical 
significance.  

Number of Independent Variables Controlled 
This option specifies the number of variables in C. This number must be greater than or equal to 
zero. Note that the total number of variables specified in the two Number options must be less 
than N-1. 

R2(C) 
RThis box specifies the 2  achieved by the variables in set C when they are fit alone in the 

regression equation. Note that this amount must be between zero and one and that the total of the 
two 2  values must be less than one. R
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Effect Size – T: Variables Tested 
These options refer to the set of independent variables (X’s) whose coefficients are to be tested to 
determine if they all are zero. That is, this is the set of variables to be tested for statistical 
significance. 

Number of Independent Variables Tested 
This option specifies the number of variables in T. This is u. This number must be greater than or 
equal to one. Note that the total number of variables specified in the two Number options must be 
less than N - 1. 

R2(T|C) 
RThis box specifies the increase in 2  due to the variables in set T after including the variables in 

set C in the regression equation. Note that this amount must be between zero and one and that the 
total of the two 2  values must be less than one. R

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Testing the Addition or Deletion of a Single 
Variable 
This example calculates the power of an F test constructed to test a fifth variable which adds 0.05 
to R2  after considering four other variables whose combined R2  value is 0.50. Sample sizes 
from 10 to 150 will be investigated. The significance level is 0.05.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Regression procedure window by clicking on 
Regression, and then clicking on Multiple Regression. You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting. 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 10 to 150 by 20 
Number of Indep Vars Controlled ........... 4 
R2(C) ....................................................... 0.50 
Number of Indep Vars Tested ................. 1 
R2(T|C) .................................................... 0.05 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
 Ind. Variables Ind. Variables  
 Tested Controlled  
Power N Alpha Beta Cnt R2 Cnt R2 
0.13037 10 0.05000 0.86963 1 0.05000 4 0.50000 
0.41799 30 0.05000 0.58201 1 0.05000 4 0.50000 
0.63511 50 0.05000 0.36489 1 0.05000 4 0.50000 
0.78431 70 0.05000 0.21569 1 0.05000 4 0.50000 
0.87818 90 0.05000 0.12182 1 0.05000 4 0.50000 
0.93366 110 0.05000 0.06634 1 0.05000 4 0.50000 
0.96493 130 0.05000 0.03507 1 0.05000 4 0.50000 
0.98192 150 0.05000 0.01808 1 0.05000 4 0.50000 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N is the number of observations on which the multiple regression is computed. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
Cnt refers to the number of independent variables in that category. 
R2 is the amount that is added to the overall R-Squared value by these variables. 
Ind. Variables Tested are those variables whose regression coefficients are tested against zero. 
Ind. Variables Controlled are those variables whose influence is removed from experimental error. 
 
Summary Statements 
A sample size of 10 achieves 13% power to detect an R-Squared of 0.05000 attributed to 1 
independent variable(s) using an F-Test with a significance level (alpha) of 0.05000. The 
variables tested are adjusted for an additional 4 independent variable(s) with an R-Squared of 
0.50000. 
 

This report shows the values of each of the parameters, one scenario per row. The definitions of 
each of the columns is given in the Report Definitions section. 
Note that in this particular example, a reasonable power of 0.90 is not reached until the sample 
size is 110. 

Plots Section 
 

                
   

This plot shows the relationship between sample size and power.  
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Example 2 – Minimum Detectable R-Squared 
Suppose the researcher in Example1 can only afford a sample size of 30. He wants to know the 
minimum detectable R2  that can be detected if the power is 80% and 90%. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Regression procedure window by clicking on 
Regression, and then clicking on Multiple Regression. You may then make the appropriate 
entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... R-Squared of IV’s Tested 
Power ...................................................... 0.80 0.90 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 30 
Number of Indep Vars Controlled ........... 4 
R2(C) ....................................................... 0.50 
Number of Indep Vars Tested ................. 1 
R2(T|C) .................................................... Ignored since this is the Find setting 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
 Ind. Variables Ind. Variables  
 Tested Controlled  
Power N Alpha Beta Cnt R2 Cnt R2 
0.90000 30 0.05000 0.10000 1 0.13787 4 0.50000 
0.80000 30 0.05000 0.20000 1 0.11066 4 0.50000 
 

2  less than 0.13787. RThis report shows that at 90% power, a sample size of 30 cannot detect an 
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Example 3 – Sample Size, Many X’s 
Suppose you have 25 observations on 19 independent variables. You run a regression analysis 
with all 19 variables and obtain an R2  value of 0.90. You find that 4 of these variables will result 
in an R2  of 0.60, leaving an R2  increment of 0.30 for the other 15. You decide to test the 
significance of these 15 variables. The F ratio is 

( )
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 =  
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,
. . /
. . /
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−
−  

Obviously, an F of 1.0 is nonsignificant, so you might be tempted to discard these variables and 
proceed with the four that are significant. Before doing so, you decided to do a power analysis on 
this F test. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Regression procedure window by clicking on 
Regression, and then clicking on Multiple Regression. You may then make the appropriate 
entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting. 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 25 
Number of Indep Vars Controlled ........... 4 
R2(C) ....................................................... 0.60 
Number of Indep Vars Tested ................. 15 
R2(T|C) .................................................... 0.3 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
 Ind. Variables Ind. Variables  
 Tested Controlled  
Power N Alpha Beta Cnt R2 Cnt R2 
0.72022 25 0.05000 0.27978 15 0.30000 4 0.60000 
 

The power is only 0.72022, which is a little low. Hence, you cannot be certain whether these 15 
variables are unimportant or if you just do not have a large enough sample. 



865-10  Multiple Regression 

Example 4 – Validation 
Ralph O’Brien, in a private communication to Jerry Hintze, gave the result that when alpha = 
0.05, N = 15, K = 2, and R-Squared = 0.6, the power is 0.96829.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Multiple Regression procedure window by clicking on 
Regression, and then clicking on Multiple Regression. You may then make the appropriate 
entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting. 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 15 
Number of Indep Vars Controlled ........... 0 
R2(C) ....................................................... 0.0 
Number of Indep Vars Tested ................. 2 
R2(T|C) .................................................... 0.6 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results 
 Ind. Variables Ind. Variables  
 Tested Controlled  
Power N Alpha Beta Cnt R2 Cnt R2 
0.96829 15 0.05000 0.03171 2 0.60000 6 0.00000 
 

The power of 0.96829 matches O’Brien’s result. 
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Chapter 870 

Poisson 
Regression 
Introduction 
Poisson regression is used when the dependent variable is a count. Following the results of 
Signorini (1991), this procedure calculates power and sample size for testing the hypothesis that 
β1 0=  versus the alternative that β1 = B . Note that e  is the change in the rate for a one-unit 
change in  when the rest of the covariates are held constant. The procedure assumes that this 
hypothesis will be tested using the score statistic 

β1

X1
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The Poisson Distribution 
The Poisson distribution models the probability of y events (i.e. failure, death, or existence) with 
the formula 
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Notice that the Poisson distribution is specified with a single parameter μ . This is the mean 
incidence rate of a rare event per unit of exposure. Exposure may be time, space, distance, area, 
volume, or population size. Because exposure is often a period of time, we use the symbol t to 
represent the exposure. When no exposure value is given, it is assumed to be one.  

The parameter μ  may be interpreted as the risk of a new occurrence of the event during a specified 
exposure period, t. The probability of y events is then given by 
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The Poisson distribution has the property that its mean and variance are equal. 
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The Poisson Regression Model 
In Poisson regression, we suppose that the Poisson incidence rate μ  is determined by a set of k 
regressor variables (the X’s). The expression relating these quantities is 

( )μ β β β β= + + + +exp 0 1 1 2 2X X Xk kL  

The regression coefficients kββββ ,,,, 210 L

bb ,, 10 L

 are unknown parameters that are estimated from a set 
of data. Their estimates are labeled .  kb,

Using this notation, the fundamental Poisson regression model for an observation i is written as 

( ) ( )Pr | ,
!

Y y t
e t

yi i i i

t
i i

y

i

i i i

= =
−

μ
μμ

 

where  

( )μ λi = ′xiβ  

( ) ( )λ β β β β′ = + + + +xiβ exp 0 1 1 2 2X X Xi i kL ki  

That is, for a given set of values of the regressor variables, the outcome follows the Poisson 
distribution. 

Power Calculations 
Suppose you want to test the null hypothesis that β1 0=  versus the alternative that β1 1= B . 
Signorini (1991) gives the formula relating sample size, α , β , and B1 when  is the only 
covariate of interest as 
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where N is the sample size, φ  is a measure of over-dispersion, μT  is the mean exposure time, 
and z is the standard normal deviate. Following the extension used in Hsieh, Block, and Larsen 
(1998) and Hsieh and Lavori (2000), when there are other covariates, PASS uses the 
approximation 
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where R2  is the square of the multiple correlation coefficient when the covariate of interest is 
regressed on the other covariates. The variance in the null case is given by 

( ) ( )
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The variance for the non-null case depends on the underlying distribution of X. Common choices 
are given next. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. For more information about the options of other tabs, go to the Procedure Window 
chapter. 

Data Tab 
The Data tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Find (Solve For) 
This option specifies the parameter to be solved for from the other parameters. Under most 
situations, you will select either Power and Beta for a power analysis or N for sample size 
determination. 

Select N when you want to calculate the sample size needed to achieve a given power and alpha 
level. Select Power and Beta when you want to calculate the power of an experiment. 

Error Rates 

Power or Beta 
This option specifies one or more values for power or for beta (depending on the chosen setting). 
Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta 
is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for 
power. Now, 0.90 (Beta = 0.10) is also very popular. 

A single value (e.g., 0.90) may be entered here or a range of values (e.g., 0.8 to 0.95 by 0.05) may 
be entered. 

Alpha (Significance Level) 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs 
when a true null hypothesis is rejected. 

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a 
value for alpha that represents the risk of a type-I error you are willing to take in your 
experimental situation. 

A single value (e.g., 0.05) may be entered here or a range of values (e.g., 0.05 to 0.2 by 0.05) may 
be entered. 

Sample Size 

N (Sample Size) 
This option specifies the total number of observations in the sample. You may enter a single 
value (e.g., 25) or a list of values (e.g., 10 to 100 by 10).  
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Effect Size – Response Rates 

Exp(B0) [Baseline Response Rate] 
Exp(B0) is the baseline response rate. This is the response rate that occurs when all covariates are 
equal to zero. Depending on the dataset being analyzed, the response rate might be the hazard 
rate, death rate, survival rate, or accident rate. 

Exp(B1)/Exp(B0) (Rate Ratio) 
B1 is the value of the regression coefficient under the alternative hypothesis. In Poisson 
regression, it is more natural to specify a value for exp(B1)/exp(B0) than for B1 because 
exp(B1)/exp(B0) represents the ratio of the response rate when X1 is increased one unit and all 
other covariates are constant to its baseline rate. Depending on the dataset being analyzed, the 
response rate might be the hazard rate, death rate, survival rate, or accident rate. 

For example, suppose the baseline response rate (the value of ( )exp β0 ) is 0.70 and you want the 
study to be large enough to detect a 30% increase in the response rate. The value entered here 
would be 1.3. 

Effect Size – Exposure Time and 
Over-dispersion 

MuT (Mean Exposure Time) 
This is the mean exposure time, μT , over which the response rate is calculated. If the response 
rates are for one year, enter 1 here. If they are for 30 days, enter 30 here. 

Phi 
Phi is the over-dispersion parameter for Poisson regression. When there is no over-dispersion, set 
this value to one.  

Effect Size – Covariates (X1 is the 
Variable of Interest) 

R-Squared of X1 with Other X’s 
This is the R-Squared that is obtained when  is regressed on the other X’s (covariates) in the 
model. Use this to account for the influence on power and sample size of adding other covariates. 
Note that the number of additional variables does not matter in this formulation. Only their 
overall relationship with  through this R-Squared value is used.  

1X

1X

This value is restricted to being greater than or equal to zero and less than one. Use zero when 
there are no other covariates. 

Distribution of X1 
This option specifies the distribution of the covariate being analyzed. You can choose from the 
normal, exponential, uniform, and binomial distributions. Once you have selected the anticipated 
distribution of the covariate, you must also specify values for the corresponding parameter(s) of 
the distribution. 
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Normal(M) 
Specify the mean of the normal covariate distribution. This option is used when Distribution of 
X1 is set to Normal(M,S).  

Normal(S) 
Specify the standard deviation of the normal covariate distribution. This option is used when 
Distribution of X1 is set to Normal(M,S).  

Uniform(C) 
Specify the minimum of the uniform covariate distribution. This option is used when Distribution 
of X1 is set to Uniform(C,D). The uniform distribution of the covariate is assumed to range from 
C to D. 

Uniform(D) 
Specify the maximum of the uniform covariate distribution. This option is used when Distribution 
of X1 is set to Uniform(C,D). The uniform distribution of the covariate is assumed to range from 
C to D. 

Exponential(L) 
Specify the value of lambda associated with the exponential covariate distribution. This option is 
used when Distribution of X1 is set to Exponential(L). Note that the pdf of the exponential 
distribution is assumed to be (lambda) exp(-lambda X). 

Binomial(P) 
Specify the value of the proportion for the binomial covariate distribution. This option is used 
when the Distribution of X1 is set to Binomial(P). For example, if the covariate being studied is 
an indicator variable of treatment and control and you anticipated having an equal number of 
treatments and controls, this value should be set to 0.50.  

Test 

Alternative Hypothesis 
Specify whether the alternative hypothesis is one-sided or two-sided. When a two-sided 
alternative hypothesis is selected, the specified value of alpha is divided by 2. When a one-sided 
hypothesis is selected, the value of alpha is left as specified. 

In general, the accepted procedure is to use the Two-Sided option unless a one-sided test can be 
justified.  

Iterations Tab 
This tab sets a couple of options used in the iterative procedures. 

Maximum Iterations 

Maximum Iterations Before Search Termination 
Specify the maximum number of iterations allowed before the search for the criterion of interest 
is aborted. When the maximum number of iterations is reached without convergence, the criterion 
is left blank. A value of 500 is recommended. 
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Example 1 – Power for Several Sample Sizes 
Poisson regression will be used to analyze the power for a study of the relationship between the 
number of flaws on a manufactured article and the experience (measured in years) of the operator. 
The researchers want to evaluate the sample size needs for detecting ratios in response rates of 
1.3 and 1.5. The experience of an operator is assumed to be normally distributed with mean 3.2 
and standard deviation 2.1. No other covariates will be included in the analysis. The researchers 
will test their hypothesis using a 5% significance level with a two-sided Wald test. They decide to 
calculate the power at sample sizes between 5 and 50.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Poisson Regression procedure window by clicking on 
Regression, and then clicking on Poisson Regression. You may then make the appropriate 
entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find (Solve For) ...................................... Power and Beta 
Power ...................................................... Ignored since this is the Find setting 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 5 to 50 by 5 
Exp(B0) ................................................... 1.0 
Exp(B1) / Exp(B0) ................................... 1.3 1.5 
MuT (Mean Exposure Time) ................... 1.0 
Phi ........................................................... 1.0 
R-Squared of X1 with Other X’s .............. 0.0 
Distribution of X1 ..................................... Normal(M,S) 
Normal(M) ............................................... 3.2 
Normal(S) ................................................ 2.1 
Alternative Hypothesis ............................ Two-Sided 

Annotated Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results when X1 is Normal with Mean = 3.2 and Sigma = 2.1 
And Phi (Over-Dispersion Parameter) = 1.0000 
    Mean R-Squared   
 Sample Response Baseline Exposure X1 vs Two-  
 Size Rate Rate Time Other X's Sided  
Power (N) Ratio Exp(B0) (MuT) (R2) Alpha Beta 
0.11604 5 1.3000 1.0000 1.0000 0.0000 0.05000 0.88396 
0.36043 10 1.3000 1.0000 1.0000 0.0000 0.05000 0.63957 
0.61237 15 1.3000 1.0000 1.0000 0.0000 0.05000 0.38763 
0.79600 20 1.3000 1.0000 1.0000 0.0000 0.05000 0.20400 
0.90403 25 1.3000 1.0000 1.0000 0.0000 0.05000 0.09597 
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0.95876 30 1.3000 1.0000 1.0000 0.0000 0.05000 0.04124 
0.98355 35 1.3000 1.0000 1.0000 0.0000 0.05000 0.01645 
0.99384 40 1.3000 1.0000 1.0000 0.0000 0.05000 0.00616 
0.99781 45 1.3000 1.0000 1.0000 0.0000 0.05000 0.00219 
0.99926 50 1.3000 1.0000 1.0000 0.0000 0.05000 0.00074 
0.44890 5 1.5000 1.0000 1.0000 0.0000 0.05000 0.55110 
0.95354 10 1.5000 1.0000 1.0000 0.0000 0.05000 0.04646 
0.99892 15 1.5000 1.0000 1.0000 0.0000 0.05000 0.00108 
0.99999 20 1.5000 1.0000 1.0000 0.0000 0.05000 0.00001 
1.00000 25 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
1.00000 30 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
1.00000 35 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
1.00000 40 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
1.00000 45 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
1.00000 50 1.5000 1.0000 1.0000 0.0000 0.05000 0.00000 
 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the size of the sample drawn from the population. 
Exp(B1)/Exp(B0) is the response rate ratio due to a one-unit change in X1. 
Exp(B0) is the response rate when all covariates have a value of zero. 
Phi is the over-dispersion parameter used when the Poisson model does not fit. 
R2 is the R-squared achieved when X1 is regressed on the other covariates. 
Alpha is the probability of rejecting Exp(B1)/Exp(B0) is one. 
Beta is the probability of accepting a false null hypothesis. 
 
Summary Statements 
A Poisson regression of a dependent variable of counts on normally distributed independent 
variable with mean = 3.2 and standard deviation = 2.1 using a sample of 5 observations achieves 
12% power at a 0.05000 significance level to detect a response rate ratio of at least 1.3000 
due to a one-unit change in the IV. The baseline rate is 1.0000 and the mean exposure time is 
1.0000. 
 

This report shows the power for each of the scenarios. Note that if you were interested in B1 
instead of Exp(B1), you would simply take the natural logarithm of the value of Exp(B1). 

Plots Section 
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Example 2 – Validation using Signorini 
Signorini (1991), page 449, presents an example which we will use to validate this program. In 
the example, Exp(B1)/Exp(B0)= 1.3, Exp(B0)= 0.85, R2 = 0.0, Mu T = 1.0, and Phi = 1.0. The 
independent variable is assumed to be binomial with proportion 0.5. A one-sided test with alpha = 
0.05 will be used. Sample sizes for power = 0.80, 0.90, and 0.95 are calculated to be 406, 555, 
and 697.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Poisson Regression procedure window by clicking on 
Regression, and then clicking on Poisson Regression. You may then make the appropriate 
entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Data Tab 
Find ......................................................... N 
Power ...................................................... 0.80 0.90 0.95 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... Ignored since this is the Find setting 
Exp(B0) ................................................... 0.85 
Exp(B1) / Exp(B0) ................................... 1.3 
MuT (Mean Exposure Time) ................... 1.0 
Phi ........................................................... 1.0 
R-Squared of X1 with Other X’s .............. 0.0 
Distribution of X1 ..................................... Binomial(P) 
Binomial(P) .............................................. 0.5 
Alternative Hypothesis ............................ One-Sided 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results when X1 is Binomial with Proportion = 0.5 
And Phi (Over-Dispersion Parameter) = 1.0000 
    Mean R-Squared   
 Sample Response Baseline Exposure X1 vs Two-  
 Size Rate Rate Time Other X's Sided  
Power (N) Ratio Exp(B0) (MuT) (R2) Alpha Beta 
0.95000 697 1.3000 0.8500 1.0000 0.0000 0.05000 0.05000 
0.90000 556 1.3000 0.8500 1.0000 0.0000 0.05000 0.10000 
0.80000 406 1.3000 0.8500 1.0000 0.0000 0.05000 0.20000 
 

Note that PASS calculated 556 rather than the 555 calculated by Signorini (1991). The 
discrepancy is due to rounding.  
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Chapter 880 

Randomization 
Lists 
Introduction 
This module is used to create a randomization list for assigning subjects to one of up to eight 
groups or treatments. Six randomization algorithms are available. Four of the algorithms (Efron’s 
biased coin randomization, Smith’s randomization, Wei’s urn randomization, and random sorting 
using maximum allowable % deviation) are designed to generate balanced random samples 
throughout the course of an experiment. The other two (complete randomization and random 
sorting) are less complex but have higher probabilities of imbalance. Technical details for each of 
these algorithms (except random sorting) as well as a discussion of randomization issues in 
general are given in Rosenberger and Lachin (2002), Pocock (1983), and Piantadosi (2005). 

Why Randomize? 
Random allocation has been an important part of scientific discovery since the time of R.A. 
Fisher. He and other scientists recognized the potential for bias in nonrandomized experiments 
that could compromise treatment comparisons. Randomization controls the influence of unknown 
factors, reducing potential bias in an experiment. Rosenberger and Lachin (2002) state on page 18 
that “…the randomization of subjects between the treatment groups is the paramount statistical 
element that allows one to claim that a study is unbiased.” The elimination of bias, however, is 
not the only reason for randomization. Pocock (1983) states on page 50 that randomization is 
used “to provide a basis for the standard methods of statistical analysis such as significance tests.” 
Clearly, randomization is necessary in order to produce accurate and generalizable statistical 
conclusions.  

Randomization in Clinical Trials 
In non-clinical (or non-human) experiments, researchers often have tight control over the 
environment and conditions surrounding an experiment, so randomization can usually be 
implemented with minor difficulty. Clinical experiments, however, are quite different. Because 
human patients are used in clinical trials, various ethical issues must be addressed. These ethical 
considerations complicate the experimental design and often require adjustments in the way 
subjects are randomly assigned to treatments. Other factors that influence randomization in 
clinical trials are purely logistical. How can the investigators ensure that treatments are 
administered the same for all patients without the patient or the doctor knowing what treatment is 
being given? These and other design factors influence how randomization is administered in 
clinical trials. 
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One of the issues that arise in clinical experiments is treatment imbalance. Clinical trials are 
usually administered over time with patients enrolling at different time points throughout the 
study. It is often desirable to maintain balance in the number of patients assigned to each 
treatment throughout the course of the experiment. This is particularly true when time-dependent 
covariates influence the response or when sequential testing will be used to analyze results. 
Several randomization algorithms have been developed to produce lists that balance the number 
of patients assigned to each treatment throughout the experiment while still maintaining the 
randomness of the assignments. These include Efron’s biased coin randomization, Smith’s 
randomization, Wei’s urn randomization, and random sorting using maximum allowable % 
deviation. Each of these algorithms will be discussed in detail in the section that follows. 

Randomization Algorithms 
Six different randomization algorithms are available in PASS. These can be roughly divided into 
two categories: those that aim to produce balanced randomization lists and those that do not. The 
following table outlines the goal of each algorithm by the number of groups each algorithm will 
allow.  
 

 Non-Balancing 
Algorithms Balancing Algorithms 

2 Groups Complete Randomization†, 
Random Sorting 

Efron’s Biased Coin*†, Smith*†, Wei’s Urn*†, 
Random Sorting using Maximum Allowable % 

Deviation  

k Groups Complete Randomization†, 
Random Sorting 

Wei’s Urn*, Random Sorting using Maximum  
Allowable % Deviation 

*These randomization algorithms have the additional restriction that unequal treatment allocation is not allowed, i.e.  
all groups must have the same target sample size. 
†These randomization algorithms produce randomization lists in which the actual group sample size may not equal 
the target group sample size. 

 

The discussion of each algorithm that follows will be based on the following scenario and 
notation. Suppose we have k treatments and that ni subjects (not necessarily all equal) are to be 
assigned to each treatment, i = 1, 2, …, k. The value ni will be referred to in discussion as the 
“target” sample size for each group. Let the actual sample size for each group be ai. For some 
algorithms, the actual group sample size may not always equal the target sample size for all 
groups. The total sample size is  

∑∑
==

==
k

i
i

k

i
i anN

11

, 

and the target allocation ratio for each group is 

N
nR i

i = . 

Define the probability of assignment of subject j to treatment i as pij. 

Define the number of subjects in each group after the jth subject is assigned as ni[j]. 
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Non-Balancing Algorithms 

Complete Randomization 
The complete randomization algorithm is commonly referred to as a “coin flip”. For the case to 
two treatments, a coin is flipped each time a subject is to be randomized, determining the 
assignment. The probability of assignment to either treatment is 0.5 for all subjects.   

The algorithm generalizes to more than two groups and allows for unequal allocation. The 
probability of assignment of subject j to group i is 

iij Rp =   

for all j. If the target sample size is the same for all k groups, then 

kpij /1=  

The complete randomization algorithm proceeds by randomly assigning subjects to treatments 
using the above assignment probabilities. The algorithm may result in imbalances between groups 
even when the target group sample sizes are equal, i.e. the actual sample sizes may not always 
equal the target sample sizes for all groups. This algorithm is not recommended when balance is 
important throughout the course of an experiment. 

Random Sorting 
The random sorting algorithm can be used for any number of treatment groups and any allocation 
ratios. The random sorting algorithm always results in randomized assignment lists in which the 
actual group sample sizes match the target group sample sizes, i.e. ai = ni for all i. The algorithm 
begins by creating a virtual database containing group names. Each row corresponds to one 
group, and the ith group is represented by ni rows. For example, if we were randomly assigning 
three groups (A, B, and C) with ten subjects in each group, then the database would consist of ten 
rows containing A’s, followed by ten rows containing B’s and ten rows containing C’s, for a total 
of 30 rows. Next, a random number is assigned to each row in the database, and then the database 
is sorted based on the column of random numbers to place the group names in random order. The 
first subject is then assigned to the group in row one of the randomly sorted database, the second 
subject is assigned to the group in row two, and so forth. Although this algorithm always results 
in groups containing the target sample sizes, longitudinal imbalances among groups may still 
occur, therefore, this algorithm is not recommended when balance is important throughout the 
course of an experiment.  

Balancing Algorithms 

Efron’s Biased Coin Randomization 
This algorithm may only be used for random assignment of subjects to two treatments. The target 
sample sizes must also be the same for both groups. In order to achieve longitudinal balance 
between groups, the algorithm dynamically changes the group assignment probabilities. The 
algorithm is outlined in Efron (1971).  

First we define a constant probability p (called “Efron’s p” in PASS), where 0.5 < p ≤ 1. A 
common value for p is 2/3. Also define a difference function ][][ 21 jnjnD j −= . The probability 
of assignment of subject j to group 1 is 
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Efron’s biased coin randomization proceeds by randomly assigning subjects to treatments using 
the above assignment probabilities. When group 1 has more subjects assigned than group 2, the 
assignment probability changes to make group 2 more probable for assignment. When group 2 
has more, then group 1 becomes more probable. The algorithm may result in final imbalances 
between groups, but the degree of imbalance throughout the randomization process is greatly 
reduced. 

Smith’s Randomization 
This algorithm may only be used for random assignment of subjects to two treatments. The target 
sample sizes must also be the same for both groups. Like Efron’s biased coin randomization, 
Smith’s algorithm dynamically changes the group assignment probabilities based on the degree of 
imbalance to achieve longitudinal balance between groups.  The algorithm is outlined in Smith 
(1984).  

We define a positive exponent parameter ρ (called “Smith’s Exponent” in PASS). The probability 
of assignment of subject j to group 1 is 

ρρ

ρ

]1[]1[
]1[

21

2
1 −+−

−
=

jnjn
jnp j   

Smith’s randomization proceeds by randomly assigning subjects to treatments using the above 
assignment probabilities. When group 1 has more subjects assigned than group 2, the assignment 
probability changes to make group 2 more probable for assignment. When group 2 has more, then 
group 1 becomes more probable. The algorithm may result in final imbalances between groups, 
but the degree of imbalance throughout the randomization process is greatly reduced.  

Wei’s Urn Randomization 
This algorithm may be used for random assignment of subjects to two or more treatments. The 
target sample sizes must also be the same for all groups. Like Smith’s randomization, Wei’s urn 
randomization algorithm dynamically changes the group assignment probabilities based on the 
degree of imbalance to achieve longitudinal balance between groups. Urn randomization is 
reviewed in Wei and Lachin (1988).  

Define positive parameters A and B (called “Wei’s A” and “Wei’s B” in PASS, respectively). We 
start the algorithm by placing A balls representing each group in an urn. A single ball is then 
randomly chosen from the urn, recorded, and replaced, and then B new balls corresponding to 
each of the other groups are added to the urn. Therefore, when a ball from one group is chosen, 
the probability shifts to make the other groups more probable on the next draw. The probability of 
the first assignment is 1/k. After that, the probability of assignment of subject j to group i is 

)1)(1(
]1[)1(

−−+
−−−+

=
kjBkA

jBnjBAp i
ij . 

The algorithm continues until all subjects have been assigned to one of the groups. The algorithm 
may result in final imbalances between groups, but the degree of imbalance throughout the 
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randomization process is diminished due to the shifting of probabilities toward the 
underrepresented groups. 

Random Sorting using Maximum Allowable % Deviation 
This algorithm is equivalent to the random sorting algorithm described earlier except that a search 
is conducted to find a randomization list that satisfies the Maximum Allowable % Deviation 
criterion. The % Deviation for group i after subject j has been assigned is defined as 

( )

.100][

100][][ Deviation%
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The % Deviation measures how far the actual sample size for group i is from the expected sample 
size after subject j is randomly assigned. The Maximum Allowable % Deviation represents the 
upper bound for this measure. The search is conducted by creating an assignment list based on 
random sorting and then running through the assignments and calculating the maximum % 
Deviation for all groups after each assignment. If the maximum % Deviation is greater than the 
Maximum Allowable % Deviation value specified, then the list is rejected, the number of 
iterations is incremented, and the random sorting algorithm is started again with a new set of 
random numbers. The search continues until a randomization list is generated for which the 
criterion is satisfied for all individual assignments. Conducting a search in this manner assures a 
degree of balance throughout the course of the experiment. 

For example, for 40 subjects to be assigned to two groups A and B with equal allocation ratios 
(0.5), suppose that there are 7 assigned A’s and 3 assigned B’s after 10 random assignments and 
the Maximum Allowable % Deviation is 10%. With the allocation ratio at 0.5, we would expect 
to have 5 A’s and 5 B’s (10 × 0.5 = 5) after 10 assignments. Therefore, the % Deviation for group 
A is |7 – 5|/20 = 10% and the % Deviation for group B is |3 – 5|/20 = 10%. Both of these are 
equal to the Maximum Allowable % Deviation so the next assignment would be tested. If the next 
assignment were to group A then the randomization list would be rejected because the % 
Deviation for group A is |8 – 5|/20 = 15% > 10%. A new randomization list based on random 
sorting would be generated and the search would continue. 

Comparison of Balancing Properties 
Rosenberger and Lachin (2002) provides a simulation comparison of the balancing properties of 
complete randomization, Efron’s biased coin (p = 2/3), Wei’s Urn (A = 0, B = 1), and Smith 
(exponent = 5). The simulation was carried out for two treatment groups with target sample sizes 
of 25 in each group. They found that complete randomization did not balance as well as the other 
three “restricted randomization” procedures. Efron’s biased coin and Smith’s randomization 
algorithms were very close in terms of bias and variability. Wei’s urn was found to be slightly 
more variable. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Design, Report, and Storage tabs. For more information about the options of other tabs, go to the 
Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Specify the Groups 

Number of Groups 
This option specifies the number of groups or treatments to which the subjects will be randomly 
assigned. Up to eight groups are allowed for random assignment. 

Specify the Groups – Group Labels 
and Target Group Sizes 

All Group Sizes are Equal 
Check this box if all groups have the same target sample size. The target sample size is then 
specified in the Equal Group Size box to the right. This is used as the target sample size for every 
group. If this box is not checked, then a target sample size must be entered for each group 
individually. 

Equal Group Size 
Specify a single target sample size to be used for all of the groups. This box is only used if the All 
Group Sizes are Equal option is checked. If the target sample sizes are not all equal, then they 
must be entered individually for each group. 

Group Label 
Specify a label or treatment name for each group. This label will be used to distinguish groups in 
the output and reports. Each group must have a different label. 

Group Size 
Specify a target sample size for the group designated to the left of this box. This option is only 
used if the All Group Sizes are Equal box is unchecked. 

If all of the target group sizes are equal, check the All Group Sizes are Equal box and enter a 
single number in the Equal Group Size box. 

Randomization Algorithm 

Randomization Algorithm 
Choose one of six randomization algorithms. These algorithms are each described in detail in the 
Randomization Algorithms section above. Some of the algorithms may result in actual (final) 
sample sizes that are not equal to the target sample sizes. To search for a randomization list in 
which the final group sizes are equal to the target group sample sizes for every group, check the 
“Search for a randomization list…” box.  
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The following algorithms are available. 

• Complete Randomization 
This is the simplest of all randomization algorithms and is commonly known as “coin 
flipping”. The algorithm may result in imbalances between groups even when the target 
group sample sizes are equal, i.e. the actual sample sizes may not always equal the target 
sample sizes for all groups. This algorithm is not recommended when balance is important 
throughout the course of an experiment.  

• Efron’s Biased Coin (2 Treatments, Equal Sample Sizes) 
This algorithm may only be used for random assignment of subjects to two treatments. The 
target sample sizes must also be the same for both groups. In order to achieve longitudinal 
balance between groups, the algorithm dynamically changes the group assignment 
probabilities. A value for Efron’s p must also be specified. 

• Random Sorting 
The random sorting algorithm can be used for any number of treatment groups and any 
allocation ratio set. The random sorting algorithm always results in randomized assignment 
lists in which the actual group sample sizes match the target group sample sizes, i.e. ai = ni 
for all i. The random assignment is conducted by sorting a database of group labels using a 
column of random numbers. This algorithm is not recommended when balance is important 
throughout the course of an experiment. 

• Random Sorting using Max Allowable % Deviation (Search) 
This algorithm is equivalent to the random sorting algorithm except that a search is conducted 
to find a randomized list for which all % Deviations are less than or equal to the Maximum 
Allowable % Deviation specified. The search is conducted until a list is found or the 
maximum iterations are reached. A value for Maximum Allowable % Deviation must also be 
specified. 

• Smith (2 Treatments, Equal Sample Sizes) 
This algorithm may only be used for random assignment of subjects to two treatments. The 
target sample sizes must also be the same for both groups. Smith’s algorithm dynamically 
changes the group assignment probabilities based on the degree of imbalance to achieve 
longitudinal balance between groups. A value for Smith’s Exponent must also be specified. 

• Wei’s Urn (Equal Sample Sizes) 
This algorithm may be used for random assignment of subjects to two or more treatments. 
The target sample sizes must also be the same for all groups. Wei’s urn randomization 
algorithm dynamically changes the group assignment probabilities based on the degree of 
imbalance to achieve longitudinal balance between groups. Values for Wei’s A and Wei’s B 
must also be specified. 

Search for a randomization list in which all final group sizes exactly match the 
target group sizes 
Some of the randomization algorithms may result is actual group sample sizes that do not exactly 
match the target group sample sizes specified. This option forces a search to find a randomization 
list in which the final sample sizes match the target sample sizes for all groups. 
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The search is conducted by creating a randomization list using the user-specified randomization 
algorithm and then looking at the final sample sizes. If the sample sizes do not match the target 
sample sizes for all groups, then the list is discarded and the algorithm is restarted. This continues 
until a list with the exact sample sizes is found. 

Maximum Iterations in Search 
Specify the number of iterations before the randomization list search is terminated. This option is 
used for the Random Sorting using Max Allowable % Deviation (Search) algorithm and in 
searching for a randomization list where final group sizes match the target group sizes. 

Algorithm Parameters 

Efron’s p 
Specify the probability parameter p for Efron’s bias coin algorithm. This value must be greater 
than 0.5 and less than or equal to 1. A probability of 0.67 is often used. 

Maximum Allowable % Deviation 
Specify a single value for the Maximum Allowable % Deviation for the random sorting using 
maximum allowable % deviation algorithm. You can enter the value as a percentage (e.g. 10%) or 
as a decimal (e.g. 0.10). 

Smith’s Exponent 
Specify the exponent parameter ρ for Smith’s randomization algorithm. Smith (1984) favors the 
design with ρ = 5. 

Wei’s A 
Specify the initialization parameter A for Wei’s urn algorithm. This is the number of balls in the 
urn for each group when the algorithm starts. A value of 0 is often used. 

Wei’s B 
Specify the parameter B for Wei’s urn algorithm. This is the number of balls added to the other 
urns when a ball is selected. A value of 1 is often used. If B is 0 then Wei’s algorithm is the same 
as complete randomization. 

Reports Tab 
The Reports tab contains options influencing the reports. 

Output Options 

Subject ID Prefix 
Enter a text value to be added to the beginning of each subject ID. For example, if this value were 
“sub_” then the subjects would be labeled sub_1, sub_2, sub_3, etc. in the reports. 
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Storage Tab 
The storage tab contains options for specifying spreadsheet storage variables. 

Spreadsheet Storage 

Write List to Spreadsheet 
If this box is checked, then the randomization list will be written to the spreadsheet using the 
variables specified. Writing the list to the spreadsheet allows you to easily store the 
randomization list for further analysis in NCSS or other software. The spreadsheet can be saved 
as a data file. 

Store Subject ID’s In 
Specify a spreadsheet variable in which to store the subject ID values. 

Store Group Assignments In 
Specify a spreadsheet variable in which to store the randomized group assignments. 

Example 1 – Randomization with Equal Allocation Ratios 
A clinical researcher wishes to randomly assign 30 subjects to three treatments. The requirement 
is that each group has exactly 10 subjects and that the maximum % deviation is no larger than 
20% of the target sample size. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Randomization Lists procedure window by expanding 
Design of Experiments, then clicking on Randomization Lists, and then clicking on 
Randomization Lists. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Number of Groups ................................... 3 
All Group Sizes are Equal ....................... Checked 
Equal Group Size .................................... 10 
Grp 1 Label ............................................. A 
Grp 2 Label ............................................. B 
Grp 3 Label ............................................. C 

Algorithm Tab 
Randomization Algorithm ........................ Random Sorting using Max Allowable % Deviation 
Maximum Iterations in Search ................ 1000 
Maximum Allowable % Deviation ............ 20% 
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Annotated Output 
Click the Run button to perform the calculations and generate the following output. Your output 
will be different because of random assignment. 

Summary and References Sections 
 

Summary 
Randomization Algorithm Random Sorting (Maximum Allowable % Deviation = 20%) 
Search Iterations 4 
Number of Groups 3 
Total Sample Size 30 
Group Sample Sizes Actual Target 
-- A 10 10 
-- B 10 10 
-- C 10 10 
 
References 
Piantadosi, S. 2005. Clinical Trials - A Methodological Perspective. John Wiley & Sons. New Jersey. 
Pocock, S.J. 1983. Clinical Trials - A Practical Approach. John Wiley & Sons. New York. 
Rosenberger, W.F., and Lachin, J.M. 2002. Randomization in Clinical Trials - Theory and Practice. John Wiley & 
     Sons. New York. 

 

This report displays the summary of the randomization algorithm and references. 

Randomization List Section 
 

Randomization List 
 
  Largest Cumulative 
 Group % Deviation Sample Size 
Subject ID Assignment from Target (A, B, C) 
1 C 6.7% (0, 0, 1)     
2 A 6.7% (1, 0, 1)     
3 B 0.0% (1, 1, 1)     
4 C 6.7% (1, 1, 2)     
5 C 13.3% (1, 1, 3)     
6 A 10.0% (2, 1, 3)     
7 C 16.7% (2, 1, 4)     
8 B 13.3% (2, 2, 4)     
9 A 10.0% (3, 2, 4)     
10 B 6.7% (3, 3, 4)     
11 A 6.7% (4, 3, 4)     
12 A 10.0% (5, 3, 4)     
13 A 16.7% (6, 3, 4)     
14 C 16.7% (6, 3, 5)     
15 B 10.0% (6, 4, 5)     
16 B 6.7% (6, 5, 5)     
17 C 6.7% (6, 5, 6)     
18 C 10.0% (6, 5, 7)     
19 B 6.7% (6, 6, 7)     
20 A 6.7% (7, 6, 7)     
21 C 10.0% (7, 6, 8)     
22 A 13.3% (8, 6, 8)     
23 A 16.7% (9, 6, 8)     
24 B 10.0% (9, 7, 8)     
25 C 13.3% (9, 7, 9)     
26 B 6.7% (9, 8, 9)     
27 C 10.0% (9, 8, 10)     
28 B 6.7% (9, 9, 10)     
29 A 6.7% (10, 9, 10)     
30 B 0.0% (10, 10, 10) 
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This report shows the complete randomization list with details after each assignment. The largest 
observed % deviation from the target is 16.7%. 

Subject ID 
The identification value of the current subject. 

Group Assignment 
The group to which the current subject was randomly assigned. 

Largest % Deviation from Target 
The largest observed % deviation after the current assignment was made. This measures how far 
away the group sample sizes are from the expected sample size based on the targets. 

Cumulative Sample Size (Grp 1, Grp 2, …, Grp 8) 
The cumulative sample size total for each group after the current assignment was made. 

Example 2 – Randomization with Unequal Allocation 
Ratios 
A researcher wishes to randomly assign 40 subjects to three treatments using complete 
randomization. The requirement is that first group has exactly 20 subjects and the other two have 
exactly 10 subjects each.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Randomization Lists procedure window by expanding 
Design of Experiments, then clicking on Randomization Lists, and then clicking on 
Randomization Lists. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Number of Groups ................................... 3 
All Group Sizes are Equal ....................... Unchecked 
Grp 1 Label ............................................. Control 
Grp 1 Size ............................................... 20 
Grp 2 Label ............................................. A 
Grp 2 Size ............................................... 10 
Grp 3 Label ............................................. B 
Grp 3 Size ............................................... 10 

Algorithm Tab 
Randomization Algorithm ........................ Complete Randomization 
Search for randomization list… ............... Checked 
Maximum Iterations in Search ................ 1000 
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Output 
Click the Run button to perform the calculations and generate the following output. Your output 
will be different because of random assignment. 

Results 
 

Summary 
Randomization Algorithm Complete Randomization 
Search Iterations 66 
Number of Groups 3 
Total Sample Size 40 
Group Sample Sizes Actual Target 
-- Control 20 20 
-- A 10 10 
-- B 10 10 

 
 

Randomization List 
 
  Largest Cumulative 
 Group % Deviation Sample Size 
Subject ID Assignment from Target (Control, A, B) 
1 A 7.5% (0, 1, 0)     
2 B 5.0% (0, 1, 1)     
3 B 12.5% (0, 1, 2)     
4 Control 10.0% (1, 1, 2)     
5 Control 7.5% (2, 1, 2)     
6 Control 5.0% (3, 1, 2)     
7 Control 7.5% (4, 1, 2)     
8 A 0.0% (4, 2, 2)     
9 B 7.5% (4, 2, 3)     
10 B 15.0% (4, 2, 4)     
11 B 22.5% (4, 2, 5)     
12 B 30.0% (4, 2, 6)     
13 Control 27.5% (5, 2, 6)     
14 Control 25.0% (6, 2, 6)     
15 B 32.5% (6, 2, 7)     
16 Control 30.0% (7, 2, 7)     
17 A 27.5% (7, 3, 7)     
18 B 35.0% (7, 3, 8)     
19 A 32.5% (7, 4, 8)     
20 Control 30.0% (8, 4, 8)     
21 Control 27.5% (9, 4, 8)     
22 A 25.0% (9, 5, 8)     
23 A 22.5% (9, 6, 8)     
24 A 20.0% (9, 7, 8)     
25 Control 17.5% (10, 7, 8)     
26 Control 15.0% (11, 7, 8)     
27 B 22.5% (11, 7, 9)     
28 Control 20.0% (12, 7, 9)     
29 Control 17.5% (13, 7, 9)     
30 Control 15.0% (14, 7, 9)     
31 Control 12.5% (15, 7, 9)     
32 Control 10.0% (16, 7, 9)     
33 A 7.5% (16, 8, 9)     
34 B 15.0% (16, 8, 10)  
35 Control 12.5% (17, 8, 10)     
36 Control 10.0% (18, 8, 10)     
37 Control 12.5% (19, 8, 10)     
38 A 5.0% (19, 9, 10)     
39 A 2.5% (19, 10, 10)     
40 Control 0.0% (20, 10, 10) 
 

The algorithm required 66 iterations to find a list using complete randomization in which the 
target and actual sample sizes are equal. 
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Example 3 – Saving the Randomization List to the 
Spreadsheet 
A researcher would like to randomize 20 subjects to two groups using Efron’s biased coin 
randomization and save the randomization list to the spreadsheet. The researcher is targeting 10 
per group, but will allow imbalance if it results from the algorithm. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Randomization Lists procedure window by expanding 
Design of Experiments, then clicking on Randomization Lists, and then clicking on 
Randomization Lists. You may then make the appropriate entries as listed below, or open 
Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Number of Groups ................................... 2 
All Group Sizes are Equal ....................... Checked 
Equal Group Size .................................... 10 
Grp 1 Label ............................................. High 
Grp 2 Label ............................................. Low 

Algorithm Tab 
Randomization Algorithm ........................ Efron’s Biased Coin 
Search for randomization list… ............... Unchecked 
Efron’s p .................................................. 0.67 

Storage Tab 
Write List to Spreadsheet ........................ Checked 
Store Subject ID’s In ............................... 1 
Store Group Assignments In ................... 2 

Output 
Click the Run button to perform the calculations and generate the following output. Your output 
will be different because of random assignment. 

Results 
 

Summary 
Randomization Algorithm Efron's Biased Coin (p = 0.67) 
Number of Groups 2 
Total Sample Size 20 
Group Sample Sizes Actual Target 
-- High 9 10 
-- Low 11 10 
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Randomization List 
 
  Largest Cumulative 
 Group % Deviation Sample Size 
Subject ID Assignment from Target (High, Low) 
1 High 5.0% (1, 0)     
2 High 10.0% (2, 0)     
3 Low 5.0% (2, 1)     
4 High 10.0% (3, 1)     
5 Low 5.0% (3, 2)     
6 Low 0.0% (3, 3)     
7 Low 5.0% (3, 4)     
8 High 0.0% (4, 4)     
9 Low 5.0% (4, 5)     
10 High 0.0% (5, 5)     
11 Low 5.0% (5, 6)     
12 High 0.0% (6, 6)     
13 Low 5.0% (6, 7)     
14 High 0.0% (7, 7)     
15 Low 5.0% (7, 8)     
16 Low 10.0% (7, 9)     
17 High 5.0% (8, 9)     
18 High 0.0% (9, 9)     
19 Low 5.0% (9, 10)     
20 Low 10.0% (9, 11)   
 

In this case, no search was conducted. The actual and target group sample sizes turned out to be 
slightly different. Go to the PASS Output Spreadsheet to view the results stored there. 
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Chapter 881 

Two-Level Designs 
Introduction 
This program generates a 2k factorial design for up to seven factors. It allows the design to be 
blocked and replicated. The design rows may be output in standard or random order. The design 
data generated by this procedure can be produced in a spreadsheet as well as the output window. 

When blocking is specified, this procedure determines whether the design is listed on page 408 of 
Box, Hunter, and Hunter (1978). If it is one of the designs specified there, the indicated 
confounding pattern is used. If not, the blocks are confounded using the standard procedure in 
which highest-order interactions are confounded first, so long as they do not cause main effects to 
be confounded with blocks. 

Experimental Design 
Experimental design is the planning of an efficient, reliable, and accurate technical study. The 
range of application of experimental design principles is as broad as science and industry. One 
person may be planning a long-term agricultural experiment, while another may have eight hours 
to rectify a production problem. 

Through the years, researchers and statisticians working together have outlined the basic steps 
necessary to conduct an effective investigation. These steps form an experimental strategy that 
seems to work well in many settings. 

The experimental design modules lend you, the investigator, a hand with the planning and 
analysis of your investigation. Once you have determined the scope of your investigation, the 
design modules will provide a data collection plan that will minimize the amount of data 
collected and maximize the amount of conclusive information available. 

The experimental design chapters will not attempt to teach you the principles of experimental 
design. There are many excellent books and pamphlets on this subject. The focus of the manual 
will be to remind you of the basic principles of experimental design and then explain where and 
how the program can help in your study. We suggest that you consult one or two of the following 
texts for detailed coverage of experimental design: Box, Hunter, and Hunter (1978), Davies 
(1971), Lawson (1987), or Montgomery (1984). 
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Experimental Design Definitions 

Alias 
Two terms are aliased if their levels are identical throughout the design (except possibly for a 
difference in sign). Aliasing occurs in designs that are less than one full replication. The two 
terms are completely confounded with one another. It is impossible to determine from the data if 
an effect is due to the first, second, or both terms. 

Blocking 
A block refers to a batch of runs conducted together. For example, a block may be the 
experiments run on a particular day, or the experiments conducted on a particular batch of 
material. 

Confounding 
Two terms are confounded when their influences on the response variable cannot be separated. 
Confounding usually occurs when blocks are equated to high-order interactions. 

Experiment (Run) 
An action to at least one of the items being studied which has an observable outcome. Each run 
produces one observation (value) of the response variable. 

Experimental Design 
The collection of experiments to be completed during an investigation or study. 

Experimental Error 
The influence on the response of all independent variables not included in the study. This error is 
a fact of life, since it is usually impossible to control every independent variable that might 
influence the response.  

Factorial Designs 
A factorial design consists of all combinations of factor levels of two or more factors. Many 
designs are two-level designs. Since the total number of factor-level combinations is the product 
of the number of levels of each factor, these two-level designs are known as 2k factorial designs 
(where k is the number of factors). 

The two levels of each factor are often referred to as the high and the low levels. For example, if 
one of the factors were agitation at 100 rpm and 200 rpm, then 100 would be the low level and 
200 would be the high level. 

The designs produced by this procedure are orthogonal. This means that an equal amount of 
information is provided about the influence of each factor. It also means that there is no 
overlapping of information. A study using these designs clearly shows the unique influence of 
each factor. 

One of the greatest strengths of the factorial experiment is that it allows the study of several 
factors at once, rather than only one factor at a time. Since each factor is paired with all possible 
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combinations of the other factors, the researcher is confident that the measured effect of the factor 
is valid under a broad range of conditions. 

Independent Variable (Factor) 
A variable whose influence on the response variable is being studied by deliberately varying it 
from run to run. 

Interaction 
The interaction among factors refers to that part of the change in the response from run to run that 
may be accounted for by a specific combination of two or more factors. Another way of 
explaining interaction is that the average effect of one factor depends on the level of another 
factor. 

The order of an interaction is the number of factors in the interaction. Hence AB is a second-order 
interaction and ABCD is a fourth-order interaction. 

The Taylor’s series expansion of a function is often used to justify the assumption that 
higher-order interactions are less significant (smaller influence on the response) than are main 
effects and low-order interactions. 

Levels 
A factor (independent variable) is set at different values or levels during an experiment. 

Main Effect 
The change in the average response as a factor is varied is called the main effect of that factor. In 
a factor with two levels, the main effect is the average of all runs at the high level of the factor 
minus the average of all runs at the low level of the factor. 

Response or Dependent Variable 
The variable whose value is observed at the completion of each run. 

Replication 
This is the number of times an experiment is repeated at identical factor levels. You must have 
some replication to determine the underlying (error) variability that occurs in the experiment. One 
rep refers to the running of every possible factor combination.  Designs may be partially 
replicated (a few treatment settings are repeated), fractionally replicated (less than one complete 
replication), or completely replicated. It should be obvious that each time a run is repeated, the 
precision of the experimental results is increased. 

Two-Level Factorial Designs 
Many of the designs that can be produced in PASS are factorial designs. Two-level designs are 
those in which all factors have only two values. This may seem like a severe restriction, but in 
many studies, this is all that is needed. 

Factorial designs allow you to fit linear (as opposed to quadratic) models with all possible 
interactions. The number of runs is often quite large, so the runs are often grouped together in 
blocks. 
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Fractional Factorial Designs 
Fractional factorial designs are constructed by taking well-chosen subsets of a complete factorial 
design. Fractional factorials are useful because they require much fewer runs, although they do 
not allow the separation of main effects from high-order interactions. 

This program gives two-level fractional factorial designs. These are usually defined as one-half 
rep, one-quarter rep, etc. They may be run all at once or in blocks. 

Screening Designs 
Screening designs are used in the initial phases of a study when you wish to investigate the main 
effects of several factors (up to 31) simultaneously.  These designs allow you to determine which 
factors warrant closer investigation and which may be ignored. 

Screening designs allow the investigation of main effects only. They use a small fraction of the 
total runs that would be needed for a complete factorial design. 

Many of the Taguchi designs are really screening designs. 

Response Surface Designs 
These designs provide for factors with more than two levels. The options for that procedure are 
Central Composite and Box-Behnken response surface designs.  

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Replications 
The number of replications (repeats) of the entire experiment. 

Block Size 
The number of experiments (runs) per block. This determines the number of blocks. This number 
must be a power of 2 (2, 4, 8, 16, etc.). 

Sort Order 
The order of the generated rows. The rows may be in random or standard order.  

• Random 
The rows are randomly ordered (random blocks and random rows within blocks). Use this 
option when the order of application to experimental units is governed by the row number. 

• Standard 
The rows are not randomly ordered. Instead, they are placed in standard order. Use this 
option when you want to quickly see the structure of the design. 
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Factor Values 
Each factor has two possible values (levels) which are specified here. These are the values that 
will be written to the database. The first value is used to represent the low value. The second 
value represents the high value. You may use both text and numeric values. 

The number of variables created depends on how many of these boxes have values in them. 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

Block Column 
The column to contain the block identification numbers. The blocks are numbered from one to B, 
where B is the number of blocks. This column is optional. If this option is left blank, no blocks 
will be generated. 

First Factor Column 
This is where the group of columns that is to contain your design begins. The K-1 columns after 
this column are also filled with data. The number of variables used is determined by the number 
of Factor Values boxes that contain data. 

Warning: The program fills these columns with data, so any previous data will be lost. 
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Example 1 – Two-Level Design 
This section presents an example of how to generate an experimental design using this program. 
CAUTION: since the purpose of this routine is to generate design data, you should always 
begin with an empty output spreadsheet.  

In this example, we will show you how to generate a five-factor design in blocks of eight runs 
each.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Two-Level Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on Two-Level 
Designs. You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Select 1 in the Replications box.  
• Select 8 in the Block Size box.  
• Select Standard in the Sort Order box.  
• Set the Factor 1 box to 1 2. 
• Set the Factor 2 box to 10 20. 
• Set the Factor 3 box to Low High. 
• Set the Factor 4 box to -1 1. 
• Set the Factor 5 box to 0 1. 
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the Block Column box.  
• Enter 2 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Sample Design Data 
 

Experimental Design 
 
Row Block Factor 1 Factor 2 Factor 3 Factor 4 Factor 5 
1 1 1 10 Low -1 0 
2 1 2 20 Low -1 0 
3 1 2 10 High 1 0 
4 1 1 20 High 1 0 
5 1 2 10 High -1 1 
6 1 1 20 High -1 1 
7 1 1 10 Low 1 1 
8 1 2 20 Low 1 1 
9 2 2 10 Low -1 0 
10 2 1 20 Low -1 0 
11 2 1 10 High 1 0 
12 2 2 20 High 1 0 
13 2 1 10 High -1 1 
14 2 2 20 High -1 1 
15 2 2 10 Low 1 1 
16 2 1 20 Low 1 1 
17 3 2 10 High -1 0 
18 3 1 20 High -1 0 
19 3 1 10 Low 1 0 
20 3 2 20 Low 1 0 
21 3 1 10 Low -1 1 
22 3 2 20 Low -1 1 
23 3 2 10 High 1 1 
24 3 1 20 High 1 1 
25 4 1 10 High -1 0 
26 4 2 20 High -1 0 
27 4 2 10 Low 1 0 
28 4 1 20 Low 1 0 
29 4 2 10 Low -1 1 
30 4 1 20 Low -1 1 
31 4 1 10 High 1 1 
32 4 2 20 High 1 1 
    
The block and factor values were also produced on the spreadsheet. 

 
 

These values are also generated on the spreadsheet. 
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Chapter 882 

Fractional 
Factorial Designs 
Introduction 
This program generates two-level fractional-factorial designs of up to sixteen factors with 
blocking. Reports show the aliasing pattern that is used. The design rows may be output in 
standard or random order. The design data generated by this procedure can be produced in a 
spreadsheet as well as the output window. 

When generating a design, the program first checks to see if the design is among those listed on 
page 410 of Box, Hunter, and Hunter (1978). If the requested design is not listed in the above 
book, the design pattern is determined using the standard procedure in which the highest-order 
interactions are confounded first, and so on. The procedure creates the design such that main 
effects are not aliased with each other. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Runs 
The desired size (number of rows) of the experiment. This number must be a power of two. This 
number determines what fraction of a complete replicate is run. For example, suppose you are 
contemplating an experiment with seven factors and have budget for sixteen runs. A full 
replication would take 27 = 128 runs. Hence, this design is a 1/8th rep (note that 16/128 = 1/8). 

Block Size 
The number of experiments (runs) per block. This determines the number of blocks. This number 
must be a power of 2 (2, 4, 8, 16, etc.). Of course, the block size must be less than or equal to one 
half the number of runs.  



882-2  Fractional Factorial Designs  

Sort Order 
The order of the generated rows. The rows may be in random or standard order.  

• Random 
The rows are randomly ordered (random blocks and random rows within blocks). Use this 
option when the order of application to experimental units is governed by the row number. 

• Standard 
The rows are not randomly ordered. Instead, they are placed in standard order. Use this 
option when you want to quickly see the structure of the design. 

Factor Values 
Each factor has two possible values (levels) which are specified here. These are the values that 
will be written to the database. The first value is used to represent the low value. The second 
value represents the high value. You may use both text and numeric values. 

The number of variables created depends on how many of these boxes have values in them. 

Data Storage to Spreadsheet 

Block Column 
The column to contain the block identification numbers. The blocks are numbered from one to B, 
where B is the number of blocks. This column is optional. If this option is left blank, no blocks 
will be generated.  

First Factor Column 
This is where the group of columns that is to contain your design begins. The K-1 columns after 
this column are also filled with data. The number of columns used is determined by the number of 
Factor Values boxes that contain data. 

Warning: The program fills these columns with data, so any previous data will be lost. 

Reports Tab 
These options designate the variables to contain the design and the values that will be placed in 
those variables. 

Select Reports 

Design Info Report 
Specifies whether to display this report. 

Aliases Report 
Specifies whether to display this report. 
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Report Options 

Aliases 
One of the reports shows the confounding pattern among the columns of the design. However, 
when several factors are confounded, the number of terms aliased with each other gets very large. 
This option lets you limit the amount of information that the program displays.  

 

Example 1 – Fractional Factorial Design 
This section presents an example of how to generate an experimental design using this program. 
CAUTION: since the purpose of this routine is to generate data, any existing data will be 
replaced. For this reason, you should begin with an empty output spreadsheet.  

In this example, we will show you how to generate a six-factor design using sixteen runs 
separated in blocks of four runs each.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Fractional Factorial Designs procedure window by 
expanding Design of Experiments, then clicking on Experimental Design, and then clicking on 
Fractional Factorial Designs. You may then make the appropriate entries as listed below, or 
open Example 1 by going to the File menu and choosing Open Example Template. 

 

1 Specify the design parameters. 
• On the Fractional Factorial Designs window, select the Design tab.  
• Select 16 in the Runs box.  
• Select 4 in the Block Size box.  
• Select Standard in the Sort Order box.  
• Set the first six of the Factor Values boxes equal to -1 1. 
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the Block Column box.  
• Enter 2 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Design Information Section 
  

Design Information Section 
 
Design: 
1/4 replication of 6 factors in 4 blocks of 4 experiments. 
 
Defining Contrast: 
i = ABCE = BCDF = ADEF 
 
Design Construction: 
Generate a reduced model of the factors [ A B C D ]. 
The remaining factors are aliased with interactions  
of this reduced model as follows: 
E = ABC 
F = BCD 
 
Blocking Section 
 
Block: 
Blocks were generated by confounding them with the  
following interactions from the reduced model: 
ABCD, CD 

 

This report provides technical information about the design that was generated. 

Aliases Section 
  

One-Factor Aliases Section 
 
A+BCE+ABCDF+DEF 
B+ACE+CDF+ABDEF 
C+ABE+BDF+ACDEF 
D+ABCDE+BCF+AEF 
E+ABC+BCDEF+ADF 
F+ABCEF+BCD+ADE 
 
Two-Factor Interaction Aliases Section 
AB+CE+ACDF+BDEF 
AC+BE+ABDF+CDEF 
AD+BCDE+ABCF+EF 
AE+BC+ABCDEF+DF 
AF+BCEF+ABCD+DE 
BC+AE+DF+ABCDEF 
BD+ACDE+CF+ABEF 
BE+AC+CDEF+ABDF 
BF+ACEF+CD+ABDE 
CD+ABDE+BF+ACEF 
CE+AB+BDEF+ACDF 
CF+ABEF+BD+ACDE 
DE+ABCD+BCEF+AF 
DF+ABCDEF+BC+AE 
EF+ABCF+BCDE+AD 

 

This report lists the aliases of the main effects and low-order interactions. The number of aliases 
listed is controlled by the Aliases Shown option.  
From the first line of the report, we find that factor A (factor 1) is confounded with interactions 
BCE, DEF, and ABCDF. If any of the three-factor interactions are known to be real, this design 
would not be useful. Note that no two-factor interactions (like AB or CD) are aliased with the 
main effects. 
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1/4 Rep of a Six-Factor Design in Blocks of 4 Runs 
  

Experimental Design 
 
Row Block Factor 1 Factor 2 Factor 3 Factor 4 Factor 5 Factor 6 
1 1 1 1 -1 -1 -1 1 
2 1 1 1 1 1 1 1 
3 1 -1 -1 1 1 1 -1 
4 1 -1 -1 -1 -1 -1 -1 
5 2 1 -1 -1 -1 1 -1 
6 2 1 -1 1 1 -1 -1 
7 2 -1 1 -1 -1 1 1 
8 2 -1 1 1 1 -1 1 
9 3 -1 1 -1 1 1 -1 
10 3 1 -1 -1 1 1 1 
11 3 1 -1 1 -1 -1 1 
12 3 -1 1 1 -1 -1 -1 
13 4 1 1 1 -1 1 -1 
14 4 -1 -1 1 -1 1 1 
15 4 1 1 -1 1 -1 -1 
16 4 -1 -1 -1 1 -1 1 
 
 
The block and factor values were also produced on the spreadsheet. 

 
 

These values are also generated on the spreadsheet. 
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Chapter 883 

Balanced 
Incomplete Block 
Designs 
Introduction 
This module generates balanced incomplete block designs. Designs for up to ten treatments are 
available. 

In order to make precise measurements of treatment means, uniform experimental conditions 
should be maintained when comparing a number of treatments. This insures that differences 
among the treatment means result from the application of the treatment and not from some 
extraneous factor. To achieve this, experimental trials are often grouped together into blocks. In 
such designs, conditions are kept constant within the blocks and allowed to vary between the 
blocks. The best known design of this type is the randomized block design. In this design, all 
treatments are present in each block. 

Occasionally, the size of convenient blocks will not accommodate all the treatments of interest. 
For example, suppose you wanted to test four types of automobile tires for wear. An obvious 
choice for a block would be an automobile. You might select ten automobiles for the study. 
Assuming that the tires were rotated among the four positions, this experiment would control for 
differences in tire wear due to the type of automobile and the terrain that each traveled. However, 
blocking difficulties arise if you want to test six types of tires. You could redesign the 
automobile, or you could adopt a balanced incomplete block design. 

In a balanced incomplete block design, the treatments are assigned to the blocks so that every pair 
of treatments occurs together in a block the same number of times. This achieves the balance that 
is described in the title of the procedure. The balance means that all differences between 
treatments are measured with equal precision.  

Following is an example of how four treatments are assigned to blocks with a natural size of three 
experimental units. Four blocks are required for this balanced incomplete block design. 

Block Treatment 
1 A B C 
2 A B D 
3 A C D 
4 B C D 
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Note that each treatment occurs three times in this experimental layout. Also note that each pair 
of treatments occurs twice. These are the basic properties of the balanced incomplete designs. 

Box, Hunter, and Hunter (1978) point out the following rules when using such designs. 

1.  Randomly assign the numbers to the blocks. 

2.  Randomly assign the letters to the treatments. 

3.  Randomly assign the treatments within the blocks. 

4.  Randomly group blocks as replicates. A replicate is a complete set of all treatments. 

If you take these steps, this design can be used effectively in those situations in which the block 
size and the number of treatments do not match. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Design Limits 
The designs used in this procedure were taken from Cochran and Cox (1992). We have included 
designs with up to ten treatments. The following table shows what block sizes are available for 
each number of treatments. 

Number of Treatments Block Sizes Available 
4 2, 3 
5 2, 3, 4 
6 2, 3, 4, 5 
7 2, 3, 4, 6 
8 2, 4, 7 
9 2, 4, 5, 6, 8 
10 2, 3, 4, 5, 6, 9 
Note that some block sizes are not available for certain numbers of treatments. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Block Size 
This option contains the size of the blocks. That is, this is the number of experimental units that 
are contained in each block. 
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Treatment Values 
The values used to represent the treatments are specified here. These values may be letters, digits, 
words, or numbers. The list is delimited by blanks or commas. The number of treatments is 
implied by the number of items in this list. 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

Store First Factor In 
The block identification numbers of each row of the design are stored in this variable. The 
treatment identification numbers (or letters) are stored in the variable immediately to the right. 

Warning: The program fills these variables with data, so any previous data will be lost. 

 

Example 1 – Balanced Incomplete Block Design 
This section presents an example of how to generate a balanced incomplete block design using 
this program. CAUTION: since the purpose of this routine is to generate data, you should 
always begin with an empty output spreadsheet.  

In this example, we will show you how to generate a design with four treatments in blocks of two 
experimental units each.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Balanced Incomplete Block Designs procedure window by 
expanding Design of Experiments, then clicking on Experimental Design, and then clicking on 
Balanced Incomplete Block Designs. You may then make the appropriate entries as listed 
below, or open Example 1 by going to the File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Set Block Size to 2.  
• Set Treatment Values to 1 2 3 4. 
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the Store First Factor In box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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BIBD with Four Treatments in Blocks of Two 
  

Experimental Design 
 
Row Block Treatment 
1 1 1 
2 1 2 
3 2 3 
4 2 4 
5 3 1 
6 3 3 
7 4 2 
8 4 4 
9 5 1 
10 5 4 
11 6 2 
12 6 3 
    
These values were also produced on the spreadsheet. 

 
 

These values are also generated on the spreadsheet. 
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Chapter 884 

Latin Square 
Designs 
Introduction 
This module generates Latin Square and Graeco-Latin Square designs. Designs for three to ten 
treatments are available. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Latin Square designs are similar to randomized block designs, except that instead of the removal 
of one blocking variable, these designs are carefully constructed to allow the removal of two 
blocking factors. They accomplish this while reducing the number of experimental units needed 
to conduct the experiment. 

Following is an example of a four treatment Latin Square. The experimental layout is as follows: 

 Columns 
Rows Col1  Col2  Col3  Col4 
Row 1 A B C D 
Row 2 B C D A 
Row 3 C D A B 
Row 4 D A B C 

In the above table, the four treatments are represented by the four letters: A, B, C, and D. The 
letters are arranged so that each letter occurs only once within each row and each column. Notice 
that a simple random design would require 4 x 4 x 4 = 64 experimental units. This Latin Square 
needs only 16 experimental units—a reduction of 75%! 

The influence of a fourth factor may also be removed from the design by introducing a second set 
of letters, this time lower case. This design is known as the Graeco-Latin Square. 

 Columns 
Rows Col1  Col2  Col3  Col4 
Row 1 Aa Bb Cc Dd 
Row 2 Bd Ca Db Ac 
Row 3 Cb Dc Ad Ba 
Row 4 Dc Ad Ba Cb 

Four factors at four levels each would normally require 256 experimental units, but this design 
only requires 16—a reduction in experimental units of almost 94%! 

The Graeco-Latin Square is formed by combining two orthogonal Latin Squares. Graeco-Latin 
Squares are available for all numbers of treatments except six. 



884-2  Latin Square Designs  

Latin Square Assumptions 
It is important to understand the assumptions that are made when using the Latin Square design. 
The large reduction in the number of experimental units needed by this design occurs because it 
assumptions the magnitudes of the interaction terms are small enough that they may be ignored. 
That is, the Latin Square design is a main effects only design. Another way of saying this is that 
the treatments, the row factor, and the column factor affect the response independently of one 
another. 

Assuming that there are no interactions is quite restrictive, so before you use this design you 
should be able to defend this assumption. In practice, the influence of the interactions is averaged 
into the experimental error of the analysis of variance table. We say that the experimental error is 
inflated. This results in a reduced F-ratio for testing the treatment factor, and a reduced F-ratio 
lessens the possibility of achieving statistical significance. 

Randomization 
Probability statements made during the analysis of the experimental data require strict attention to 
the randomization process. The randomization process is as follows: 

1.  Randomly select a design from the set of orthogonal designs available. 

2.  Randomly assign levels of the row factor to the rows. 

3.  Randomly assign levels of the column factor to the columns. 

4.  Randomly assign treatments to the treatment letters (or numbers as the case may be). 

Orthogonal Sets 
These designs were taken from Rao, Mitra, and Matthai (1966). We have included designs with 
up to ten treatments. The number of available squares depends on the number of treatments. The 
following table shows the number of orthogonal squares stored within this procedure. 

Number of Treatments Number of Orthogonal Designs 
3 2 
4 3 
5 4 
6 1 
7 6 
8 7 
9 8 
10 2 

Graeco-Latin Squares are generated by combining two of the available orthogonal squares. Note 
that there are no six-level Graeco-Latin Squares. 



   Latin Square Designs  884-3 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Row Values 
The values used to represent the rows are specified here. These values may be letters, digits, 
words, or numbers. The list is delimited by blanks or commas. The number of rows is implied by 
the number of items in this list. The number of row, column, and treatment values must be equal. 
From three to ten values are allowed. 

Column Values 
The values used to represent the columns are specified here. These values may be letters, digits, 
words, or numbers. The list is delimited by blanks or commas. The number of rows is implied by 
the number of items in this list. The number of row, column, and treatment values must be equal. 
From three to ten values are allowed. 

Treatment 1 Values 
The values used to represent the treatments are specified here. These values may be letters, digits, 
words, or numbers. The list is delimited by blanks or commas. The number of rows is implied by 
the number of items in this list. The number of row, column, and treatment values must be equal. 
From three to ten values are allowed. 

Treatment 2 Values 
The values used to represent the second set of treatments are specified here. These values may be 
letters, digits, words, or numbers. The list is delimited by commas. The number of rows is 
implied by the number of items in this list. The number of row, column, and treatment values 
must be equal. From three to ten values are allowed. 

Note that this value is left blank unless you want to generate a Graeco-Latin Square. 

Experimental Setup – Orthogonal 
Designs 

Orthogonal Design Number I 
Select one of the available orthogonal designs. The number of available orthogonal designs is 
given in the table in Orthogonal Sets section above. Good scientific protocol requires that you 
randomly choose which of these designs is used. 

Orthogonal Design Number II 
This option is only used when the Treatment 2 Values box is non-blank (when you are generating 
a Graeco-Latin Square). Select a second of the available orthogonal designs to be combined with 
the first in forming a Graeco-Latin Square. The value here must be different from the value 
specified in Orthogonal Design I. Good scientific protocol requires that you randomly choose 
which of these designs is used. 
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Data Storage Variables 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

Store First Factor In 
The row values are stored in this column of the spreadsheet. The column values are stored in the 
column immediately to the right. The treatment values are stored in the column immediately to 
the right of the column column. If specified, the values of the second treatment are stored in the 
column immediately to the right of the first treatment column. 

Warning: The program fills these column with data, so any previous data will be replaced. 

 

Example 1 – Latin Square Design 
This section presents an example of how to generate a Latin Square design using this program. 
CAUTION: since the purpose of this routine is to generate data, you should begin with an 
empty output spreadsheet.  

In this example, we will show you how to generate a design with four treatments.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Latin Square Designs procedure window by expanding 
Design of Experiments, then clicking on Experimental Design, and then clicking on Latin 
Square Designs. You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Set Row Values to R1 R2 R3 R4.  
• Set Column Values to C1 C2 C3 C4.  
• Set Treatment 1 Values to A B C D.  
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the Store First Factor In box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Four-Level Latin Square Design 
  

Experimental Design 
 
ID Row Column Treatment 1 
1 R1 C1 A 
2 R1 C2 B 
3 R1 C3 C 
4 R1 C4 D 
5 R2 C1 B 
6 R2 C2 A 
7 R2 C3 D 
8 R2 C4 C 
9 R3 C1 C 
10 R3 C2 D 
11 R3 C3 A 
12 R3 C4 B 
13 R4 C1 D 
14 R4 C2 C 
15 R4 C3 B 
16 R4 C4 A 
    
The values were also produced on the spreadsheet. 

 
 

These values are also generated on the spreadsheet. 
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Chapter 885 

Response Surface 
Designs 
Introduction 
Response-surface designs are the only designs provided that allow for more than two levels. 
There are two general types of response-surface designs. The central-composite designs give five 
levels to each factor. The Box-Behnken designs give three levels to each factor. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

The Central-Composite designs build upon the two-level factorial designs by adding a few center 
points and star points. A factor's five values are: -a, -1, 0, 1, and a. The value of a is determined 
by the number of factors in such a way that the resulting design is orthogonal. For example, if you 
are going to use either four or five factors, the value of a is 2.00. 

The actual values of the levels are determined from these five values as follows: 

1. The low-level value is assigned to -1. 

2. The high-level value is assigned to 1. 

3. The average of these two values is assigned to 0. 

4. The values of -a and a are used to find the minimum and the maximum values. 

For example, suppose we entered 50 for the low-level and 60 for the high level. Further, suppose 
there were four factors in the experiment. The levels would be 

Coded Level Actual Level 
-a 45 
-1 50 
0 55 
1 60 
a 65 
 
The values of a depend on the number of factors in the design: 

Factors  Value of a 
2 1.41 
3 1.73 
4 2.00 
5 2.00 
6 2.24 
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The Box-Behnken designs have two differences from the central-composite designs. First, they 
usually use fewer runs. Second, they only use three levels while the central-composite designs use 
five. 

The actual values of the levels are determined in the same manner as the central-composite 
designs, except that the value of a is ignored. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Design Type 
Specify whether to generate a central-composite or a Box-Behnken design. This selection controls 
the number of runs generated as well as the block size (if a blocking variable is present). 

Sort Order 
The order of the generated rows. The rows may be in random or standard order.  

• Random 
The rows are randomly ordered (random blocks and random rows within blocks). Use this 
option when the order of application to experimental units is governed by the row number. 

• Standard 
The rows are not randomly ordered. Instead, they are placed in standard order. Use this 
option when you want to quickly see the structure of the design. 

Experimental Setup – Factor Values 

Factor Values 
Each factor has three or five possible values (levels). The values associated with -1 and 1 are 
entered here.  

If a Box-Behnken design was selected, the resulting three values will be -1,0,1. For example, if 
you entered 10 20 here, the resulting values would be 10, 15, and 20. 

If a central-composite design was selected, the resulting five values will be -a, -1, 0, 1, a. For 
example, if you had four factors and entered 50 60 here, the resulting values would be 45, 50, 55, 
60, and 65. 

These are the values that will be written to the database. You can only use numeric values. 
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Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

Block Column 
The variable to contain the block identification numbers. The blocks are numbered from one to B, 
where B is the number of blocks. This column is optional. If this option is left blank, no blocks 
will be generated.  

First Factor Column 
This is where the group of columns that is to contain your design begins. The K-1 columns after 
this column are also filled with data. The number of variables used is determined by the number 
of Factor Values boxes that contain data. 

Warning: The program fills these columns with data, so any previous data will be lost. 

Example 1 – Response Surface Design 
This section presents an example of how to generate an experimental design using this program. 
CAUTION: since the purpose of this routine is to generate data, you should always begin 
with an empty output spreadsheet.  

In this example, we will show you how to generate a three-factor central composite design with 
blocks.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Response Surface Designs procedure window by expanding 
Design of Experiments, then clicking on Experimental Design, and then clicking on Response 
Surface Designs. You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Select Central-Composite in the Design Type list box.  
• Select Standard in the Sort Order list box.  
• Set three of the Factor Values boxes equal to -1 1. 
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the Block Column box.  
• Enter 2 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Three-Factor Response-Surface Design 
  

Experimental Design: Central-Composite 
 
Row Block Factor 1 Factor 2 Factor 3 
1 1 -1 -1 -1 
2 1 1 -1 -1 
3 1 -1 1 -1 
4 1 1 1 -1 
5 1 -1 -1 1 
6 1 1 -1 1 
7 1 -1 1 1 
8 1 1 1 1 
9 1 0 0 0 
10 1 0 0 0 
11 1 0 0 0 
12 2 -1.73 0 0 
13 2 1.73 0 0 
14 2 0 -1.73 0 
15 2 0 1.73 0 
16 2 0 0 -1.73 
17 2 0 0 1.73 
18 2 0 0 0 
19 2 0 0 0 
20 2 0 0 0 
    
The block and factor values were also produced on the spreadsheet. 

 

These values are also generated on the spreadsheet. Note that there are three replicates of the 
center points in each block. Note the star points represented by -1.73 and 1.73. 
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Chapter 886 

Screening 
Designs 
Introduction 
Screening designs are used to find the important factors from a large number (up to 31) of two-
level factors. When the number of runs is 4, 8, 16, or 32 (powers of 2), the design is a regular 
fractional replication. When the number of runs is 12, 20, 24, or 28, the design used is a Plackett-
Burman design. 

This program uses the screening designs given in Lawson (1987). These designs make it possible 
to evaluate each main effect, although these are aliased with several interactions. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Runs 
The desired size (number of rows) of the experiment. This number must be 4, 8, 12, 16, 20, 24, 
28, or 32. This number determines which design is generated. 

• Random 
The rows are randomly ordered (random blocks and random rows within blocks). Use this 
option when the order of application to experimental units is governed by the row number. 

• Standard 
The rows are not randomly ordered. Instead, they are placed in standard order. Use this 
option when you want to quickly see the structure of the design. 
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Sort Order 
The order of the generated rows. The rows may be in random or standard order. 

Experimental Setup – Factor Values 

Factor Values 
Each factor has two possible values (levels), which are specified here. These are the values that 
will be written to the database. The first value is used to represent the low value. The second 
value represents the high value. You may use both text and numeric values, although we 
recommend that you stick with numeric values since these may be used in the regression 
program. 

Enter a pair of values separated by a blank or comma, such as ‘-1 1’ or ‘0 1.’ 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

First Factor Column 
This is where the group of columns that is to contain your design begins. The K-1 columns after 
this column are also filled with data. The number of variables used is determined by the number 
of Factor Values boxes that contain data. 

Warning: The program fills these columns with data, so any previous data will be lost. 
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Example 1 – Screening Design 
This section presents an example of how to generate an experimental design using this program. 
CAUTION: since the purpose of this routine is to generate data, you should always begin 
with an empty output spreadsheet.  

In this example, we will show you how to generate a six-factor design using 16 runs.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Screening Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on Screening 
Designs. You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• On the Screening Designs window, select the Design tab.  
• Set the number of Runs to 16. 
• Select Standard in the Sort Order list box.  
• Set six of the Factor Values boxes equal to -1 1. 
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 

Six-Factor Screening Design in Sixteen Runs 
  

Experimental Design 
 
Row Factor 1 Factor 2 Factor 3 Factor 4 Factor 5 Factor 6 
1 -1 -1 -1 -1 -1 -1 
2 1 -1 -1 -1 1 1 
3 -1 1 -1 -1 1 1 
4 1 1 -1 -1 -1 -1 
5 -1 -1 1 -1 1 -1 
6 1 -1 1 -1 -1 1 
7 -1 1 1 -1 -1 1 
8 1 1 1 -1 1 -1 
9 -1 -1 -1 1 -1 1 
10 1 -1 -1 1 1 -1 
11 -1 1 -1 1 1 -1 
12 1 1 -1 1 -1 1 
13 -1 -1 1 1 1 1 
14 1 -1 1 1 -1 -1 
15 -1 1 1 1 -1 -1 
16 1 1 1 1 1 1 
    
The values were also produced on the spreadsheet. 

 
 

These values are also generated on the spreadsheet. Usually, you would specify the number of 
runs as close to the number of variables as possible, while still leaving some degrees of freedom 
for an estimate of error. 
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Chapter 887 

Taguchi Designs 
Introduction 
Taguchi experimental designs, often called orthogonal arrays (OA’s), consist of a set of fractional 
factorial designs which ignore interaction and concentrate on main effect estimation. This 
procedure generates the most popular set of Taguchi designs.  

Taguchi uses the following convention for naming the orthogonal arrays: La(b^c), where a is the 
number of experimental runs, b is the number of levels of each factor, and c is the number of 
variables. Designs can have factors with several levels, although two and three level designs are 
the most common. The L18 design is perhaps the most popular. 

When a design is generated, the levels of each factor can be stored in the current spreadsheet--
replacing any data that is already there. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Design Type 
This option designates the particular design that is to be generated. The available choices are: 

• L4   2^3 
This design consists of up to 3 factors at 2 levels each. There are 4 rows. 

• L8   2^7 
This design consists of up to 7 factors at 2 levels each. There are 8 rows. 

• L12  2^11 
This design consists of up to 11 factors at 2 levels each. There are 12 rows. 

• L16  2^15 
This design consists of up to 15 factors at 2 levels each. There are 16 rows. 
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• L32  2^31 
This design consists of up to 31 factors at 2 levels each. There are 32 rows. 

• L64  2^63 
This design consists of up to 63 factors at 2 levels each. There are 64 rows. 

• L9   3^4 
This design consists of up to 4 factors at 3 levels each. There are 9 rows. 

• L27  3^13 
This design consists of up to 13 factors at 3 levels each. There are 27 rows. 

• L27' 3^22 
This design consists of up to 22 factors at 3 levels each. There are 27 rows. 

• L16' 4^5 
This design consists of up to 5 factors at 4 levels each. There are 16 rows. 

• L25  5^6 
This design consists of up to 6 factors at 5 levels each. There are 25 rows. 

• L18  2^1 x 3^7 
This design consists of one factor at 2 levels and up to 7 factors at 3 levels each. There are 18 
rows. 

• L36  2^3 x 3^13 
This design consists of up to 3 factors at 2 levels and up to 13 factors at 3 levels each. There 
are 36 rows. 

• L36' 2^11 x 3^12 
This design consists of up to 11 factors at 2 levels and up to 12 factors at 3 levels each. There 
are 36 rows. 

• L54  2^1 x 3^25 
This design consists of one factor at 2 levels and up to 25 factors at 3 levels each. There are 
54 rows. 

• L32' 2^1 x 4^9 
This design consists of one factor at 2 levels and up to 9 factors at 4 levels each. There are 32 
rows. 

• L50  2^1 x 5^11 
This design consists of one factor at 2 levels and up to 11 factors at 5 levels each. There are 
50 rows. 
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Experimental Setup – Factor 
Specification 

2 Level Factors…5 Level Factors 
The number of columns of this type (number of levels) that are generated. For example, if you 
selected L36 2^3 x 3^13 as the Design Type, you could specify up to three two-level factors and 
up to thirteen three-level factors. You would enter the number of two-level factors in the 2-Level 
Factors box and the number of three-level factors in the 3-Level Factors box. Entries in the 
unused boxes (such as 4-Level and 5-Level in this example) are ignored. If you enter more than 
the maximum allowed, the maximum will be used. 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

First Factor Column 
This is where the group of columns of the spreadsheet that is to contain your design begins. The 
K-1 columns after this column are also filled with data, where K is the number of factors 
specified. 

Warning: The program fills these columns with data, so any previous data will be lost. 
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Example 1 – Taguchi Design 
This section presents an example of how to generate an experimental design using this program. 
CAUTION: since the purpose of this routine is to generate data, you should always begin 
with an empty output spreadsheet.  

In this example, we will show you how to generate an L18 design.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Taguchi Designs procedure window by expanding Design of 
Experiments, then clicking on Experimental Design, and then clicking on Taguchi Designs. 
You may then make the appropriate entries as listed below, or open Example 1 by going to the 
File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Select L18  2^1 x 3^7 in the Design Type list box.  
• Enter 1 in the 2-Level Factors box.  
• Enter 7 in the 3-Level Factors box.  
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 

Taguchi L18 Design 
  

Experimental Design 
 
Row Factor 1 Factor 2 Factor 3 Factor 4 Factor 5 Factor 6 Factor 7 Factor 8 
1 1 1 1 1 1 1 1 1 
2 1 1 2 2 2 2 2 2 
3 1 1 3 3 3 3 3 3 
4 1 2 1 1 2 2 3 3 
5 1 2 2 2 3 3 1 1 
6 1 2 3 3 1 1 2 2 
7 1 3 1 2 1 3 2 3 
8 1 3 2 3 2 1 3 1 
9 1 3 3 1 3 2 1 2 
10 2 1 1 3 3 2 2 1 
11 2 1 2 1 1 3 3 2 
12 2 1 3 2 2 1 1 3 
13 2 2 1 2 3 1 3 2 
14 2 2 2 3 1 2 1 3 
15 2 2 3 1 2 3 2 1 
16 2 3 1 3 2 3 1 2 
17 2 3 2 1 3 1 2 3 
18 2 3 3 2 1 2 3 1 
    
The values were also produced on the spreadsheet. 

 

These values are also generated on the spreadsheet. You can use the Find/Replace facility of the 
spreadsheet if you want to change the values from 1, 2, 3 to something more meaningful. 



  888-1 

Chapter 888 

D-Optimal Designs 
Introduction 
This procedure generates D-optimal designs for multi-factor experiments with both quantitative 
and qualitative factors. The factors can have a mixed number of levels. For example, you could 
use this procedure to design an experiment with two quantitative factors having three levels each 
and a qualitative factor having seven levels. 

D-optimal designs are constructed to minimize the generalized variance of the estimated 
regression coefficients. In the multiple regression setting, the matrix X is often used to represent 
the data matrix of independent variables. D-optimal designs minimize the overall variance of the 
estimated regression coefficients by maximizing the determinant of X’X. Designs that are D-
optimal have been shown to be nearly optimal for several other criteria that have been proposed 
as well. 

D-optimal designs are used when there is a limited budget and a completely replicated factorial 
design cannot be run. For example, suppose you want to study the response to three factors: A 
with three levels, B with four levels, and C with eight levels. One complete replication of this 
experiment would require 3 x 4 x 8 = 96 points (we use the word ‘point’ to mean an experimental 
unit). If only 20 points can be afforded, the D-optimal design algorithm provides a reasonable 
choice for the 20 points. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

D-Optimal Design Overview 
This section provides a brief overview of how the D-optimal design algorithm works. It will 
provide a general understanding of what the algorithm is trying to accomplish so that you can 
make intelligent choices for the various options. 

Suppose you are studying the influence of height and weight on blood pressure. If you believe 
that a linear (straight line) relationship exists, you will only need to look at two height values and 
two weight values. An experiment designed to study this relationship would require four 
treatment combinations. However, if you decide that the relationship may be curvilinear, you will 
have to include at least three levels for each factor which results in nine treatment combinations. 
Clearly, the appropriate experimental design depends on the anticipated functional relationship 
between the response variable and the factors of interest.  

The D-optimal algorithm works as follows. First, specify an approximate mathematical model 
which defines the functional form of the relationship between the response (Y) and the 
independent variables (the factors). Next, generate a set of possible candidate points based on this 
model. Finally, from these candidates select the subset that maximizes the determinant of the X’X 



888-2  D-Optimal Designs 

matrix. This is the D-optimal design. The details of this algorithm are given in Atkinson and 
Donev (1992). 

The number of possible designs grows rapidly as the complexity of the model increases. This 
number is usually so large that an exhaustive search of all possible designs for a given sample 
size is not feasible.  

The D-optimal algorithm begins with a randomly selected set of points. Points in and out of the 
current design are exchanged until no exchange can be found that increases the determinant of 
X’X. To cut down on the running time, the number of points considered during any one iteration 
may be limited. 

Unfortunately, this method does not guarantee that the global maximum is found. To overcome 
this, the algorithm is repeated several times in hopes that at least one iteration leads to the global 
maximum. For this reason 50 or 100 random starting sets are needed. (During the testing of the 
algorithm, we found that some designs required 500 starts to obtain the global maximum.) 

Factor Scaling 
This algorithm deals with both quantitative (continuous) and qualitative (discrete) factors. The 
levels of quantitative factors are scaled so that the minimum value is -1 and the maximum value 
is 1. Qualitative factors are included as a set of variables. For example, suppose that a qualitative 
variable has four values. Three independent variables are created to represent this factor: 

Original X1 X2 X3 
1 -10 0 0 
2 0 -1 0 
3 0 0 -1 
4 1 1 1 
As you can see, each of these variables compares a separate group with the last group. Also note 
that the number of generated variables is always one less than the number of levels.  

Duplicates (Replicates) 
The measurement of experimental error is extremely important in the analysis of an experiment. 
In most cases, if an estimate of experimental error is not available, the data from the experiment 
cannot be analyzed. One of the best estimates of experimental error comes from points that are 
duplicates (often called replicates) of each other. Since D-optimal designs are often used in 
situations with limited budgets, the experimenter is often tempted to ignore the need for 
duplicates and instead add points with additional treatment combinations. The tenth 
commandment for experimental design should be “Thou shalt have at least four duplicates in an 
experiment.”  

Unfortunately, the D-optimal design algorithm ignores the need for duplicates. Instead, you have 
to add them after the experimental design has been found. You should set aside at least four 
points from the algorithm. For example, suppose you have budget for 20 design points. You 
would tell the program that you have only 16 points. The algorithm would find the best 16 point 
design. You would then duplicate four of the resulting design points to provide an estimate of 
experimental error. We recommend that you spread these duplicates out across the experiment so 
you can have some indication as to whether the magnitude of the experimental error is constant 
across all treatment settings.  
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Specifying a Model  
Selecting an appropriate model is subjective by nature. Often, you will know very little about the 
true functional form of the relationship between the response and the factor variables. A common 
approach is to assume that a second-order Taylor-series approximation will work fairly well. You 
are assuming that the true function may be approximated by parabolic surface in the 
neighborhood of interest. Cutting down on the complexity of the model reduces the number of 
points that must be added to the experimental design. 

When dealing with qualitative factors, you generally limit the model to first order interactions. 
Higher order interactions may be studied later when a complete experiment can be run. 

Augmenting an Existing Design  
Occasionally, you will want to add more points to an existing experimental design. This may be 
accomplished by forcing the algorithm to include points that are read from the spreadsheet. The 
D-optimal algorithm will pick the most useful additional points from the list of candidate points. 
One of the attractive features of the D-optimal design algorithm is that you can refine the model 
as your knowledge of it increases. 

Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

N Per Block 
This option specifies the required sample size. If you are not using blocks, enter a single number 
giving the total sample size. The sample size must be large enough to fit the designated model. If 
it is not large enough, you will be shown the minimum number of points necessary. 

If you are using blocks, enter the sample size for each block, separated by blanks or commas. 
These sample sizes do not have to be equal, although they usually are. For example, if you have 
three blocks, you might enter 8,8,12 which would give an overall sample size of 28. The first 
block will have 8 points, the second 8 points, and the third 12 points. 

You must be careful when specifying blocks when you also have forced design points. In this 
case, the first few blocks are matched with the forced design points. The size of the blocks must 
match the number of forced points. For example, suppose you have already run two blocks of 
four each and you want to augment this with three blocks of six each. You would have eight 
forced points. The entry in this field would be 4,4,6,6,6. If you entered 4,3,7,6,6 an error would 
occur because the forced points cannot be assigned exactly to one or more blocks. The bottom 
line is, you cannot force partial blocks into the design. 
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Input Columns (Candidate and Forced) 
When specified, these columns contain either a set of points to be forced into the final design, a 
set of candidate points from which the design is to be selected, or both. The data must be arranged 
so that the forced points are located at the top of the spreadsheet followed by any candidate 
points. When candidate points are specified, no additional candidate points are generated. If you 
want to force points in the design and choose the rest from among those generated by the model 
statement, the total number of rows in these variables must equal the total number of forced rows 
specified below. 

Note that these variables are matched with the factors specified in the model after those factors 
have been sorted. 

Qualitative factors must be entered using positive integers (1, 2, 3, etc.). You cannot use any 
other identifiers. If you have data entered using some other scheme (such as A, B, C, etc.), you 
will have to recode the values so that they are positive integers. 

Quantitative factors must be scaled so that the minimum value is -1 and the maximum value is 1. 
For example, suppose an existing design has a factor whose values are 10, 15, and 20. Here the 
minimum is 10 and the maximum is 20. You would transform these using the formula  

Scaled = (Original + Original - Max - Min) / (Max - Min) 

Since, in this example, Max = 20 and Min = 10, the transformation reduces to New = (Original + 
Original - 30)/10 = Original /5 - 3. You would create a new variable using the transformation 
Original /5-3. This transformation would give 10/5 - 3 = -1, 15/5 - 3 = 0, and 20/5 - 3 = 1. That is, 
the new variable would contain -1’s, 0’s, and 1’s instead of 10’s, 15’s, and 20’s. 

Number Duplicates 
It is very important to have duplicates of at least some of the design points to provide an estimate 
of experimental error. This option designates the number of duplicates to be generated. The first 
design point is duplicated, then the second, and so on. Even though this option is convenient, we 
recommend that you pick appropriate points for duplication by looking at scatter plots of the 
design. 

If your design includes blocking, you should not create duplicates since that will give erroneous 
block sizes. Rather, you should manually create duplicates. 

Input Data Type 
If you have Input Variables specified, this option specifies the type of data contained in those 
variables. Two types of data are possible. 

• Factor Values 
Specifies that the input data contains indices of each factor. An expanded design matrix will 
be generated from these factor indices using the designated model. This is the more common 
data type. 

• Expanded Matrix 
Specifies that the input dataset contains the expanded design matrix. That is, the quadratic, 
cubic, and interaction terms have been created. The model statement is not used. You would 
use this option when you want to specify the candidate design set in more detail than is 
allowed by the program. The expanded matrix must include the intercept (a column of one’s) 
if one is to be included in the model. 
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Forced Points 
The number of rows in the Input Variables that should be forced into the final design. These rows 
must be located at the top of the database, before any candidate points. If the number of forced 
points is equal to the number of points read in, the generated design matrix is used. Otherwise, the 
additional rows are used as candidate points and no other rows are generated. 

Optimize the Design for this Model 
Your design is optimized for the model specified here. Specify main effects (factors) with names 
consisting of one or more letters, such as A B C. Specify interactions using an asterisk (*), such 
as A*B. You can use the bar (|) symbol (see examples below) as a shorthand method to specify a 
complete model. You can use parentheses. You can separate terms with blanks or the '+' (plus) 
sign. Duplicate terms are removed during the evaluation of the model. Note that the main effects 
are always sorted in alphabetical order. 

Some examples will help to indicate how the model syntax works: 

C + B + A + B*A + C*A = A+B+C+A*B+A*C (Note the sorting!) 

A|B = A+B+A*B 

B|A = A+B+A*B 

A|B A*A B*B = A+B+A*B+A*A+B*B 

A|A|B|B (Max Term Order=2) = A+B+A*B+A*A+B*B 

A|B|C  =  A+B+C+A*B+A*C+B*C+A*B*C 

(A+B)*(C+D)  = A*C+A*D+B*C+B*D 

(A+B)|C = A+B+C+(A+B)*C 

 =  A+B+C+A*C+B*C 

You can experiment with various expressions by viewing the Model Terms report. 

For quantitative factors, each term represents a single variable in the expanded design matrix. For 
qualitative variables, each term represents a set of variables in the expanded design matrix.  

Note that qualitative terms should not be squared or cubed. That is, if A is a qualitative factor, 
you would not include A*A or an A*A*A in your model. 

Max Term Order 
This option specifies that maximum number of factors that can occur in an interaction term. For 
example, A*B*C is a third order interaction term and if this option were set to 2, the A*B*C 
would be removed from the model. 

This option is particularly useful when used with the bar notation to remove unwanted terms. 

Qualitative Factors and Levels 
List any qualitative factors here followed by the number of levels given in parenthesis. Factors in 
the model which do not appear here are assumed to be quantitative (continuous). For example, 
you might enter A(5),B(4),C(7) to indicate three qualitative factors, one with five levels, the next 
with four levels, and the third with seven levels. Of course, the names used here must match the 
names used in the model statement. 
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Max Iterations 
Specify the number of times the algorithm is started with a new random design. Often 50 or 100 
iterations are necessary and 500 is not unheard of. As the number of Inclusion Points and 
Removal Points are increased (see below), the number of iterations may be decreased. 

We suggest that you increase this value until the optimal design is found on several iterations as 
reported in the Determinant Analysis report. 

Inclusion Points 
This is the number of candidate points considered for addition during an iteration. Instead of 
considering all candidate points, only this many are used. A value between 1 and Nc-1 (where Nc 
is the number of candidate points) may be used. Usually, a value near Nc/2 is adequate. 

Removal Points 
This is the number of points currently in the design that will be considered for removal during a 
particular iteration. A value between 1 and N (the desired sample size) is used. Setting this value 
smaller than N speeds up the search, but reduces the possibility of finding the optimal design.  

Include Intercept 
This option specifies whether to include the intercept in the expanded design matrix. Usually, the 
intercept is left out of mixture designs. The intercept is automatically deleted in designs with 
more than one block. 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

First Factor Column 
If the Input Data Type is set to Factor Values, the final design is stored in a set of contiguous 
columns of the spreadsheet, beginning with this column. Be careful not to overwrite existing data. 
If you have four factors, the design will be stored in this variable and the next three to the right. 
Existing data will be lost! 

If the Input Data Type is set to Expanded Matrix, an index is stored in this column that represents 
whether the row is used in the design. If the row is not in the optimum design, a zero is stored. If 
the row is in the optimum design, the number of times it occurs is stored here. 

First Expanded Column 
This option specifies the first column in which to store the expanded version of the selected 
design. The rest of the expanded design columns will be stored in the columns to the right. Use 
this option if you want to output the expanded design matrix for use in a multiple regression 
procedure. 

Warning: The program fills these columns with data, so existing data will be replaced. 
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Data Storage to Spreadsheet – 
Storage Options 

Rename Factor Columns with Factor Labels 
The names of the factors that were used in the model statement are used to rename the columns in 
which the design is stored. 

Clear Existing Data 
Clear all existing data in the design columns before writing the new design data. This is 
especially useful if you are experimenting with several designs of different sizes. You will not be 
warned that data is being lost. The data will be cleared and the new design written automatically. 

Reports Tab 
This panel specifies the reports that will be generated. 

Select Reports 

Factor Report - Expanded Design Matrix Report 
These options control which reports are displayed. Some of the reports may be fairly lengthy, so 
you will often want to omit them. 

Report Options 

Precision 
Specify the precision of numbers in the report. A single-precision number will show seven-place 
accuracy, while a double-precision number will show thirteen-place accuracy. Note that the 
reports are formatted for single precision. If you select double precision, some numbers may run 
into others. Also note that all calculations are performed in double precision regardless of which 
option you select here. This is for reporting purposes only. 

Decimal Places 
Specify the number of decimal places shown when displaying the design. 
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Example 1 – D-Optimal Design with 10 Points, 3 Factors 
This section presents an example of how to generate a D-optimal design using this program. 
CAUTION: since the purpose of this routine is to generate data, you should begin with an 
empty output spreadsheet.  

In this example, we will show you how to generate a 10-point design for a study involving three 
quantitative factors. We want the design optimized to estimate a second-order response surface 
model.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

1 Specify the design and data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N per Block to 10. 
• Set Optimize the Design for this Model to A|A|B|B|C|C.  
• Set Max Term Order to 2. 
• Set the First Factor Column to 1.  
• Set the First Expanded Column to 5.  
• Check Rename Factor Column with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Check all reports. 
• Set Decimal Places to 0. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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10-Point, 3 Factor D-Optimal Design 
  
 A B C C4 Int’t Ax Bx Cx A_A A_B A_C B_B B_C C_C 
 -1 -1 -1  1 -1 -1 -1 1 1 1 1 1 1 
 1 -1 -1  1 1 -1 -1 1 -1 -1 1 1 1 
 0 0 -1  1 0 0 -1 0 0 0 0 0 1 
 -1 1 -1  1 -1 1 -1 1 -1 1 1 -1 1 
 1 1 -1  1 1 1 -1 1 1 -1 1 -1 1 
 1 0 0  1 1 0 0 1 0 0 0 0 0 
 0 1 0  1 0 1 0 0 0 0 1 0 0 
 1 -1 1  1 1 -1 1 1 -1 1 1 -1 1 
 -1 0 1  1 -1 0 1 1 0 -1 0 0 1 
 1 1 1  1 1 1 1 1 1 1 1 1 1 
 

Several columns in the spreadsheet are filled with data. The results may vary from the values seen 
here, as there may be equally optimal designs. The first, second, and third, variables (A, B, and C) 
contain the actual design. You would replace the -1’s with the corresponding factor’s minimum 
value, the 1’s with the maximum value, and the 0’s with the average of the two. 
The variables from Intercept to C_C contain the expanded design matrix. Each variable is 
generated by multiplying the appropriate factor values. For example, in the first row, A_B is 
found by multiplying the value for A, which is -1, by the value for B, which is also -1. The result 
is 1. The intercept is set to one for all rows. The expanded matrix is usually saved so that the 
design can be analyzed using multiple regression. 

To use this design, you would randomly assign these ten points to the ten experimental units.  

Factor Section 
  

 Number 
Name Values Type Value1 Value2 Value3   
A 3 Quantitative -1.0000 0.0000 1.0000   
B 3 Quantitative -1.0000 0.0000 1.0000   
C 3 Quantitative -1.0000 0.0000 1.0000   
 
A total of 27 observations will be needed for one replication. 

 

This report summarizes the factors that were included in the design. The last line of this report 
gives the number of observations required for one complete replication of the experiment. This 
value is the product of the number of levels for each factor. 

Name 
The symbol(s) used to represent the factor. 

Number Values 
The number of values (levels) generated for each factor. For qualitative factors, this value was set 
in the Qualitative Factors and Levels box of the Design panel. For quantitative factors, this value 
is one more that the highest exponent used with this term. For example, if the model includes an 
A*A and nothing of a higher order, this value will be three. 

Type 
A factor is either quantitative or qualitative. 
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Value1 – Value 3 
These columns list the individual values that are used as the levels of each factor when generating 
the expanded design matrix based on the model. Notice that the smallest is always -1 and the 
largest is always 1. 

When the expanded design matrix is input directly, these values should be ignored. 

Model Terms Section 
  

Variables  
Needed Term 
1 A 
1 B 
1 C 
1 A*A 
1 A*B 
1 A*C 
1 B*B 
1 B*C 
1 C*C 
9 Model Total 

 

This report shows the terms generated by your model. You should check this report carefully to 
make sure that the generated model matches what you wanted. The last line of the report gives the 
total number of degrees of freedom (except for the intercept) required for your model. This 
number plus one is the minimum size of the D-optimal design for this model. 

Variables Needed 
The number of degrees of freedom (expanded design variables) required for this term. 

Term 
The name of each term.  

D-Optimal Design 
  

Original Factors   
Row A B C 
1 -1 -1 -1 
3 1 -1 -1 
5 0 0 -1 
7 -1 1 -1 
9 1 1 -1 
13 -1 0 0 
17 0 1 0 
20 0 -1 1 
25 -1 1 1 
27 1 1 1 

 

This report gives the points in the D-optimal design.  

Original Row 
This is the row number of the point from the list of candidate points. It is only useful in those 
cases in which you provided the list of candidate points manually. 
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Factors (A B C) 
These are the values of the factors. For example, the first row sets A, B, and C to -1. Remember 
that these are scaled values. You would transform them back into their original metric using the 
formula: 

Original = (Scaled(Max - Min) + Max + Min)/2 

For example, suppose the original metric for factor A is minimum = 10 and maximum =20. The 
original values would be calculated as follows: 

Scaled Formula Original 
-1 (-1(20-10)+20+10)/2 10 
0 (0(20-10)+20+10)/2 15 
1 (1(20-10)+20+10)/2 20 

The values 10, 15, and 20 represent the three levels of factor A that are used in the design. They 
would replace the -1, 0, and 1 displayed in this report. 

Determinant Analysis Section 
  

 Determinant D- Percent of 
Rank of X'X Efficiency Maximum 
1 1327104 40.95 100.00 
2 1327104 40.95 100.00 
3 1048576 40.00 79.01 
4 1048576 40.00 79.01 
5 1048576 40.00 79.01 
6 1048576 40.00 79.01 
7 1048576 40.00 79.01 
8 921600 39.49 69.44 
9 921600 39.49 69.44 
10 802816 38.95 60.49 
11 802816 38.95 60.49 
12 802816 38.95 60.49 
13 802816 38.95 60.49 
14 802816 38.95 60.49 
15 802816 38.95 60.49 
16 746496 38.66 56.25 
17 589824 37.76 44.44 
18 589824 37.76 44.44 
19 589824 37.76 44.44 
20 589824 37.76 44.44 
 
The maximum was achieved on 2 of 30 iterations. 

 

This report shows the largest twenty determinants. The main purpose of this report is to let you 
decide if enough iterations have been run so that a global maximum has been found. Unless the 
maximum value was achieved on at least five iterations, you should double the number of 
iterations and rerun the procedure. 
In this example, the top value occurred on only two iterations. In practice we would probably try 
another 200 iterations to find out if this is the global maximum.  

Rank 
Only the top twenty are shown on this report. The values are sorted by the determinant. 
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Determinant of X’X 
This is the value of the determinant of X’X which is the statistic that is being maximized. This 
value is sometimes called the generalized variance of the regression coefficients. Since this value 
occurs in the denominator of the variance of each regression coefficient, maximizing it has the 
effect of reducing the variance of the estimated regression coefficients. 

D-Efficiency 
D-efficiency is the relative number of runs (expressed as a percent) required by a hypothetical 
orthogonal design to achieve the same determinant value. It provides a way of comparing designs 
across different sample sizes. 
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where p is the total number of degrees of freedom in the model and N is the number of points in 
the design. 

Percent of Maximum 
This is the percentage that the determinant on this row is of the best determinant found. 

Individual Degree of Freedom Section 
  

  Diagonal of Diagonal of 
Number Name X'X X'X Inv 
1 Intercept 10.0000 0.861111 
2 A 7.0000 0.250000 
3 B 8.0000 0.166667 
4 C 8.0000 0.166667 
5 A*A 7.0000 0.722222 
6 A*B 6.0000 0.250000 
7 A*C 6.0000 0.250000 
8 B*B 8.0000 0.861111 
9 B*C 7.0000 0.194444 
10 C*C 8.0000 0.861111 
 
Determinant  1327104 
D-Efficiency  40.95345 
Trace  4.583333 
A-Efficiency  21.81818 

 

This report shows the diagonal elements of the X’X and its inverse. Since the variance of each 
term is proportional to diagonal elements from the inverse of X’X, the last column of this report 
lets you compare those variances. From this report you can determine if the coefficients will be 
estimated with the relative precision that is desired. 
For example, we can see from this example that them main effects will be estimated with the 
greatest precision—usually a desirable quality in a design. 

Number 
An arbitrary sequence number. 

Name 
The name of the term. 



 D-Optimal Designs  888-13 

Diagonal of X’X 
The diagonal element of this term in the X’X matrix. 

Diagonal of X’X Inv 
The diagonal element of this term in the X’X inverse matrix. See the discussion above for an 
understanding of how this value might be interpreted. 

Determinant 
This is the value of the determinant of X’X which is the statistic that is being maximized. This 
value is sometimes called the generalized variance of the regression coefficients. Since this value 
occurs in the denominator of the variance of each regression coefficient, maximizing it has the 
effect of reducing the variance of the estimated regression coefficients. 

D-Efficiency 
D-efficiency is the relative number of runs (expressed as a percent) required by a hypothetical 
orthogonal design to achieve the same determinant value. It provides a way of comparing designs 
across different sample sizes. 
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where p is the total number of degrees of freedom in the model and N is the number of points in 
the design. 

Trace 
This is the value of the trace of X’X-inverse which is associated with A-optimality.  

A-Efficiency 
D-efficiency is the relative number of runs (expressed as a percent) required by a hypothetical 
orthogonal design to achieve the same trace value. It provides a way of comparing designs across 
different sample sizes. 
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where p is the total number of degrees of freedom in the model and N is the number of points in 
the design. 
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Candidate Points Section 
  
Original Factors   
Row A B C 
1 -1 -1 -1 
2 0 -1 -1 
3 1 -1 -1 
4 -1 0 -1 
5 0 0 -1 
6 1 0 -1 
7 -1 1 -1 
8 0 1 -1 
9 1 1 -1 
10 -1 -1 0 
11 0 -1 0 
12 1 -1 0 
13 -1 0 0 
14 0 0 0 
15 1 0 0 
16 -1 1 0 
17 0 1 0 
18 1 1 0 
19 -1 -1 1 
20 0 -1 1 
21 1 -1 1 
22 -1 0 1 
23 0 0 1 
24 1 0 1 
25 -1 1 1 
26 0 1 1 
27 1 1 1 
 

This report gives a list of candidate points from which the D-optimal design points were selected.  

Original Row 
This is an arbitrary identification number. 

Factors (A B C) 
These are the values of the factors. For example, the first row sets A, B, and C to -1. Remember 
that these are scaled values. You would transform them back into their original metric using the 
formula: 

Original = (Scaled(Max - Min) + Max + Min)/2 

For example, suppose the original metric for factor A is minimum = 10 and maximum =20. The 
original values would be calculated as follows: 

Scaled Formula Original 
-1 (-1(20-10)+20+10)/2 10 
0 (0(20-10)+20+10)/2 15 
1 (1(20-10)+20+10)/2 20 

The values 10, 15, and 20 represent the three levels of factor A. They would replace the -1, 0, and 
1 displayed in this report. 
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Expanded Design Matrix Section 
  

 Variable       
Row Intercept A B C A*A A*B A*C B*B B*C C*C 
1 1 -1 -1 -1 1 1 1 1 1 1 
2 1 0 -1 -1 0 0 0 1 1 1 
3 1 1 -1 -1 1 -1 -1 1 1 1 
4 1 -1 0 -1 1 0 1 0 0 1 
5 1 0 0 -1 0 0 0 0 0 1 
6 1 1 0 -1 1 0 -1 0 0 1 
7 1 -1 1 -1 1 -1 1 1 -1 1 
8 1 0 1 -1 0 0 0 1 -1 1 
9 1 1 1 -1 1 1 -1 1 -1 1 
10 1 -1 -1 0 1 1 0 1 0 0 
11 1 0 -1 0 0 0 0 1 0 0 
12 1 1 -1 0 1 -1 0 1 0 0 
13 1 -1 0 0 1 0 0 0 0 0 
14 1 0 0 0 0 0 0 0 0 0 
15 1 1 0 0 1 0 0 0 0 0 
16 1 -1 1 0 1 -1 0 1 0 0 
17 1 0 1 0 0 0 0 1 0 0 
18 1 1 1 0 1 1 0 1 0 0 
19 1 -1 -1 1 1 1 -1 1 -1 1 
20 1 0 -1 1 0 0 0 1 -1 1 
21 1 1 -1 1 1 -1 1 1 -1 1 
22 1 -1 0 1 1 0 -1 0 0 1 
23 1 0 0 1 0 0 0 0 0 1 
24 1 1 0 1 1 0 1 0 0 1 
25 1 -1 1 1 1 -1 -1 1 1 1 
26 1 0 1 1 0 0 0 1 1 1 
27 1 1 1 1 1 1 1 1 1 1 
    

This report gives a list of candidate points expanded so that each individual term may be seen. 
The report is useful to show you how the expanded matrix looks. Each variable is generated by 
multiplying the appropriate factor values. For example, in the first row, A_B is found by 
multiplying the value for A, which is -1, by the value for B, which is also -1. The result is 1. The 
intercept is set to one for all rows. 
If you want to constrain the design space, you could cut and paste these values back into the 
spreadsheet and then eliminate points that cannot occur. 

Example 2 – Two Factors 
This section presents an example of how to generate and analyze a D-optimal design involving 
two factors. Suppose we want to study the effect of two factor variables, A and B, on a response 
variable, Y. A and B happen to be quantitative variables and there is reason to believe that a 
second-order response surface design will work well. A full replication of this design requires 
nine points. In addition, four more are required to provide an estimate of experimental error. 
However, we can only afford eight. We will create a D-optimal design with six of the 
experimental units and use the remaining two as duplicates to provide the estimate of 
experimental error.  

We want to analyze the response surface for values of A between 10 and 20 and values of B 
between 1 and 3.  
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

1 Specify the design and data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N Per Block to 6. 
• Set Optimize the Design for this Model to A|A|B|B.  
• Set Max Term Order to 2. 
• Check the Store Data on Spreadsheet box. 
• Set the First Factor Column to 1.  
• Set the First Expanded Column to 4.  
• Check Rename Factor Variables with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Set Decimal Places to 0. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 

6-Point, 2 Factor D-Optimal Design 
  
 A B 

 -1 -1 
 0 -1  
 1 -1 
 0 0 
 -1 1 
 1 1 

 

Columns A and B give the design. The Determinant Analysis Section showed that the maximum 
was achieved on 25 of the 30 iterations. Hence, we assume that the algorithm converged to the 
global maximum. 
Next, we add the two duplicates to the design. When only a few duplicates are available, we like 
to have them in the middle, so we will duplicate the two rows having zero values. We choose 
random numbers for the two new response values. The resulting design appears as follows. 
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6-Point Design with Two Duplicates  
  
 A B 

 -1 -1 
 0 -1  
 0 -1  
 1 -1 
 0 0 
 0 0 
 -1 1 
 1 1 

 

Next, we change the factor values back to their original scale. Factor A went from 10 to 20 and 
factor B went from 1 to 3. We call the two new variables A1 and B1. While we are at it, we also 
create other variables of the expanded design matrix. The resulting database appears as follows. 

6-Point Design in Expanded Form  
  

A B A1 B1 A1_B1 A1_A1 B1_B1 
-1 -1 10 1 10 100 1 
0 -1 15 1 15 225 1 
0 -1 15 1 15 225 1 
1 -1 20 1 20 400 1 
0 0 15 2 30 225 4 
0 0 15 2 30 225 4 
-1 1 10 3 30 100 9 
1 1 20 3 60 400 9 
 

We could continue this exercise by running these data through a multiple regression program, 
paying particular attention to the Multicollinearity Section and the Eigenvalues of Centered 
Correlations Section. When we did this, we found that multicollinearity seemed to be a problem 
in the original scale, but not in the -1 to 1 scale used by the D-optimal algorithm.  

Example 3 – Three Factors with Blocking 
This section presents an example of how to generate and analyze a D-optimal design involving 
three factors with blocking.  

Suppose we want to study the effect of three quantitative factor variables (A, B, and C) on a 
response variable. There is reason to believe that a second-order response surface design will 
work well. A full replication of this design requires twenty-seven experimental units. The 
manufacturing process that we are studying produces items in batches of four at a time. Because 
of this and the limited budget available for this study, we decide to use three batches (which we 
will call ‘Blocks’) of four points each. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 3 by 
going to the File menu and choosing Open Example Template. 
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1 Specify the design and data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N Per Block to 4 4 4. 
• Set Optimize the Design for this Model to A|B|C A*A B*B C*C.  
• Set Max Term Order to 2. 
• Set Max Iterations to 100. 
• Set Inclusion Points to 45. This is approximately (3)(3)(3)(3)/2 which is the number of 

blocks times the product of the number of levels in each factor, all divided by two. 
• Set Removal Points to 11. This is one less than the total number of points desired. 
• Check the Store Data on Spreadsheet box. 
• Set the First Factor Column to 1.  
• Check Rename Factor Variables with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Set Decimal Places to 0. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 

12-Point, 3 Factor D-Optimal Design with Blocking 
  

 A B C Block 
 -1 -1 -1 2 
 1 -1 -1 1 
 -1 0 -1 3 
 -1 1 -1 1 
 1 1 -1 2 
 0 -1 0 3 
 -1 0 0 2 
 -1 -1 1 1 
 1 -1 1 3 
 0 0 1 2 
 -1 1 1 3 
 1 1 1 1 

 

Columns A, B, C, and Blocks give the design. The Determinant Analysis Section showed that the 
maximum was achieved on 12 of the 100 iterations. Hence, we assume that the algorithm 
converged to the global maximum.  
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Example 4 – Adding Points to an Existing Design 
This section presents an example of how to augment additional points to an existing design. 

Suppose a standard three factor design has been run. Each factor has two levels. The design was 
blocked into two blocks of four points each. The design values are contained in the spreadsheet 
when the example is loaded. This design allows only first-order (linear) terms to be fit.  

Suppose that you wish to add more points to the design so that a second-order response surface 
may be fit. Specifically, suppose you want to add one more block of four points to extend the 
model from first to second order. What four points should be added? 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 4 by 
going to the File menu and choosing Open Example Template. You can see that the design 
values are in the spreadsheet by clicking the spreadsheet button on the Design tab. 

1 Specify the design and data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N Per Block to 4 4 4. 
• Set Input Columns (Candidate and Forced) to A-C. 
• Set Forced Points to 8. 
• Set Optimize the Design for this Model to A|B|C A*A B*B C*C.  
• Set Max Term Order to 2. 
• Set Max Iterations to 30. 
• Set Inclusion Points to 5.  
• Set Removal Points to 5. 
• Check the Store Data on Spreadsheet box. 
• Set the First Factor Column to 1.  
• Check Rename Factor Columns with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Set Decimal Places to 0. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Augmented D-Optimal Design with Blocking 
  

 A B C Blocks 
 -1 -1 -1 1 
 1 1 -1 1 
 1 -1 1 1 
 -1 1 1 1 
 1 -1 -1 2 
 -1 1 -1 2 
 -1 -1 1 2 
 1 1 1 2 
 -1 0 -1 3 
 0 1 -1 3 
 1 -1 0 3 
 0 0 0 3 
 

Variables A, B, C, and Blocks give the design. The new block is shown as the last four rows of 
the design.  
The Determinant Analysis Section showed that the maximum was achieved on 9 of the 30 
iterations. Hence, we assume that the algorithm converged to the global maximum.  

Example 5 – Mixture Design 
This section presents an example of how to generate a mixture design. Mixture designs are useful 
in situations in which the factors are constrained to sum to a total. The interest is in the 
proportions of each factor, not the absolute amounts. For example, the proportions of the 
components of a chemical solution must sum to one. 

Suppose that you wish to design a first-order mixture experiment for a chemical that has three 
components (which we will label as A, B, and C). In this case, you will not code the factor levels 
from -1 to 1. Rather, the factor levels will be coded from zero to one. Because of this constraint, 
the intercept will not be fit in this model. 

In this particular case, we will constrain the design space by only entering certain points in the list 
of candidate points. The candidate points are contained in the input spreadsheet when the 
example is loaded. The following plots (not generated using PASS) show the design space for 
each pair of factors. Remember that these factors are constrained so that the missing factor is 
equal to one minus the sum of the other two. Hence, if A is 0.7 and B is 0.2, then C must be 0.1. 
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The task for the algorithm is to pick the ten best points from the thirteen that are shown here. 
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 5 by 
going to the File menu and choosing Open Example Template. You can see that the design 
values are in the spreadsheet by clicking the spreadsheet button on the Design tab. 

1 Specify the design and data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N Per Block to 10. 
• Set Input Columns (Candidate and Forced) to 1-3. 
• Set Forced Points to 0. 
• Set Optimize the Design for this Model to A|B|C.  
• Set Max Term Order to 2. 
• Set Max Iterations to 30. 
• Set Inclusion Points to 5.  
• Set Removal Points to 5. 
• Remove the check from the Include Intercept check box. 
• Check the Store Data on Spreadsheet box. 
• Set the First Factor Column to 1.  
• Check Rename Factor Columns with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Set Decimal Places to 4. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 
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Mixture Design  
  

Original  Factors   
Row A B C 
1 0.7000 0.1000 0.2000 
2 0.2000 0.6000 0.2000 
3 0.7000 0.2000 0.1000 
4 0.2000 0.2000 0.6000 
5 0.3000 0.6000 0.1000 
6 0.3000 0.1000 0.6000 
8 0.2000 0.4000 0.4000 
9 0.5000 0.1000 0.4000 
11 0.5000 0.4000 0.1000 
13 0.4000 0.3000 0.3000 
 

Columns A, B, and C give the design. The original row from the candidate list is shown as the 
first column of the report. 
The Determinant Analysis Section showed that the maximum was achieved on 30 of the 30 
iterations. Hence, we assume that the algorithm converged to the global maximum.  

In order to visually analyze the design, we generate the scatter plots (not generated using PASS) 
for each pair of variables in the design. 

Plot of Design  
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It is interesting to compare these plots with those produced earlier to see which points were kept 
by the algorithm. 
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Example 6 – Qualitative Factors 
This section presents an example of how to design an experiment with qualitative and quantitative 
factors.  

Suppose your experimental situation involves two quantitative variables, A and B, and a 
qualitative variable C that has five possible levels. You want to fit a second-order response 
surface to the quantitative variables. Also, you want to fit all two-way interactions among these 
factors. You have budget for an 18-point design (you will add four duplicates later).  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the D-Optimal Designs procedure window by expanding Design 
of Experiments, then clicking on Experimental Design, and then clicking on D-Optimal 
Designs. You may then make the appropriate entries as listed below, or open Example 6 by 
going to the File menu and choosing Open Example Template. 

1 Specify the data storage. 
• On the D-Optimal Designs window, select the Design tab.  
• Set N Per Block to 18. 
• Set Optimize the Design for this Model to A|B|C A*A B*B.  
• Set Max Term Order to 2. 
• Set Qualitative Factors and Levels to C(5). 
• Set Max Iterations to 30. 
• Set Inclusion Points to 20.  
• Set Removal Points to 18. 
• Remove the check from the Include Intercept check box. 
• Check the Store Data on Spreadsheet box. 
• Set the First Factor Column to 1.  
• Check Rename Factor Columns with Factor Labels. 
• Check Clear Existing Data. 

2 Specify the reports. 
• On the D-Optimal Designs window, select the Reports tab.  
• Set Decimal Places to 0. 

3 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button. 



888-24  D-Optimal Designs 

Design with Qualitative Factors  
 
Original  Factors   
Row A B C 
1 -1 -1 1 
3 1 -1 1 
5 0 0 1 
9 1 1 1 
11 0 -1 2 
16 -1 1 2 
18 1 1 2 
19 -1 -1 3 
21 1 -1 3 
25 -1 1 3 
27 1 1 3 
28 -1 -1 4 
33 1 0 4 
34 -1 1 4 
38 0 -1 5 
40 -1 0 5 
42 1 0 5 
44 0 1 5 
 

Columns A, B, and C give the design. Notice that column C simply gives the level for factor C—
it was not rescaled. Also note that the levels of factor C are numbered arbitrarily. This means that 
only the pattern is important, not the particular level. For example, in this solution, there are only 
three level 2’s and three level 4’s. In the next solution, there might be three level 3’s and three 
level 4’s.  
The Determinant Analysis Section showed that the maximum was achieved on 5 of the 30 
iterations. Hence, we assume that the algorithm converged to the global maximum.  
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Chapter 889 

Design Generator 
Introduction 
This program generates factorial, repeated measures, and split-plots designs with up to ten 
factors. The design can be placed in the current spreadsheet. 

An introduction to experimental design is presented in Chapter 881 on Two-Level Factorial 
Designs and will not be repeated here. 

Crossed Factors 
Two factors are crossed if all levels of one factor occur with each level of the second factor. No 
distinction needs to be made as to whether a factor is random or fixed. Factorial and randomized 
block designs are examples of designs that contain crossed factors. 

Nested Factors 
In the repeated measures and split-plot designs, at least one of the factors is nested in another 
factor. A factor is nested when all levels of this factor do not occur with each level of another 
factor. For example, suppose a study is being made to compare the heart rate of males and 
females. Five males and five females are selected. One factor in the study would be gender with 
two levels: male and female. Another factor would be individual with ten levels: P1, P2, …, and 
P10. Since five of the ten individuals are in the males group and the other five individuals are in 
the females group, individuals are nested within gender. 

The basic structure of repeated measures and split-plot designs is identical. The difference 
between the two is in the way the factor levels are assigned within the individual factor. Consider 
an exercise study in which heart rate readings are to be made on an individual at five different 
points in time. If the amounts of exercise is assigned at random before each reading, the design is 
a split plot. If the amounts of exercise follow the same pattern for each individual, the design is a 
repeated measures.  
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Procedure Options 
This section describes the options available in this procedure. 

Design Tab 
This panel specifies the parameters that will be used to create the design values. 

Experimental Setup 

Factor (1 to 12) Values 
The values used to represent the rows are specified here. These values may be letters, digits, 
words, or numbers. The list is delimited by blanks or commas. The number of levels of a factor 
corresponds to the number of values that are listed here. 

To specify a nested factor, use the word Nested followed by the number of levels within a group. 
For example, entering ‘Nested 4’ signifies a design in which four individuals are placed in each 
group. The number of groups is found by crossing the factors before the nested factor. 

An easy way to replicate a design is to specify a nested factor as the last factor with the number of 
replicates specified as the number of levels. 

Data Storage to Spreadsheet 

Store Data on Spreadsheet 
Check this box to generate the design data on the spreadsheet. The spreadsheet data will be 
identical to the design data generated on the output window. 

Store First Factor In 
The first factor is stored in this column. Each additional factor that is specified is stored in the 
columns immediately to the right of this column. A factor is specified when values are entered 
into its Factor Values box. 

Warning: The program fills these variables with data, so any previous data will be replaced. 
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Example 1 – Three-by-Four Factorial Design with Three 
Replicates 
This section presents an example of how to degenerate a three-by-four factorial design with three 
replicates per treatment combination. To run this example, take the following steps. CAUTION: 
since the purpose of this routine is to generate data, you should always begin with an empty 
output spreadsheet.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Design Generator procedure window by expanding Design of 
Experiments, then clicking on Experimental Design, and then clicking on Design Generator. 
You may then make the appropriate entries as listed below, or open Example 1 by going to the 
File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Enter 1 2 3 in the Factor 1 Values (A) box.  
• Enter 1 2 3 4 in the Factor 2 Values (B) box.  
• Enter Nested 3 in the Factor 3 Values (C) box.  
• Check the Store Data on Spreadsheet box. 
• Enter 1 in the First Factor Column box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button (the 

left-most button on the button bar at the top). 
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Three-by-Four Design with Three Replicates 
 

Experimental Design 
 
Row Factor 1 Factor 2 Factor 3 
1 1 1 1 
2 1 1 2 
3 1 1 3 
4 1 2 4 
5 1 2 5 
6 1 2 6 
7 1 3 7 
8 1 3 8 
9 1 3 9 
10 1 4 10 
11 1 4 11 
12 1 4 12 
13 2 1 13 
14 2 1 14 
15 2 1 15 
16 2 2 16 
17 2 2 17 
18 2 2 18 
19 2 3 19 
20 2 3 20 
21 2 3 21 
22 2 4 22 
23 2 4 23 
24 2 4 24 
25 3 1 25 
26 3 1 26 
27 3 1 27 
28 3 2 28 
29 3 2 29 
30 3 2 30 
31 3 3 31 
32 3 3 32 
33 3 3 33 
34 3 4 34 
35 3 4 35 
36 3 4 36 
    
The values were also produced on the spreadsheet. 

 

These values are also generated on the spreadsheet. 
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Example 2 – Randomized Block Design 
This section presents an example of how to degenerate a randomized block design with three 
blocks and four treatments. To run this example, take the following steps. CAUTION: since the 
purpose of this routine is to generate data, you should always begin with an empty output 
spreadsheet.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Design Generator procedure window by expanding Design of 
Experiments, then clicking on Experimental Design, and then clicking on Design Generator. 
You may then make the appropriate entries as listed below, or open Example 2 by going to the 
File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Enter 1 2 3 in the Factor 1 Values (A) box.  
• Enter A B C D in the Factor 2 Values (B) box.  
• Make sure that the Factor 3 Values (C) box is blank. 

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button (the 

left-most button on the button bar at the top). 

Randomized Block Design 
 

Experimental Design 
 
Row Factor 1 Factor 2 
1 1 A 
2 1 B 
3 1 C 
4 1 D 
5 2 A 
6 2 B 
7 2 C 
8 2 D 
9 3 A 
10 3 B 
11 3 C 
12 3 D 

 

It is important to remember that when you use this design, you must randomly assign treatments 
to the four letters and randomly assign the physical blocks to the three block numbers. 
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Example 3 – Repeated Measures Design 
This section presents an example of how to degenerate a repeated measures design with three 
groups, two individuals per group, and two treatments which we will label ‘Pre’ and ‘Post.’ To 
run this example, take the following steps. CAUTION: since the purpose of this routine is to 
generate data, you should always begin with an empty output spreadsheet. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Design Generator procedure window by expanding Design of 
Experiments, then clicking on Experimental Design, and then clicking on Design Generator. 
You may then make the appropriate entries as listed below, or open Example 3 by going to the 
File menu and choosing Open Example Template. 

1 Specify the design parameters. 
• Enter 1 2 3 in the Factor 1 Values (A) box.  
• Enter Nested 2 in the Factor 2 Values (B) box.  
• Enter Pre Post in the Factor 3 Values (C) box.  

2 Run the procedure. 
• From the Run menu, select Run Procedure. Alternatively, just click the Run button (the 

left-most button on the button bar at the top). 

Repeated Measures Design 
 

Experimental Design 
 
Row Factor 1 Factor 2 Factor 3 
1 1 1 Pre 
2 1 1 Post 
3 1 2 Pre 
4 1 2 Post 
5 2 3 Pre 
6 2 3 Post 
7 2 4 Pre 
8 2 4 Post 
9 3 5 Pre 
10 3 5 Post 
11 3 6 Pre 
12 3 6 Post 
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Chapter 900 

Chi-Square Effect 
Size Estimator 
Introduction 
This procedure calculates the effect size of the Chi-square test for use in power and sample size 
calculations. Based on your input, the procedure provides effect size estimates for Chi-square 
goodness-of-fit tests and for Chi-square tests of independence.  

The Chi-square test is often used to test whether sets of frequencies or proportions follow certain 
patterns. The two most common cases are in tests of goodness of fit and tests of independence in 
contingency tables.  

The Chi-square goodness-of-fit test is used to test whether a set of data follows a particular 
distribution. For example, you might want to test whether a set of data comes from the normal 
distribution.  

The Chi-square test for independence in a contingency table is another common application of 
this test. Here individuals (people, animals, or things) are classified by two (nominal or ordinal) 
classification variables into a two-way contingency table. This table contains the counts of the 
number of individuals in each combination of the row categories and column categories. The Chi-
square test determines if there is dependence (association) between the two classification 
variables.  

Effect Size 
For each cell of a table containing m cells, there are two proportions considered: one specified by 
a null hypothesis and the other specified by the alternative hypothesis. Usually, the proportions 
specified by the alternative hypothesis are those occurring in the data. Define p0i to be the 
proportion in cell i given by the null hypothesis and p1i to be the proportion in cell i according to 
the alternative hypothesis. The effect size, W, is calculated using the following formula 

W =  ( p - p )
p

.
i=1

m 2
0i 1i

0i
∑  
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The formula for computing the Chi-square value, is  χ 2 ,

χ 2 =  ( O - E )
E

 =  N ( p - p )
p

,

i=1

m 2
i i

i

i=1

m 2
0i 1i

0i

∑

∑
 

where N is the total count in all the cells. Hence, the relationship between W and  is χ 2

χ 2 2 =  NW  

or 

W
N

=
χ 2

 

Contingency Table Tab 
This window allows you to enter up to an eight-by-eight contingency table. You can enter 
percentages or counts. If you enter counts, the Chi-Square and Prob Level values are correct and 
may be used to test the independence of the row and column variables. If you enter percentages, 
you should ignore the Chi-Square and Prob Level values. 

Note that if you are entering percentages, it does not matter whether you enter table percentages 
or row (or column) percentages as long as you are consistent. 

Example 
Suppose you are planning a survey with the primary purpose of testing whether marital status is 
related to gender. You decide to adopt four marital status categories: never married, married, 
divorced, widowed. In the population you are studying, previous studies have found the following 
percentages in each of these categories:   
 

Never Married 27% 

Married 39% 

Divorced 23% 

Widowed 11% 
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You decide that you want to calculate the effect size when the individual percentages for males 
and females are 
 

Gender Male Female 

Never Married 22% 32% 

Married 46% 33% 

Divorced 22% 24% 

Widowed 10% 11% 
 

To complete this example, you would load the Chi-Square Effect Size Estimator procedure from 
the PASS-Other menu and enter “22  46  22  10” across the top row and “32  33  24  11” across 
the next row. The value of W turns out to be 0.143626. 

Note that even though a Chi-square value (4.13) and probability level (0.248) are displayed, you 
would ignore them since you have entered percentages, not counts, into the table. If you had 
entered counts, these results could be used to test the hypothesis of independence. 

Multinomial Test Tab 
This window allows you to enter a multinomial table with up to fourteen cells. You can enter 
percentages or counts. If you enter counts, the Chi-Square and Prob Level values are correct and 
may be used to test the statistical significance of the table. If you enter percentages, you should 
ignore the Chi-Square and Prob Level values.  

Note that if you are using the window to perform a goodness-of-fit test on a set of data, you will 
need to adjust the degrees of freedom for the number of parameters you are estimating. For 
example, if you are testing whether the data are distributed normally and you estimate the mean 
and standard deviation from the data, you will need to reduce the degrees of freedom by two. 

Example 
Suppose you are going to use the Chi-square goodness-of-fit statistic calculated from a 
multinomial table to test whether a set of exponential data follow the normal distribution. That is, 
you want to find a reasonable effect size for comparing exponentially distributed data to the 
normal distribution. 

You decide to divide the data into five groups: 5 or less, 5-10, 10-15, 15-20, 20+ 

Using tables for the normal and exponential distributions, you find that the probabilities for each 
group are
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Category Normal Exponential 
5 or Less 11% 39% 

5 to 10 20% 26% 

10 to 15 38% 18% 

15 to 20 20% 11% 

Above 20 11% 6% 
 

To complete this example, you would set the Chi-Square Effect Size Estimator procedure to the 
Multinomial Test tab and enter “11  20  38  20  11” down the first column and “39  26  18  11  6” 
down the second column. The calculated value of W is 0.948271. You would enter this value into 
the Effect Size option of the Chi-Square Test window in PASS to determine the necessary sample 
size. 
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Chapter 903 

Survival 
Parameter 
Conversion Tool 
Introduction 
This procedure can be used to generate any of the following survival parameters from the others: 
hazard rate, proportion surviving past a given time, mortality, and median survival time. Each of 
these parameters is functionally related to the others as described in the following section. This 
procedure may also be used to convert rates and proportions to different time units.  

Functional Relationship of Survival Parameters 
The parameter conversions in this tool assume an exponential survival distribution. Using the 
hazard rate equations below, any of the four survival parameters can be solved for from any of the 
other parameters. 

Exponential Distribution 
The density function of the exponential is defined as 

( ) hthe =tf −  

The probability of surviving the first t years is  

( ) hte = tS −  

The mortality (probability of dying during the first t years) is  

( ) hte = tM −−1  

For an exponential distribution, the mean survival is 1/h and the median is ln(2)/h. 

Notice that it is easy to translate between the hazard rate, the proportion surviving, the mortality, 
and the median survival time. The choice of which parameterization is used is arbitrary and is 
selected according to the convenience of the user. 
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Hazard Rate from Median Survival Time 
Here, the median survival time is specified. These are transformed to hazard rates using the 
relationship h = ln(2) / MST. 

Hazard Rate from Proportion Surviving 
In this case, the proportion surviving until a given time T0 is specified. These are transformed to 
hazard rates using the relationship h = –ln(S(T0)) / T0. Note that when separate proportions 
surviving are given for each time period, T0 is taken to be the time period number. 

Hazard Rate from Mortality 
Here, the mortality until a given time T0 is specified. These are transformed to hazard rates using 
the relationship h = –ln(1 – M(T0)) / T0. Note that when separate mortalities are given for each 
time period, T0 is taken to be the time period number. 

Hazard Ratio 
The hazard ratio is the simple ratio of two hazard rates: HR = h1 / h2. 

Mortality Ratio 
The mortality ratio is the simple ratio of two mortalities: MR = M1 / M2. 

Example 
Convert a median survival time of 2.3 to the corresponding hazard rate. 

1.  Load the Survival Parameter Conversion Tool window by clicking on Tools and then 
clicking on Survival Parameter Conversion Tool. Click on the Survival Parameters 
tab. 

2.  Enter 2.3 for Median Survival Time 1 (T1). 

3.  The value in Hazard Rate 1 (h1) becomes 0.301368339373889. This is the value of the 
corresponding hazard rate.  

Rates and Proportions Tab 
Changing the values on this tab allows the user to convert proportions and/or rates from one time 
unit to another, e.g., annual to monthly. 

Main Proportion (e.g., Annual) 
This is the proportion corresponding to the main time unit (e.g. annual proportion). 

The main proportion and the sub proportion are related by the formula 

M = 1 - (1 - S) ^ K 

where M is the main proportion, S is the sub proportion, and K is the number of sub time units in 
each main time unit. 

Range: 0 < Main Proportion < 1 
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Sub Proportion (e.g., Monthly) 
This is the proportion corresponding to the sub time unit (e.g. monthly proportion). 

The sub proportion and the main proportion are related by the formula 

S = 1 - (1 - M) ^ (1 / K) 

where S is the sub proportion, M is the main proportion, and K is the number of sub time units in 
each main time unit. 

Range: 0 < Sub Proportion < 1 

Main Rate (e.g., Annual) 
This is the rate corresponding to the main time unit (e.g. annual rate). 

The main rate and the sub rate are related by the formula 

Main Rate = Sub Rate × K 

where K is the number of sub time units in each main time unit. 

Range: Main Rate > 0 

Sub Rate (e.g., Monthly) 
This is the rate corresponding to the sub time unit (e.g. monthly rate). 

The sub rate and the main rate are related by the formula 

Sub Rate = Main Rate / K 

where K is the number of sub time units in each main time unit. 

Range: Sub Rate > 0 

Example 
Convert an annual proportion of 0.7 to the corresponding monthly proportion. 

1.  Load the Survival Parameter Conversion Tool window by clicking on Tools and then 
clicking on Survival Parameter Conversion Tool. Click on the Rates and Proportions tab. 

2.  Enter 12 for Number of Sub Time Units in Each Main Time Unit. 

3.  Enter 0.7 for Main Proportion. 

4.  The value in Sub Proportion becomes 0.0954620942160428. If this proportion of the 
remaining total is allocated each month, the total proportion at the end of 12 months is 
0.7.  
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Chapter 905 

Standard 
Deviation 
Estimator 
Introduction 
Even though it is not of primary interest, an estimate of the standard deviation (SD) is needed 
when calculating the power or sample size of an experiment involving one or more means. 
Finding such an estimate is difficult not only because the estimate is required before the data are 
available, but also because the interpretation of the standard deviation is vague and our 
experience with it may be low. How do you estimate a quantity without data and without a clear 
understand of what the quantity is? This section will acquaint you with the standard deviation and 
offer several ways to obtain a rough estimate of it before the experiment begins using the 
Standard Deviation Estimator.  

The Standard Deviation Estimator can also be used to calculate the standard deviation of the 
means, a quantity used in estimating sample sizes in analysis of variance designs. 

Understanding the Standard Deviation 
It is difficult to understand the standard deviation solely from the standard deviation formula. 
There are two general interpretations that can be useful in understanding the standard deviation. 

1. The standard deviation may be thought of as the average difference between an 
observation and the mean, ignoring the sign.  

2. The standard deviation may be thought of as the average difference between any two data 
values, ignoring the sign. 

The population standard deviation is calculated using the formula:  

( )
σ

μ
=

−
=
∑ X

N

i
i

N
2

1  

where N is the number of items in the population, X is the variable being measured, and μ  is the 
mean of X. This formula indicates that the standard deviation is the square root of an average. 
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This average is the average of the squared differences between each value and the mean. The 
differences are squared to remove the sign so that negative values will not cancel out positive 
values. After summing up these squared differences and dividing by N, the square root is taken to 
give the result in the original scale. That is, the standard deviation can be thought of as the 
average difference between the data values and their mean (the terms mean and average are used 
interchangeably). 

Example 
Consider the following two sets of numbers 

A: 1, 5, 9 

B: 4, 5, 6 

Both sets have the same mean of 5. However, their standard deviations are quite different. 
Subtracting the mean and squaring the three items in each set results in 

Set A 

(1-5)(1-4) = 16 

(5-5)(5-5) =  0 

(9-5)(9-5) = 16 

Sum = 32 

3
32

=ASD  = 3.266 

Set B 

(4-5)(4-5) = 1 

(5-5)(5-5) = 0 

(6-5)(6-5) = 1 

Sum = 2 

3
2

=BSD  = 0.8165 

The standard deviations show that the data in set A vary more than the data in set B. 

Divide by N or N-1? 
Note in the example above that we are dividing by N, not N-1 as is usually seen in standard 
deviation calculations. When the standard deviation is computed using all values in the 
population, N is used as the divisor. However, when the standard deviation is calculated from a 
sample, N-1 is used as the divisor. We stress that the results for a sample by using the lower-case 
n and naming the sample standard deviation S. The value of S is computed from a sample of n 
values using the formula 
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( )
S

X X

n

i
i

n

=
−

−
=
∑ 2

1

1
 

The n-1 is used instead of n to correct for bias that statisticians have discovered. That is, over the 
long run, dividing by n-1 provides a better estimate of the true standard deviation than does 
dividing by n. Although we divide by n-1 rather than n for sample standard deviations, we 
recommend that for purposes of interpretation, the divisor is assumed to be n, so that the 
operation can be thought of as computing an average. 

Average Absolute Deviation 
If we were to devise a measure of variability with no previous experience, we might first consider 
the average absolute deviation (AD), sometimes called the mean absolute deviation, or MAD, 
which is computed by forming the deviations from the mean, taking their absolute values, and 
computing their average. The absolute value is applied to remove the negative signs, which, in 
turn, avoids the cancellation of values when the average is taken. The formula for AD is 

AD
X M

N

i
i

N

=
−

=
∑

1  

This simple average of absolute deviations is much easier to understand, but is very difficult to 
work with mathematically. Opposingly, the standard deviation is more difficult to interpret 
directly, but it can be worked with mathematically in statistical problems. The ability to work 
with the standard deviation mathematically outweighs its deficiency in interpretation. Hence, we 
generally use the standard deviation rather than the average absolute deviation in practice. 

Comparing Average Absolute Deviation and Standard 
Deviation 
Fortunately, the average absolute deviation and the standard deviation are usually close in value. 
Mathematically, it can be shown that AD is always less than or equal to SD. A small simulation 
study is summarized below. It shows the relationship between AD and SD for data generated from 
various distributions. 
 

Distribution Percent SD > AD Characteristics 
Uniform 15% Level 

Normal 20% Bell-Shaped 

Gamma(5) 30% Moderately Skewed Right 

Gamma(5)^2 45% Extremely Skewed Right 
 

These distributions were selected for study because they represent a wide range of possibilities. 
The table shows that, for typical datasets, the standard deviation is from 15 to 30 percent larger 
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than the average absolute deviation. And in the case of the normal distribution, the SD is about 
20% higher than AD. 

Hence, for planning purposes, you can think of the standard deviation as an inflated version of the 
average absolute deviation. 

Example 
In out example, we can compute AD for datasets A and B as follows. 

Set A 

ADA = (4+0+4)/3 = 8/3 = 2.667. Recall that SDA = 3.266. 

Set B 

ADB = (1+0+1)/3 = 2/3 = 0.667. Recall that SDB = 0.8165. 

We see that the values are similar. The degree of difference is likely within the error that we 
would expect during the planning phase. 

Standard Deviation as the Average Difference between 
Values 
The above discussion and formula have pointed out that the standard deviation may be thought of 
as an average deviation from the mean. In this section, a second interpretation of the standard 
deviation will be given.  

We can manipulate the formula for the sum of squared deviations to show that 

( )
( )

X M
X X

Ni
i

N i j
j i

N

i

N

− =
−

=

= +=

−

∑
∑∑

2

1

2

11

1

 

This formula shows that the squared deviations from the mean are proportional to the squared 
deviations of each observation from every other observation. Note that the mean is not involved 
in the expression on the right.  

Using the above relationship, the standard deviation may be calculated using the formula 

( )
SD

X X N

N

i j
j i

N

i

N

=
−

= +=

−

∑∑
2

11

1

/
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Example 
Consider again our simple example of sets A and B. Applying this operation to the three possible 
pairs of the data in set A (1, 5, 9) gives 

(1-5)(1-5) = 16 

(1-9)(1-9) = 64 

(5-9)(5-9) = 16 

The sum is 96. Dividing 96 by 3 (the number of pairs) again yields 32. Hence, the standard 
deviation is computed as SD = SQRT(96/9) = 3.266 (which matches the previous result). 

Likewise, for set B (4, 5, 6), the formula results in 

(4-5)(4-5) = 1 

(4-6)(4-6) = 4 

(5-6)(5-6) = 1 

so that SD = SQRT(6/9) = 0.8165. 

Estimating the Standard Deviation 
Our task is to find a rough estimate of the standard deviation. Several possible methods are 
available in the Standard Deviation Estimator procedure which may be loaded from the PASS-
Other menu. PASS provides a panel that implements each of these methods for you. 

Data Tab – Standard Deviation from Data Values 
One method of estimating the standard deviation is to put in a typical set of values and calculate 
the standard deviation.  

This window is also used when you need the standard deviation of a set of hypothesized means in 
an analysis of variance sample size study. 

Pros and Cons of This Method 
This method lets you experiment with several different data values. It lets you determine the 
influence of different data configurations on the standard deviation. In so doing, you can come up 
with a likely range of SD values.  

However, investigators tend to pick trial numbers that are closer to the mean and more uniform 
than will result in practice. This results in SD’s that are underestimated. If you use this method, 
you should be careful that your range of possible SD values is wide enough to be accurate. 
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Example 1 – SD for a Set of Values 
As an example, suppose that you decide that the following values represent a typical set of data 
that you would anticipate for one group of individuals:   

10, 12, 14, 10, 11, 10, 12, 13, 9, 13, 15, 11 

To calculate the appropriate standard deviation, do the following: 

1.  Load the Standard Deviation Estimator window and click on the Data tab. 

2.  The order that the data are entered in does not matter. However, to show the use of the 
Counts column, we count up the number of times each value occurs. The values and their 
frequency counts are then entered into the Values and Counts columns. The data entry 
goes as follows: 
9  1 
10 3 
11 2 
12 2 
13 2 
14 1 
15 1 

3.  Check the Use N-1 as divisor box. (We use the N-1 divisor when estimating sigma from 
a set of data.) 

4.  Press the Calculate N, Mean, SD from Values button. The standard deviation is 
1.825742. We might round this value up to 2.0 for planning purposes. 

Example 2 – SD for a Set of Means 
In this example, we will show you how to obtain the standard deviation of a set of hypothesized 
means. Care must be taken that you select the correct divisor—N, not N-1. 

In this example, a researcher is studying the influence of a drug on heart rate. He estimates that 
the average heart rate of his group without the drug is 80. His experimental design will apply 
three different doses. The first dose is expected to lower the heart rate by 10%, the second by 
20%, and the third by 30%. Hence, the hypothesized means for the four groups are 80, 80(0.9) = 
72, 80(0.8) = 64, and 80(0.7) = 56. 

To calculate the appropriate standard deviation, do the following: 

1.  Load the Standard Deviation Estimator window and click on the Data tab. 

2.  Enter the four means into the Values column. The Counts column is left blank. 
80 
72 
64  
56 

3.  Make sure the Use N-1 as divisor box is not checked since we want the population 
standard deviation. 

4.  Press the Calculate N, Mean, SD from Values button. The standard deviation of the 
means is 8.944272. 
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Standard Error Tab – Standard Deviation from Standard Error 
If the value of the standard error of the mean is available from another experiment, it may be used 
to estimate the standard deviation. The formula estimating the standard deviation from the 
standard error is 

SD SE N=  

where N is the sample size.  

Pros and Cons of This Method 
This method is only useful when you have a standard error value available. 

Example 
To calculate the appropriate standard deviation when a previous study of 23 individuals had a 
standard error of the mean of 2.7984, do the following: 

1.  Load the Standard Deviation Estimator window and click on the Standard Error tab. 

2.  Enter 23 for N. 

3.  Enter 2.7984 for Standard Error. 

4.  Press the Calculate Standard Deviation button. The standard deviation is 1.825742. We 
might round this value up to 2.0 for planning purposes. 

Range Tab – Standard Deviation from Population or Sample Data 
Range 
There are two cases in which the range may be used to estimate the standard deviation. In the first 
case, the sample size and data range may be available from a previous study. In the second case, a 
reasonable estimate of the population range may be obtainable. This window allows you to 
estimate SD in both of these situations. 

The basic formula for estimating the standard deviation from the range is 

SD Range
C

=  

where C is determined by the situation. 

Determining C 
If the population range can be established, it may be used to estimate sigma by dividing by an 
appropriate constant. To determine an appropriate value of the constant, statisticians use the fact 
that most of the data is contained within three standard deviations of the mean—so they set C to 
six. However, consultants have found that for some reasons (e.g., understated range, or non-
normal population) dividing by six tends to understate the standard deviation. So they divide by 
five or even four. Dividing by a smaller number increases the estimated standard deviation. Our 
recommendation is to divide by four. To use this method, enter the divisor (4, 5, or 6) in the C 
(Divisor) box. 
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If the data range is available from a previous study, the constant C may be calculated as the 
median of the distribution of the range for that sample range. This distribution assumes that the 
data themselves are normally distributed. The median of the distribution of the range is calculated 
in NCSS using numerical methods, and similar calculations can be made using the Probability 
Calculator. To use this method, enter the data range and the sample size in the lower region of the 
Range tab. 

Pros and Cons of This Method 
The range is a poor substitute for having the standard deviation. This method should be used as a 
‘last resort’. 

Example 1 – Population Range ‘Known’ 
To calculate an estimate of the standard deviation when the population range is known to be 150, 
do the following: 

1.  Load the Standard Deviation Estimator window and click on the Range tab. 

2.  Enter 150 for Range (of Population) in the upper region of the tab. 

3.  Enter 4 for C (Divisor).  

4.  Press the Calculate Standard Deviation button. The estimate of the standard deviation 
is 37.5. The value of C used is 4. 

Example 2 – Previous Sample Available 
To calculate an estimate of the standard deviation when a previous study of 20 animals had a 
minimum value of 15.3 and a maximum of 18.7, do the following: 

1.  Load the Standard Deviation Estimator window and click on the Range tab. 

2.  Enter 20 for N (Sample Size) in the lower region of the tab. 

3.  Enter 3.4 for Range (of Sample Data) in the lower region of the tab. This is 18.7 minus 
15.3. 

4.  Press the Calculate Standard Deviation button. The estimate of the standard deviation 
is 0.92243. The value of C used is 3.685916. 

Percentiles Tab – Standard Deviation from Percentiles 
If you are willing to assume that the population values are normally distributed (bell-shaped), you 
can use the values of two percentiles to estimate the standard deviation. 

The basic formula for estimating the standard deviation from two percentiles is 

⎟
⎠
⎞

⎜
⎝
⎛−⎟

⎠
⎞

⎜
⎝
⎛

−
=

100
1

100
2

12
PZPZ

XXSD  

where X1 and X2 are the two percentiles, P1 and P2 are the two percentages, and Z(P) is the 
standard normal deviate that has a tail area of P to the left. 
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Pros and Cons of This Method 
This method works well if you have two accurate percentiles available and the underlying 
distribution of the data is normal. 

Example 
To calculate an estimate of the standard deviation when you know that the 25th percentile of the 
population is 80.25, the 75th percentile of the population is 116.38, and that the population is 
normally distributed, do the following: 

1.  Load the Standard Deviation Estimator window and click on the Percentiles tab. 

2.  Enter 25 for Percentage 1. 

3.  Enter 80.25 for Percentile Value 1. 

4.  Enter 75 for Percentage 2. 

5.  Enter 116.38 for Percentile Value 2. 

6.  Press the Calculate Standard Deviation button. The estimate of the standard deviation 
is 26.78321. 

COV Tab – Standard Deviation from Coefficient of Variation 
The coefficient of variation (COV) is equal to SD divided by the mean. Hence, if you know the 
coefficient of variation and the mean, you can estimate SD.  

Note that t-tests and the analysis of variance assume that the standard deviations are equal for all 
groups. If the standard deviations are proportional to their group means, you should use a data 
transformation (such as the square root or the logarithm) to make the standard deviations equal. 

The basic formula for estimating the standard deviation from the COV is 

( )( )SD COV Mean=  

Pros and Cons of This Method 
This method works well if you have estimates of the mean and COV. 

Example 
To calculate an estimate of the standard deviation when you know that the mean is 127 and the 
COV is 0.832, do the following: 

1.  Load the Standard Deviation Estimator window and click on the COV tab. 

2.  Enter 0.832 for Coefficient of Variation (COV). 

3.  Enter 127 for Mean. 

4.  Press the Calculate Standard Deviation button. The estimate of the standard deviation 
is 105.664. 
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Confidence Limits Tab – Confidence Limits of the Standard 
Deviation 
Often, you will obtain an estimate of the standard deviation from a previous study or a pilot 
study. Since this estimate is based on a sample, it is important to understand its precision. This 
can easily be calculated since the square of the sample standard deviation follows a chi-squared 
distribution. This confidence interval does assume that the population you are sampling from is 
normally distributed. 

Once a confidence interval has been obtained, it would be wise to enter both values (the 
confidence limits) into the appropriate place in the sample size calculations to provide a range of 
possible sample size values (or of statistical power). 

Example 
Suppose a pilot study of 10 individuals yields a standard deviation of 83.21. Calculate a 95% 
confidence interval for the population standard deviation using these results. 

1.  Load the Standard Deviation Estimator window and click on the Confidence Limits 
tab. 

2.  Enter 10 for N. 

3.  Enter 83.21 for Standard Deviation. 

4.  Enter 0.05 for Alpha. 

5.  Press the Calculate Confidence Limits button. The confidence limits are 57.23477 and 
151.909.  
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Chapter 910 

Odds Ratio and 
Proportions 
Estimator 
Introduction 
The Odds Ratio tab of this procedure calculates any one of three parameters, odds ratio, , or , 
from the other two parameters. Note that  and  are the proportions in groups one and two, 
respectively. This provides you with a tool to study the relationship between these three parameters. 
This procedure is most often used when planning the sample size for a test involving two 
proportions. The procedure may be loaded by selecting Odds Ratio Estimator from the PASS-Other 
menu.  

p1 p2

p1 p2

As an expanded version of the Odds Ratio tab, the Proportions tab calculates , , the 
difference, ratio, odds ratio, or Ln(OR) from various combinations of these parameters. 

p1 p2

When planning studies involving two proportions, two parameters,  and , need to be specified. 
At times, it may be difficult to propose a value for . In these cases, it might be easier to propose a 
value for the odds ratio (OR).   

p1 p2

p2

The odds of obtaining the response of interest in group 1 are ( )p p1 1/ 1− and the odds of obtaining 
the response in group 2 are ( )p p2 1/ 2− . The ratio of these odds, called the odds ratio, is defined as 

( )
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( )
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p p
p p

p p
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To understand better how to interpret an odds ratio, consider the following example. Suppose the 
proportion dying from a particular disease during the first five years is 80%. The odds of dying 
are thus 0.8 / 0. 2 = 4.0 Suppose a treatment reduces the death rate from 80% to 60%. The odds of 
dying are now 0.6 / 0.4 = 1.5. The odds ratio is 4.0 / 1.5 =  2.7. That is, the odds of dying have 
been reduced by a factor of 2.67. 
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The odds ratio is reversible. In this example, suppose we talk in terms of surviving instead of 
dying. The odds of the two groups are now 0.2 / 0.8 = 0.25 and 0.4 / 0.6 = 0.67. The odds ratio is 
0.67 / 0.25 = 2.67. The odds of surviving have increased by a factor of 2.67. 

In some situations, it may be easier to define a meaning treatment effect in terms of the odds 
ratio. That is, it might be meaningful to say that a certain treatment increases the odds of survival 
by 50% (OR = 1.5) or by 200% (OR = 2.0). If this is the case, a value for  can be calculated 
from p1 and OR by solving the above equation for  to find that 

p2

p2

( )
( )

p
p OR

p p OR2
1

1 11
=

− +
 

Hence, given a value for  and OR, you can calculate an appropriate value for . p1 p2

Odds Ratio Tab 
This window lets you calculate , , or the odds ratio (OR) from the other two parameters. p1 p2

Example 1 – Solving for P1 
Suppose you know that  and that OR = 4 and you want to find the corresponding value 
of .   

p2 0 8= .
p1

1.  Load the Odds Ratio and Proportions Estimator procedure by selecting it from the 
PASS-Other menu. 

2.  Select the Odds Ratio tab. 

3.  Set P2 equal to 0.8. 

4.  Set Odds Ratio equal to 4. 

5.  Press the Calculate P1 button. 

6.  Read the result in the P1 box. The result is 0.5. 

Example 2 – Solving for P2 
Suppose you know that  and that OR = 1.5 and you want to find the corresponding value 
of . 

p1 0 4= .
p2

1.  Load the Odds Ratio and Proportions Estimator procedure by selecting it from the 
PASS-Other menu. 

2.  Select the Odds Ratio tab. 

3.  Set P1 equal to 0.4. 

4.  Set Odds Ratio equal to 1.5. 

5.  Press the Calculate P2 button. 

6.  Read the result in the P2 box. The result is 0.5. 
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Example 3 – Solving for Odds Ratio 
Suppose you know that  and that p1 0 4= . p2 0 8= .  and you want to find the corresponding value 
of the odds ratio. 

1.  Load the Odds Ratio and Proportions Estimator procedure by selecting it from the 
PASS-Other menu. 

2.  Select the Odds Ratio tab. 

3.  Set P1 equal to 0.4. 

4.  Set P2 equal to 0.8. 

5.  Press the Calculate Odds Ratio button. 

6.  Read the result in the Odds Ratio box. The result is 6. 

Proportions Tab 
This window lets you calculate , , the difference, ratio, odds ratio, or Ln(OR) from various 
combinations of these parameters. 

p1 p2

Example 1 – Calculating Ln(OR) 
Suppose you know that  and thatp1 0 4= . p2 0 8= .  and you want to find the corresponding value 
of Ln(OR). 

1.  Load the Odds Ratio and Proportions Estimator procedure by selecting it from the 
PASS-Other menu. 

2.  Select the Proportions tab. 

3.  Set P1 equal to 0.4. 

4.  Set P2 equal to 0.8. 

5.  Press the P1 & P2 button. 

6.  Read the result in the Ln(O.R.) box. The result is 1.79176. 
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Chapter 912 

Standard 
Deviation of 
Means Estimator 
Introduction 
An important task in finding the power or sample size in an ANOVA-type design is specifying 
the effect size, which, in this case, is the standard deviation of the means. We often denote this 
value as Sm or σm. Since the standard deviation does not have an obvious, physical interpretation, 
PASS provides this tool to aid in determining an appropriate set of Sm values.  

Note that this tool is only useful for computing Sm for individual factors and their two-way 
interactions. It does not help with higher order interactions. 

Technical Details 
We begin with an example. Consider a study of two groups of subjects. Each subject was tested, 
then treated, then tested again at the ten minutes, and then tested a third time after sixty minutes. 
The researchers want a sample size large enough to detect the following pattern among the 
means. 

Table of Hypothesized Means   
 Factor B   
Factor A B1 B2 B3 Average 
A1 100 130 100 110 

A2 120 180 120 140 

Average 110 155 110 125 

 
Our task is to convert this table of means into the three Sm values need for sample size 
computations. This is done as follows. 
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Step 1 – Remove the Overall Mean 
Subtract 125, the overall mean, from each of the individual means. 

Adjust for Overall Mean  
 Factor B   
Factor A B1 B2 B3 Average 
A1 -25 5 -25 -15 

A2 -5 55 -5 15 

Average -15 30 -15 125 

 

Step 2 – Remove the Factor A (group) Effect 
Subtract -15 from all entries in the first row and 15 from those in the second row. 

Adjust for Factor A  
 Factor B   
Factor A B1 B2 B3 Total 
A1 -10 20 -10 -15 

A2 -20 40 -20 15 

Total -15 30 -15 125 

 

Step 3 – Remove the Factor B (Time) Effect 
Subtract -15 from each entry in the first column, 30 from each entry in the second column, and -
15 from each entry in the third column. This leaves the following table of effects. 

Table of Effects    
 Factor B    
Factor A B1 B2 B3 Effect Average 
A1 5 -10 5 -15 110 

A2 -5 10 -5 15 140 

Effect -15 30 -15   

Average 110 155 110  125 

 
This table, called an effects table, reports the individual effect of each component of the ANOVA 
model. For example, the hypothesized pattern across time is that T10 is 45 units higher than either 
endpoint. Similarly, we note that the hypothesized pattern for the two groups is that the mean of 
A1 is 30 units larger than that of A2. 
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A way to understand the interaction effects is to look at their role in the ANOVA model. The 
effects are additive components. Thus, the first mean has been partitioned into four components 
as follows: 

100 = 125 + (-15) + (-15) + 5 

Likewise, the mean of the second row is 

120 = 125 + (-15) + 15 + (-5) 

Finally, the Sm values are computed by summing the squared values of each set of effects and 
taking the square root. Note that the means do not need to be subtracted because they are always, 
by definition, zero. 

Hence, the three Sm values are 

 ( ) ( ) ( ) 000000.15
2

1515 22

=
+−

=ASm  

( ) ( ) ( ) ( ) 213203.21
2

153015 222

=
−++−

=BSm  

( ) ( ) ( ) ( ) ( ) ( ) ( ) 071068.7
2

51055105 222222

=
−++−++−+

=ABSm  

Once acceptable Sm values have been found, you can copy them one at a time to the clipboard 
and paste them as needed. 
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Chapter 915 

Probability 
Calculator 
Introduction 
Most statisticians have a set of probability tables that they refer to in doing their statistical work. 
This procedure provides you with a set of electronic statistical tables that will let you look up 
values for various probability distributions.   

To run this option, select Probability Calculator from the Other menu of the Analysis menu. A 
window will appear that will let you indicate which probability distribution you want to use along 
with various input parameters. Select the Calculate button to find and display the results.  

Many of the probability distributions have two selection buttons to the left of them. The first (left) 
button selects the inverse probability distribution. An inverse probability distribution is in a form 
so that when you give it a probability, it calculates the associated critical value. The second 
(right) button selects the regular probability distribution which is formulated so that when you 
give it a critical value, it calculates the (left tail) probability. 

Probability Distributions 

Beta Distribution 
The beta distribution is usually used because of its relationship to other distributions, such as the t 
and F distributions. The noncentral beta distribution function is formulated as follows: 
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where 

0 < A, 0 < B, 0 ≤ L, and 0 ≤ x  ≤ 1 

When the noncentrality parameter (NCP), L, is set to zero, the above formula reduces to the 
standard beta distribution, formulated as 
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When the inverse distribution is selected, you supply the probability value and the program solves 
for X. When the regular distribution is selected, you supply X and the program solves for the 
cumulative (left-tail) probability. 

Binomial Distribution 
The binomial distribution is used to model the counts of a sequence of independent binary trials 
in which the probability of a success, P, is constant. The total number of trials (sample size) is N. 
R represents the number of successes in N trials. The probability of exactly R successes is: 
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The probability of from 0 to R successes is given by: 
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When the inverse distribution is selected, you supply the probability value and the program solves 
for R. When the regular distribution is selected, you supply R and the program solves for the 
cumulative (left-tail) probability. 

Bivariate Normal Distribution 
The bivariate normal distribution is given by the formula 

Pr( , | ) exp
( )

x h y k r
r

x rxy y
r

dx dy
kh

< < =
−

− + −
−

⎧
⎨
⎩

⎫
⎬
⎭−∞−∞ ∫∫

1

2 1

2
2 12

2 2

2
π

 

where x and y follow the bivariate normal distribution with correlation coefficient r. 

 

Chi-Square Distribution 
The Chi-square distribution arises often in statistics when the normally distributed random 
variables are squared and added together. DF is the degrees of freedom of the estimated standard 
error. 

The noncentral Chi-square distribution function is used in power calculations. The noncentral 
Chi-square distribution is calculated using the formula: 
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where 
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When the noncentrality parameter (NCP), L, is set to zero, the above formula reduces to the 
(central) Chi-square distribution. 

When the inverse distribution is selected, you supply the probability value and the program solves 
for X. When the regular distribution is selected, you supply X and the program solves for the 
cumulative (left-tail) probability. 

Correlation Coefficient Distribution 
The correlation coefficient distribution is formulated as follows: 
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where 

|r| < 1, |ρ| < 1, and |R| < 1 

When the inverse distribution is selected, you supply the probability value and the program solves 
for R. When the regular distribution is selected, you supply R and the program solves for the 
cumulative (left-tail) probability. 

F Distribution 
The F distribution is used in the analysis of variance and in other places where the distribution of 
the ratio of two variances is needed. The degrees of freedom of the numerator variance is DF1 
and the degrees of freedom of the denominator variance is DF2.  

The noncentral-F distribution function is used in power calculations. We calculate the noncentral-
F distribution using the following relationship between the F and the beta distribution function. 
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When the noncentrality parameter (NCP), L, is set to zero, the above formula reduces to the 
standard F distribution 

When the inverse distribution is selected, you supply the probability value and the program solves 
for F. When the regular distribution is selected, you supply F and the program solves for the 
cumulative (left-tail) probability. 
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Hotelling’s T2 Distribution 
Hotelling’s T-Squared distribution is used in multivariate analysis. We calculate the distribution 
using the following relationship between the F and the T2 distribution function. 
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where k is the number of variables and df is the degrees of freedom associated with the 
covariance matrix. When the inverse distribution is selected, you supply the probability value and 
the program solves for T2. When the regular distribution is selected, you supply T2 and the 
program solves for the cumulative (left-tail) probability. 

Gamma Distribution 
The Gamma distribution is formulated as follows: 
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0 < A, 0 < B, and 0 ≤ G 

When the inverse distribution is selected, you supply the probability value and the program solves 
for G. When the regular distribution is selected, you supply G and the program solves for the 
cumulative (left-tail) probability. 

Hypergeometric Distribution 
The hypergeometric distribution is used to model the following situation. Suppose a sample of 
size R is selected from a population with N items, M of which have a characteristic of interest. 
What is the probability that X of the items in the sample have this characteristic. 

The probability of exactly X successes is: 
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Negative Binomial Distribution 
The negative binomial distribution is used to model the counts of a sequence of independent 
binary trials in which the probability of a success, P, is constant. The total number of trials 
(sample size) is N. R represents the number of successes in N trials. Unlike the binomial 
distribution, the sample size, N, is the variable of interest.  

The question answered by the negative binomial distribution is: how many tosses of a coin (with 
probability of a head equal to P) is necessary to achieve R heads and X tails. 

The probability of exactly R successes is: 
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Normal Distribution 
The normal distribution is formulated as follows: 
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When the mean is 0 and the variance is 1, we have the standard normal distribution. The regular 
normal distribution uses the variable X. The standard normal distribution uses the variable Z. Any 
normal distribution may be transformed to the standard normal distribution using the relationship: 

z x
=

− μ
σ

 

When the inverse distribution is selected, you supply the probability value and the program solves 
for R. When the regular distribution is selected, you supply R and the program solves for the 
cumulative (left-tail) probability. 

Poisson Distribution 
The Poisson distribution is used to model the following situation. Suppose the average number of 
accidents at a given intersection is 13.5 per year. What is the probability of having 2 accidents 
during the next half year? 

The probability of exactly X occurrences with a mean occurrence rate of M is: 
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Studentized Range Distribution 
The studentized range distribution is used whenever the distribution of the ratio of a range and an 
independent estimate of its standard error is needed. This distribution is used quite often in 
multiple comparison tests run after an analysis of variance. DF is the degrees of freedom of the 
estimated standard error (often the degrees of freedom of the MSE). K is the number of items 
(means) in the sample. The distribution function is given by: 
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where P(Rs|n) is the probability integral of the range. 

When the inverse distribution is selected, you supply the probability value and the program solves 
for R. When the regular distribution is selected, you supply R and the program solves for the 
cumulative (left-tail) probability. 

Student’s t Distribution 
The t distribution is used whenever the distribution of the ratio of a statistic and its standard error 
is needed. DF is the degrees of freedom of the estimated standard error. 

The noncentral-t distribution function is used in power calculations. We calculate the noncentral-t 
distribution using the following relationship between the t and the beta distribution function. 
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When the noncentrality parameter (NCP), L, is set to zero, the above formula reduces to the 
(central) Student’s t distribution 

When the inverse distribution is selected, you supply the probability value and the program solves 
for T. When the regular distribution is selected, you supply T and the program solves for the 
cumulative (left-tail) probability. 

Weibull Distribution 
The Weibull distribution is formulated as follows: 

( )Pr( | , ) exp ( )t T T≤ = − −λ γ λ γ1  

When gamma (γ) equal to one, the distribution simplifies to the exponential distribution. 

When the inverse distribution is selected, you supply the probability value and the program solves 
for T. When the regular distribution is selected, you supply T and the program solves for the 
cumulative (left-tail) probability. 
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Chapter 920 

Data Simulator 
Introduction 
Because of mathematical intractability, it is often necessary to investigate the properties of a 
statistical procedure using simulation (or Monte Carlo) techniques. In power analysis, simulation 
refers to the process of generating several thousand random samples that follow a particular 
distribution, calculating the test statistic from each sample, and tabulating the distribution of these 
test statistics so that the significance level and power of the procedure may be investigated. This 
module creates a histogram of a specified distribution as well as a numerical summary of 
simulated data. By studying the histogram and the numerical summary, you can determine if the 
distribution has the characteristics you desire. The distribution formula can then be used in 
procedures that use simulation, such as the new t-test procedures. Below are examples of two 
distributions that were generated with this procedure. 

   

Technical Details  
A random variable’s probability distribution specifies its probability over its range of values. 
Examples of common continuous probability distributions are the normal and uniform 
distributions. Unfortunately, experimental data often do not follow these common distributions, 
so other distributions have been proposed. One of the easiest ways to create distributions with 
desired characteristics is to combine simple distributions. For example, outliers may be added to a 
distribution by mixing it with data from a distribution with a much larger variance. Thus, to 
simulate normally distributed data with 5% outliers, we could generate 95% of the sample from a 
normal distribution with mean 100 and standard deviation 4 and then generate 5% of the sample 
from a normal distribution with mean 100 and standard deviation 16. Using the standard notation  
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for the normal distribution, the composite distribution of the new random variable Y could be 
written as 

( ) ( ) ( ) ( )Y X N X N~ . , . . ,δ δ0 0 95 100 4 0 95 100 100 16≤ < + ≤ ≤   
where X is a uniform random variable between 0 and 1, ( )zδ is 1 or 0 depending on whether z is 
true or false, N(100,4) is a normally distributed random variable with mean 100 and standard 
deviation 4, and N(100,16) is a normally distributed random variable with mean 100 and standard 
deviation 16. The resulting distribution is shown below. Notice how the tails extend in both 
directions. 

 
The procedure for generating a random variable, Y, with the mixture distribution described above 
is  

1. Generate a uniform random number, X. 

2. If X is less than 0.95, Y is created by generating a random number from the N(100,4) 
distribution. 

3. If X is greater than or equal to 0.95, Y is created by generating a random number from the 
N(100,16) distribution. 

Note that only one uniform random number and one normal random number are generated for 
any particular random realization from the mixture distribution. 

In general, the formula for a mixture random variable, Y, which is to be generated from two or 
more random variables defined by their distribution function ( )F Zi i  is given by  

( ) ( )Y a X a F Z a a ai i i i
i

k

K~ ,δ ≤ < = < < < =+
=

+∑ 1
1

1 2 10 1L   

Note that the ’s  are chosen so that weighting requirements are met. Also note that only one 
uniform random number and one other random number actually need to be generated for a 
particular value. The ’s may be any of the distributions which are listed below.  

ai

( )F Zi i

Since the test statistics which will be simulated are used to test hypotheses about one or more 
means, it will be convenient to parameterize the distributions in terms of their means. 
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Beta Distribution 
The beta distribution is given by the density function 
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where A and B are shape parameters, C is the minimum, and D is the maximum. In statistical 
theory, C and D are usually zero and one, respectively, but the more general formulation used 
here is more convenient for simulation work. In this program module, a beta random variable is 
specified as A(M, A, B, C), where M is the mean which is  

( )E X M D C A
A B

C( ) = = −
+

⎡
⎣⎢

⎤
⎦⎥
+  

The parameter D is obtained from M, A, B, and C using the relationship  

( )( )D
M C A B

A
C=

− +
+ . 

The beta density can take a number of shapes depending on the values of A and B: 

1. When A<1 and B<1 the density is U-shaped. 

 
2. When 0 1< < ≤A B  the density is J-shaped. 
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3. When A=1 and B>1 the density is bounded and decreases monotonically to 0. 

 
4. When A=1 and B=1 the density is the uniform density. 

 
5. When A>1 and B>1 the density is unimodal. 

 
Beta random variates are generated using Cheng’s rejection algorithm as given on page 438 of 
Devroye (1986). 
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Binomial Distribution 
The binomial distribution is given by the function 

( ) ( )Pr , , , , ,X x
n
x

x nx n x= =
⎛
⎝
⎜
⎞
⎠
⎟ − =−π π1 01 K2  

In this program module, the binomial is specified as B(M, n), where M is the mean which is equal 
to nπ  and n is the number of trials. The probability of a positive response, π , is not entered 
directly, but is obtained using the relationshipπ = M n/ . For this reason, 0 < <M n . 

 
Binomial random variates are generated using the inverse CDF method. That is, a uniform 
random variate is generated, and then the CDF of the binomial distribution is scanned to 
determine which value of X is associated with that probability. 

Cauchy Distribution 
The Cauchy distribution is given by the density function 
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Although the Cauchy distribution does not possess a mean and standard deviation, M and S are 
treated as such. Cauchy random numbers are generated using the algorithm given in Johnson, 
Kotz, and Balakrishnan (1994), page 327. 

In this program module, the Cauchy is specified as C(M, S), where M is a location parameter 
(median), and S is a scale parameter. 
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Constant Distribution 
The constant distribution occurs when a random variable can only take a single value, X. The 
constant distribution is specified as K(X), where X is the value.  

Data with a Many Zero Values 
Sometimes data follow a specific distribution in which there is a large proportion of zeros. This 
can happen when data are counts or monetary amounts. Suppose you want to generate 
exponentially distributed data with an extra number of zeros. You could use the following 
simulation model: 

K(0)[2]; E(5)[9] 

The exponential distribution alone was used to generate the histogram below on the left. The 
histogram below on the right was simulated by adding extra zeros to the exponential data. 

  

Exponential Distribution 
The exponential distribution is given by the density function 

( )f x
M

e x
x
M= >

−1 0,  

In this program module, the exponential is specified as E(M), where M is the mean. 
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Random variates from the exponential distribution are generated using the expression 
, where U  is a uniform random variate. ( )− M Uln

F Distribution 
Snedecor’s F distribution is the distribution of the ratio of two independent chi-square variates. 
The degrees of freedom of the numerator chi-square variate is A, while that of the denominator 
chi-square is D. The F distribution is specified as F(M, A), where M is the mean and A is the 
degrees of freedom of the numerator chi-square. The value of M is related to the denominator chi-
square degrees of freedom using the relationship M=D/(D-2).  

F variates are generated by first generating a symmetric beta variate, B(A/2,D/2), and 
transforming it into an F variate using the relationship 

F BD
A BAA D, =
−

 

Below is a histogram for data generated from an F distribution with a mean of 1.1 and A = 6. 

 

Gamma Distribution 
The three parameter gamma distribution is given by the density function 

( ) ( )
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f x
x
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e x A B
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1

0 0
Γ

, , , > 0  

where A is a shape parameter and B is a scale parameter. In this program module, the gamma is 
specified as G(M, A), where M is the mean, given by M=AB. The parameter B may be obtained 
using the relationship B = M/A.  

Gamma variates are generated using the exponential distribution when A = 1, Best’s XG 
algorithm given in Devroye (1986), page 410, when A > 1, and Vaduva’s algorithm given in 
Devroye (1986), page 415, when A < 1. 
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Multinomial Distribution 
The multinomial distribution occurs when a random variable has only a few discrete values such 
as 1, 2, 3, 4, and 5. The multinomial distribution is specified as M(P1, P2, …, Pk), where Pi is 
the is the probability of that the integer i occurs. Note that the values start at one, not zero. 

For example, suppose you want to simulate a distribution which has 50% 3’s and 1’s, 2’s, 4’s, 
and 5’s all with equal percentages. You would enter M(1 1 4 1 1). 

As a second example, suppose you wanted to have a equal percentage of 1’s, 3’s, and 7’s, and 
none of the other percentages. You would enter M(1 0 1 0 0 0 1). 

Likert-Scale Data 
Likert-scale data are common in surveys and questionnaires. To generate data from a five-point 
Likert-scale distribution, you could use the following simulation model:  

M(6 1 2 1 5) 

Note that the weights are relative—they do not have to sum to one. The program will make the 
appropriate weighting adjustments so that they do sum to one.  

The above expression generated the following histogram. 
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Normal Distribution 
The normal distribution is given by the density function 

( )f x x x=
−⎛

⎝⎜
⎞
⎠⎟

− ∞ ≤ ≤ ∞φ μ
σ

,  

where ( )φ z is the usual standard normal density. The normal distribution is specified as N(M, S), 
where M is the mean and S is the standard deviation. 

The normal distribution is generated using the Marsaglia and Bray algorithm as given in Devroye 
(1986), page 390. 

 

Poisson Distribution 
The Poisson distribution is given by the function 

( )Pr
!

, , , , ,X x e M
x

x M
M x

= = = >
−

0 1 2 0K  

In this program module, the Poisson is specified as P(M), where M is the mean.  

Poisson random variates are generated using the inverse CDF method. That is, a uniform random 
variate is generated and then the CDF of the Poisson distribution is scanned to determine which 
value of X is associated with that probability. 
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Student’s T Distribution 
Student’s T distribution is the distribution of the ratio of a unit normal variate and the square root 
of an independent chi-square variate. The degrees of freedom of the chi-square variate are the 
degrees of freedom of the T distribution. The T is specified as T(M, A), where M is the mean and 
A is the degrees of freedom. The central T distribution generated in this program has a mean of 
zero, so, to obtain a mean of M, M is added to every data value.  

T variates are generated by first generating a symmetric beta variate, B(A/2,A/2), with mean 
equal to 0.5. This beta variate is then transformed into a T variate using the relationship 

( )
T A X

X X
=

−
−
0 5

1
.

 

Here is a histogram for data generated from a T distribution with mean 0 and 5 degrees of 
freedom. 

 

Tukey’s Lambda Distribution 
Hoaglin (1985) presents a discussion of a distribution developed by John Tukey for allowing the 
detailed specification of skewness and kurtosis in a simulation study. This distribution is extended 
in the work of Karian and Dudewicz (2000). Tukey’s idea was to reshape the normal distribution 
using functions that change the skewness and/or kurtosis. This is accomplished by multiplying a 
normal random variable by a skewness function and/or a kurtosis function. The general form of 
the transformation is  

( ) ( ){ }X A B G z H z zg h= +  

where z has the standard normal density. The skewness function Tukey proposed is  

( )G z e
gzg

gz

=
−1

 

The range of g is typically -1 to 1. The value of ( )G z0 1≡ . The kurtosis function Tukey proposed 
is 

( )H z eh
hz=

2 2/  
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The range of h is also -1 to 1. 

Hence, if both g and h are set to zero, the variable X follows the normal distribution with mean A 
and standard deviation B. As g is increased toward 1, the distribution is increasingly skewed to 
the right. As g is decreased towards -1, the distribution is increasingly skewed to the left. As h is 
increased toward 1, the data are stretched out so that more extreme values are probable. As h is 
decreased toward -1, the data are concentrated around the center—resulting in a beta-type 
distribution. 

The mean of this distribution is given by 

( )
M A B e

g h
h

g h

= +
−

−

⎛

⎝
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⎞

⎠
⎟⎟ ≤ <

−2 2 1 1
1

0 1
/

,  

which may be easily solved for A.  

Tukey’s lambda is specified in the program as L(M, B, g, h) where M is the mean, B is a scale 
factor (when g=h=0, B is the standard deviation), g is the amount of skewness, and h is the 
amount of kurtosis.  

Random variates are generated from this distribution by generating a random normal variate and 
then applying the skewness and kurtosis modifications. Here are some examples as g is varied 
from 0 to 0.4 to 0.6. Notice how the amount of skewness is gradually increased. Similar results 
are achieved when h is varied from 0 to 0.5. 

   

Uniform Distribution 
The uniform distribution is given by the density function 

( )f x
B A

A x B=
−

≤ ≤
1 ,  

In this program module, the uniform is specified as U(M, A), where M is the mean which is equal 
to (A+B)/2 and A is the minimum of x. The parameter B is obtained using the relationship B=2M-
A. 
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Uniform random numbers are generated using Makoto Matsumoto’s Mersenne Twister uniform 
random number generator which has a cycle length greater than 1.0E+6000 (that’s a one followed 
by 6000 zeros). 

Weibull Distribution 
The Weibull distribution is indexed by a shape parameter, B, and a scale parameter, C. The 
Weibull density function is written as 
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Shape Parameter – B 
The shape parameter controls the overall shape of the density function. Typically, this value 
ranges between 0.5 and 8.0. One of the reasons for the popularity of the Weibull distribution is 
that it includes other useful distributions as special cases or close approximations. For example, if 

 B = 1 The Weibull distribution is identical to the exponential distribution. 

 B = 2 The Weibull distribution is identical to the Rayleigh distribution. 

 B = 2.5 The Weibull distribution approximates the lognormal distribution. 

 B = 3.6 The Weibull distribution approximates the normal distribution. 

Scale Parameter – C 
The scale parameter only changes the scale of the density function along the x axis. Some authors 
use 1/C instead of C as the scale parameter. Although this is arbitrary, we prefer dividing by the 
scale parameter since that is how one usually scales a set of numbers.  

The Weibull is specified in the program as W(M, B), where M is the mean which is given by  

M C
B

= +⎛
⎝⎜

⎞
⎠⎟

Γ 1 1
.  
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Combining Distributions 
This section discusses how distributions may be combined to form new distributions. Combining 
may be done in the form of algebraic manipulation, mixtures, or both.  

Creating New Distributions using Expressions 
The set of probability distributions discussed above provides a basic set of useful distributions. 
However, you may want to mimic reality more closely by combining these basic distributions. 
For example, paired data is often analyzed by forming the differences of the two original 
variables. If the original data are normally distributed, then the differences are also normally 
distributed. Suppose, however, that the original data are exponential. The difference of two 
exponentials is not a common distribution.  

Expression Syntax 
The basic syntax is  

C1 D1 operator1 C2 D2 operator2  C3 D3 operator3 … 

where C1, C2, C3, etc. are coefficients (numbers), D1, D2, D3, etc. are probability distributions, 
and operator is one of the four symbols: +, -, *, /. Parentheses are only permitted in the 
specification of distributions. 

Examples of valid expressions include 
N(4, 5) – N(4, 5) 

2E(3) – 4E(4) + 2E(5) 

N(4, 2)/E(4)-K(5) 

Notes about the Coefficients: C1, C2, C3 
The coefficients may be positive or negative decimal numbers such as 2.3, 5, or -3.2. If no 
coefficient is specified, the coefficient is assumed to be one.   
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Notes about the Distributions: D1, D2, D3 
The distributions may be any of the distributions listed above such as normal, exponential, or 
beta. The expressions are evaluated by generating random values from each of the distributions 
specified and then combining them according to the operators. 

Notes about the operators: +, -, *, / 
All multiplications and divisions are performed first, followed by any additions and subtractions. 

Note that if only addition and subtraction are used in the expression, the mean of the resulting 
distribution is found by applying the same operations to the individual distribution means. If the 
expression involves multiplication or division, the mean of the resulting distribution is usually 
difficult to calculate directly. 

Creating New Distributions using Mixtures 
Mixture distributions are formed by sampling a fixed percentage of the data from each of several 
distributions. For example, you may model outliers by obtaining 95% of your data from a normal 
distribution with a standard deviation of 5 and 5% of your data from a distribution with a standard 
deviation of 50. 

Mixture Syntax 
The basic syntax of a mixture is  

D1[W1]; D2[W2]; …;  Dk[Wk] 

where the D’s represent distributions and the W’s represent weights. Note that the weights must 
be positive numbers. Also note that semi-colons are used to separate the components of the 
mixture. 

Examples of valid mixture distributions include 

N(4, 5)[19]; N(4, 50)[1] 95% of the distribution is N(4, 5), and the other 5% is 
N(4, 50). 

W(4, 3)[7]; K(0)[3] 70% of the distribution is W(4, 3), and the other 30% is 
made up of zeros.  

N(4, 2)-N(4,3)[2]; E(4)*E(2)[8] 20% of the distribution is N(4, 2)-N(4,3), and the other 
80% is E(4)*E(2). 

Notes about the Distributions 
The distributions D1, D2, D3, etc. may be any valid distributional expression. 

Notes about the Weights 
The weights w1, w2, w3, etc. need not sum to one (or to one hundred). The program uses these 
weights to calculate new, internal weights that do sum to one. For example, if you enter weights 
of 1, 2, and 1, the internal weights will be 0.25, 0.50, and 0.25. 

When a weight is not specified, it is assumed to have the value of ‘1.’ Thus 
N(4, 5)[19]; N(4,50)[1] 

is equivalent to 
N(4, 5)[19]; N(4,50) 
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Special Functions 
A set of special functions is available to modify the generator number after all other operations 
are completed. These special functions are applied in the order they are given next. 

Square Root (Absolute Value) 
This function is activated by placing a ^ in the expression. When active, the square root of the 
absolute value of the number is used. 

Logarithm (Absolute Value) 
This function is activated by placing a ~ in the expression. When active, the logarithm (base e) of 
the absolute value of the number is used. 

Exponential 
This function is activated by placing an & in the expression. When active, the number is 
exponentiated to the base e. If the current number x is greater than 70, exp(70) is used rather than 
exp(x). 

Absolute Value 
This function is activated by placing a | in the expression. When active, the absolute value of the 
number is used. 

Integer 
This function is activated by placing a # in the expression. When active, the number is rounded to 
the nearest integer. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the 
Data tab. To find out more about using the other tabs such as Template, go to the Procedure 
Window chapter. 

Data Tab 
The Data tab contains the parameters used to specify a probability distribution. 

Data Simulation 

Probability Distribution to be Simulated 
Enter the components of the probability distribution to be simulated. One or more components 
may be entered from among the continuous and discrete distributions listed below the data-entry 
box.  

The W parameter gives the relative weight of that component. For example, if you entered  

P(5)[1];K(0)[2], about 33% of the random numbers would follow the P(5) distribution, and 67% 
would be 0. When only one component is used, the value of W may be omitted. For example, to 
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generate data from the normal distribution with mean of five and standard deviation of one, you 
would enter N(5, 1), not N(5, 1)[1]. 

Each of the possible components were discussed earlier in the chapter. 

Data Simulation – Number of Values 
for Histogram and Summary 

Number of Simulated Values 
This is the number of values generated from the probability distribution for display in the 
histogram. We recommend a value of about 5000. 

Reports Tab 
The following options control the format of the reports. 

Select Report 

Numerical Summary 
This option controls the display of this report. 

Select Plot 

Histogram 
This option controls the display of the histogram. 

Report Options 

Precision 
This allows you to specify the precision of numbers in the report. A single-precision number will 
show seven-place accuracy, while a double-precision number will show thirteen-place accuracy. 
Note that the reports are formatted for single precision. If you select double precision, some 
numbers may run into others. Also note that all calculations are performed in double precision 
regardless of which option you select here. This is for reporting purposes only. 

Report Options – Percentile Options 

Percentile Type 
This option specifies which of five different methods is used to calculate the percentiles. 

RECOMMENDED: Ave Xp(n+1) since it gives the common value of the median.  

In the explanations below, p refers to the fractional value of the percentile (for example, for the 
75th percentile p = .75), Zp refers to the value of the percentile, X[i] refers to the ith data value 
after the values have been sorted, n refers to the total sample size, and g refers to the fractional 
part of a number (for example, if np = 23.42, then g = .42).  The options are 

• Ave Xp(n+1)  
This is the most commonly used option. The 100pth percentile is computed as  

Zp = (1-g)X[k1] + gX[k2] 
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where k1 equals the integer part of p(n+1), k2=k1+1, g is the fractional part of p(n+1), and 
X[k] is the kth observation when the data are sorted from lowest to highest.  

• Ave Xp(n) 
The 100pth percentile is computed as 

Zp = (1-g)X[k1] + gX[k2] 

where k1 equals the integer part of np, k2=k1+1, g is the fractional part of np, and X[k] is the 
kth observation when the data are sorted from lowest to highest.  

• Closest to np 
The 100pth percentile is computed as 

Zp = X[k1] 

where k1 equals the integer that is closest to np and X[k] is the kth observation when the data 
are sorted from lowest to highest.  

• EDF 
The 100pth percentile is computed as 

Zp = X[k1] 

where k1 equals the integer part of np if np is exactly an integer or the integer part of np+1 if 
np is not exactly an integer. X[k] is the kth observation when the data are sorted from lowest 
to highest. Note that EDF stands for empirical distribution function. 

• EDF w/Ave 
The 100pth percentile is computed as 

Zp = (X[k1] + X[k2])/2 

where k1 and k2 are defined as follows: If np is an integer, k1=k2=np. If np is not exactly an 
integer, k1 equals the integer part of np and k2 = k1+1. X[k] is the kth observation when the 
data are sorted from lowest to highest. Note that EDF stands for empirical distribution 
function. 

Smallest Percentile 
This option lets you assign a different value to the smallest percentile value shown on the 
percentile report. The default value is 1.0. You can select any value between 0 and 100, including 
decimal numbers. 
Largest Percentile 
This option lets you assign a different value to the largest percentile value shown on the 
percentile report. The default value is 1.0. You can select any value between 0 and 100, including 
decimal numbers. 

Report Options – Report Decimal 
Places 

Means – Values 
Specify the number of decimal places used when displaying this item. 

GENERAL: Display the entire number without special formatting. 
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Storage Tab 
The Data tab contains the parameters used to specify a probability distribution. 

Storage of Simulated Values to 
Spreadsheet 

Store Values in Column 
This is the column of the spreadsheet in which the simulated values will be stored. Any data 
already in this column will be replaced. 

Spreadsheet 
Press this button to open the spreadsheet window for storage. 

Numbers of Values Stored (Maximum of 16000) 
This is the number of generated values that are stored in the current spreadsheet. 

Example 1 – Generating Normal Data 
In this example, 5000 values will be generated from the standard normal (mean zero, variance 
one) distribution. These values will be displayed in a histogram and summarized numerically.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 1 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... N(0, 1) 
Numbers in of Simulated Values .......................... 5000 

Storage Tab 
Numbers of Values Stored ................................... 0 
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Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

 
 
Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 8.627304E-03 Minimum -3.453244 
Standard Deviation 0.9910903 1st Percentile -2.289698 
Skewness -6.010016E-02 5th Percentile -1.65369 
Kurtosis 2.847444 10th Percentile -1.298245 
Coefficient of Variation 114.8783 25th Percentile -0.6598607 
Count 5000 Median 2.659537E-02 
  75th Percentile 0.6922649 
  90th Percentile 1.276735 
  95th Percentile 1.620931 
  99th Percentile 2.274097 
  Maximum 3.645533 
 

This report shows the histogram and a numerical summary of the 5000 simulate normal values. It 
is interesting to check how well the simulation did. Theoretically, the mean should be zero, the 
standard deviation one, the skewness zero, and the kurtosis three. Of course, your results will 
vary from these because these are based on generated random numbers. 

Example 2 – Generating Data from a Contaminated 
Normal 
In this example, we will generate data from a contaminated normal. This will be accomplished by 
generating 95% of the data from a N(100,3) distribution and 5% from a N(110,15) distribution.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 2 by clicking the Open button. 
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Option Value 
Data Tab 
Probability Distribution to be Simulated ............... N(100 3)[95]; N(110 15)[5] 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
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Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 100.3549 Minimum 71.11177 
Standard Deviation 4.716588 1st Percentile 92.40327 
Skewness 2.67692 5th Percentile 94.82752 
Kurtosis 23.11323 10th Percentile 96.01687 
Coefficient of Variation 4.699908E-02 25th Percentile 97.88011 
Count 5000 Median 100.0328 
  75th Percentile 102.18 
  90th Percentile 104.266 
  95th Percentile 105.9543 
  99th Percentile 120.4605 
  Maximum 145.2731 
 

This report shows the data from the contaminated normal. The mean is close to 100, but the 
standard deviation, skewness, and kurtosis have non-normal values. Note that there are now some 
very large outliers. 
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Example 3 – Likert-Scale Data 
In this example, we will generate data following a discrete distribution on a Likert scale. The 
distribution of the Likert scale will be 30% 1’s, 10% 2’s, 20% 3’s, 10% 4’s, and 30% 5’s.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 3 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... M(30 10 20 10 30) 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
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Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 2.9858 Minimum 1 
Standard Deviation 1.622506 1st Percentile 1 
Skewness 1.169226E-02 5th Percentile 1 
Kurtosis 1.436589 10th Percentile 1 
Coefficient of Variation 0.5434074 25th Percentile 1 
Count 5000 Median 3 
  75th Percentile 5 
  90th Percentile 5 
  95th Percentile 5 
  99th Percentile 5 
  Maximum 5 
 

This report shows the data from a Likert scale.  
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Example 4 – Bimodal Data 
In this example, we will generate data that have a bimodal distribution. We will accomplish this 
by combining data from two normal distributions, one with a mean of 10 and the other with a 
mean of 30. The standard deviation will be set at 4.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 4 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... N(10 4);N(30 4) 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

 
 
Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 19.82392 Minimum -7.067288 
Standard Deviation 10.81724 1st Percentile 1.819361 
Skewness 3.503937E-02 5th Percentile 4.949873 
Kurtosis 1.500108 10th Percentile 6.473907 
Coefficient of Variation 0.545666 25th Percentile 9.863808 
Count 5000 Median 17.73235 
  75th Percentile 29.94195 
  90th Percentile 33.4243 
  95th Percentile 35.11861 
  99th Percentile 38.04005 
  Maximum 43.71141 
 

This report shows the results for the simulated bimodal data.  
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Example 5 – Gamma Data with Extra Zeros 
In this example, we will generate data that have a gamma distribution, except that we will force 
there to be about 30% zeros. The gamma distribution will have a shape parameter of 5 and a 
mean of 10.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 5 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... G(10,5)[7];K(0)[3] 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

 
 
Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 7.0965 Minimum 0 
Standard Deviation 5.960041 1st Percentile 0 
Skewness 0.4635893 5th Percentile 0 
Kurtosis 2.730829 10th Percentile 0 
Coefficient of Variation 0.8398563 25th Percentile 0 
Count 5000 Median 7.24275 
  75th Percentile 11.09861 
  90th Percentile 14.94062 
  95th Percentile 17.41686 
  99th Percentile 22.18812 
  Maximum 36.13172 
 

This report shows the results for the simulated gamma data with extra zeros.  
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Example 6 – Mixture of Two Poisson Distributions  
In this example, we will generate data that have a mixture of two Poisson distributions. 60% of 
the data will be from a Poisson distribution with a mean of 10 and 40% from a Poisson 
distribution with a mean of 20.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 6 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... P(10)[60];P(20)[40] 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

P(10)[60];P(20)[40]

Simulated Data

0 10 20 30 40
0

4

8

12

16

 
 
Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean 13.8662 Minimum 0 
Standard Deviation 6.088589 1st Percentile 4 
Skewness 0.5726398 5th Percentile 6 
Kurtosis 2.580317 10th Percentile 7 
Coefficient of Variation 0.4390957 25th Percentile 9 
Count 5000 Median 13 
  75th Percentile 18 
  90th Percentile 23 
  95th Percentile 25 
  99th Percentile 29 
  Maximum 36 
 

This report shows the results for the simulated mixture-Poisson data.  
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Example 7 – Difference of Two Identically Distributed 
Exponentials 
In this example, we will demonstrate that the difference of two identically distributed exponential 
random variables follows a symmetric distribution.  This is particularly interesting because the 
exponential distribution is skewed.  In fact, the difference between any two identically distributed 
random variables follows a symmetric distribution.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from 
the PASS Home window, load the Data Simulator procedure window by clicking on Tools, and 
then clicking on Data Simulator. You may then follow along here by making the appropriate 
entries as listed below or by opening Example 7 by clicking the Open button. 

Option Value 
Data Tab 
Probability Distribution to be Simulated ............... E(10)-E(10) 
Numbers in of Simulated Values .......................... 5000 
Numbers of Values Stored ................................... 0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

 
 
Descriptive Statistics of Simulated Data 
 
Statistic Value Statistic Value 
Mean -0.3431585 Minimum -99.37727 
Standard Deviation 14.20288 1st Percentile -41.02162 
Skewness -7.391038E-02 5th Percentile -23.19279 
Kurtosis 6.115685 10th Percentile -16.70725 
Coefficient of Variation -41.38868 25th Percentile -7.131404 
Count 5000 Median -0.1380393 
  75th Percentile 6.575472 
  90th Percentile 15.78555 
  95th Percentile 22.12444 
  99th Percentile 38.82129 
  Maximum 72.36995 
 

This report demonstrates that the distribution of the difference is symmetric. 
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Chapter 925 

Spreadsheets 
Introduction 
This chapter discusses the operation of the spreadsheets, used to enter data for a few select PASS 
procedures and to store simulated and some output data. Each spreadsheet is the tool that lets you 
enter, view, and modify data.  

The spreadsheet corresponding to each procedure is saved when the procedure template is saved. 
The Output Spreadsheet, which is used for outputting simulated data or some procedure results 
can be saved individually. 

The operation of the PASS spreadsheet is similar to the operation of other spreadsheets with 
which you may be familiar. It has many of the operational features of Microsoft Excel. Since the 
operation of these spreadsheets is so common, we will not spend a lot of space teaching them to 
you. Perhaps the easiest way to enter data into the spreadsheet is a simple copy and paste. 

 
                   Input Spreadsheet 
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Spreadsheet Menus 
You should be familiar with the operation of pull down menus. We will discuss the various 
options that are on these menus.  

File Menu 
The File Menu controls the opening and closing of spreadsheets.  

We will now discuss each of these options. 

New (Clear Spreadsheet) 
This option clears the spreadsheet. 

Import from Excel File (1st Sheet Only) 
This option a dialog for finding and importing the first page of an Excel spreadsheet. 

Export to Excel File 
This option a dialog for exporting the spreadsheet data to an Excel spreadsheet. 

Close Spreadsheet 
This option closes the spreadsheet window. For input spreadsheets, the spreadsheet data are not 
cleared when the spreadsheet is closed. 

Edit Menu 
The Edit Menu controls the editing of spreadsheets.  

Undo 
This option undoes the latest change to the spreadsheet. 

Redo 
This option undoes the latest undo to the spreadsheet. 

Cut 
The Cut option copies the currently selected (highlighted) data to the Windows clipboard and 
clears those cells. This data may be pasted at another location within NCSS or to another 
program. 

Copy 
The Copy option copies the currently selected (highlighted) data to the Windows clipboard. The 
selected data is untouched. The copied data may be pasted at another location within NCSS or to 
another program. 
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Paste 
The Paste option copies data from the clipboard to the current datasheet at the currently selected 
location. The contents of the clipboard may have come from a previous Cut or Copy operation 
within PASS or from another program. 

Clear Selected Values 
This option clears or deletes the selected values. 

Clear Spreadsheet 
This option clears the spreadsheet. 

Add Rows / Columns 
The default spreadsheet has 1000 rows and 100 columns. This option can be used to create 
additional rows and/or columns. 

Rename Columns 
This option opens a simple dialogue for renaming columns. Columns may also be renamed by 
double-clicking the column heading. 

Help Menu 
From this menu you can open a PDF chapter about the spreadsheets (this chapter) or launch the 
PASS Help System to this topic.  
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Chapter 930 

Macros 
Introduction 
This software has an interactive (point and click) user interface which makes in easy to learn and 
use. At times, however, it is necessary to repeat the same steps over and over. When this occurs, a 
batch system becomes more desirable. This chapter documents a batch language that lets you 
create a macro (script or program) and then run that macro. With the click of a single button, you 
can have the program run a series of procedures.  

We begin with a discussion of how to create, modify, and run a macro. Next, we list all of the 
macro commands and their functions. 

Macro Command Center 
This section describes how to create a macro, edit it, and run it. This is all accomplished from the 
Macro Command Center window. You can load this window by selecting Macros Home from the 
Tools menu. 

We will now describe each of the objects on the Macro Command Center window. 

Active Macro 
This box displays the name of the currently selected macro file. A preview of this macro is 
displayed in the Preview window. You can change this name by typing over it or by selecting a 
different macro from the Existing Macros box.  

Existing Macros 
This box displays a list of all existing macros. Click on a macro in this list to make it the active 
macro—the macro that is used when the Play Macro button to the right is pressed. Double-
clicking a macro causes that macro to open in the window’s Notepad program for editing. 

The macros are stored in the MACROS subdirectory of the PASS 11 folder. They always have the 
file extension “.ncm”. 

Preview of Active Macro 
This box displays the beginning of the macro that is in the Active Macro box. 

Record Macro 
Pressing this button causes the commands you issue to be written to the macro file named in the 
Active Macro box. The Macro Command Center window will be replaced by a small Macro 
window that lets you stop recording the macro. When the recording starts, if there is a previous 
macro file with the same name as that in the Active Macro Name box, the previous macro file is 
erased.  
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The PASS macro recorder does not record every keystroke and click that you make. Instead, it 
records major operations. For example, suppose you want to include calculating the sample size 
for a t-test in your macro. You would load the t-test procedure, change some options, and run it. 
The macro recorder saves a copy of the t-test settings as a template file and writes a single 
command line to the macro file that references this template. All of your settings are included in 
the template file—there is no reference in the macro to the individual settings changes. This 
makes the macro much smaller and easier to modify. 

Functions from the View, File, and Edit menus are not recorded during a macro recording. Those 
functions are performed using the SendKeys commands or other specific commands. As a general 
rule, the loading, running, and unloading of procedures that have templates are recorded during a 
macro recording. 

Edit Macro 
Pressing this button causes the Active Macro to be loaded in the Windows NotePad program. 
This program lets you modify the macro and then save your changes.  

Play Macro 
Pressing this button causes the Active Macro to be run. Once the macro is finished, the Macro 
Command Center window will close and you can view the results of running your macro. 

Delete Macro 
Pressing this button causes the Active Macro to be deleted. The macro file is actually moved to 
the Recycle Bin from which it can be rescued if you decide it shouldn’t have been deleted. 

Close 
Pressing this button closes the Macro Command Center window. 

Set Menu Macro 
A play macro menu item is available from the Home window and the various procedure windows.  
Clicking this Play menu item causes the designated macro to be run. The macro that is associated 
with the macro button is controlled by this section of the Macro Command center. To change the 
macro that is associated with the play macro menu item, simply select the desired macro from the 
Existing Macros list and then click the Menu Macro button. This will associate the macro to the 
menu item. This association will remain even if the program is exited. 

Syntax of a Macro Command Line 
PASS macros are line based. That is, each macro command expression is written on a separate 
line. The basic structure of a line is that it begins with a command followed by one or more 
options or parameters of the command, called arguments. For example, the following macro loads 
a procedure, loads a template for that procedure, and then runs the procedure with the loaded 
template.  

LoadProc PSProp2IP 
LoadTemplate PSProp2IP "Template1" 
RunProc PSProp2IP 
 

In this example, LoadProc, LoadTemplate, and RunProc are commands, while PSProp2IP and 
"Template1" are arguments. 
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Comment Lines 
It is often useful to add comment lines to a macro to make it easier to understand later. Comment 
lines begin with single quotes. When the macro processor encounters a single quote at the 
beginning of a line, the rest of the line is ignored. Single quotes occurring at a location other than 
the beginning of a line are treated as text. 

Blank lines may also be added to a macro to improve readability. These are also ignored.  

Macro Constants and Macro Variables 
As stated above, macro command lines consist of keywords followed by arguments. These 
arguments are either constants, such as "Template1" or 'PSProp2IP', or macro variables. These 
will be discussed next. 

Macro Constants 
Macro constants are fixed values. There are two types of macro constants: text and numeric. 

Numeric Constants 
Numeric constants are numbers. They may be whole or decimal numbers. They may be positive 
or negative. They may be enclosed in double quotes, although this is not necessary. When the 
macro processor expects a number but receives a text value, it sets the numeric value to zero. 

Examples of numeric constants are 

1, 3.14159, and 0. 

Text Constants 
Text constants are usually enclosed in double quotes. If a constant is a single word (made of 
letters and digits with no blanks or special characters), the double quotes are not necessary. 

Examples of text constants are 

Apple, "Apple Pie", and "D:/Program Files". 

Macro Variables 
Macro Variables are used to store temporary values for use in macro command lines. Some 
examples of assigning values to macro variables are 

A# = 4 
B# = 4 + 3 
File$ = "C:/Program Files/PASS/Data/ABC.S0" 
F$ = "4" & "5" 

 

In these examples, A#, B#, File$, and F$ are macro variables. The assigned values for each of the 
variables are 4, 7, "C:\Program Files\PASS\Data\ABC.S0", and 45, respectively. 

There are two types of macro variables: text and numeric. 

Text Macro Variables 
Text macro variables are used to hold text values. The rules for naming them are that the names 
can contain only letters and numbers (no spaces or special characters) and they must end with a 
'$'. The case of the letters is ignored (so 'A$' is used interchangeably with 'a$'). 
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Examples of text macro variable names are 

A$   
Apple$   
FileName$ 

Numeric Macro Variables 
Numeric variables are used to hold numeric values. The rules for naming them are that the names 
can contain only letters and numbers (no spaces or special characters), and they must end with a 
'#'. The case of the letters is ignored (so 'A#' is used interchangeably with 'a#'). 

Examples of numeric macro variable names are 

A#   
Apple#   
NRows# 

Assigning Values to Macro Variables 
One type of macro variable expression is that of assigning a value to a variable. The basic syntax 
for this type of expression is  

{variable} = {value} 

where the {variable} is text or numeric and {value} is a  macro variable or (text or numeric) 
macro constant. If a text value contains spaces or special characters, it must be enclosed in double 
quotes. 

A text value can be is assigned to a numeric macro variable. In this case, the text value is 
converted to a number. If it cannot be converted to a number (e.g., it is a letter), the numeric 
macro variable is set to zero. 

Following are some examples of valid assignment expressions. 

A# = 4 
X$ = John 
File$ = "C:\Program Files\PASS\Data\ABC.S0" 
X$ = File$ 
X$ = A# 
A# = F$ 
F$ = 4 

Macro Variable Combination Expressions 
Macro variables can be combined using simple mathematical expressions. The basic syntax for 
this type of expression is  

{variable} = {value} {operator} {value}. 

The available operators are + (add), - (subtract), * (multiply), / (divide), and & (concatenate). 

If a text value is involved in a mathematical expression, it is converted to a numeric value before 
the mathematical expression is evaluated. If it cannot be converted to a number, the text value is 
set to the numeric value of zero. 
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Following are some examples of valid assignment expressions. 

Expression Result 
A# = 4 + 3 A# = 7 
B# = A# * 2 B# = 14 
C$ = "C:/Pgm/"  
D$ = C$ & "ABC.S0" D$ = "C:/Pgm/ABC.S0" 
E# = C$ * 4 E# = 0 
F$ = "4" + "5" F$ = "9" 
F$ = "4" & "5" F$ = "45" 
A# = 1 
A# = A# + 1 A# = 2 

Macro variable assignments are used while the macro is running, but are not saved when the 
macro has completed.  

Displaying Macro Variables 
The value of one or more macro variables may be displayed on the output using the PRINT or 
HEADING commands.  

Print 
This command outputs the requested values to the printout.  

The syntax of this command is 

PRINT {p1} {p2} {p3} … 

where  

{p1} {p2} ... are assigned macro variables or constants.   

Following are some examples of Print commands. 

Command Printed Result 
PRINT "Hi World" Hi World 
I# = 1  
J$ = "C:/PASS/Data/ABC" 
F$ = J$ & i# 
F$ = F$ & ".s0" 
PRINT "File=" F$ File=C:/PASS/Data/ABC1.s0 
PRINT "1" "2" "3" "4" 1 2 3 4 

Heading 
This command adds a line to the page heading that is shown at the top of each page.  

The syntax of this command is 

HEADING {h1} 

where  

{h1}  is an assigned macro variable or constant.   
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Following are some examples of valid HEADING commands. 

Command Heading 

HEADING "Hi World" Hi World 
F$ = "Heart Study" 
HEADING F$ Heart Study 

Logic and Control Commands 
The lines in a macro are processed in succession. These commands allow you to alter the order in 
which macro lines are processed, allow user-input, or end the program.  

List of Logic and Control Commands: 

Flag 
GOTO 
IF 
INPUT 
END 
SendKeys 

Flag Statement 
A flag is a reference point in the program. The GOTO command sends macro line control to a 
specific flag. A flag is made up of letters and numbers (no spaces) followed by a colon.  

Following are some examples of valid flags. More extensive examples are shown in the 
description of the IF statement (below) 

Examples 
Flag1: 
A: 
Loop1: 

GOTO command 
This command transfers macro processing to the next statement after a flag.  

The syntax of this command is 

GOTO {P1} 

where  

{P1}  is a text variable or text constant.   

Following are some examples of valid GOTO commands. 

Examples 
GOTO Flag1 
or 
F$ = "Flag1" 
GOTO F$ 
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IF command 
This command transfers macro processing to the next statement after a flag if a condition is met. 
The syntax of this command is 

IF {p1} {logic} {p2} GOTO {p3} 

where  

{p1} is a variable or constant.   

{p2} is a variable or constant.   

{p3} is a flag.   

{logic}  is a logic operator. Possible logic operators are =, <, >, <=, >=, and <>.   

Following are some examples of valid IF commands. 

Examples 
IF x1# > 5 GOTO flag1 
IF y$ = "A" GOTO flag2 
IF y$ <> "A" GOTO flag3 

INPUT 
This command stops macro execution, display a message window, and waits for a value to be 
input. This value is then stored in the indicated macro variable.  

The syntax of this command is 

INPUT {variable} {prompt} {title} {default} 

where  

{variable} is the name of the variable (text or numeric) to receive the value that is input.   

{prompt} is the text phrase that is shown on the input window.   

{title} is the text phrase that is displayed at the top of the input window.   

{default} is the default value for the input.   

Following is an example of this command. 

Example 
INPUT A# "Enter the number of items" "Macro Input Window" 1 

END 
This command closes the PASS system.  

The syntax of this command is 

END 

Example 
END 
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SendKeys 
This command sends one or more keystrokes to the program as if you had typed them in from the 
keyboard. This facility allows you to create macros to accomplish almost anything you can do 
interactively within the program. 

To use this, run the program from the keyboard, noting exactly which keys are pressed. Then, 
type the appropriate commands into the sendkeys text. Note that spaces are treated as characters, 
so '{down} {tab}' is different from '{down}{tab}'. 

The syntax of this command is 

SendKeys {value} 

where {value} is a text constant or variable.  

Remarks 
Each key is represented by one or more characters. To specify a single keyboard character, use 
the character itself. For example, to represent the letter A, use "A" for value. To represent more 
than one character, append each additional character to the one preceding it. To represent the 
letters A, B, and C, use "ABC" for string. 

The plus sign (+), caret (^), percent sign (%), tilde (~), and parentheses ( ) have special meanings 
to SendKeys. To specify one of these characters, enclose it within braces ({}). For example, to 
specify the plus sign, use {+}. Brackets ([ ]) have no special meaning to SendKeys, but you must 
enclose them in braces. To specify brace characters, use {{} and {}}. 

To specify characters that are not displayed when you press a key, such as ENTER or TAB, and 
keys that represent actions rather than characters, use the following codes: 

Key Code 

Backspace {bs} 
Break {break} 
Caps Lock {capslock} 
Delete {delete} 
Down Arrow {down} 
End {end} 
Enter {enter} 
Esc {esc} 
Home {home} 
Insert {insert} 
Left Arrow {left} 
Num Lock {numlock} 
Page Down {pgdn} 
Page Up {pgup} 
Right Arrow {right} 
Tab {tab} 
Up Arrow {up} 
F1 {F1} 
F2 {F2} 
F3 {F3} 
F4 {F4} 
F5 {F5} 
F6 {F6} 
F7 {F7} 
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Key Code 

F8 {F8} 
F9 {F9} 
F10 {F10} 
F11 {F11} 
F12 {F12} 
F13 {F13} 
F14 {F14} 
F15 {F15} 
F16 {F16} 
 

To specify keys combined with any combination of the SHIFT, CTRL, and ALT keys, precede 
the key code with one or more of the following codes: 

Key Code 

Shift + 
Ctrl  ^ 
Alt % 
 
To specify that any combination of SHIFT, CTRL, and ALT should be held down while several 
other keys are pressed, enclose the code for those keys in parentheses. For example, to specify to 
hold down SHIFT while E and C are pressed, use "+(EC)". To specify to hold down SHIFT while 
E is pressed, followed by C without SHIFT, use "+EC". 

To specify repeating keys, use the form {key number}. You must put a space between key and 
number. For example, {LEFT 4} means press the LEFT ARROW key 4 times; {h 8} means press 
H 8 times. 

Spreadsheet Note: When a macro is run the usual beginning location on the screen is the new 
page icon (just below File) in the upper left of the screen. A single tab may be entered in the 
macro to go to the upper left cell position on the spreadsheet. 

Examples Action 
SendKeys "ABC {enter}" (Types ABC and then enter) 
SendKeys "{enter right}" (Enter and then down arrow) 
SendKeys "%H{down 2}{enter}" (Activates the Serial Numbers from the Help menus) 
SendKeys "{right}" (Moves to the right one cell) 

 

Window Position Commands 
These commands allow the user to position or hide windows while the macro is running. 

List of Window Commands: 

WindowLeft 
WindowTop 

WindowLeft 
This command sets the position of the left edge of the home, panel, and output windows. This 
allows you to effectively hide these windows while a macro is running.  
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The syntax of this command is 

WINDOWLEFT {value} 

where  

{value}  is the value of the left edge in thousandths of an inch.   

Examples Action 
WINDOWLEFT 0 (positions the left edge to zero) 
WINDOWLEFT 10000 (positions the left edge ten inches to the right) 
WINDOWLEFT -10000 (positions the left edge ten inches to the left) 

WindowTop 
This command sets the position of the top of the home, panel, and output windows. This allows 
you to effectively hide these windows while a macro is running.  

The syntax of this command is 

WINDOWTOP {value} 

where  

{value} is the value of the left edge in thousandths of an inch.   

Examples Action 
WINDOWTOP 0 (positions the top to zero) 
WINDOWTOP -10000 (positions the top ten inches up) 

Spreadsheet Commands 
The following commands open, close, and modify an PASS spreadsheet. 

List of Dataset Commands: 

GetCell 
SetCell 
NumRows 
GetMaxRows 
GetMaxCols 
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GetCell  
This command obtains the value of a spreadsheet cell. The syntax of this command is 

GetCell {procedure} {column} {row} {macro variable} 

where 

{procedure} is the macro name or number of the procedure that uses a spreadsheet. For the 
output spreadsheet, the number is 73 and the name is Output. 

{column} is the name or number of the column with the cell to be read. 

{row} is the row number of the cell to be read. 

{macro variable} is the text or numeric macro variable that will hold the value of the 
spreadsheet cell. 

Examples 
GetCell Output "HeartRate" 27 H# 
GetCell Output Name 16 Name16$ 

SetCell  
This command sets a spreadsheet cell to a specified value. The syntax of this command is 

SetCell {procedure} {col1} {row1} {row2} {value} 

where 

{procedure} is the macro name or number of the procedure that uses a spreadsheet. For the 
output spreadsheet, the number is 73 and the name is Output. 

{col1} is the name or number of the column to receive the new value. 

{row1} is the first row in a range of rows to receive the new value. 

{row2} is the last row in a range of rows to receive the new value 

{value} is the new value. This value may be text or numeric. 

Examples 
SetCell Output "HeartRate" 10 10 "100" 
SetCell Output 1 10 20 100 
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NumRows  
This command loads the number of rows used in a specific column into a macro variable. The 
syntax of this command is 

NumRows {procedure} {col1} {n} 

where 

{procedure} is the macro name or number of the procedure that uses a spreadsheet. For the 
output spreadsheet, the number is 73 and the name is Output. 

{col1} is a column name or number on the current spreadsheet. 

{n} is a numeric macro variable. 

Examples 
NumRows Output "HeartRate" n1# 
NumRows Output 1 n# 

GetMaxRows  
This command loads the maximum number of rows used by any column into a macro variable.  

The syntax of this command is 

GetMaxRows {procedure} {n} 

where 

{procedure} is the macro name or number of the procedure that uses a spreadsheet. For the 
output spreadsheet, the number is 73 and the name is Output. 

{n} is a numeric macro variable. 

Examples 
GetMaxRows Output n1# 
GetMaxRows Output n# 

GetMaxCols  
This command causes the number of the right-most column with data to be loaded into a macro 
variable.  

The syntax of this command is 

GetMaxCols {procedure} {n} 

where 

{procedure} is the macro name or number of the procedure that uses a spreadsheet. For the 
output spreadsheet, the number is 73 and the name is Output. 

{n} is a numeric macro variable. 

Example 
GetMaxCols Output nvars# 
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Procedure Commands 
The following commands open, modify, run and close procedures. 

List of Procedure Commands: 

LoadProc 
RunProc 
SaveTemplate 
UnloadProc 
Option 

LoadProc 
This command loads the designated procedure window. Once loaded, the options of the 
procedure may be modified and then the procedure can be executed. 

The syntax of this command is 

LoadProc {proc} {template} 

where  

{proc} is a variable or constant that gives the name or number of the procedure to be 
loaded. Each procedure’s name and number is displayed near the bottom of the 
window under the Template tab.   

{template}  is an optional text variable or text constant that gives the name of a template file that 
is loaded with this procedure. If this value is omitted, the default (last) template for 
this procedure is loaded. Note that the text value does not include the extension or 
the folder information for the template file. 

Following are some examples of valid LOADPROC commands. 

Example 
LOADPROC 24 "macro 1" 
LOADPROC PSProp2IP "macro 1" 
LOADPROC PSProp2IP 
LOADPROC 24  

RunProc  
This command executes the indicated procedure. The syntax of this command is 

RunProc {proc} {template} 

where  

{proc} is a variable or constant that gives the name or number of the procedure to be run. 
Each procedure’s name and number is displayed near the bottom of the window 
under the Template tab.   

{template} is a required variable or text constant that gives the name of the resulting template 
file. Note that the text value does not include the extension or the folder information 
for the template file.   
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SaveTemplate  
This command saves the settings in the last procedure loaded to a template file. Once loaded, the 
options of the procedure may be modified and then the procedure can be executed. 

The syntax of this command is 

SaveTemplate {proc} {template} {id} 

where  

{proc} is a variable or constant that gives the name or number of the procedure whose 
template is to be saved. Each procedure’s name and number is displayed near the 
bottom of the window under the Template tab.   

{template} is a required variable or text constant that gives the name of the resulting template 
file. Note that the text value does not include the extension or the folder information 
for the template file.   

{id}  is an optional text variable or text constant that is stored with the file. This text is 
displayed with the file name under the Template tab. 

Following are some examples of valid SaveTemplate commands. 

Example 
SaveTemplate PSProp2IP "Template1" 
SaveTemplate PSProp2IP "Template1" "This template was created by a macro on January 1" 

UnloadProc 
This command closes the indicated procedure window. The syntax of this command is 

UnloadProc {proc} 

where  

{proc} is a variable or constant that gives the name or number of the procedure. Each 
procedure’s name and number is displayed near the bottom of the window under the 
Template tab.   

Option 
This command lets you set the values of the individual options of a procedure. If the option 
numbers are not displayed on the procedure windows, go to View or File, Options, View, and 
check the box next to ‘Show Option Numbers’. 

For example, you may want to change the value of Alpha or the type of test that is run. 
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The syntax of this command is 

Option {proc} {number} {value1} {value2} {value3} … 

where  

{proc} is a variable or constant that gives the name or number of the procedure. Each 
procedure’s name and number is displayed near the bottom of the window under the 
Template tab.   

{number} is the number of the option that is to be set. This number is displayed at the lower, 
left corner of the procedure window when the mouse is positioned over that option.  

 If the 'Opt' value is not displayed, activate it by doing the following: from the 
spreadsheet menus select File or View, Options, and View. Check the option labeled 
'Show Option Numbers'.  

{value1}  is the new value of the option.  

{value2}…  are the new values of the remaining parameters of the option. Most options only 
have one value, so a second value is not necessary. However, a few options, such as 
text properties, bring up a window for option selection. These options have two or 
more parameters. 

Following are some examples of valid OPTION commands. 

Example 
OPTION 24 2 4 
OPTION “PSProp2IP” 3 0.8 

Output Commands 
The following commands manage the output (word processor) windows. 

List of Output Commands: 

SaveOutput 
ClearOutput 
PrintOutput 
AddToLog 
NewLog 
SaveLog 
OpenLog 

SaveOutput 
This command saves the current output to the designated file name. 

The syntax of this command is 

SaveOutput {filename} 

{filename} a text constant or variable that gives the name of the file to receive the output. Note 
that the extension of the file name should be '.RTF'. 

Example 
SAVEOUTPUT "C:/Program Files/PASS/Sample.rtf" 
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ClearOutput 
This command clears (erases) the current output. 

The syntax of this command is 

ClearOutput 

Example 
CLEAROUTPUT 

PrintOutput 
This command prints the current output. 

The syntax of this command is 

PrintOutput 

Example 
PRINTOUTPUT 

AddToLog 
This command copies the output in the output window to the log window. Note that nothing is 
saved by this command. 

The syntax of this command is 

AddToLog 

Example 
ADDTOLOG 

NewLog 
This command clears log window. 

The syntax of this command is 

NewLog 

Example 
NEWLOG 

SaveLog 
This command saves the current contents of the log output window to the designated file name. 

The syntax of this command is 

SaveLog {filename} 

{filename} a text constant or variable that gives the name of the file to receive the log. Note that 
the extension of the file name should be '.RTF'. 

Example 
SAVELOG "C:/Program Files/PASS/Reports/Sample.rtf" 
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OpenLog 
This command opens and displays the contents of the specified file. 

The syntax of this command is 

OpenLog {filename} 

{filename} a text constant or variable that gives the name of the file to opened. Note that only 
RTF files can be opened.  

Example 
OPENLOG "C:/Program Files/PASS/Sample.rtf" 

Alphabetical Macro Command List 
AddToLog 
ClearOutput 
End 
GetCell {proc} {variable} {row} {macro variable} 
GetMaxCols {proc} {n} 
GetMaxRows {proc} {n} 
Goto {P1} 
Heading {h1} 
If {p1} {logic} {p2} goto {p3} 
Input {variable} {prompt} {title} {default} 
LoadProc {proc} {template} 
LoadTemplate {proc} {template} 
NewLog 
NumRows {proc} {v1} {n} 
OpenLog {filename} 
Option {number} {value1} {value2} {value3} … 
Print {p1} {p2} {p3} … 
PrintOutput 
RunProc {proc} 
SaveLog {filename} 
SaveOutput {filename} 
SaveTemplate {proc} {template} {id} 
SendKeys {value} 
SetCell {proc} {v1} {row1} {row2} {value} 
UnloadProc {proc} 
WindowLeft {value} 
WindowTop {value} 
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Examples 
The following section provides examples of PASS macros. Our intention is that these examples 
will help you learn how to write macros to accomplish various repetitive tasks with PASS. 

Example 1 – Automatically Run a Procedure 
This macro opens the two-sample T-test procedure and runs the procedure with the default 
values. 
'***  Load the Two-Sample T-Test procedure 
'***  Note that the default values are used. 
LoadProc PSMean2ID 
 
'***  Run the analysis 
RunProc PSMean2ID 
'*** End of Macro 1 

Example 2 – Run Several Procedures 
This macro runs three procedures. The two-sample T-test procedure is run with the default values, 
except that Alpha is set to 0.10. The one-sample T-test procedure is run with default values, 
except that Alpha is set to 0.15. The linear regression procedure is run with the values set by the 
template ‘My LinReg Template’. 
'***  Load the Two-Sample T-Test procedure 
LoadProc PSMean2ID 
'***  Set Alpha (Option 8) to 0.10 
Option PSMean2ID 8 0.10 
'***  Run the analysis 
RunProc PSMean2ID 
 
'***  Load the One-Sample T-Test procedure 
LoadProc PSMeanCorr 
'***  Set Alpha (Option 8) to 0.15 
Option PSMeanCorr 8 0.15 
'***  Run the analysis 
RunProc PSMeanCorr 
 
'***  Load the Linear Regression procedure 
LoadProc PSLinReg 
'***  Load the ‘My LinReg Template’ template 
LoadTemplate PSLinReg "My LinReg Template" 
'***  Run the analysis 
RunProc PSLinReg 
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Chapter 940 

Scatter Plots  
Introduction 
This section describes the options that are available for the appearance of a scatter plot. A set of 
all these options can be stored as a template file which can be retrieved later.  

X and Y Axis Tabs 
These options specify the characteristics of the lines, labels, and tick marks along the X and Y 
axes.  

Boundaries 
These boundaries set the minimum and maximum of the plot. Data values outside these 
boundaries are ignored. When set, these boundaries override any other boundaries.  

Minimum 
This is the smallest value of the axis. If left blank, a nice value is determined from the data.  

Maximum 
This is the largest value of the axis. If left blank, a nice value is determined from the data.  

Corners 
Click to bring up a window that lets you extend the axis a little further. This is usually done so 
that the X and Y tick mark labels are not too close together or so that data points do not fall 
directly on the axis line. The value is the number of pixels the axis end is shifted.  

Note that this does not change scale of the graph. It only shifts the location of the axis. 

Scale 

Linear 
Selects a linear scale in which the plot distant between equally-spaced points along the axis is 
constant. For example, the distance on the plot between 10 and 20 is the same as that between 80 
and 90.  

Log  
Selects a logarithmic scale in which the plot distant between equally-spaced points along the axis 
increases. For example, the distance on the plot between 1 and 10 is the same as that between 100 
and 1000. 
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• Base 
This is the base of the logarithms. Possible choices are integers between 2 and 16. A common 
choice is 10.  

Here are some examples of tick patterns resulting from various bases. 

Base = 2: 1, 2, 4, 8, 16, 32, 64, 128, etc. 

Base = 3: 1, 3, 9, 27, 81, 243, 729, etc. 

Base = 5: 1, 5, 25, 125, 625,  etc. 

Base = 8: 1, 8, 64, 512, 4096, etc. 

Base = 10: 1, 10, 100, 1000, etc. 

• Format 
This option specifies the format of the tick reference numbers.  

Choose Numbers to display the tick values as integers (e.g., 1, 10, 100, 1000). 

Choose Powers to display the tick values as exponential numbers (e.g., 100, 101, 102, 103). 

 

Axis Labels 
These options specify the characteristics of the axis label.  

Top, Bottom or Left, Right 
These options indicate whether the label is to be shown along the top and/or bottom (left and/or 
right) axes. 

Text 
Enter the label text here.  

Text replacement codes can be used to create labels that will be changed at runtime. These codes 
are replaced by appropriate text (such as variable names) when a plot is generated. The codes are 

{X} is replaced by the name of the X axis variable.  

{Y} is replaced by the name of the Y axis variable.  

Font 
The font size, color, and style of the label may be modified by pressing the font button (A) to the 
right of the text.  

Layout 
The exact position of the text is set by pressing the layout button (Layout) to the right of the font 
button.  

The text is printed inside of an imaginary box of appropriate size. The Layout window sets the 
alignment, the margins, and the shift of the text.  

The alignment designates whether the text is centered, right-justified, or left-justified within the 
box.  

The margin indicates the number of pixels displayed above and below the text. 



 Scatter Plots  940-3 

The shift indicates the number of pixels that the text is shifted in the X and/or Y directions. This 
is used to make small adjustments to the text placement. 

Lines 
These options specify the characteristics of the axis lines. Note that the axis lines can be specified 
separately from the axis boundaries. 

Top, Bottom or Left, Right 
These options indicate whether a line is displayed for the top and/or bottom (left and/or right) 
axes. 

Line Format Button 
Pressing this button displays the Axis Line Format window that sets the format (color, width, and 
pattern) of the axis line. Click the left side of the button to load the Line Format window. Click 
the right side of the button to select a format from various preset line formats. 

Crosses X (or Y) Axis at 
Specifies the point at which this axis crosses the opposite axis.  

• {blank} 
The axis is placed at the edge of the plot region. 

• Numeric Value 
The axis is placed at this value of the opposite axis. For example, if the X axis has both positive 
and negative values, you might want to enter '0' here for the Y axis so that it crosses the X axis at 
0. 

Axis Line Min and Max 
These values are used to set a specific minimum and maximum for the axis line. When entered, 
the axis line is only visible in that region. Note that other axis objects such as the tick marks and 
tick reference labels might extend beyond the end of the visible axis line. 

Possible choices are 

• {blank} 
The axis line is extended to the edge of the axis. 

• Value 
The axis line is extended to the specified value. 

• Data 
If Data is entered, the axis line is extended to the exact minimum (or maximum) of the data. 

Major Ticks 
These options specify the characteristics of the major (primary) ticks, including their placement 
and format.  
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Top Marks, Bottom Marks or Left Marks, Right Marks 
These options indicate whether major tick marks are displayed along the top and/or bottom (left 
and/or right) axes.  

Format 
Clicking this button allows the color, size, and position of the tick marks to be set.  

Tick Number and Spacing 
Clicking this button allows the number and spacing of the ticks to be set.  

Top Labels, Bottom Labels or Left Labels, Right Labels 
These options indicate whether the tick reference labels are displayed at the corresponding ticks. 

Font 
Pressing the font button (A) lets the font size, color, and style of the tick reference label to be 
modified. 

Layout 
The exact position of the tick reference labels are set by pressing the layout button (Layout).The 
labels are displayed inside an imaginary box. The Layout window sets the alignment, rotation 
angle, margins, and shift of the reference labels.  

The alignment designates whether the reference labels are centered, right-justified, or left-
justified within the box.  

The rotation angle designates whether the reference labels are rotated through a specified angle.  

The margin indicates the number of pixels displayed above and below the reference labels. 

The shift indicates the number of pixels that the reference labels are shifted in the X and/or Y 
directions. This is used to make small adjustments to the text placement. 

Decimals 
Specify the number of decimal places displayed in the tick label.  

• Auto 
If Auto is selected, the number of decimal places is determined from the data values. 

Minor Ticks 
These options specify the characteristics of the minor ticks, including their placement and format. 
Note that no reference labels are available for minor ticks.  

Top Marks, Bottom Marks or Left Marks, Right Marks 
These options indicate whether minor tick marks are displayed along the top and/or bottom (left 
and/or right) axes. 

Format 
Clicking this button allows the color, size, and position of the minor tick marks to be set.  

Tick Number and Spacing 
Clicking this button allows the number and spacing of the minor ticks to be set.  
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Grid Line Tab 
These options specify the characteristics of various grid lines the X and Y axes. 

From X Axis 
These grid lines extend vertically from the X axis.  

At Major Ticks 
Check this option to extend grid lines vertically from the major ticks along the X axis. The check 
box is followed by a Line Format button that sets the characteristics of the line. 

At Minor Ticks 
Check this option to extend grid lines vertically from the minor ticks along the X axis. The check 
box is followed by a Line Format button that sets the characteristics of the line. 

At These Values 
Check this option to extend grid lines vertically from the minor ticks at the values in the list. The 
check box is followed by a text box in which the values are entered. The text box is followed by a 
Line Format button that sets the characteristics of the line. 

• List 
You can enter a list separated by blanks such as 

10 20 25 30 40 

• Range 
You can enter a range of values using the xxx TO yyy BY zzz syntax such as 

10 to 100 by 10 

The value list is followed by a Line Format button that sets the characteristics of the line. 

 

From Y Axis 
These grid lines extend horizontally from the Y axis.  

At Major Ticks 
Check this option to extend grid lines horizontally from the major ticks along the Y axis. The 
check box is followed by a Line Format button that sets the characteristics of the line. 

At Minor Ticks 
Check this option to extend grid lines horizontally from the minor ticks along the Y axis. The 
check box is followed by a Line Format button that sets the characteristics of the line. 

At These Values 
Check this option to extend grid lines horizontally from the minor ticks at the values in the list. 
The check box is followed by a text box in which the values are entered. The text box is followed 
by a Line Format button that sets the characteristics of the line. 
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• List 
You can enter a list separated by blanks such as 

10 20 25 30 40 

• Range 
You can enter a range of values using the xxx TO yyy BY zzz syntax such as 

10 to 100 by 10 

The value list is followed by a Line Format button that sets the characteristics of the line. 

Symbols Tab 
These options specify the characteristics of the symbols used for plotting.  

Symbols 1 - 100 
These buttons display the Symbol window that lets you edit the settings of the symbol associated 
with a specific group. Click the left side of the button to bring up the symbol window. Click the 
right side of the button to choose from a list of preset, favorite, or recent symbols. 

Note that group 1 is used when no grouping variable is selected. 

Using the symbol window, you can choose the shape, size, color, transparency, and border of the 
symbol.  

Shapes 
There are many different symbol shapes, including circles, rectangles, triangles, stars, and arrows. 
You can also choose a character as a shape from among the many thousand characters that 
Windows has available. You can even type a short phrase. 

Fill 
The color of the symbol’s interior can be a solid color or multi-colored gradient pattern. 

Size 
The size is set as a percentage of the default size. 

Border Width 
Set the width of the symbol’s border in pixels. 

Border Color 
Set the symbol’s border color. 

Other Options 

Show Symbols 
Uncheck this option to hide all symbols. Check it to display the symbols. 

Change All 
Check this option to change the size, border width, or transparency of all 100 symbols to a 
specified value. 
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Titles Tab 
These options set the titles of the plot. Up to two titles may be specified on each of the four sides 
of the plot.  

Titles along the X Axes 
These options specify the characteristics of the title displayed at the top or bottom of the plot. 

Top 1, Top 2,  Bottom 1, or Bottom 2 
These options indicate whether the title is shown along the top and/or bottom of the plot. 

Text 
Enter the title text here.  

Text replacement codes can be used to create labels that will be changed at runtime. These codes 
are replaced by appropriate text (such as variable names) when a plot is generated. The codes are 

{T} by the program generated plot title. 

{X} is replaced by the name of the X axis variable.  

{Y} is replaced by the name of the Y axis variable.  

{G} by the grouping variable's name. 

{Z} by the third variable's name. 

{A} by the intercept. 

{B} by the slope. 

{R} by the R squared value. 
 

For example, you would enter 

{Y} = {A} + ({B}){X} 

to display the linear regression equation. 

Font (A) 
The font size, color, and style of the title may be modified by pressing the font button (A) to the 
right of the text. 

Layout 
The exact position of the text is set by pressing the layout button (Layout) to the right of the font 
button.  

The text is printed inside of an imaginary box of appropriate size. The Layout window sets the 
alignment, the margins, and the shift of the text.  

The alignment designates whether the text is centered, right-justified, or left-justified within the 
box.  

The margin indicates the number of pixels displayed above and below the text. 

The shift indicates the number of pixels that the text is shifted in the X and/or Y directions. This 
is used to make small adjustments to the text placement. 
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Titles along the Y Axes 
These options specify the characteristics of the title displayed at the left or right of the plot. The 
details are identical to those for the X Axes (above). 

Legend Tab 
These options display the characteristics and position to the plot legend.  

General Tab 
This tab displays options about the location, title, and appearance of the box containing the 
legion. 

Show Legend 
This check box specifies whether to display the legend. 

Show Legend If 
This setting indicates if the legend is displayed when there is only one group. 

Margin Outside the Legend Frame 
These options specify the margins around the edges of the legend. 

Titles 
These options specify one or two titles for the legend. 

Frame and Fill 
These options set the properties of the legend’s frame (outline) and its fill (interior color). 

Layout Tab 
This tab displays options about the layout (arrangement) of the entries within the legend. 

Arrangement 
These options control the number of columns in the legend and the direction in which the legend 
entries are displayed. 

Margins Inside the Legend 
These options control the margins between the various portions of the legend. 

Spacing 
These options control the margins (space) between the entries 

Legend Entry Order 
These options control order in which the entries are shown. 

Groups Tab 
This tab displays options about the display of the grouping variable in the legend. 
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Group Labels 
These options control the format of the text portion of the entry for each group. 

Group Symbols 
These options control the format of the symbol portion of the entry for each group. 

Customize Individual Legend Entries 
These options let you change the format and position of specific groups in the legend. 

Connect Tab 
This tab displays options about the display of the connecting lines in the legend. 

Connecting Line Labels 
These options control the format of the text portion of the entry for each connecting line. 

Connecting Line Size 
These options control the format of the line portion of the entry for each connecting line. 

Customize Individual Legend Entries 
These options let you change the format and position of specific connecting lines in the legend. 
They also let you generate separate legend entries for each trend line and group combination. 

Extra Lines Tab 
This tab displays options about the display of the extra lines in the legend. 

Extra Line Labels 
These options control the format of the text portion of the entry for each extra line. 

Extra Line Size 
These options control the format of the line portion of the entry for each extra line. 

Customize Individual Legend Entries 
These options let you change the format and position of specific extra lines in the legend. 

Extra Symbols Tab 
This tab displays options about the display of the extra symbols in the legend. 

Extra Symbol Labels 
These options control the format of the text portion of the entry for each extra symbol. 

Extra Symbol Size 
These options control the format of the symbol portion of the entry for each extra symbol. 

Customize Individual Legend Entries 
These options let you change the format and position of specific extra symbols in the legend. 
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Connect Tab 
These options control the characteristics of connecting lines that can be added to the plot.  

Point Connecting Line 
This option draws a line connecting each point. One line is drawn per group.  

Connection Order 
The points may be connected in different orders. 

• Row Order 
The points are connected in the order in which the points appear on the database. 

• Left to Right 
The points are connected in the order of their X values. 

• Bottom to Top 
The points are connected in the order of their Y values. 

Extras Tab 
The options on this tab let you add extra lines, symbols, and notes to the plot. 

Extra Lines 
This option lets you add an unlimited number of extra lines to a plot. To add a line, specify a line 
format and the beginning and ending points of the line.  

Extra Symbols 
This option lets you add an unlimited number of extra symbols to a plot. To add a symbol, specify 
a symbol format and the point where the symbol is to be displayed.  

Notes 
This option lets you add an unlimited number of notes (text) to a plot. To add a phrase, specify 
the text, its format, and the beginning location on the plot.  

Points-to-Axis Tab 
The options on this tab let you to add display tick marks, lines, or bars at each data point.  

Tick Marks for each Data Point 
These options let you display a tick mark along the axis for each data point. 
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Lines from each Data Point 
These options let you display a line from each data point to the designated axis. 

Bars from each Data Point 
These options let you display a bar from each data point to the designated axis.  

Colors and Size Tab 
These options specify a background color for the whole plot (background) and for the data region 
(interior).  They also specify size and margins of the plot. 

Background 
This option specifies the background outline and fill color.  

Interior 
This option specifies the interior fill color. This is the color of the portion of the plot on which the 
data points are plotted. 

Size 
This option specifies the width and height (in pixels) of the interior area of the plot. The legend, 
border plots, tick marks, titles, and labels are added to the outside of this area. Thus, the total 
width and height of the plot cannot be specified.  

Margin 
This option a margin for each edge of the plot (in pixels). 

Painting Order Tab 
The options under this tab control the order in which items are placed on the plot. Items at the top 
of the list are placed on the plot first. They may be obscured the items that are plotted later.  

Example Data Tab 
Usually, you will set up the format of a scatter plot before the data are available. This option lets 
you see how your options appear on a set of random data. 

You control the number of groups, number of data points, and the data limits of both the X and Y 
variable.  

Pressing the New Data button generates a new set of random data. 
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Chapter 945 

Histograms  
Introduction 
This section describes the options that are available for the appearance of a histogram. A set of all 
these options can be stored as a template file which can be retrieved later.  

Histogram Tab 
These options specify the characteristics of the histogram.  

Format 
These options specify the format of the histogram outline and interior. 

Interior Lines 
This is the smallest value of the axis. If left blank, a nice value is determined from the data.  

Bins 
These options specify the appearance of the histogram’s bins (divisions or classes). This includes 
setting the number of bins or the width of the bins.  

Auto 
This option indicates that the number of bins is to be determined from the data. Click to set the 
number of bins (intervals or classes) to Auto (meaning automatic). 

The program finds a number of bins that will: 

1) result in nice numbers for the bin boundaries, and 

2) display the general shape of the data distribution. 

Note that as the number of data values increases, so does the number of bins. 

When a discrete dataset (one with only a few unique values) is detected, the number of bins will 
be set to the number of unique values, regardless of the number of rows. 

Treat as Discrete if the Number of Uniques  
This option is only used when the Auto option is selected for the number of bins. 

This option sets the maximum number of unique values that a dataset can have and still be treated 
as discrete. When a dataset is discrete, the bins are set to surround the discrete values. Note that 
only (nearly) consecutive integers are considered. Datasets with fractional discrete values receive 
no special treatment. 
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Number 
Click to set the number of bins to Number. This option forces the program to use the number of 
bins specified to the right.  

If a minimum and/or maximum is specified, they will be used. If not, an appropriate minimum 
and maximum values are determined from the data. 

Min 
Optional minimum for the bin boundaries. If this value is blank, a nice minimum based on the 
data is used. 

This minimum is used to construct the bins, but it does not necessarily set the minimum for the 
axis or the axis lines. Those are set elsewhere. 

Max 
Optional maximum for the bins boundaries. If this value is blank, a nice maximum based on the 
data is used. 

This maximum is used to construct the bins, but it does not necessarily set the maximum for the 
axis or the axis lines. Those are set elsewhere. 

Bin Width 
Click to set the number of bins to Bin Width. This option sets the space between bin boundaries to 
the amount entered to the right (or a power of ten multiple of the value). Beginning at the 
minimum, bins are added until the maximum of the data is reached.  

For example, suppose the minimum is set to 20 and the maximum is set to 44. Further suppose 
that the interval is 10. Bins would be 10 ≤ X < 20, 20 ≤ X < 30, 30 ≤ X < 40, and 40 ≤ X ≤ 50. 

Note that the boundaries of the bins are closed on the left and open on the right, except for the last 
bin which is closed on both sides. 

Bin Width Scaling 
This option determines whether the interval is scaled so that between 4 and 20 ticks occur.  

• Scale interval by power of 10 
The interval is scaled (multiplied) by an appropriate power of 10. 

• Unscaled - Use this interval 
Use this interval without scaling. 

Bin Width Min 
Optional minimum for the bins. If this value is blank, a nice minimum based on the data is 
determined. This minimum is used to construct the bins, but it does not necessarily set the 
minimum for the axis or the axis lines. Those are set elsewhere. 

Overlays Tab 
These options specify objects that can enhance or replace the histogram. These include the 
density trace, frequency polygon, and normal density. 
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Density Trace 
The density trace is a smoothed version of the histogram. It is described elsewhere.  

Interval Width as a Percent of Range 
The interval width controls the smoothness of the density trace. The wider the interval, the 
smoother the curve. 

Since the entering the actual interval desired would require a different entry for each case, a 
relative interval width is specified as the percentage of the overall range of the data. 

The appearance of the density trace depends a great deal on your entry here. Remember that as 
you increase this width, more data are processed at each calculation point which results in more 
and more time needed to complete the plot. 

Number of Calculation Points 
The number of values along the X axis at which the Y value is calculated. As you increase the 
number, the line gets more and more precise. Usually, 50 calculation points will suffice. 
Sometimes you will need more to show an accurate depiction of the relationship. 

Frequency Polygon 
The frequency polygon replaces the histogram bars with a line connecting the top midpoint of 
each bar.  

Normal Density 
A normal density can be displayed over the plot. This object depends solely on the mean and 
standard deviation of the data.  

Number of Calculation Points 
This is the number of values along the X axis at which the Y value is calculated. As you increase 
the number, the line gets more and more precise. Usually, 50 calculation points will suffice. 
Sometimes you will need more to show an accurate depiction of the relationship. 

X and Y Axis Tabs 
These options specify the characteristics of the lines, labels, and tick marks along the X and Y 
axes.  

Boundaries 
These boundaries set the minimum and maximum of the plot. Data values outside these 
boundaries are ignored. When set, these boundaries override any other boundaries.  

Minimum 
This is the smallest value of the axis. If left blank, a nice value is determined from the data.  

Maximum 
This is the largest value of the axis. If left blank, a nice value is determined from the data.  
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Corners 
Click to bring up a window that lets you extend the axis a little further. This is usually done so 
that the X and Y tick mark labels are not too close together or so that data points do not fall 
directly on the axis line. The value is the number of pixels the axis end is shifted.  

Note that this does not change scale of the graph. It only shifts the location of the axis. 

Scale (Y axis only) 

Scale 
Indicate whether the scale of the Y axis is in terms of percents, proportions, or frequencies 
(counts).  

Cumulative Scale 
Checking this option displays the cumulative frequencies (or percentages) instead of the 
individual frequencies (or percentages). 

The summing occurs as you move from left to right.  

Axis Labels 
These options specify the characteristics of the axis label.  

Top, Bottom or Left, Right 
These options indicate whether the label is to be shown along the top and/or bottom (left and/or 
right) axes. 

Text 
Enter the label text here.  

Text replacement codes can be used to create labels that will be changed at runtime. These codes 
are replaced by appropriate text (such as variable names) when a plot is generated. The codes are 

{X} is replaced by the name of the X axis variable.  

{Y} is replaced by the name of the Y axis variable.  

Font 
The font size, color, and style of the label may be modified by pressing the font button (A) to the 
right of the text.  

Layout 
The exact position of the text is set by pressing the layout button (Layout) to the right of the font 
button.  

The text is printed inside of an imaginary box of appropriate size. The Layout window sets the 
alignment, the margins, and the shift of the text.  

The alignment designates whether the text is centered, right-justified, or left-justified within the 
box.  

The margin indicates the number of pixels displayed above and below the text. 

The shift indicates the number of pixels that the text is shifted in the X and/or Y directions. This 
is used to make small adjustments to the text placement. 
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Lines 
These options specify the characteristics of the axis lines. Note that the axis lines can be specified 
separately from the axis boundaries. 

Top, Bottom or Left, Right 
These options indicate whether a line is displayed for the top and/or bottom (left and/or right) 
axes. 

Line Format Button 
Pressing this button displays the Axis Line Format window that sets the format (color, width, and 
pattern) of the axis line. Click the left side of the button to load the Line Format window. Click 
the right side of the button to select a format from various preset line formats. 

Crosses X (or Y) Axis at 
Specifies the point at which this axis crosses the opposite axis.  

• {blank} 
The axis is placed at the edge of the plot region. 

• Numeric Value 
The axis is placed at this value of the opposite axis. For example, if the X axis has both positive 
and negative values, you might want to enter '0' here for the Y axis so that it crosses the X axis at 
0. 

Axis Line Min and Max 
These values are used to set a specific minimum and maximum for the axis line. When entered, 
the axis line is only visible in that region. Note that other axis objects such as the tick marks and 
tick reference labels might extend beyond the end of the visible axis line. 

Possible choices are 

• {blank} 
The axis line is extended to the edge of the axis. 

• Value 
The axis line is extended to the specified value. 

• Data 
If Data is entered, the axis line is extended to the exact minimum (or maximum) of the data. 

Major Ticks 
These options specify the characteristics of the major (primary) ticks, including their placement 
and format.  

Top Marks, Bottom Marks or Left Marks, Right Marks 
These options indicate whether major tick marks are displayed along the top and/or bottom (left 
and/or right) axes.  



945-6  Histograms  

Format 
Clicking this button allows the color, size, and position of the tick marks to be set.  

Tick Number and Spacing 
Clicking this button allows the number and spacing of the ticks to be set.  

Top Labels, Bottom Labels or Left Labels, Right Labels 
These options indicate whether the tick reference labels are displayed at the corresponding ticks. 

Font 
Pressing the font button (A) lets the font size, color, and style of the tick reference label to be 
modified. 

Layout 
The exact position of the tick reference labels are set by pressing the layout button (Layout).The 
labels are displayed inside an imaginary box. The Layout window sets the alignment, rotation 
angle, margins, and shift of the reference labels.  

The alignment designates whether the reference labels are centered, right-justified, or left-
justified within the box.  

The rotation angle designates whether the reference labels are rotated through a specified angle.  

The margin indicates the number of pixels displayed above and below the reference labels. 

The shift indicates the number of pixels that the reference labels are shifted in the X and/or Y 
directions. This is used to make small adjustments to the text placement. 

Decimals 
Specify the number of decimal places displayed in the tick label.  

• Auto 
If Auto is selected, the number of decimal places is determined from the data values. 

Minor Ticks 
These options specify the characteristics of the minor ticks, including their placement and format. 
Note that no reference labels are available for minor ticks.  

Top Marks, Bottom Marks or Left Marks, Right Marks 
These options indicate whether minor tick marks are displayed along the top and/or bottom (left 
and/or right) axes. 

Format 
Clicking this button allows the color, size, and position of the minor tick marks to be set.  

Tick Number and Spacing 
Clicking this button allows the number and spacing of the minor ticks to be set.  

Grid Line Tab 
These options specify the characteristics of various grid lines the X and Y axes. 
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From X Axis 
These grid lines extend vertically from the X axis.  

At Major Ticks 
Check this option to extend grid lines vertically from the major ticks along the X axis. The check 
box is followed by a Line Format button that sets the characteristics of the line. 

At Minor Ticks 
Check this option to extend grid lines vertically from the minor ticks along the X axis. The check 
box is followed by a Line Format button that sets the characteristics of the line. 

At These Values 
Check this option to extend grid lines vertically from the minor ticks at the values in the list. The 
check box is followed by a text box in which the values are entered. The text box is followed by a 
Line Format button that sets the characteristics of the line. 

• List 
You can enter a list separated by blanks such as 

10 20 25 30 40 

• Range 
You can enter a range of values using the xxx TO yyy BY zzz syntax such as 

10 to 100 by 10 

The value list is followed by a Line Format button that sets the characteristics of the line. 

 

From Y Axis 
These grid lines extend horizontally from the Y axis.  

At Major Ticks 
Check this option to extend grid lines horizontally from the major ticks along the Y axis. The 
check box is followed by a Line Format button that sets the characteristics of the line. 

At Minor Ticks 
Check this option to extend grid lines horizontally from the minor ticks along the Y axis. The 
check box is followed by a Line Format button that sets the characteristics of the line. 

At These Values 
Check this option to extend grid lines horizontally from the minor ticks at the values in the list. 
The check box is followed by a text box in which the values are entered. The text box is followed 
by a Line Format button that sets the characteristics of the line. 

• List 
You can enter a list separated by blanks such as 

10 20 25 30 40 
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• Range 
You can enter a range of values using the xxx TO yyy BY zzz syntax such as 

10 to 100 by 10 

The value list is followed by a Line Format button that sets the characteristics of the line. 

Titles Tab 
These options set the titles of the plot. Up to two titles may be specified on each of the four sides 
of the plot.  

Titles along the X Axes 
These options specify the characteristics of the title displayed at the top or bottom of the plot. 

Top 1, Top 2,  Bottom 1, or Bottom 2 
These options indicate whether the title is shown along the top and/or bottom of the plot. 

Text 
Enter the title text here.  

Text replacement codes can be used to create labels that will be changed at runtime. These codes 
are replaced by appropriate text (such as variable names) when a plot is generated. The codes are 

{T} by the program generated plot title. 

{X} is replaced by the name of the X axis variable.  

{Y} is replaced by the name of the Y axis variable.  

{G} by the grouping variable's name. 

{Z} by the third variable's name. 

{A} by the intercept. 

{B} by the slope. 

{R} by the R squared value. 
 

For example, you would enter 

{Y} = {A} + ({B}){X} 

to display the linear regression equation. 

Font (A) 
The font size, color, and style of the title may be modified by pressing the font button (A) to the 
right of the text. 

Layout 
The exact position of the text is set by pressing the layout button (Layout) to the right of the font 
button.  

The text is printed inside of an imaginary box of appropriate size. The Layout window sets the 
alignment, the margins, and the shift of the text.  
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The alignment designates whether the text is centered, right-justified, or left-justified within the 
box.  

The margin indicates the number of pixels displayed above and below the text. 

The shift indicates the number of pixels that the text is shifted in the X and/or Y directions. This 
is used to make small adjustments to the text placement. 

Titles along the Y Axes 
These options specify the characteristics of the title displayed at the left or right of the plot. The 
details are identical to those for the X Axes (above). 

Legend Tab 
These options display the characteristics and position to the plot legend.  

General Tab 
This tab displays options about the location, title, and appearance of the box containing the 
legion. 

Show Legend 
This check box specifies whether to display the legend. 

Show Legend If 
This setting indicates if the legend is displayed when there is only one group. 

Margin Outside the Legend Frame 
These options specify the margins around the edges of the legend. 

Titles 
These option specify one or two titles for the legend. 

Frame and Fill 
These options set the properties of the legend’s frame (outline) and its fill (interior color). 

Layout Tab 
This tab displays options about the layout (arrangement) of the entries within the legend. 

Arrangement 
These options control the number of columns in the legend and the direction in which the legend 
entries are displayed. 

Margins Inside the Legend 
These options control the margins between the various portions of the legend. 

Spacing 
These options control the margins (space) between the entries 
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Legend Entry Order 
These options control order in which the entries are shown. 

Lines Tab 
This tab displays options about the display of the overlay lines in the legend. 

Overlay Line Labels 
These options control the format of the text portion of the entry for each overlay line. 

Overlay Line Size 
These options control the format of the line portion of the entry for each overlay line. 

Customize Individual Legend Entries 
These options let you change the format and position of specific overlay lines in the legend.  

Extra Lines Tab 
This tab displays options about the display of the extra lines in the legend. 

Extra Line Labels 
These options control the format of the text portion of the entry for each extra line. 

Extra Line Size 
These options control the format of the line portion of the entry for each extra line. 

Customize Individual Legend Entries 
These options let you change the format and position of specific extra lines in the legend. 

Extras Tab 
The options on this tab let you add extra lines, symbols, and notes to the plot. 

Extra Lines 
This option lets you add an unlimited number of extra lines to a plot. To add a line, specify a line 
format and the beginning and ending points of the line.  

Notes 
This option lets you add an unlimited number of notes (text) to a plot. To add a phrase, specify 
the text, its format, and the beginning location on the plot.  

Border Plots Tab 
These options let you display any of several reference plots in the border of the plots. These plots 
include the box plot and the dot plot.  
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Plot Order 
The order in which the plots are displayed in the margin is set by the Plot Order list. 

Box Plot 
A box plot can be placed in the margin of the X axis. Box plots emphasize the middle of the data.  

Dot Plot 
A dot plot can be placed in the margin of the X axis. Dot plots emphasize the individual 
characteristics of the data values.  

Colors and Size Tab 
These options specify a background color for the whole plot (background) and for the data region 
(interior).  They also specify size and margins of the plot. 

Background 
This option specifies the background outline and fill color.  

Interior 
This option specifies the interior fill color. This is the color of the portion of the plot on which the 
data points are plotted. 

Size 
This option specifies the width and height (in pixels) of the interior area of the plot. The legend, 
border plots, tick marks, titles, and labels are added to the outside of this area. Thus, the total 
width and height of the plot cannot be specified.  

Margin 
This option a margin for each edge of the plot (in pixels). 

Painting Order Tab 
The options under this tab control the order in which items are placed on the plot. Items at the top 
of the list are placed on the plot first. They may be obscured the items that are plotted later.  

Example Data Tab 
Often you will need to set up the format of a histogram before the data is available. This option 
lets you see how your options appear on a set of random data. 

You control the number of data points and the data limits of the X variable.  

Pressing the New Data button generates a new set of random data. 
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validation, 500-10 

Cross-over (two means) - equivalence 
examples, 520-7 
validation, 520-10 

Cross-over (two means) - non- unity null 
validation, 513-8 

Cross-over (two means) - non- zero null 
examples, 508-7 
validation, 508-10 

Cross-over (two means) - non-inferiority 
examples, 510-7 
validation, 510-10 

Cross-over (two means) - ratio 
examples, 505-6 
validation, 505-8 

Crossover analysis 
mixed models, 571-1 

Cumulative scale 
histogram, 945-4 

CUSUM chart, 290-4 

D 
D’Agostino kurtosis, 670-2 
D’Agostino omnibus test, 670-3 
D’Agostino skewness test, 670-4 
Data 

histogram, 945-11 
scatter plot, 940-11 
simulation of, 920-1 

Data bars 
scatter plot, 940-11 

Data entry, 925-1 
Data simulation 

examples, 920-18 
Data simulator, 920-1 
Data tab, 4-6 
Data ticks 

scatter plot, 940-10 
Decimals 

histogram, 945-6 
scatter plot, 940-4 

Default template, 4-2 
D-efficiency 

D-optimal designs, 888-12 
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Density trace 
histogram, 945-3 

Design generator, 889-1 
examples, 889-3 

Design of experiments 
randomization lists, 880-1 

Designs 
Box-Behnken, 885-1 
central-composite, 885-1 
design generator, 889-1 
factorial, 881-2 
fractional factorial, 882-1 
Plackett-Burman, 886-1 
response surface, 885-1 
screening, 886-1 
Taguchi, 887-1 
two-level factorial, 881-1, 889-1 

Determinant 
D-optimal designs, 888-13 

Determinant analysis 
D-optimal designs, 888-11 

Diagnostic testing 
ROC curve (one), 260-1 

Difference 
proportions, 7-2 

Difference data 
simulation, 920-25 

Discordant pairs 
McNemar test, 150-2 

Distributions 
combining, 920-13 
mixing, 920-13 
simulation, 920-1 

Documentation 
printing, 1-7 

Donner and Klar 
cluster randomized design, 230-2 

D-optimal designs, 888-1 
examples, 888-8 

Dot plot 
histogram, 945-11 

Downloading updates, 1-2 
Drift 

survival - group sequential, 710-5 
two means - group sequential, 475-4 
two proportions - group sequential, 220-4 

Dunn’s test 
multiple contrasts - simulation, 590-3 

Dunnett’s test 
multiple comparisons, 575-3 

Dunnett's test 
simulation, 585-1, 585-3 

Dunn's test 
simulation, 590-1 

Duplicates 
D-optimal designs, 888-4 

E 
Edit menu 

output window, 5-5 
spreadsheet, 925-2 

Effect size, 6-5 
ANOVA, 560-2, 560-7 
chi-square estimator, 900-1 
chi-square test, 250-2 
multiple regression, 865-2 
one-way ANOVA, 550-3 
randomized block ANOVA, 565-2 

Efficacy boundaries, 221-1, 222-1, 223-1, 476-1, 477-
1, 478-1 

Efron’s biased coin randomization, 880-3 
Entering procedure options, 4-1 
Entering your serial number, 1-2 
Equivalence 

correlated proportions, 165-1 
means (two), 460-1 
means (two) - ratio, 470-1 
means (two) - simulation, 465-1 
one proportion, 110-1 
two proportions, 215-1 

Equivalence - two correlated proportions 
examples, 165-11 
validation, 165-14 

Equivalence hypothesis, 6-9 
Equivalence limits - paired means 

simulation, 495-9 
Equivalence test data 

simulating, 495-3 
Error rates - simulation 

multiple comparison, 580-1, 585-2 
multiple contrasts, 590-1 

Errors, 6-2 
EWMA chart limits, 290-5 
Exact binomial test 

one proportion, 100-4 
Example data 

histogram, 945-11 
scatter plot, 940-11 

Examples 
ANCOVA, 551-10 
balanced incomplete block designs, 883-3 
Chi-square estimator, 900-2 
Chi-square test, 250-6 
Cochran-Armitage test, 255-12 
control charts - means, 290-10 
control charts - variability, 295-8 
correlation (one) - confidence interval, 801-4 
Cox regression, 850-4 
cross-over - higher-order - equivalence, 540-9 
cross-over - higher-order - non- zero null, 528-8 
cross-over - higher-order - non-inferiority, 530-8 
cross-over - ratio - equivalence, 525-7 
cross-over - ratio - higher-order - equivalence, 545-

9 
cross-over - ratio - higher-order - non- zero null, 

533-9 
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cross-over - ratio - higher-order - non-inferiority, 
535-9 

cross-over - ratio - non-inferiority, 515-6 
cross-over - ratio - non-unity null, 513-6 
cross-over (two means), 500-7 
cross-over (two means) - equivalence, 520-7 
cross-over (two means) - non- zero null, 508-7 
cross-over (two means) - non-inferiority, 510-7 
cross-over (two means) - ratio, 505-6 
data simulation, 920-18 
design generator, 889-3 
D-optimal designs, 888-8 
equivalence - two correlated proportions, 165-11 
exponential mean (one), 405-8 
exponential means (two), 435-5 
fixed effects ANOVA, 560-13 
fractional factorial designs, 882-3 
intraclass correlation, 810-4 
kappa, 811-6 
Latin square designs, 884-4 
linear regression, 855-5 
logistic regression, 860-9 
logrank tests - non-inferiority, 706-7 
logrank tests (Lakatos), 715-15 
Mann-Whitney test, 430-16 
MANOVA, 605-12 
many proportions - trend, 255-12 
matched case-control - proportions, 155-6 
McNemar test - two correlated proportions, 150-7 
mean ratio - non- zero null, 453-6 
mean ratio - non-inferiority, 455-6 
microarray one-sample or paired t-test, 610-12 
microarray two-sample t-test, 615-12 
minimum effective dos, 595-4 
mixed models, 571-36 
multiple comparisons, 575-13 
multiple comparisons - simulation, 580-13 
multiple comparisons - vs control - simulation, 

585-12 
multiple contrasts - simulation, 590-14 
multiple regression, 865-6 
non-inferiority - two correlated proportions, 160-

10 
normality - simulation, 670-8 
odds ratio estimator, 910-2 
one coefficient alpha, 815-4 
one correlation, 800-4 
one mean - confidence interval, 420-5 
one mean - tolerance - confidence interval, 421-6 
one proportion, 100-13 
one proportion - confidence interval, 115-6 
one proportion - equivalence, 110-11 
one proportion - non-inferiority, 105-10 
one proportion - non-zero null, 103-10 
one sensitivity, 270-6 
one specificity, 270-6 
one standard deviation - confidence interval, 640-5 
one standard deviation - relative error - confidence 

interval, 642-4 
one standard deviation - tolerance - confidence 

interval, 641-6 

one variance - confidence interval, 651-4 
one variance - relative error - confidence interval, 

653-4 
one variance - tolerance - confidence interval, 652-

6 
one-way ANOVA, 550-10 
one-way ANOVA - simulation, 555-10 
paired means - confidence interval, 496-5 
paired means - tolerance - confidence interval, 

497-6 
paired sensitivities, 276-7 
Poisson mean (one), 412-4 
Poisson means (two), 437-7 
Poisson regression, 870-7 
post-marketing surveillance, 135-6 
proportions estimator, 910-2 
randomization lists, 880-9 
randomized block ANOVA, 565-9 
ratio of two means, 445-6 
ratio of two means - equivalence, 470-7 
regression - confidence interval, 856-7 
repeated measures - two means, 431-13 
repeated measures - two proportions, 201-16 
repeated measures ANOVA, 570-29 
response surface designs, 885-3 
ROC curve (one), 260-8 
ROC curves (two), 265-8 
screening designs, 886-3 
single-stage phase II trials, 120-3 
standard deviation estimator, 905-6 
survival - group sequential, 710-11, 711-27 
survival - logrank, 700-6 
survival - logrank - advanced, 705-8 
Taguchi designs, 887-4 
three-stage phase II trials, 130-8 
t-test (one mean), 400-8 
t-test (one mean) - non- zero null, 413-8 
t-test (one mean) - non-inferiority, 415-8 
t-test (one mean) - simulation, 410-10 
t-test (paired means) - equivalence - simulation, 

495-11 
t-test (paired means) - simulation, 490-11 
t-test (paired), 400-13, 485-8 
t-test (two means), 430-10 
t-test (two means) - simulation, 440-12 
two coefficient alphas, 820-6 
two correlated proportions - equivalence, 165-11 
two correlated proportions - non-inferiority, 160-

10 
two correlations, 805-5 
two means - cluster randomized, 480-4 
two means - confidence interval, 471-5 
two means - equivalence, 460-5 
two means - equivalence - simulation, 465-12 
two means - group sequential, 475-10, 476-17, 

477-15 
two means - non- zero null, 448-10 
two means - non-inferiority, 450-10 
two means – non-inferiority – group sequential, 

478-17 
two means - ratio, 445-6 
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two means - ratio - equivalence, 470-7 
two means - tolerance - confidence interval, 472-6 
two ordered categorical variables, 253-5 
two proportions - cluster - equivalence, 240-8 
two proportions - cluster - non-inferiority, 235-7 
two proportions - cluster - non-zero null, 233-7 
two proportions - cluster randomized, 230-9 
two proportions - confidence interval, 216-26 
two proportions - equivalence, 215-17 
two proportions - group sequential, 220-9, 221-18 
two proportions - inequality, 200-14 
two proportions - non-inferiority, 210-17 
two proportions – non-inferiority – group 

sequential, 223-22 
two proportions – non-zero null – group sequential, 

222-22 
two proportions - offset, 205-18 
two proportions - stratified design, 225-8 
two sensitivities, 275-9 
two-level designs, 881-6 
two-stage phase II trials, 125-8 
variance (one), 650-4 
variance ratio - confidence interval, 656-5 
variance ratio - relative error - confidence interval, 

657-4 
variances (two), 655-4 
Williams’ test, 595-4 

Exiting PASS, 4-3 
Experiment (run) 

two-level designs, 881-2 
Experimental design, 881-1 

two-level designs, 881-2 
Experimental error 

two-level designs, 881-2 
Experimentwise error rate 

simulation, 580-1, 585-2, 590-1 
Exponential 

logrank, 705-3 
log-rank, 715-2 

Exponential distribution 
simulation, 920-6 

Exponential mean (one), 405-1 
examples, 405-8 
validation, 405-10 

Exponential means (two), 435-1 
examples, 435-5 
validation, 435-7 

Exponential test 
simulation, 410-4 

Exposure 
Poisson regression, 870-1 

Exposure probability 
matched case-control, 155-4 

F 
F distribution 

probablility calculator, 915-3 
simulation, 920-7 

Factor scaling 
D-optimal designs, 888-2 

Factorial ANOVA, 560-1 
Factorial designs 

two-level designs, 881-1, 881-2 
False discovery rate adjustment 

t-test 
two groups, 615-4 

t-test - one group, 610-6 
Familywise error rate 

simulation, 580-1, 585-2, 590-1 
Farrington-Manning confidence interval 

two proportions, 216-5 
Farrington-Manning test 

two proportions - equivalence, 215-9 
two proportions - non-inferiority, 210-10 
two proportions - offset, 205-9 

Fast initial response, 290-4 
File menu 

output window, 5-2 
procedure window, 4-3 
spreadsheet, 925-2 

Finite population correction 
t test, 400-8, 485-8 

Finite population size 
one mean - confidence interval, 420-2 

FIR, 290-4 
Fisher's exact test 

two proportions, 200-4 
Fisher-z transformation 

two correlations, 805-1 
Fixed effects ANOVA 

examples, 560-13 
validation, 560-19 

Fixed effects models 
mixed models, 571-1 

Fixed factor 
ANOVA, 560-5 

Fleiss Confidence intervals 
two proportions, 216-12, 216-16 

Fleming algorithm 
single-stage phase II trials, 120-1 

Fleming-Harrington tests 
Group Sequential, 711-5 

Follow-up 
logrank, 705-4 

Font 
histogram, 945-4 
scatter plot, 940-2 

Forced points 
D-optimal designs, 888-5 

FPR 
ROC curve (one), 260-7 
ROC curves (two), 265-1 

Fractional factorial designs, 882-1 
examples, 882-3 

Freedman 
logrank, 700-1 

Frequency polygon 
histogram, 945-3 

 



Index-8 

F-test 
Geisser-Greenhouse, 570-4 
simulation, 555-1 
two variances, 655-1 

Futility boundaries, 221-1, 222-1, 223-1, 476-1, 477-
1, 478-1 

G 
Gallery, 5-2 
Games-Howell - simulation 

multiple comparison, 580-1 
Games-Howell test 

simulation, 580-3 
Gamma data 

simulation, 920-23 
Gamma distribution 

probablility calculator, 915-4 
simulation, 920-7 

Gart-Nam confidence interval 
two proportions, 216-7 

Gart-Nam test 
two proportions - equivalence, 215-10 
two proportions - non-inferiority, 210-11 
two proportions - offset, 205-10 

Gehan test 
Group Sequential, 711-5 

Geisser-Greenhouse 
repeated measures ANOVA, 570-1 

Geisser-Greenhouse F-test 
repeated measures ANOVA, 570-4 

General linear multivariate model 
MANOVA, 605-2 
repeated measures ANOVA, 570-3 

Generating data, 920-1 
Goodness of fit 

chi-square estimator, 900-1 
Chi-square test, 250-1 

Graeco-Latin square designs, 884-1 
Grid lines 

histogram, 945-7 
scatter plot, 940-5 

Group sequential test 
log-rank, 710-1, 711-1 
survival, 710-1, 711-1 
two means, 475-1, 476-1, 477-1 
two means – non-inferiority, 478-1 
two means – non-inferiority (simulation), 478-1 
two proportions, 220-1, 221-1 
two proportions – non-inferiority, 223-1 
two proportions – non-inferiority (simulation), 

223-1 
two proportions – non-zero null, 222-1 
two proportions – non-zero null (simulation), 222-

1 
two proportions (simulation), 221-1 

H 
Hazard rate 

Cox regression, 850-1 
Hazard rate conversion, 903-1 
Hazard rate parameterization 

logrank, 711-2, 715-2 
Hazard rates 

logrank, 700-2 
logrank - advanced, 705-2 
time dependent, 715-22 

Hazard ratio 
group sequential, 710-2 

Help menu 
output window, 5-7 
procedure window, 4-5 
spreadsheet, 925-3 

Help system, 1-3 
contents window, 1-5 
index window, 1-4 
navigating, 1-4 
printing documentation, 1-7 
search window, 1-6 

Heterogeneous variances 
mixed models, 571-47, 571-49 

Histogram 
alignment, 945-4 
axis, 945-3 
axis line, 945-5 
background color, 945-11 
bars, 945-1 
bin width, 945-2 
bins, 945-1 
border plots, 945-10 
boundaries, 945-3 
box plot, 945-11 
color, 945-11 
comments, 945-10 
corners, 945-4 
cumulative scale, 945-4 
data, 945-11 
decimals, 945-6 
density trace, 945-3 
dot plot, 945-11 
example data, 945-11 
font, 945-4 
frequency polygon, 945-3 
grid lines, 945-7 
interior lines, 945-1 
labels, 945-4 
layout, 945-4 
legend, 945-9 
lines, 945-10 
major ticks, 945-5 
maximum, 945-3 
minimum, 945-3 
minor ticks, 945-6 
normal density, 945-3 
notes, 945-10 
number bins, 945-2 

 



  Index-9 

painting order, 945-11 
scale, 945-4 
scaling, 945-2 
settings, 945-1 
size, 945-11 
text, 945-10 
ticks, 945-5 
titles, 945-8 

Histograms, 945-1 
Hotelling’s T2, 600-1 

validation, 600-11 
Hotelling’s T2 distribution 

probablility calculator, 915-4 
Hotelling-Lawley trace, 605-1 

MANOVA, 605-3 
repeated measures ANOVA, 570-1, 570-7 

Hypergeometric distribution 
probablility calculator, 915-4 

Hypergeometric model 
one proportion, 100-2 

Hypothesis 
equivalence, 6-9 
inequality, 6-7 
introduction, 6-1 
means, 8-1 
non-inferiority, 6-7 
superiority, 6-8 
types, 6-6 

Hypothesis testing 
introduction, 6-1 

I 
Icons 

output window, 5-8 
procedure window, 4-5 

Incidence rate 
post-marketing surveillance, 135-2 

Inclusion points 
D-optimal designs, 888-6 

Independence test, 250-1 
Inequality 

one proportion, 100-1 
two means ratio, 445-1 
two proportions, 200-1 
two proportions - offset, 205-1 

Inequality hypothesis, 6-7 
Installation, 1-1 
Interaction 

two-level designs, 881-3 
Intercept 

linear regression, 855-1 
Interim analysis 

survival, 710-1, 711-1 
three-stage trial, 130-1 
two means, 475-1, 476-1, 477-1 
two means – non-inferiority, 478-1 
two proportions, 220-1, 221-1 
two proportions – non-inferiority, 223-1 

two proportions – non-zero null, 222-1 
Interior lines 

histogram, 945-1 
Intraclass correlation, 810-1 

examples, 810-4 
validation, 810-6 

Intracluster correlation 
cluster randomization - two means, 480-3 
cluster randomized - non-inferiority, 235-4 
cluster randomized - non-zero null, 233-4 
cluster randomized design, 230-2 

Introduction to power analysis, 6-1 
Iterations 

maximum, 4-7 
Iterations tab, 4-7 

K 
Kappa 

examples, 811-6 
validation, 811-11 

Kappa test for rater agreement, 811-1 
Kenward and Roger method 

mixed models, 571-11 
Kolmogorov-Smirnov test, 670-2 
Kruskal-Wallis 

multiple comparisons - simulation, 580-1 
simulation, 555-1 

Kruskal-Wallis test 
multiple comparisons - simulation, 580-3, 585-1 
simulation, 585-3 

L 
Labels 

histogram, 945-4 
scatter plot, 940-2 

Lachin and Foulkes 
logrank test, 705-1 

Lakatos 
logrank, 715-1 

Lan-DeMets 
survival - group sequential, 710-1, 711-1 
two means - group sequential, 475-1 
two proportions - group sequential, 220-1 

Latin square 
ANOVA, 560-17 

Latin square designs, 884-1 
examples, 884-4 

Layout 
histogram, 945-4 
scatter plot, 940-2 

Legend 
histogram, 945-9 
parameter, 4-10 
scatter plot, 940-8 
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Likelihood ratio test 
two proportions, 200-7 

Likert-scale 
simulation, 410-21, 920-8 
simulation, 920-21 

Lilliefors' critical values 
normality tests, 670-2 

Linear model 
ANOVA, 560-2 
repeated measures ANOVA, 570-3 

Linear regression, 855-1 
confidence interval, 856-1 
examples, 855-5 
validation, 855-7 

Lines 
histogram, 945-10 
scatter plot, 940-10 

Loading a procedure, 2-3 
Log base 

scatter plot, 940-2 
Log transformation 

cross-over, 505-2 
cross-over - equivalence, 525-2 
cross-over - higher-order - equivalence, 545-4 
cross-over - higher-order - non- zero null, 533-4 
cross-over - higher-order - non-inferiority, 535-4 
cross-over - non-inferiority, 515-2 
cross-over - non-unity null, 513-2 
mean ratio, 445-2 
mean ratio - equivalence, 470-2 
mean ratio - non- zero null, 453-2 
mean ratio - non-inferiority, 455-2 

Logarithm 
scatter plot, 940-1 

Logistic regression, 860-1 
examples, 860-9 
validation, 860-14 

Logit 
logistic regression, 860-2 

Logrank 
hazard rate parameterization, 711-2, 715-2 
median survival time parameterization, 711-2, 715-

2 
mortality parameterization, 711-2, 715-2 
proportion surviving parameterization, 711-2, 715-

2 
Log-rank 

group sequential test, 710-1, 711-1 
Logrank procedure comparison, 715-3 
Logrank test, 700-1, 715-1 

Lachin and Foulkes, 705-1 
non-inferiority, 706-1 

Log-rank test 
Group Sequential, 711-5 

Logrank tests - non-inferiority 
examples, 706-7 
validation, 706-11 

Logrank tests (Lakatos) 
examples, 715-15 
validation, 715-21 

Longitudinal data models 
mixed models, 571-2 

Longitudinal models, 571-1 

M 
Macros, 930-1 

commands, 930-6 
examples, 930-18 
syntax, 930-2 

Major ticks 
histogram, 945-5 
scatter plot, 940-4 

Mann-Whitney test, 430-1 
assumptions, 430-4 
examples, 430-16 
group-sequential - simulation, 476-4, 477-4, 478-5 
non- zero null, 448-5 
non-inferiority, 450-5 
simulation, 440-5 

Mann-Whitney test - equivalence 
simulation, 465-5 

Mann-Whitney test - simulation 
equivalence, 465-1 

MANOVA, 605-1 
assumptions, 605-1 
examples, 605-12 
validation, 605-17 

Mantel Haenszel test 
two proportions, 200-7 

Mantel-Haenszel, 225-1 
Many proportions - trend 

examples, 255-12 
validation, 255-19 

Martinez-Iglewicz test, 670-3 
Matched case-control, 155-1 

post-marketing surveillance, 135-2 
Matched case-control - proportions 

examples, 155-6 
validation, 155-10 

Maximum 
histogram, 945-3 
scatter plot, 940-1 

Maximum iterations, 4-7 
Maximum likelihood 

mixed models, 571-8 
McNemar test, 150-1 
McNemar test - two correlated proportions 

examples, 150-7 
validation, 150-9 

Mean (one) 
confidence interval, 420-1 
control chart - simulation, 290-1 
exponential, 405-1 
Poisson, 412-1 
simulation, 410-1 

Mean (one) - confidence interval 
examples, 420-5 
validation, 420-7 

 



  Index-11 

Mean (one) - tolerance - confidence interval 
examples, 421-6 
validation, 421-8 

Mean (one) - tolerance probability 
confidence interval, 421-1 

Mean absolute deviation 
standard deviation estimator, 905-3 

Mean ratio 
equivalence, 470-1 
inequality, 445-1 

Means 
introduction, 8-1 
one-way - simulation, 555-1 

Means - ratio - equivalence 
cross-over, 525-1 

Means - ratio - non- zero null - higher-order 
cross-over, 533-1 

Means - ratio - non-inferiority 
cross-over, 515-1 

Means - ratio - non-inferiority - higher-order 
cross-over, 535-1 

Means - ratio - non-unity null 
cross-over, 513-1 

Means (paired) 
confidence interval, 496-1 
simulation, 490-1 

Means (paired) - confidence interval 
examples, 496-5 
validation, 496-6 

Means (paired) - equivalence 
simulation, 495-1 

Means (paired) - tolerance - confidence interval 
examples, 497-6 
validation, 497-8 

Means (paired) - tolerance probability 
confidence interval, 497-1 

Means (two) 
cluster randomized design, 480-1 
confidence interval, 471-1 
cross-over, 500-1 
equivalence, 460-1 
exponential, 435-1 
group sequential test, 475-1, 476-1, 477-1 
interim analysis, 475-1, 476-1, 477-1 
interim analysis – non-inferiority, 478-1 
non-inferiority, 450-1 
non-zero null, 448-1 
Poisson, 437-1 
ratio, 445-1 
simulation, 440-1 
T-test, 430-1 
t-test - equivalence, 460-1 
T-test - non-inferiority, 450-1 
T-test - non-zero null, 448-1 

Means (two) - cluster randomized design 
examples, 480-4 
validation, 480-6 

Means (two) - confidence interval 
examples, 471-5 
validation, 471-7 

Means (two) - equivalence 
cross-over, 520-1 
examples, 460-5 
validation, 460-7 

Means (two) - equivalence - higher-order 
cross-over, 540-1, 545-1 

Means (two) - equivalence - simulation 
examples, 465-12 
validation, 465-19 

Means (two) - group sequential 
examples, 475-10, 476-17, 477-15 
validation, 475-17, 476-28, 477-26 

Means (two) – non- inferiority – group sequential 
examples, 478-17 
validation, 478-28 

Means (two) - non- zero null 
cross-over, 508-1 
examples, 448-10 
validation, 448-13 

Means (two) - non- zero null - higher-order 
cross-over, 528-1 

Means (two) - non-inferiority 
cross-over, 510-1 
examples, 450-10 
validation, 450-13 

Means (two) - non-inferiority - higher-order 
cross-over, 530-1 

Means (two) - ratio 
cross-over, 505-1 
equivalence, 470-1 
non- zero null, 453-1 
non-inferiority, 455-1 

Means (two) - ratio - non- zero null 
examples, 453-6 
validation, 453-8 

Means (two) - ratio - non-inferiority 
examples, 455-6 
validation, 455-8 

Means (two) - simulation 
equivalence, 465-1 
t-test - equivalence, 465-1 

Means (two) - tolerance - confidence interval 
examples, 472-6 
validation, 472-8 

Means (two) - tolerance probability 
confidence interval, 472-1 

Means matrix 
MANOVA, 605-4 
repeated measures ANOVA, 570-7 

Measurement error 
randomized block ANOVA, 565-2 

Median survival time conversion, 903-1 
Median survival time parameterization 

logrank, 711-2, 715-2 
Menus 

output window, 5-2 
PASS home window, 3-2 
procedure window, 4-3 
spreadsheet, 925-2 
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Microarray data 
one sample t-test, 610-1 
paired T-test, 610-1 
two sample t-test, 615-1 

Microarray one-sample or paired t-test 
examples, 610-12 
validation, 610-19 

Microarray two-sample t-test 
examples, 615-12 
validation, 615-19 

Miettinen-Nurminen confidence interval 
two proportions, 216-6 

Miettinen-Nurminen test 
two proportions - equivalence, 215-7 
two proportions - non-inferiority, 210-8 
two proportions - offset, 205-7 

Minimum 
histogram, 945-3 
scatter plot, 940-1 

Minimum detectable difference 
mixed models, 571-14 
multiple comparisons, 575-11 
one-way ANOVA, 550-17 
t-test, 400-12 
two-sample t test, 430-14 

Minimum effective dose 
examples, 595-4 
validation, 595-7 

Minimum Effective Dose 
Williams’ Test, 595-1 

Minimum system requirements, 1-1 
Minor ticks 

histogram, 945-6 
scatter plot, 940-4 

Mixed model 
defined, 571-2 

Mixed models, 571-1 
differential evolution, 571-12 
examples, 571-36 
F test, 571-11 
Fisher scoring, 571-12 
fixed effects, 571-1 
G matrix, 571-5 
heterogeneous variances, 571-47, 571-49 
Kenward and Roger method, 571-11 
L matrix, 571-9 
likelihood formulas, 571-8 
maximum likelihood, 571-8 
minimum detectable difference, 571-14 
MIVQUE, 571-12 
Newton-Raphson, 571-12 
pairwise contrasts, 201-6, 431-7 
R matrix, 571-5 
restricted maximum likelihood, 571-9 
simulation steps, 571-17 
types, 571-1 
validation, 571-42 

Mixture data 
simulation, 920-24 

Mixture design 
D-optimal designs, 888-20 

Monte Carlo, 8-3 
Monte Carlo simulation, 920-1 
Mortality conversion, 903-1 
Mortality parameterization 

logrank, 711-2, 715-2 
MTBF 

exponential mean (one), 405-1 
Multinomial 

chi-square estimator, 900-3 
Multinomial distribution 

simulation, 920-8 
Multiple comparisons, 575-1 

Dunnett's test - simulation, 585-1 
examples, 575-13 
Games-Howell - simulation, 580-1 
pair-wise - simulation, 580-1 
validation, 575-19 
vs control - simulation, 585-1 
with a control, 575-2 
with best, 575-5 

Multiple comparisons - simulation 
examples, 580-13 
power, 580-4 
validation, 580-22 

Multiple comparisons - vs control - simulation 
examples, 585-12 
validation, 585-21 

Multiple contrasts 
simulation, 590-1 

Multiple contrasts - simulation 
examples, 590-14 
validation, 590-24 

Multiple regression, 865-1 
examples, 865-6 
validation, 865-10 

Multiple testing adjustment 
t-test - two groups, 615-2 
t-test -one group, 610-4 

Multivariate analysis of variance, 605-1 

N 
Navigating the help system, 1-4 
Navigation pane 

output window, 5-9 
Negative binomial distribution 

probablility calculator, 915-5 
Nested factors 

design generator, 889-1 
New template, 4-3 
Noncentrality 

one-way ANOVA, 550-3 
Noncentrality parameter 

one-way ANOVA, 550-4 
Non-inferiority 

correlated proportions, 160-1 
logrank, 705-13, 706-1 
means (two), 450-1 
means (two) - ratio, 455-1 
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one proportion, 105-1 
paired t-test, 415-1 
survival, 706-1 
two proportions, 210-1 

Non-inferiority - two correlated proportions 
examples, 160-10 
validation, 160-13 

Non-inferiority hypothesis, 6-7 
Non-Inferiority test (two means) 

simulation, 440-17 
Nonparametric 

t-test, 400-7, 485-7 
Nonparametric tests 

Wilcoxon test, 400-1 
Non-zero null 

means (two), 448-1 
means (two) - ratio, 453-1 
one proportion, 103-1 
paired t-test, 413-1 

Normal density 
histogram, 945-3 

Normal distribution 
probablility calculator, 915-5 
simulation, 920-9, 920-18 

Normality - simulation 
examples, 670-8 
validation, 670-11 

Normality tests, 670-1 
Anderson-Darling test, 670-2 
D’Agostino kurtosis, 670-2 
D’Agostino omnibus, 670-3 
D’Agostino skewness, 670-4 
Kolmogorov-Smirnov, 670-2 
Lilliefors' critical values, 670-2 
Martinez-Iglewicz, 670-3 
range, 670-4 
Shapiro-Wilk, 670-4 

Notes 
histogram, 945-10 
scatter plot, 940-10 

Nuisance parameter, 8-2 
Nuisance parameters, 6-6 
Null hypothesis, 6-1, 8-1 
Number bins 

histogram, 945-2 

O 
O’Brien-Fleming 

survival - group sequential, 710-1, 711-1 
two means - group sequential, 475-1 
two proportions - group sequential, 220-1 

Odds ratio 
logistic regression, 860-2 
matched case-control, 155-1 
McNemar test, 150-3 
one proportion, 100-6 
proportions, 7-3 
two proportions, 200-3 

Odds ratio estimator, 910-1 
examples, 910-2 

One proportion 
equivalence, 110-1 
inequality, 100-1 
non-inferiority, 105-1 
non-zero null, 103-1 
superiority, 103-1 

One-sample t-test 
microarray data, 610-1 

One-way ANOVA, 550-1 
examples, 550-10 
simulation, 555-1 
validation, 550-19 

One-way ANOVA - simulation 
examples, 555-10 
validation, 555-16 

Open example template, 4-3 
Open template, 4-3 
Operating system, 1-1 
Ordered categorical variables (two), 253-1 

examples, 253-5 
validation, 253-10 

Orthogonal arrays, 887-1 
Orthogonal sets of Latin squares, 884-2 
Outliers 

multiple comparisons - simulation, 580-23 
one-way ANOVA - simulation, 555-18 

Outliers (two means) 
simulation, 440-19 

Output, 2-5 
Output Gallery, 5-2 
Output window, 5-1 

bottom bar, 5-10 
edit menu, 5-5 
file menu, 5-2 
help menu, 5-7 
navigation pane, 5-9 
toolbar, 5-8 
view menu, 5-4 
window menu, 5-7 

P 
P value, 6-4 
Painting order 

histogram, 945-11 
scatter plot, 940-11 

Paired design 
microarray data, 610-1 

Paired designs 
non- zero null, 413-1 
non-inferiority, 415-1 

Paired distributions 
simulating, 490-2 

Paired means 
simulation, 490-1 

Paired means - equivalence 
simulation, 495-1 
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Paired proportions 
equivalence, 165-1 
non-inferiority, 160-1 

Paired t-test, 400-1, 485-1 
assumptions, 400-3, 485-3 
microarray data, 610-1 
non- zero null, 413-1 
non-inferiority, 415-1 
superiority, 413-1 

Pairwise comparisons 
multiple comparisons, 575-7 

Pair-wise comparisons 
simulation, 580-1 

Pairwise contrasts 
mixed models, 201-6 

Pairwise contrasts 
mixed models, 431-7 

Panel, 4-1 
Parameters 

abbreviations, 4-10 
axis, 4-10 
entering, 4-6 
legend, 4-10 

PASS help system, 1-3 
PASS home window, 3-1 

Category Tree, 3-4 
Find, 3-5 
Menus, 3-2 
Procedure list, 3-5 
Search, 3-5 
toolbar, 3-3 

Patient entry 
logrank, 705-3 

Peto-Peto test 
Group Sequential, 711-5 

Phase I trials 
definition, 120-1 

Phase II clinical trials 
single-stage one proportion, 120-1 
three-stage one proportion, 130-1 
two-stage one proportion, 125-1 

Phase II trials 
definition, 120-1 

Pillai-Bartlett trace, 605-1 
MANOVA, 605-3 
repeated measures ANOVA, 570-1, 570-6 

Plackett-Burman designs, 886-1 
Planned comparisons 

ANCOVA, 551-1 
one-way ANOVA, 550-1 

Plot setup tab, 4-9 
Pocock 

survival - group sequential, 710-1, 711-1 
two means - group sequential, 475-1 
two proportions - group sequential, 220-1 

Poisson distribution 
probablility calculator, 915-5 
simulation, 920-9 

Poisson incidence 
post-marketing surveillance, 135-1 

Poisson mean (one), 412-1 

examples, 412-4 
validation, 412-9 

Poisson means (two), 437-1 
examples, 437-7 
validation, 437-10 

Poisson regression, 870-1 
examples, 870-7 
validation, 870-9 

Population size 
t-test, 400-8, 485-8 

Post-marketing surveillance, 135-1 
examples, 135-6 
validation, 135-8 

Power 
calculating, 6-4 
introduction, 6-1 
means, 8-1 
multiple comparisons - simulation, 580-4 

Prevalence 
correlated proportions, 160-2, 165-2 

Printing documentation, 1-7 
Printing output, 5-4, 5-8 
Probability calculator, 915-1 

Beta distribution, 915-1 
Binomial distribution, 915-2 
Bivariate normal distribution, 915-2 
Chi-square distribution, 915-2 
Correlation coefficient distribution, 915-3 
F distribution, 915-3 
Gamma distribution, 915-4 
Hotelling’s T2 distribution, 915-4 
Hypergeometric distribution, 915-4 
Negative binomial distribution, 915-5 
Normal distribution, 915-5 
Poisson distribution, 915-5 
Student’s t distribution, 915-6 
Studentized range distribution, 915-6 
Weibull distribution, 915-6 

Procedure menus 
procedure window, 4-4 

Procedure options, 4-1 
Procedure window, 4-1 

file menu, 4-3 
help menu, 4-5 
procedure menus, 4-4 
run menu, 4-4 
tabs, 4-6 
toolbar, 4-5 
tools menu, 4-4 
view menu, 4-4 
window menu, 4-4 

Producer’s risk 
exponential mean (one), 405-2 

Program updates, 1-2 
Proportion (one) 

binomial model, 100-2, 270-2 
confidence interval, 115-1 
continuity correction, 100-5 
equivalence, 110-1 
exact binomial test, 100-4 
examples, 100-13 
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hypergeometric model, 100-2 
inequality, 100-1 
non-inferiority, 105-1 
odds ratio, 100-6 
saw-tooth power function, 100-16 
single-stage phase II trials, 120-1 
superiority, 103-1 
three-stage phase II trials, 130-1 
two-stage phase II trials, 125-1 
validation, 100-20 
Z test, 100-4 

Proportion (one) - confidence interval 
examples, 115-6 
validation, 115-9 

Proportion (one) - equivalence 
examples, 110-11 
validation, 110-17 
Z test, 110-6 

Proportion (one) - non-inferiority 
examples, 105-10 
validation, 105-16 

Proportion (one) - non-zero null 
examples, 103-10 
validation, 103-14 

Proportion surviving parameterization 
logrank, 711-2, 715-2 

Proportion trend test, 255-1 
Proportional hazards regression, 850-1 
Proportions 

comparing, 7-1 
difference, 7-2 
interpretation, 7-3 
introduction, 7-1 
logistic regression, 860-1 
odds ratio, 7-3 
odds ratio estimator, 910-1 
paired (equivalence), 165-1 
paired (non-inferiority), 160-1 
ratio, 7-2 

Proportions (many) 
trend, 255-1 

Proportions (many) - trend 
examples, 255-12 
validation, 255-19 

Proportions (multiple) 
Chi-square test, 250-1 

Proportions (two) 
Chi-square test, 200-5, 223-6 
cluster randomized - equivalence, 240-1 
cluster randomized - non-inferiority, 235-1 
cluster randomized – non-zero null, 233-1 
cluster randomized design, 230-1 
confidence intervals, 216-1 
equivalence, 215-1 
Fisher's exact, 200-4 
group sequential test, 220-1, 221-1 
group sequential test – non-inferiority, 223-1, 478-

1 
group sequential test – non-zero null, 222-1 
independent, 200-1 
independent - equivalence, 215-1 

independent - non-inferiority & superiority, 210-1 
independent - offset, 205-1 
inequality, 200-1 
inequality - offset, 205-1 
interim analysis, 220-1, 221-1 
interim analysis – non-inferiority, 223-1 
interim analysis – non-zero null, 222-1 
matched case control, 155-1 
McNemar test, 150-1 
non-inferiority & superiority, 210-1 
stratified, 225-1 

Proportions (two) - cluster - equivalence 
examples, 240-8 
validation, 240-12 

Proportions (two) - cluster - non-inferiority 
examples, 235-7 
validation, 235-11 

Proportions (two) - cluster - non-zero null 
examples, 233-7 
validation, 233-11 

Proportions (two) - cluster randomized design 
examples, 230-9 
validation, 230-17 

Proportions (two) - confidence interval 
examples, 216-26 
validation, 216-28 

Proportions (two) - equivalence 
examples, 215-17 
validation, 215-23 

Proportions (two) - group sequential 
examples, 220-9, 221-18 
validation, 220-17, 221-29 

Proportions (two) - inequality 
examples, 200-14 
validation, 200-19 

Proportions (two) – non- inferiority – group sequential 
examples, 223-22 
validation, 223-33 

Proportions (two) - non-inferiority 
examples, 210-17 
validation, 210-24 

Proportions (two) – non-zero null – group sequential 
examples, 222-22 
validation, 222-33 

Proportions (two) - offset 
examples, 205-18 
validation, 205-24 

Proportions (two) - stratified design 
examples, 225-8 
validation, 225-11 

Proportions (two) correlated 
equivalence, 165-1 
non-inferiority, 160-1 

Proportions estimator, 910-1 
examples, 910-2 
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Q 
Qualitative factors 

D-optimal designs, 888-5 
Quitting PASS, 4-3 

R 
Random assignment, 880-1 
Random effects models, 571-1 

mixed models, 571-2 
Random factor 

ANOVA, 560-5 
Random numbers, 920-1 

multiple comparisons - simulation, 580-5 
simulation, 585-5, 590-5 

Random sorting, 880-3 
Random sorting using max % deviation, 880-5 
Randomization 

complete, 880-3 
Efron’s biased coin, 880-3 
Latin square designs, 884-2 
random sorting, 880-3 
random sorting using max % deviation, 880-5 
Smith, 880-4 
Wei’s urn, 880-4 

Randomization lists, 880-1 
examples, 880-9 

Randomized block ANOVA, 565-1 
examples, 565-9 
validation, 565-11 

Randomized block design 
design generator, 889-5 

Range test, 670-4 
Rater agreement - kappa, 811-1 
Rating data 

ROC curve (one), 260-4 
ROC curves (two), 265-3 

Ratio 
proportions, 7-2 
two means, 445-1 
two means - equivalence, 470-1 

Ratio (two means) 
non- zero null, 453-1 
non-inferiority, 455-1 

Ratio of two means 
examples, 445-6 
validation, 445-8 

Ratio of two means - equivalence 
examples, 470-7 
validation, 470-9 

Ratio -two means 
cross-over, 505-1 

Regression 
confidence interval, 856-1 
Cox, 850-1 
linear, 855-1 
logistic, 860-1 

multiple, 865-1 
Poisson, 870-1 

Regression - confidence interval 
examples, 856-7 
validation, 856-10 

Rejection region, 6-3 
Repeated measures 

mixed models, 571-1 
two means, 431-1 
two proportions, 201-1 

Repeated measures - two means 
examples, 431-13 
validation, 431-19 

Repeated measures - two proportions 
examples, 201-16 
validation, 201-24 

Repeated measures ANOVA, 570-1 
examples, 570-29 
validation, 570-49 

Repeated measures design 
design generator, 889-6 

Replication 
two-level designs, 881-3 

Reports tab, 4-8 
Requirements, 1-1 
Resetting a template, 4-3 
Response surface designs, 885-1 

examples, 885-3 
Restricted maximum likelihood 

mixed models, 571-9 
Risk ratio 

Blackwelder, 205-26 
ROC curve (one), 260-1 

examples, 260-8 
validation, 260-12 

ROC curves (two), 265-1 
examples, 265-8 
validation, 265-13 

R-squared 
logistic regression, 860-7 
multiple regression, 865-1 

RTF files, 5-1 
Ruler, 5-4 
Run menu 

procedure window, 4-4 
Running PASS, 2-1 

S 
Sample size 

introduction, 6-1 
Save template, 4-3 
Saw-tooth power function 

one proportion, 100-16 
Scale 

histogram, 945-4 
scatter plot, 940-1 

Scaling 
histogram, 945-2 
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Scaling factors 
D-optimal designs, 888-2 

Scatter plot 
alignment, 940-2 
axis, 940-1 
axis line, 940-3 
background color, 940-11 
bars, 940-11 
boundaries, 940-1 
color, 940-11 
comments, 940-10 
connecting points, 940-10 
corners, 940-1 
data, 940-11 
data bars, 940-11 
data ticks, 940-10 
decimals, 940-4 
example data, 940-11 
font, 940-2 
grid lines, 940-5 
labels, 940-2 
layout, 940-2 
legend, 940-8 
lines, 940-10 
log base, 940-2 
logarithm, 940-1 
major ticks, 940-4 
maximum, 940-1 
minimum, 940-1 
minor ticks, 940-4 
notes, 940-10 
painting order, 940-11 
scale, 940-1 
settings, 940-1 
size, 940-11 
symbols, 940-6, 940-10 
text, 940-10 
ticks, 940-3, 940-10 
titles, 940-7 
trend lines, 940-10 

Score test 
two proportions - equivalence, 215-7 
two proportions - non-inferiority, 210-8 
two proportions - offset, 205-7 

Screening designs, 886-1 
examples, 886-3 

Search 
PASS home window, 3-5 

Sensitivities (paired) 
examples, 276-7 
validation, 276-11 

Sensitivities (two) 
examples, 275-9 
validation, 275-13 

Sensitivity 
correlated proportions, 160-2, 165-2 
one-sample, 270-1 
paired, 276-1 
ROC curve (one), 260-1 
two-sample, 275-1 

Sensitivity (one) 
examples, 270-6 
validation, 270-11 

Serial number, 1-2 
Settings 

histogram, 945-1 
Shapiro-Wilk test, 670-4 
Sign test 

simulation, 410-3 
Sign test - paired means 

simulation, 490-4 
Sign test - paired means - equivalence 

simulation, 495-5 
Significance boundaries, 221-1, 222-1, 223-1, 476-1, 

477-1, 478-1 
Significance level, 6-3 

adjusting, 8-5 
Significance level - simulation 

multiple comparisons, 580-1, 585-2 
multiple contrasts, 590-1 

Simon 
two-stage phase II trials, 125-1 

Simple linear regression 
confidence interval, 856-1 

Simulation, 8-3, 920-1 
Beta distribution, 920-3 
Binomial distribution, 920-5 
Cauchy distribution, 920-5 
Constant distribution, 920-6 
contaminated normal, 920-19 
Exponential distribution, 920-6 
F distribution, 920-7 
Gamma distribution, 920-7 
Likert-scale, 920-8, 920-21 
Multinomial distribution, 920-8 
multiple comparisons, 580-1, 580-5, 585-1, 585-4 
multiple contrasts, 590-1, 590-4 
Normal distribution, 920-9, 920-18 
normality tests, 670-1 
one mean, 410-1 
one mean – control chart, 290-1 
one-way ANOVA, 555-1 
paired means, 490-1 
paired means - equivalence, 495-1 
Poisson distribution, 920-9 
random number generation, 580-5, 585-5, 590-5 
size, 8-3 
skewed distribution, 920-10 
Student's T distribution, 920-10 
syntax, 920-13 
T distribution, 920-10 
Tukey's lambda distribution, 920-10 
two means, 440-1 
two means - equivalence, 465-1 
Uniform distribution, 920-11 
variability – control chart, 295-1 
Weibull distribution, 920-12 

Simulation steps 
mixed models, 571-17 

Single-stage design 
one proportion, 120-1 
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Single-stage phase II trials 
examples, 120-3 
validation, 120-3 

Size 
histogram, 945-11 
scatter plot, 940-11 

Skewed data 
one-way ANOVA - simulation, 555-20 
simulation, 410-12 

Skewed data (two means) 
simulation, 440-20 

Skewed distribution 
simulation, 920-10 

Skewness test, 670-4 
Slope 

linear regression, 855-1 
Slope - simple linear regression 

confidence interval, 856-1 
Smith’s randomization, 880-4 
Specificity 

correlated proportions, 160-2, 165-2 
one-sample, 270-1 
ROC curve (one), 260-1 

Specificity (one) 
examples, 270-6 
validation, 270-11 

Spending functions 
survival - group sequential, 710-3 
two means - group sequential, 475-2, 476-5, 477-4 
two proportions - group sequential, 220-2, 221-7 
two proportions - group sequential – non-zero null, 

222-10, 223-10 
Split plot analysis 

mixed models, 571-1 
Spreadsheet, 925-1 

edit menu, 925-2 
file menu, 925-2 
help menu, 925-3 
menus, 925-2 

Standard deviation, 8-2 
estimator, 905-1 
interpretation, 905-1 

Standard deviation (one) 
confidence interval, 640-1 

Standard deviation (one) - confidence interval 
examples, 640-5 
validation, 640-7 

Standard deviation (one) - relative error 
confidence interval, 642-1 

Standard deviation (one) - relative error - confidence 
interval 
examples, 642-4 
validation, 642-6 

Standard deviation (one) - tolerance - confidence 
interval 
examples, 641-6 
validation, 641-8 

Standard deviation (one) - tolerance probability 
confidence interval, 641-1 

Standard deviation estimator 
examples, 905-6 

Standard deviation of means estimator, 912-1 
Standard deviation test 

one, 650-1 
two, 655-1 

Starting PASS, 1-2, 2-1 
Stratified designs 

two proportions, 225-1 
Student’s t distribution 

probablility calculator, 915-6 
Studentized range distribution 

probablility calculator, 915-6 
Student's T distribution 

simulation, 920-10 
Superiority 

one proportion, 103-1 
paired t-test, 413-1 
two proportions, 210-1 

Superiority hypothesis, 6-8 
Survival 

logrank, 700-1, 715-1 
logrank - Lachin and Foulkes, 705-1 
non-inferiority, 706-1 

Survival - group sequential 
examples, 710-11, 711-27 
validation, 710-18, 711-40 

Survival - logrank 
examples, 700-6 
validation, 700-9 

Survival - logrank - Lachin and Foulkes 
examples, 705-8 
validation, 705-12 

Survival Parameter Conversion Tool, 903-1 
Symbols 

scatter plot, 940-6, 940-10 
Syntax 

macros, 930-2 
System requirements, 1-1 

T 
T distribution 

simulation, 920-10 
T test 

two proportions - equivalence, 215-7 
two proportions - non-inferiority, 210-8 

T2 
Hotelling’s, 600-1 

Tabs 
data, 4-6 
iterations, 4-7 
plot setup, 4-9 
reports, 4-8 

Tabs on the procedure window, 4-6 
Taguchi designs, 887-1 

examples, 887-4 
Tarone-Ware test 

Group Sequential, 711-5 
Technical support, 1-9 
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Templates, 4-1 
automatic, 4-2 
creating a new, 4-3 
default, 4-2 
loading, 4-3 
loading examples, 4-3 
opening, 4-3 
opening examples, 4-3 
saving, 4-3 

Test statistics, 6-6 
Text 

histogram, 945-10 
scatter plot, 940-10 

Three-stage design 
one proportion, 130-1 

Three-stage phase II trials 
examples, 130-8 
validation, 130-8 

Ticks 
histogram, 945-5 
scatter plot, 940-3, 940-10 

Time averaged difference 
binary data, 201-1 
normal data, 431-1 
power for, 201-2, 431-2 
two means, 431-1 
two proportions, 201-1 

Titles 
histogram, 945-8 
scatter plot, 940-7 

Toolbar 
output window, 5-8 
PASS home window, 3-3 
procedure window, 4-5 

Tools menu 
procedure window, 4-4 

Trend in proportions, 255-1 
Trend lines 

scatter plot, 940-10 
Trimmed t-test (two means) 

simulation, 440-4 
Trimmed t-test (two means) - equivalence 

simulation, 465-4 
T-test 

cross-over, 500-3 
microarray data, 610-1, 615-1 
one group - multiple testing adjustment, 610-4 
one mean, 400-1 
one mean - simulation, 410-1 
paired, 400-1, 485-1 
paired - equivalence - simulation, 495-1 
paired - simulation, 490-1 
two groups - multiple testing adjustment, 615-2 
two means, 430-1 
two means - equivalence, 460-1 
two means - non-inferiority, 450-1 
two means - non-zero null, 448-1 
two means - simulation, 440-1 
two proportions, 200-8, 223-6 

T-test - equivalence 
cross-over, 520-3 

T-test - simulation 
two means - equivalence, 465-1 

T-test (one mean) 
assumptions, 400-3 
examples, 400-8 
non-inferiority, 415-1 
non-zero null, 413-1 
superiority, 413-1 
validation, 400-17 

T-test (one mean) - non- zero null 
examples, 413-8 
validation, 413-10 

T-test (one mean) - non-inferiority 
examples, 415-8 
validation, 415-11 

T-test (one mean) - simulation 
examples, 410-10 
validation, 410-16 

T-test (paired means) - equivalence - simulation 
examples, 495-11 
validation, 495-17 

T-test (paired means) - simulation 
examples, 490-11 
validation, 490-16 

T-test (paired) 
examples, 400-13, 485-8 
validation, 485-10 

T-test (two means) 
assumptions, 430-3 
examples, 430-10 
validation, 430-18 

T-test (two means) - simulation 
examples, 440-12 
validation, 440-16 

Tukey-Kramer 
simulation, 580-1 

Tukey-Kramer test 
multiple comparisons, 575-7 
simulation, 580-3 

Tukey's lambda distribution 
simulation, 920-10 

Two correlated proportions - equivalence 
examples, 165-11 
validation, 165-14 

Two correlated proportions - non-inferiority 
examples, 160-10 
validation, 160-13 

Two means 
cluster randomized design, 480-1 
cross-over, 500-1 

Two means - cluster randomized design 
examples, 480-4 
validation, 480-6 

Two means - equivalence 
cross-over, 520-1 
examples, 460-5 
validation, 460-7 

Two means - equivalence - higher-order 
cross-over, 540-1, 545-1 
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Two means - equivalence - simulation 
examples, 465-12 
validation, 465-19 

Two means - group sequential 
examples, 475-10, 476-17, 477-15 
validation, 475-17, 476-28, 477-26 

Two means – non- inferiority – group sequential 
examples, 478-17 
validation, 478-28 

Two means - non- zero null 
cross-over, 508-1 
examples, 448-10 
validation, 448-13 

Two means - non- zero null - higher-order 
cross-over, 528-1 

Two means - non-inferiority 
cross-over, 510-1 
examples, 450-10 
validation, 450-13 

Two means - non-inferiority - higher-order 
cross-over, 530-1 

Two means - ratio 
cross-over, 505-1 
examples, 445-6 
validation, 445-8 

Two means - ratio - equivalence 
cross-over, 525-1 
examples, 470-7 
validation, 470-9 

Two means - ratio - non- zero null - higher-order 
cross-over, 533-1 

Two means - ratio - non-inferiority 
cross-over, 515-1 

Two means - ratio - non-inferiority - higher-order 
cross-over, 535-1 

Two means - ratio - non-unity null 
cross-over, 513-1 

Two means (ratio) - non- zero null 
examples, 453-6 
validation, 453-8 

Two means (ratio) - non-inferiority 
examples, 455-6 
validation, 455-8 

Two ordered categorical variables, 253-1 
examples, 253-5 
validation, 253-10 

Two proportions 
cluster randomized - equivalence, 240-1 
cluster randomized - non-inferiority, 235-1 
cluster randomized - non-zero null, 233-1 
cluster randomized design, 230-1 
equivalence, 215-1 
inequality, 200-1 
inequality - offset, 205-1 
matched case-control, 155-1 
McNemar test, 150-1 
non-inferiority & superiority, 210-1 

Two proportions - cluster - equivalence 
examples, 240-8 
validation, 240-12 

Two proportions - cluster - non-inferiority 
examples, 235-7 
validation, 235-11 

Two proportions - cluster - non-zero null 
examples, 233-7 
validation, 233-11 

Two proportions - cluster randomized design 
examples, 230-9 
validation, 230-17 

Two proportions - equivalence 
examples, 215-17 
validation, 215-23 

Two proportions - group sequential 
examples, 220-9, 221-18 
validation, 220-17, 221-29 

Two proportions - inequality 
examples, 200-14 
validation, 200-19 

Two proportions – non- inferiority – group sequential 
examples, 223-22 
validation, 223-33 

Two proportions - non-inferiority 
examples, 210-17 
validation, 210-24 

Two proportions – non-zero null – group sequential 
examples, 222-22 
validation, 222-33 

Two proportions - offset 
examples, 205-18 
validation, 205-24 

Two proportions - stratified design 
examples, 225-8 
validation, 225-11 

Two-channel arrays, 610-1 
Two-level designs, 881-1 

examples, 881-6 
Two-level factorial designs, 881-1 
Two-sample t-test, 430-1 

equivalence, 460-1 
microarray data, 615-1 
non-inferiority, 450-1 
non-zero null, 448-1 

Two-sample t-test - simulation 
equivalence, 465-1 

Two-stage design 
one proportion, 125-1 

Two-stage phase II trials 
examples, 125-8 
validation, 125-10 

Type-I error, 6-2 
Type-II error, 6-2 

U 
Uniform distribution 

simulation, 920-11 
Updates, 1-2 
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V 
Validation 

ANCOVA, 551-14 
Chi-square test, 250-9 
Cochran-Armitage test, 255-19 
control charts - means, 290-14 
control charts - variability, 295-11 
correlation (one) - confidence interval, 801-7 
Cox regression, 850-6 
cross-over - higher-order - equivalence, 540-12 
cross-over - higher-order - non- zero null, 528-11 
cross-over - higher-order - non-inferiority, 530-11 
cross-over - ratio - equivalence, 525-9 
cross-over - ratio - higher-order - equivalence, 545-

12 
cross-over - ratio - higher-order - non- zero null, 

533-12 
cross-over - ratio - higher-order - non-inferiority, 

535-12 
cross-over - ratio - non-inferiority, 515-8 
cross-over (two means), 500-10 
cross-over (two means) - equivalence, 520-10 
cross-over (two means) - non- unity null, 513-8 
cross-over (two means) - non- zero null, 508-10 
cross-over (two means) - non-inferiority, 510-10 
cross-over (two means) - ratio, 505-8 
equivalence - two correlated proportions, 165-14 
exponential mean (one), 405-10 
exponential means (two), 435-7 
fixed effects ANOVA, 560-19 
Hotelling’s T2, 600-11 
intraclass correlation, 810-6 
kappa, 811-11 
linear regression, 855-7 
logistic regression, 860-14 
logrank tests - non-inferiority, 706-11 
logrank tests (Lakatos), 715-21 
MANOVA, 605-17 
many proportions - trend, 255-19 
matched case-control - proportions, 155-10 
McNemar test - two correlated proportions, 150-9 
mean ratio - non- zero null, 453-8 
mean ratio - non-inferiority, 455-8 
microarray one-sample or paired t-test, 610-19 
microarray two-sample t-test, 615-19 
minimum effective dos, 595-7 
mixed models, 571-42 
multiple comparisons, 575-19 
multiple comparisons - simulation, 580-22 
multiple comparisons - vs control - simulation, 

585-21 
multiple contrasts - simulation, 590-24 
multiple regression, 865-10 
non-inferiority - two correlated proportions, 160-

13 
normality - simulation, 670-11 
one coefficient alpha, 815-7 
one correlation, 800-7 
one mean - confidence interval, 420-7 

one mean - tolerance - confidence interval, 421-8 
one proportion, 100-20 
one proportion - confidence interval, 115-9 
one proportion - equivalence, 110-17 
one proportion - non-inferiority, 105-16 
one proportion - non-zero null, 103-14 
one sensitivity, 270-11 
one specificity, 270-11 
one standard deviation - confidence interval, 640-7 
one standard deviation - relative error - confidence 

interval, 642-6 
one standard deviation - tolerance - confidence 

interval, 641-8 
one variance - confidence interval, 651-6 
one variance - relative error - confidence interval, 

653-6 
one variance - tolerance - confidence interval, 652-

8 
one-way ANOVA, 550-19 
one-way ANOVA - simulation, 555-16 
paired means - confidence interval, 496-6 
paired means - tolerance - confidence interval, 

497-8 
paired sensitivities, 276-11 
Poisson mean (one), 412-9 
Poisson means (two), 437-10 
Poisson regression, 870-9 
post-marketing surveillance, 135-8 
randomized block ANOVA, 565-11 
ratio of two means, 445-8 
ratio of two means - equivalence, 470-9 
regression - confidence interval, 856-10 
repeated measures - two means, 431-19 
repeated measures - two proportions, 201-24 
repeated measures ANOVA, 570-49 
ROC curve (one), 260-12 
ROC curves (two), 265-13 
single-stage phase II trials, 120-3 
survival - group sequential, 710-18, 711-40 
survival - logrank, 700-9 
survival - logrank - Lachin and Foulkes, 705-12 
three-stage phase II trials, 130-8 
t-test (one mean), 400-17 
t-test (one mean) - non- zero null, 413-10 
t-test (one mean) - non-inferiority, 415-11 
t-test (one mean) - simulation, 410-16 
t-test (paired means) - equivalence - simulation, 

495-17 
t-test (paired means) - simulation, 490-16 
t-test (paired), 485-10 
t-test (two means), 430-18 
t-test (two means) - simulation, 440-16 
two coefficient alphas, 820-10 
two correlated proportions - equivalence, 165-14 
two correlated proportions - non-inferiority, 160-

13 
two correlations, 805-8 
two means - cluster randomized, 480-6 
two means - confidence interval, 471-7 
two means - equivalence, 460-7 
two means - equivalence - simulation, 465-19 
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two means - group sequential, 475-17, 476-28, 
477-26 

two means - non- zero null, 448-13 
two means - non-inferiority, 450-13 
two means – non-inferiority – group sequential, 

478-28 
two means - ratio, 445-8 
two means - ratio - equivalence, 470-9 
two means - tolerance - confidence interval, 472-8 
two ordered categorical variables, 253-10 
two proportions - cluster - equivalence, 240-12 
two proportions - cluster - non-inferiority, 235-11 
two proportions - cluster - non-zero null, 233-11 
two proportions - cluster randomized, 230-17 
two proportions - confidence interval, 216-28 
two proportions - equivalence, 215-23 
two proportions - group sequential, 220-17, 221-29 
two proportions - inequality, 200-19 
two proportions – non- inferiority – group 

sequential, 223-33 
two proportions - non-inferiority, 210-24 
two proportions – non-zero null – group sequential, 

222-33 
two proportions - offset, 205-24 
two proportions - stratified design, 225-11 
two sensitivities, 275-13 
two-stage phase II trials, 125-10 
variance (one), 650-7 
variance ratio - confidence interval, 656-8 
variance ratio - relative error - confidence interval, 

657-6 
variances (two), 655-8 
Williams’ test, 595-7 

Variance (one) 
confidence interval, 651-1 
examples, 650-4 
validation, 650-7 

Variance (one) - confidence interval 
examples, 651-4 
validation, 651-6 

Variance (one) - relative error 
confidence interval, 653-1 

Variance (one) - relative error - confidence interval 
examples, 653-4 
validation, 653-6 

Variance (one) - tolerance - confidence interval 
examples, 652-6 
validation, 652-8 

Variance (one) - tolerance probability 
confidence interval, 652-1 

Variance ratio 
confidence interval, 656-1 

Variance ratio - confidence interval 
examples, 656-5 
validation, 656-8 

Variance ratio - relative error 
confidence interval, 657-1 

Variance ratio - relative error - confidence interval 
examples, 657-4 
validation, 657-6 

Variance test 

one, 650-1 
two, 655-1 

Variances (two) 
examples, 655-4 
validation, 655-8 

View menu 
output window, 5-4 
procedure window, 4-4 

Viewing output, 2-5 

W 
Walter’s confidence intervals 

two proportions, 216-11 
Wei’s urn randomization, 880-4 
Weibull distribution 

probablility calculator, 915-6 
simulation, 920-12 

Welch test 
multiple contrasts - simulation, 590-4 

Welch's test - simulation 
equivalence, 465-1 

Welch's t-test 
non- zero null, 448-4 
non-inferiority, 450-4 
simulation, 440-3 

Wilcoxon test, 400-1, 400-7, 413-7, 415-7, 448-9, 
450-9, 485-7 
assumptions, 400-3, 485-3 
non- zero null, 413-1 
non-inferiority, 415-1 
simulation, 410-3 
superiority, 413-1 

Wilcoxon test - paired means 
simulation, 490-4 

Wilcoxon test - paired means - equivalence 
simulation, 495-4 

Wilks’ Lambda, 605-1 
MANOVA, 605-2 
repeated measures ANOVA, 570-1, 570-6 

Williams test 
examples, 595-4 
validation, 595-7 

Williams’ test, 595-1 
Wilson score limits 

one proportion, 115-2 
Wilson’s score confidence interval 

two proportions, 216-7 
Window menu 

output window, 5-7 
procedure window, 4-4 

Winsorized test (two means) - equivalence 
simulation, 465-4 

Within standard deviation 
repeated measures ANOVA, 570-15 

Within-subjects design 
repeated measures ANOVA, 570-3 
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Z 
Z test 

one proportion, 100-4 

one proportion - equivalence, 110-6 
two proportions - equivalence, 215-5 
two proportions - non-inferiority, 210-6 
two proportions - offset, 205-6 
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